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DVMAX Practice v8.6. Fast. Smart. Integrated.

Put the new DVMAX v8.6 to work on the day-to-day management of your busy practice and

spend more of your time where it matters most – caring for your patients.

Get more done in less time with the most powerful, flexible and integrated veterinary practice

management system available. DVMAX v8.6 introduces enhanced VetConnect PLUS inte-

gration, Autobook quick boarding, a new Image Markup and Notation feature and an updated

database engine under-the-hood for improved speed and stability. Plus, find many user-requested

updates and additions, like new custom reports, improved label printing, and enhancements to

invoicing and the appointment scheduler.

DVMAX v8.6 introduces a number of key upgrades and features including:

l An upgrade to the background database engine that will improve processing

speeds

l A number of VetConnect PLUS workflow upgrades

l The ability to assign a Client to a Staff record for requisition discounts

l Backup Mirroring to an additional backup server

l Several new custom reports

l An upgraded Image markup tool that allows staff to edit images

l An new Autobook feature that speeds up bookings in busy boarding sites

l Ability to set a default LIMS for Requisition orders

l Updated workflow for manual credit card processing
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Getting Started with DVMAX
Welcome to DVMAX, the complete Veterinary Practice Management solution for Windows and

Macintosh.

Conventions

The documentation contains many Helpful Hints. These contain useful information that will

help you work more efficiently with DVMAX. Helpful Hints are indicated with an information

icon.

Throughout the documentation you will also find Important Notes, which warn you of

actions that have potential consequences you should be aware of, such as data loss or changed

application behavior. Important notes are indicated with an exclamation point icon.

Other manual conventions:

l Names of menus, menu items, buttons, text enterable fields and checkboxes are

in bold.

l Keystrokes or keyboard shortcuts are in ALL CAPS.

l Directions to accomplish specific tasks are presented as bulleted lists.

About DVMAX Anywhere
The new DVMAX Anywhere is a flexible, responsive application that works where you do.

Whether you’re using a tablet, laptop or desktop device, Anywhere offers many of the powerful

features of your DVMAX client in a streamlined, web-based framework. With DVMAX Any-

where, you can work with patient or client records, complete scheduled To Do items, create

MREs, check the appointment Scheduler, review invoices, present consent forms for electronic

signature, view lab results and much more.

Many functionalities outlined in this Getting Started chapter work in very similar ways in

DVMAX and in Anywhere. For specific details on working with DVMAX Anywhere, refer to

the DVMAX Anywhere chapter in this user guide.

Starting DVMAX

Starting DVMAX for Windows
To start DVMAX for Windows:

l Double-click the DVMAX shortcut on your Desktop. If there is no DVMAX

icon on your Desktop, see Installation.

Starting DVMAX for Macintosh
l Double-click the DVMAX alias on your Desktop. If there is no DVMAX icon

on your Desktop, see Installation.
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Starting DVMAX Anywhere
The new DVMAX Anywhere is a flexible, responsive application that works on tablet, laptop or

desktop device. Anywhere offers many of the powerful features of your DVMAX client in a

streamlined, web-based framework. Refer to the DVMAX Anywhere chapter of this manual for

more information.

To launch Anywhere the first time:

l From the Special menu of the main screen of your DVMAX client, select

DVMAX Anywhere.

l From the DVMAX Anywhere dialog, choose whether to open Anywhere on

your current desktop machine or on a tablet. The URL for Anywhere will be

shown in the Enter URL on Tablet field. This URL can be used by desktop,

laptop or tablet. Bookmark Anywhere in your browser for quicker access the

next time you want to use it.

Logging in to DVMAX
When you start DVMAX, one or two dialogs appear, depending on which version of DVMAX

you have installed. The first sets up a network connection between your workstation and the

DVMAX server. The second provides the login window for DVMAX.

If you are using the single-user version of DVMAX, only the second of the dialogs below

will appear. 

To log on to DVMAX:

l From the list of servers (if your display shows more than one), select the

location of DVMAX.

l Click OK. This will connect your station to DVMAX.

l A DVMAX Login dialog will open. In the User Name field, type your

assigned user name.

l In the Password field, type your assigned password.  Your password can be

changed from the General Management option on the DVMAX Section

menu.  See Change Your Password for more information.

l Click Connect or press ENTER.
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Password Errors
If you type the incorrect user name or password, DVMAX will not launch. Try re-typing your

user name and password.

Changing Your Password
To change your assigned password after logging in the first time:

l From the Section menu, choose General Management.

l Select the Utilities tab.

l Select Set Passwords and Users and click OK.

l A warning dialog opens asking if you are attempting to change the Admin-

istrator password.

The Web server (Appointment Scheduler) must be closed before changes can be made to

the Admin password.

l Select Not Editing Admin User if you ARE NOT changing the Admin pass-

word.

l Select Stop Web Server if you ARE editing the Admin password. The Web

Server will close and you can then make changes to Admin passwords.

l The Passwords dialog opens.

l Select the User you wish to edit.

l The User screen displays.

l Select Edit to change the password, then type and confirm your password.

l Select OK.
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Depending on your user configuration and level of system access, you may not have access

to this area of DVMAX.

The Admin password cannot be changed while the web server (Appointment Scheduler) is

running. The web server must be closed before changes can be made to the Admin password.

Changing the User
You can change users without logging out of DVMAX. From the File menu, select Change

User. The User Identification dialog opens to allow you to log in as a different user.

You should close the Appointment Scheduler and Boarding facility before you change user

to be sure that the access restrictions for the new user are properly applied to those web-based

functions. If the appointment Scheduler or Boarding functionality is open when you select

Change User, DVMAX will prompt you to close and reopen them once you have entered the

username and password for the new user.

Quitting (Exit) DVMAX
To quit or exit from DVMAX:

l Choose Quit from the DVMAX File menu.

If you have difficulty quitting DVMAX, try closing all open DVMAX windows, then try

selecting Quit again.

When you quit DVMAX, please also ensure that you close the appointment and boarding

schedulers. DVMAX may prompt you to close these browser windows if you have not done so

on Quit.

Logging In to DVMAX Anywhere
DVMAX Anywhere requires users to log in. For security reasons, each user is strongly rec-

ommended to log in with their own unique username and password. When you are finished with

your session, you should log out. For more on using DVMAX Anywhere, refer to the DVMAX

Anywhere chapter in this user guide.

l To log in, type your username and password in the respective fields. Click

or tap Login.
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l To log out, click the Logout (“X”) icon.

DVMAX Fundamentals
Each text enterable “box” of on the screen is referred to as a “field”. You can move from field

to field in a forward direction by pressing the TAB key. To move backward, use the SHIFT-

TAB key combination. You can also use your mouse to place the cursor in any field on the

screen.

The cursor will be an arrow unless you are in a field that accepts typed input, at which point the

arrow becomes an I-beam (typing) cursor.

The active field is highlighted on screen with a blue outline.

DVMAX will automatically capitalize names and addresses. For capital letters not at the begin-

ning of a word (e.g. McAllister) you will need to use the SHIFT key.

If a button is double-bordered by a bold-heavy line, you can either click on it OR use the

ENTER key to accomplish its task (this may not work on some laptop keyboards).

DVMAX assigns a unique Client ID Number to each client you add. Patients are assigned a

unique Patient ID number. You can use these numbers for your filing system. If you have

already assigned numbers in your current filing system, you can use these numbers in DVMAX.

For more information, see Clients.
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Date Format
DVMAX expects dates to be in MM/DD/YY format. A leading 0 is recommended but not nec-

essary. You must type / or - to separate components. If your computer’s date format is not

MM/DD/YY, DVMAX should work with it we recommend you test to see if your date format

causes any errors. The Calendar is also available in most places where a Date field appears.

Time Format
When asked to enter a time of day in a Time field in DVMAX, the standard format is HH:MM.

A 24 Hour clock is used.  In most cases, seconds may be entered but will not display.

Using the Calendar
The Calendar allows you to quickly select a month, day and year.  It appears in most places in

DVMAX where a date needs to be entered.

To use the Calendar feature to select a date:

l Click the Calendar icon.

l From the Choose a Date window, click the left or right arrows beside the

Year to select the year. By default, the current year is selected.

l From below the Year, select a month. The selected month will be high-

lighted.

l The calendar corresponding to the month selected will be displayed to the

right of the Year and Month lists. Click to select a day of the month.
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l Click OK to accept the date. DVMAX will enter the date in the date field

beside the Calendar icon.

Pick Lists
When you are in a field which requires you to choose from a predefined list of choices (such as

Bill Item Codes or Species) you can use BACKSPACE-TAB (DELETE-TAB on Macintosh) to

bring up an on-screen list. You can then pick from the list by clicking on your choice with the

mouse, or by using the arrow keys to highlight your choice and then pressing ENTER.

The DVMAX Main Screen or Work Area
When you have successfully logged into DVMAX, you will see the main screen or work area,

sometimes called the DVMAX Splash Screen.

l The Window List allows you to see open windows at a glance, and switch

between them.

l The Command Palette provides convenient one-click access to the areas of

DVMAX you will use most frequently.

l The Menu Bar is located at the top of the screen, and provides access to

DVMAX commands. The contents of the Menu Bar will change depending

on the task you are performing.

DVMAX Practice V8.6 - User Manual



- 9 -

l The Section menu in the Menu Bar is the most frequently used menu in

DVMAX. It is the starting point for most of the work you will do.

For details on working with DVMAX Anywhere, refer to the DVMAX Anywhere chapter

of this user guide.

The Window List
The Window List allows you to see which windows are currently open, and how each of those

windows is currently being used.

The Window List shows the headings of all of open windows. It may also show available win-

dows not currently open (e.g. the “OTC Invoice” window).

Each item in the Window List reflects information about each open window. For example, if

you are viewing a client record for John Doe, then the Window List will display “(Client) John

Doe”.

You can jump to any window in the Window List by clicking on that item on the list.  This will

bring the window to the front and allow you to work with it. The only time it is not possible to do

this is during the display of a dialog window, when you must provide the requested information

before proceeding.

Two exceptions to the above:

l The OTC Invoice option always shows up in the Window List even through

no OTC Invoice may be open. It is used to bring up an OTC invoice for

invoicing non-clients as quickly and easily as possible. See Invoicing for

more information.

l You will not see Appointments in the Window List with DVMAX 7.6 and

higher, where the Appointment scheduler is web-based. The Scheduler is

not running in a 4D process, so it will not show up in the Window List. See

the Appointments chapter for more information.

You will not see Appointments or Boarding in the Window List with DVMAX 7.6 and

higher, where the Appointment scheduler is web-based. See the Appointments chapter for more

information.

Hiding & Showing the Window List
You can hide the Window List at any time by clicking on the close box in the corner of the win-

dow. You can also move the Window List to a more convenient location, as it “floats” above all

other windows.

If the Window List has been closed, you can show the Window List by choosing Show Win-

dows List from the File menu.
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The Display Window List at Startup preference controls whether the Window List is dis-

played when DVMAX starts.

Each datafile in use at a practice can have a label that will be displayed as part of the Win-

dow List.  This is helpful if different practices (e.g. a Small-Animal & an Emergency practice)

share the same facility but use different databases for business purposes. The label is set in Sys-

tem Constants.

The Command Palette

The Command Palette gives you one-click access to:

l Clients

l Patients

l Labs

l Reports

l Pending Items such as To dos and Treatment Plans

l Appointments

l Boarding

For more information on most of these topics, see The Section Menu.

The Section Menu

The Section Menu consists of the following items:
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Clients & Patients gives you access to Client and Patient records, along with several other key

items such as Invoicing, Transactions (payments, etc.), Referral Sources, and Word Processing

(Letters).

Inventory Management gives you access to Inventory, Bill items, Item Categories, Payment

methods, etc.

Patient Codes takes you to the code system used for defining patient related items such as

Reminders, Recalls, Treatments, Diagnoses, Staff, Rabies Info, etc.

System Constants controls the behavior of various aspects of DVMAX. All users of DVMAX

at your practice share these settings.

General Management contains management and financial routines and reports.

Log Records gives you access to the various log records that DVMAX keeps as part of its oper-

ations.

Boarding gives you access to the boarding schedule for your clinic.

Treatment Plans provides a list of all treatments or medical procedures due or pending for

patients of the clinic.

Reminders allows you to generate and send Reminders to your clients.

How to Perform a Search
All searches in DVMAX are conducted the same way, regardless the type of search. When you

need to perform a search, you will use the Find dialog. The exact contents of the Find dialog

are context-dependent.

To search for one or more records:

l From the Find dialog, select what you are searching for from the Search

For drop-down menu. For example, to search for Clients after choosing

Clients and Patients from the Section menu, you would choose Clients

from the Search For drop-down menu. Note that this step is not always nec-

essary.

l From the Find dialog, select your search criteria from the By drop-down

menu. For example, if searching for clients, you may choose to search By
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name or by those who have unfinished invoices.

l Provide additional information on the selected criteria as needed. For exam-

ple, if you chose to search for Clients By name, you will need to type in the

client’s name.

l Click Search.

l A list of all records matching the criteria you defined is generated. If you

chose to search for all Clients with unfinished invoices, then the search will

return a list of every Client with an unfinished invoice.

l Select one or more records from the records list.

l Click Show to see the record(s).

Refer to the appropriate sections of this documentation for information on searching for specific

types of records.

Sorting a Search Result
Every list of records list is sorted according to a specific default selection. This default selection

is indicated by an upward or downward-facing triangle in the heading. Typically, you can re-sort

the list by any of the column headings on the list, although there are occasional exceptions.

To sort the list of records:

l From the list window, click on the column heading by which you would like

to sort the list.  The list will be sorted according to that heading in ascending

order. 

l Click the heading again to sort in descending order.

Sorting Lists in Appointments and Boarding
Sorting lists under Appointments and Boarding looks slightly different, but lists can still be sorted

by any of the column headings on the list.

To sort a list from Appointment or Boarding:
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l From the list area, click on the column heading by which you would like to

sort the list.

l From the drop down menu, choose to sort the list by the column heading in

Ascending or Descending order by selecting SortAscending or Sort

Descending from the menu.

Selecting Multiple Records
Once you have generated a list of records matching your search criteria, you may want to select

a group of those records to view in a new window, hide a set of records from the list, or select a

group of records to which to apply a specific action.

To select a set of records:

l Select a record; hold down the shift key while clicking on the last record.

This will highlight all the records between the first selected and last

selected.

-OR-
l To select several records are not sequential on the records list, press and

hold the CTRL key as you click each record you want to select.

Subset/Selection
To view a selected group of records in a separate window:
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l Highlight the records you want to include in the new list.

l From the records list select the Show button at the bottom of the window. A

new list window will open containing only those records you selected. 

Exclude Subset
To remove selected records from the list:

l Highlight those records you want to exclude (hide) from the list.

l From the records list window, click Exclude button. The selected records

will be hidden from the list.

Display/Hide Columns from Lists in Appointments or Boarding
The lists you find from the Appointment Scheduler  or Boarding display with a set of default col-

umns. It is possible to hide the display of columns. To display or hide columns from the list:

l From the records list, move your pointer or “mouse over” the heading of a

column on the list.

l Note that there is an arrow on the right side of the column heading. Click on

the arrow to display the drop down menu.

l Click Columns from the menu to see the list of columns that can be dis-

played or hidden.

l Click on an item to select it and have it appear on the list. An item is

selected if there is a checkmark in the box beside the column name.

l To hide a column so that it does not appear on the list, click the associated

checkbox to remove the mark from the box.  An item is hidden or deselected

if there is no checkmark in the box beside the column name.

Getting Started with Clients and Patients

Creating a New Client Record
To enter a new client in DVMAX:

l Choose Clients and Patients from the Section menu

-OR-
l Click Clients on the Command Palette

l The Find dialog opens.

l Click Add New at the bottom of the Find dialog.

l A New Client record window opens. Fill out as many fields as necessary.
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l Click OK to save the new client.

Creating a New Patient Record
To enter a new Patient into DVMAX:

l Locate the client who owns the patient from the Clients list.

l From the Client record, choose Add Patient from the Patient menu, or dou-

ble-click in a blank area of that client record’s Patient List (in the lower

left quadrant of the Client screen).
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l A new patient record window opens. Fill out as many fields as necessary.

l Click OK to save the patient record.

A new patient record can only be created from a client record. A patient must be associated

with a client.

Creating Appointments
The Appointment Scheduler lets you create, view and modify appointments for new or existing

clients and patients. You can “click and drag” on the scheduler to create appointments or you

can choose Set Appointment from a Client record (under the Client menu) or Patient record

(under the Patient menu).

Beginning with DVMAX v7.6, the Appointment Scheduler is entirely web-based, adding further

flexibility. In addition to the functionality you’re used to, the new scheduler gives you features

like patient/client Check In, expanded reporting and the ability to copy, cut and paste appoint-

ments. Refer to the Appointments chapter in this manual for more details.

l In Day View, select a start time for the appointment by clicking and drag-

ging on time on the Appointment Scheduler for the day you have selected.

Release the mouse when the appointment box is drawn. Alternatively, dou-

ble click on a time block.

l An Appointment Detail window opens.

l You will need to identify the Client/Patient for whom you want to create the

appointment using the Client and Patient fields and/or the pick list. If you are

creating an appointment directly from a client or patient record, the name of

the client/patient will already be filled in.

l Use the Client and Patient fields to filter the Client/Patient list.

l Define appointment details, including type of appointment, and enter com-

ments if desired.

l Click Save to confirm the appointment.

l Enter your Staff ID if required.

Using the Contextual (Right Click) Menu: A Summary
Cut Appointment works in combination with Paste Appointment to allow you to quickly move

an appointment anywhere using the same cut and paste method familiar to many applications.

Clicking Cut Appointment removes the appointment. Find the date where you wish to move the

appointment, right click and select Paste Appointment.

Copy Appointment allows you to create a copy or duplicate of an existing appointment and

place it in another location. Right click on an existing appointment, click Copy Appointment

and then select Paste Appointment.
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Double Book lets you quickly create a new appointment beside an existing appointment. Right

click on a selected appointment and choose Double Book. An appointment is created beside the

existing appointment. The appointment is the same type and length as the original appointment,

but there is no associated client or patient.

Find Next Appointment locates the next scheduled appointment for the patient or client. If

there is no future appointment, a dialog displays indicating this.

The Go To Record option in the pop up menu opens the associated Client record (if the appoint-

ment is a Client only appointment) or Patient record (for Patient appointments).

Selecting a Check-In lets you mark an appointment as “checked in”. This marks the start of a

patient or client visit. You must choose a reason for the visit from a predefined list of options.

The status of the appointment will change to Checked In and this will be noted by a check mark

in the top right corner of the appointment, depending on how you have configured the Check In

Status Value.

Selecting Set Status will bring up a Status drop-down menu that will allow you to express the

current status of the appointment, along with a visual marker on the appointment to allow for a

quick, at-a-glance view of where a patient or client is in the appointment process. Status values

are defined under Appointment Setup. These values also permit you to track the amount of time

a patient spends at each stage of their visit.

Keyboard Shortcuts
The following table lists the most commonly-used keyboard shortcuts (or “hotkeys”) in

DVMAX. You activate a keyboard shortcut by simultaneously pressing the CONTROL key

(Windows) or COMMAND key (right beside the spacebar on Macintosh) and the identified

number or letter.

Press Control/Command

and this key…

To achieve this:

1 Search for clients and patients. When the

search box appears, you can change what you

are searching for by using the up and down

arrow keys. You can change how you are

searching for something by using the left and

right arrow keys.

N Add new – If you are at the client search box,

you have searched for the client and he/she is not

in the system, you can use ctrl-N to add a new

client. If you are in the client screen and you

need to add a new patient, Ctrl-N will work to

add a new patient.

F From a client screen -

Brings you to that client’s financial infor-
mation.
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L In a client or patient screen -

Brings you to theWord Processing tab.
T In a client screen - Add a new transaction. 

In the patient history screen – Add a new MRE
E In a client screen - Create an estimate.
Y In a client or patient screen – Create an Alert
M In a client or patient screen – Create aMemo
H In a patient screen –

Brings you to patient History
J In a patient screen – Jumps back to owner

screen

S In a patient screen –

Set/Find Appointment for that patient
B In a patient screen –

Set/Find Boarding for that patient
I From a client or patient screen –

Creates an invoice, or will bring up an open
(invisible) invoice.

There are many more keyboard shortcuts in DVMAX. Each is listed next to its corresponding

task in the pull-down menus.

These shortcuts will not work from the Appointment Scheduler in DVMAX v7.6 or higher.

Creating an Appointment: A Quick Summary
Use the following process to create an appointment for an existing Patient or Client. If you want

to make an appointment for a new Patient or Client (one who does not yet have a record), refer

to the Appointments chapter for details.

Creating an Appointment from a Client or Patient Record
If you are creating an appointment from a Client or Patient record, the steps are the same for

both. The process can be summarized as follows:

l Open the record for the Client or Patient for whom you want to make the

appointment.

l Select Set Appointment from the Client or Patient pull-down menu. This

will open the Appointment Book to Day View, and the next created appoint-

ment will be for the client or patient whose record you were just viewing.

l By default, the Scheduler opens to the current date in Day View. Select a

different date, using the Date Picker or the Date field, if needed.

DVMAX Practice V8.6 - User Manual



- 19 -

l From the appointment grid, choose a start time for the appointment by click-

ing and dragging on time on the Appointment Book. Release the mouse

when the appointment box is drawn.

l An Appointment Detail window opens. Define appointment details and

enter comments if desired.

l Enter your Staff Initials, if requested.

l Click Save to confirm the appointment, or click Cancel to return to the

Appointment Book.

Creating an Appointment from the Appointment Book
If you are creating an appointment directly from the Appointment Book:

l From Day View, select a start time for the appointment by clicking and drag-

ging on time on the Appointment Book for the day you have selected. Alter-

natively, double click on the appointment block where you want to create the

appointment.

l An Appointment Detail window opens.

l Type a Client or Patient name in the appropriate field. Depending on the

way your Appointment setup is configured, you may need to TAB out of the

field to get the list of Clients and Patients below the Client/Patient fields to

refresh.

l Select the Client or Patient from the list.

l Define appointment details and enter comments if desired.

l Enter your Staff Initials if requested.

l Click Save to confirm the appointment, or click Cancel to return to the

Appointment Book.

Deceased patients are indicated in grey font in the patient listing below the Client/Patient

fields.

Help and Technical Support
To access help for DVMAX:

l Select About DVMAX from the 4D menu on the DVMAX main screen.

l Click DVMAX Help from the About DVMAX dialog. 

For DVMAX technical support, please call 1-800-950-5455. Please have your DVMAX User

ID ready.
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Quick Reference Guide

Generating an End of Day Report
To generate a End of Day report:

l Click the Reports button on the Command Palette.

l Double-click Transaction Summary Report.

l The Start and End dates & times will automatically default to the LAST EOD

report run to the current time.  Change if necessary.

If you are using DVMAX’s integrated credit card processing feature and are an X-Charge

client, you must run the X-Charge/DVMAX EOD Comparison as part of your EOD process. 

See Integrated Credit Card and Debit Card Processing.

In DVMAX, date fields – type in just the day and DVMAX will know you mean ‘this

month’. (eg; If it’s February and you type in “21” and hit tab, DVMAX will assume you mean

February 21st of the current year and fill in 2/21/07 automatically.) Type in a month and day and

DVMAX assumes you mean this year. (eg; Type in 4/21 and hit tab and DVMAX will fill in

4/21/07 automatically)
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l Choose End of Day in the Transaction Summary report type.

Smart Summary is automatically selected to tell DVMAX to remove corrected transactions,

or other transactions that cancel each other out, from the report. For more information, see The

Smart Summary Option.

l Click OK to generate the report.

l Click Print to print the report.

l If you chose End of Day as your report type, DVMAX will ask you to update

the timer for the next end of day report.

Before choosing Yes or No from the Print confirmation dialog, reconcile the printed report

to the payments you have on hand. If everything is correct, click Yes. If there is an error, click

No, exit General Management, correct the error, then come back to rerun the report. (If you

choose Yes, then recognize a mistake, the report can be rerun, you will just need to manually

enter the dates in Step 3)

l Clicking Yes resets the current date, time and current receivables total for use

in the next end of day report. For more information, see Transaction Summary

Report Types in the main Manual.

End Of Month Reports

Generating an End of Month Report
To generate a End of Month Report:

l Click the Reports button on the Command Palette. The Report List appears.
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l Double-click Detailed Sales Report. The Sales Summary Options screen

appears.

l Choose a Doctor to report on from the Doctor drop-down list at the top of the

Report Options screen or leave the field as it is defaulted. This will print the

EOM report for ALL doctors in your practice.

l Type the time period you wish to include in the report into the Date Range

Entry boxes. The format for all dates in DVMAX is MM/DD/YYYY. So, for

example, to generate a report for June 2004, type 06/01/2004 into the Start Date

box and 06/30/2004 into the End Date box. (Or 6/1 and 6/30 – DVMAX will

assume you mean the current year and fill in the dates for you.)

l Choose a Sales Type by clicking the appropriate radio button.  (The most com-

mon report is the Dr. & Category)

l Click OK to generate the Detailed Sales report. DVMAX will begin compiling

the report. The time it takes to generate the report depends on the amount of data

DVMAX needs to sort through and the speed of your computer.

l Click Ok to print the report.

Printing and Exporting Reports
You can print all financial reports in DVMAX. You can also export some reports to a text file

that you can then open in a spreadsheet application such as Microsoft Excel. The reports avail-

able for export are:

l Full Details Transaction Summary

l Daily Totals Transaction Summary

l Totals Only Transaction Summary

l Detailed Sales

l Receivables

l Sales Tax Collected
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A setting in System Constants (Main Constants tab) controls whether DVMAX gives you the

option to export reports. Then, each time you print a report, DVMAX will ask if you want to

Print or Export the report.

Receivables Report
The Receivables report gives you a snapshot of what is owed to you by your clients (Accounts

Receivables), and what you owe them (Credit Balances) at the time you run the report.

Generating a Receivables Report
To generate a Receivables report:

l Click the Reports button on the Command Palette. The Report List appears.

l Double-click Receivables Report. The Receivables Report Options screen

appears.

l Choose a Receivables report type (Totals Only, Full Report or Provider

Breakdown) by clicking the appropriate radio button. For information on the dif-

ferences between types of Receivables reports, see the following section,

Receivables Report Types.

l Click Print to print the report.
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Receivables Report Types
DVMAX can produce three variations on the Receivables report: a Full Report, a Totals-Only

report, and a Provider Breakdown report.

The Full Report
The Full Report is the most comprehensive Receivables report type. For each receivable and

credit balance, DVMAX lists:

l The client’s name and ID

l The amount and date of the client’s last payment

l The client’s telephone number

l Subtotals of the client’s total balance by age (current, 30 days, 60 days, and 90+

days)

l The total amount due from this client

DVMAX also totals receivables and credits, and combines the two for an overall total. The per-

centage of your balances at each age (current, 30, 60 and 90+ days) is also calculated.

The Totals-Only Report
The Totals-Only Receivables report is a summary of your Accounts Receivables and Credit Bal-

ances. For both Receivables and Credits, DVMAX shows aged amounts (current, 30 days, 60

days, and 90+ days) and the percentage of the total balance at each age. Overall totals are also

provided.

The Provider Breakdown Report
The Receivables By Provider report type lists the total receivables produced by each provider

in your practice. The percentage accounted for by each provider is also calculated, as is a total

for your practice as a whole.

Any receivables not attributed to a provider are also listed on the report. Finally, totals for sales

taxes are also provided.

The Provider Breakdown report type is useful if you pay your providers based on pro-

duction.

Calculation of Staff Compensation based on a % of collected revenue
This calculation is used when a staff member is to be compensated based on a % of collected

revenue rather than on a % of 'Billable Amounts'.

To calculate a % of billable amounts:

l Produce a Detailed Sales Report listing the DR. and Category.

l Enter the date range for the current month and choose OK.

This report provides production values for each Provider over the chosen period.

l Produce a Receivables Report listing Provider Breakdown.
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It is not possible to enter a date range when printing a Receivables Report. It is important

that you print and or export Receivable Reports each month for comparison purposes.

l Compare the current receivables to the previous month value.

l If the receivable difference has increased over the previous month, the dif-

ference is added to the Total sales

l If the receivable difference has decreased from the previous month, the dif-

ference is subtracted from Total Sales.

l Calculate the new Total Sales value and multiple by the commission rate.

Printing Reminders
A reminder is a notice that is sent to a client indicating that a patient is due for a specified pro-

cedure or set of procedures.  DVMAX’s Reminders function lets you identify all patients need-

ing reminders for procedures due within a specified date range, and allows you to create and

send reminder notices via email or standard mail.

Reminders: A Quick Overview
To create a list of patients requiring a reminder notice:

l From the Section drop-down menu, choose Reminders.

l From the Reminders window, select a Date Range, or use the default range as

listed.  (The default Date Range is determined by the Reminder Setup button.)

l Choose the procedures for which you would like to create reminders from the

Types area of the Reminders window. By default, all procedures are selected. 
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Procedures can be added/deleted from the default procedures list:

l Click Select All to include all Types.

l Click any item to select it, click again to deselect the item.

l Click Remove All to deselect all Types.

Once desired Reminders are selected:

l Click OK to produce a list of all patients requiring reminders.

The list of patients generated by the Reminder function is color-coded to indicate that the

patient is due to receive either a first, second or third reminder.  For each patient, all procedures

due within the specified date range will appear on the same reminder notice.  Depending on how

you have set up the Reminder function (see Reminder Setup, patients can be sent up to 3

reminder notices.

l Green indicates first reminder.

l Blue indicates second reminder.
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l Red indicates third reminder.

l From the Reminder List window, click OK to generate the reminder notices. 

The kind of reminder notice created (email or standard mail) will be determined

by the selection you have made in the client record. 

Where the Email Reminder box is checked on the Client record, an email reminder will be

sent.  For those clients where the Email Reminder option is not selected, a regular mail notice

will be prepared.

Excluding Patients from the Reminder List

You can choose not to generate a reminder for any patient on the Reminders list.

To exclude a patient:

l Click to highlight a patient from the list.

-OR-
l Click and drag to highlight a group of patients from the list.

l Click Exclude.  The selected patients will be removed from the list.

Excluded patients may be used for an owner that you know has called to schedule on their

own already, or if a new staff member’s pets are listed and that staff member has not been

marked as “Do Not Send Reminders”
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Reminder Setup

The Reminder Setup determines the format of the reminder notice, as well as the default

Date Range. 

To configure the Reminder function:

l From the Section menu, click Reminders. The Reminders window opens.

l From the Reminders window, click Setup. The Reminder Setup window opens.
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l From the Send Reminders area, choose how often you wish to generate

reminder notices (Monthly, Semi-monthly or Weekly).  The default value is

semi-monthly.  This will determine the default Date Range used in generating

the Reminder List.  (DateRange, including Start Date and End Date fields,

appears on the main Reminder window.)

The Monthly default Start Date will be the first day of the month following the current

month (current date is the first of the month).  Semi-monthly will default to the first or middle of

the month, depending on the current date.  For example, if the current date is May 5, the default

date for Semi-monthly will start at May 15.  For Weekly, the default Start Date will be the Mon-

day of the week following the current date.
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l From the Reminders to Send menu, select the number of reminder notices to

send to each client and associated patient.  You can send a single reminder, or

choose to send second and third reminders.

l From the Format drop-down menu, select Built-In (default), 4D Write or

Semi-Custom. Follow the same process forMail and E-mail reminders. You

cannot send reminders by both mail and e-mail to the same client, and you must

have a valid e-mail address in the client’s record in order to send an electronic

reminder.

l If you choose a format other than Built-In, click Set to select the format for

reminders.

l Repeat the format setup for First, Second and third reminders as applicable. 

You will only see second and third reminder options if you have chosen 2 or 3

from the Reminders to Send menu.

l If you are sending mail reminders, you can choose to include more than one

reminder card per printed page.  ClickMultiple Cards on a Page to include

more than one reminder on a page. (Helpful Hint – if you are using the rec-

ommended 3-up Laser cards – you should check this setting.)

Only one reminder per patient will be sent out at any one time. All procedures for which a

patient is due within the selected Date Range will appear on the same reminder notice. If the

patient comes in they will be marked as complying with the reminder and will be sent no further

reminders for the procedures listed on the last reminder sent. If the patient does not present, the

patient may appear on the Reminder List the next time Reminders is run.   In order for a patient

to receive a second or third reminder, the specified time between reminders (as set up under Sys-

tem Constants) must have lapsed, and you must have indicated under Reminder Setup that you

wish to generate second and third reminders.
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Adding a New Transaction

Payment Information
DVMAX provides multiple methods to pay for treatment and services and also allows the client

to split the payment into two types of methods on an invoice.

You may specify up to two methods of payment per invoice on the payments area of the invoice

screen.

In most cases, only one will be needed.

To add payment information:

l Select a pay method from the Pay Method 1 drop-down list.  For more infor-

mation on using DVMAX integrated credit and debit card processing (pay meth-

ods cCard and Debit), refer to Integrated Credit Card and Debit Card

Processing.

l The full amount owing on the invoice may automatically appear in the first

Amount box, depending on the Suppress Auto-entry of Payment Amount Sys-

tem Constant (see System Constants that Affect Invoicing for more information).

You can edit the contents of the Amount box at any time while the invoice is

unfinished.

l The Pay Notes box will fill in automatically when you supply a pay method.

You can edit the Pay Notes if necessary and your changes will appear on the

printed invoice.

l Repeat the steps above for Pay Method 2 if necessary.

l The combined total of the values in the Pay Method 1 and the Pay Method 2

boxes will appear in the Payments box.
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Type CONTROL+P (COMMAND+P on Macintosh) to jump to the payments area from any

other part of the invoice. This will bring you to the first payment method field.

Credits
Credits are used when you would like to make a credit on a clients account but don’t want to

change your revenues for the day. Credits are put forward against future changes and or pur-

chases.

A credit is only used if no money was received. There is no connection with payments

made with credit cards.

To make a credit on a Client’s account:

l Select the Client you would like to add a credit

l Select Add new transaction from the Client menu

l The Transaction window opens

l Select Credit in the Transaction Type drop-down menu

l Add Transaction amount (credit)

l Add Notes to clarify why the credit was made

l Select OK

Non-Sufficient Funds (NSF) and Chargebacks
In cases when a check comes back with non-sufficient funds you will need to edit the original

invoice to reflect a new payment and or enter a charge for the NSF.

To edit the original invoice to reflect the new payment arrangement:

l Open the Client screen for the client who wrote the NSF check

l Click the Finances tab

l Select the payment made with the NSF check

l Select Add new Transaction from the Client menu

l The Transaction Report screen appears

l Select Chargeback from the Transaction Type menu.

l Enter the date of the original NSF payment

l Enter the amount of the original NSF check in the Transaction amount entry box.

You will be recharging for the original NSF amount.

l Add a note stating this is a Chargeback for a NSF, with date, type and amount

l Click OK

If you wish to make an additional charge for the NSF, repeat the Add New Transaction process

above.  This time however the Chargeback will be for the NSF fee charged.
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l Enter the Transaction Type as Chargeback.

l Enter the original Date, Transaction amount and notes.

l Click OK

Editing, Correcting or Voiding Finished Invoices and Payments

Editing or correcting a finished invoice can have unintended consequences on your practice’s

financial records. If you are uncertain how to correct an error on a finished invoice, or if you are

uncertain of the effects your correction might have on your financial records, please contact

DVMAX Technical Support before proceeding.

Editing or Correcting a Finished Invoice
To edit a finished invoice:

l Locate the client for the invoice.

l Locate the invoice you wish to edit on the Client Finances screen.

l Double-click the invoice you wish to edit.

l Choose Edit This Invoice from the Invoice menu on the DVMAX main screen.

l DVMAX will ask you to confirm that you wish to edit the invoice. Click Yes.

l DVMAX will ask you to confirm again that you wish to edit the invoice. Click

Yes.

l DVMAX may ask you if you wish to keep any payments originally made on this

invoice:

l Choose Keep Pmnt (Keep Payment) if you have already deposited the payment

originally made on this invoice. Choosing Keep Payment will reverse the invoice

only, not the payment. The payment will stay on the client’s account.

If you choose Keep Payment, do not enter the payment again when editing the invoice.

-OR-
l Choose Enter Again if you have not deposited the payment originally made on

this invoice. Choosing Enter Again will reverse both the invoice and the

payment.  Behavior will be different for transactions involving the integrated

credit and debit card processing.  Refer to Integrated Credit and Debit Card

Processing for more information.

If you choose Enter Again, make sure to enter the payment again while editing this invoice.

l DVMAX will create a new invoice with the same line items, patient and staff

as the original. Make the necessary changes to the invoice.
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l Click OK to save your changes. Your changes are recorded on the Client

Finances screen, creating a “paper trail” that allows you to track altered trans-

actions.

Voiding an Invoice
If an entire invoice is incorrect or unnecessary you may void or cancel the invoice. When you

void an invoice, DVMAX creates an Edit Credit on the Client Finances screen to ‘zero’ the bal-

ance due for the line items on that invoice.

DVMAX also creates an Edit Charge on the Client Finances screen to remove any payment(s)

made on the voided invoice. DVMAX also stores a note as to the date the void was performed.

Depending on your payment processor, you may not be permitted to void an invoice on

which a credit or debit card transaction has been processed using the integrated credit and debit

card feature.

To void an invoice:

l Locate the client for the invoice.

l Locate the invoice you wish to void on the Client Finances screen.

l Double-click the invoice you wish to void.

l Choose Void This Invoice from the Invoice menu on the DVMAX main

screen.

l DVMAX will ask you to confirm that you wish to void this invoice: Click Yes.

l DVMAX voids the invoice and returns you to the Client Finances screen.

Voiding a Payment
DVMAX creates an Edit Charge on the Client Finances screen to remove any payment(s) made.

DVMAX also stores a note as to the date the void was performed.

When you try to void a credit card (cCard method) payment, DVMAX tries to perform a

refund first, then do a return afterward. If both fail, however DVMAX lets you know you need

to run the void manually.  DVMAX assumes you wanted to perform the void regardless of the

method, and will post the refund/return transaction as Echg in DVMAX Client Financials to

reflect the refund you process.

Depending on your payment processor, you may not be permitted to void a debit card

transaction.  You will have to use the credit card (cCard) method to issue a refund instead to try

to have funds returned to the client’s credit card, or issue a refund or return in the same way you

would for a cash transaction.  If you try to void a Debit transaction with a processor that does

not permit this transaction (processed using DVMAX’s integrated credit and debit card feature),

you will get an Alert notice from DVMAX indicating that you cannot perform the void.

To void a Payment:
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l Locate the client for the payment.

l Locate the payment you wish to void on the Client Finances screen.

l Double-click the payment you wish to void.

l Choose Void this Entry… from the Transaction menu.

l DVMAX will ask you to confirm that you wish to void this payment: Click Yes.

l DVMAX voids the payment and returns you to the Client Finances screen.

Batch Payments
Batch Payments allows you to enter more than one payment in one simple screen.  This saves

you the time of having to enter multiple payments.

To make a Batch Payment:

l Select Enter Batch Payments from the Special menu of the main screen.

l The Batch Payment Entry screen appears.

l Add the Client ID or last name

If you need a list of all clients select (/ tab) to bring up a list of all clients.

l If there is an outstanding balance for this particular client it will be posted in

starting balance.

l Enter the payment amount you wish to make in the Transaction amt box. The

New Balance will then appear.

l Add Payment method and add General notes

l Click OK
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Barn Billing
Barn Billing applies a single invoice to a group of patients. DVMAX will generate an identical

invoice for each patient in the group and apply the history to each patient and invoice to each

individual client. Barn Billing is used mostly in equine practices.

To use Barn Billing, your DVMAX datafile must be labeled Equine in System Constants.

DVMAX recommends you do not leave barn-billed invoices unfinished.

To barn bill you’ll first need to create an Invoice:

l Search for a patient in the barn/stable.

l Select patient by double clicking on the Patient’s name.

l Create an invoice,

l The Invoice screen will appear and will be titled “Invoice xxx for Client Name”,

where xxx is a unique invoice number generated by DVMAX and Client Name

is the name of the client you are billing.

l The current date will be in the Date box. Type a different date in the date box if

needed.

l Type the details of the product or service you are selling in a Line Item row.

Include the Quantity of the item sold, Date (if different from the current date),

Staff (if different from the Primary Provider), and Item Code. Each product or

service uses one line item row. To add a line item row, click the Add Line but-

ton.
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l Before clicking OK to post or save the invoice, click once to select the Barn Billing

checkbox.

The Payment Fields are removed. You do not want to add a payment to this invoice, as it

would apply the payment to each client record. If an owner paid you onsite – you’ll need to “Add

New Transaction” (see above) to enter the payment as its own entry.

l Click OK.

l You are returned to the original patient history.

l Perform the same search for the Patients associated with the barn/stable.

l You are returned to your original list of Patients from the stable.

l Highlight the patient you just invoiced and exclude this patient.

l Exclude any other patients that did not receive these services

You can select multiple patients by holding the CONTROL key (COMMAND on Mac-

intosh) while clicking.

l Click Add Patients on the Barn Billing window. The Barn Billing window will

update to reflect the number of patients you selected.

l When you have finished adding patients, click Apply to Patients on the Barn Bill-

ing window.

l DVMAX will ask you to confirm that you wish to apply the invoice to this group of

patients.

l Click Yes to invoice the group of patients.
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Using DVMAX on the Remote Terminal
Ensure that you have followed the steps in Setting Up For Remote Processing. Not setting up

properly will cause the remote processing procedure to fail, and can cause serious damage to

your data. For more information on using DVMAXSync (Remote Processing), please refer to the

chapter DVMAXSync and Remote Processing.

If a DVMAX Trainer has not recently set up this routine during a personal visit, you must

call Technical Support and schedule a time for this procedure. Please call DVMAX Technical

Support. Remote Processing has changed. Ask Technical Support about the new DVMAXSync

introduced in DVMAX v7.5

Users and Groups
To create new Users and Groups for your office you will need to open up the Tool Box. This

screen will list all current Users and Groups and will allow you to create and edit Users and

Groups.

To open the Tool Box:

l From the Section menu select General Management.

l The Management Functions screen appears.

l Select the Utilities tab.

l Select the Set Password & Users radio button and click OK.

l The Tool Box appears.
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l The relationship between the Users and Groups is that Users are assigned to a

Group while Groups are assigned privileges. With this structure a User must

be part of Group to gain the privileges associated with that group.

l

Adding a new User
To Add a new user:

l Click the plus sign under the Users list.

l Type a name for the user. Click Edit and type a password. Confirm your pass-

word. Click Change.

l In the Member of Groups area, select the groups to which this user will belong.

Deleting a User
Only the Administrator has the ability to delete a User. Contact your System Administrator.

Security Groups
To view security groups, click the Groups button at the left of the Tool Box. Groups display in

the Groups list on the left, and Users display in the User / Group list in the upper right.  In the

Members column, click to select which users belong to the group.
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DVMAX Practice provides the following default security groups:

l Animal Husbandry

l Batch

l Clients & Patients

l CM Admin

l CM Tech

l Delete Clients & Patients

l Edit & Void Invoices & Trans

l General Management

l Inventory Management

l Log Records

l Mailings & Contacts

l Manager / Supervisor

l Mass Change & Delete

l Patient Codes

l PI

l Practice Financials

l Preferences Access

l Replication

l Scheduling Access

l System Administrator

l System Constants

l Testing

l Time Limited Financial Access
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l Tox Tech

l User Site Access

l Veterinary

l Word Processing Access

Saving and Restoring Users and Groups
When the DVMAX server shuts down, it automatically writes its Users and Groups to a file

location on the server machine. 

If you need more information on this, please contact DVMAX Technical Support.

Manually Saving Users and Groups
To manually save your current users and groups configuration to file, click the Save Users and

Groups icon below the Groups list in the Tool Box.

l A Save dialog box displays. Specify a file name and location for the file. Click

OK.

Manually Loading Users and Groups
To load saved users and groups from file, click the Load Users and Groups icon below the

Groups list.
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A dialog box displays. Locate your users and groups file, and click OK.

Quitting and Force Quitting DVMAX

Quitting or Exiting from DVMAX
To quit or exit from DVMAX:

l From the DVMAX main window, choose Quit from the File menu.

l If you have difficulty quitting DVMAX, try closing all open DVMAX windows,

then try selecting Quit again.

Force Quitting
If you cannot quit DVMAX in the usual way you will need to force quit the program. Force Quit-

ting is used on the Mac while CTL+ALT+DEL is used on the PC.

If DVMAX appears to be ‘locked’ and won’t let you do anything, or if the cursor looks ‘dif-

ferent’ –one black and one white box – try hitting the spacebar. This will often bring a window

to the front that must be dealt with before DVMAX will allow you to proceed.

A Force Quit should always be your last resort. Unsaved changes in your open applications

will be lost when force quitting.

Force Quitting In the PC
If you cannot quit an application you will need to Force quit by:

l Selecting CTL+ALT+DEL on your keyboard while the program is running in the

foreground.

l Choose the DVMAX program and click “End Task”
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Force Quitting on the Macintosh
If you cannot quit an application you will need to Force quit by:

l Choosing Force Quit from the Apple menu (or press ALT + Apple/Option Key +

ESC),

l A dialog box will appear,

l Select the unresponsive application and click Force Quit.

l Say yes to the Confirm box that will appear.

Adding Alerts vs. Memos
DVMAX now has two ways to provide patient or client notes to other staff members.

The first option is to place an Alert note in the Command Palette when the patient or client

screen is opened. The second option is to create a Memo note that appears on screen when the

patient or client screen is opened.

How To Create an Alert Note
For a Patient:

l Open the Patient record to which you wish to attach the Alert note.

l When the Patient screen is open select Set Alert Message from the Patient

Menu.

l A window named Alert note for this record will appear.

l Add your note to the Window and click OK.

l The note displays in red at the bottom of the Command Palette.

For a Client:

l Open the Client record to which you wish to attach the Alert note.

l When the Client screen is open, select Set Alert Message from the Client

Menu,

l A window named Alert note for this record will appear

l Add your note to the Window and click OK

l The note will then appear in the Command Palette.

Client Alerts will show up whether you open the client or any of the client’s patients. 

Patient Alerts only appear when you open the specific patient record.

How To Create a Memo
From a Patient record:
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l Open the Patient record you wish to attach the Memo to.

l When the Patient screen is opened, select Create a Memo from the Patient

menu. A window named Enter your memo below will appear.

l Add your memo to the window and click OK.

A memo window will come to the forefront of DVMAX the next time this record is opened.

From a Client
l Open the Client record you wish to attach the Memo to.

l When the Client screen is opened, select Create a Memo from the Client

menu.

l A window named Enter your memo below will appear.

l Add your memo to the Window and click OK.

A memo window will come to the forefront of DVMAX the next time this record is opened.

You are able to delay the time of a Memo. For instance, if a client drops off a cat for a

spay in the morning and ask you to remind them to buy a bag of food when they pick the cat up

that afternoon – Enter a Memo, but delay the time until 4pm (or whatever your pickup time

begins) – then you don’t have to see or possibly delete the Memo for the rest of the day!

Memos show up in a client or patient record regardless of whether it was originally added

to the client or patient record.

Clearing the Cache (For Advanced Users Only)
In order to optimize performance, DVMAX stores certain application elements fetched from the

server (such as the user interface) on your local hard disk. Over time, it is possible for this

cache to become outdated or corrupt. If you notice odd behavior on your DVMAX workstation

that does not occur on other workstations in your practice, you may need to clear the application

cache.

Clearing the Cache on Mac OS X
l In the Finder, navigate to /Library/Application Support/4D Folder

l Delete the 4D Folder

l Relaunch DVMAX

l If the message "Duplicating Resources Locally" appears, the process has been

done correctly.

DVMAX must now rebuild a few files so the login process may take 2-3 minutes.

Clearing the Cache on Windows
l Select Search form the Start menu

l Search for files and folder
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l Search for files and folders containing 4D

l Locate the folder named 4D

l Delete this folder

l Relaunch DVMAX
l If the message "Duplicating Resources Locally" appears, the process has been

done correctly.

DVMAX must now rebuild a few files so the login process may take 2-3 minutes.
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DVMAX Anywhere
The new DVMAX Anywhere is a flexible, responsive application that works where you do.

Whether you’re using a tablet, laptop or desktop device, Anywhere offers many of the powerful

features of your DVMAX client in a streamlined, web-based framework. With DVMAX Any-

where, you can work with patient or client records, complete scheduled To Do items, create

MREs, check the appointment Scheduler, review invoices, present consent forms for electronic

signature, view lab results and much more.

Using Anywhere on Desktop and Tablet
DVMAX Anywhere runs on tablet, laptop or desktop. There are a few differences between the

available features in Anywhere when running in your browser on a desktop machine and when

running from a tablet, but most of the functionality is the same.

Key differences include:

The desktop application has a sidebar menu that includes the additional options

of a To Do by Patient list view and an Appointments list view.

There are some additional filters for patient searches in desktop view.

The Labs tab from a Patient record offers a hierarchical view under desktop.

Because most of the general functionality in Anywhere is the same as in DVMAX, you should

already be familiar with the basics of working with patient records. For more details on working

with DVMAX functionality, like creating and editing MREs, adding MRE Findings, working

with lab requisitions, viewing lab results and more, refer to the specific chapters in the DVMAX

user guide.

Launching DVMAX Anywhere
You can use Anywhere from you tablet, laptop or desktop.  To launch Anywhere the first time:

From the Special menu of the main screen of your DVMAX client, select

DVMAX Anywhere.

From the DVMAX Anywhere dialog, choose whether to open Anywhere on

your current desktop machine or on a tablet. The URL for Anywhere will be

shown in the Enter URL on Tablet field. This URL can be used by desktop,

laptop or tablet.
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Open Anywhere on Desktop or Laptop
To open the desktop version of Anywhere:

From the Special menu of the main screen of your DVMAX client, select

DVMAX Anywhere.

Click Launch Anywhere on Computer or copy and paste the URL from the

Enter URL on Tablet field into your browser on your desktop.

Anywhere will open in your default browser.

Bookmark Anywhere in your browser for quick access in the future.

For iPad users: To be sure you can access all of the features of Anywhere on your iPad, you will

need to use Anywhere directly from your browser, not from a link saved on your home screen.

Safari does not support the ability to open multiple tabs for links placed on your home screen,

a feature important for viewing images, attachments or WP documents.

Open Anywhere on Tablet
To open DVMAX Anywhere on your tablet:

From the Special menu of the main screen of your DVMAX client, select

DVMAX Anywhere.

You will need to send a link via email to your tablet, then simply click the link in

the email to open Anywhere.

If email is enabled in DVMAX, you will see a Send URL Email button on the

dialog.

Type an email address that can be opened on your tablet in the Enter Email on

Tablet field, then click Send URL Email.
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If you do not have email enabled in DVMAX, copy and paste the URL from the

Enter URL on Tablet field into an email on your email client and send it to

your tablet.

Click the Anywhere URL link in the email you sent to your tablet. Anywhere

will automatically launch in the default tablet browser.

Bookmark Anywhere in your tablet’s browser for quick access.

For iPad users: To be sure you can access all of the features of Anywhere on your iPad, you will

need to use Anywhere directly from your browser, not from a link saved on your home screen.

Safari does not support the ability to open multiple tabs for links placed on your home screen,

a feature important for viewing images, attachments or WP documents.

Logging In to DVMAX Anywhere

DVMAX Anywhere requires users to log in. For security reasons, each user is strongly rec-

ommended to log in with their own unique username and password. When you are finished with

your session, you should log out.

To log in, type your username and password in the respective fields. Click or tap

Login.

To log out, click the Logout (“X”) icon.
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About the Anywhere Home Page
The Anywhere homepage title bar provides some at-a-glance information about the clinic, includ-

ing clinic name, number of pending To Dos on the Whiteboard for the current day, number of

appointments on the Scheduler for the current day, the current date and time.  Below the title

bar, there are 4 tabs. Two of the tabs are customizable URLs set by your clinic (see Customize

the Home Page), one tab lists Lab results, and one tab takes you to a web page that provides

general information and news about Anywhere.

The Labs tab provides a list of lab result records. The default number of days of results shown is

7. This can be adjusted under Advanced Settings. Double click or touch on a result to view

details.

The customizable, clinic-defined tabs ship with default URLs from DVMAX, but you can

change the URL to a link of your choice by clicking the Customize button. For example, you

could use the URL for one of the custom report in DVMAX, like the Visit Report or Appoint-

ments by Staff Report.

Customize the Anywhere Home Page
You can customize 2 of the 4 tabs on the Anywhere Home page using the Customize button.

To customize the tabs on the Home page:

From the Home page, select a tab. If there is a Customize button, you can cus-

tomize that tab. The Lab Results and News tabs are not customizable.

Click Customize.

In the Title field, type a short name for the tab.
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In the URL field, type the address to which you would like to direct this section

of the page.

Click OK to save.

Refresh the Anywhere Home Page Content
Information on Home screen automatically refreshes every 60 seconds when Automatically

Refresh is selected. You can choose to manually refresh the page using your browser’s reload

option. Automatically Refresh is located at the bottom of the Home page.

About the Anywhere Main Menu
The main menu for DVMAX Anywhere looks different depending on whether you are using

desktop or tablet mode.

Anywhere Main Menu from Desktop or Laptop
The DVMAX Anywhere desktop menu includes Appointments, Scheduler, Patients and To

Dos.

DVMAX Practice V8.6 - User Manual



- 51 -

You can view the menu as text and icons or as icons alone by clicking the hamburger icon at the

top left corner of the screen to hide/reveal text on the menu.

Menu items with multiple options, such as Patients or To Dos, can have the sub menu hidden by

clicking the white arrow to expand or collapse the view.

Anywhere Main Menu on Tablet
The menu bar when working with Anywhere on a tablet, like an iPad, consists of several icons

along the top part of the window, including Home, Scheduler, Whiteboard and Patients.
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Navigating the Anywhere Main Menu
To navigate DVMAX Anywhere from the Menu bar on tablet or desktop:

Select Home to return to the Home page.

Select the Scheduler icon to view the Appointment Scheduler.

Select the Whiteboard icon to view the Whiteboard and work with To Dos.

Select the Patients menu to search for and work with patient records.

Click the Logout (“x”) icon to log out of DVMAX Anywhere.

Click the Settings (Gear) icon to adjust label printer selection (for Prescription

label printing).

Settings (Gear Icon)
The Settings (Gear) menu lets you select your label printer for use by Prescription label label-

ing.

Click the Settings (Gear) icon to open the Settings panel.

From the Label Printer menu, select your label printer.

Close the Settings panel.

Note that DVMAX Client must be running and shared label printing must be enabled in

DVMAX in order for Anywhere to access shared Rx label printers.

Appointments Menu (Desktop Only)
The Appointments menu provides a list view of all appointments for a selected date and staff.

The default view is to show Appointments for the current date and for all staff.
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Viewing Appointments By Staff (Desktop Only)
The default Appointment list view is to show Appointments for the current date and for all staff.

Use the Display For menu to filter appointments by a specific staff.

Viewing a List of Appointments by Date (Desktop Only)
The default view is to show Appointments for the current date and for all staff. Use the When

filters to view appointments for a specified date or date range. 

Choose Today, Yesterday or Tomorrow from the drop down menu, or select a date from the

calendar field to see all appointments from the selected date forward (showing every appoint-

ment Since the selected date).
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For example, if you choose a date seven days in the past, you will see all appointments from that

date forward. This includes future appointments. You can sort appointments using the column

headings by clicking on the column heading (ascending or descending options).

Double click or tap an appointment to go to the patient record.

To see appointments on tablet, choose the Scheduler icon to go to the Scheduler

view.

Appointment Scheduler in Anywhere
The Scheduler in Anywhere shows the same type of grid as the Scheduler in DVMAX.

While Scheduler in Anywhere is view only, you can view appointment details, go to a patient

record and change patient appointment status from this Scheduler. You cannot create appoint-

ments in Anywhere. Appointments will show checked in status, and we strongly suggest people

take advantage of this valuable feature in DVMAX.
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To work with the Scheduler:

The Scheduler shows appointments for the current date by default. To adjust the

date for the Scheduler, use the Today, Yesterday or Tomorrow buttons or spec-

ify a date by picking a date from the calendar field.

Double click an appointment to view appointment details, patient and client infor-

mation, just like in the DVMAX main app.

You can set and change appointment status from the Status drop down menu on

the Appointment details dialog.

Click Save and Open Patient Record to open the patient record in Anywhere.

For more on working with Appointments, including setting patient appointment status, refer to

the Appointments chapter in the DVMAX user guide.

Appointment Scheduler Change Mode Option
You can display the scheduler as Appointment Time by Staff (default) or Staff by Appointment

Time. To change the view, click or tap the Change Mode button.

Appointment Scheduler Refresh
The Scheduler is automatically refreshed every minute. This is controlled by a setting in Any-

where. Click or tap the Refresh button to manually refresh the scheduler.
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Searching for Patient Records in Anywhere
You can use the Patients menu to search for and view records for patients who are Checked In,

Hospitalized, patients who were Recently Seen, patients with Recalls or search for records by

patient Name. Depending on the type of search, you may have options to further refine the

search by Staff or other variables.

Searching for Patients with Checked In Status
The Checked In option provides a list of all patients with an appointment status of “Checked In”

(see DVMAX manual for details on setting up and using this feature, available in the new sched-

uler since DVMAX v8).

Patients by Checked In Status Search - Desktop
Choose Checked In from the Patients menu to view a list of all patients currently checked in to

the clinic. From the list of patient records, double click or tap to pick a record. Select a name

from the Staff drop down menu at the bottom of the page to further narrow the list. The patient

list shows a number of details, including Patient ID, Patient Name and Client Name. If there are

no Checked In records, the list will be blank.

Patients By Checked In Status Search - Tablet
Select the Patients icon from the menu bar. A page opens with a blank patient record displayed.

This record is not editable. From the Type menu, select Checked In to search for patients

whose status is checked in.
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Use the Staff filter to further narrow the search.  From the list of names, select a record to view.

If desired, type a patient name (or partial name) in the Name field, then select a name from the

drop down list to open the patient record. If there are no Checked In records, the list will be

blank.

Searching for Patients with Status Hospitalized
The Hospitalized option provides a list of all patients that have the status “In Hospital”.

Patients By Hospitalized Status Search - Desktop
Choose Hospitalized from the Patients menu to view a list of all patients with the status “In

Hospital”. From the list of patient records, double click to pick a record. Select a name from the

Staff drop down menu at the bottom of the page to further narrow the list. The patient list shows

a number of details, including Patient ID, Patient Name and Client Name. If there are no match-

ing records, the list will be blank.
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Patients By Hospitalized Status Search - Tablet
Select the Patients icon from the menu bar. A page opens with a blank patient record displayed.

This record is not editable. From the Type menu, select Hospitalized to search for patients

whose status is “In Hospital”.

Use the Staff filter to further narrow the search. From the list of names, select a record to view.

If desired, type a patient name (or partial name) in the Name field, then select a name from the

drop down list to open the patient record. If there are no matching records, the list will be blank.

Searching for Patients By Recently Seen
The Recently Seen option provides a list of all patients that have been seen in a defined period.

The default period is Last 7 Days.

Patients By Recently Seen Search - Desktop
Choose Recently Seen from the Patients menu to see a list of all patients that have been seen in

a defined period. The default period is Last 7 Days. Select a name from the Staff drop down

menu at the bottom of the page to further narrow the list. The patient list shows a number of

details, including Patient ID, Patient Name and Client Name. Select a name from the list to open

the patient record. If there are no matching records, the list will be blank.
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You can pick the Recently Seen period from a list (7 Days, 30 Days, 60 Days, 90 Days). Once

you have selected a Recently Seen period, use the up/down filter beside the selection to

increase or decrease the number of days in the selected period.

Patients By Recently Seen Search - Tablet
Select the Patients icon from the menu bar. A page opens with a blank patient record displayed.

This record is not editable. From the Type menu, select Recently Seen to search for patients

who have been seen in the past 7 days. Use the Staff filter to further narrow the search.
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From the list of names, select a record to view. If desired, type a patient name (or partial name)

in the Name field, then select a name from the drop down list to open the patient record. If there

are no matching records, the list will be blank.

Searching for Patients with Recalls
The Recalls option provides a list of all patients that have recalls pending.

Patients with Recalls Search - Desktop
Choose Recalls from the Patients menu to see a list of all patients that have recalls pending.

Select a name from the Staff drop down menu at the bottom of the page to further narrow the

list. The patient list shows a number of details, including Patient ID, Patient Name and Client

Name. Select a name from the list to open the patient record. If there are no matching records,

the list will be blank.

Patients with Recalls Search - Tablet
Select the Patient icon from the menu bar. A page opens with a blank patient record displayed.

This record is not editable. From the Type menu, select Recalls to search for patients who have

recalls pending. Use the Staff filter to further narrow the search. From the list of names, select a

record to view. If desired, type a patient name (or partial name) in the Name field, then select a

name from the drop down list to open the patient record. If there are no matching records, the list

will be blank.

Searching for Patients By Name (All Patient Records)
The Name search lets you look up patient records by patient name or client name. On desktop,

you can also look up patient records by Staff or by client phone number.
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Patients By Name Search - Desktop
To search for patient records by name, click Name from the Patients menu. A list of all patients

is displayed. Patient names are sorted alphabetically by default.

To find a specific patient record:

From the Staff drop down, filter patients by staff.

From the Patient combo, select Patient Name (default), Client Name or Client

Phone Number. In the text field beside the combo, type a name or number in

the field. The list will be filtered by what you type.
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The patient list shows a number of details, including Patient ID, Patient Name

and Client Name. Select a name from the list to open the patient record.

Patients By Name Search - Tablet
To search for patient records by name, select the Patients icon from the menu bar. A page

opens with a blank patient record displayed. This record is not editable.

From the Type menu, select Name (default) to search all patient records by name. Type a

patient name (or partial name) or client name in the Name field, then select a name from the

drop down list to open the patient record.
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Working with Patient Records in Anywhere
DVMAX Anywhere lets you access many of the same powerful features of DVMAX in a

streamlined, web-based application that works on tablets, laptops and desktop. When working

with patient records, that means you can view and edit patient and client general information

create and edit MREs, view requisitions and lab results, view invoices, present documents for

electronic signature and more.

Open a Patient Record
To open a patient record:

From your desktop or laptop, find a record using the Patients menu options, then double click to

select a record from the list. From your tablet, use the Patients menu options to find a record,

type a name or partial name in the Name field. From the list generated, select the record you

wish to view. See Searching for Patient Records in Anywhere for more on finding a record.

Select an Invoice
When you open a patient record, if there is more than one open invoice for the associated client,

the Select an Invoice dialog displays before the patient record opens.

Select an existing invoice. Choose an invoice from the list and click or touch

Select.

-OR-

Choose New Invoice to begin a new invoice.

Once you select an invoice, the patient record will open.
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View the Select an Invoice Dialog
The Select an Invoice dialog displays when you open a patient record for which there is more

than one open, unfinished invoice. If you would like to view the dialog once you have opened a

patient record, you can click the invoice link on the top right corner of the patient record.

About the Patient Record
The patient record in Anywhere consists of a series of 8 tabs. Above the tabs in the top right

corner is the number of the current invoice and the client balance. In the top left corner of the

patient record, there is a Quick Glance patient ID area, including patient species identification

icon, patient name, species and breed, plus the client’s name and address.
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You navigate the patient record much the same way as in DVMAX client. Keep in mind that

from a tablet, you may not see the full screen and you may need to scroll up and down to see the

full panel in some cases. Alternatively, you may want to rotate the tablet between landscape and

portrait modes to maximize viewing area for certain screens.

Sharing Patient Information Via Email
DVMAX Anywhere lets you quickly email patient information using the Share button in the bot-

tom left corner of the patient record. To email a patient record link:

Click the Share icon, located in the bottom left corner of the patient record.

In the Email Address dialog, enter the email address of the recipient in the

Email field and click OK. An email with the link to the patient record will be

send to the email recipient.

Patient General Info Tab
The Patient General Information tab in Anywhere offers most of the same detail as what you

will find in DVMAX.

Patient Alerts are displayed in red font at the top of the Patient General Info

area, above the Patient ID field.
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Deceased Patients – The Deceased field is highlighted if the patient is

deceased.

Recalls and Reminders appear at the bottom of the Patient Info screen, just

like in DVMAX. You will also see these areas at the bottom of the Client Info

page and Notes page. You can sort the Reminders and Recalls areas by ascend-

ing or descending Date or Reminder/Recall name by clicking the header.

Referral Source - Click the box beside the Referral field to see a list of refer-

ral sources. Select from the list.

Closing a Patient Record (Desktop) – You need to close the patient record

before you can navigate away from an open record in desktop mode. To save

and close a record, click Save. To cancel, click Cancel. This is not necessary

when using Anywhere on tablet.

Client General Info Tab
Basic Client General Information is provided in Anywhere in a tab beside the Patient Gen-

eral Information. Client details include name, address, email, phone number and occupation.
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For more detailed information, including complete financial history, you will need to use

DVMAX client. Invoice history associated with the current patient is provided under the

Invoices tab.

A Client Alert, where applicable, displays at the top of the Client General Info area, above the

Client Title field.

Notes Tab
The Patient Notes area offers the same information as is present in DVMAX client, including

Major Problems, Comments and a weight graph/chart.
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History
Just like in DVMAX, Anywhere’s Patient History tab lets you view, edit and create Medical

Record Entries. A text view is available from the Text View tab.

Text View
To view MRE History text view, select the Text View tab under History.
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Click or touch to select an MRE in text view. This will open the associated full

MRE record. You can view or edit the MRE. Close the MRE to return to text

view.

You can use your browser’s Print function to print the text view.

View an MRE
From the History tab, tap or click to open the MRE you wish to view.

Add an MRE
The process of creating an MRE is the same as in DVMAX.

To create a new Medical Record Entry:

Click Add MRE.

The MRC dialog is divided into 2 parts, the MRC Categories list and the MRC

Code and Description. By default, Anywhere displays a list of the most com-

monly used MRCs. Select a different category to view other MRC lists, or

choose All for a list of all MRCs.

From the Select MRC dialog, choose the item you wish to add.

DVMAX Practice V8.6 - User Manual



- 70 -

Use the Filter field to search by Code or Description. Remember, Anywhere

will search for matching keywords or codes only in the MRC Category selected.

In the MRE dialog, enter Findings and Comments as applicable.

Choose Save Medical Record Entry to save the MRE or choose Cancel to exit

the MRE without saving.

If the MRC is linked to a Requisition Code, a requisition will be created. You

must be in DVMAX to submit requisitions, but you can create a requisition in

Anywhere.
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MRE Findings and Options
Adding MRE comments and findings is done in much the same way as in DVMAX.

Type comments in the Comments field.

If there are Findings associated with the MRC, a Finding Items list will display.

In the Finding Items list, click or tap the Finding item with which you want to

work.

If the Finding item has associated options, a Show Options button will be dis-

played. Click or tap Show Options to see Finding Options.

Select the appropriate Finding Options from the list, then click or tap Use

Selected Options. Choose All if you want to select all options. Choose None to

deselect any selected options.
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Create and Print Rx Labels in Anywhere
If you add an Rx MRE, the Prescription Label dialog will display. Once you complete the Rx

label details, choose OK and Print to print the prescription label, the same way you do in

DVMAX. Note that you must have selected a shared Prescription Label Printer (see the section

on Settings in this chapter) and DVMAX client must be running on at least one terminal in order

to print a prescription label.

Labs
The Labs tab displays a list of all Lab results for the patient.  Select a lab result record to view

more details. From the lab record, click Close Lab to close the record and return to the Labs

list.
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To Dos
The To Dos tab lets you view or complete pending To Do items for the current patient. As with

DVMAX, items are color-coded based on whether they are due now, past due or due on a future

date.

Note that To Do items are added in DVMAX by creating Treatment Plans. Refer to the asso-

ciated section in the DVMAX user guide for more on creating Treatment Plans.

View a To Do
To view a To Do item, click or tap a record. The To Do detail dialog opens.

Complete a To Do
To complete a pending To Do item from the patient record:
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Click the Do button beside the To Do you want to complete.

-OR-

Double click/tap to open the To Do record.

From the To Do item detail dialog, select the Completed checkbox, then click

OK on the To Do dialog.

A linked MRE dialog will open. Add MRE Findings and Comments as needed

and click Save to save the MRE.

Requisitions
The Requisitions tab lets you review the status of lab and Cubex requisitions, as well as view-

ing the associated lab result (where applicable). Select a Requisition record to view details.

The Requisition results page has 2 tabs, Requisition and Results.

To view the details of the Requisition, choose the Requisition tab (default

view). Requisition records are not editable in Anywhere. Choose Close Req-

uisition to close the record and return to the Requisitions list.

To view lab result details for completed requisitions, select the Results tab.

Choose Close Requisition to close the record and return to the Requisitions list.
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You can create requisitions in Anywhere (by adding an MRC with a linked Requisition Code),

but you must be in DVMAX to submit or edit requisitions. For more on working with Req-

uisitions, refer to the Requisitions and Results chapter in the DVMAX user guide.

Invoices
The Invoices tab lets you look for and review both Finished and Unfinished invoices. By default,

only Unfinished invoices are listed.

View an Invoice
From the Invoices tab, click or tap to select the invoice record you wish to view.
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Edit an Invoice
You cannot add or remove line items on an Invoice from the Invoices tab in Anywhere. How-

ever, you can make adjustments to the quantity on an invoice. Use the + or – boxes to adjust the

quantity up or down for any selected line item.

View Finished Invoices
By default, Anywhere only displays Unfinished invoices on the Invoice list. To view Finished

invoices as well, select the View Finished Invoices checkbox.

Attachments
You can view documents and images attached to the patient record from the Attachments tab,

just as you can in DVMAX. In addition, all consent forms or other documents that have been pre-

sented for electronic signature and submitted (see WP Documents) are added to the Attach-

ments tab of the patient record.

To view an attachment:

Click/tap the record you want to view.

The Attachment record opens.

Click View Attachment.
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For more on working with attachments, see the associated section in the Patients chapter of the

DVMAX user guide.

WP Documents
The WP (Documents) tab in Anywhere lets you view a patient’s Protected and Case doc-

uments. These documents cannot be edited in Anywhere, but you can convert Protected doc-

uments to Case documents, and all Case documents can be presented for electronic signature.

The WP tab is divided into 2 main sections, the document list (Case and Protected) areas and the

document preview area. The Case Documents list is on the top left part of the screen, while the

Protected Documents list is on the lower left part of the screen. When you click/tap to select a

document, the contents of the document are shown in the document preview area on the right

side of the screen.

Convert a Protected Document to a Case Document
To convert a Protected document to a Case document (so that it can be signed):

From the Protected Documents list, click or tap to select the document you want

to convert.

Click Convert Protected Document.
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The converted document will appear in the Case document list.

Sign a Consent Form or Document
Anywhere lets you present any Case document for electronic signature. Only Case documents

can be signed. If you do not see the document you need signed in the Case list, you may need to

convert a Protected document to a Case document first. See Convert a Protected Document to

a Case Document.

To present a document for signature:

From the list of Case documents, select the form or document you would like to

have signed.

When you select the document, the contents will display in the preview area on

the right side of the screen.

Click Sign Document. A signature capture area opens at the bottom of the pre-

view pane.

Sign the document using the mouse (desktop) or stylus (for touch devices, like a

tablet).

Click Submit Document to create a PDF of the document. The PDF opens in a

new window. You can choose to print the document or simply close the window.

The signed document will be added to the Attachments tab of the patient rec-

ord.
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For more on working with WP documents, see the Patients chapter andWord Processing chap-

ter of the DVMAX user guide.

To Dos Menu (Desktop Only)
The To Do menu option is only available when working in desktop mode. To work with To Dos

in tablet mode, use the Whiteboard feature.

Note that To Do items are added in DVMAX by creating Treatment Plans. Refer to the asso-

ciated section in the DVMAX user guide for more on creating Treatment Plans.

Search for To Do Items
To search To Do items from the To Do list:

Choose an option from the drop down menu – Today, Yesterday or Tomorrow

-OR-

Select a date from the calendar field to see all To Dos due from the selected

date forward. For example, if you choose a date seven days in the past, you will

see all To Dos from that date forward, including To Dos items due on a future

date.
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View a To Do
To view a To Do item:

Double click on the item you want to view on the list.

The To Do dialog opens.

You can complete the To Do, add notes or close the To Do record.

Complete a To Do
Completing a To Do item creates an MRE and removes the To Do from the list. To complete a

pending To Do item from the To Do list:

Click the Do button beside To Do item you want to complete.
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-OR-

Double click to open the To Do record.

From the To Do item detail dialog, select the Completed checkbox, then click

OK on the To Do dialog.

A linked MRE dialog will open. Add MRE Findings and Comments as needed

and click Save to save the MRE.

Once the MRE is saved, Anywhere will return you to the To Do list.

About the Whiteboard
The Whiteboard gives you a view of the To Do activities for a single day. The default view is

the current date. Green blocks on the Whiteboard blocks represent pending To Do items. Com-

pleted Whiteboard items are shown as grey blocks.
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You can complete to do items and/or go to patient records from the Whiteboard. Completing a

To Do item from the Whiteboard creates an MRE.

Choosing a Date From the Whiteboard
The Whiteboard shows To Dos for the current date by default. To adjust the date for the White-

board, select the Today, Yesterday or Tomorrow buttons, or specify a date by picking a date

from the calendar field.

View a Patient Record from the Whiteboard
From the Patient column on the Whiteboard, click on a patient name. This will open the patient

record.

You can work with the record as you like, including going to the To Do tab of the patient record

to view or complete any To Dos associated with the record. When you close the patient record,

you will be returned to the Whiteboard.

DVMAX Practice V8.6 - User Manual



- 83 -

View To Dos from the Whiteboard
All To Do items are represented by colored blocks on the Whiteboard grid. Some blocks rep-

resent single To Do items, while others represent multiple To Do items due at the same time. To

view a To Do item from the Whiteboard:

Double click or tap on the Whiteboard item you want to view.

If the block you select represents a single To Do item, a To Do item record will

open.

If the block you select represents multiple To Do items (“Multiples”), a list of

the To Dos will display. Select an individual item from the list to view the To

Do item details.

Multiple To Dos on the Whiteboard
If there are multiple To Do items associated with a block on the Whiteboard, the item will say

“Multiples” at the bottom of the block. Double click on the block to view all of the To Do items

associated with the block. Select a To Do from the list to view or complete.
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Completing To Dos from the Whiteboard
To complete a To Do item from the Whiteboard:

Double click or tap on the item you want to view or complete.

If the block you select represents a single To Do item, a To Do item record will

open. Select the Completed checkbox, then click OK on the To Do dialog.

If the block you select represents multiple To Do items (“Multiples”), a list of

the To Dos will display. You must complete each item on the list individually.

Double click the To Do item on the list that you want to complete. A To Do item

record opens. Select the Completed checkbox, then click OK on the To Do

dialog.

Once you choose Completed on the To Do record and click OK, linked MRE

dialog will open. Add MRE Findings and Comments as needed and click Save to

save the MRE.

Once the MRE is saved, Anywhere will return you to the Whiteboard.

Refresh the To Do List
The Whiteboard is automatically refreshed every minute. Click the Refresh button to manually

refresh the scheduler.
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Appointments
The Appointment Scheduler lets you create, view and modify appointments for new or existing

clients and patients. The flexible features include letting you “click and drag” to quickly create

appointments, switch between a variety of scheduler views, track appointments for one or more

staff and find the next scheduled appointment for a client or patient. You can access a client or

patient record associated with any appointment directly from the Appointment Scheduler, letting

you get important information easily and efficiently.

Beginning with DVMAX v7.6, the Appointment Scheduler is entirely web-based, adding further

flexibility. In addition to the functionality you’re used to, the new scheduler gives you features

like Month View, List View, patient/client Check In, expanded reporting and the ability to copy,

cut and paste appointments.

Appointment Scheduler Setup for MPA and Multi-Site Schedules
Beginning with DVMAX v8, MPA practices can now view and work with schedules for all of

the clinics associated with the multi-site practice. Each clinic in the multi-site practice will con-

figure their own scheduler using the details in the Setup sections of this chapter.

For more information on setup for MPA, contact DVMAX Technical Support.

Opening the Appointment Scheduler
DVMAX lets you open the Appointment Scheduler three different ways. When you launch the

Appointment scheduler, it will open as an embedded browser window within DVMAX (default

setting). To open the Appointment Scheduler:

l Click the Appointments icon on the Command Palette.

l From a client record, choose Set Appointment under the Clients drop-down

menu.
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l From a patient record, choose Set Appointment under the Patients drop-down

menu.

The Appointment Scheduler opens as an embedded browser within DVMAX.  While it is

not the recommended option, you can choose to open the Scheduler in an external web browser.

See Defining the Default Browser for Appointments.

Defining the Default Browser for Appointments
The Appointment Scheduler and Boarding Scheduler open in a browser within DVMAX. This is

the default setting and is recommended for optimal performance. You can choose to have

DVMAX open the scheduler in an external browser.

To change the default browser for Appointments and Boarding:

l From the File menu on the DVMAX main window, choose Preferences.

l From Preferences, choose the Assorted Prefs tab.

l In the Appointment Scheduler/Boarding area, use the Open With drop down

menu to select the browser you would like DVMAX to use to open Appoint-

ments and Boarding. This can be Internal (default), System Default (your work-

station’s default internet browser) or another browser you have available on your

terminal (such as Internet Explorer, Firefox or Chrome).

l The recommended (default) selection is Internal. This permits DVMAX to

open the Appointment Book within DVMAX and is the only setting that will ena-

ble the Scheduler to show in the Window List.

l You can have the scheduler open in an external web browser. DVMAX can use

your computer system’s default web browser as the default selection (select Sys-

tem Default), or you can designate another browser available on your terminal

to dedicate to the Scheduler.

For optimal performance, it is strongly recommended that you use the Internal setting for

the Scheduler. If you choose to display the Scheduler in an external browser, you should select a

browser for use by the scheduler that is different from your system default browser. For exam-

ple, if your workstation’s default internet browser is Safari, select a browser other than Safari in

which to open the Scheduler.
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Opening the Appointment Scheduler from the Window List
Once the Scheduler is open, you can access the Appointment Scheduler quickly by clicking

Scheduler/Boarding from the Window list. 

The Window List will show Scheduler/Boarding when the Appointment Scheduler is open,

the Boarding Scheduler is open, or both the Appointment and Boarding schedulers are open.

In order to see the Scheduler in the Window list, the scheduler must be open. Sched-

uler/Boarding will only appear in the Window List if you use the default selection, Internal,

under File ->Preferences.

For optimal Appointment Scheduler performance, it is strongly recommended that you use

the Internal setting (default setting) for the Scheduler. If you choose to display the Scheduler in

an external browser, you should select a browser for use by the scheduler that is different from

your system default browser. For example, if your workstation’s default internet browser is

Safari, select a browser other than Safari in which to open the Scheduler. Note that the Sched-

uler will not display in the Window list if you open the Scheduler in an external browser.
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Opening the Appointment Scheduler from the Command Palette
You can access the Appointment Scheduler quickly by selecting the Appts icon from the Com-

mand Palette.

If you cannot see the Command Palette, select Command Palette from the Window List.

Opening the Appointment Scheduler from Set Appointment
You can create an appointment directly from the client or patient record. If the Scheduler is not

already running, this process will launch the scheduler as well as allow you to create the client

or patient appointment.

To open the Appointment Scheduler from a client or patient record:

l From a patient record, click Set Appointment under the Patient menu.

l From a client record, click Set Appointment under the Client menu.

l The Scheduler will open.

l At the top of the Scheduler dialog, there will be text indicating that the next

scheduled appointment will be for the Client or Patient for which you wanted to

create the appointment.
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l When you click and drag to create the appointment, the applicable patient and/or

client information will be pre-filled in the Patient Info and/or Client Info sec-

tions of the appointment detail dialog.

Setting Up the Appointment Scheduler
Before you can use the Appointment Scheduler for the first time, you need to define Appoint-

ment Types (the kinds of appointments you want to be able to schedule) and Appointment Staff

(the staff and resources for which you will need to schedule appointments). You can also define
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Appointment Status records. You define all of these from Setup on the Appointment Sched-

uler.

As well, several other Appointment Settings must be set up, including Start of Day, End of

Day, Default Appointment Type, Initial Appointment Color, Default Appointment Color

andMinimum Appointment Time. These are also configured from Setup on the Scheduler.

Advanced Appointment Settings include areas for defining the templates for Day and Month

view appointment labels and ToolTips display.

General Appointment Settings
General Appointment Settings are details that apply to the regular structure of the Appoint-

ment Scheduler and must be defined before the Appointment Scheduler can be used. These are

typically defined during initial DVMAX installation, but can be modified at any time by users

with appropriate access permissions.

To adjust the Appointment Settings:

l From the Appointment Scheduler, click Setup.

l From the Appointment Settings tab, adjust the individual settings as needed.

l Click the “x” in the top right corner of the Setup window to save the Appoint-

ment settings.

You will need to close and reopen the Appointment Scheduler after making changes Setup.

Start of Day General Appointment Setting
Use the Start of Day and End of Day options to define the hour when you want the Scheduler to

begin and end. The time must be on the hour, it cannot be on the half or quarter hour. For a 24

hour clinic, set the Start of Day to 0 and End of Day to 24.

To set the Start of Day:

l From the Scheduler, click Setup.

l From Settings, select a start time from the Start of Day drop down list. This rep-

resents the start time for the first available appointment of the day on the

Appointment Scheduler.
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The Start of Day value must not be greater than the End of Day value. For a 24 hour

clinic, set the Start of Day to 0 and End of Day to 24.

End of Day General Appointment Setting
Use the Start of Day and End of Day options to define the hour when you want the Scheduler to

begin and end. The time must be on the hour, it cannot be on the half or quarter hour. For a 24

hour clinic, set the Start of Day to 0 and End of Day to 24.

To set the End of Day:

l From the Scheduler, click Setup.

l From Settings, select an end time from the End of Day drop down list. This rep-

resents the end time for the last available appointment of the day on the Appoint-

ment Scheduler.

The Start of Day value must not be greater than the End of Day value. For a 24 hour

clinic, set the Start of Day to 0 and End of Day to 24.
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Minimum Appointment Time General Setting
The value in the Min. Appt Time field defines the minimum length of an appointment you can

draw on the scheduler.

l In the Min. Appt Time field, type the default minimum length of a standard

appointment in minutes or use the up and down arrows to adjust the value.

The Min. Apt Timevalue cannot be less than 5 minutes.

It is strongly recommended that you consider this Min Appt Time value as you define the

duration for Appointment Types and the Time Increment setting.

The Min. Appt Time value cannot be less than 5 minutes.

Prior to DVMAX 7.6, the value in the Appointment Time field under System Constants

determined both the minimum length of an appointment and the appointment time increment on

the Day view of the Scheduler. This is no longer the case. Minimum Appointment length and

Scheduler Time Increment are now defined separately. See Time Increment General Appoint-

ment Setting for more information.

Time Increment General Appointment Setting
The value in the Time Increment field determines the intervals between rows on the Appoint-

ment Scheduler. For example, if you use an Increment of 20, then the Appointment grid will be

divided into 20-minute blocks. Of course, actual appointment length can be easily adjusted when

creating an appointment (see sections on creating and modifying appointments for more infor-

mation).

l In the Time Increment field, type the increment value for the Appointment grid

in minutes or use the up and down arrows to adjust the value.

List Number of Days General Appointment Setting
The value in the List No.of Days field determines how many days of appointments will be

shown from the List View tab on the Appointment Scheduler. The default value is 1 (the
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current day).

l In the List No. of Days field, type the number of days of appointments you

want displayed from List View on the Scheduler, or use the up and down

arrows to adjust the value.

User Initials Required Appointment Setting
l If you want user initials to be required when creating, editing or deleting appoint-

ments, select User Initials Required. When an appointment is created or when

changes are made to an existing appointment, the user will be prompted to enter

their staff code when they OK the changes.

The Staff Code can be viewed or edited from Section -> Patient Codes -> Staff. This is

NOT related to the Appointment Staff record (see Setting Up Appointment Staff for more on

Appointment Staff records).

Reset Duration to Appointment Type Default
Every Appointment Type has a default duration, defined when the Appointment Type record

is created. However, it is possible to create an appointment outside of the default length, either

by “click and drag” or by typing in a time value.

If Reset Duration to Appointment Type Default is selected, you are still able to create an

appointment longer than the default duration, but if you then change the appointment type on the

Appointment Detail dialog, the appointment length will be reset to the default value for that

appointment type.

Setting Up Appointment Types
You need to define the types of appointments that can be scheduled by the Appointment Sched-

uler. Some of these Appointment Types are defined for you during the DVMAX installation, but
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you may want to include additional types of appointments (see also Selecting Appointment Types

under Appointment Detail Window).

As well, you can create Appointment Types that can be used for staff scheduling entries under

Scheduler Staff Dr. Weekly and Recurring schedules (see those sections for more information).

Viewing All Appointment Types
To view the list of all Appointment Types:

l Select Setup from the Appointment Scheduler.

l Appointment Types are listed under the Appt. Types section of Setup.

l Click Add to create a new Appointment Type record. Refer to Adding a New

Appointment Type for more information.

l Double click the name of the Appointment Type record you want to edit from

the list.

The Appointment Types List
The Appointment Types list displays Name (Appointment Name), Color (the default color of

the appointment when used on the scheduler), Text Color (the color of the font or text on the

appointment label), Duration (default length of the appointment), Conflict Level (whether over-

booking is permitted) andMobile (whether this type of appointment can be displayed on mobile

devices). (See the sections titled Appointment Type Information and Editing Appointment Labels

for more on these headings).

Sorting the List of Appointment Type Records
The list of Appointment Type records can be sorted by any of the column headings on the list.

To sort the list of Appointment Type records:

l From the list area, click on the column heading by which you would like to sort

the list.

l From the drop down menu, choose to sort the list by the column heading in

Ascending or Descending order by selecting SortAscending or Sort Descend-

ing from the menu.
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Display or Hide Columns from the Appointment Type List
The Appointment Type record list displays with a set of default columns. It is possible to hide

the display of columns. To display or hide columns from the list:

l From the records list, move your pointer or “mouse over” the heading of a col-

umn on the list.

l Note that there is an arrow on the right side of the column heading. Click on the

arrow to display the drop down menu.

l Click Columns from the menu to see the list of columns that can be displayed or

hidden.

l Click on an item to select it and have it appear on the list. An item is selected if

there is a checkmark in the box beside the column name.

l To hide a column so that it does not appear on the list, click the associated

checkbox to remove the mark from the box.  An item is hidden or deselected if

there is no checkmark in the box beside the column name.

Adding New Appointment Types: An Overview
To create a new Appointment Type record:

l Click Add from below the Appointment Types list under Appointment Setup.

l Enter new appointment type information.

l Click Update to save the new Appointment Type record.

Appointment Type Information
The following information needs to be added for new appointment types. You can also use these

steps to edit existing records.

l Click Add to create a new Appointment Type record or double click an existing

record to edit the record.

l Type an Appointment Name. This is the appointment name as it will display on

the Appointment Scheduler, as well as the name that will show on the
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Appointment Type drop-down list in the Appointment detail window when cre-

ating or editing an appointment.

l Select a default color for this appointment type from the Color menu. This will

be the default color of all appointments scheduled with the selected appointment

type. Each appointment type can have its own appointment color. The default

color is gray. Appointment Type colors can determine appointment color

through the Initial and Default Color settings.

l Select black or white from the Text Color option list.

l Type a default appointment length, or duration, for this type of appointment in

the Dur. field. You can use the up and down arrows to adjust the duration as

well.

l Choose a Conflict Level. This determines the level of overbooking that is

allowed for the selected appointment type. There are three options for conflict

level: Allow over-booking, Allow but warn (provides a warning if you are over-

booking but will permit over-booking) and No over-booking.

l SelectMobile to permit this appointment type to be viewed from mobile devices

(such as when working with the DVMAX Anywhere mobile app).

l Click Update to add the new appointment type or save any changes you made to

the record.

Editing Appointment Types
To view or edit an existing Appointment Type record:

l Double click the record you want to edit from the Appointment Type list.
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l The record can be edited when you see the Update and Cancel buttons below

the record on the list. You can change Appointment Name, Color, Text Color,

Duration (Dur.), Conflict Level andMobile permission.  Follow the process

described in the section titled Appointment Type Information for details.

l Click Update to save the changes or Cancel to revert changes.

Deleting Appointment Type Records
All Appointment Type records can be deleted.

Exercise caution when deleting these records, as it may leave other records or aspects of

DVMAX incomplete.

To delete an Appointment Type record:

l From the Appointment Types list, click to select the record you wish to delete.

l Click Delete from below the Appointment Type list.

l In the Confirm window, click OK to continue or Cancel to abort the delete.

l The selected Appointment Type record will be deleted.

Default Appointment Type
From the Default Type drop down list, select the default appointment type to use when creating

a new appointment on the Scheduler. You can change the appointment type from the Appt. Type

menu on the appointment detail dialog, but DVMAX assigns a default value to all newly created

appointments.
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Initial and Default Appointment Color
The Initial Color and Default Color menus under Appointment Setup let you decide how the

color of an appointment should be determined. Depending on your clinic’s preference, the color

of a new appointment made on the Scheduler can be decided based on one of the following.

Once an initial appointment is made, the color of the appointment can change based on one of

those same options.

l Appointment Type

l Appointment Staff

l Appointment Status

Initial Color
The selection you make from the Initial Color drop down list tells DVMAX what the color of an

appointment should be when it is first created. There are 3 possible choices.

Appointment Type – Select Appointment Type if you want the color of a new appointment to

be determined by the color associated with the appointment type. The color of an appointment

type is selected under Appointment Setup -> Appt Types -> Color (see Appointment Type Infor-

mation).

Appointment Staff - Select Appointment Staff if you want the color of a new appointment to be

determined by the color associated with the appointment staff column in which the new appoint-

ment is created. The color assigned to an appointment staff is provided under Appointment Setup

-> Scheduler Staff -> Color (see Appointment Staff Information).

Appointment Status - Select Appointment Status if you want the color of a new appointment to

be determined by the color associated with the appointment status assigned when a new appoint-

ment is created. The color assigned to an appointment status is provided under Appointment

Setup -> Status Values -> Color (see Status Value Information).

Appointment color can always be changed manually when an appointment is created or any

time an appointment detail dialog is opened. From the Appointment Detail dialog, simply click

the Color drop down menu and select a new color. Manual color selection will override the Ini-

tial and Default Color settings.

Default Color
The selection you make from the Default Color drop down list tells DVMAX what color an

appointment should be when changes are made to the appointment. The color of an appointment

can change if the appointment type changes, if the staff associated with the appointment changes

or if the status of the appointment changes. The Initial Color setting determines the color of an

appointment when the appointment is first created. The Default Color dictates how the color of

an appointment should change after that.

Appointment Type – Select Appointment Type if you want the color of an appointment to

change if the appointment type is changed after the initial appointment has been created and

saved.
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Appointment Staff - Select Appointment Staff if you want the color of an appointment to

change if the appointment staff is changed after the initial appointment has been created and

saved.

Appointment Status - Select Appointment Status if you want the color of an appointment to

change if the appointment status is changed after the initial appointment has been created and

saved.

Appointment color can always be changed manually any time an appointment detail dialog

is opened. From the Appointment Detail dialog, simply click the Color drop down menu and

select a new color. Manual color selection will override the Initial or Default Color settings.

Setting Up Status Values
Status values allow users to define the state of an appointment. An appointment or clinic visit

begins with Check In and you can change the status of an appointment as the patient moves

from the waiting room, for example, to an exam room to a treatment room. A status value can be

selected from an appointment detail dialog or by right clicking on an appointment.

Viewing All Status Values
To view the list of all Status Types:

l Select Setup from the Appointment Scheduler.

l Status Values are listed under the Status Values section of Setup.

l Click Add to create a new Status record. Refer to Adding a New Status Value

for more information.

l Double click the name of the Status Value record you want to edit from the list.

The Status Values List
The Status Values list displays Name (Status Value Name), Color (Status Color) and Icon (vis-

ual marker placed on the appointment label).

Sorting the List of Status Types
The list of Status Values can be sorted by any of the column headings on the list.

To sort the list of Status Values:

l From the list area, click on the column heading by which you would like to sort

the list.

l From the drop down menu, choose to sort the list by the column heading in

Ascending or Descending order by selecting SortAscending or Sort Descend-

ing from the menu.
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Display or Hide Columns from the Status Values List
The Status Values list displays with a set of default columns. It is possible to hide the display of

columns. To display or hide columns from the list:

l From the records list, move your pointer or “mouse over” the heading of a col-

umn on the list.

l Note that there is an arrow on the right side of the column heading. Click on the

arrow to display the drop down menu.

l Click Columns from the menu to see the list of columns that can be displayed or

hidden.

l Click on an item to select it and have it appear on the list. An item is selected if

there is a checkmark in the box beside the column name.

l To hide a column so that it does not appear on the list, click the associated

checkbox to remove the mark from the box.  An item is hidden or deselected if

there is no checkmark in the box beside the column name.

Adding New Status Values: An Overview
To create a new status record:

l Click Add from below the Status Value list under Appointment Setup.

l Enter new appointment type information.

l Click Update to save the new Status Value record.

Status Value Information
The following information needs to be added for new status values. You can also use these steps

to edit existing records.

l Click Add to create a new Status Value or double click an existing record to

edit the record.
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l Type a Status Value Name. This is the Status Value label as it will display on

the Status drop-down menu when you right click (or Ctrl + click) and appoint-

ment and choose Set Status, as well as the name that will show on the Status

drop-down list in the Appointment detail window when creating or editing an

appointment.

l Choose a status Color. The default color is gray. Status colors can determine

appointment color through the Initial and Default Color settings.

l Choose a status value Icon. The icon will display on the appointment label on

the Scheduler, and provides a quick visual indication of the current status of the

visit. If you do not want an icon for the status record, chose None.

l Click Update to add the new status value or save any changes you made to the

record.

Editing Status Values
To view or edit an existing Status Value:

l Double click the record you want to edit from the Status Value list.

l The record can be edited when you see the Update and Cancel buttons below

the record on the list. You can change Name, Color and Icon. Follow the proc-

ess described in the section titled Status Value Information for details.

l Click Update to save the changes or Cancel to revert changes.

Deleting Status Values
All Status Value records can be deleted. Exercise caution when deleting these records, as it may

leave other records or aspects of DVMAX incomplete.

To delete a Status Value:

l From the Status Value list, click to select the record you wish to delete.

l Click Delete from below the Status Value list.

l In the Confirm window, click OK to continue or Cancel to abort the delete.

l The selected Status Value record will be deleted.
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Setting Up Appointment Staff
Before you can schedule any appointments, you need to specify at least one staff or resource for

which appointments can be made. While some Appointment Staff records are usually added dur-

ing initial DVMAX installation, you may need to edit existing records or add new appointment

staff. Only staff and resources listed in the Scheduler Staff area of Appointment Setup can be

used to schedule appointments.

You can also use the Scheduler Staff area to set up a Dr. Weekly and/or a Recurring schedule

that applies to a selected staff or resource.

View All Appointment Staff Records
To view the list of all Appointment Staff:

l Select Appointments from the Command Palette.

l From the Appointment Scheduler, select Setup.

l From the Setting tab, view a list of all Scheduler Staff on the right side of the

Setting dialog.

l To add a new Appointment Staff record, refer to Adding a New Staff Record.

DVMAX Practice V8.6 - User Manual



- 103 -

The Appointment Staff List
The Appointment Staff list displays Column Name, Full Name, whether the staff Takes appoint-

ments (See Appointment Staff Information for more detail). To set or edit the color associated

with the Appointment Staff record, double click a Staff record.

Sorting the Appointment Staff List
The list of Appointment Staff records can be sorted by any of the column headings on the list.

To sort the list of Appointment Staff records:

l From the list area, click on the column heading by which you would like to sort

the list.

l From the drop down menu, choose to sort the list by the column heading in

Ascending or Descending order by selecting SortAscending or Sort Descend-

ing from the menu.

Display or Hide Columns from the Appointment Staff List
The Appointment Staff list displays with a set of default columns. It is possible to hide the dis-

play of columns. To display or hide columns from the list:

l From the records list, move your pointer or “mouse over” the heading of a col-

umn on the list.

l Note that there is an arrow on the right side of the column heading. Click on the

arrow to display the drop down menu.

l Click Columns from the menu to see the list of columns that can be displayed or

hidden.

l Click on an item to select it and have it appear on the list. An item is selected if

there is a checkmark in the box beside the column name.

l To hide a column so that it does not appear on the list, click the associated

checkbox to remove the mark from the box.  An item is hidden or deselected if

there is no checkmark in the box beside the column name.
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Opening a Record from the Appointment Staff List
l Double click a selected entry to view or edit the record.

Adding New Appointment Staff
To create a new Appointment Staff record:

l Select Add from the Scheduler Staff list under Appointment Setup.

l A New Appt Staff tabbed window opens.

l Type new appointment staff information in the General Information area. Refer

to Appointment Staff Information for more details.

l Click OK to save the new Scheduler Staff record.

Add or Edit Appointment Staff Information
The following information needs to be added for new appointment staff. You can also use these

steps to edit existing records.

l In the Column Name field, type a short name. The Column Name will also

appear on the column header in the Appointment Scheduler.

l In the Full Name field, type the full name of the staff person or resource. This

is the staff or resource name as it will be listed in the With drop down list on

the Appointment creation dialog.

l Select Takes Appointments to indicate that the staff or resource takes appoint-

ments. Click again to clear. Only staff designated as taking appointments can be

displayed on the Appointment Scheduler.

l Type a value in the Sort Order field. This is a user-defined value used to deter-

mine the order in which the columns appear on the Appointment Scheduler. The

Appointment Staff name with the biggest Sort number is listed farthest right in

the column order on the Appointment Scheduler. The name with lowest Sort

number will appear first on the Appointment Scheduler. If 2 Sort values are the

same, the names will appear in alphabetical order from left to right.
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l From the Color drop down list, select a color to assign to the column header for

the appointment staff. This color will display in the column header for that staff

member on the Appointment Scheduler. Color will also be used to determine

appointment color through the Initial and Default Color settings where Appt

Staff is selected for one or both of those options.

Editing Appointment Staff
To view or edit an existing Scheduler Staff record:

l Double click the record you want to edit from the Scheduler Staff list. This

opens an Appt Staff record tabbed window.

l Follow the process described in the section titled Appointment Staff Information

to edit the basic Scheduler Staff information, or refer to the sections on Dr.

Weekly Schedule, Recurring Schedule and Regions for more on creating staff

schedules.

Deleting Appointment Staff Records
Appointment Staff records can be deleted, but they may have several associated records that

will be affected by the deletion. Alternatives include marking the staff as not taking appoint-

ments by clearing the Takes field, thereby marking them as inactive.

Deleting an Appointment Staff record will permanently remove any past or future appoint-

ments made under that name. Unless a selected record has never been used, deleting the record

is not recommended.

To delete an Appointment Staff record:

l From the Scheduler Staff list, click to select the record you want to delete.

l Click Delete from below the Scheduler Staff list.

l A Confirm window opens. Click OK again to continue with the deletion of the

record, or click Cancel to abort the deletion process.
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Creating a Dr. Weekly Schedule (Daily Schedule) for Appointment Staff
Formerly called the Daily Schedule, the Dr. Weekly Schedule looks like a smaller version of

the Appointment Scheduler. While the Appointment Scheduler manages Client and Patient

appointments, the Dr. Weekly Schedule is like a personal, 7-day calendar for a selected staff or

resource. The Dr. Weekly Schedule is for staff entries that are not regularly scheduled or are

not generally recurring items, such as a special blackout period. Items created in the Dr. Weekly

schedule only apply to the current week, Sunday-Saturday. Use the Recurring Schedule to set

up regularly occurring staff scheduling events and apply the recurring events to a longer period

of time.

To create or edit the Dr. Weekly Schedule:

l Click the Dr. Weekly Schedule tab from the Appt Staff window.

l Drag to create the Schedule event on the day associated with the pending event

(see Creating Appointments for more on how to create and work with appoint-

ments).

l From the Time drop down, select the start time if different than the value dis-

played.

l Type an appointment length in the For field (if different than the length dis-

played).

l Select an Appointment Type (scheduled event). Items in this drop-down menu

are defined under Appointment Types.

l If desired, select Staff Scheduling Entry for this appointment. A Staff Sched-

uling Entry is not editable from the main Appointment Scheduler. Use this option

to make the event non-editable from the main scheduler. You can edit the event

from the Dr. Weekly Schedule.
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l If desired, you can select Split into MultipleAppointments.  This is par-

ticularly useful if you want to create a large block of the same appointment type.

You can select several hours, for example, then divide that block into a series of

20 minute appointments of the same type.

l When you view the regular Appointment Scheduler, this event for that staff or

resource will already be blocked on the Scheduler.

l Repeat the process as needed to create the Dr. Weekly schedule.

l Click Save from the Dr. Weekly Schedule tab to save the schedule. The events

you created will be visible on the main scheduler for the current week. You may

need to refresh the Scheduler to see the new events.

For more information on working with appointments, see Creating and Editing Appointments

for the regular Appointment Scheduler.  The basic process of creating, moving and editing is

the same for the Dr. Weekly and Recurring as it is for the main Appointment Scheduler.

Deleting Dr. Weekly Schedule Appointments
You cannot delete Staff Scheduling Entries added via the Dr. Weekly Schedule from the main

Appointment Scheduler. You must be in the Appointment Staff Dr. Weekly Schedule.

To delete a Dr. Weekly Schedule Appointment block or blocks:

l From the Dr. Weekly Schedule tab of the Appointment Staff record, double

click the appointment you want to delete.

l Click Delete.

l Type staff initials if requested.

Clearing the Dr. Weekly Schedule
You can clear events added to the main Appointment Book from the Dr. Weekly Scheduler using

the Clear Staff Schedule button.

To clear the Dr. Weekly Schedule:

l From the Dr. Weekly Schedule tab, click Clear Staff Schedule.
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l Type a date range over which to apply the Clear. This will clear all Staff Sched-

uling Entries and all non-populated regular appointments from this appointment

staff person’s schedule for the specified date range. It will also clear those

appointments from the Dr. Weekly Schedule tab.

l Click OK to continue.

l The Dr. Weekly Schedule for the specified Appointment Staff will be cleared

for the selected date range. Those appointments will be removed from the Dr.

Weekly schedule and from the main Scheduler.

Clicking Clear Staff Schedule will only remove Staff Scheduling Entries and all non-pop-

ulated regular appointments from this appointment staff person’s schedule for the specified date

range. Appointments associated with a client or patient, or appointments to which notes have

been added and saved, will never be removed from the main scheduler unless you delete individ-

ual appointments manually.

Creating and Editing a Recurring Schedule for Appointment Staff
The process of creating and editing a Recurring Schedule is effectively the same as that for the

Dr. Weekly Schedule. The Recurring Schedule is designed to reflect recurring staff scheduling

entries over a generic one-week period and is useful for events that occur at regular time and

day intervals over a period of weeks or months, such as lunch breaks. The Recurring Schedule

may also be used to block off times when a particular staff or resource is never available for

appointments or is only available for certain types of appointments.

Remember that the Recurring Schedule must be applied to a specified date range before

you click OK or the schedule will not become effective. The Recurring Schedule will display on

the main Appointment Scheduler for the selected staff for the duration of the range.

To create or edit a Recurring Schedule:

l From Appointment Scheduler Setup, select the Scheduler Staff for whom you

wish to create a Recurring Schedule.

l Click the Recurring Schedule tab from the Appt Staff window.

l Drag to create the Schedule event on the day associated with the pending event

(see Creating Appointments for more on how to create and work with appoint-

ments).

l From the Time drop down, select the start time if different than the value dis-

played.

l Type an appointment length in the For field (if different than the length dis-

played).

l Select an Appointment Type (scheduled event). Items in this drop-down menu

are defined under Appointment Types.

l If desired, select Staff Scheduling Entry for this appointment. A Staff Sched-

uling Entry is not editable from the main Appointment Scheduler.

l If desired, you can select Split into MultipleAppointments.  This is par-

ticularly useful if you want to create a large block of the same appointment type.
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You can select several hours, for example, then divide that block into a series of

20 minute appointments of the same type.

l When you view the regular Appointment Scheduler, this event for that staff or

resource will already be blocked on the Scheduler. These blocks will be editable

from the main Scheduler, provided they are not Staff Scheduling Entries.

l Repeat the process as needed to create the recurring schedule.

l Click Apply to Date Range and type a Start Date and End Date for the range

over which you want to apply the schedule.

l A notification window will open in the top right corner of your browser window

indicating that events are being created.
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l When the appointments or events have been created on the main Schedule, you

will see a pop up alert that says “Apply Completed”. Click OK to close the

Alert.

l Click Save from the Recurring Schedule tab to close the Recurring Schedule tab

and return to the Setup dialog.

Remember you must click Apply to Date Range and specify a start date and end date or

the recurring schedule will not be applied.

For more information on working with appointments, see Creating and Editing Appointments

for the regular Appointment Scheduler. The basic process of creating, moving and editing is the

same for the Dr. Weekly and Recurring as it is for the Appointment Scheduler.

Deleting Recurring Schedule Events
You cannot delete some types of appointments made using the Recurring Schedule from the

main Appointment Scheduler. If you try, you will get a message reminding you that staff sched-

uling entries cannot be modified on the Appointment Scheduler.
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To remove or edit individual Staff Scheduling Entries that appear on the main Appointment

Scheduler, you must be in the Appointment Staff Dr. Weekly Schedule Setup tab. From the

Recurring Schedule you can only clear the full schedule over a specified date range (See Clear-

ing the Recurring Schedule) or modify the Recurring Schedule template.

Clearing the Recurring Schedule
You can clear events added to the main Appointment Book from the Dr. Weekly Scheduler and

Recurring Schedule using the Clear Staff Schedule button

To clear Recurring Schedule events from the main appointment Scheduler:

l From the Recurring Schedule tab, click Clear Staff Schedule.

l Type a date range over which to apply the Clear. This will clear all Staff Sched-

uling Entries and all non-populated regular appointments from the main appoint-

ment scheduler for this appointment staff for the specified date range.

l To edit or modify the Recurring schedule template itself, you must individually

edit or delete the events on the Recurring schedule.

l Click OK to continue.

Clicking Clear Staff Schedule from the Recurring Schedule tab will only remove Staff

Scheduling Entries and all non-populated regular appointments from the main Appointment

Scheduler for this staff person for the specified date range. Appointments associated with a

client or patient, or appointments to which notes have been added and saved, will never be

removed from the main scheduler unless you delete individual appointments manually on the

main scheduler.

When Clear is used on the Recurring Schedule, associated items in the specified date

range are cleared from the Main Scheduleronly. The events on the Recurring Schedule tab

itself remain in tact (are not cleared). To change the Recurring Schedule itself, you must man-

ually move, edit or delete individual items on the Recurring Schedule tab.

The existing items on the Main Scheduler are not removed when you apply a new Recurring

Schedule, so events may overlap. If you want to replace one recurring schedule with a new one,

clear the old one first by manually deleting the events you want to remove. Then, edit the Recur-

ring Schedule template as needed, and Apply.

Regions
The Regions scheduler lets you visually block out sections of the Day View schedule over a

generic one-week period. You can color segments or full columns if you choose. Regions are

background colored blocks on the scheduler, where the color corresponds with the default color

of the selected appointment type. There is no possible user interaction with these blocks. They

are simply a background visual cue for users as to the type of appointment that should be booked

in the blocked space. When you create and save a Regions schedule for a staff or resource, the

opaque “schedule” appears as a watermark or background on the staff column. Actual appoint-

ments can easily be created over these colored “regions”.

To create or edit Regions:
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l From Appointment Scheduler Setup, select the Scheduler Staff for whom you

wish to create a Region Schedule.

l Click the Regions tab from the Appt Staff window.

l Drag to create a region on a day or part of the day.

l From the Create Region pop up menu, select the type of appointment you want

to assign to this region. This will provide a visual cue for those using the sched-

uler that on that day of the week, over the specified time period, scheduling

appointments of the specified type is preferred. For example, if you create a

Patient Appointment region from 7AM-4PM on Monday, this will display on the

Main Scheduler as an opaque block on Mondays, reminding users that time is pri-

marily for scheduling patient appointments.

l Click Save to create the Regions schedule for the selected staff.

l The schedule is applied indefinitely. You can edit or remove the regions at any

time by going to the Regions tab and double clicking the block you want to edit

or remove. Choose a different appointment type from the drop down menu, or

click Delete to remove the region.

Advanced Appointment Settings
From the Advanced tab under Appointment Setup, you can define the appointment labels, also

called templates, for appointments in Day view and Month view, as well as defining what you

would like to display with the ToolTip bubble that appears when hovering over appointments.
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Day Template
The Day template defines the label that displays on appointments under Day view on the Sched-

uler.

It is strongly recommended that you seek the advice of DVMAX Technical Support before

making any changes to the templates.

Month Template
The Month template defines the label that displays on appointments under Month view on the

Scheduler.

The default template is {[Ext.Date.format(values.StartDate, "g:i a")]} {Appt_Type}, which will

display the date and time

It is strongly recommended that you seek the advice of DVMAX Technical Support before

making any changes to the templates.

ToolTip Template
The ToolTip appears when hovering over appointments. The content of the ToolTip is managed

from Advanced tab of Appointment Setup. You can turn the ToolTip behavior on or off from

Preferences on the Appointment Scheduler.

It is strongly recommended that you seek the advice of DVMAX Technical Support before

making any changes to the templates.

Defining Appointment Labels and ToolTip Templates
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It is strongly recommended that you seek the advice of DVMAX Technical Support before

making any changes to the templates.

There are default values provided for appointment labels (Day and Month) and the ToolTips bub-

ble when DVMAX is installed. However, the information displayed is very flexible and can be

configured to reflect values most useful to your clinic staff by using templates.

General Guidelines for Creating Templates

1. Most templates will start with <tpl> and end with </tpl> (These are called tags). Inside these tags

are placeholders for appointment information. Placeholders are inside brackets {…}.

The simplest template possible is something like this:

<tpl>{Client}</tpl>

This will simply display the client name.

2. Templates can also use conditionals (i.e. "if" and "else") like this:

<tpl if="Client">{Client}<tpl else>{Appt_Type}</tpl>

This says if there is a client name (if="Client") then put it on the label. If there is no client name

("else"), then just display the appointment type.

3. Templates can also include simple formatting codes, like bold, and italic:

<tpl if="Client"><b>{Client}</b><tpl else><i>{Appt_Type}</i></tpl>

This will display the client name in bold, or the appointment type in italic.

4. You can also include date and time in the template. When editing date and time values, only

edit the values between the quotation marks. Do not edit or manipulate brackets or commas or

other punctuation.

{[Ext.Date.format(values.StartDate, "g:i a")]}

This says the time will display using a 12-hour clock, including minutes and the time will be fol-

lowed by “am” or “pm” in lowercase.

If you see the following (as contained in the default ToolTip template):

{[Ext.Date.format(values.StartDate, "g:i a")]} - {[Ext.Date.format(values.EndDate, "g:i a")]}

This represents a range of time, such as with the beginning (StartDate) and end (EndDate) of an

appointment block.
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Review the values under Date and Time Formatting for Templates for date and time formatting

options.

Contact DVMAX Technical Support if you require assistance in setting up the Day, Month

and ToolTip templates to make sure everything works correctly.

Possible Fields for Inclusion in Templates
The following is a selection of possible fields to include in your templates. Keep in mind that

space is very limited, as this is just a small label for an appointment or tooltip.

{Appt_Type} – Use to include appointment type in the template.

{Appt_Status} – Use to include appointment status in the template.

{Breed} - Use to include breed in the template.

{Business_Phone} - Use to include business phone in the template.

{City} - Use to include city in the template.

{Client_Alert} - Use to include client alert in the template.

{Client} - Use to include Client name in the template.

{Deceased} - Use to include deceased status in the template.

{DOB} - Use to include patient DOB in the template.

{Email} - Use to include client email in the template.

{Gender} – Use to include patient gender in the template.

{Home_Phone} - Use to include home phone in the template.

{Patient_Alert} - Use to include patient alert in the template.

{Patient} - Use to include patient name in the template.

{Species} - Use to include species in the template.

{Staff_Name} – Use to include the appointment staff/resource name in the template.

{Visit_Reason} - Use to include visit reason in the template.

{Weight} - Use to include patient weight in the template.

{Zip} - Use to include client zip code in the template.

Date and Time Formatting for Templates
Below is a list of Date- and Time-related formatting values that may be used in templates. Included

for each value is the format, description and examples.

d  - Day of the month, 2 digits with leading zeros 01 to 31

D - A short textual representation of the day of the week Mon to Sun

j  - Day of the month without leading zeros 1 to 31
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l  - A full textual representation of the day of the week Sunday to Saturday

m  - Numeric representation of a month, with leading zeros 01 to 12

M  - A short textual representation of a month Jan to Dec

n  - Numeric representation of a month, without leading zeros 1 to 12

a  - Lowercase Ante meridiem and Post meridiem am or pm

A  - Uppercase Ante meridiem and Post meridiem AM or PM

g  - 12-hour format of an hour without leading zeros 1 to 12

G  - 24-hour format of an hour without leading zeros 0 to 23

h  - 12-hour format of an hour with leading zeros 01 to 12

H  - 24-hour format of an hour with leading zeros 00 to 23

i  - Minutes, with leading zeros 00 to 59

s  - Seconds, with leading zeros 00 to 59

When editing date and time values, only edit the values between the quotation marks. Do

not edit or manipulate brackets or commas or text other than that inside the commas. For exam-

ple, notice “g:i a” in the following template could be edited, but you should not change the rest:

{[Ext.Date.format(values.StartDate, "g:i a")]}

Contact DVMAX Technical Support if you require assistance in setting up the Day, Month

and ToolTip templates to make sure everything works correctly

The Appointment Scheduler: An Overview
Before you can take full advantage of the flexibility of the Appointment Scheduler, you should

become familiar with the many features it contains. The Appointment Scheduler is a tabbed win-

dow divided into 6 panels for working with appointments: Day View, Week View, Month

View, Combined View, List View and Heat Map. There is a toolbar at the top of the Sched-

uler that includes appointment Preferences and Print buttons, a ShowDate Picker button, a

Date field with calendar and a Find field. There is a Setup button at the top of the Scheduler.

l The Setup button is positioned in the upper left corner of the Appointment Book

and opens the Setup user interface for the Appointment Scheduler.

l The Print button is positioned in the lower left when working with a scheduler

open in an internal browser (default) or in the upper left corner of the Appoint-

DVMAX Practice V8.6 - User Manual



- 117 -

ment Book if the scheduler is open in an external browser. Clicking Print will

print appointments by selected staff for the date range specified.

l The Date Picker button opens a floating calendar that can be repositioned.

l The Date field is positioned in the upper right of the Appointment Book.

l The Find field is positioned in the upper right corner of the Appointment Book.

Confirm that typing in the Find field provides a list of client and patient appoint-

ments that begin with the text you type.

Scheduler Views
The Scheduler can be displayed in 6 different views. You can move between views by clicking

the tab of the view you wish to see. For information on working with those views, see the rel-

evant section in the Appointments chapter.

Day View – The Day view on the main appointment grid is the place where scheduled appoint-

ments for the selected day are displayed. Appointments appear as colored blocks on the grid.

What label appears on the appointment block is defined under Setup -> Advanced tab -> Day

Template. The ToolTip bubble that displays when you hover the pointer (mouse over) an appoint-

ment in Day View is defined under Setup ->Advanced -> ToolTip template. You can create and

edit appointments from Day View.
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Week View – The Week View displays appointments in a 1-week (Sunday – Saturday) cal-

endar. By default, the current week displays, showing appointments for the first staff or resource

on the Appointment Staff List (determined by Staff Sort Order in Setup). There is a Staff filter

on the Week View. You can create and edit appointments for any appointment staff in Week

View.

Month View – The Month View displays appointments in a one-month calendar. Appointments

on the Month View are filtered by Appointment Type and Appointment Staff. Filters are

located in the top right of the appointment grid area. The default view is to show the default

appointment type (as defined under Setup) for the first listed Appointment Staff person (deter-

mined by Staff Sort Order in Setup). You can create and edit appointments in Month View.

Combined View – The Combined View is a combination of Month and Day Views, with the top

portion of the window showing Month View and lower half of the window showing Day View.

You can create and edit appointments in Combined View.

List View – The List View displays a list of appointments by date. The default view is to show

appointments over a 1-day period. You cannot create appointments in List View, but you can

edit existing appointments.
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Heat Map – The Heat Map view displays a one month visual overview of productivity, showing

the percentage of time booked for client- and patient-associated appointments per day in relation

to the total hours for which the clinic is open daily (as defined under Scheduler Setup). You can-

not create or edit appointments from this view. Clicking on a day in the Heat Map takes you to

the selected date in Day View.

Optimizing Scheduler Performance
Scheduler speed and performance will be affected by the number of columns, resources (staff)

and/or events (appointments) displayed on any given Scheduler view. You may wish to consider

constraining the number of columns or resources (staff) in a particular view, such as showing

fewer columns in Day View or fewer staff in week view, to optimize performance. Since Sched-

uler configuration is a preference set per workstation, not everyone at every workstation may

need to see every column/event or resource all the time. As well, for optimum performance,

users should refer to DVMAX hardware and operating system requirements documents found at

http://dvmax.com/kb/questions/113/DVMAX+v7.6+System+Requirements. Contact DVMAX

Technical Support with any questions about system requirements or proper setup for the Appoint-

ment Scheduler.

DVMAX Practice V8.6 - User Manual

http://dvmax.com/kb/questions/113/DVMAX+v7.6+System+Requirements


- 120 -

Appointment Preferences
Appointment Preferences give you control over the column width and row height of the Sched-

uler grid ad well as whether the ToolTip feature is enabled. The ToolTip is an information bub-

ble that displays when you hover or “mouse over” an appointment. The content of the ToolTip

message is defined under Setup (see ToolTips under Advanced Appointment Settings).

Show ToolTips
Select Show ToolTips to display the ToolTip message when you hover over an appointment. To

adjust the content of the ToolTip message, see ToolTip Template under Advanced Appointment

Settings.

Automatic Column Widths
Select Automatic Column Widths to automatically resize column width based on the size of the

appointment scheduler window. DVMAX will update column width to fit the size of the sched-

uler window. When this option is not selected, you can manually adjust column width the Col-

umn Width slider, also located under Scheduler Preferences.

Adjust the Column Width on the Appointment Scheduler
Column width and row height of the Scheduler display are set from Preferences on the Appoint-

ment Scheduler. To adjust column width of the Appointment grid, move the horizontal Column

Width slider to the left for narrower columns or to the right for wider columns. To have column
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widths automatically adjust as you resize the appointment window, select Automatic Column

Widths, also located under Scheduler Preferences.

Adjust the Row Height on the Appointment Scheduler
Column width and row height of the Scheduler display are set from Preferences on the Appoint-

ment Scheduler. To adjust row height of the Appointment grid, move the vertical Row Height

slider up for taller rows or down for shorter rows.

Show Date Picker (Calendar)
The Date Picker is a floating calendar you can position anywhere inside the Appointment Sched-

uler window. Clicking the ShowDate Picker button opens the floating calendar. The Date

Picker remains open until it is closed.

Selecting a date from the Date Picker opens that date on the Day View, Combined View or List

View and changes the date in the Date field to the selected date. Use the Date Picker like the

Calendar to select a day or month in which to view or create appointments. See Using the Cal-

endar for more details on how to use the Date Picker.

The Date Picker will remain open until it is closed. Even if you close the browser, if you

did not close the Date Picker, it will be open in the same location you last placed it when you

reopen the browser. Please note that you cannot move the Date Picker off the screen.

Appointment Scheduler Date Field
The Date field is positioned in the upper right of the Appointment Book. Type a date in the field

or use the Calendar to select the day and month for which you wish to make or view
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appointments on the Appointment Book. See Using the Calendar for more details on how to use

the calendar in the Date field.

Using the Calendar
Use the Calendar from the Date Picker or Date field to select the day and month for which you

wish to make or view appointment on the Appointment Scheduler.

Any appointments showing will be for the day and month selected on the Calendar, and any new

appointments you create will be for that day. By default, the Appointment Scheduler shows the

current month and day. You can move forward or back in the Calendar by clicking the appro-

priate area.

Choosing a Day from the Calendar
The Calendar shows all of the days in the selected month. The default is to display the dates for

the current month. The current date is indicated on the Calendar with a red square around the

day.

To choose a day from the Calendar:

l Click on a date on the Calendar. The date you select will be highlighted.

l The Appointment view will adjust to reflect appointments, if any, for the chosen

day (in Day View) or month (in Month View).

l Click the Today button from the Calendar to quickly return to the current date.

Selecting a Month from the Calendar
By default, the Calendar shows the days for the current month in Month View. The top of the

Calendar shows the name of the month, with arrows on the left and right side of the name.

To make or view appointments in a different month:

l Click the left or right arrow on either side of the name of the month to scroll for-

ward or back in the Calendar year.

l As you click an arrow, the month displayed in Month View will change.

l Click the Today button from the Calendar to quickly return to the current date.
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Searching for Appointments Using the Find Option
You can use the Find option to find appointments from any view. The Find field is positioned in

the upper right corner of the Appointment Book. Typing in the Find field provides a list of client

and patient appointments that begin with the text you type.

To use Find to locate appointments:

l From the Find field, type the first few letters of the patient name or client name

(first or last name). If you prefer, type the full name to filter the list further. A

drop down list will display with all client and patient appointments matching

what you type. Click the drop down arrow to the right of the Find field to display

the list if it is not visible.

You must type at least 4 characters in the Find field before DVMAX will search. The

<Space> bar can be used as a “blank” character. For example, if you were looking for an

appointment for a client whose last name contains “Mill”, you could either type “Mill” or type

“Mil” and press the <Space> bar.

If you want to find an appointment for a client with the last name Miller and patient Andy,

you could type Miller then press the <Space> bar then type Andy. Alternatively, you could

simply type “Mi”, press the <Space> bar then type “An”. The list of appointments will be fil-

tered by all records containing Mi + An.

l Click to select an appointment from the drop down list. The Appointment Detail

dialog for the appointment will open. View or edit appointment details as needed

and close the appointment (using Save, Check-In or Cancel, as desired).

l If there are no appointments for a client or patient name matching the text you

type, the Find field will display the message, “No Appointments Found”.

l To find the next appointment for the same client or patient, right click (or Ctrl +

click) on the appointment block and select Find Next Appointment from the

pop up menu. You will move to the next scheduled appointment on the calendar

for that patient or client. Where there is no other appointment for the patient or

client, a dialog displays stating “Cannot locate future appointment for this

patient/client”.
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Reload the Scheduler (Internal Scheduler Only)
The Reload button at the bottom of the Scheduler is available when the scheduler is open in an

internal browser window. This allows you to reload or refresh the scheduler window if needed.

About Day View
Day View is the default view for the Appointment Scheduler. If you are looking at a different

Scheduler view, click the Day View tab to move to Day View. You can create, edit and delete

in Day View. See Working with Appointments in Day View, for more on the appointment options

in this view.

The Appointment grid is the place where scheduled appointments are displayed. In Day View,

appointments appear as colored blocks on the grid. The appointment color is configured under

Setup.

The content of the appointment label in Day View is defined under Setup. However, space is lim-

ited and if you choose to narrow the rows and/or columns (set under Preferences), this may also

restrict what you see on the appointment label.

By default, Day View opens to the current day with a column for all defined appointment staff

or resources. Between the scheduler toolbar at the top of the page (with the Setup, Preferences

and Print buttons) and the column headings/titles for the grid, the date being viewed is shown in

the format “Daily Schedule for <Day of Week, Month Day of month, Year>.

Rows and Columns on the Day View Grid
In Day View, rows represent time. The rows are divided into blocks based on the value spec-

ified under Setup -> Time Increment. The first row represents the time specified in the Start

of Day field under Setup. The last time on the grid is one time interval before the time specified

in the End of Day field under Setup.
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Columns represent appointment staff defined under Setup as taking appointments. If there are

more columns than can fit on the screen at one time, the scroll bar at the bottom of the Appoint-

ment grid will allow you to view the rest of the daily schedule. It is possible to quickly

show/hide columns by selecting or deselecting staff/resource from the Staff drop down menu.

Using the Appointment Staff Filter in Day View
In Day View, appointments are sorted into columns representing appointment staff or resources.

You can adjust what columns are displayed using the Staff drop down menu. The Staff drop

down menu is located in the top right of the appointment grid area. The default view is to show

appointments for all defined Appointment Staff. The order of the columns is determined by the

Staff Sort Order field in AppointmentSetup.

To show/hide columns for specified one or more staff or resource:

l From Day View, select the Staff drop down menu.

l All staff/resources are selected by default. A selected staff/resource is high-

lighted with a blue background.

l From the Staff drop down menu, click to deselect a staff or resource. Dese-

lected staff/resources appear with a white background. Click again to select.

l The Day View panel will need to be refreshed to see the changes. Click on

another tab, such as Week View or Month View, then return to Day View.

l Changes made to displayed columns in Day View will remain while the sched-

uler session is open. When you close the scheduler and reopen it, the Day View

will return to default display and all staff/resource columns will be present.
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Display or Hide Appointment Staff Columns in Day View
By default, all appointment staff or resources designated as taking appointments (under Sched-

uler Setup) are displayed in Day View. To display or hide columns from the list:

l From the Staff drop down list on the right side of the Day View window, click to

select the staff you want to display.

l Click again to deselect. You may need to reload the screen to see the changes.

Moving Within the Appointment Grid in Day View
l To move up and down within the grid in Day View, use the scroll bar on the

right side of the grid, or use the scroll wheel on your mouse (if applicable).

l To navigate left and right, use the scroll bar at the bottom of the grid, or use the

left and right arrow keys. The scroll bar on the bottom will only be enabled if

there are columns that do not fit on the screen with the view and settings you

have selected.

Adjusting the Appointment Scheduler Column Width
See Automatic Column Width, Adjusting Row Height and Adjusting Column Width under Appoint-

ment Preferences.

Scrolling Left and Right in the Appointment Scheduler
If there are more columns than can fit on the screen at one time, the scroll bar at the bottom of

the Appointment grid will allow you to view the rest of the daily or weekly schedule.

If you find the Scheduler has performance problems while scrolling using Firefox as your

browser (if scrolling is very slow), try turning off Use Smooth Scrolling from Preferences ->

Advanced tab.

Appointment Labels in Day View
Appointment labels are highly customizable and are configured under Setup. See Advanced

Appointment Settings for configuring appointment label templates for Day View and Month

View.

The ToolTip Display in Day View
When moving the pointer around on the grid in Day View, the pointer is a clock showing poten-

tial appointment start times that correspond to the Time Increment value defined under Setup.

For example, if the Time Increment is 20 minutes, there will be 3 possible appointment times in

a 1 hour block – at :00, :20, and :40 on the hour.

A ToolTip information bubble will display when hovering over an appointment block. The con-

tents of the ToolTip match what is defined under Setup -> Advanced tab -> ToolTip Template.

About Week View
Week View is the second tab or panel on the Appointment Scheduler. Click the Week View tab

to open this view. The Week View grid displays appointments by staff over a 1-week (Sunday –
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Saturday) calendar. By default, the current week displays, showing appointments for the first

staff or resource on the Appointment Staff List (determined by Staff Sort Order in Setup). If

there are no appointments for a given week for a selected staff person, the Week View calendar

will be empty. Use the Staff drop down menu to select the scheduler for one or more staff.

While it is possible to select multiple staff in Week View, be aware that speed and per-

formance of the Scheduler will be affected by the number of events displayed.

Appointment Labels in Week View
The content of the appointment label in Week View is the same as under Day View and is

defined under Setup. However, space is limited and if you choose to view appointments for mul-

tiple staff simultaneously, this will restrict what you see on the appointment label.

Using the Appointment Staff Filter in Week View
Appointments in Week View are filtered by Appointment Staff. The Staff drop down menu is

located in the top right of the appointment grid area. The default view is to show appointments

for the first resource in the Appointment Staff list, as determined by Staff Sort Order in Setup.

To see appointments for a specific staff or resource:

l From Week View, select the Staff drop down menu.

l From the Staff drop down menu, select the staff or resource for whom to display

appointments. You can select more than one staff or resource, but this will

affect the ability to display appointment labels.

About Month View
Month View is the third tab or panel on the Appointment Scheduler. Click the Month View tab

to open this view. The Month View grid displays appointments by appointment type and
appointment staff for a single calendar month. Appointments appear in a list format on each
day on the grid. If there are no appointments for a given day for the selected staff person, the

date on the calendar will be blank.
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Appointments inMonth View are displayed by Appointment Type and Staff or Resource.

You cannot display all appointments for all staff/resources on Month View. You may only view

one staff or resource’s Monthly schedule at a time. To view all appointments for all staff over a

date range, use List View.

If the number of appointments for a day exceeds what will fit on a day block on the grid, there

will be text at the bottom of the day block indicating the number of additional appointments not

displayed. You can click the “+ more…” message to display a full list of the specified appoint-

ment type for that day for the staff member.

By default, Month View opens to the current month. Between the scheduler toolbar at the top of

the page (with the Setup, Preferences and Print buttons) and the calendar grid, the date being

viewed is shown in the format “Monthly Schedule for <Month,Year> - Appointment Staff -

Appointment Type”.

Appointment Labels in Month View
The content of the appointment label in Month View is defined under Setup. See Advanced

Appointment Settings for configuring appointment label templates for Month View. When you

hover over an appointment, a ToolTip bubble will display. Content of the ToolTip is also con-

figured under Advanced Appointment Settings.

Using the Appointment Type Filter in Month View
Appointments inMonth View are filtered by Appointment Type and Staff. Filters are located

in the top right of the appointment grid area. The default view selects the default appointment

type (as defined under Setup) for the first listed Staff person (determined by Staff Sort Order in

Setup).

To filter appointments for the selected staff by appointment type:

l From Month View, select the Appt Type drop down menu.

l From the Appt Type drop down menu, select the type of appointment to display

on the calendar. You can select an individual appointment type, or select

AnyAppointment Type to display all appointments within the month for the

selected staff or resource.

l From the Staff drop down menu, select the staff or resource for whom to display

appointments. You can only display the monthly schedule for one staff or

resource at a time. To view appointments for all staff or resources over a time

period, use List View.

l Appointments will be displayed in a list format on each day of the grid. If the

number of appointments for a day exceeds what will fit on a day block on the

grid, there will be text at the bottom of the day block indicating the number of

additional appointments not displayed. You can click the “+ more…” message

to display a full list of the specified appointment type for that day for the staff

member.
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l If a date on the calendar is blank, there are no appointments of the selected type

for the chosen staff or resource.

Using the Appointment Staff Filter in Month View
Appointments in Month View are filtered by Appointment Type and Appointment Staff. Filters

are located in the top right of the appointment grid area. The default view is to show default

appointment type (as defined under Setup) for the first listed Staff person (determined by Staff

Sort Order in Setup).

To see appointments for a specific staff or resource:

l From Month View, select the Staff drop down menu.

l From the Staff drop down menu, select the staff or resource for whom to display

appointments. You can only display one staff or resource at a time.

l From the Appt Type drop down menu, select the type of appointment to display

on the calendar. You can select an individual appointment type, or select

AnyAppointment Type to display all appointments within the month for the

selected staff or resource.
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l Appointments will be displayed in a list format on each day of the grid. If the

number of appointments for a day exceeds what will fit on a day block on the

grid, there will be text at the bottom of the day block indicating the number of

additional appointments not displayed. You can click the “+ more…” message

to display a full list of the specified appointment type for that day for the staff

member.

l If a date on the calendar is blank, there are no appointments of the selected type

for the chosen staff or resource.

About Combined View
The Combined View on the Scheduler displays Monthly Schedule in the top part of the panel and

Daily Schedule in the bottom part of the panel. The specifications for Month View and Day

View apply to this view. Refer to those sections for more information on how to work with Com-

bined View.

Between the toolbar (with the Setup, Preferences and Print buttons) and the filters for the

Monthly Schedule part of the panel, the month being viewed is shown in the date format

“Monthly Schedule for <Month, Year> - Appointment Staff - Appointment Type”. Changing the

month in the Date field changes the month displayed.

Between the bottom of the Monthly Schedule portion of the Combined View and the column

headings/titles for the Daily Schedule grid, the date being viewed is shown in the format “Daily
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Schedule for <Day of Week, Month Day of month, Year> - All Staff – Appointment Type.

Changing the day being viewed changes the date displayed in the Daily Schedule section, but the

Monthly Schedule area will only change if you change the month from the Date or Date Picker.

About List View
The List View on the Appointment Scheduler displays a list of appointments over a specified

number of days. The default view is to show a list of all appointments for the current date. The

column options are Date, Time, Duration, Appointment Type, Appointment Staff or Resource,

Appointment Status, Checked In Reason, Client Name, Patient Name, Address, City, Email,

Phone1, Phone 2, Comments.

Text at the bottom right of the list indicates the number of records displayed in the format “Dis-

playing 1-X of X”. You can move though pages in List View using the directional arrows at the

bottom left of the panel.

You can use Quick Print in List View to print a copy of the list as it appears on the screen. If

you sort the list, Quick Print will provide a printed copy of the list as sorted.

You cannot add new appointments from List View. You can edit or delete existing appoint-

ments; open client or patient records or change the check-in or status value of an appointment

from List View.
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The Quick Print button is not available from List View when using the embedded (Internal)

option for the Scheduler. You would have to have the Scheduler open in an external browser to

use Quick Print,

Number of Days in List View
By default, List View shows a list of all appointments for the current date. To change the

number of days of appointments displayed:

l From List View, type a value in days in the No. Days field, located at the top of

the List View panel.

l The default display moves from the current day forward, so if you type 3 in the

No. Days field, you will see appointments for the current day plus the following

2 days.

l If you want to look back a few days, you will need to change the date in the

Date field to an appropriate start date in the past, then set the No. Days from

that point forward to build your list.

Sorting the Appointment List in List View
The list of appointments can be sorted by any of the column headings under List View.

To sort the list of appointments:

l From the list, click on the column heading by which you would like to sort the

list.

l From the drop down menu, choose to sort the list by the column heading in

Ascending or Descending order by selecting SortAscending or Sort Descend-

ing from the menu.

Display or Hide Columns in List View
The appointments list displays with a set of default columns. It is possible to hide the display of

columns. To display or hide columns from the list:

l From the records list, move your pointer or “mouse over” the heading of a col-

umn on the list.
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l Note that there is an arrow on the right side of the column heading. Click on the

arrow to display the drop down menu.

l Click Columns from the menu to see the list of columns that can be displayed or

hidden.

l Click on an item to select it and have it appear on the list. An item is selected if

there is a checkmark in the box beside the column name.

l To hide a column so that it does not appear on the list, click the associated

checkbox to remove the mark from the box.  An item is hidden or deselected if

there is no checkmark in the box beside the column name.

About Heat Map View
The Heat Map displays a one month calendar, defaulting to the current month, showing the

approximate percentage of time booked for client- and patient-associated appointments per day

in relation to the total hours for which the clinic is open daily (as defined under Scheduler

Setup).

The Heat Map uses level of cell opacity (the boldness of the color of a day on the grid) to vis-

ually indicate how busy the clinic is overall. The darker or less opaque the color on a day, the

greater the number of appointments booked for that day. So, if a day on the Heat Map is a solid

red, the day is booked close to capacity, while a very opaque or pale red indicates significant

availability on the day. Clicking on a day on the Heat Map opens the Day View for that day.
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There is a vertical bar representing how busy each staff or resource is on each day, much like a

bar graph. The height of the bar indicates how busy the staff or resource is for the day. The

taller the bar, the busier the resource.

You cannot work with appointments from Heat Map view. The Heat Map is only intended

to provide a visual indication of clinic productivity over a selected month.

The Heat Map is intended as a quick, visual reference and does not represent an exact ratio

of booking:capacity. Appointments not linked to a client or patient are not included in the Map.

Multi-Site Scheduler and MPA
Among many other advantages, DVMAX v8 permits MPA users to access Schedulers for all of

the clinics associated with their multi-site practice. That means if you have a multi-site practice,

you can schedule appointments at your local site as well as any of your associated remote clin-

ics. In fact, DVMAX v8 lets you access the appointment book for any of your clinics. If you use

the multi-site scheduling feature (only available with MPA), each remote clinic scheduler will

have the site name/clinic at the top, identifying the location associated with the schedule. The

other functions and features of the scheduler remain identical.

Working with Appointments in Day View
Day View is the default view you will see when you open the Appointment Book. You can

create, edit and delete appointments in Day View, Week View, Month View or Combined

View. By using the Date Picker you can quickly and easily move and copy appointments as

well.

From Day View, right clicking on an appointment brings up a short pop up menu, sometimes

called a contextual menu, with the following options: Cut Appointment, Copy Appointment,

Find Next Appointment, Go to Record, Double Book, Check-In and Set Status. When you

use Cut or Copy, you will enable the Paste Appointment option, letting you move an appoint-

ment or duplicate an appointment, respectively.
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Using the Contextual (Right Click) Menu: A Summary
Cut Appointment works in combination with Paste Appointment to allow you to quickly move

an appointment anywhere using the same cut and paste method familiar to many applications.

Clicking Cut Appointment removes the appointment. Find the date where you wish to move the

appointment, right click (or Ctrl + click) and select Paste Appointment.

Copy Appointment allows you to create a copy or duplicate of an existing appointment and

place it in another location. Right click (or Ctrl + click) on an existing appointment, click Copy

Appointment and then select Paste Appointment.

Double Book lets you quickly create a new appointment beside an existing appointment. Right

click (or Ctrl + click) on a selected appointment and choose Double Book. An appointment is

created beside the existing appointment. The appointment is the same type and length as the orig-

inal appointment, but there is no associated client or patient.

Find Next Appointment locates the next scheduled appointment for the patient or client. If

there is no future appointment, a dialog displays indicating this.

The Go To Record option in the pop up menu opens the associated Client record (if the appoint-

ment is a Client only appointment) or Patient record (for Patient appointments).

Selecting a Check-In lets you mark an appointment as “checked in”. This marks the start of a

patient or client visit. You must choose a reason for the visit from a predefined list of options.

The status of the appointment will change to Checked In and this will be noted by a check mark

in the top right corner of the appointment, depending on how you have configured the Check In

Status Value. Visit Reasons are defined under System Constants -> Client and Patient Settings.

Selecting Set Status will bring up a Status drop-down menu that will allow you to express the

current status of the appointment, along with a visual marker on the appointment to allow for a

quick, at-a-glance view of where a patient or client is in the appointment process. Status values

are defined under Appointment Setup. These values also permit you to track the amount of time

a patient spends at each stage of their visit.

Moving an Appointment
Once an appointment has been created, it can be easily moved to a new date using the Cut

Appointment and Paste Appointment options, or by dragging and dropping the appointment to a

new spot on the Day View grid. Cut Appointment is only available in Day View and from the

Daily Schedule section of Combined View.
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Using Drag and Drop to Move an Appointment
If you want to move a previously scheduled appointment to another time but the same day within

Day View, you can easily Drag and Drop the appointment to its new time. To drag and drop an

appointment in Day View:

l Click on the appointment you wish to move. The mouse cursor (pointer) will

change to a “hand” pointer and “grab” the appointment.

l Drag the appointment to a new time on the grid and drop the appointment.

l If you move the appointment to a different staff or resource, you will be asked to

confirm the move. Click Yes to proceed or No to cancel. If you click No, the

appointment will not be moved.

l If staff initials are required, enter your staff code in the Staff Code pop up.

Dragging and Dropping Beyond the Displayed Columns or Rows
You can use the Drag and Drop method as long as you are moving an appointment to a different

time within the current day, even if all columns or rows are not showing on the screen.

l Click and drag in the same manner as above, but drag just past the outside bound-

aries of the grid to “force” the browser to scroll up/down or left/right (with the

same effect as though you had used the scroll bar).

l When you click and drag, you cannot use the scroll bar, since the mouse is

needed for this function, and it is already in use.

l You may find using Cut Appointment and Paste Appointment a more con-

venient way to reschedule an appointment if you need to move it outside of the

current window. You will need to use Cut/Paste to move the appointment to a

new date.

Using Cut Appointment
The Drag and Drop method is one way to move an appointment, but it only works to move an

appointment within the same day. You must use Cut and Paste to move an appointment to a dif-

ferent date. Cut and Paste work much the same way as standard cut and paste options found in

many other applications. Cut Appointment is only available from Day View, Week View and

the Daily Schedule section of Combined View.

To move an appointment using Cut and Paste:

l From the Appointment Scheduler in Day View, right click (or Ctrl + click) on

the appointment you wish to move.

l From the pop up menu, select Cut Appointment. The appointment will be “cut”

from the Appointment window.
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l Find the new date and time where you would like to move the appointment, by

selecting a date with the Date Picker or using the Date field (see The Appoint-

ment Calendar section).

l Right click (or Ctrl + click) on the day and time where you would like to move

the appointment and select Paste Appointment from the pop up.

l If you move the appointment to a different staff or resource, you will be asked to

confirm the move. Click Yes to proceed or No to cancel. If you click No, the

appointment will not be moved.

If you exit DVMAX without pasting the cut appointment, the appointment will be deleted It

will be listed in the Deleted Appointment Report.
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Using Paste Appointment
When you use Cut Appointment or Copy Appointment, the Paste Appointment option will be

available by right clicking on a time on the appointment scheduler in Day View, Week View or

the Daily Schedule area of Combined View. See Using Cut Appointment or Using Copy Appoint-

ment for more information.

Moving an Appointment to a Different Staff Person or Resource
If you move an appointment from one staff person or resource to another (by dragging or through

the Cut and Paste options), you will be prompted to confirm that you want to perform that action.

Click Yes to continue, or No to return to the Scheduler. If you click No, the appointment will not

be moved.

Using Copy Appointment
You can create a duplicate of an existing appointment - including Client and Patient information,

appointment type and appointment length - using Copy Appointment and Paste Appointment.

Copy and Paste works much the same way as standard copy and paste options found in many

other applications. Copy Appointment is only available from Day View, Week View and the

Daily Schedule section of Combined View.

To create a duplicate appointment using Copy Appointment:

l From the Appointment Scheduler Day View orWeek View, right click (or Ctrl

+ click) on the appointment you wish to copy.

l From the pop up menu, select Copy Appointment.
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l Find the date and time where you would like to place a copy of the appointment,

by selecting a date with the Date Picker or using the Date field (see The Appoint-

ment Calendar section).

l Right click (or Ctrl + click) on the day and time where you would like to copy

the appointment.

l Select Paste Appointment from the pop up.

l If you copy the appointment to a different staff or resource than the original

appointment, you will not be asked to confirm the change, but the appointment

staff will be updated on the record to reflect the staff under the column in which

the appointment is placed. This is an exact copy of the original appointment, and

so maintains the appointment color and type of the original appointment.

l You can proceed to another date to create yet another copy of the appointment,

right clicking again and selecting Paste. In this way, you can quickly create as

many appointments for the same patient as needed.

Using Paste Appointment
When you use Cut Appointment or Copy Appointment, the Paste Appointment option will be

available by right clicking on a time on the appointment scheduler in Day View, Week View or

the Daily Schedule area of Combined View. See Using Cut Appointment or Using Copy Appoint-

ment for more information.

Using Find Next Appointment
The Find Next Appointment option locates the next appointment scheduled for a selected

Client or Patient, if another appointment exists. Find Next Appointment is only available from

Day View, Week View and the Daily Schedule section of Combined View.

To find the next appointment for a client or patient:

l From the Appointment Scheduler in Day View, right click (or Ctrl + click) on an

appointment.

l From the pop up menu, select Find Next Appointment.

l You will be moved within the Appointment Scheduler to the next scheduled

appointment for that Client of Patient.

l You can repeat this until no future appointment can be found.
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l When there is no future appointment found, DVMAX will show you a message

to that effect.

You can use the Find field in the top right corner of the Scheduler to display a list of all

upcoming appointments for a client or patient. Simply type a full or partial name in the field to

create a list. Click the drop down arrow if you do not see the list right away. See Searching for

Appointments Using the Find Option for details on how to work with this functionality.

Using Go To Record: View a Client or Patient Record from the Scheduler
Once an appointment has been created, the Go to Record option will let you retrieve the asso-

ciated file directly from the Appointment Scheduler. This makes it easy to open the file when the

Client or Patient arrives for their scheduled appointment. Go To Record is only available from

Day View, Week View and the Daily Schedule section of Combined View and List View. You

may also open the client or patient record by selecting Save and Go to Record from an open

appointment record.

To open or view an associated Client or Patient file from the Appointment Scheduler:

l From the Appointment Scheduler in Day View or Week View, right click (or

Ctrl + click) on an appointment.

l From the pop up menu, select Go to Record.

l For Client-only appointments, the associated client record will open. For appoint-

ments with an associated patient, the Patient record will open.

l Alternatively, you go to a patient or client record from an open appointment rec-

ord. From the open appointment record, click Save and Go to Record.
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About Double Booking Appointments
Double booking occurs when two or more appointments share a block of time. The Appoint-

ment Scheduler will allow more than one appointment at a given time, provided that the Con-

flict Level of the appointment type record (defined under Setup) permits overbooking.

When you schedule an appointment to overlap with a pre-existing one, you may get one of three

responses from the scheduler depending on the conflict level set for the appointment types:

Allow without a confirmation message; Allow but confirmation is required, or Overbooking is

not allowed.

You can use the drag and drop method to move one existing appointment over another to create a

double booking, or use the Double Book function to quickly and easily create a double booking.

For more on using the drag and drop method, see Using Drag and Drop to Move an Appointment.

For more on creating and working with appointments, see the related sections in this Appoint-

ments chapter.

Using Double Book
The Double Book option lets you create a double booking with a single click. It is only available

from Day View or from the Daily Schedule section of Combined View. Double Book displays

as an option in a pop-up menu when you right click (or use Ctrl + click) on an existing appoint-

ment.

To use Double Book:

l Right click (or Ctrl + click) on an existing appointment.

l From the pop up menu, select Double Book.
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l An appointment is created beside the existing appointment with the same

resource or staff. The appointment will be the same type and length as the orig-

inal appointment, but there will be no associated client or patient.

l If you click Double Book on an appointment type that is configured under Setup

as “Allow but Warn”, a warning is displayed before the double booking is

created. Click OK to proceed or Cancel to cancel the action.

l If you click Double Book on an appointment type that is configured under Setup

to not permit double booking, an alert will be displayed and the action is not

allowed. The double booking will not be created.
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l Once the double booking is created, you will need to open the appointment and

assign it to a client or patient by selecting a Client/Patient from the pick list.

You may also wish to change the appointment type, as needed. For more on cre-

ating and working with appointments, see the related sections in this Appoint-

ments chapter.

When Overbooking Prompts a Confirmation Window
Appointment Types that allow overbooking may be set to alert the user that they are about to

create a new appointment or move an appointment over an existing one. A Confirm dialog box

will only pop up if the Appointment Type has been configured with an “Allow but Warn” Con-

flict Level under Setup.

To allow the overbooking:

l Click Yes. The appointment will be scheduled over an existing appointment.

l Click No and the double booking is canceled. No new appointment will be

created over the existing appointment.

When Overbooking Is Not Allowed
Appointment Types may be defined so that overbooking is not allowed. This is configured

under Appointment Setup -> Appointment Types. When you schedule an appointment with the

Conflict Level “No Overbooking”, no other appointments for the same staff member may be

booked to overlap with it. A dialog will display indicating this.

Overbooking Alert When No Other Appointment Is Visible
Occasionally, more than one user may try to reserve or book an appointment for the same patient

or client on the scheduler at the exact same moment on different terminals. For example:

Receptionist A is in the process of booking an appointment for Tuesday morning at 10AM with

Dr. John Smith from terminal A. In another room, Receptionist B is also creating an appointment

for Tuesday morning at 10AM with Dr. John Smith.

In such cases, DVMAX provides immediate conflict checking to let Receptionist B know that

they are drawing an appointment in a slot that is already being booked by Receptionist A. While

the new appointment may not yet show on the grid because the scheduler has not refreshed,

DVMAX will display an alert: “You are booking this appointment over another appointment, do

you want to continue?"

To continue, click OK and continue with scheduling the appointment. Click Cancel to book into

a different time slot. This first alert is simply to tell you that the time slot already contains an

appointment, even though it may not yet be visible.
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Note that all conflict level settings for appointment types will still be respected, so when it is

time to save the second appointment in the time slot, you will again see the alert. When you

schedule an appointment with the appointment type Conflict Level “No Overbooking”, no other

appointments for the same staff member may be booked to overlap with it. A dialog will display

indicating this.

Overbooking When Using MPA and Multi Site Scheduler

Because users of the MPA multi-site scheduling feature can book appointments at any of the clin-

ics associated with the MPA practice, occasionally, more than one user may try to reserve or

book an appointment for the same patient or client on a particular scheduler at the exact same

moment from different clinics. For example:

A receptionist at Clinic A is in the process of booking an appointment for Tuesday morning at

10AM with Dr. John Smith at Clinic A. In another clinic across town, a receptionist at Clinic B

is also creating an appointment for Tuesday morning at 10AM with Dr. John Smith at Clinic A.

In such cases, DVMAX provides immediate conflict checking to let receptionist B know that

they are drawing an appointment in a slot that is already being booked by Receptionist A. While

the new appointment may not yet show on the grid because the scheduler has not refreshed,

DVMAX will display an alert: “You are booking this appointment over another appointment, do

you want to continue?"

To continue, click OK and continue with scheduling the appointment. Click Cancel to book into

a different time slot. This first alert is simply to tell you that the time slot already contains an

appointment, even though it may not yet be visible.

Note that all conflict level settings for appointment types will still be respected, so when it is

time to save the second appointment in the time slot, you will see the standard double booking

alert. When you schedule an appointment with the appointment type Conflict Level “No Over-

booking”, no other appointments for the same staff member may be booked to overlap with it. A

dialog will display indicating this.

Using Check In
Check In is a valuable tool that lets you keep track of when clients and patients have arrived for

their appointments. When an appointment is Checked In, this marks the start of a visit record.

You must choose a reason for the visit from a predefined list of options. Visit history for every

appointment that was checked in can be found on the General Information tab of the associated

patient and/or client record. You can also view the history of open visits for the patient or client

from the associated invoice.

Visit Reasons are defined under System Constants -> Client and Patient Settings. Refer to

that section of the manual for more details on defining visit reasons.

When an appointment is “checked in”, the status of the appointment will change from “blank” to

“Checked In”. Depending on how you have defined the status, Checked In (see Status Values
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under Appointment Setup), the appointment may show a green check mark or other icon in the

top right corner of the appointment.

Check In is only available from Day View, Week View, the Daily Schedule section of Com-

bined View and from List View. However, opening an appointment also lets you choose the

Check In option from the Status menu from the Appointment Detail dialog. For more on creating

and working with appointments, see the related sections in this Appointments chapter.

To use the Check In option from the Scheduler without opening the appointment:

l From Day View, Week View or List View, right click (or Ctrl + click) on an

appointment.

l Move the mouse pointer to the Check In option on the pop up menu. A Visit Rea-

son dialog opens. Select a Visit Reason from the Reason drop down list. You

may scroll the list, or type the full or partial name of the visit reason in the Rea-

son field to filter the list. You can change the Reason for the visit at any time,

where needed. This change will be captured in visit history.
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l The appointment may be marked with a green checkmark or other icon in the top

right corner.

l If you open the appointment, you will note that the Status reads “Checked In”

and the specified reason is listed in the Reason field of the Appointment Detail

dialog. As well, there is a note in the appointment history area showing the

appointment was checked in, along with the date, time and visit reason.

l Alternatively, you can double click to open an existing appointment to check in

an appointment. Select “Checked In” from the Status menu and choose a visit

reason from the drop-down list. The appointment will be checked in.
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You must select a visit reason if you choose the status Checked In.

Cancel Check In
If you accidentally marked an appointment as checked in, you can cancel the check in. To can-

cel:

l From Day View, Week View or List View, right click (or Ctrl + click) on an

appointment. 

l Select Cancel Check In.

l The appointment will no longer be marked as checked in. The visit history is

cleared.

As initial appointment color and status of the appointment are saved when you do a check in,

when you cancel the check in at any time in the future, the color and status of the appointment

are reverted to the values held at the time of the check in.
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The Cancel Check In button is only available for active visits where the patient is already

checked in. Once the visit is closed, the scheduler may need to be refreshed in order to see that

the Cancel Check In button is no longer available for that appointment record.

Close Visit
Once a visit is closed (from the Visits option under the Client or Patient General Info tab, or

from an associated invoice), the Check In option and Cancel Check In option are no longer avail-

able for the appointment associated with that visit, and changing the status on an appointment

will not create a visit event.

Using Set Status
Status values allow users to define the state of an appointment, as well as to track visit history

from Check In to the close or end of the visit. Every appointment or clinic visit begins with

Check In, which starts the visit record, and you can change the status of an appointment as the

patient moves from point to point in a visit. For example, once a patient is arrives for a visit and

is Checked In, you can change the status to Exam Room, to Treatment Room to Surgery to

Recovery. Every Status record can have an associated Icon that will display on the appointment

label, allowing a quick visual cue as to the location and progress of the patient in your clinic.

Checking In an appointment begins the Visit, and status events are then tracked in Visit History.

Visit history can be viewed from the General Info tab of a patient or associated client record.

Status Values are defined under Appointment Setup. You can also view the history of open visits

for the client or patient from an associated invoice.

Selecting Set Status will bring up a Status drop-down menu that will allow you to express the

current status of the appointment, along with a visual marker on the appointment to allow for a

quick, at-a-glance view of where a patient or client is in the appointment process.  You can also

set and change status from the open appointment record. Status values are defined under Appoint-

ment Setup. These values also permit you to track the amount of time a patient spends at each

stage of their visit.

To use the Set Status option from the Scheduler without opening the appointment:

l From Day View, Week View or List View, right click (or Ctrl + click) on an

appointment.
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l Select Set Status option from the pop up menu. A Status dialog opens. Select a

status from drop down list. You should make sure the appointment is checked in

before you select a status if you plan to track visit history, since every Visit

begins with Check In.

l The appointment may be marked with an icon in the top right corner, if one has

been defined for that status value under Setup.

l If you open the appointment, you will note that the selected value is in the

Status field As well, there is a note in the appointment history area showing the

appointment status was changed, along with the date, time and status value.

l Alternatively, you can double click to open an existing appointment to change

the status value of an appointment. From the Appointment Detail dialog, select a

Status from the Status drop down list. You should make sure the appointment is

checked in before you select a status if you plan to track visit history, since

every Visit begins with Check In.
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Every appointment Visit must begin with the Checked In status or the Visit History will

not be tracked in the patient or client record. The status Checked In indicates the start of a Visit

record, while all other status events relate back to the Visit record. Once the appointment is

Checked In, the Reason drop down will be available. You can change the Reason for the visit at

any time, where needed. This change will be captured in visit history.

Creating an Appointment for an Existing Client or Patient
Creating an appointment in DVMAX is fast and easy. Once you have reviewed the basic com-

ponents of the Appointment Scheduler, you will be equipped to take full advantage of the flexible

scheduling options available to you.

Creating Appointments with Multi-Site Scheduling
This is a new feature introduced with DVMAX v8. Once MPA and multi-site scheduling has

been configured, users can schedule and work with appointment schedulers across all clinics in

the multi-site practice.  That means that a user at Site A can create appointments both for their

own clinic and for any other clinics that are part of the same practice group simply by opening

that site’s scheduler from the Command Palette.

To open a scheduler for your current location, simply click the Appointment icon on the Com-

mand Palette. To open a scheduler for a remote clinic, right click on the Appointment icon in the

Command Palette and select the schedule with which you would like to work. You can have mul-

tiple schedulers open at one time, and each scheduler will be titled with the defined clinic name

or site name.

If you have several schedulers open at one time, take care when creating an appointment

that you have selected the location at which you meant to scheduler the appointment.

Creating an Appointment: A Quick Summary
You can create new appointments from Day View, Week View, Month View and Combined

View on the DVMAX Appointment Scheduler. Use the following process to create an appoint-

ment for an existing Patient or Client. If you want to make an appointment for a new Patient or

Client (one who does not yet have a record), see the appropriate section later in this chapter.

If you are creating an appointment from a Client or Patient record, the process can be sum-

marized as follows:

l Open the record for the Client or Patient for whom you want to make the appoint-

ment.

l Select Set Appointment from the Client or Patient pull-down menu. This will

open the Appointment Scheduler to Day View. If you prefer, you can move to

Month View or Combined View.

DVMAX will automatically save a new patient record when you select Set Appointment if

you have not yet saved the new patient record.

l When the Scheduler opens, the name of the client or patient for whom the

appointment is to be made is displayed in large, bold font at the top of the
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Scheduler window.

l The Scheduler opens to the current date by default. Select a different date, using

the Calendar or Date Picker if needed.

l Select a start time for the appointment by clicking and dragging on time on the

Scheduler for the day you want to create the appointment. Release the mouse

when the appointment box is drawn. A rectangular outline will appear, showing

where the appointment will be created when you use the click and drag method.

When you release the mouse button, a new appointment area will be drawn in

color. Alternatively, you can double click on an appointment time block in Day

View or a date in Month View.

l A Create Appointment window opens. Define appointment details and enter

comments if desired.

l When you create a client or patient appointment from the client or patient rec-

ord, the basic client information (including name, client ID, client file number

and contact details) and patient name (including name, gender and spe-

cies/breed) will display on the right side of the Create Appointment dialog under

the Patient Info and Client Info areas.

l Click Save to confirm the appointment or click Cancel to return to the Appoint-

ment Scheduler without creating the appointment.

l Enter your Staff ID if required.

To create an appointment directly from the Appointment Scheduler:

l In Day View, select a start time for the appointment by clicking and dragging on

time on the Appointment Scheduler for the day you have selected. Release the

mouse when the appointment box is drawn. Alternatively, double click on a time

block.
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l In Week View, click and drag on a date and time. In Month View, double click

on a day on the Month View grid.

l An Appointment Detail window opens.

l Use the Search area of the Appointment dialog to find the Client or Patient for

whom you want to create the appointment. Type a name or partial name in the

Client Filter field or Patient filter field and select the client/patient record from

the pick list.

When you select a client/patient record from the pick list, the basic client information

(including name and contact details) and patient name (including name, gender and spe-

cies/breed) will display on the right side of the Create Appointment dialog.

l For a Client-Only appointment for an existing client, from the Appointment

Detail area, type a full or partial Client name in the Client field and select the

Client record from the list. Select Client Appt from the Appt Type drop down

list.

DVMAX Practice V8.6 - User Manual



- 153 -

l To create a patient appointment for an existing patient, from the Appointment

Detail area, type a full or partial patient name in the Patient field. Use the Client

and Patient fields to filter the Client/Patient list.

l Select an Appointment Staff from the With drop down menu. If you are creating

an appointment from Day View, this field will be populated with the staff under

whose column you are creating the appointment.

l Define appointment details and enter comments if desired.

l Click Save to confirm the appointment, Save and Check In (if the client/patient

has arrived), or click Cancel to return to the Appointment Scheduler without

creating the appointment.

l Enter your Staff ID if required.

It is possible to make an appointment for a deceased patient. Deceased patients are indi-

cated in gray font in the Client/Patient pick list. The deceased status will be noted in the Patient

Information section of the Appointment Detail dialog as well.

Using Client and Patient Filters When Making an Appointment
You can create a client or patient appointment directly from the Client or Patient record using

Set Appointment from the Client or Patient menu, respectively. You can also create an appoint-

ment on the Scheduler by clicking and dragging to draw in the appointment block on the grid and

then using the Client and Patient filters and pick list to select a record.

To use the search function to find a client or patient for whom you wish to create an appoint-

ment:

l To find a Client record, type a full or partial client name in the Client Filter.

You may need to press <TAB> to filter the list.

l To find a Patient record, type a full or partial Client name in the Client Filter

and/or type a full or partial name in the Patient Filter. You may need to press

<TAB> to filter the list.

l From the Pick List, click to select the record for which to create the appoint-

ment. The name of the Client and Patient will display in the Client and Patient

Info areas.

Tips for Searching for Clients and Patients When Creating an Appoint-
ment

Here are some important useful tips for using the Filters and Pick List:

l The Appointment Detail dialog has 2 filters, a Client Filter and a Patient

Filter. You can search using one or both filters. Type a full or partial name in

the appropriate filter. The more exact you are, the more the pick list will be nar-

rowed.
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Note in this illustrated example, when you type only the first few letters of the Client name,

you have a list of records that match the Client name.

When you add the first few letters of the Patient name as well, you narrow the list of records

and the record you are looking for is much easier to locate.

l Depending on your DVMAX configuration (determined by Advanced Settings),

the filters either work on keystroke (the list is filtered as you type) or the filters

allow you to type and once you press <TAB> the pick list is sorted by what you

typed. This “search on keystroke” functionality may not be ideal for clinics with

very a very large number of records, as it does take more time to perform this

type of search.

l DVMAX does not display the complete list of client and patient records in the

pick list, as that would greatly slow down the search. Instead, the Scheduler

presents a predefined number of records (configured under Advanced Settings)

at one time. However, the Scheduler searches every record in your database to

find the record you want.

l If a Client has more than one animal, typing the Client name in the Client Filter

will display an alphabetical list of all patients associated with that client. You

can then select the appropriate patient record from the pick list.

Editing Client or Patient Info from an Appointment Record
DVMAX v7.6 introduced the ability to edit certain client and patient details directly from the

appointment record. For a patient record, you can edit Patient Status (Active, Deceased, In Hos-

pital), DOB, Weight, Gender and whether the patient is Spayed/Neutered. You cannot edit

Name, Species or Breed from the appointment record. For a Client, you can edit Client address,

email and phone number from the appointment record. You cannot edit the client’s name, client

ID or File Number from the appointment record.
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If the Client or Patient record associated with the appointment you are creating is open in

DVMAX, you will see a note under the Client Info and/or Patient Info areas indicating that the

Client or Patient fields in the appointment record cannot be edited.

Selecting an Appointment Date and Time
Before you can make an appointment, you need to display the selected date on the Appointment

Scheduler, much like opening a paper Appointment book to the proper page. By default, the

Appointment Scheduler will open in DayView, showing appointments for the current date. In

Month View, it will show appointments for a one-month period, defaulting to the current month.

You cannot edit the date of an appointment from the Appointment Detail dialog, although

you can use the Cut Appointment functionality to move an existing appointment to a new date.

For new appointments, you must create the appointment from the date for which you want to

schedule it. Use the Date Picker or Date field to open the Scheduler to the appropriate date, then

make the appointment.

See the related sections on using the Date Picker and Date Field in this Appointments chapter.

DVMAX Practice V8.6 - User Manual



- 156 -

Making an Appointment from Day View or Week View
With the Appointment Scheduler open in Day View, Week View or the Daily Scheduler section

of Combined View to the date for which you wish to make the appointment:

l Click and drag on a start time (the time that you want the appointment to begin)

in the Appointment grid. Alternatively, double click on a time block on the grid

where you want to create the appointment. Be sure to choose the staff or

resource with whom to make the appointment (if applicable) by working within

the appropriate column.

l A rectangular outline will appear, showing where the appointment will be

created.

The appointment will use the default appointment length defined for that type under Setup.

You can drag down through multiple cells or change the appointment length on the Appointment

Detail dialog to create a longer or shorter appointment period.

The appointment will use the default appointment type defined under Setup. Choose a dif-

ferent appointment type from the Types list in the Appointment Detail dialog if needed.

l An Appointment Detail window will open. You can define the length of the

appointment and other details here.

To click and drag to create an appointment, place the mouse pointer in the cell where you

want the appointment to start. Click and hold the Left mouse button. You will see a rectangle

appear in the cell. Drag down and to the right to create the appointment.  Release the mouse but-

ton, and the Appointment Detail window will open.

Double click on a time block on the grid where you want to create the appointment.

Making an Appointment from Month View
With the Appointment Scheduler open inMonth View to the month in which you wish to make

the appointment:

l Double click on the day on the Month View grid where you want to create the

appointment.

l An Appointment Detail window will open. You can define the length of the

appointment and other details here.

The appointment will use the default appointment type and appointment Staff/Resource

defined under Setup. Choose a different option from the Appointment Detail dialog if needed.

Defining Appointment Details
The Appointment Detail window will open after you have created an appointment on the Day

View orMonth View grid.

From the Appointment Detail window, you can modify the default appointment staff, appoint-

ment type and length of the appointment. When you have finished entering the details:
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l Click Save to confirm the appointment details and close the window.

l Click Cancel to return to the Appointment Scheduler without booking the

appointment.

l To complete the task you may be asked for your Staff ID, depending on how

DVMAX is configured.

What’s In the Appointment Detail Window
The date of the scheduled appointment is shown in the window title bar. The following infor-

mation is in the Appointment Detail dialog:

l Client and Patient selection (who the appointment is for)

l Start Time

l Appointment Length

l End Time

l Appointment Staff or Resource

l Appointment Type

l Appointment Color

l Use Manual (Appointment) Color checkbox

l Appointment Notes

l Appointment Status

l Appointment History

l Visit History

l Patient Information Area

l Client Information Area

About Appointment History
DVMAX tracks 2 kinds of appointment history: appointment change history and visit history. In

the History area, there is a listing of when the appointment was created and who created the

appointment, as well as entries for any changes made to the appointment.  When an appointment

is checked in or the appointment status is changed, the information appears in the Visit History.

Setting or Changing the Start Time
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The Time field shows the appointment start time you selected when you created the appoint-

ment. You can use the drop-down menu to change the start time if needed. The intervals shown

on the Time drop down are determined by the Time Increment value under Setup.

If you want to move the appointment to an entirely different time, drag and drop the appointment

to a new time, or use the Cut Appointment and Paste Appointment options. These options are

only available from Day View.

To change the start time of the appointment:

l Click to select an appointment start time from the Time drop-down menu. The

appointment times are in increments determined by the Time Increment value

under Setup.

Although it is possible to type a start time in the Time field, it is strongly recommended that

you use the drop down menu to select a time. Typing a value that is not found in the drop down

menu can create visually confusing appointment blocks or appointments outside the Start/End of

day limits, which will not show up on Day View.

Setting or Changing the Length of the Appointment
Each appointment type has a user-defined, default duration, shown in the For field. This can be

adjusted within the current appointment by entering a different minute value.

To change the length of the appointment:

l Backspace to delete the current value or drag over the box to highlight the box.
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l Type a new appointment length.

If you plan to change the appointment type, select the new type first. Otherwise, changing

the appointment type may reset the duration to reflect the default value for that appointment type.

Appointment End Time
The Until field represents the appointment end time based on Start time and duration. It will be

recalculated each time you make changes to the start time or length of the appointment.

Selecting the Staff Member or Resource
The With field shows the name of the staff or resource with whom the appointment is sched-

uled.

If you have entered an appointment from DayView, you have already selected the staff member

with whom the appointment is to be booked by your choice of column.

To select or change the staff or resource with which to schedule the appointment:

l Click to select a staff or resource from the With drop-down menu.
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Only staff and resources that have an Appointment Staff record under Appointment Setup

will appear on this list.

Selecting the Appointment Type
All appointments are automatically assigned the Appointment Type default value, defined under

Setup. However, you can change the appointment type using the Appt Type drop-down menu.

Appointment types showing in this list have been defined under Appointment Types in Setup.

Each appointment type has a default duration that will be reflected in the For field as you select

the Type.

To choose an Appointment Type:

l Click to select an appointment type from the Appt Type drop-down menu.

Entering Notes About the Appointment
The Notes area of the Appointment Detail window lets you add any comments about the

appointment as needed.

To type Notes:

l Click anywhere within the Notes area.

l The typing cursor will indicate where text will begin.

l Type notes.
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Changing Appointment Type Color
The default color of an appointment is determined by the Initial Color and Default Color set-

tings under Appointment Setup (see related sections in this chapter for more detail). You can

manually change the appointment color any time using the Color drop-down menu.

To choose an appointment color:

l Click to select an appointment color from the Color drop-down menu. This will

only change the color for the appointment you are creating, not the default color

for all appointments of that type.

Use Manual Color Option for Appointment Color
The default color of an appointment is determined by the Initial Color and Default Color set-

tings under Appointment Setup (see related sections in this chapter for more detail). You can

manually change the appointment color any time using the Color drop-down menu.

When you select a color from the Color drop down menu, the Use Manual Color checkbox

beside the Color drop down is automatically selected. Selecting Use Manual Color overrides

the Initial Color and Default Color settings for this appointment, and as long as this checkbox

is selected, the only way to change the color of this appointment is to do so manually.

DVMAX Practice V8.6 - User Manual



- 162 -

Uncheck Use Manual Color to have the regular color rules (as determined by Appointment

Setup) take effect. Changes to this setting will not retroactively affect the appointment.

Scheduling Multiple Appointments for the Same Client or Patient
If you want to make more than one appointment for the same Client or Patient, you can use the

Shift+Save function from the Appointment Detail window. Clicking <Shift>+Save or

<Shift>+Check-In Reason functions like OK and Next button in DVMAX v7.5.1 and earlier.

To make multiple appointments:

l Make the first appointment by following the steps as outlined above under Cre-

ating an Appointment for an Existing Client or Patient.

l When you have finished entering information in the Appointment Detail dialog,

hold down the <Shift> key and select Save.

l You will see text at the top of the Scheduler that reads “Next created appoint-

ment will be for <Client Name>” (for client-only appointments) or “Next

created appointment will be for <Patient Name>”, as applicable. The next

created appointment will have the correct patient and/or client name pre-filled.

l Select a new date and time for the next appointment and repeat the appointment

creation process.

OK and Next Appointment
See Scheduling Multiple Appointments for the Same Client or Patient.

Appointment Change History
You can view all the changes made to an appointment in the History area of the Appointment

Detail window. The History lists appointment creation date as well as the date and time changes

were made to the appointment.

If you want to see the Appointment Change history for all appointments over a specified period,

see the report section for the Appointments Change History Report.
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Appointment Change History is recorded regardless of whether Staff ID is required when

creating, editing and deleting appointments.

Creating an Appointment for a New Client (and Associated Patient)
You can make an appointment for a new Client two ways.

1) You can create and save a new record for the Client and associated Patient. Then, follow the

basic process for Creating an Appointment for an Existing Client or Patient.

2) You can open the Scheduler and create a new appointment using an appointment type such as

New/Unknown or whatever appointment type you may have defined under Setup for a new client

who does not yet have a record in DVMAX. A new Client (and associated patient, where appli-

cable) record can be created at a later date.

To create an appointment for a new client/patient:

l From the Command Palette, click Appts to open the Scheduler.

l In Day View, select a start time for the appointment by clicking and dragging on

time on the Appointment Scheduler for the day you have selected. Release the

mouse when the appointment box is drawn. Alternatively, double click on a time

block.

-OR-

l In Month View, double click on a day on the Month View grid.

l An Appointment Detail window opens.

l Leave the Client and Patient fields blank, as there is no record for this client in

DVMAX yet.

l Select the appointment type as appropriate for a New/Unknown client, since the

appointment is not associated with a known Client or Patient.

l Use the Notes space in the Appointment Detail window to enter Client name,

and any other details that may be known (such as phone number and animal’s

name).
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To create a Client Only appointment, you must select Client Appt from the Appt Type drop

down list.

Modifying or Extending Existing Appointments
There are several ways in which you may want to adjust an existing appointment. You can

change the length of an appointment, the type, the status, the staff or resource, edit notes and

edit client or patient details.

Changing the Appointment Details
You can make changes to an existing appointment simply by double clicking on the appointment.

This opens the Appointment Detail window. You can modify any of the appointment details here

except the actual Date on which the appointment has been scheduled.

Changing the Appointment Length
You can adjust the length of the appointment through the Appointment Detail window by chang-

ing the value in the For field. You can also make changes to the length of an appointment in Day

View by clicking and dragging on the bottom edge of the appointment. Drag up to shorten the

appointment, down to lengthen it.

Deleting Appointments
To delete an appointment:

l From Day View, the Daily Scheduler section of Combined View or from Month

View, double click the appointment you want to delete.

l The Appointment Detail window opens.

l Click Delete.

l From the Confirm window, click Yes to confirm the deletion of the appointment,

or No to keep the appointment and return to the Detail window.

Printing an Appointment List
To print an appointment list from the Scheduler:

l From the top left corner of the Scheduler, click Print.

l Select a Start Date and an End Date range over which to print appointments.

l You can print the appointment list for every doctor in the clinic individually by

selecting only a single doctor or resource at a time. Select a resource or staff by

clicking the name in the Staff list. An asterisk beside the name indicates it has

been selected. No asterisk means it is not selected and will not be included in

the printing. Select all resources to print a complete list. Remember, these staff

DVMAX Practice V8.6 - User Manual



- 165 -

names correspond with the names at the top of each staff or resource column

listed in Day View on the Scheduler.

l The appointment type, appointment start time and duration, client name and

phone number, patient name and appointment notes are all included on the print-

out.

Printing a List of Clients by Appointment Date
To generate a list of clients with appointments within a specified date range:

l From the DVMAX main screen, click Clients from the Command Palette.

l From the Find dialog, select Appointment Dates (Start, End) from the By drop

down menu.

l In the Enter Date Range field, specify a date range for which you would like to

print appointments. Enter the start date followed by the end date using the format

MM/DD/YY,MM/DD/YY. The default range is the current day.

l After the date range, you can specify one or more appointment staff. This lets

you create a list of appointments on a given day for specified staff. To specify

staff, you can use last name, first name (or partial name). The default search

includes all appointment staff. The format should be MM/DD/YY,MM/DD/YY,

Name
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l Click Search.

l DVMAX returns a list of all clients with appointments in the date range spec-

ified and for the specified appointment staff.

l To print the list, select Print from the File menu, then choose List and click the

Print button from the Printing Clients dialog.

Printing a List of Patients by Appointment Date
To generate a list of patients with appointments within a specified date range:

l From the DVMAX main screen, click Patients from the Command Palette.

l From the Find dialog, select Appointment Dates (Start, End) from the By drop

down menu.

l In the Enter Date Range field, specify a date range for which you would like to

print appointments. Enter the start date followed by the end date using the format

MM/DD/YY, MM/DD/YY. The default range is the current day.

l After the date range, you can specify one or more appointment staff. This lets

you create a list of appointments on a given day for specified staff. To specify

staff, you can use last name, first name (or partial name). The default search

includes all appointment staff. The format should be MM/DD/YY,MM/DD/YY,

Name
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l Click Search.

l DVMAX returns a list of all patients with appointments in the date range spec-

ified and for the appointment staff specified.

l To print the list, select Print from the File menu, then choose List and click the

Print button from the Printing Patients dialog.

Using Quick Print from List View

The Quick Print function is not available when using the Internal browser option for dis-

playing the Scheduler.  If you are using the Internal browser (Scheduler opens within DVMAX

not in an external browser window), you will not see the Quick Print button.

You can use Quick Print in List View to print a copy of information on the list exactly as it

appears on the screen. If you sort the list, Quick Print will provide a printed copy of the list as

sorted. If you hide columns in List View, only details in those columns that are displayed will

print.

To print, click Quick Print.

Appointment Reports
Using the Print option from the Scheduler provides you with a quick method for printing a list of

appointments for one or more staff or resource over a specified date range.

There are also a number of Appointment-related report options available from General Man-

agement under the Section menu from the DVMAX main screen. Refer to the Reports chapter

for more information.

Appointment Listing – The Appointment Listing report shows all appointments within a user-

specified date range. It is much like the Appointment List you can generate from the Print option

on the Scheduler, except it prints the list for all staff and resources.

Appointment Change History – The Appointment Change History report lists those appoint-

ments that have been changed within a user-specified date range. This report requires you to

have the Require User Initials option enabled under Appointment Setup.

Deleted Appointments – This custom report provides a list of deleted appointments over a user-

defined date range.
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Appointment Range Report – The Appointment Range Report is a custom report that returns

appointments within a user-specified date range. The report output is information about the

appointment, client, and patient. You can copy and paste this report into an Excel spreadsheet to

share with third-party vendors.

Appointment Type Count and Sales - This custom report reviews appointments within a user-

specified date range, totaling them by Appointment Type. The system then makes a comparison

between the date of an appointment and any invoices on the same date with an associated client

to return an estimate of sales by appointment type.

Visit Report – A custom report that provides a list of all active Visits for reference by care

staff away from the Front Desk/Waiting Area. The list will show the most recently checked-in

visit at the top.

Viewing the Appointments List in Web Browsers/Smartphones
You can view your Appointments in a Web browser or on a mobile browser from your Smart-

phone. For iPhone and iPad users, you can also download the free DVMAX Anywhere App

from the App Store to work with appointments and view patient histories.

To view appointments from the web, point your web browser at http://<-

YourWebserverAddress>/appts/. Login using a DVMAX username that has scheduler access.

When logged in, you can view any doctor's schedule in HTML or RSS (the HTML page will

refresh every 5 minutes, the RSS feed refreshing is handled by the RSS reader software).

For the applicable staff member, click HTML or RSS, for either Recent or Upcoming appoint-

ments. The definitions of "Recent" and "Upcoming" are Advanced Settings, by default set to 1

day. Scheduled appointments display in the web browser.

You can also view the most recent history items for any patient listed in an appointment. The

number of history items listed is determined by an Advanced Setting. The default setting is 5 his-

tory items. Click the View Recent History link to view the history items. For more on the

Advanced Settings that control web appointments and web history, please contact DVMAX

Technical Support.
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Bill Items
Bill Items are the key components in DVMAX’s invoicing system. They represent any inventory

item or service for which you would charge a client. They can also be used to place messages

onto an invoice, add items to a patient history, or record other information into the patient record.

Bill items can be linked to inventory items to help you keep track of the quantity on hand of any

physical items that your practice uses or sells. Linking a bill item with one or more inventory

items also allows you the option of automatically updating the price of any linked bill item if

inventory costs change. 

Bill Items have a wide variety of settings that can be used to control pricing of the item(s).

Patient links allow a Bill Item to make a wide variety of automatic entries and adjustments to a

Patient’s history and record. The settings you apply to a Bill Item determine how the item

behaves when used on an invoice.

Creating a New Bill Item Record
To create a new Bill Item record:

l From the Section drop-down menu, choose Inventory Management.

l From the Find window, select Bill Items from the Search For list.

l Click Add New. A new Bill Item record window opens.
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l From the General Information tab on the Bill Item window, type a unique bill

item code in the Bill Code field.

To help remember and organize bill item records, you can create a bill item code that uses

the Category code plus a number, such as RX5000 for the pharmacy item Amoxicillin 50mg. 

This makes it easy to identify the category, such as RX, to which the bill item belongs.

l In the field to the right of the Bill Code field, type a bill item description. This is

a brief name or description you want to give to the bill item.

l In the Category field, type the category code in which to place that the bill item.

To display a list of all Category Codes, press BACKSPACE and TAB

(DELETE and TAB on a Macintosh system).  Select a Category Code from the

list and click OK.

l The Bar Code field is used to hold a secondary bill item code. It is typically a

UPC (universal product code). A Bar Code is not required to create a Bill Item,

and you may choose to leave this field blank.

The Bar Code can be up to 15 characters long.  If your system contains data converted from

another practice management program, you may want to use this field to hold the code used by

your previous system for this item or service.

l If the Bill Item will not be linked to an inventory item, type a simple price in the

Service Price field.  The price for a service or an inventory item whose cost

does not fluctuate can be entered in the Service Price field.
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l The Inventory Price is set under Inventory Items and cannot be adjusted from

the Bill Items record.  See Linking Inventory Items to Bill Items for more infor-

mation on inventory price.

l The Net Price is the sum of the Service Price and Inventory Price, and it is cal-

culated automatically. This is the price used on an invoice when billing for this

item.

Current Cost and Pricing Cost are not editable. Current Cost is the actual last cost paid

for an inventory item (entered as a purchase). Pricing Cost is the cost that the bill item is using

to base the bill item price on.

l SelectMinimum if this bill item will have a minimum price when placed on an

invoice. Type a minimum fee value in the field to the right of the Minimum

checkbox.  You must both selectMinimum and type a fee value in order to use

this bill item feature on an invoice.  If the price based on quantity sold is below

the minimum price, DVMAX will automatically charge the minimum price.

l The Minimum price will be used when an item's calculated Ext Price (i.e. qty x

price) is below the minimum setting. In these cases the Ext price is set to the

Minimum. In cases when the Ext Price is below or equal to the Minimum

price, the Add-On value is added to the price before it calculates the Ext price

based on quantity.  Then, if that value is less than the minimum, it changes the

Ext price to the minimum.

l Select Add-On if you want to set this item to have a set fee automatically added

to the calculated price when this item is placed on an invoice. Type an add-on

fee value in the field to the right of the Add-On checkbox.  You must both

select Add-On and type a fee value in order to use this bill item feature on an

invoice. The Add-On only is added to the Ext Price when the Ext Price is equal

to or above the Minimum Price. An Add-On is generally used for a dispensing

fee or pharmacy fee.

l Type a value in the Round Up To field to which you want to round the extended

price (the total price for the bill item, including quantity and pricing adjustments

such as minimum or add-on amounts) whenever this item is sold.  For example,

you may choose to round the price up to the nearest $1.00.  Leave this field at

the default value of $0.00 to prevent any rounding of the price on an invoice.

Rounding is applied only to the price on the invoice line with this bill item on an invoice not

to the invoice total.

l Est. High Price designates the estimated high-end cost of this bill item when

applied to an estimate.  The default value of the Est. High Price is the Net

Price.  The estimated high price can be increased as necessary to indicate a

higher potential estimate, but will always be at least as much as the Net Price

of the bill item.

l The Administration Fee will be added to an invoice if this Bill Item is Admin-

istered (as opposed to Dispensed – see Invoicing for details). DVMAX will

automatically add the value you type in the Administration Fee field to an

invoice if this Bill Item is marked as Administered on an invoice line.
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l Select Taxable if the bill item will be subject to sales tax when sold to your

clients. From the drop-down menu below the Taxable checkbox, select a sales

tax rate. Sales tax rates are set in System Constants.

l Select Adjustable if you want the bill item to have an adjustable price. When an

adjustable item is entered on an invoice, invisible invoice or an estimate,

DVMAX will ask you to enter a price.  The Net Price for the bill item will be

the suggested price.

The Adjustable setting will slow down the entry of items on an invoice.  It is recommended

you use it only when necessary.

l SelectMiscellaneous if you want to be able to type a general description beside

the bill item when it appears on an invoice.  This makes it possible to have a gen-

eral bill item for unusual charges. When you type a description on an invoice, it

is unique to that invoice and it will not be stored in the bill item record for use on

other invoices.

l Select Discountable to set the item as discountable. This is valuable if you

prefer to allow discounts on only certain items in the system.   DVMAX allows

you to select Global Discounting on invoices (determined by Invoice Settings

under System Constants).  If the Global Discounting setting is not selected, only

those bill items marked as Discountable can be discounted on an invoice.

l Select Certificates if you would like DVMAX to ask you to print certificates

after completing any invoice with this item on it.  This setting should be used on

any service or procedure that would typically necessitate a certificate; such as

rabies vaccines, spay or neuter procedures.

l Select Non-Printing if you would not like this item to appear as a line item on

any printed invoice. All non-printing items must have a Net Price of $0.00.

l Select Auto-Update Costs if the price for the bill item should increase when-

ever the cost for the linked inventory item increases.  If you pay more for this

product, then your clients will be charged more for it as well.   This option is

only applicable to bill items that have linked inventory items.

DVMAX will never automatically lower a price, only increase it.

l Select Travel Sheet Item to include this item in the list of bill items that is

found by selecting a search for Bill Items by Travel Sheet from the Find

window.  This option allows you to mark the common items that you may want

on a basic travel sheet.

l Select Fixed Price if the price of the bill item will not depend on the quantity

sold. This means that the final price for the client will always be the same,

regardless of the quantity of this bill item sold on an invoice.

The Fixed Price option should be used with caution, since it can easily result in selling

goods at a loss.
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l Select Antech/ Zoasis Requisition if this is a lab requisition bill item.

l Select Always Dispensed if you want to have this Bill Item default to Dis-

pensed even when the item is listed on a treatment plan (where it would usually

default to Administered).

l Select Def Dr. and type a default staff code in the field below the Def Dr.

checkbox if the service described by the bill item is always rendered by a spe-

cific provider. Choosing this option assures that the appropriate provider is cred-

ited when the service is invoiced.  Use <BACKSPACE> and <TAB> (or

<DELETE> and <TAB> on a MacIntosh) to display a list of providers.  Click

Clear to clear the Def Dr. code if needed. Any default provider information for

this bill item will be removed.

Linking Inventory Items to Bill Items
Every Bill Item record can be linked to one or more inventory items. Linking inventory items to

bill items lets you accurately reflect the depletion of inventory Quantity on Hand for tracking

and reorder purposes.  It also gives you the option of using a markup percentage based on inven-

tory cost when calculating the bill item price (the price charged to clients on an invoice). You do

not need to link inventory items to bill items if you do not plan to track the physical inventory of

a bill item, and/or you do not plan to use markup percentages to adjust your bill item price, such

as when you are using a flat-rate Service Price.

There are three ways to link inventory items to bill items:

l Use the Auto-Link function to create a new inventory item and link it to a new

bill item as you create the bill item record.

l Link an existing inventory item to a new bill item record.

l Select the Create Item button to create a new Inventory Item with the same

item code.

Typically, an associated inventory item does not exist at the time of creating your new bill

item, so using the Auto-Link function is the easiest way to accomplish both tasks at once.

Linking a New Inventory Item to a Bill Item Using Auto-Link
Typically, an associated inventory item record has not been created at the time you are creating

a new bill item record. DVMAX’s Auto-Link function, available from the Bill Item record win-

dow, lets you create and link a new or existing inventory item to the bill item record.

To link a new inventory item record to a new bill item record:

First create the inventory item, then complete the linked inventory item details.  An overview of

the steps involved in creating a linked inventory item is as follows:

l From the Bill Items window, select Add Linked Inventory from the Inventory

Links drop-down menu. The Add Linked Inventory Item window opens.
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l Click Auto-Link. An Auto-Link Entry for Inventory Item window opens.

l Complete the Inventory Item record details. This creates a new inventory item to

link to the bill item.

l Click OK to save the inventory item and return to the Add Linked Inventory

Item window.

l From the Add Linked Inventory window, complete the linked inventory details.

l Click OK. The new inventory item will be linked to the bill item record.

You can also double click in the Linked inventory area to link an item.

Create a New Inventory Item through Auto-Link
To create a new inventory item to link to a bill item:

l From the Inventory Links drop-down menu, select Add Linked Inventory.

l Click Auto-Link. A new Inventory Item record window opens.

l The identical code and description assigned to the linked bill item will be given

to the new inventory item.

l In the Purchase Units field, type over the default text with a description of how

you purchase and receive your inventory for this item.  For example, you might

type Case of 24 Cans as the Purchase Units for a certain pet food.

l In the Dispensing Units field, type over the default text with a description of the

way that this item will be dispensed to clients.  For example, the units might be

in Cans for pet food.

l Type the number of dispensing units contained in a purchase unit in the Unit Fac-

tor field.

Purchase Units Example: If a bill item is for One Can Dog Food, but you purchase dog

food from your vendor in a case of 24 cans, the Purchase Units field would be Case of 24, the
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Dispensing Units would be Can and the Unit Factor would be 24, because there are 24 cans of

dog food in a Case of 24.

l Type the last cost that you paid to the vendor for this product in the Last Cost

field. This is required if you intend to use a markup percentage in establishing

the Net Price for the bill item.

l Type the current physical quantity on hand of this product, in terms of Purchase

Units in the Qty on Hand field.

l Type the minimum quantity of Purchase Units you want on hand before this

item appears on a reorder list in the Reorder Minimum field.

l Select Rx Item if this inventory item is a pharmacy item and should appear on

your Rx Labeling list. You may also want to select Rx item if you wish to track

the Lot # and or expiration dates of the item.

If the inventory item is RX, it will not appear on the RX list until you rebuild that list or quit

and restart DVMAX on each terminal.

l Select Taxable if you pay sales taxes when purchasing this inventory item from

the vendor. Note that this is not related to whether the client pays tax to your

clinic for this item.

l Click OK to save the new inventory item record.

l The newly created inventory item will appear in the Add Linked Inventory Item

window.

Link a New Inventory Item to a Bill Item
To link a new inventory item created from Auto-Link to the bill item record:

l From the Bill Items window, follow the steps listed under Create a New Inven-

tory Item through Auto-Link to add the inventory item you wish to link to the bill

item.

l From the Add Linked Inventory Item window, the Item Code should already

contain the newly created inventory item code.  Typically, this is the same as

the bill code.

l Type a linked quantity in the Linked Qty field.  The Linked Quantity determines

how much of the inventory item to sell with this Bill Item. The quantity is meas-

ured in the units shown just to the right of this field. The units shown are the Dis-

pensing units for the inventory item that was set using the Auto-Link function.

Linked Quantity controls how the inventory is depleted and must be set correctly or the

inventory tracking will be incorrect.

l Cost reflects the cost of the inventory item and the linked quantity associated

with this Bill Item. It is not editable. 

l If you are setting the bill item price based on an inventory markup, enter the

markup percentage in the Markup field.
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The markup is the percentage above the inventory cost that you want to charge for this bill

item. For example, a 50% markup = 1.5 x inventory cost. If your inventory item cost is $1.00 a

can, a 50% markup will charge $1.50 per can to the client on an invoice.

The Markup default value is -100%. This tells DVMAX not to use inventory costs as a

determining factor for the bill item price. If you are using a flat-rate Service Price as the price

for this bill item, and are only linking an inventory item to this bill item for tracking purposes,

use the defaultMarkup value.

l Select Sales Independent if you want DVMAX to deduct only the linked quan-

tity of the item from inventory, regardless of how many of the bill items are sold

on a single invoice line. Use this setting with caution.

l Click OK to save the Linked Inventory Item settings.

Link an Existing Inventory Item to a New Bill Item
Existing inventory can be linked to a new bill item. The process is similar to linking a new inven-

tory item to a new bill item.

To link an existing inventory item to a new bill item:

l From the Bill Items window, select Add Linked Inventory from the Inventory

Links drop-down menu. An Add Linked Inventory Item window opens.

l Click Auto-Link.

l DVMAX will link the bill item to the inventory item whose code matches the

bill item code.  The code for the inventory item will appear in the Item Code

field, with the description beside the field.  If there is no matching inventory

item, you can create a new inventory item or link to an existing inventory item.

l Type a linked quantity in the Linked Qty field.  The Linked Quantity determines

how much of the inventory item to sell with this Bill Item. The quantity is meas-

ured in the units shown just to the right of this field. These are the Dispensing

units for the inventory item.

Linked Quantity controls how the inventory is depleted and must be set correctly or the

inventory tracking will be incorrect.

l Cost reflects the cost of the inventory item and the linked quantity associated

with this Bill Item. It is not editable.

l If you are setting the bill item price based on an inventory markup, enter the

markup percentage in the Markup field.

The markup is the percentage above the inventory cost that you want to charge for this bill

item. For example, a 50% markup = 1.5 x inventory cost. If your inventory item cost is $1.00 a

can, a 50% markup will charge $1.50 per can to the client on an invoice.

The Markup default value is -100%. . This tells DVMAX not to use inventory costs as a

determining factor for the bill item price. If you are using a flat-rate Service Price as the price
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for this bill item, and are only linking an inventory item to this bill item for tracking purposes,

use the default value

l Select Sales Independent if this setting is checked, the system will only deduct

the linked quantity of the item from inventory, regardless of how many of the bill

items are sold on a single invoice line. Use this setting with caution.

l Click OK to save the Linked Inventory Item settings.

If you have just entered a newly linked inventory item with a markup percentage, you may

not immediately see the new price reflected on the bill item record under Inventory Price and

Net Price. To update the bill item with the new settings, select Update Inventory Price from

the Inventory Links drop-down menu.

You may encounter a message asking if you would like to link this new bill item to a MRC

or a treatment after setting up the new bill item. It is strongly recommended that you always

choose Yes even if you think it is unnecessary. Creating a linked treatment will never have a

negative impact on your system, whereas not creating one can cause many problems.

Bill Items and the Patient Record
A Bill Item can be connected to any combination of Reminders, Recalls, Medical Record

Entries and Diagnoses. When you place a Bill Item on an invoice, DVMAX will search for

these connections and modify the Patient record accordingly.

You can see and specify links to the patient record on the Patient Links tab of the Bill Items

screen.

The Patient Links Tab
The Patient Links tab is divided into 4 areas:

l Linked Reminders: DVMAX will apply the Reminders in this list to the

Patient record when the Bill Item is entered on an Invoice.

l Linked Recalls: DVMAX will apply the Recalls in this list to the Patient rec-

ord when the Bill Item is entered on an Invoice.

l Linked Medical Record Entries: DVMAX will apply the Medical Record

Entries in this list to the Patient record when the Bill Item is entered on an

Invoice. Typically each Bill Item has only one linked Medical Record Entry.

l Linked Diagnoses: DVMAX will apply the Diagnoses in this list to the Patient

record when the Bill Item is entered on an Invoice. A typical diagnosis does not

appear on the printed invoice.
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Linked Reminders
Linked Reminders tell DVMAX how to update Reminders on a Patient record when a Bill Item

is used on an invoice. Linked Reminders can create new Reminders, update existing Reminders,

or remove Reminders from a Patient record.

To link a Reminder to a Bill Item:

l Locate the Bill Item you wish to link.

l Click the Patient Links tab at the top of the Bill Item dialog.

l Choose Add Linked Reminder from the Patient Links drop-down menu

-OR-

l Double-click an empty area in the Linked Reminders list.

CONTROL+R (COMMAND+R on Macintosh) is a keyboard shortcut for Add Linked

Reminder.

l The Add Linked Reminder dialog opens.

l Type the code of the Reminder you wish to link into the Reminder Code field.

Type BACKSPACE+TAB (DELETE+TAB on Macintosh) to see a full list of

Reminder codes to choose from. If you know the first few letters of the

Reminder code, type them into the field and then press the TAB key to see a list
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of matches.

l Type a number into the Days Ahead field. This tells when to set the due date for

this Reminder. This field defaults to the duration that is defined in the Reminder

itself.

The calculation of the due date is based on the From Administration or From Birthdate

setting for the Reminder type. If the selected reminder is a fixed date reminder, then the Days

Ahead field is ignored. For more information, see Reminders.

l If you wish DVMAX to erase this Reminder from the Patient record when this

Bill Item is placed on an invoice, select Remove this Reminder from the

Patient Record. If you intend this Bill Item to place the Reminder on the

Patient record, make sure not to select this check box.

l Click OK to save your changes, or Cancel to return to the Patient Links tab

without saving the Reminder.

Linked Recalls
Linked Recalls tell DVMAX how to update Recalls on a Patient record when a Bill Item is used

on an invoice. Linked Recalls can create new Recalls, update existing Recalls, or remove

Recalls from a Patient record.

To link a Recall to a Bill Item:

l Locate the Bill Item you wish to link.

l Click the Patient Links tab at the top of the Bill Item window.

l Choose Add Linked Recall from the Patient Links drop-down menu

-OR-

l Double-click in the Linked Recalls list.

CONTROL+M (COMMAND+M on Macintosh) is a keyboard shortcut for Add Linked

Recall.

l The Add Linked Recall dialog opens.

l Type the code of the Recall you wish to link into the Recall Code field. If you

do not know the exact recall code, type the first letter into the Recall Code field

and press TAB. This will bring up a window listing all existing codes.

l Type a number into the Days Ahead field. This tells when to set the due date for

this Recall. This field defaults to the duration that is defined in the Recall itself.
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The calculation of the due date is based on the From Administration or From Birthdate

setting for the Recall. If the selected reminder is a fixed date reminder, then the Days Ahead

field is ignored. For more information, see Recalls.

l If you wish DVMAX to erase this Recall from the Patient record when this Bill

Item is placed on an invoice, select Remove this Recall from the Patient Rec-

ord. If you intend this Bill Item to place the Recall on the Patient record, do not

select this checkbox.

l Click OK to save your changes, or Cancel to return to the Patient Links dialog

without saving the Recall.

Linked Medical Record Entries
Linked Medical Record Entries tell DVMAX how to update the treatment history for a Patient

record when a Bill Item is used on an invoice.

To link a Medical Record Entry to a Bill Item:

l Locate the Bill Item you wish to link.

l Click the Patient Links tab at the top of the Bill Item dialog.

l Choose Add Linked Med Rec Entry from the Patient Links drop-down menu.

-OR-

l Double-click in the Linked Medical Record Entries list.

CONTROL+T (COMMAND+T on Macintosh) is a keyboard shortcut for Add Linked

Med Rec Entry.

l The Add Linked Medical Record Entry dialog opens.

l Type the code of the Medical Record Entry you wish to link into the Medical

Record Entry Code field. If you do not know the exact medical record code,

type the first letter into the Medical Record Code field and press TAB. This

will bring up a window listing all existing codes.

l Click OK to save your changes, or Cancel to return to the Patient Links dialog

without saving the Medical Record Entry.

Linked Diagnoses
Linked Diagnoses tell DVMAX how to update the diagnosis history for a Patient record when a

Bill Item is used on an invoice.

In most cases Bill Items with linked diagnoses are non-printing items and do not appear on

a printed invoice.

To link a Diagnosis to a Bill Item:
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l Locate the Bill Item you wish to link.

l Click the Patient Links tab at the top of the Bill Item dialog.

l Choose Add Linked Diagnosis from the Patient Links drop-down menu

-OR-

l Double-click in the Linked Diagnoses list.

CONTROL+D (COMMAND+D on Macintosh) is a keyboard shortcut for Add Linked

Diagnosis.

l The Add Linked Diagnosis dialog opens.

l Type the code of the Diagnosis you wish to link into the Diagnosis code box. If

you do not know the exact Diagnostic Code, type the first letter into the Diag-

nostic Code field and press TAB. This will bring up a window listing all exist-

ing codes.

l Click OK to save your changes, or Cancel to return to the Patient Links tab

without saving the Diagnosis.

Bill Item Notes Tab
You can associate up to two Bill Item Notes with an individual Bill Item.

A Bill Item Note attached to a Bill Item as its Note is printed on any invoice containing that Bill

Item. This Note should address issues present after a procedure is performed or treatment is pro-

vided.

A Bill Item Note attached to a Bill Item as its Estimate Note is printed on any estimate con-

taining that Bill Item. Estimate Notes should address issues present before a procedure is per-

formed or treatment is provided.

For more information on Bill Item Notes, see Bill Item Notes elsewhere in this reference.

Attaching Notes to a Bill Item
To attach notes to a Bill Item:

l Locate the Bill Item you wish to link.

l Click the Notes tab at the top of the Bill Item dialog.

l The Notes tab is split into two sections: the top section contains the Bill Item

Note (which will appear on Invoices containing this Bill Item), and the lower

half contains the Estimate Note (which will appear on Estimates containing this

Bill Item).
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l To specify a Bill Item Note to be printed on any Invoice containing this Bill

Item, type the code of an existing Bill Item Note into the Bill Item Note

Code box. To see a list of Bill Item Notes codes to choose from, click in the

Bill Item Note Code field and type the first letter and press TAB. This will

bring up a window listing all existing codes.

l To specify a Bill Item Note to be printed on any Estimate containing this

Bill Item, type the code of an existing Bill Item Note into the Estimate Note

Code field. To see a list of Bill Item Notes codes to choose from, click in

the Bill Item Note Code field and type the first letter and press TAB. This

will bring up a window listing all existing codes.

For more information on Bill Item Notes see Bill Item Notes elsewhere in this reference.

Creating a New Bill Item Note from the Notes Tab
You can create a new Bill Item Note from a Bill Item’s Notes tab. A Note that you create in

this manner will become a regular Bill Item Note, and will be available to all other Bill Items.

For an alternate method of creating Bill Item Notes, see Bill Item Notes elsewhere in this ref-

erence.

To create a new Bill Item Note from a Bill Item record:

l From the Notes tab of a Bill Item record type a new Bill Item Code in either

the Bill Item Note Code field or Estimate Note Code field.

l If the code is not currently in use, DVMAX will present a dialog informing

you that the Note Code you typed is not a pre-existing Note Code.
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l Click OK. The Enter New Note dialog opens, with the Code you typed pre-

viously in the Note Code field.

l Type a description of the new Bill Item Note in the Description field.

l Type the text of the new Note in the Note field.

l Click OK.

The Note field in the Enter New Note dialog is relatively small. If your new Bill Item

Note is going to be longer than a paragraph, you may find it easier to create a Bill Item Note by

following the procedures outlined in Bill Item Notes.

Editing a Bill Item Note from the Notes Tab
You can edit the text of an existing Bill Item Note from the Notes tab of the Bill Item.

The changes you make will be saved as part of the Bill Item Note linked to the Bill Item.

This means they will be printed on all future Invoices containing Bill Items that use the Bill Item

Note.

For an alternate method of editing Bill Item Notes, see Bill Item Notes elsewhere in this ref-

erence.

l From the Notes tab of a Bill Item, type the changes you wish to make to the Bill

Item Note or the Estimate Note.

l Click anywhere outside the Note field, or press the TAB key.

l DVMAX will ask you to confirm that you wish to modify the Bill Item Note

linked to this Bill Item.
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l Click OK to save your changes to the Bill Item Note. Click Cancel to discard

your changes and leave the original note unchanged.

Sales History Tab
You can view an up-to-date graphical Sales History of any Bill Item in your practice at any

time. You can see sales totals in terms of revenue generated and quantity of items sold.

To view Sales History:

l Open the record of the Bill Item you wish to view.

l From the Bill Item record, select the Sales History tab.

l The top part of the Sales History dialog shows the complete Sales History for the

Bill Item, in chronological order. The bottom part of the screen is a graphical rep-

resentation of the information in the top part of the dialog.

l By default, the graph will show sales in dollar amounts. To change the graph to

show quantity, click the Qty radio button above the Quantity column of the sales fig-

ures table near the top of the dialog. To change back to dollars, click the Sales radio

button.

l To print the Sales History exactly as it appears on screen, along with a summary of

this Bill Item’s settings, click the Print History button.

You can click on a month in the top list to alter the graph.  For example, if you click from

Mar 02 to Jul 02 and change the graph pop-down to 3 months, it will show 3 months starting with

Jul 02.
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Bill Item Notes
DVMAX uses Bill Item Notes to define standard messages to appear on Invoices and Estimates.

When a Bill Item Note is linked to a Bill Item, the text in the Bill Item Note will appear on any

Invoice or Estimate that includes the Bill Item.

Bill Item Notes make it easy for you to associate a single message with more than one Bill Item,

and to make sure that the same note does not appear more than once on an Invoice or Estimate.

This chapter tells you how to locate, create, modify and delete Bill Item Notes. For more infor-

mation on how to use Bill Item Notes in DVMAX, see Bill Items.

Viewing All Bill Item Notes
To see a list of all Bill Item Notes:

l Choose Inventory Management from the Section drop-down menu on the

DVMAX main screen.

l The Find window opens. Select Bill Item Notes from the Search For drop-

down list.

l Click All Records.

l A list of all Bill Item Notes displays.
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Finding a Bill Item Note
To find an existing Bill Item Note:

l Choose Inventory Management from the Section drop-down menu.

l The Find window opens.

l Select Bill Item Notes from the Search For drop-down list.
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l From the By drop-down list, choose one of Note Code, Description or Key-

word in Notes.

l Note Code will search all Note Codes for the code you’re looking for. Descrip-

tion will locate all Bill Item Notes who’s Description begins with the text

you’re looking for. Keyword in Notes will find all Bill Item Notes containing

the word you specify.

l Type a Note Code, Description or Keyword into the box below the By drop-

down list. If you do not know a complete code or are unsure of the spelling of a

Description or Keyword, type as much as you are sure of.

l Click Search. If there are multiple records matching your search criteria,

DVMAX will present them in a list. To view the Bill Item Note you are inter-

ested in, double-click it.

l If there is a single match for your search criteria, DVMAX will open the rec-

ord.
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l DVMAX will present an Alert dialog if there are no matches for your search.

l Click OK in this dialog to return to the Find window and search again.

Creating a New Bill Item Note
To create a new Bill Item Note record:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, select Bill Item Notes from the Search For drop-down

list.
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l Click Add New.

l A new Bill Item Note screen opens.

l Type a unique code for this Bill Item Note in the Note Code box. DVMAX will

use the code you type to identify this Bill Item Note. The code you type can be

no longer than 12 characters.

l Type a short description of this Bill Item Note in the Description box. The

description is the name of this Bill Item Note, and can be up to 80 characters

long.

l Type (or paste) the text of the Bill Item Note itself into the Note box. The text in

the Note box is what will be printed on Invoices or Estimates, and can be up to

32,000 characters (about ten pages) long.

DVMAX Practice V8.6 - User Manual



- 190 -

l Click OK to save the new Bill Item Note, or click Cancel to close the Bill Item

Note dialog without saving your new Bill Item Note record.

You can also create a new Bill Item Note by choosing Add New from the Bill Item Notes

drop-down menu when the Bill Item Notes record list is displayed. The Bill Item Notes menu is

available when you are viewing a list of Bill Item Notes. For more information on lists of Bill

Item Notes, see Finding a Bill Item Note and Viewing All Bill Item Notes.

Modifying a Bill Item Note Record
You can modify the description and text of any Bill Item Note record.

You should NOT modify the Note Code of a Bill Item Note. Doing so will cause problems

with any Bill Items currently using the Note.

To modify a Bill Item Note record:

l Locate the Note you wish to modify by following the procedures outlined in

Finding a Bill Item Note.

l Type the changes you wish to make in the Description and/or Note box.

l Click OK to save your changes, or click Cancel to discard your changes.

Deleting Bill Item Notes
Typically, you will have no need to delete a Bill Item Note; an unused Note has no adverse

effect on DVMAX.

Deleting a Bill Item Note record can affect Bill Items linked to the Note, and leave other

records in DVMAX incomplete. If you are unsure of the effects of deleting a Bill Item Note,

leave the Note record intact.

Deleting a Single Bill Item Note
To delete a single Bill Item Note:

l Locate and open the Bill Item Note you wish to delete by following the pro-

cedure outlined in Finding a Bill Item Note.

l Click Delete at the bottom of the Bill Item Note dialog. DVMAX will ask you

to confirm that you wish to delete this Note.
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l Click OK. DVMAX will warn you that deleting this Note record may affect

other parts of the system.

l If you are sure you wish to delete the Note, click OK. Otherwise, click Cancel

to leave the Note record intact.

Deleting Multiple Bill Item Notes
To delete multiple Bill Item Notes, you must be viewing a list of Bill Item Note records from

which you can then make a selection. To view a list of Bill Item Notes, follow the procedure out-

lined in Finding a Bill Item Note or Viewing All Bill Item Notes.

To delete multiple records from the Bill Item Note records list:

l From the records list, click to select the Bill Item Notes you wish to delete.

Press the SHIFT key while clicking to select multiple adjacent lines. Press the

CONTROL key (COMMAND on Macintosh) while clicking to select lines that

are not adjacent.

l Choose Delete Records from the Bill Item Notes drop-down menu.

l DVMAX will ask you to confirm that you wish to proceed.

l Click Delete. DVMAX will warn you that the delete action is permanent.
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l If you are sure you wish to proceed, click Delete. Otherwise, click Stop.
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Blood Analyzer Configuration

DVMAX works with a variety of in-house blood analyzers, providing the seamless integration of

test results to your patient records. This chapter describes how to configure DVMAX to work

with supported blood analyzers and provides vendor-specific setup procedures.  For more infor-

mation on working with analyzers and lab results, see the chapter Lab Requisitions and

Results.

Supported Analyzers
You can configure DVMAX to work with any of the following analyzers:

l Abaxis Vetscan VS2, VetScan, VetScan HMT, VetScan + HMT, Abaxis HM5,

Abaxsis VetScan HMTII

l Hemagen Analyst

l IDEXX VetTest, VetTest + VetCom, and VetTest + SnapReader

l Synermed

l Vet-ABC-Diff

l Heska Spotchem

l Heska CBC-Diff

l Heska Dry-Chem/Heska DCU

l HEMAVET

l IDEXX VetLab Station Serial

l IDEXX VetLab Station Network

Configuring Analyzers in DVMAX
To configure DVMAX to work with your analyzer:

l Choose Preferences from the File drop-down menu.

l The DVMAX Preferences dialog opens.

l Select the Lab Result Setup tab.

l Click the Set Analyzer button in the In-Office Analyzer section of the Lab

Results Setup tab.  A dialog appears to allow you to select your analyzer and
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port.

l From the Analyzer drop-down list, select your analyzer.

l Your analyzer is connected to DVMAX on a specific port. Click the Port drop-

down list and select your port. If you do not know the port, please contact

DVMAX technical support. The IDEXX VetLab Station Network will not

require you to specify a port because it is networked.

If you use a Serial to Ethernet adapter you will need to specify an IP address in Advanced

Settings.  Please contact DVMAX Technical Support for assistance.

l Click Select to save your analyzer settings and return to the Lab Results Setup

tab.

-OR-
l Click Cancel to return to the Lab Results Setup tab without changing your set-

tings.

l Click Start Analyzer in the In-Office Analyzer section to start the analyzer.

l Click OK to close Preferences and save your settings.

IDEXX VetLab Station
DVMAX integrates easily with the IDEXX VetLab Station. The VetLab Station can be either

Serial or Network. The IDEXX VetLab Station Network lets you manage requisitions (send,

resubmit, edit or cancel requisitions) to the VetLab and automatically receive results, sent

directly to the appropriate patient record.

To learn more about setting up lab requisitions for, and working with lab results received from,

the VetLab Network, refer to the chapter Lab Requisitions and Results.

Configuring the IDEXX VetLab Station Network
You will need to specify a Practice Management Network Connection to use the VetLab Net-

work Station.

l Connect the proper power cable to Dell PC

l Connect the monitor cable to Dell PC

l Connect the Lab Station mouse to Dell PC

l Connect the power supply to the Lab Station

l Connect the Lab Station to Dell PC with a USB cable

l Power on all machines.

l To enable DVMAX to work with the VetLab Station Network, you will need to

make sure the VetLab Station Practice Management Network Connection is

properly configured.
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l If it is not already enabled, from the Practice Management tab, Practice Man-

agement Software area, select the Other radio button. Then select Network.

Click Configure to specify the network settings. Select Autoconfigure, or to

work from a specified IP, select Direct Connect and enter the IP address. Be

sure to type DVMAX in the Integration Name field. 

l Configure DVMAX to read data from the VetLab Station Network. See Con-

figuring Analyzers in DVMAX for instructions. Note you will not need to

select a port for the networked connection. When a connection has been made,

an icon on the VetLab machine displays on the bottom of right the lab station

screen with the message “Ready”.

To learn more about setting up lab requisitions and working with lab results received from the

VetLab Network, refer to the chapter Lab Requisitions and Results.

Configuring the IDEXX VetLab Station Serial
To configure the IDEXX VetLab Station Serial to work with DVMAX:

Step 1: Connect and Power On All Machines:
l Connect the proper power cable to Dell PC

l Connect the monitor cable to Dell PC

l Connect the Lab Station mouse to Dell PC

l Connect the power supply to the Lab Station

l Connect the Lab Station to Dell PC with a USB cable

l Power on all machines.

l Configure DVMAX to read data from the VetLab Station Serial. See Con-

figuring Analyzers in DVMAX for instructions. When a connection has been

made, an icon for the machine displays on the bottom of the lab station screen

with the message “ready”.

Step 2: Set Preferences on the Lab Station:
l Click the Settings button.

l Click the Practice Management tab.

l Click to select the Other radio button. Serial is selected by default.

l Click OK.

l Click the Instruments button.

l Click the Practice Management tab.

l Click the On (Records Will be Transmitted) radio button in the Transmit Rec-

ords area of the screen.

l Click OK.

To run a sample on the IDEXX Lab Station:
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l Insert Sample into the Lab Station.

l Click the Sample button on the instrument screen. The Identify Sample screen

appears.

l Enter Client information (ID, Last Name, First Name, Requisition ID) on the

Identify Sample screen.

l Enter Patient information (Name, Species) on the Identify Sample screen.

Existing (previous) client information can be accessed by choosing a client ID from the Client

ID drop-down list.

l On the Run Sample screen, select the Lab Station/ProCyte/LaserCyte check-

box under Instruments to Run.

l Click to select a Reason for Testing.

l Click OK.

l The Lab Station will start analysis – the machine will beep. When the sample is

complete, a results screen will appear. You can you choose to print, view,

change or delete results.

l Results will be automatically displayed in DVMAX and will be added to the

Patient history.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

Abaxis Vetscan VS2 Chemistry Analyzer
The Vetscan VS2 Chemistry Analyzer provides quantitative in-vitro determinations of clinical

chemistry analytes in heparinized whole blood, heparinized plasma, or serum.

The Vetscan VS2 Chemistry Analyzer is equipped to transmit patient and control results in

eight-bit, ASCII format to a computer through the USB serial port. To receive the results from

the VS2, a computer requires terminal emulation software, such as HyperTerminal, which is

included with Windows 95 and higher. The computer also requires driver software to com-

municate with the VS2. The driver software is available on the VS2’s accompanying CD.

For more information, go to http://www.abaxis.com.

Setting up the VS2 Analyzer

To set up the VS2 analyzer:
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l Turn on the computer, and insert the Abaxis Driver CD into the CD drive. 

l DO NOT connect the analyzer to the computer yet.

l For PCs, run the Abaxis Driver Setup.exe in the Win2K_XP folder.

l For Macs, browse to the CD drive and run FTDIUSBSerialDriver_vX_X_

X.dmg in the Mac\Intel folder for Intel-based Macs, or run FTDI-

USBSerialDriver_vX_X_X.dmg in the Mac\PPC folder for PowerPC-based

Macs.

l Follow the installer instructions. Wait for the installer to complete.  Click OK.

l Plug the power jack into the analyzer, and plug the detached power supply cord

into the power adapter and into a grounded electrical outlet.

l Connect the USB cable to a Type A connector on the computer and to the upper-

most USB connector (Type B) on the back of the analyzer.

l Turn on the analyzer.  Wait for the computer to recognize the analyzer. This

may take a few minutes.

l Press the power button to turn on the analyzer. A spiral image will be displayed.

l The analyzer goes through a warming up period.  After passing the self-test and

reaching operating temperature, the analyzer is ready to run the first reagent

rotor, and displays “Analyze”.

Configuring HEMAVET CDC Mascot
To configure the HEMAVET analyzer to work with DVMAX:

l Attach modem cable to the back of the machine, and to the computer.

l Attach the power cable to the machine.

l Turn on the power switch at the side of the machine.

To run a test on the CDC Mascot:

l The HEMAVET CDC Mascot has been set up with one file in memory for the pur-

pose of re-transmitting data as an initial test.  DO NOT press the Start key. This

will run a cycle and the data will be lost.

To re-transmit data from the last sample run, on the analyzer keypad, press the following key

sequence:

l 9 SPECL

l Then press 7 (Diagnostics)

l Press 3 (DMS)

l Press 1 (Initialize)

l Press 2 (Send)
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You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

Configuring the Abaxis HM5
Support has been added for the Abaxis HM5 blood cell count machine.

For configuration details, please contact DVMAX technical support.  Error conditions do

not get added to the graph, they only appear in the main result.

Configuring the Abaxis VetScan Chemistry System
The VetScan Chemistry System provides quantitative in vitro determinations of clinical chem-

istry analytes in heparinized whole blood, heparinized plasma, or serum.

To configure this device to work with DVMAX:

l Connect the analyzer and your computer with a Straight Through Cable.

l Configure your analyzer for auto-transmission. Press the Recall button on the

unit’s keypad.

l Press 1, then press Enter.

l Press 2, then press Enter.

l Choose Results, then press Enter to test your configuration.

l Test Results will appear on your computer screen.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

Configuring the Abaxis VetScan HMT Hematology Analyzer
VetScan HMT Hematology is a fully automated system for complete blood count (CBC) of

white blood cells, red blood cells, and platelets in whole blood in a veterinary setting.

To configure this device to work with DVMAX:

l Plug the device into an electrical outlet and turn on the power.

l Insert an HMT card into the slot on the side of the analyzer.

l Select your preferences. Press the Menu button on the front of the unit.

l Use the arrows on the front of the unit to select SYSTEM on the unit’s screen.

l Press the Enter button on the front of the unit.

l Use the arrows on the front of the unit to select COMMUNICATIONS on the

unit’s screen.

l Press the Enter button on the front of the unit.
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l Select a Baud rate of 9600.

l Select a Data rate of 8 bit.

l Set Parity to NONE.

l Set Data Out to NONE.

l Press the Exit button to return to the main menu.

l Insert the provided NULL modem cable (Serial Cable) into the Computer port

(2nd from top) on the side of analyzer.

l Attach the other end of the cable to your computer.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

To run a sample:

l Put the blood sample in the analyzer.

l Press the Analysis (Test Tube) button on the front of the analyzer.

l Enter patient codes.

l Press Enter to start the analysis.

l Press Enter to validate.

l When the analysis is complete, a printout will appear, and results will display on

the monitor.

Configuring the Abaxis VetScan HMTII Hematology Analyzer
To configure this device to work with DVMAX:

l On the back of the analyzer, hook up all the appropriate hoses to the associated

Hematology Reagent Pack. See HMII Owners manual.

l Attach null modem serial cable to the port labeled Serial on the analyzer, and

then to the serial port on your computer.  Contact DVMAX Technical Support

for assistance on selecting a port if needed.

If you use a Serial to Ethernet adapter you will need to specify an IP address in Advanced

Settings.  Please contact DVMAX Technical Support for assistance.

l Attach the power cable and plug it into the power outlet.

l Turn on power switch.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

To run a test on the VetScan HMTII:
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l Select the test tube button on the keypad at the front of the analyzer.

l Put a sample in the tray.

l Start analysis by selecting the Start button.

l Once the analysis has finished, the results will be displayed on the analyzer

screen.

l The results will also be displayed in DVMAX.

Configuring the Hemagen Analyst
The Hemagen Analyst provides a profile, panel and single results in 10 minutes for Glucose,

BUN, creatinine, BUN/creatinine ratio, uric acid, cholesterol, triglyceride, GOT, total bilirubin,

Alkaline phosphatase, GPT, GGT, calcium, total protein and amylase.

For configuration details, please contact DVMAX Technical Support.

Configuring the Heska CBC Diff Veterinary Hematology System
To configure this device to work with DVMAX:

l Make sure the unit is powered down, and insert a serial cable into the back.

l Plug in the power cable. Turn on the power.

l Set your preferences. On the menu pad, press Menu. This brings up the main

menu.

l Use the arrow keys to move down to item 5, “Setup Menu”. Press the Enter but-

ton.

l Use the arrow keys to move down to item 5.10, “Setup menu 2”. Press the

Enter button.

l Use the arrow keys to move down to item 5.10.5, “Serial Port Setup ”. Press the

Enter button.

l Select the following options: Baud 9600, Parity = N, Databits = 8, Stopbits = 1,

HW-handshake = y. Press the Enter button.

l Press Main to return to the main menu.

l On the main menu, set autoprint mode to 6.

l On the main menu, set print key function to 6.

l On the main menu, set print format to 18.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.
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Configuring the Heska Dri Chem (Heska DCU)

For configuration details, please contact DVMAX Technical Support.  Visit Heska product

support online at http://www.heska.com/Products/Lab-Systems.aspx for more details on con-

figuring this instrument..

Configuring the Heska Spotchem EZ Dry Chemistry System
To configure this device to work with DVMAX:

l Connect cable to analyzer and computer. The end of the cable that resembles a

telephone jack plugs into the back of your Spotchem EZ analyzer. The opposite

end (large silver block) attaches to the serial port on the back of your computer.

l Configure the analyzer. Ensure that the Main Menu on the analyzer displays “1,

2, 3”.

l Press MENU & STOP together.

l At the password prompt, press the -/. key.

l Type in 4430, and then press -/. again.

l Press Enter.

l Press the 2 key (Submenu), 6 key (Setup), and then the 3 key

(Communication)

l Press -/. to toggle function to "ON", then press ENTER.

l Press -/. to toggle format to "1", then press ENTER.

l Press -/. to toggle Baud  to "9600", then press ENTER.

l ID format is displayed. Press ENTER.

l When the menu reappears, press STOP several times to "Back to USER

MODE?"

l Press the START button.

l The analyzer will do a brief initialization.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

Configuring the IDEXX VetTest
To configure this device to work with DVMAX:

Step 1: Insert the software disk

l Make sure the analyzer is OFF

l Remove the disk cover at the back of the analyzer.
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l Push the black button to eject any disk that may be in the drive.

l Insert software disk into drive.

l Replace cover to prevent inadvertent ejection of disk.

Step 2: Connect the serial cable to the computer

l To connect directly to the computer, use the serial cable marked IDEEX VetTest –

D. To connect to the VetCom multiplexing Device, use the serial cablemarked

IDEEX VetTest – S

l Connect the appropriate serial cable to the serial port on the back of the

analyzer, labeled RS232.

l Attach other end of cable into the computer for direct connections, or into the

port labeled VetTest for connecting to the VetCom.

If you use a Serial to Ethernet adapter you will need to specify an IP address in Advanced

Settings.  Please contact DVMAX Technical Support for assistance.

Step 3: Turn on the power

l Insert the female end of the power cord into the back of the VetTest, in the port

marked “Power.”

l Plug the male end of the power cord into a wall outlet or power bar.

l Turn on the analyzer.

l The analyzer will run through a series of self-checking procedures, which last

for two minutes. The analyzer will then begin its warm-up procedure to reach

the correct operating temperature. This will normally take 25 minutes.

Step 4: Check settings.

l After warm up, the main menu will appear.

l Select “5. Settings”.

l Select “7. Data Transfer choices”.

l Select “4. Transmission Control”.

l The next screen will present you with “2. Disable Transmission” or “Enable

Transmission”.  Make sure the option “2. Disable transmission” is visible. This

actually means that “2. Enable Transmission” is currently selected.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.

To run a test sample

l Press 1 on the keypad to enter New Sample.

l Follow the prompts to enter patient information.

l Place pipettor tip in sample and press button. You will hear one (1) beep.
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l When you hear two (2) beeps, remove pipettor from the sample.

l At three (3) beeps, wipe off tip.

l Examine the tip, and place the pipettor back in the analyzer.  The rest of the test-

ing occurs automatically.

Configuring the Vet ABC Hematology Analyzer

Step 1. Hook up cables
l Attach the power cord to the outlet in the back of the analyzer.

l Attach the printer cable to the back of the analyzer.

l Using a Keyspan cable adapter, connect the printer cable to your computer.

Step 2. Turn on analyzer
l Switch the analyzer on by pressing the ON/OFF (I/O) switch on the back of the

analyzer.

l When first switched on, the analyzer goes into a warm-up period followed by an

automatic STARTUP cycle. The STARTUP should be interrupted to make pref-

erence settings.

l To stop the STARTUP, hit the Esc button until you are given a new menu.

Select Yes using the Enter button.

Step 3. Set analyzer preferences
By default, the analyzer will search for a printer. If this setting is not changed, an error will

occur and the analyzer will be unable to send results to DVMAX. To change this setting, use the

Up and Down arrow buttons from analyzer’s main menu to:

l Select 5. Setup, then Enter

l In Setup menu select, 1. Results, then Enter

l In Results menu select, 4. Printer, then Enter

l In Printer menu select, 5. None, then Enter

l Hit ESC until you get back out to the Main Menu

Step 4. Setup DVMAX
l Launch DVMAX

l From the file menu, select preferences

l From the lab results tab select Set analyzer

l Select analyzer: Vet ABC_Diff

l Select port to be used

l Select Start analysis
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Step 5. Restart DVMAX
To complete the setup, restart DVMAX.

You can configure DVMAX to read data from your analyzer. See Configuring Analyzers in

DVMAX for instructions.

An illustrated tutorial on this topic is available under Support on the DVMAX website at

www.dvmax.com.
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Boarding
The DVMAX Boarding facility lets you schedule patients for boarding. The Boarding facility

was completely redesigned in DVMAX v7.5 to make it a web-based interface, greatly increas-

ing the flexibility of the boarding functions. Boarding is typically used to reserve or “book” a

cage for a patient for a term ranging from a few hours (such as following a surgical procedure)

to several days (as with formal boarding of the pet if owner is away).  You can schedule board-

ing from a patient record or directly from the Boarding facility.

You will need to set up the Boarding facility before you can use the Boarding functionality for

the first time.

Setting Up Boarding: An Overview
Before you can use the Boarding facility for the first time, you need to specify Rooms and Cages

within those rooms where animals can be boarded, as well as a few other details. Boarding

Setup is found on the Boarding facility by clicking the Setup button in the top left corner of the

Boarding window.

As a general overview, the steps you follow to set up boarding are listed below. Refer to the

applicable section for more detail.

To set up Boarding:

l Open the Boarding facility by clicking the Boarding icon from the Command

Palette or select Boarding from the Section drop-down menu.

l From Boarding select Setup in the top left corner of the Boarding window.

l From the Setup tabbed window, choose the Settings tab. This is the default dis-

play when you open Boarding Setup. Depending on your user configuration, you

may not have access to the Setup functionality.

l Set the boarding label format for short-term (Events Under One Day) and

longer-term (Events Over One Day) boarding appointments.  This is the label

that will show on any boarding or boarding reservations you schedule.  The

default is Patient Name: Check In Time/Date, Check Out Time/Date.

l In the Options area, set the default # Days Forward to display. This determines

how many days forward from the current date will show in the Boarding grid in

the standard Days view. The default value is 365 days, which allows you to

view the next 365 days in the boarding schedule (using the horizontal scroll bar).

l In the Options area, set the default # Days Back to display. This determines

how many days back from the current date will show in the Boarding grid in the

standard Days view. The default value is 7 days, which allows you to view the

previous 7 days in the boarding schedule (using the horizontal scroll bar).
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l In the Options area, select the default status to display when a boarding is

created.

l Select Prompt for Boarding for In-Hospital Patients if you wish DVMAX to

prompt for boarding from a patient record when a patient status is changed in the

record to “In Hospital”.

l Define at least one Boarding Status type in the Status Values area.  Examples

of boarding values include Reserved or Arrived.

l From the Setup tabbed window, choose the Rooms & Cages tab.

l Add at least one Room (see Boarding Setup: Add a Ward or Room for more

information). A room or ward is a group name under which one or more cages

can be added. Patients cannot be boarded in a room, only in cages linked to a

room.

l Add Cages to a Room.

l Close the Boarding Setup window.

l The changes you make to boarding setup will be available to all workstations run-

ning DVMAX.

Boarding Setup: Settings
The Boarding Settings tab under Setup includes 3 main sections: Event Format, Options and

Status Values.  The Event Values area is where you set the boarding label format for short-

term and longer-term boarding appointments. 
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In the Options area, you set the default Days to Display (Forward and Back), set the default

status for new boarding appointments, determine if you want DVMAX to prompt for boarding

for a patient with status “In-Hospital”. Under the Status Values area, you need to define board-

ing Status types. These values are used when scheduling boarding and color code the boarding

appointments so you can see at a glance what types of boarding appointments are scheduled, as

well as the Check-In status of the boarding appointment.

Boarding Setup: Event Format (Boarding Label)
Set the boarding label format for short-term (Events Under One Day) and longer-term (Events

Over One Day) boarding appointments.  These are the labels that will show on any boarding or

boarding reservations you schedule.

Events Under One Day are considered short term boarding appointments. The default label for

these types of boarding appointments is Patient Name: Check In Time, Check Out Time. The

boarding label on the Boarding grid will show a patient’s name and the time of day they check in

and check out. You can add or remove items from the label using the options shown on the lower

part of the Events area. See Boarding Appointment Label Options for a description of the

options.

Events Over One Day are considered long term boarding appointments. The default label is

Patient Name: Check In Date, Check Out Date. The boarding label on the Boarding grid will

show a patient’s name and the date they check in and date check out. You can add or remove

items from the label using the options shown on the lower part of the Events area. See Boarding

Appointment Label Options for a description of the options.

Boarding Appointment Label Options
You can use any of the follow options in the boarding appointment (or event) label. Keep in mind

that space is limited, especially on short term boarding appointments, so you may not be able to

see the full label.

l Patient name – use the format {Patient}

l Client name – use the format {Client}

l Boarding start date - use the format {StartDate}

l Boarding start time - use the format {StartTime}

l Boarding end date - use the format {EndDate}

l Boarding end time - use the format {EndTime}

l Boarding status - use the format {Status}

To create a boarding label:

l From the label options listed above, select what items you want to appear in the

boarding label.  Keep in mind that depending on the length of the boarding and

the Boarding grid display, you may have very limited space in the label.

l Using the format listed above, add any of the 7 label options.  You may separate

the label options with spaces (<SPACEBAR>), commas (“,”) or colons (“:”).
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l The default labels are {Patient}: {StartTime}{EndTime} and {Patient}: {Start-

Date}{EndDate}.

Boarding Setup: Default Days to Display
In the Options area, type a number of days in the # Days Forward and # Days Back fields, or

use the Up/Down arrows beside the field to increase or decrease the default value.  This deter-

mines how many days will show in the boarding grid in the standard Days view.

Boarding: Number of Days Forward
The default # Days Forward value is 365 days, which allows you to view the next 365 days,

beginning with the current date, in the boarding schedule. A horizontal scroll bar will display in

the bottom of your browser window if the number of days you select does not fit in the browser

window.

If # Days Forward is set to a large number, switching from Days view to another view,

such as Hours, may prompt an alert from DVMAX that the date range displayed has been

adjusted. This is because you may be requesting DVMAX display a very large number of cells

in the boarding grid and that could take a significant amount of time to generate. For example,

displaying 365 days of boarding data, broken down by hours (365days x 24hrs) for every cage in

boarding could result in a massive boarding grid with hundreds of thousands of cells. If this

happens, DVMAX will display a notice that the view user is trying to display is too complex and

adjusts the date range to make the display work.

Boarding: Number of Days Back
The default # Days Back value is 7 days, which allows you to view the previous 7 days, begin-

ning with the current date, in the boarding schedule. A horizontal scroll bar will display in the

bottom of your browser window if the number of days you select does not fit in the browser win-

dow.

Remember that this setting will provide a default boarding display that does NOT begin

with the current date. The leftmost column in Day View will be 7 days back from the current

day. Keep this in mind when drawing in a boarding reservation so that you create the boarding

for the correct date.

Boarding Setup: Default Status
From the Default Status drop down list, select the default status to display when a boarding is

created. There are 3 pre-defined status values: Reserved, Arrived and Cancelled. Under the

Status Values area of Boarding Setup -> Settings tab you can add, edit or delete status values.
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Boarding Setup: Status Values
Boarding Status values define the status of a scheduled boarding appointment. You can assign a

status to a new boarding type when you schedule the boarding. The status is associated with a

selected color and icon (if defined) on the boarding grid so you can see at-a-glance the status of

boarding appointments you have scheduled. For example, you could create a boarding status of

Reserved that you can apply to upcoming boarding appointments, letting you know what cages

are reserved and when. When a patient arrives for the boarding, you can change the status to

Arrived, indicating that the cage is now occupied.

Status values are available from the Status drop-down menu when creating a new boarding

appointment for a patient. If you do not define any status values, this field will not be visible.

To add Status Values:

l From the Status Values area, click Add.

l In the Status field, type a name for the status. For example, Reserved.

l In the Text Color field, select a text color for this boarding type from the Text

Color drop-down menu.

l In the Color field, select a block or cell color for the boarding appointment type

from the Color drop-down menu.

l In the Icon field, select an icon for this boarding type from the Icon drop-down

menu. You can choose No Icon (no icon will display), Checkmark (a checkmark

will display on the new boarding appointment), Cancel (an “X” icon will show

on the new boarding appointment) or Exclamation Point (an exclamation mark.

“!”, will show on the new boarding appointment).

l Click Update to save the Status Value.

Boarding Setup: Prompt For In-Hospital Patients
If the Prompt for Boarding for 'In Hospital' Patients" checkbox is selected, the Boarding

Cage dialog is displayed when assigning In-Hospital status to a patient from the patient record.

If it is not checked then the Boarding Cage dialog is not displayed when “In-Hospital” status is

added to a patient record.
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Boarding Setup: Rooms & Cages
Before you can use the Boarding facility for the first time, you need to specify Rooms and Cages

within those rooms where animals can be boarded. 

Boarding Setup: Add a Room
A Room provides a group heading to which one or more cages can be assigned. It does not have

to be an actual physical room. The Room designation allows you to group a set of cages for use

by animals of a certain species, weight, or other criteria. For example, you may have a number

of cages in your facility that are used specifically for small canines. You could create a Room

named Small Dog Room and then define which cages in your facility are designated as part of

that room.

Quotation marks are not permitted in Room and Cage names. If you use them, they will be

stripped from the name when the Room or Cage name is saved.

Room and Cage Code Essentials
A Room must be given a Code number, and cages are assigned Codes that are associated

with the Room Code.  The Room and Cage codes must be in a specific format.

Room Codes: Rooms Codes must be numbered 1000-999000, where each Room Code has 3 trail-

ing zeros.  Start your numbering at room 1000, then 2000, 3000, 4000, 5000, etc. 

Cage Codes: The Room to which Cages are linked can be easily identified because the Cage

Code will begin with the same number as the Room Code.  For example, all cage codes asso-

ciated with Room Code 1000 would fall between 1001 and 1999; all cage codes linked to room

code 2000 would fall between 2001 and 2999, etc. 

Even if you do not have many rooms or cages, you need to use this Code format.
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To Add a Room:

l Open the Boarding facility by clicking the Boarding icon from the Command

Palette or select Boarding from the Section drop-down menu.

l From Boarding select Setup (the Tool icon) in the top left corner of the Board-

ing window.

l From the Setup tabbed window, choose the Rooms & Cages tab.

l Under the Room(s) area in the Rooms & Cages window, click Add.

l In the Room Code field, type the Room Code using the format described under

Room and Cage Code Essentials. 

You must use the format as described under Room and Cage Code Essentials.

l Type a name for the room in the Room Name field.

l Click Update to save the Room. The room will appear in the Rooms drop-down

menu when scheduling a new boarding.

The name you give to the Room can help you to select the most appropriate Room (and asso-

ciated cage) in which to board an animal. Try to select a Room name that accurately reflects the

species (and possibly size or weight) of animal you expect to house in that area. For example,

the name Dog Ward indicates that this Room contains cages for canines.
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View or Edit a Room
To view or edit a Room:

l From the Rooms & Cages window, double click a room name on the Rooms

list.

l Make any changes, as needed.

l Click Update to save the changes to the Room.

Delete a Ward/Room
l From the Rooms & Cages window, click the room on the Rooms list that you

want to delete.

l Click Delete.

l Click OK from the Confirm window to delete the Room.

A Room cannot be deleted if it has associated Cages. You must delete the Cages first, mov-

ing or deleting any scheduled boarding for those cages, then you can delete the Room.

Boarding Setup: Add a Cage
To add a cage:

l Open the Boarding facility by clicking the Boarding icon from the Command

Palette or select Boarding from the Section drop-down menu.

l From Boarding select Setup (the Tool icon) in the top left corner of the Board-

ing window.

l From the Setup tabbed window, choose the Rooms & Cages tab.

l On the Room list, click to select a Room group under which the cage will be

created.

l If no cages have been defined for the selected Room, the Cages list area will be

empty.

l If cages have already been created for that Room, the associated cage list will

display in the Cages list area.

l To add a new cage to the selected Room, click Add under the Cages list area.
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l Type a Code number for the Cage in the Code field using the format described

under Room and Cage Code Essentials. 

You must use the format as described under Room and Cage Code Essentials.

l Type a name for the cage in the Name field.

l Type a number to determine the cage sort order in the Order field. The lower

the number, the higher up in the default sort order the cage will appear.

l From the Species drop-down list, choose which species you want to allow to

board in the selected cage. By default, all species are selected. If you wish to

place restrictions on the species of animal that can be boarded in the cage, click

to deselect each species you want removed from the allowed list. Those species

marked with a bullet can be selected for boarding. Click to select and deselect

any species on the list.
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l In the Max Weight field type a maximum allowable weight (in lbs) for any

animal boarded in the selected cage. Setting a maximum weight allows you to

place restrictions on the size of animal that can be boarded in the cage. If you do

not wish to set any restrictions on the cage, use the defaultMax Weight value

of 0. This will allow an animal of any weight to be booked in the cage.

l Click Update to save the cage. The cage will appear in the Cages drop-down

menu when scheduling a new boarding once the Room under which the cage is

defined is selected.

l Continue the Add Cage process until all cages have been created.

The name you give to each cage can help you later when selecting the most appropriate

cage in which to board an animal. Consider choosing Cage names that accurately reflect the spe-

cies (and possibly size or weight) of the animals you expect to board in those cages. For exam-

ple, the name Large Dog Cage indicates that this cage can house larger canines. 

Quotation marks are not permitted in Room and Cage names. If you use them, they will be

stripped from the name when the Room or Cage name is saved.

View or Edit a Cage
To view or edit a Cage:

l From the Rooms list, click to select the Room under which the Cage you want to

view or edit is grouped.

l Under the Cages list area, double click on the cage you want to edit.

l Modify the cage details as needed.

l Click Update to save changes.

Delete a Cage
l From the Rooms list, click to select the Room under which the Cage you want to

view or edit is grouped.

l Under the Cages list area, click on the cage you want to delete.
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l Click Delete.

l Click OK from the Confirm window to delete.

If there is a current or scheduled boarding for the cage you are trying to delete,

you will need to move the boarding to another cage before you can delete the selected

cage.

Opening the Boarding Facility
To open the Boarding window:

l From the Section drop-down menu, choose Boarding.

-OR-
l Click the Boarding icon on the Command Palette.

-OR-
l From the Patient drop-down menu in a patient record, choose Set/Find Board-

ing.

About the Boarding Window
The Boarding schedule is a grid, where columns are a time period (hours or days, depending on

the view you have selected), and rows represent Room and associated Cages.  Scheduled board-

ing shows in Cage rows only. For more information about the various sections of the Boarding

schedule, see the related topics in this Boarding chapter.

Defining the Default Browser for Boarding
The default browser in which Boarding and Appointments opens is specified under File -> Pref-

erences on the DVMAX main window. To set the default browser for Boarding:

l From the File menu on the DVMAX main window, choose Preferences.

l From Preferences, choose the Assorted Prefs tab.
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l In the Appointment Scheduler/Boarding area, use the drop down menu to select

the browser you would like DVMAX to use to open Boarding and Appoint-

ments. DVMAX uses your computer system’s default browser as the default

selection.

View a Room and Associated Cages
A room is defined in DVMAX as the group name under which there exists one or more asso-

ciated cages. When scheduling a boarding, a patient is booked in to a cage within a selected

room.

The default view displays the Boarding schedule with rooms and cages. Rooms and Cages are

listed in the Cage column of the Boarding window. Rooms are indicated with a small box before

the room name and the room name is in a bold font.

To hide cages associated with a room:

l Click the small box beside the room name to hide the cages associated with that

room.

l To view cage rows, click the small box beside Room name again.

l If rooms are hidden, the small box will have a plus (“+”) sign in the box. If the

rooms are already displayed, the small box will have a minus (“-“) sign in the

box.

Color Coding on the Boarding Schedule
The Boarding schedule uses a color-coding scheme to assist you with reading cage availability,

boarding status and the duration of boarding appointments.

Cages and Scheduled Boarding
Rows representing individual cages are white. Within these rows, a scheduled boarding appears

as a colored bar that extends the length of the scheduled boarding, as defined by the display type

on the boarding grid (Hours, Days, Weeks, etc.).

The length of the line represents the duration of the scheduled boarding. As with Appointments,

the details on the scheduled boarding are defined under setup. See the Boarding Setup sections

in this Boarding chapter for more information. Double click a scheduled boarding to view board-

ing details for that patient.
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Room and Cage Availability Indicator
Current space availability in the cages associated with a room or ward is indicated by levels of

grey shading.  The deeper the shade of grey, the more full the cages.

Boarding Schedule Display Type
The Boarding schedule can be displayed using Hours, Days, Weeks or Months view. The default

view is Days. The number of days displayed forward (ahead of the current date) and back

(before the current date) is defined under Boarding Setup.

To change the view

l Click to select the display setting you prefer from the selection at the top of the

Boarding window.

The view selection is:

l Hours – The Hours view displays the schedule of boarders over a 24 hour

period.

l Days – The Days view displays the schedule of boarders over a set number of

days.  The default number of days forward, configured under Boarding Setup, is

365. The default number of days back is 7. You can change the default number

of days under Setup, or use the Start Date and End Date calendars at the top

of the Boarding window to adjust the selection.

l Weekly – The Weeks view displays the schedule for a 6-week period from the

current week.

l Months– The Months view displays the schedule for a 12-month period from

the current month.

Switching from one view to another view, such as from Days to Hours, may prompt an

alert from DVMAX that the date range displayed has been adjusted. This is because you may be

requesting DVMAX display a very large number of cells in the boarding grid and that could take

a significant amount of time to generate. For example, displaying 365 days of boarding data (the

default number of days forward displayed. See Boarding Setup for more on this setting.),

broken down by hours (365days x 24hrs) for every cage in boarding could result in a massive

boarding grid with hundreds of thousands of cells. If this happens, DVMAX will display a notice

that the view user is trying to display is too complex and adjusts the date range to make the dis-

play work.

Print Boarding
DVMAX allows you to print 3 different boarding options from the Boarding Scheduler:

1. Check In - A report of all patients checking in on a specified date.

2. Check Out – A report of all patients checking out on a specified date

3. Is Boarding – A report of all patients in boarding on a specified date.

To print a boarding:
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l From the Boarding schedule window, click the Print icon found in the top left

corner of the window.

l Select Check In, Check Out or Is Boarding, depending on the report you wish

to print.

l Type a start date and end date in the Date fields, or select a date range using the

Calendar icons.

l Click OK to print.

See also Boarding Reports.

Add New Boarding
You can add a new boarding from a patient record or directly from the Boarding window. The

following is an overview of the steps involved in scheduling a new boarding. See the related top-

ics in this section for more information on a particular step.

Add Boarding from a Patient Record (Set/Find Boarding)
To add a new boarding from a patient record:

l Open the record for the patient for whom you wish to schedule boarding.

l From the Patient drop-down menu, click Set/Find Boarding.

l The Boarding scheduler opens. From the Boarding window, click and drag

across the area where you would like to schedule the new boarding. This means

you need to find the Room and Cage area where you want to place the boarding

as well as finding the appropriate date for the boarding.

l The Boarding detail dialog opens. The patient name will be pre-filled. The date

range will correspond to the date(s) in which you created the record using the

click and drag motion. The date range can be manually adjusted using the

Check In and Check Out fields. Complete any other boarding details as

needed.

Add Boarding from the Boarding Scheduler
You can either create the new boarding appointment by using the click and drag method, or you

can open the Boarding Detail dialog and edit the details to create the boarding record.

To add new boarding from the Boarding window using click and drag:

l From the Boarding window, click and drag across the area where you would

like to schedule the new boarding. This means you need to find the Room

and Cage area where you want to place the boarding as well as finding the

appropriate date for the boarding.

l From the Boarding details dialog, select the patient for which you want to

schedule the boarding. The patients list will only display if you are adding

boarding directly from the boarding window. If you add boarding from a

Patient record, the patient and client details will display automatically in the

Boarding detail window.
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l Note that only patients whose species type and weight is allowed to be

boarded in the selected cage will be listed in the Patients list area of the

Boarding details dialog.

l Use the Patient and Client filters at the top of the Boarding detail window to

find the Patient for which you would like to schedule boarding.

l Complete the boarding details as needed.

To add a new boarding appointment from the Boarding Detail dialog:

If you try to add boarding for a patient marked as Deceased, you will get a message alerting

you to this.

l You will need to click and drag on any open space on the Boarding scheduler to

open the Boarding dialog. Remember that only patients whose species type and

weight is allowed to be boarded in the selected cage will be listed in the Patients

list area of the Boarding details dialog.

l In the Client and Patient area, select the patient for which you would like to

schedule the boarding.

l If desired, select a status type for this boarding. Status types are defined under

Setup.

l From the Boarding dialog select a Check In date and time.

l Select a Check Out date and time.

l Select a Room and Cage from the drop-down lists.

l If the patient record shows the patient is hospitalized, the In Hospital box

should be marked. If needed, select In Hospital. Click Reason to type or view

the reason for hospitalization.

l Click Add Comments to type any additional notes about the selected patient, as

needed.

l Click OK to schedule the boarding and return to the main Boarding window. The

new boarding will show on the schedule under the room and cage you selected.

AutoBook from the Boarding Scheduler

AutoBook is a time saving feature that allows busy boarding facilities to quickly find and book

boarding times within a packed boarding schedule. The AutoBook feature identifies open cage

times for a specified time period by species and cage size.

To add a new boarding using the AutoBook feature:

l Open the Boarding Scheduler.

l Click AutoBook. The AutoBook button is located under the tab bar next to the

Print button.
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l The AutoBook dialog displays.

l Identify desired Check In and CheckOut times and dates.

l Select the Room/Ward to identify species and boarding requirements.

Note: the default Room/Ward value is for Avian boarding. The booking will not proceed if the

booked patient is not an Avian within the default size restrictions.

l The Boarding window displays. Select a patient from the Patient menu.

l Make any edits required and click OK to schedule the boarding and return to the

main Boarding window.

l The new boarding will show on the schedule in an available open cage within

the room selected and for the date/time specified.

Setting the Status Type for Boarding
Boarding Status values provide a quick means of determining the status of boarding appointments

you have scheduled. You can assign a status to a new boarding type when you schedule the

boarding. The status is associated with a specified color on the boarding grid so you can see at-

a-glance what types of boarding appointments you have at your facility. For example, you could

create a boarding status of Reserved that you can apply to upcoming boarding appointments, let-

ting you know what cages are reserved and when.

To set a status for a new boarding:

l From the Boarding Detail dialog, select a status from the Status drop-down

menu. This status will affect the color, font color and icon (if any) displayed

on the boarding grid for this boarding appointment.
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Setting the Check In and Check Out Date and Time
Check In is the date and time at which you expect the patient to be admitted to boarding (when

the selected cage will be occupied). Check Out is the date and time when the patient is sched-

uled to be “picked up”, or when boarding ends.  The Check In and Check Out time will define

the duration of the boarding, and will be indicated by green and red markers respectively on the

Boarding window.

To set the Check In and Check Out date and time:

l From the Boarding Detail dialog, type a Check In date or click the Calendar

icon and select a date. The default setting is the current date.

l Select a Check In time from the drop-down menu or type a Check In time

(HH:MM), using a 12-hour clock, and type AM or PM. The default time is

defined under Setup. See Boarding Setup for more on this default value.

l Type a Check Out date or click the Calendar icon and select a date.

l Select a Check Out time from the drop-down menu or type a Check Out time

(HH:MM), using a 12-hour clock, and type AM or PM. The default time is

defined under Setup. See Boarding Setup for more on this default value.

l If you typed a Check In and Check Out date, the Total Duration of the board-

ing, in days, will be calculated automatically.

l If you prefer, you can type a Check In date, then type a duration in days in the

Duration field. The Check Out date will be automatically updated. You will

still need to modify the Check Out time, if different than the default time.

Selecting a Room and Cage
To schedule boarding, you need to select a cage in which the patient is to be boarded.  This

involves selecting an appropriate room or ward, then choosing a cage from within that room.

(See also, Boarding Setup: Rooms and Cages for more information).

Species and weight restrictions can be placed on cages under Cage Setup. Therefore, only those

cages suited to the species and weight of the animal will be available as options.

To select a room and cage:
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l From the Room drop-down list, select a room. The Room is the name under

which a set of cages has been grouped.

l Select a cage from the Cage drop-down list. By default, only Open Cages

(those not already booked for the selected dates) are shown. To display a list of

all cages associated with a room, even those which may already be occupied or

booked, choose All Cages. Any species and weight restrictions on cages (as

defined under Cage Setup) will still limit the cage options displayed.

Boarding: Patient “In Hospital” Status
If the animal for which you are scheduling boarding is currently in hospital, this should be indi-

cated on the Status field on the patient record. In that case, the In Hospital status should also be

indicated on the Boarding detail window.

To mark the patient as In Hospital from the Boarding window:

l On the Boarding detail window, select In Hospital. Click again to deselect.

l Type a reason for hospitalization in the text area as needed.

Additional Comments
To make any additional boarding notes for the selected patient:

l Type comments in the Comments field of the Boarding detail window.

View or Edit Existing Boarding Appointment
You can choose to view or edit scheduled boarding through either the Patient menu (from a

patient record), through the Section menu, or by selecting the Boarding icon.

To view or edit the details of a scheduled boarding:

l From the Section drop-down menu, click Boarding.

-OR-
l Select the Boarding icon from the Command Palette.

-OR-
l Choose Set/Find Boarding from the Patient menu in a patient record.

l From the Boarding window, double click on the scheduled boarding you want to

view or edit.

l This opens a Boarding detail window, the same window as seen when adding a

new boarding.

l From the Boarding window, make any necessary changes to the existing sched-

ule. See related topics under Add New Boarding for more detail on modifying

areas of the Boarding For detail window.

l Click OK.

Adjusting Boarding Duration
You can adjust the duration of a scheduled boarding as follows:

DVMAX Practice V8.6 - User Manual



- 223 -

l From the Boarding window, double click on the scheduled boarding you wish to

modify.

l Then, from the Boarding detail window, change the Check In and/or Check

Out date or time.

-OR-
l Drag the beginning or the end of the scheduled boarding to make the dura-

tion longer or shorter.

Delete Boarding
To delete a scheduled boarding:

l From the Boarding window, double click on the boarding you want to delete.

l From the Boarding detail window, click Delete.

l Click OK from the Confirm window to delete the boarding record.

You cannot delete a boarding until it has actually been scheduled. Therefore, while you are

adding a new boarding, the Delete button will be unavailable.

Go To Record: Open a Patient Record from Boarding
You can open the patient record associated with a scheduled boarding directly from the Boarding

Scheduler. To open a patient record:

l From Boarding, right click on the boarding appointment associated with the

patient record you want to view. A pop up menu displays

l Select Go To Record from the pop up menu. The associated patient record will

open.

l Note that DVMAX must be running (not just the Boarding and Appointments

schedulers) in order for the associated patient record to open.

Boarding Reports
There are a variety of Boarding reports that can be viewed or printed. Three reports can be

printed directly from the Boarding display. The fourth, the Canine Boarding Report, is run from
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General Management in DVMAX.

DVMAX allows you to print 3 different boarding options from the Boarding Scheduler:

Check In Report
The Check In report provides a report of all patients checking in on a specified date.

Check Out
The Check Out report provides a report of all patients checking out on a specified date.

Is Boarding Report
The Is Boarding report provides a report of all patients in boarding on a specified date.

Running Check In, Check Out and Is Boarding Reports
To print the Check In, Check Out or Is Boarding report:

l From the Boarding schedule window, click the Print icon in the top left corner

of the boarding window.

l Select Check In, Check Out or Is Boarding, depending on the report you wish

to print.

l Type a start date and end date in the Date fields, or select a date range using the

Calendar icons.

l Click OK to print.

Canine Boarding Report
This custom report shows all canine patients boarded within the user-specified date range. The

report provides patient signalment and client address information. To run this report:

l From the DVMAX main window, select General Management from the Sec-

tion menu.

l Choose the Reports tab from General Management.

l From the Custom Reports area, select Canine Boarding Report.

l Type a start date and end date for the reporting period and click Generate

Report.

Breed Records
Breed records allow you to standardize the way you classify your patients in DVMAX. Setting

up Breed records properly allows DVMAX to make certain breed-specific adjustments to a

patient’s record.

Breed records require a corresponding species record in order to be set up correctly. See Spe-

cies Records for more information.
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Creating a New Breed Record
To create a new Breed record in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l The Find window displays.

l From the Find dialog, choose Breed from the Search For drop-down list.

l Click Add New.

l A New Breed Record dialog displays.

l Type a unique code for the Breed record in the Breed Code field. Breed Code

can be up to 20 characters in length.

l Type a name for the breed in the Breed Name field. See Breed Names and

January Aging for information on naming conventions that can affect Thor-

oughbred Aging.

l Type the species name in the Species Name field, or click the magnifying glass

to the right of the field and select a species from the list of species records.
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l To see a list of Species Names, click in the Species Name field, type the first

letter and press TAB. This will bring up a window listing all existing codes.

l Click to select the Aging checkbox if you wish DVMAX to calculate ages for

this breed with January or Thoroughbred aging. The species must be Equine for

this setting to have any effect. See Species Names and Sex Nomenclature in

Species and Breed Names and January Aging for more details.

l Click OK to save the Breed record.

Searching For Breed Records
To find a Breed record in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l The Find dialog displays.
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l Choose Breed from the Search For drop-down list.

l Choose Breed Code from the By drop-down list to search Breed records by

code.

-OR-

l Choose Keyword in Breed to find any Breed records by breed name.

l Type a Breed code or name into the field below the By drop-down list. If you

are searching by code, you must type at least the first few letters of the breed

code. If you are searching by name, DVMAX will find all breeds that contain

the word you type.

l Click Search.

l If there is more than one match for your search, the Breed List window will

present a list of all items that matched your search.

l If there is only one Breed Record that matches your criteria, DVMAX will open

that Breed Record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window. Try your search again with different criteria, or

display a list of all breed records and select from the list.
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List All Breed Records
To list all Breed records defined in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l The Find dialog displays.

l Choose Breeds from the Search For drop-down list.

l Click All Records at the bottom of the Find window. A list of all defined

Breeds displays.

l Each Breed record is listed on an individual line, with columns for Breed Name,

Breed Code, and Breed Species.

Deleting a Breed Record
To delete a single Breed record from DVMAX:
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l Find and open the Breed record you wish to delete. See Searching for Breed

Records.

l Click Delete.

l DVMAX will ask you to confirm that you want to delete the Breed record

l Click OK.

To delete multiple Breeds from DVMAX:

l List all Breed record (see Listing All Breed Records).

l Click to select the Breed record you wish to delete.

l Choose Delete Records from the Breed menu.

l DVMAX will ask you to confirm that you want to delete the Breed records.

l

l Click Delete.

Breed Code Names: Conventions and Recommendations
As you continue to use DVMAX, you will need to add new breed codes. It is important not to

duplicate breed names. We recommend that you follow these conventions when creating new

breed codes:

l Breed Codes should be made up of letters or numbers, and must not contain

spaces.

l If the full breed name is 10 letters or less, use it as the breed code.
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l If the full breed name is longer than 10 characters, combine the first 3 letters

from each word in the breed name to make a breed code. For example, “Boston

Terrier” would be coded “BosTer”.

l If you are creating a code for a new breed mix, place the word “mix” (or the

characters “mx”) at the end of the breed code you create. An example would be:

Labcolliemx.

Breed Names and January (Thoroughbred) Aging
DVMAX will calculate an animal’s age using thoroughbred aging if two conditions are met on a

patient record:

l The species name includes the word “equine” and

l The breed code for the patient contains the letters “TBA”, for “Thoroughbred

Aging”.

If these two conditions are met, then the age of the patient will be calculated as if the animal

were born on January 1st. For instance, a breed code of QH for Quarter Horse would calculate

the age based on the date of birth, while a breed code of QHtba would calculate the age based

on Thoroughbred Aging.

For more information on this see Species Records andWorking with Patient Records.

DVMAX Practice V8.6 - User Manual



- 231 -

Client Records
Much of your time in DVMAX will be spent working with Client records. A Client is a cus-

tomer of your practice or clinic. A Client Record contains all information about a particular

client.

Through the Client screen you can access client and patient information, and enter financial

transactions such as invoices and payments. You can also write directly to your clients using

DVMAX's built-in word processor.

You can also write invoices, estimates, and returns from the client screen. For more information

on these topics, see the Invoices, Estimates and Returns sections of this documentation.

An Overview of the Client Record

A Client Record has three tabbed entry screens.

l The General Information screen shows basic client data such as the client's

name and address, account information, and a list of all patients that belong to

the client.

l The Finances screen shows past financial transactions, unfinished invoices, and

financial settings for the client.

l The Word Processing screen displays the word processing area for the client.

You can switch between these screens by clicking the appropriate tab near the top of the client

window.
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It is not necessary to click OK or Cancel before switching screens.

Searching for Client Records
To find a Client Record in DVMAX:

l Click Clients on the Command Palette.

-OR-

l Choose Clients & Patients from the Section drop-down menu.

l The Find dialog opens.

l Choose a criterion from the By drop-down list. See Search Criteria for more

information.
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l If necessary, type an appropriate search term into the field below the By drop-

down list. See Search Criteria for more information on appropriate search

terms. The label of this field is determined by your choice from the By drop-

down list.

l If your practice has multiple sites, choose a site from the Site drop-down list.

l Click Search.

l If there is more than one match for your search, the Client List window will

appear, containing a list of items that matched your search.

l The first column of the Client List displays either the Client ID number or the

Client File number.

Whether the Client ID or File number is displayed is controlled in the Clients & Patients Set-

tings section of System Constants.

l DVMAX also displays the client’s name, address and home phone number. You

can sort the list either by Client number or Client name.
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l If there is only one Client Record that matches your criteria, DVMAX will open

that Client Record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Search Criteria
DVMAX provides a number of predefined ways to search for Client Records. A description of

each follows.

Searching for Client Records by Last Name, First Name
To conduct a simple search based on name:

l Type the last name, a comma, and the first name. DVMAX will check both first

and last names on the Client Record for a match.  For example, if you wanted to

search for “James Madison” you could enter “Madison, James”.

l DVMAX will search the first and last name of both Name 1 and Name 2 on the

Client record, if applicable.

l DVMAX will also search for partial matches based on how the name starts. For

example, you could enter “Mad, J” to find all clients whose last name begins

with “Mad”, and whose first name begins with “J”. This search would find

“James Madison”, and would also find “John Madden”.

l You can leave out the first name and simply enter “madison” to find all clients

whose last names are “Madison”.

Searches are not case-sensitive. “James Madison” and “james madison” are the same

names. You do not need to capitalize your entries when searching.

Searching for Client Records by Telephone Number
The Telephone number search uses the phone number provided in the first Phone field to locate

the Client Record. It uses the 7 digits of that phone number (it does not use the area code) but

can sometimes search on the last four digits. You do not need to enter any dashes. DVMAX will

find only exact matches with a Telephone number search.

Searching for Client Records by Client File Number
The Client File Number search uses the File Number to locate a Client Record. This search will

find a client only if the File number matches exactly.
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For more information on File Numbers, see Client File Numbers.

Searching for Client Records by Client ID Number
The Client ID Number search uses the ID Number to locate a Client Record. This search will

find a client only if the ID number matches exactly.

For more information on ID Numbers, see Client File Numbers.

Searching for Client Records by Invoice Number
The Invoice Number search finds a Client Record based on an Invoice number. If the invoice

has not been deleted DVMAX will find the invoice and then the client it belongs to.

Searching for Client Records by Unfinished Invoices (No Input)
The Unfinished Invoices search finds all Clients with unfinished invoices. Typically, these are

clients who have patients in the hospital for treatment. You do not enter any information for this

search.

Searching for Client Records with Overdue Balances
The Overdue search finds all Clients with overdue balances aged between the specified days.

For example, entering “90, 120” will find all clients who have a balance that is more than 90

days old, and less than 120 days old. This search is useful for generating notices and cor-

respondence to slow-paying clients.

Searching for New Client Records
The New Client search finds all new Client Records created between the specified dates. By

default, the first and last days of the previous month are entered when you choose this type of

search. You can edit these dates as required. The New Client search is useful for tracking new

clients and referral sources.

Searching for Client Records with a Balance
The Balance Search finds all clients with a balance within the range you specify. You can fur-

ther narrow your search by specifying a date range within which the client must have last visited

your clinic. In Multi-Practice Access environments you can constrain by site.

To specify criteria for a Balance Search:
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l In the Balance Range field, type a range of numbers into which client’s balance

must fall. For example, to find all clients with a balance between $50 and $100,

inclusive, you would type 50,100.

l In the Last Visit Date Range field, type a range of dates in which the client’s

last visit must have occurred. For example, to see only clients who visited the

clinic in June of 2004, you would type 06/01/2004, 06/30/2004.

l To limit the search by site, choose a site from the Site drop-down list.

Searching for Client Records via User Defined Items
This search allows you to find Clients based on the contents of a User Defined Item. For exam-

ple, if you keep clients’ drivers license numbers in user-defined item #1 you can enter a license

number to find a client.

If you have defined a label for this user defined item, then the search menu will list the

“label” you defined for this field rather than “User defined item 1”. For example, if you defined

the label for user defined item #1 to be “Drivers License #”, then the search menu will read

“Drivers License #”.

For more information, see User-Defined Fields.

Client Record Search with Keyword in User Defined Items
This search allows you to find Clients based on a word, phrase, or code stored in a User Defined

Item.

This makes it possible for you to use the user-defined item to store information to “classify” your

clients. For example, you may want to note which clients are breeders, trainers, or sitters for

animals. You can do this easily by entering the appropriate word in User Defined Item 2 for

each client. Then you can use this keyword search to find all of your “sitter” clients.

For more information, see User-Defined Fields.

Searching for Client Records Using General Query
This search allows you to query based on any field that is part of the Client Record. For more

information, see General Searches.

Listing All Clients
To list all clients in DVMAX:

l Click Clients on the Command Palette.

-OR-

l Choose Clients & Patients from the Section drop-down menu.
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l The Find dialog opens.

l Click All Records at the bottom of the Find Window.

Creating a New Client Record
When you create a new Client Record, DVMAX will automatically assign it a unique client ID

number. This means that you do not need to worry if two or more clients share the same name,

telephone number, or any other information.

If you are going to enter many client records in one sitting, you will want to enable the

Quicker Client Entry in System Constant. For more information, see the entry in System Con-

stants That Affect the Client Record.

To create a new Client Record in DVMAX:

l Click Clients on the Command Palette.

-OR-

l Choose Clients & Patients from the Section drop-down menu.
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l The Find dialog opens.

l Click Add New at the bottom of the Find Window.

You will also find an Add New button at the bottom of the list of clients resulting from a

Client search. For more information about Client searches, see Searching for a Client.

l DVMAX creates an empty Client Record, showing the General Information

screen.

l Type the client’s name, contact information, any relevant notes, and add any

patients this client owns. See the sections below for more detail. You can add to

or alter most client information at any time.

l Click OK to save the new Client Record and return to the Find window, or click

OK & Next Client to create another new Client Record.

Entering a Client Name on a Client Record
To create a Client record, you must at least fill in the first Last Name field in the Name 1 line.

A Client record can contain two names (Name 1, Name 2). Many will only need one. Each

name is divided into three fields on the screen (in order): Title, First Name, Last Name.

If your client is a business, enter the business name in the Last Name field for Name 1.

Leave the Title and First Name fields in Name 1 empty.  Enter the name of a contact person in
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Name 2.  This allows you to search for this client either by company name or by the contact per-

son’s name.

To fill out the Client Name fields:

l Type the title, first name and last name of the first person associated with this

client record into the appropriate fields beside the Name 1 button. Use the TAB

key to move between the fields.

l If necessary, type the title, first name and last name of the second person asso-

ciated with this client record into the appropriate fields beside the Name 2 but-

ton. DVMAX will automatically enter the last name from Name 1. You can

type over this name.

Clicking either the Name 1 or Name 2 button will show you a list of pre-defined titles:

Selecting a title from this list will insert it into the Title field.

DVMAX will automatically capitalize the first letter of the name you type if the Auto-Cap-

italization preference is turned on. To find the Auto-Capitalization preference, first select Pref-

erences from the File menu and then click the Assorted tab.

Adding Client Contact Information to a Client Record
To fill out client contact information:

l Type the client's address in the Address field. Use two lines if necessary. Press

the TAB key to move to the City field.

l Type the client's city, town or village in the City field. Press the TAB key to

move to the State field.

You can type the client’s zip code into the City field and DVMAX will automatically fill in

the City, State and Zip Code fields and move you to the first Phone number field. For more infor-

mation, see Zip Code Lookups.

l Type the two-letter abbreviation of the client's state or province in the State

field.  DVMAX will automatically capitalize any two-letter state or province

abbreviation you type. Press the TAB key to move to the Zip/Postal Code field.

l Type the client's zip or postal code into the Zip/Postal Code field. Press the

TAB key to move to the Home Phone number field.

DVMAX will warn you if the zip or postal code you type is not the correct length or format

for your country. You can choose to ignore this warning and DVMAX will leave what you typed

intact.
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l DVMAX provides Phone Number fields for up to 3 phone numbers. Type the

client's phone numbers, as applicable, into the phone number fields.

l Press the TAB key to move through the 3 phone number fields. The second and

third phone fields provide space for an Extension (Ext).

l Beside each phone number is a Time of Day drop down menu. Use these to iden-

tify which phone number is the best contact based on time of day you may be

calling the client. For example, you may choose the “Day” option for the Work

number, or “Eve” for the Home number.

The labels and time of day drop down menus for each of the Phone fields are customizable

with the assistance of DVMAX Technical Support. For example, you may want to use one of

the phone fields for a client’s cell phone number.

DVMAX automatically formats any telephone number into “xxx-xxxx” or “xxx-xxx-xxxx”

format.  There is no need to type dashes or parentheses. The system will warn you if a telephone

number is not a 7 or 10 digit number. DVMAX will also convert letters to their number

equivalents. 

l Type the client's occupation into the Occupation field. Press the TAB key to

move to the Item 2 field.

The titles of the Occupation and Item 2 fields are configurable. You can set these fields to

contain whatever information is useful to your practice. For more information, see User Defined

Fields.

l If necessary, type a value into the Item 2 field. Press the TAB key to move to

the Email Address field.

l Type the client’s email address into the Email Address field. Email addresses

are of the form example@example.com.

l If you wish to send Reminders to this client via email, click to select the Email

Reminders checkbox.

l If you do not wish to send this client any Reminders, click to select the Do Not

Send Reminders checkbox.
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l If you wish to send Statements to this client via email, click to select the Email

Statements checkbox.

In order to enable the email reminders and statements capabilities, you must also configure

email (including selecting Send Reminders by Email If Possible checkbox) from the Email

Reminders tab under System Constants. See the Email and System Constants chapters for

more details.

For more information on sending Reminders, see the chapter, Reminders.

Adding Notes to a Client Record
The Notes area in the lower right of a client’s General Information dialog should contain general

comments about the client: family members, staff preferences, etc.  These notes only appear on

the General Information dialog and are not printed anywhere. Notes can hold up to 32 000 char-

acters (about 15-20 pages).

Actions in other sections of DVMAX, such as printing statements, can automatically add text to

the notes field of the Client Record.

These comments should be non-critical notes, not medical notes or any other critical infor-

mation. Medical notes should be stored on the appropriate Patient record.

Adding a New Patient to a Client Record
To add a new patient to a Client Record:

l Double-click in an empty area of the Patient list (in the lower left corner of the

General Information dialog).

-OR-

l Choose Add New Patient from the Patient drop-down menu.
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l A new Patient dialog opens. For information on filling out the Patient dialog, see

Working with Patient Records.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for Add New

Patient.

DVMAX prevents you from combining patients when opening a patient from the client rec-

ord. To combine patients, you must open the patient record directly.  For more information, refer

to the chapter Patients in this manual.

Deleting Client Records
If you are absolutely certain that you will have no need for a client record in the future, you may

delete that client record from DVMAX.

You cannot delete a client with an outstanding balance or unfinished invoice.

Deleting a client will also delete all patients belonging to the client. Deleting a client is per-

manent and cannot be undone.

An alternative to deleting a client is marking the client as inactive. For more information, see

Marking a Client as Inactive.

The ability to delete clients can be restricted to authorized users only. For more information, see

Users and Passwords.

Deleting a Single Client Record
To delete a single Client Record while you are viewing it:

l Choose Delete Client from the Client menu.

l DVMAX will ask you to confirm that you want to delete this client.
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l Click Stop to return to the Client Record

-OR-

l Click Delete and then click Yes when asked again to confirm. The client will be

deleted, and you will be taken either back to the Find window or to the next

client in the set you have been working with.

Deleting Multiple Client Records
To delete more than one Client Record at once:

l Use the Find Window to view a list of the Client Records you wish to delete.

For information on finding Client Records, see Searching for and Finding

Client Records.

l Click to select the specific clients you wish to delete from the list. To select con-

tiguous clients, press and hold the SHIFT key while clicking.  To select non-con-

tiguously, press and hold the CONTROL key.

l Choose Delete Records from the Clients menu.

l DVMAX will ask you to confirm that you want to delete this client.

l Click Stop to return to the list of Client Records

-OR-

l Click Delete and then click Delete when asked again to confirm. The clients

will be deleted, and you will be taken back to the Find window.
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Client General Information
The General Information tabbed window shows the client's name and address, account infor-

mation, notes, and a list of all patients that belong to the client.

Client Name and Contact Information
See Creating a Client Record for details on the various fields that make up a client’s name and

contact information. Most of these fields contain standard data, such as addresses and telephone

numbers. You can configure two of the fields to contain data specific to your practice.

User Defined Fields on a Client Record
DVMAX allows you to define two fields on a Client Record. By default, these are set to “Occu-

pation” and “Item 2”. You may label these fields to contain whatever data is most useful to your

practice. For instance, you may want a field to contain a client’s cell phone number, or a field to

contain a client’s fax number.

To define the Data Fields:

l Choose System Constants from the Section menu.

l Click the User Settings tab.

-OR-

l Choose User Settings from the System Constants menu.

l Type the first label in the User Defined Client Label 1 field.

l Type the second label in the User Defined Client Label 2 field.

l Click OK to exit System Constants and save your changes.
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You do not need to define both labels. If you define only the first label, the second will appear as

“Item 2” on the Client Record.

Zip Code Lookup from a Client Record
DVMAX can memorize zip codes and the towns or cities with which they are associated.

DVMAX learns this information from the data you enter into the system.

To speed the entry of new clients into the system, you can use the zip code of a new client as a

shortcut to enter their city and state.

Typically, when you enter client information you will enter the name, the address and then move

into the City field. If at this point you type the client’s zip code into the City field, DVMAX will

automatically fill in the city, state and zip code for you and will then move you into the next field

(home phone) for data entry.

DVMAX will accept zip+4 codes and use only the first 5 digits for the purpose of looking up the

matching city and state. If there is more than one city or town associated with the zip code, you

will be able to choose the right one from a popup selection list.

If the zip code is not “on file” DVMAX will tell you this and ask you to enter the full infor-

mation. It will then “learn” that zip code and be able to handle it next time.

To use this feature youmust enter the zip code into the City field.

Emailing a Client Directly from a Client Record
You can send an email directly to the client from the record. Enter an email address in the

Email Address field. Click the email icon.

Viewing Patient Visit History from a Client Record
The Visits button in the General Info section of the Client record lets you view Visit details for

all of the Client’s patients, including Visit Reason and any status changes (as tracked from the

appointment using Check In and Status drop-down menus).

The top section of the Visits dialog shows Visits (current/active and past visits), and indicates

whether a visit is active or not.

l If the Visit Active checkbox is selected (checked), then the visit is active.

l Click the Visit Active checkbox to deselect and close a patient visit. When you

close the Visits dialog, DVMAX will ask to confirm that you want to close the

visits you deselect. Those visits will remain in the visit history, but will be

marked as inactive. You can also close a visit from an invoice or directly from

the patient record.

l The lower portion of the Visit history dialog shows visit Events, or status

changes, over a selected visit. These Events are selected from an appointment

record. For example, a patient may be marked as being in the Waiting Room,

then an Exam Room, then a Treatment Room. In this way, you can see the

approximate amount of time a patient spent in the clinic and where they spent

their visit.
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The Patient List on a Client Record
Animals owned by a client (in other words, patients of your clinic) are listed in the lower-left

hand area of the client’s General Information dialog.

Each patient owned by a client is listed on an individual line. The patient’s Status, Name, Sex,

and Species are listed. For more information on these items, see Patients. The patient’s next

upcoming Reminder is also listed. For more information, see Reminders.

Patients in red in the list are due for a recall, or a Reminder is overdue for that patient.

Opening a Patient Record from the Patient List
To open a Patient Record while viewing a Client record:

l Double-click the desired patient from the Patient List

-OR-

l Click the patient’s name in the Patient List.

l Choose View Patient Record from the Patients menu.

CONTROL+P (COMMAND+P on Macintosh) is a keyboard shortcut for View Patient

Record.

DVMAX prevents you from combining patients when opening a patient from the client rec-

ord. To combine patients, you must open the patient record directly.  For more information, refer

to the chapter Patients in this manual.

Adding a Patient to the Patient List
To add a patient to a client’s Patient List:

l Double-click in an empty area of the Patient list (in the lower left corner of the

General Information dialog).
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-OR-

l Choose Add New Patient from the Patient drop-down menu.

l A new Patient dialog appears. For information on filling out the Patient dialog,

see Working with Patient Records.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for Add New

Patient.

About the Client Notes Section of the Client Record
The Notes area in the lower right of a client’s General Information dialog should contain general

comments about the client: family members, staff preferences, etc.  These notes only appear on

the General Information dialog and are not printed anywhere. Notes can hold up to 32 000 char-

acters (about 15-20 pages).

Actions in other sections of DVMAX, such as printing statements, can automatically add text to

the notes field of the Client Record.

These comments should be non-critical notes, not medical notes or any other critical infor-

mation.

Viewing Account Information from a Client Record
The Account Information section of the General Information dialog contains an overview of

your client’s account at your practice.  These details include:

l The client’s File Number at your practice.

l The client’s unique ID Number as assigned by DVMAX.

In many cases the ID number is the same as the File Number – see Client File Numbers for

more information on File and ID numbers.
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l The YTD field contains the amount your client has spent so far this year.

l The Balance field contains the client’s current balance. See Viewing Balance

Details for more information.

l The date of the client’s First Visit to your clinic.

l The date of the client’s Last Activity at your clinic, where activity is any finan-

cial transaction involving the client.

Viewing Balance Details from a Client Record
To see a quick summary of the details of a client’s balance:

l Click the Balance field in the client’s Account Information on the General Infor-

mation dialog.

l The Aging Info/Other balances dialog opens

l This window contains alert messages, aged balances, payment information, and

balances at other sites.

Client Referral Details on the Client Record
DVMAX allows you to keep track of how clients are referred to your practice. Referrals can

come from other practitioners, from marketing sources, or from other clients.

Specialty and emergency practices can keep track of the colleagues who refer patients, and gen-

eral practices can record the source of new clients.

For more information, see Referral Sources.

In order to set a Referral Source for a patient, the source must already be defined. See

Referral Sources for information on setting up Referral Source records.

Setting a Client’s Referral Source
To specify how a client was referred:

l Click the magnifying glass beside the Ref By field.
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l The Select Referral Source window opens.

l Click the Practice Name tab if you wish to search Referral Sources by Practice

Name rather than by the default, Full Name.

l Type the first few characters of the referral source’s name into the Search By

field at the top of the Select Referral Source window. This will narrow the list

of referral sources shown.

l Click to select the referral source you wish to use.

l Click OK.

You may be able to set the referral source to another client of yours. To set the referral

source to another client of your practice, type “Client Referral” into the Search By field and

click OK. This will produce a list of clients in your practice from which you can choose using

techniques similar to those outlined above. Whether you can set the referral source to another

client is controlled by the Allow Referrals By Other Clients setting of the Client & Patient

Settings of System Constants. It is also possible to enter a referral source directly by typing the

practice name or full name in the referral field then hit Tab.

Showing Information About a Client’s Referral Source
To see a quick summary of a client’s referral source:

l Click the Referral Info button near the Ref By field.
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l The Referral Info floating window displays, containing a summary of the

client’s referral source.

Emailing a Referral Letter from the Client Record
To email a referral letter for the patient, click the e-mail icon to the right of the Ref by field. 

The referral source must have a valid email address listed in the Referral Source record.

Client Finances
The Client Finances tabbed window shows a client’s completed financial history as well as any

unfinished invoices on file. You can also set many billing options from this dialog.

To access the Client Finances dialog:

l Click the Finances tab

-OR-
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l Choose Finances from the Client menu

CONTROL+F (COMMAND+F on Macintosh) is a keyboard shortcut for choosing

Finances from the Client menu.

Setting Billing Options for a Client
You can set several billing options from the Client Finances dialog. To turn on any of the

options, click to select the checkbox beside the option. To turn off any of the options, click to

deselect the checkbox beside the option.

Detailed Billing from the Client Record
The Detailed Billing option, when set, assures that simplified copies of all recent unpaid

invoices will accompany any printed monthly statement.

Delay Interest Until Billed – Client Billing Option
The Delay Interest Until Billed option, when set, keeps the interest “clock” from starting until

a statement is produced by the system at the end of the month. Use this if you normally bill your

clients for collected charges at the end of the month.

If this option is not set, interest will be calculated from the dates of individual invoices, rather

than of statements.

For example, if you have this option checked and your Grace Period is set to 25 days, then

DVMAX will start charging interest 25 days after you print the first statement for the client.

Do Not Bill - Client Billing Option
The Do Not Bill option, when set, prevents DVMAX from issuing a statement for any out-

standing balance for a client. The client will not be charged interest or a billing fee while this set-

ting is active. This is used when a Client account has been transferred to a collection agency.

DVMAX Practice V8.6 - User Manual



- 252 -

Tax Exempt – Client Billing Option
The Tax Exempt option, when set, ensures that the client will not be charged any sales tax. Use

this for tax-exempt organizations.

Suppress Interest – Client Billing Option
The Suppress Interest option, when set, keeps DVMAX from charging interest against any out-

standing balance.

Suppress Billing Charge – Client Billing Option
The Suppress Billing Charge option, when set, keeps DVMAX from issuing a billing charge on

statements.

Default Discount – Client Billing Option
Defines a discount that will be applied automatically to invoices for this client. You can override

this setting on any invoice or invoice line item.

To set a default discount for a client:

l Type a percentage into the Default Discount field

To remove a default discount for a client:

l Type a percentage of 0 into the Default Discount field.

Payment Due Delay – Client Billing Option
The Payment Due Delay setting applies only if the Practice Language Preference in System

Constants is set to a language other than English. This setting is used as the basis of a due date

calculation for some non-English invoices. See Multi-Language Support for more information

on this setting.

Marking a Client as Inactive
Marking a client as inactive means the client:

l Will not be sent any statements

l Will not be charged interest or billing charges for any outstanding balance

l Will not be sent reminders.

To mark a client as inactive:

l Click to select the Inactive Client checkbox in the Other Options section of

the Finances dialog.

l Click OK to save the change.
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Viewing a Client’s Financial History
A client’s recent financial transactions are listed in the bottom half of the Client Finances

dialog. To see a client’s complete financial history, click the All Past Finances tab on the Client

Finances dialog.

Viewing a Transaction in a Client’s Financial History
To view an individual transaction from a client’s Financial History:

l Click to select a transaction line from either Past Finances list.

l Choose View Item from the Finances menu

Printing a Transaction in a Client’s Financial History
To print an individual transaction from a client’s Financial History:

l Click to select a transaction line from either Past Finances list.

l Choose Print Item from the Finances menu.
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Viewing Balance Details
To see a quick summary of the details of a client’s balance:

l Click the Balance field in the lower right of the Client Finances dialog.

l The Aging Info/Other balances window displays.

l This window contains aged balances, payment information, and balances at

other sites.

Viewing Unfinished Invoices
A client’s unfinished invoices are listed in the upper left hand side of the Client Finances dialog.

To view an unfinished invoice:

l Double-click an unfinished invoice in the list.

-OR-

l Click to select an unfinished invoice from the list.

l Choose View Unfinished Invoice from the Finances menu.

For more information on unfinished invoices, see Invoices.
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Word Processing from a Client Record
You can use the Word Processing function under the client record Word Processing tabbed win-

dow to write letters and other correspondence to your clients, utilizing templates and accessing

relevant client, patient and financial information. The Word Processing window gives you the

option to Open a template document or start a New blank document.

For a complete discussion of using the Word Processor to write to clients, see Word

Processing.

The Client Word Processing Palette
The Client Word Processing palette allows you to easily insert client and patient information into

a document.
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Opening the Client Word Processing Palette
To open the Client Word Processing Palette at any time while working on a Client Word Proc-

essing dialog:

l Click the Show Palette button in the lower left of the WP window.
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Closing the Client Word Processing Palette
To close the Client Word Processing Palette at any time while working on a Client Word Proc-

essing dialog:

l Click the Close box(‘x’) in the upper right corner of the Palette.

l -OR-

l Click the Hide Palette button in the lower left of the WP window.
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Using the Client Word Processing Palette
To use the Client Word Processing Palette, simply click an information field on the palette, then

click Insert at the bottom of the palette. DVMAX will place the selected information into the

word processing document at the current cursor position. Double-clicking a field name in the Pal-

ette is a shortcut for inserting that field.

Holding down the Shift key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

The Client Word Processing Palette is broken down into 5 main “groups” of references:

l Client Merge Fields insert information from the client record onto a document.

l Client Patient Info inserts information about the client’s patients onto a doc-
ument.

l Client Patient Extras inserts pronouns and other special items related to
patient information onto a document.

l Patient Referral Fields insert information about the referral source for this
client.

l Client Address Lines insert the Client or practice address onto a document.

Adding information through the WP Palette creates a reference to that field from the cur-

rent client record, as opposed to copying that information from the current client record.  This
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means that if you insert the client’s “name” onto the document, then that document can display

the name of whichever client record you are viewing at the time you load the document.

Client Merge Fields (Word Processing from the Client Record)
Inserting any of the Client Merge Fields will place that information from the client record into

the document.

Client Patient Info (Word Processing from the Client Record)
Client Patient Info references allow you to insert information on a group of patients belonging to

this client.

These references can deal only with groups of a client’s patients. To write about an individ-

ual patient, use the Word Processing Palette on the Patient Word Processing dialog.

Patients List: Inserts a list of all living patients that belong to this client.  DVMAX separates

this list by commas if there are more than 2 patients and by “and” if there are only 2 patients. 

Single patients are listed alone. This makes it easy to write a sentence like “We welcome

Fluffy, Suzie, and Munch to our practice!”
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Canines List: Similar to the Patients list command except that it inserts living canines only.

DVMAX identifies which patients are canines by comparing their species code to that specified

for canines in System Constants - Client & Patient settings.

Felines List: Similar to the Patients list command except that it inserts living felines only.

DVMAX identifies which patients are felines by comparing their species code to that specified

for felines in System Constants - Client & Patient settings.

Patient & Reminders Block: Inserts a block of text listing all patients due for reminders as

well as the procedures for which they are due.  The system determines which patients are due

based on the criteria of your most recent search for reminders.

The block will show the patient names on the left, and then include a list of reminders for which

they are due to the right.  This list of reminders is built from the “short note” field in the

Reminder Type record. The block will include all patients that are due, and is very useful if you

send reminder letters to your clients to inform them when their animals are due for their vac-

cines, etc.  It is not recommend for use on reminder cards because it may easily exceed the size

of a single card.

See Reminders for more information.

Patient & Reminders #1 through #5: These commands insert a single line, one for each patient

belonging to this client that is due for reminders. Each line is constructed in the same fashion as

the Patient & Reminders block, with the patient name on the left, and the list of reminders

slightly to the right.

Using the separate lines it is possible to build a compact document for printing onto a postcard. 

This makes it possible to send a single reminder card which refers to multiple patients to a

client.

Client Patient Extras (Word Processing from the Client Record)
Client Patient Extras words your document so that it reads correctly regardless of how many

patients you are addressing.
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To use these commands, locate the type of “extra” you want to add (Pluralize, is or are, they

or he-she, their or his-her, them or him-her).  Then select the “group” of patients on which

DVMAX will base the “extra” (All Patients, Canines, Felines, Reminders).

For example, if you were writing to welcome a new client to your practice, you might write:

“We want to welcome your pet to our practice!”  But this would only be correct if the client has

only one pet.  If they have several animals, you would have to write: “We want to welcome your

pets to our practice!“ 

Pluralize: will add an “s” wherever it is inserted if the referred group has more than one

patient.  Thus “We welcome your pet to our practice” can automatically become “We welcome

your pets to our practice”.

Is or are: provides the right form of “is” or “are” depending on how many animals you are refer-

ring to.  For example: “Your pet is going to feel right at home in our practice” can automatically

become “Your pets are going to feel right at home in our practice”.

They or he-she: provides the right pronoun for the number of animals you are referring to.  For

example: “We know that he will feel comfortable with our staff“ can become “We know that

they will feel comfortable with our staff”.  In the case of just one animal, DVMAX will auto-

matically select the appropriate pronoun (he or she) based on the sex of the animal.

Their or his-her: provides the right possessive pronoun depending on the number of animals you

are referring to.  For example: “We will write again when his vaccines are due” can auto-

matically become “We will write again when their vaccines are due”.  DVMAX will auto-

matically select the appropriate pronoun (he or she) based on the sex of the animal.

Them or him-her: provides the right pronoun depending on the number of animals.  For exam-

ple: “We know you love him, so be sure to come back for your free follow-up exam” can

become “We know you love them, so be sure to come back for your free follow-up exams”.

Patient Referral Fields (Word Processing from the Client Record)
Patient Referral Fields allow you to insert information from the Client referral source onto a

letter or other document. The fields are self-explanatory.
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Client Address Lines (Word Processing from the Client Record)
Client Address Lines allow you to insert the client’s address onto a letter or other document

easily.

Using this menu you can also insert the Practice name, address, and telephone number. This is

useful since it will change automatically if the practice should move to a new location.

Below is a list of the other commands and their functions:

Address Block: inserts the complete client address as a single block.

Address, Line 1-4: inserts the client‘s address line-by-line. Using these separate lines makes it

possible to include text to the right of the address if this is required.

POSTNET Code: calculates and inserts a US Postal Service POSTNET delivery code to aid in

delivery of your letter. In order to use this feature you must have a printable POSTNET Bar

Code Font installed on your computer. The POSTNETcode must be printed using this font and in

an appropriate location on your document so it can be read by the Postal Service.

Practice Name: inserts the practice name onto your document.  The practice name is taken from

System Constants.

Practice Address, line 1 (etc.): inserts the lines of the practice address into your document. 

The address lines are taken from System Constants.

Practice telephone: inserts the practice telephone number into your document.  The practice tel-

ephone is taken from System Constants.

Client File Numbers
By default, DVMAX will assign each new client a sequential file number. You can override this

assigned file number if you wish to maintain consistency between DVMAX and a secondary fil-

ing system.

Setting a Client's File Number
To manually set a client's file number:

l Choose Set File Number from the Client drop-down menu.
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l The Client File Number dialog opens.

CONTROL+S (COMMAND+S on Macintosh) is a keyboard shortcut for Set File

Number.

l Type the new file number and click OK.

Reserved File Numbers
DVMAX reserves certain file numbers:

l OTC: This file number indicates that this Client record is to be used as an

“OTC” (“over the counter” or “cash sale”) client. See Invoicing for more infor-

mation.

l Hospital: This file number is for the Client record that represents your practice
or hospital itself. DVMAX will apply no charges to this client record for any

invoices that are written (they are automatically set to a net charge of $0.00),

and invoice entries on this client record will not be recorded into a patient his-

tory (a “dummy” patient record is still required - we suggest the name “Hospital

Use”). We suggest that the name for this Client record be “Inventory Adjust-

ment”.

l Resident: This file number is similar to the “Hospital” file number, except that
entries on invoices for this client will be recorded onto the patient history. You

can use this client to record treatments made to resident animals.

Client Alerts and Memos
An Alert is a message that appears when you open a Client record in DVMAX.
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l Click the Alert to have it open in a window. Click OK to dismiss it. You cannot

work with the Client record until you have dismissed the alert. There can be

only one alert message per client. Use alerts for critical notes.

l A Memo is a message that appears in a floating window when a Client record is

opened in DVMAX:

You can continue to work with the Client record while the memo is displayed. It is possible to

have more than one memo per client. Memos are useful for alerting staff about follow-up ques-

tions, answers, etc.  Memos can either be kept on file (to reappear the next time the Client Rec-

ord appears), or deleted.

Setting an Alert for a Client
To set an alert that will appear as soon as a Client Record is opened:

l Open the Client Record for which you wish to set an alert.

l Choose Set Alert Message from the Client menu.

CONTROL+Y (COMMAND+Y on Macintosh) is a keyboard shortcut for Set Alert Mes-

sage.

l The Alert Note dialog opens.

l Type your message into the Alert Note dialog.

l Click OK to save the alert message.

-OR-
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l Click Cancel to close the Alert Note dialog without setting an alert.

Editing an Alert Message
To change the text of a client’s alert message:

l Open the Client Record for which you wish to edit the alert.

l Choose Set Alert Message from the Client menu.

CONTROL+Y (COMMAND+Y on Macintosh) is a keyboard shortcut for Set Alert Mes-

sage.

l The Alert Note dialog opens.

l Change the text in the Alert Note dialog.

l Click OK to save the changed alert message.

-OR-

l Click Cancel to close the Alert Note dialog without saving your changes.

Erasing or Deleting a Client Alert
To remove an alert from a Client Record:

l Open the Client Record from which you wish to remove the alert.

l Choose Set Alert Message from the Client menu.
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CONTROL+Y (COMMAND+Y on Macintosh) is a keyboard shortcut for Set Alert Mes-

sage.

l The Alert Note dialog appears.

l Click Erase. The Alert Note dialog closes and the alert is removed from the

Client Record.

Setting a Client Memo
To set a memo to display in a floating window when a Client Record is opened:

l Open the Client Record for which you wish to set a memo.

l Choose Create a Memo from the Client menu.

l The Memo dialog field appears.
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l Type the text of the memo in the Memo dialog field.

l If necessary, type the date and time after which the memo should appear into the

appropriate spaces. The current date and time are filled in by default.

l Click OK to save the memo to the Client Record.

-OR-

l Click Cancel to close the Memo dialog without setting a memo.

Dismissing a Client Memo
You can dismiss a client memo without deleting it. This means that the memo will appear the

next time the Client Record is accessed.

To dismiss a client memo, click OK & Keep when the memo appears.

Deleting a Client Memo
To remove a memo from a Client Record:

l Open the Client Record from which you wish to remove the memo. The memo

you wish to remove will appear.

l Click OK & Delete.

Editing a Client Memo
There is no way to edit a client memo. To change a client memo, create a new memo and delete

the old memo requiring change.

Setting a Client Appointment
You can jump to the Appointment Scheduler while viewing a client record to schedule an

appointment for the selected client or associated patients.

To go to the Appointment Scheduler from a Client dialog:

l Choose Set Appointment from the Client menu.
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l The Appointment window opens, ready to schedule a new appointment for this

client. Note that on the top of the Scheduler beside the DVMAX icon, there is a

note that says, “Next scheduled appointment will be for <Client Name>.”

For more information on setting and finding appointments, see Appointments.

Printing Labels
You can print a variety of useful labels while viewing a Client Record. In each case below, the

label will contain information pertaining to the open Client Record.

Label printing requires a label printer. For information on setting up a label printer to work

with DVMAX, see Setup Label Printers.

Printing a Client File Label
A Client File Label contains the client’s name, phone number, File and ID numbers and is useful

for labeling a folder or other documents.

To print a single Client File Label:

l Choose Print Client File Label from the Client menu.

Printing a Client Address Label
A Client Address Label is useful for mailing correspondence to a client.
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To print a single Client Address Label:

l Click the Client Addr Label button in the Contact Information area of the

client’s General Information dialog.

Printing a Referral Address Label
This label includes a client’s referral source name and address.

To print a single Referral Address Label:

l Choose Print Referral Addr Label from the Client menu.

-OR-

l Click the Ref Addr Label button in the Referred By section of the client’s

General Information dialog.

Printing a Patient Label
For information on printing a Patient Label while working with a Client Record, see Working

with Patients on the Client Record.

Working with Patients on the Client Record
You can perform several operations relating to a client’s patients while you are working with the

Client Record. These operations are available only while you are on the General Information

dialog.

For complete information about working with Patients, see the Working With Patient Records

section of this manual.
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Printing Certificates From a Client Record
DVMAX allows you to quickly print certificates for any of the patients belonging to a client.

To print a certificate while working with a Client Record:

l Choose Print Certificates from the Patients menu.

l The Certificate Printing dialog appears.

l Click once in the appropriate columns to choose which certificates to print for

each patient.

l If desired, click to select the Display Page Setup Prior to Printing checkbox.

l Click Print.

Printing Prescription Labels From a Client Record
DVMAX allows you to print a prescription label for a selected patient (or for any patient belong-

ing to a client) while working with a Client Record.

To print a prescription label while working with a Client Record:

l Choose Prescription Label from the Patients menu.

l The Prescription Labeling dialog appears.

For information on filling out the Prescription Labeling dialog, see Prescriptions.
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Printing a Patient Label From a Client Record
You can print a Patient Label while working with a Client Record. For more information on

Patient Labels, see Working with Patient Records.

To print a Patient Label while working with a Client Record:

l Click once to select a patient from the Patient List.

l Choose Print Patient Label from the Patients menu.

Printing Client Reports & Statements
DVMAX offers a number of predefined Client reports and statements. To print these reports or

statements:

l Choose Print from the File menu when viewing a Client or list of Clients.

l The Printing Clients window appears

l Select the report you would like to print from the list of available reports. For

more information on each type of report, see its documentation.

l If necessary, click to select the Page Setup checkbox.

l Click Print.
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Reports will be based on the number of Client Records selected in the Client List Window.

If you are viewing an individual Client Record, the report will be based on that one Client Rec-

ord. For more information on the Client List Window, see Searching For and Finding Client Rec-

ords.

The Client List Report
The Client List Report prints a list of selected clients. The list includes client ID or File

number, client name, address, home phone number and business phone number.

The General Info – Pet List Report
For each selected client, the General Info – Pet List report prints client name & contact infor-

mation, then a list of the client’s patients, including their sex and species, next due and reason

for next visit.

Statement (Client Record)
A statement is a summary of all financial activity on the client’s account.

Normally, when you select File->Print to print a statement or billing statement for a client,

DVMAX will post a "STMT" transaction to the client's transaction history.  The clients.pos-

tStatementTransactionWhenReprinting advanced setting can be used to suppress this behav-

ior. The default value is True. Contact DVMAX technical support for more information.

Billing Statement
For each selected client. DVMAX will print a statement listing any items outstanding on the

client account.

If Detailed Billing is set on the client’s Finance dialog, the billing statement will also print

a copy of any outstanding invoices for the last 30 days. For more information, see Setting Billing

Options for a Client.

Overdue List
Typically, you will print this report after searching for clients with overdue accounts. (See

Searching For and Finding Clients for more information). The Overdue List prints a listing of

client names, home and business phone numbers, balance due, last payment amount and last pay-

ment date.

Referral Report
This report is typically printed after searching for a specific group of clients (such as new clients

from a specific time period). The Client Referral Report lists clients referred by Doctor, Hos-

pital or other Client. Patient information is provided for each client, along with a total number of

referrals and the revenue generated from each referral.

When you generate a Client Referral Report, DVMAX will present you with the Referral

Report Options dialog.
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To complete the Referral Report Options dialog:

l Click to select the Client Referral Source and First Date radio button.

l Type a Start and End date into the fields provided. Referrals must have first vis-

ited your clinic within these dates to be counted in the report.

l To report only on New Referrals in the given time period, click to select the

Report Only New Referrals checkbox.

l Click OK.

Purchase History Report
The Purchase History Report lists all purchases made by each selected client in a given time

period. The date of the purchase, invoice number, Bill Item code and description, Doctor, quan-

tity, price, extended price and item total are all listed. Subtotals are provided per patient and per

client.

When you generate a Purchase History Report, DVMAX will present you with the Purchase

History Options dialog.

To fill out the Purchase History Options dialog:

l Click the calendar beside the Start Date field to enter a starting date for the

report, or type a date directly into the field itself.

l Click the calendar beside the End Date field to enter an ending date for the

report, or type a date directly into the field itself.
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l Select whether you would like a Summary report at inventory item detail

level, or a Detail report at invoice line item date level.

l Click OK.

System Constants That Affect the Client Record
Some behaviors and appearances in Client Records are set or affected by settings in System Con-

stants.

Client and Patient Settings
To access the Client and Patient Settings:

l From the Section drop-down menu of the DVMAX main window, choose Sys-

tem Constants. The System Constants dialog appears.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Client & Patient Settings. Alternatively, locate and click the Client &

Patient Settings tab. The Client & Patient Settings dialog appears.

For Client Number, Display: ID Number or File Number
This setting determines whether the Client ID number or File number will be shown on Client

list dialogs, invoices, statements and reports.
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Quicker Client Entry
This setting enables DVMAX to accept new clients quickly, one after another. Quicker Client

Entry is typically used when a system is first set up, to speed entry of an existing client base.

When Quicker Client Entry is selected DVMAX will bring up a new client record as soon as

you have clicked OK on the previous client record, or as soon as you click OK & Next Client

on a patient record.

This setting will also allow you to enter patients repeatedly by clicking OK on the patient record.

Delayed Interest Default
This is the default setting for the Delay Interest Until Billed option on the Client Finances

dialog. If Delayed Interest Default is checked, then Delay Interest Until Billed will be

selected for every new client.

Default Constants
To access the Default Constants:

l From the Section drop-down menu of the DVMAX main window, choose Sys-

tem Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Default Constants. Alternatively, locate and click the Default Con-

stants tab. The Default Constants window appears.

Default Client City, State and Zip Code from System Constants
The text in these three fields will appear initially in the corresponding location of a new Client

Record.

User Settings for Client Records
To access the User Settings:

l From the Section drop-down menu of the DVMAX main window, choose Sys-

tem Constants.

l From the System Constants drop-down menu on the DVMAX main window,

choose User Settings. Alternatively, locate and click the User Settings tab.

User Defined Fields for Client Records
The text typed in these fields will appear as labels in the corresponding location on all client rec-

ords. See the discussion in the User Defined Fields section under Client General Information.
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Integrated Credit Card and Debit Card Processing

DVMAX offers fully integrated credit and debit card processing capabilities that allow for the

automatic capture of all payment information. The easy-to-use Terminal Setup Wizard lets you

configure your workstation to run an EMV terminal (chip card capable) or a non-EMV terminal.

You must have a persistent internet connection (not dial-up) to utilize the credit card processing

feature.

Advantages to this feature include:

l No more manual processing.

l Entry mistakes, mismatched end of day reports, and the time spent correcting

these are all eliminated.

l All payment information is automatically captured from credit and debit cards

and processed through DVMAX.

This chapter describes how set up your workstation(s) to use the credit card processing feature

and how to process a payment from an invoice, estimate or other similar transaction using credit

or debit card. Batch Reports and Credit and Debit Card Transaction logs are described in this

chapter as well.

If you plan to have more than one pay terminal set up at your location, each terminal must

have its own set up. DVMAX also includes an option for multiple merchant accounts if needed.

See About the Payment Terminal Setup Wizard for more information.

Setting Up Integrated Credit and Debit Card Processing: An Overview
With DVMAX’s integrated credit card and debit card payment processing functions, trans-

actions are authorized in real time using supported gateway(s) via an internet connection. To ena-

ble the credit and debit card processing feature, you need to complete three main steps:

l Assign DVMAX users proper security access to allow them to accept credit and

debit card payments.

l Connect the hardware peripherals to the Payment Terminal workstation(s),

where applicable.

l Run the Payment Terminal Setup Wizard to configure the payment terminal(s).
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Assign Security Group Access to Users for Credit Card Processing
You must add users to the Credit Card Processing security group before they can process credit

and debit card payments. Only users in this group are able to initiate transactions, access the

setup wizard, or browse credit card processing logs.

To add users to Credit Card Processing security group:

l From the Section menu, select General Management. The Management Func-

tions dialog opens.

l Select Set Passwords and Users, and click OK. The Tool Box dialog displays.
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l Select the user you wish to assign to the Credit Card Processing group. In the

Member column, select the Credit Card Processing check box.

l Alternatively, click the Groups icon, select the Credit Card Processing group,

and add users to it by selecting the check box beside their name.

l Close the Tool Box.

Connect Your Hardware Peripherals for Credit and Debit Card Proc-
essing for EMV Terminals

To be able to accept debit and credit card payments through DVMAX, you need to connect the

relevant hardware peripherals. If you are running an EMV Terminal, your EMV Smart Terminal

(iPP320) and Epson receipt printer need to be connected to the workstation you are setting up as

a pay terminal. DVMAX supports multiple merchant accounts, so you may have more than one

type of pay terminal and/or peripheral(s) in your clinic. If you are running a non-EMV Terminal,

see Connecting Your Hardware and Peripherals for Credit and Debit Card Processing for Non-

EMV Terminals.

To connect your hardware peripherals to the workstation:

l Plug the smart terminal or card reader into a USB port on the pay terminal work-

station.
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l Set up your receipt printer, if applicable.  See supported devices under Receipt

Printer in this chapter of the User Guide.

You can have more than one pay terminal set up at your location but each terminal has to be

set up.  DVMAX also includes an option for multiple merchant accounts, if needed. See About

the Payment Terminal Setup Wizard for more information.

For assistance in setting up your payment terminals, contact DVMAX Technical

EMV Terminal
DVMAX supports the use of EMV Terminals (Integrated Circuit or Chip Card Capable Point of

Sale Terminals). The EMV Terminal is both a card reader and a PINPad device. Plug the EMV

Terminal into an available USB port on the workstation you are configuring for EMV trans-

actions.

You will need to install ancillary software to run an EMV Terminal. Contact IDEXX Sales at

800-283-8386, option 5 (for Payment Processing) for information on supported EVM terminals

and ancillary software setup.

Receipt Printer
For credit card processing with EVMV terminals, only the network ready Epson TM88IV or

TM-T20 receipt printers are supported.

Epson TM88IV or TM-T20 Ethernet - Paper as per Epson specifications (Thermal Roll

Paper). The Epson Printer requires an Ethernet cable to access LAN.
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Connecting Your Hardware Peripherals for Credit and Debit Card Proc-
essing for Non-EMV Terminals

To be able to accept debit and credit card payments through DVMAX, you need to connect the

relevant hardware peripherals. For a non-EMV Terminal, your card reader (optional), receipt

printer (optional) and/or PINPad (optional) need to be connected to the workstation you are set-

ting up as a pay terminal. Details regarding the various peripherals are noted in sections in this

chapter titled Card Swipe Track Reader, Receipt Printers and PINPad. DVMAX supports

multiple merchant accounts, so you may have more than one type of terminal and/or peripheral

(s) in your clinic. If you are running an EMV Terminal, see Connecting Your Hardware and

Peripherals for Credit and Debit Card Processing for EMV Terminals.

To connect your hardware peripherals to the workstation:

l Plug the card reader, where applicable, into a USB port on the pay terminal

workstation.

l Set up your receipt printer, if applicable.  See supported devices under Receipt

Printer in this chapter of the User Guide.

l Plug the PINPad, if you are using one, in to a USB port on the pay terminal work-

station. Be sure to install the driver for this device, where applicable, before

using. The use of a Keyspan USB/serial adapter will be needed if your computer

does not have a serial port.

You can have more than one pay terminal set up at your location but each terminal has to be

set up.  DVMAX also includes an option for multiple merchant accounts, if needed. See About

the Payment Terminal Setup Wizard for more information.

For assistance in setting up your payment terminals, contact DVMAX Technical Support,

or visit DVMAX online for support documents at: http://dvmax.com/kb-

/categories/External+Integration/Credit+Card+Processing/
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Card Swipe Track Reader
DVMAX supports the use of keyboard equivalent swipers, as well as a number of other card

readers. You may need to install a driver for this device before using. We recommend you visit

http://dvmax.com/kb/categories/External+Integration/Credit+Card+Processing/ or contact

DVMAX Technical Support for help with identifying supported card readers and installing driv-

ers, as needed. You will need an EMV terminal if you plan to run chip card transactions. See the

section titled EMV Terminal.

Receipt Printer
DVMAX Credit Card Processing supports the use of the Dymo/Costar LabelWriterSE300 and

SE450, the Star TSP700II, as well as the network ready Epson TM88IV or TM-T20 receipt

printers. Only the Epson printers are supported for EVM Terminals.

If you are using a serial to ethernet adapter to connect your device, you will need to specify

your IP address. Contact DVMAX Technical Support for assistance.

Dymo/Costar LabelWriter – Paper as per Dymo specifications.

Epson TM88IV or TM-T20 Ethernet - Paper as per Epson specifications (Thermal Roll

Paper). The Epson Printer requires an Ethernet cable to access LAN.

Star TSP700II – Paper as per Star Micronics specifications. Be sure to install the appropriate

printer driver. This printer will require a USB port.
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PINPad
DVMAX supports the use of the Verifone 1000SE for non-EMV terminals. Note that this is a

serial device and will require a Keyspan USB/Serial adapter if there is no serial port on the

workstation you plan to use as the pay terminal. The Keyspan serial adapter driver must be

installed on the system before using the adapter. For supported EMV Terminals, see the section

EMV Terminal.

If you are using a serial to ethernet adapter to connect your device, you will need to specify

your IP address. Contact DVMAX Technical Support for assistance.

About the Payment Terminal Setup Wizard
Once users have security access to credit card processing and the peripherals have been con-

nected, a workstation can be set up as a pay terminal. The Payment Terminal Setup Wizard

walks you though a simple, step-by-step process for configuring a DVMAX workstation to

accept real-time credit and debit card payments. Payments are authorized in real time using sup-

ported payment gateways. Multiple payment terminals are permitted but each terminal has to

have its own setup.

To open the Payment Terminal Setup Wizard:

l From the DVMAX File menu, select Preferences. The DVMAX Preferences

tabbed dialog opens.
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l Choose the Payment Terminal tab.

l Click Run Setup Wizard. A message indicates all existing Payment Terminal

information will be overwritten.
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l Click OK to continue and proceed with Payment Terminal setup or Cancel to go

back.

EMV Payment Terminal Setup
The following sections cover set up for EMV terminals. For information on setting up an EMV

terminal, see Non-EMV Payment Terminal Setup.

EMV Payment Terminal Setup Wizard: Select a Payment Processor
Once you click Run Setup Wizard from the Payment Terminal dialog, the Payment Terminal

Setup Wizard opens. The first step is to select your payment processor. From the list of options,

click the radial button beside the name of the processor used by your clinic.

l If multiple merchant accounts need to be configured, select the Multiple mer-

chant accounts in this copy of DVMAX check box. This prevents the Mer-

chant ID, Authentication Key, and Terminal ID from being auto-populated,

allowing you to enter per terminal values. SelectingMultiple Merchant

accounts is particularly useful at a location that needs to have multiple, unique

credit card processing accounts, such as might be the case where DVMAX has

been installed to a multiple business environment.

l If the Multiple Merchant setting is cleared, the Merchant ID, Authentication

Key, and Terminal ID will be persistent across terminals. Merchant ID, Authen-

tication Key, and Terminal ID values will then be automatically inserted as the

default values in the appropriate fields when the wizard is run on another ter-

minal at your location.

l Only X-Charge merchant accounts can select Use EMV Terminal. If a station

will be an EMV Terminal, click Use EMV Terminal.
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l Click Next. Terminal Setup Wizard Step 2 of 8: Account Information page dis-

plays.

EMV Payment Terminal Setup Wizard: Account Information
The process of setting up your account information, Step 2 of 8 in the Payment Terminal Setup

Wizard, will vary depending on the payment processor you use.

l On the Payment Terminal Wizard Account Information dialog (Step 2 of 8), type

your X-Web ID, X-Charge Authentication Key, and X-Charge Terminal ID.

You should have received these values from X-Charge.

l In the OpenEdge EMV Token field, enter your EMV token. You should have

received this value from X-Charge.

l Click Next. This will take you to Step 3 of 8, Test the Connection, in the Pay-

ment Terminal Setup Wizard, Payment Terminal Setup.

If these values have been provided on another terminal, and ifMultiple merchant

accounts in this copy of DVMAX has not been selected, all but Terminal ID and EVM Token

will be pre-filled.

EMV Payment Terminal Setup Wizard: Test the Connection
After the account information has been set up, the Terminal Setup Wizard tests the connection

between your payment terminal and the payment processor. A transaction request is made to the

appropriate payment gateway, and a particular response expected. No customer or other sen-

sitive information is transmitted.

To test the connection:

l From the Payment Terminal Setup dialog window (Step 3 of 8), click Test Con-

nection.
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l The Next button is enabled only when the expected gateway response is

received.

l If the connection test is successful, a message displays in green text that the con-

nection was made and a response received.

l Click Next.
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If a Test Connection Fails
If the test connection fails, it could mean one of the following:

l There is no internet connection.

l The payment processor host is unreachable.

l You entered correct information, but there is a problem with the payment proc-

essor host. Contact Support for your payment processor.

l You entered incorrect information, resulting in an error message. Error mes-

sages are displayed in red text.

EMV Payment Terminal Setup Wizard: Test Receipt Printer
The next step in the Payment Terminal setup is to test your receipt printer.  To test your receipt

printer:

l Your receipt printer will be shown in the Receipt Printer Type field. For EMV

Terminals, only Epson printers identified in the peripherals section of this chap-

ter are supported.
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The Epson printers are network-based (TCP/IP) and can be used by multiple terminals.

l If an Epson printer is chosen, the Port drop-down list changes to a Receipt

Printer IP Address field. Enter the IP address of your receipt printer in the

Receipt Printer IP Address field.

When entering an IP address in the Receipt Printer IP Address field, you must supply

leading zeros for each octet (for example, the IP address 192.168.1.90 must be entered as

192.168.001.090). For assistance, contact DVMAX Technical Support or visit

http://dvmax.com/kb/categories/External+Integration/Credit+Card+Processing/.
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l Click Print Test Receipt to send a test receipt to the printer.

l Click Next. This takes you to the next step, identifying pay methods.

EMV Payment Terminal Setup Wizard: Create Pay Methods

The next step in setting up credit and debit card processing using the Payment Terminal Setup

Wizard is to ensure pay method codes are properly created and ready for use (Step 7 of 8 in the

Wizard). To enable payment processing, DVMAX needs to create 2 specially-named pay meth-

ods, one for credit card and one for debit card payments.  These methods will have the abbre-

viations “cCard” and “Debit”, respectively. These pay method code names are automatically

reserved by DVMAX for this purpose, and cannot be in use elsewhere in your DVMAX data-

base. If they are, those existing codes will have to be renamed.

Credit and Debit Card Pay Methods Already Created

It is possible that the “cCard” and “Debit” Pay Methods were previously created via the Pay-

ment Terminal Wizard for use by another Payment Terminal at your location. In that case, the

Credit and Debit Card Pay Methods dialog indicates that the pay methods already exist. Click

Next to proceed to the next step in setup.
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Credit and Debit Card Pay Methods Need to Be Renamed

If your DVMAX database was already using a method named "cCard" or "Debit", but the pay

method was not created by the Payment Terminal Wizard for DVMAX credit and debit card

transactions, DVMAX will prompt you to rename your existing codes to free up the method

names “cCard” and “Debit” for use by the Pay Terminal function.

To rename the existing codes:

l In the Credit Card Code and/or Debit Card Code field, type a new name for the

code that needs to be renamed.

l In the Credit Card Description or Debit Card Description field, type a descrip-

tion for the code you are renaming.

l Click Rename.

l Once these old codes have been renamed, DVMAX will create the necessary

Pay Methods “cCard” and “Debit” for use by the Payment Terminal.

l Click Next.
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Credit and Debit Card Pay Methods Need to Be Created

If one or both pay methods need to be created:

l From the Credit and Debit Card Pay Methods dialog, click Create.
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l You will receive a message on the page when the pay methods have been suc-

cessfully created.

l Click Next.

EMV Payment Terminal Setup Wizard: Best Practices Review and Sign
Off

The Best Practices dialog provides valuable information on safeguarding the security of the data

in your pay terminal and network.

l The Best Practices page opens. Read or review the Best Practices information.
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l When you have finished reading the Best Practices information, select I have

read these Best Practices.

l Click Next.

Finish and Close the Payment Terminal Setup Wizard
When you have completed the basic steps in the Payment Terminal Setup Wizard, click Finish

to close the Setup Wizard.
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l The Setup Complete page displays. A summary of your Payment Terminal Con-

figuration displays on the Payment Terminal tab of the DVMAX Preferences

window.

l Click OK to close the window.

Non-EMV Payment Terminal Setup
The following sections cover set up for non-EMV terminals. For information on setting up an

EMV terminal, see EMV Payment Terminal Setup.
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Non-EMV Payment Terminal Wizard Step 1 of 8: Select a Payment Proc-
essor

Once you click Run Setup Wizard from the Payment Terminal dialog, the Payment Terminal

Setup Wizard opens. The first step is to select your payment processor. From the list of options,

click the radial button beside the name of the processor used by your clinic.

l If multiple merchant accounts need to be configured, select the Multiple mer-

chant accounts in this copy of DVMAX check box. This prevents the Mer-

chant ID, Authentication Key, and Terminal ID from being auto-populated,

allowing you to enter per terminal values. SelectingMultiple Merchant

accounts is particularly useful at a location that needs to have multiple, unique

credit card processing accounts, such as might be the case where DVMAX has

been installed to a multiple business environment.

l If the Multiple Merchant setting is cleared, the Merchant ID, Authentication

Key, and Terminal ID will be persistent across terminals. Merchant ID, Authen-

tication Key, and Terminal ID values will then be automatically inserted as the

default values in the appropriate fields when the wizard is run on another ter-

minal at your location.

l Only X-Charge merchant accounts can select Use EMV Terminal. For more on

configuring an EVM Terminal, see EMV Payment Terminal Setup.

l Click Next. Terminal Setup Wizard Step 2 of 8: Account Information page dis-

plays.
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Non-EMV Payment Terminal Setup Wizard Step 2 of 8: Account Infor-
mation

The process of setting up your account information, Step 2 of 8 in the Payment Terminal Setup

Wizard, will vary depending on the payment processor you use.

X-Charge Customers
l On the Payment Terminal Wizard Account Information dialog (Step 2 of 8), type

your X-Web ID, X-Charge Authentication Key, and X-Charge Terminal ID.

You should have received these values from X-Charge.

l Click Next. This will take you to Step 3 of 8, Test the Connection, in the Pay-

ment Terminal Setup Wizard, Payment Terminal Setup.

If these values have been provided on another terminal, and ifMultiple merchant

accounts in this copy of DVMAX has not been selected, all but Terminal ID will be pre-filled.

If these values have been provided on another terminal, and ifMultiple merchant

accounts in this copy of DVMAX has not been selected, all but Terminal ID and EVM Token

will be pre-filled.
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Quickbooks Merchant Services Intuit Customers
l On the Payment Terminal Wizard Account Information dialog box (Step 2 of 8),

enter the Connection Ticket. You should already have received this from Quick-

books Merchant Services (Intuit).

l Click Next. This will take you to Step 3 of 8, Test the Connection, in the Pay-

ment Terminal Setup Wizard, Payment Terminal Setup.

l If you have not set up your Quickbooks Merchant Services/Intuit account and do

not have a connection ticket for DVMAX, you will need to obtain a connection

ticket for DVMAX before you can proceed further with the Payment Terminal

Setup.

l Click Get Connection Ticket. A Confirm dialog box opens. To get a ticket, you

will need to visit Quickbooks’/Intuit’s Merchant Account website.  You must

have your Intuit log in details ready, along with the confirmation email you

would have received from Intuit.
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l Click I have a LOGIN if you wish to continue.

l Click Cancel to quit the installation if you do not have your Intuit Login created

and/or have not received a confirmation email from Intuit.

l If you clicked I have a LOGIN, a page will display to allow you to log in to

your Quickbooks Merchant Services (Intuit) Account. Enter your Merchant

Account login details, including E-mail and Password information, and click

Log In.

l Follow the directions on the Intuit site to obtain a ticket. Once you obtain a con-

nection ticket for DVMAX, copy this connection ticket to the system clipboard.

Return to the DVMAX Payment Terminal Setup Wizard and paste the ticket

into the Connection Ticket field.

First Data/Rapid Connect Customers
l On the Payment Terminal Wizard Account Information dialog (Step 2 of 8), type

your First Data/Rapid Connect Merchant ID, your Datawire Secure Transport

ID (DID), your Terminal ID and your Group ID. You should have received

these values from First Data/Rapid Connect.

l Click Next. This will take you to Step 3 of 8, Test the Connection, in the Pay-

ment Terminal Setup Wizard, Payment Terminal Setup.
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If these values have been provided on another terminal, all but Terminal ID will be pre-

filled.

Non-EMV Payment Terminal Setup Wizard Step 3 of 8: Test the Con-
nection

After the account information has been set up, the Terminal Setup Wizard tests the connection

between your payment terminal and the payment processor. A transaction request is made to the

appropriate payment gateway, and a particular response expected. No customer or other sen-

sitive information is transmitted.

To test the connection:

l From the Payment Terminal Setup dialog window (Step 3 of 8), click Test Con-

nection.

l The Next button is enabled only when the expected gateway response is

received.

l If the connection test is successful, a message displays in green text that the con-

nection was made and a response received.
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l Click Next.

If a Test Connection Fails
If the test connection fails, it could mean one of the following:

l There is no internet connection.

l The payment processor host is unreachable.

l You entered correct information, but there is a problem with the payment proc-

essor host. Contact Support for your payment processor.

l You entered incorrect information, resulting in an error message. Error mes-

sages are displayed in red text.
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Non-EMV Payment Terminal Setup Wizard Step 4 of 8: Configure and
Test Card

The next step in the setup process is to configure and test your card reader. The card reader is

optional, and not all payment terminals will necessarily make use of a card reader. You will not

see this step if you are configuring an EMV Terminal.
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l If your payment terminal does not use a card reader, select No Card Reader on

this Terminal and click Next.

l If you have a card reader on the terminal, select your card reader type from the

Card Reader Type drop-down menu.

l Select the card reader port from the Card Reader Port drop-down menu.

l When your card reader and port have been set, the Test Swipe button becomes

enabled. To test the card reader, click Test Swipe.

l Swipe the card through the card reader. You should see a message that the card

has been read successfully.

l Click OK.

l Click Next. Step 5 of 8: Configure and Test Your PINPad page opens.

You will not see this step if you are configuring an EMV Terminal.
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Non-EMV Payment Terminal Setup Wizard Step 5 of 8: Configure and
Test PINPad

If your payment terminal uses a PINPad, the next step in the Payment Terminal setup is to iden-

tify and test your PINPad. You will not see this step if you are configuring an EMV Terminal.

l If you do not use a PINPad, selectWe don’t use a PINPad and click Next to

move to the next step in the setup process.

l If you use a PINPad for debit card transactions, select the PINPad from the PIN-

Pad drop-down list.  DVMAX supports Verifone SE1000 PINPad.

l Select the port to which the PINPad is attached from the PINPad Port drop-

down list.

l Click Test PINPad.

l The screen on your PINPad should read “DVMAX ONE SWIPE”.

l From the Confirm window, click Yes if you see the “DVMAX ONE SWIPE”

message in the PINPad. 

l If you do not see the “DVMAX ONE SWIPE” message on your PINPad, click

No. Check that all hardware is connected properly to your pay terminal, and try

again.
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l From the Configure and Test Your PINPad dialog, click Next.

Non-EMV Payment Terminal Setup Wizard Step 6 of 8: Configure and
Test Receipt Printer

The next step in the Payment Terminal setup is to configure and then test your receipt printer. 

To configure and test your receipt printer:

l Select your receipt printer from the Receipt Printer Type drop-down list.

The Epson printers are network-based (TCP/IP) and can be used by multiple terminals.

l If a LabelWriter is selected, choose the port the printer is connected to from the

Receipt Printer Port drop-down list.
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l If an Epson printer is chosen, the Port drop-down list changes to a Receipt

Printer IP Address field. Enter the IP address of your receipt printer in the

Receipt Printer IP Address field.

When entering an IP address in the Receipt Printer IP Address field, you must supply

leading zeros for each octet (for example, the IP address 192.168.1.90 must be entered as

192.168.001.090). For assistance, contact DVMAX Technical Support or visit

http://dvmax.com/kb/categories/External+Integration/Credit+Card+Processing/.

l Click Print Test Receipt to send a test receipt to the printer.

l Click Next. This takes you to step 7 of 8, identifying pay methods.

Non-EMV Payment Terminal Setup Wizard Step 7 of 8: Credit Card and
Debit Card Pay Methods

The next step in setting up credit and debit card processing using the Payment Terminal Setup

Wizard is to ensure pay method codes are properly created and ready for use (Step 7 of 8 in the

Wizard). To enable payment processing, DVMAX needs to create 2 specially-named pay meth-

ods, one for credit card and one for debit card payments.  These methods will have the
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abbreviations “cCard” and “Debit”, respectively. These pay method code names are auto-

matically reserved by DVMAX for this purpose, and cannot be in use elsewhere in your

DVMAX database. If they are, those existing codes will have to be renamed.

Credit and Debit Card Pay Methods Already Created

It is possible that the “cCard” and “Debit” Pay Methods were previously created via the Pay-

ment Terminal Wizard for use by another Payment Terminal at your location. In that case, the

Credit and Debit Card Pay Methods dialog indicates that the pay methods already exist. Click

Next to proceed to step 8 of 8.

Credit and Debit Card Pay Methods Need to Be Renamed

If your DVMAX database was already using a method named "cCard" or "Debit", but the pay

method was not created by the Payment Terminal Wizard for DVMAX credit and debit card

transactions, DVMAX will prompt you to rename your existing codes to free up the method

names “cCard” and “Debit” for use by the Pay Terminal function.

To rename the existing codes:

l In the Credit Card Code and/or Debit Card Code field, type a new name for the

code that needs to be renamed.
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l In the Credit Card Description or Debit Card Description field, type a descrip-

tion for the code you are renaming.

l Click Rename.

l Once these old codes have been renamed, DVMAX will create the necessary

Pay Methods “cCard” and “Debit” for use by the Payment Terminal.

l Click Next.

Credit and Debit Card Pay Methods Need to Be Created

If one or both pay methods need to be created:

l From the Credit and Debit Card Pay Methods dialog, click Create.
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l You will receive a message on the page when the pay methods have been suc-

cessfully created.

l Click Next.
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Non-EMV Payment Terminal Setup Wizard Step 8 of 8: Best Practices
Review and Sign Off

The Best Practices dialog provides valuable information on safeguarding the security of the data

in your pay terminal and network.

l The Best Practices page opens. Read or review the Best Practices information.

l When you have finished reading the Best Practices information, select I have

read these Best Practices.

l Click Next.

Finish and Close the Payment Terminal Setup Wizard
When you have completed the 8 basic steps in the Payment Terminal Setup Wizard, click Finish

to close the Setup Wizard.
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l The Setup Complete page displays. A summary of your Payment Terminal Con-

figuration displays on the Payment Terminal tab of the DVMAX Preferences

window.

l Click OK to close the window.
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Processing a Credit or Debit Card Payment Using the Payment Terminal
Once you have your payment terminal(s) set up, you are ready to process real-time credit card

and debit card transactions within DVMAX, including:

l As payment method on an invoice (see Invoicing in the User Guide for more on

working with invoices)

l As a deposit method for estimates (see Estimates in the User Guide for more on

working with estimates)

l As payment method for OTC invoicing (see Invoicing in the User Guide for

more on working with OTC invoices)

l As a payment method via Add New Transaction from the Client menu in a

client record.

l As a payment method when entering batch payments from Batch Payments

under the Special menu on the DVMAX main screen.

l As a refund method when processing a return (see Writing Returns in the User

Guide for more on working with returns).

Processing a payment, return or deposit using the integrated credit card feature is nearly iden-

tical to using any other pay method in DVMAX, such as cash or check, with the addition of one

extra step.  When you choose cCard or Debit as a pay method, a Process Payment Now button

appears beside the Pay Method amount field, and you need to click that button to proceed with

the transaction.

Remember, you must configure DVMAX to accept credit and debit card transactions,

including running the Payment Terminal Setup Wizard to set up a payment terminal, before you

can use the credit and debit card processing functions. Review the steps required in the User

Guide under the sections Assign Security Group Access, Configure Your Hardware Peripherals

and About the Payment Terminal Setup Wizard for more details.

Processing a Payment from an EMV Terminal
To process a payment using credit card (cCard pay method) or debit (Debit pay method) from

any area in DVMAX that displays the payment transaction:

l From the Pay Method drop-down list, select the pay method cCard for credit

card or choose Debit for debit pay method.
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l The Process Payment Now button displays. Enter a payment in the Amount

field, and click Process Payment Now.

l Follow the prompts on the EMV terminal display to Insert, Swipe or Tap the

card.

l To run the transaction manually, select the Manual Entry checkbox before

selecting Process Now. This option is not available for Debit transactions.

l For manual input you will be prompted to enter card number, expiry date and

CVV.

l If making a transaction that requires the client to enter a PIN number (such as

with a debit transaction), present the PINPad to the customer for them to OK the

purchase and enter their PIN.

l Clicking Cancel on the PINPad cancels the transaction.
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Processing a Payment from a Non-EMV Terminal

To process a payment using credit card (cCard pay method) or debit (Debit pay method) from

any area in DVMAX that displays the payment transaction:

l From the Pay Method drop-down list, select the pay method cCard for credit

card or select Debit for debit card pay method.

l The Process Payment Now button displays. Enter a payment in the Amount

field, and click Process Payment Now.
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l If your Pay Terminal is using a non-EMV card reader (which has already been

set up under the Pay Terminal Wizard), you are prompted to Swipe the card.

l On the Swipe Card Now dialog, swipe the card through the card reader (where

applicable).

l To run the transaction manually, select the Manual Entry button after selecting

Process Now. This option is not available for Debit transaction.

l ClickManual Input to see the Enter Card Data dialog.

l For manual input, on the Enter Card Data dialog, complete the cardholder infor-

mation, making sure to enter the Card Number, Expiry Date, and CCV. You

will receive error messages if the card number is not in a valid format, or if the

expiry date is in the past.

l Click Submit to continue and process the payment, or click Cancel to go back.

l If making a transaction that requires the client to enter a PIN number (such as

with a debit transaction), present the PINPad to the customer for them to OK the

purchase and enter their PIN.

Processing a Transaction Using Batch Payments

You can use the Batch Payments function to enter a credit card or debit card payment quickly

and directly, without having to open the associated client record.

To process a payment using the Batch Payments function:

l From the DVMAX main screen, choose Enter Batch Payments from the Spe-

cial drop-down menu.

l On the Batch Payment Entry dialog, type the client name or client ID.

l If you do not know the full client name, type the first letter or letters of the last

name, then press <Tab>.  Choose the client from the client list.

l Type a pay method code in the Payment Method field.  When you enter cCard

or Debit, the Process Now button becomes visible.   You must have entered

both an amount and an appropriate pay method to have the Process Now button

enabled.
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l Type an amount in the Transaction Amt field. You must have entered both an

amount and an appropriate pay method to have the Process Now button enabled.

l Click Process Now.

l If your Pay Terminal is using a non-EMV card reader (which has already been

set up under the Pay Terminal Wizard), you are prompted to Swipe the card,

with the option of manually entering the card number for a credit card payment.

Swipe the card through the card reader (where applicable), or clickManual

Input to see the Enter Card Data dialog. No manual option is available for debit

transactions.

l If you are using an EMV Terminal, follow the prompt on the EVM terminal dis-

play to Swipe, Insert or Tap the card, with the option of selecting Manual Input.

For manual input, you will need the card expiry date and CVV.

l If no card reader has been set up on your non-EMV Pay Terminal, the Enter

Card Data manual input dialog appears automatically.

l For manual input, on the Enter Card Data dialog, complete the cardholder infor-

mation, making sure to enter the Card Number, Expiry Date, and CCV. You

will receive error messages if the card number is not in a valid format, or if the

expiry date is in the past.  Where available, the client name and details will be

prefilled by DVMAX. Click Authorize to continue and process the payment, or

Cancel to go back.

l If making a transaction that requires the client to enter a PIN number (such as

with a debit transaction), present the PINPad to the customer for them to OK the

purchase and enter their PIN.
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Failed Transactions at the Processor

If a credit card transaction fails after swiping a card (other than an internet connection failure -

see Internet Failed Transactions), DVMAX will return a message. The text of the message

varies based on your payment processor and reason for transaction failure. You may try running

the transaction again, try a different pay method or cancel the transaction.

Internet Failed Transactions
For the case when a credit card payment transaction fails to process because of an internet-

related issue (Internet Failed), you will be prompted to store the authorization number to allow

the transaction to be completed in DVMAX. The transaction will be flagged as “no online auth”

so you can report on this and see which transactions need to be reconciled. The card type is

already set correctly, since it is detected from the card number.

If you are processing EMV cards, please contact Open Edge in the case of internet failed trans-

actions.

Voiding Credit Card and Debit Card Transactions

DVMAX allows to you void a credit card and debit card transactions and, where available, have

the associated funds automatically returned to the client’s card.
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Depending on your payment processor, you may not be able to void a debit card transaction.

In those cases, you will have to use the credit card (cCard) method to issue a refund instead to

try to have funds returned to the client’s credit card, or issue a refund or return in the same way

you would for a cash transaction. If it is not possible to void a Debit transaction (processed using

DVMAX’s integrated credit and debit card feature), you will get an Alert notice from DVMAX

indicating that you cannot perform the void.

For more information on voiding transactions, see the Invoicing chapter of the User Guide.

To void a credit card transaction:

l From the Finances tab of the Client record, chose the card transaction you want

to void.

l Double click to select the transaction. This opens the Transaction detail dialog.

l From the Transaction menu, choose Void this Entry.

l A Confirm dialog opens. Click Yes to continue and void the entry, or No to can-

cel the action.

l Another Confirm dialog opens indicating that your action will create an entry in

the Finance History to show that the transaction was reversed.  Click Yes to con-

tinue or No to cancel.

l A third dialog opens to ask if you would like DVMAX to try to return funds to

the client’s card. Click Yes to have funds returned to the client’s card. An Alert

dialog lets you know if the funds were successfully returned to the client’s card.

If funds could not be automatically returned to the card, you must issue funds

manually.

l Click OK from the Alert dialog to close the dialog and return to the Finances tab

of the Client record. Note that an entry has been made under the Recent

Finances area of the Finances tab to show that a transaction was voided.

When you try to void a card payment, DVMAX tries to perform a refund first, then do a

return afterward. If both fail, DVMAX lets you know you need to run the void manually.

DVMAX assumes you wanted to perform the void regardless of the method, and will post the

refund/return transaction as Echg in DVMAX Client Financials to reflect the refund you proc-

ess.

While individual card transactions can be automatically reversed to the client’s card, voided

invoices that contain debit or credit card transactions do NOT have the option of having those

payments auto-reversed and it is not possible to void such an invoice. Those transactions must be
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refunded manually. See Voiding an Invoice that Contains a Credit or Debit Card Trans-

action for more information.

Voiding an Invoice that Contains a Credit or Debit Card Transaction
It is not possible to void an invoice that contains a credit card or debit card transaction processed

on DVMAX’s integrated credit card processing feature using the payment terminal. If you try to

void the invoice, a message is displayed indicating that you cannot void the invoice because a

debit or credit card payment was accepted on the invoice.   For information on voiding other

types of invoices, see the Invoicing chapter of the User Guide.

Writing Returns on Credit Card Transactions

Writing a return using the credit card (cCard) or Debit pay methods is effectively the same as

writing a return for any other pay method (see Writing Returns in the User Guide for more infor-

mation). When writing a return where funds will be transferred to a client’s credit or debit card,

choose the appropriate pay method and follow the same process as listed under Processing a

Credit or Debit Card Payment Using the Payment Terminal.

Depending on your payment processor, you may not be permitted to perform a return on a

debit card transaction. You may be asked to use credit card (cCard) to issue a refund, or perform

a return by other pay method. If this is the case, when you select Debit as pay method, you will

see an Alert message noting that this pay method cannot be used for a return.

Batch Reports (X-Charge Only)
DVMAX offers a batch inquiry function for X-Charge users, where an automatic end of day

report compares the totals in DVMAX with the totals in the XML report from X-Charge.

To view the XCharge/DVMAX EOD Comparison report:

l From the Section menu, select General Management. The Management Func-

tions dialog opens.

l Click the Financials tab.

l Select XCharge/DVMAX EOD Comparison and click OK.
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l The XCharge/DVMAX EOD will be displayed.

Batch Settlement/Batch Close

DVMAX offers a batch settlement option, but the feature is dependent on whether your payment

processor offers a Batch option.

DVMAX normally closes the batch at a set time daily, as determined by the payment processor.

This is the most common (and recommended) option. Users can force a settlement (batch close)

of the open batch at the payment processor. This is typically only recommended for clinics with

24hour operation. To force a settlement:
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l From the Section menu, select General Management. The Management Func-

tions dialog opens.

l Click the Financials tab.

l Select Release Current Open Batch for Settlement and click OK.

l If batch closes successfully, DVMAX will display a notice on the screen indi-

cating a successful close and a Batch Close report will print from the receipt

printer.

Accessing the Intuit Merchant Service Centre from DVMAX

Intuit Quickbooks users can securely access the Quickbooks/Intuit Merchant Service Centre

from DVMAX at any time.

To access the MSC:

l From the Section menu, select General Management. The Management Func-

tions dialog opens.

l Click the Financials tab.

l Select Intuit Quickbooks Merchant Service Centre and click OK.

l The MSC secure webpage will open in your browser.

Credit and Debit Card Transaction Logs
DVMAX logs all incoming and outgoing credit and debit card transaction requests.  DVMAX

audit logs are automatically enabled, and cannot be disabled. These logs can be exported and

then purged. For Batch Close users, the amount of the closed batch will be reflected in the log as

well.

To view the Credit and Debit Card transaction log:

l From the Section menu, select General Management and go to the Financials

tab.

l Select View Credit/Debit Card Transactions and click OK.
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Custom Reports
Custom Reports are available from the General Management Reports tab, and from the Reports

button on the Command Palette. These reports are web-based; that is, they require an internet

connection to generate the report.  DVMAX’s reporting engine allows custom reports to be sent

to the clinics independent of release cycle. The reporting engine respects existing DVMAX secu-

rity and logins. Each report's security is mapped to an existing Practice security group. CSS style

sheets are used for display and printing.

From time to time new reports are added. The list provided in this Reports chapter may

not cover all existing custom reports.  There is a description of each report included in the list

of custom reports. You can review the selection of reports by choosing General Management

from the Section menu of the DVMAX main screen.

The webserver must be running, and you must have a valid IP address.

To verify that the webserver is running:

l Log in to DVMAX as Administrator.

l From the Section menu, select System Constants.  Go to the User Settings tab.

l Verify that the Web Server is ON and that there is a valid Port number.

l Close System Constants.

About Custom Reports
Custom reports not only offer a powerful addition to DVMAX’s report generating function but

the reports offer the data in a more presentation-ready layout. Reports are written in Active 4D,

and are stored in the "customReports" folder in the web folder. Each report is contained in its

own folder inside the "customReports" folder. Any patient names in the reports (where appli-

cable) will link to DVMAX Anywhere. This feature will let you click the link and the patient

record will open in DVMAX Anywhere. In each report's folder are two files:

l index.shtml - this is the report code.

l Definition.xml - the report definition. This contains the report's name, security

access, and description.

The name of the report and its description appear on the Reports list.

Appointment List By Staff
The Appointment by Staff list shows patient, client and appointment information for selected

staff by date range. Report columns are configurable and can be exported to Excel. Click a

patient name link on in the report to open the record in DVMAX Anywhere. For more on using

DVMAX Anywhere, refer to the DVMAX Anywhere chapter in the user guide.

Appointment Range Report
This report shows Client, Patient and Appointment data and can be used to share infor-

mation with third-party vendors. Click a patient name link on in the report to open the
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record in DVMAX Anywhere. For more on using DVMAX Anywhere, refer to the

DVMAX Anywhere chapter in the user guide.

Appointment Type Count and Sales
This report totals appointments by appointment type and roughly estimated sales.

Boarding Report
The Boarding Report shows all canine patients who visited within the requested date

range. Click a patient name link on in the report to open the record in DVMAX Any-

where. For more on using DVMAX Anywhere, refer to the DVMAX Anywhere chap-

ter in the user guide.

Call Up List
This report functions the same as the Call Up List report built into DVMAX, but has the

extended ability to list more than 5 reminders per patient if in existence. It excludes inac-

tive/deceased patients.

Client Retention Analysis
This report gathers client activity based on two user-specified time periods to make

comparisons.

Complete Audit Trail – All Transactions
Complete Audit Trail lists all transactions, broken down by client, for a given time

period.  All unfinished invoices are included, regardless of specified date. Click a

patient name link on in the report to open the record in DVMAX Anywhere. For more

on using DVMAX Anywhere, refer to the DVMAX Anywhere chapter in the user

guide.

Consult Retention
This report allows referral practices to determine if patients who visited for an initial consult

return to the referral clinic for another visit. In most cases, the patient typically comes in to be

seen once for specific reason and then returns to their primary hospital.

Current Visit Report
The Visit Report presents a list of active visits for reference by care staff away from the Front

Desk/Waiting Area. The report shows the most recently checked-in visit at the top of the list and

is refreshed every 30 seconds. This report is ideal to display on a monitor rather than a paper

print out. Click a patient name link on in the report to open the record in DVMAX Anywhere.

For more on using DVMAX Anywhere, refer to the DVMAX Anywhere chapter in the user

guide.

Deleted Appointments
Shows a list of deleted appointments for a given date range. Click a patient name link

on in the report to open the record in DVMAX Anywhere. For more on using

DVMAX Anywhere, refer to the DVMAX Anywhere chapter in the user guide.
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Detailed Doctor Production
The Detailed Doctor Production report allows you to configure and perform bonus cal-

culations by provider. The report gathers information from the Detailed Sales Report,

Receivables Report and the Average Invoices per Doctor report.

Detailed Sales Report
The Detailed Sales Report is the standard DVMAX sales report, which allows you to

report on any combination of doctors, time periods and bill items.

Discount Report
This report gathers all undefined discounts (global/default discounts, etc) and reports

on them.  Separately, it reports on bill item discounts as well and then returns a grand

total value.

GL Account
This report makes full use of the GL Account codes in DVMAX. If assigned to Bill items,

DVMAX will search for and group sales totals based on GL Account codes. The report can be

copy/pasted into excel, and then imported into accounting software like Quickbooks.

Initial Referral Report
The Initial Referral Report provides a comparison of referral numbers between two

time periods, broken down by referring DVM, Practice and referral recipient.  It

allows users to measure impact of marketing efforts.

Invoice to Line Item Comparison Report
Find how an adjustable bill item is used on invoices. The output shows the invoice

number, the invoice total, whether the queried bill item was used and how much

money was associated with it.

MRE Search Report
The MRE Search report gathers medical record entries with a specified code and

within a date range and reports on client/patient, medical record code/description and

totals them per active doctor or provider.

Multi Site Detailed Doctor Production
The multi site detailed doctor production report lets you configure and perform bonus cal-

culations per provider.

Patient Visits
This report looks over invoices in a date range, and reports on how many Patients were invoiced.

As a result, it gives an idea of how many unique patient visits have occurred for a specific pro-

vider compared to revenue.
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Price Increase/Revenue Projection
This report shows the top-selling items in your practice over the last 12 months, and

what the net increase in revenue would be were you to increase the prices of these

items 5%, 10% or 15%.

Rabies Vaccine Report
The Rabies Vaccine report displays or exports information on patients who have

received a rabies vaccination within a specified time period. Click a patient name link

on in the report to open the record in DVMAX Anywhere. For more on using

DVMAX Anywhere, refer to the DVMAX Anywhere chapter in the user guide.

Recall Reason
This report searches a date range for recalls and their reason, summarized in a compact view.

Referral Line Item Report
The Referral Line Item report gathers invoice line items in a specified date range and

category and reports on patient, provider and referral revenue associated with them.

This report is meant to be exported. Click a patient name link on in the report to open

the record in DVMAX Anywhere. For more on using DVMAX Anywhere, refer to the

DVMAX Anywhere chapter in the user guide.

Reminder Compliance Helper
The Reminder Compliance Helper gathers all reminders due in a date range, grouped

by reminder type.  It will help you track compliance for specific reminder types.

Species Revenue Report
The species revenue report groups sales totals by species.

Transaction Report
The transaction report shows all transactions for a given time period. You can report

on one or multiple transaction types.

Visit Overview Report
A report on a per doctor basis that estimates average visit duration, wait time and revenue per

visit. This report works when using the Visit Check-In and Status features associated with the

Appointment Scheduler. Click a patient name link on in the report to open the record in

DVMAX Anywhere. For more on using DVMAX Anywhere, refer to the DVMAX Anywhere

chapter in the user guide.

Generating a Custom Report
l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu and click the Reports tab. The

Report List appears.
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l The Standard and Custom report lists display. Double-click the report in the Cus-

tom list you want to generate.

l Type the requested information such as Start Date and End Date in the appro-

priate fields.

l Click Generate Report.

l The report opens in a new browser window

l Where applicable, click a patient name link on in the report to open the record in

DVMAX Anywhere. For more on using DVMAX Anywhere, refer to the

DVMAX Anywhere chapter in the user guide.

Adding a New Custom Report to the Custom Report List
When a new report is received (typically by e-mail from your DVMAX Technical Support

team), you must place it in its proper folder.

Only alphanumeric codes and the underscore character can appear in the XML element def-

initions.

To add a new custom report:

l From the Section menu, select System Constants. Click the User Settings

tab. In the Custom Report section, click Reload From Server.
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Custom Reporting Security Access
You can restrict access to a specific group by adding the group name to the "Access" parameter

in the XML file. Separate multiple groups with commas.

When upgrading to a new version of DVMAX take care to preserve the contents of the Cus-

tom Reports folder.

Diagnoses
DVMAX uses Diagnosis records to store and classify possible diagnoses for use on a Patient

record.

You can place a Diagnosis on a Patient record manually, or DVMAX can place it there auto-

matically when a linked Bill Item is added to an Invoice. See Working with Patient Records,

Invoicing and Bill Items for more information. Like MRCs, the Diagnosis record can include

linked external documents (such as LifeLearn documents) and editable templates that can be

attached to the patient record when the Diagnosis is applied.

A Diagnosis can also be part of a Finding Class and/or a History Class. See Findings and His-

tory Classes for more information about these topics.

An Overview of the Diagnosis Record
The Diagnosis record in DVMAX consists of a dialog box with 2 tabs: General Information

(Diagnosis code, description and notes) and a Documents tab (for linking external documents).
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There are also settings that affect how a Diagnosis behaves when placed on a patient record.

For full information on Diagnosis record settings, see Creating a Diagnosis Record.

Listing All Diagnosis Records
To list all Diagnosis records in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Diagnoses from the Search For drop-down list.

l Click All Records at the bottom of the Find window.

l The Diagnoses List displays, containing all defined Diagnoses in DVMAX.
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The Diagnoses List
The Diagnoses list displays one Diagnosis record per line. There are columns for Diagnosis

Code and Description.

Opening a Record from the Diagnosis List

l Double click a selected Diagnosis to view the record.

-OR-

l Click to highlight a selected record and click Show.

Search from the Diagnosis List

l Click Search to run a new Diagnosis or other Patient Codes search.

-OR-

l Choose Search from the Diagnoses drop-down menu.

l The Find dialog box opens. See the section titled Searching For and Finding

Diagnosis Records for more detail.

Show a Subset of Records

l Select a set of records from the Diagnosis records list.

l Click Show from the Diagnosis records list to display the subset of selected rec-

ords.

Exclude a Subset of Records
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l Select a set of records from the Diagnosis records list.

l Click Exclude to hide the group of selected records.

Add a New Diagnosis Record from the Diagnosis List
To add a new diagnosis record from the Diagnosis List:

l Click Add New at the bottom of the Diagnosis List.

-OR-

l Choose Add New from the Diagnoses drop-down menu.

l A new Diagnosis record window opens.

See Creating a Diagnosis Record for more information

Creating a Diagnosis Record
To create a new Diagnosis record:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Diagnoses from the Search For drop-down list.

l Click Add New at the bottom of the Find window.

You can also create a new Diagnosis record by clicking the Add New button at the bottom

of the Diagnosis List. See The Diagnosis List for more information.

l The New Diagnosis Type record window displays.
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l Type a unique diagnosis code in the Diagnosis Code field. This code can be up

to 12 characters long.

l Type the name of the diagnosis into the Diagnosis field. This will appear on the

Patient history and any Word Processing documents that reference this diag-

nosis.

l Type the text that you want DVMAX to place automatically on a patient’s his-

tory into the Default Notes field. This text will appear in the notes area of the

individual diagnosis entry. You can edit or even delete this text entirely after it

has been placed on the patient history.

l Click to select the Major Problem checkbox if you want DVMAX to place a

copy of this diagnosis in the Major Problems area of the patient record.

l Click to select the Do Not Include on WP documents checkbox if you do not

wish this diagnosis to be inserted on Word Processing documents. See Word

Processing for more information.

You can override this setting when entering a diagnosis on a patient record.

l Click to select the Hide Name of WP documents checkbox if you wish the con-

tents of this diagnosis, but not the name, to appear in Word Processing doc-

uments. This setting is useful for inserting comments on the patient record.

l If you want to enter Findings on the patient record with this Diagnosis, type a

valid Finding Class Code in the Finding Class Code box. See Linking a Diag-

nosis to a Finding Class.

l If you wish this Diagnosis to be included in a History Class, type a valid History

Class Code in the History Class Code box. See Linking a Diagnosis to a His-

tory Class.
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l If you wish to link this Diagnosis code to an external document or editable tem-

plate, select the Documents tab and complete the required steps. See Linking a

Document to a Diagnosis.

l Click OK to save the Diagnosis.

To see a list of Finding Class and History Class Codes, click in the code field, type the

first letter of the desired code and press TAB. This will bring up a window listing existing

codes.

Linking a Diagnosis to a Finding Class
When a Diagnosis is linked to a Finding Class, the Findings button will become available when

you enter the Diagnosis on a patient history, allowing you enter specialized predefined Findings

for this Diagnosis.

For more information on Findings, see Findings. For more information on entering Findings on a

patient history, see Working With Patient Records.

Linking a Diagnosis to a History Class
History Classes allow you to insert items from a Patient’s history in organized and related sec-

tions into a Word Processing document. When a Diagnosis on a patient record is part of a par-

ticular History Class, that Diagnosis will be included in any patient Word Processing documents

that make use of that History Class.

See History Classes for more information.

Linking a Document to a Diagnosis
When an external document is linked to a Diagnosis record, the document will display when you

enter the Diagnosis on a patient history. Depending on the document type you select, it will

either be an informative document (non-editable) or an editable document (such as a template).

To link a document to a Diagnosis record:

l From the Diagnosis record, click the Documents tab.
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l From the Documents tab, specify the document location for the document

you wish to link to the Diagnosis code under the Launchable Document

Associations area.

l From the File Name field, click Load and select your document. The name

of the file will display in the File Name field. Once you have specified the

Launchable Document Associations, you can click View to see the doc-

ument. You can change the document at any time by repeating the Load

process.

l From the Type options, choose Informative Document if you do not want

the linked document to be added to the Attachments tab of the patient rec-

ord when you use the Diagnosis code. Choose Editable Template if you

may want an edited version of the document to be added to the Attachments

tab of the patient record when you use the Diagnosis code.

l From the Display options, select Upon DX Code Selection to have the doc-

ument open when you click to create the diagnosis on the patient record,

Choose Upon DX Save to have the document open when you click to save

the diagnosis to the patient record.

l In the Default Document Comment field, type the default comments you

want to post to the Comments area of the Attachments tab of the patient

record. These will only be applied to the Attachments tab of the patient rec-

ord if you have chosen document type Editable Template.

l Click OK to save the Diagnosis record.

Searching for Diagnosis Records
To find a Diagnosis record in DVMAX:

l Select Patient Codes from the Section drop-down menu.

l The Find window displays.
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l Click to select Diagnoses from the Search For drop-down list.

l Choose Diagnosis Code from the By drop-down list to search Diagnosis records

by code.

-OR-

l Choose Keyword in Diagnosis to search the description fields of Diagnoses.

l Type a Diagnosis Code or word(s) from a Diagnosis description into the field

below the By drop-down list. If you are searching by code, you can enter as

many or as few of the characters of the Diagnosis code as you know. If you are

searching by description, DVMAX will find all Diagnoses whose descriptions

contain the word you type.

l Click Search.

l If there is more than one match for your search, the Diagnosis List window will

appear, containing a list of items that matched your search.

DVMAX Practice V8.6 - User Manual



- 336 -

If there is only one Diagnosis that matches your criteria, DVMAX will open that Diagnosis Rec-

ord.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.
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Deleting a Diagnosis Record
To delete a single Diagnosis from DVMAX:

l Find and open the Diagnosis you wish to delete. See Searching for Diagnosis

Records.

l Click the Delete button at the bottom of the Diagnosis window.

l Click OK to confirm that you wish to delete the record, or Cancel to keep the

record.

l DVMAX will ask you to confirm that you are sure you want to delete the

record.  Click OK to continue and delete the record.

To delete multiple diagnosis records from DVMAX:

l List all Diagnoses (see Listing All Diagnoses).

l Click to select the diagnosis records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent diagnosis records from the list.

Press and hold the CONTROL key (COMMAND on Macintosh) to select multiple non-adjacent

Diagnoses.

l Choose Delete Records from the Diagnoses drop-down menu.
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l Click OK to confirm that you wish to delete the records, or Cancel to keep the

record.

l DVMAX will ask you to confirm that you are sure you want to delete the

records.  Click Delete to continue and delete the records.

When you delete a Diagnosis, it can affect any Patient record on which that Diagnosis has

been placed. The text from the Diagnosis record will remain on the Patient record, but the Diag-

nosis itself will be marked as invalid in the Diagnosis List on the Patient history. See Working

With Patient Records for more information.

Deleting a Diagnosis will also leave incomplete any Bill Items that are linked to the deleted

Diagnosis. You should remove the link to the deleted Diagnosis from any Bill Items that used the

deleted Diagnosis. See Bill Items for more information.

Modifying a Diagnosis Record
You can change any part of a diagnosis record at any time, except for the Diagnosis Code.

Patient records on which this diagnosis has been placed will not be updated to reflect your

changes, with the exception of the Diagnosis Name. If you update the Diagnosis Name, the

name will be updated on Patient records which contain the diagnosis.

To update the Diagnosis Name on all records which use this name:

l Click Change beside the Diagnosis field.

l DVMAX warns you that changing the name will change the name on all patient

records containing this diagnosis.
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l Click Yes.

l Type the new name into the Diagnosis field.

l Click OK to save the changed Diagnosis.

l Changes made to the Do Not Include on WP documents and Hide Name of

WP documents also take effect immediately.
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DVMAXLink DICOM Integration (SecureRAD)
DVMAXLink refers to the functionalities in DVMAX that allow for automated downloading of

lab results as well as the integrated PACS Link DICOM viewing feature. This chapter

addresses the setup of the PACS Link integration.  For more on lab results integration, refer to

the Lab Results chapter.

DVMAXLink provides an integrated MWL (modality work list) that takes image requests from

DVMAX and passes them on the medical imaging equipment such as X-Ray, Ultrasound, MRI

and CT.  The resulting images are delivered directly and automatically to the appropriate patient

record, and you can view an image on multiple workstations under DVMAX. 

Once you have the DVMAX PACS Link configured, the process is triggered automatically

when you create a PACS Link Medical Record Entry on a patient’s history. For more infor-

mation on creating Medical Record Entries, see Working with Patient Records.

Configuring DVMAX PACS Link Integration
DVMAX Technical Support will guide you through the process of configuring the DVMAX

PACS Link. Configuration will include:

1. Providing DVMAX with the address of the DVMAX PACS Link server.

2. Creating or editing Medical Record Codes in DVMAX containing the PACS Link spe-

cial setting.

Entering the DVMAX PACS Link Server Address

DVMAX Technical Support will assist you in setting up your DVMAX PACS Link and

ensuring it is running smoothly.  Please contact Technical Support to determine the first steps.

If you do not know your DVMAX PACS Link server address, please contact your network

administrator or DVMAX technical support.

To enter the VetPACS digital radiography server address:

l Choose System Constants from the Section drop-down menu.

CONTROL+5 (COMMAND+5 on Macintosh) is a keyboard shortcut for System Con-

stants.

l Click the User Settings tab.

-OR-
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l Choose User Settings from the System Constants drop-down menu.

l Type the web address of the DVMAX PACS Link server into the DVMAX

PACS Link Server Address field in the lower right corner of the User Set-

tings tab.

l Click OK to save your changes.

l Click OK again to exit System Constants.

Testing the DVMAX PACS Link Server Setting
You can test your DVMAX PACS Link Server address before you attempt to send an actual

working request. To test your Server Address:

l Click Test PACS Link on the User Settings tab of System Constants.

l DVMAX will present a dialog informing you that testing is about to begin. Click

OK to begin the test.

l DVMAX will notify you of the success or failure of the test by noting whether

the PACS Link is available (successful test) or not available (failed test).

l If DVMAX is unable to connect to your server, the IP address portion of the

PACS Link Server Address previously recorded will be replaced with <Please-

CheckAddress>.

Creating Medical Record Codes for DVMAX PACS Link Integration
In order to enable DVMAX PACS Link integration, you must create Medical Record Codes

with the PACS Link Special Setting.  In this way, the DVMAX PACS Link will automatically

be triggered whenever a MRE is made using a MRC created with the PACS Link Special Set-

ting.

This section outlines the minimum steps necessary to create MRCs that enable the PACS Link

integration. For complete information on creating MRCs, see Medical Record Codes.
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DVMAX PACS Link MRC Format

Medical Record Codes that work with DVMAX PACS Link integration must be created using a

specified format.  An example of the required format is DXCT45, where DX represents the

MRC Category to which ALL PACS Link MRCs are assigned;  CT represents the 2-character

code for modality type (in this example, CT Scan) and the end of the MRC is a 2 digit number

for purposes of distinguishing types of images within your clinic.

Use the following guide to format your MRCs for PACS Link integration:

l The MRC begins with the 2-character Category code that you will use for diag-

nostic imaging.  Select the same Category code for all MRCs with the PACS

Link special setting.  This is often DX, but your clinic may use a different Cat-

egory code.

l The next 2 characters must be the modality code.  These include CT (CT

Scan), US (Ultrasound) and CR (X-ray).

l The last part of the MRC will be a unique ID number of at least 2 digits.

l All MRCs must also be given the PACS Link special setting. (See Creating a

Medical Record with the PACS Link Special Setting).

Creating a Medical Record Code with the PACS Link Special Setting
To enable DVMAX PACS Link integration, you must create at least one Medical Record Code

for each modality you will use, and each MRC must have the PACS Link special setting ena-

bled.

To create a Sound PACS Medical Record Code in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose Med Rec Codes from the Search For drop-

down list.
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l Click Add New at the bottom of the Find window.

You can also create a new Medical Record Code by clicking the Add New button at the

bottom of the Medical Record Code List. See The Medical Record Code List in Medical Rec-

ord Codes for more information.

l From the new Medical Record Code window, type a unique code for this MRC

in the Medical Record Code field.  The format for the code must be as

described under the DVMAX PACS Link MRC Format. The MRC begins

with the diagnostic imaging Category code (such as DX), followed by the

required 2 character modality code (such as CT, or US) and a unique number

code of at least 2 digits.  For example, DXCT45, where DX is the category, CT

is the code for CT Scan and 45 is the unique numeric ID that the clinic assigned

to this particular type of CT image.

l Type a short description of this MRC in the Description field.

l Click to place an asterisk (*) beside PACS Link in the Special Settings list.

l Click OK to save the Medical Record Code.

For more information on the other settings available when creating Medical Record Codes, see

Medical Record Codes.
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Optional DICOM Image Viewing Software
With DVMAX PACS Link, you can view DICOM (Digital Imaging and Communications in

Medicine) images directly from a patient record without the need to have any dedicated DICOM

viewing software, and you can access the images from any workstation via the patient record. 

To edit DICOM images, you will need to obtain and install DICOM image viewing software for

your computer. Osirix is the recommended choice for software (http://www.osirix-viewer.com). 

For further assistance, contact DVMAX Technical Support.

Configuring DVMAX PACS Link
Please contact DVMAX Technical Support for information and assistance on configuring your

DVMAX PACS Link. It is important to have your DVMAX ID ready when calling Tech Sup-

port.

How DVMAX PACS Link Integration Works
In the following example, the Medical Record Code DXCT45 has the PACS Link special setting

enabled.

1. Creating a Medical Record Entry containing DXCT45 on a patient history will send an

imaging request to the DVMAX PACS Link server.  The following data is transferred to

the PACS Link server:

l Patient Information:

l Patient ID

l Name

l Date of Birth or Age

l Sex

l Breed

l Species

l Weight

l Client Information:

l ID

l Name

l Address (Street, City, State, Postal/Zip code)

l Email

l Phone

l Fax

l Alternate phone numbers

l Exam Information:

l ID

l Vet ID
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l Vet Name

l Vet Address (Street, City, State, Postal/Zip code)

l Email

l Phone

l Fax

l Alternate phone numbers

2. When the new image is ready, the image will be automatically link back to DVMAX by

the DVMAX PACS Link, in DICOM format.

3. The image can then be viewed directly from the patient record under the DICOM tab.
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DVMAX Sync (Remote Processing)

DVMAXSync, introduced with DVMAX v7.5, replaces Remote Processing with a “one-click”

synchronize feature that allows remote terminals and laptop workstations to quickly and con-

fidently update records changed in the field and stay synchronize their records with data stored

on the main DVMAX server.

In this chapter, “main computer” refers to the computer or server at your office or clinic that

holds your DVMAX data. “Remote computer” refers to the laptop(s) or computer(s) at satellite

locations.

Be certain to follow all instructions below carefully and in the exact order they appear. Skip-

ping or misunderstanding a step can cause serious damage to your data.  Working with

DVMAX Technical Support in the initial setup of DVMAX Sync is recommended.

Setting Up For DVMAX Sync (Remote Processing)
The following sections will take you through the steps involved in preparing for and setting up

DVMAX Sync.  Again, if you have any questions, please contact DVMAX Technical Support.

DVMAX Sync Pre-Setup Checklist
l The DVMAX Server or "Main" Single User computer must be on a static IP.

l The synchronization takes places over a network, so both the laptops/remote ter-

minals and your main system should be on the same network for the best expe-

rience - wired or wireless.

l DVMAX 7.5 should already be installed and running on all computers. This

includes installing DVMAX Single User on the laptops to be used.

DVMAX Sync Step 1: DVMAX Server Setup
If the 'Main' computer is running DVMAX Single User, you do not need to check these set-

tings and you can skip to the next step, Get a Copy of the Data from the DVMAX Server.

There should not be any setup necessary on the DVMAX Server, but verify the SQL Server is

running.

On the DVMAX Server:

l Click on the SQL Server tab at the top.

l Verify the Status says SQL Server is started. If it is not, click Start SQL

Server.

l Lastly, Quit the DVMAX Server computer in preparation for later steps.
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DVMAX Sync Step 2: Get a Copy of the Data from the Server
The next step is to get a copy of the data from the DVMAX Server.

l Ensure the DVMAX Server program is not running.

l On the Remote Station/Laptop, get a copy of the entire DVMAX Data

either through copying files over the network, or from a USB Hard drive.

l The DVMAX Server datafile is typically located in C:/DVM-

AXDatabaseFiles/DVMAXDataFolder/ on Windows, or Macintosh

HD:DVMAXDatabaseFiles:DVMAXDataFolder. The exact files to copy

must be the following:

DVMAX.4DD

DVMAX.4DIndx

DVMAX.4DSyncData

DVMAX.4DSyncHeader

DVMAX.Match

The exact files to copy MUST BE those listed about. Your files may not have the name

'DVMAX' but should have all the listed extensions.

l Place the copied DVMAX Data into the Data folder on the Remote Laptop,

again typically located in: Windows C:/DVM-

AXDatabaseFiles/DVMAXDataFolder/ and for Macintosh, HD:DVMA-

XDatabaseFiles:DVMAXDataFolder

l The DVMAX Server can now be launched again, and must be running for

the next step.

DVMAX Sync Step 3: Launch DVMAX Remote and Configure

DVMAX Server must be running for this step.

l Launch DVMAX Single User on the Remote Laptop.

l If this is first time launching DVMAX, you will be given a prompt to select

from a few options. Click the Open button.

l Navigate to the DVMAX.4DD file you saved on the computer and click

Open.

l Log into DVMAX as Administrator with no password and click Connect.

l Once DVMAX has fully launched, click on the File menu and choose Pref-

erences.

l Select Use as a Remote Terminal if it is not checked already and confirm

the change, then click OK to exit Preferences.
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l Go to the Section menu and while holding down the SHIFT key, click Sys-

tem Constants. From the Advanced Settings Warning dialog, read the warn-

ing then click I understand.

Working in the Advanced Settings area of DVMAX is only recommended when in direct

contact with DVMAX Technical Support. Be careful to follow directions explicitly.

l Select the Functions tab.

l Click the Execute Method button near the top right of the dialog.

l Type in last rec fix and click OK.

l A "loading data" message will appear several times.  Within a minute or

two you should be able to close the Advanced Settings window. If you can-

not, the procedure is still running.

l From the DVMAX main window, select the Special menu and choose Syn-

chronize.

l Type in the IP of the DVMAX Server computer, using Administrator for the

username, and your correlating password. If your Administrator user does

not have a password, leave it blank.

l Click the Synchronize button to initiate the first Synchronization between

the Laptop and the Server.

l Confirm the choice and wait for Synchronization to complete.  The first Syn-

chronization could take anywhere from 5 - 30 minutes. Be patient and let it

complete.

If you receive an error almost immediately after clicking Synchronize, your settings may

not be correct. Verify you've entered the right IP, Username, and Password for connecting to

your server.

l When the sync process is finished, an alert will appear stating Syn-

chronization complete. Click OK.

l The laptop is now ready to be used with DVMAX Sync (remote proc-

essing).

Using DVMAX Sync
Using DVMAX with DVMAX Sync enabled is exactly the same as using DVMAX in your main

office or clinic.  You can use DVMAX with DVMAX Sync enabled for any length of time.
To Synchronize:

l From your laptop or remote terminal, go to the Special menu and choose Syn-

chronize. DVMAX will first check to make sure that your version of

DVMAX is licensed to use this feature.

l Select Synchronize with Server.

l Wait for the Synchronization to complete.
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l You can be sure Synchronization is successful when you receive the alert

stating Synchronization complete.

If Synchronization is disrupted at any point in time, click OK and tell DVMAX to Syn-

chronize again.

Tips for Maximizing DVMAX Sync Performance
For maximum performance, and the best experience, the laptop should be synchronized as often

as possible. Since both the Main system and the laptop are trading data with each other, the

more frequently it is done, the faster Synchronization will complete.

The System does not need to be shut down to Synchronize. The Laptop can synchronize as many

times as you like. Data will not 'duplicate'.

Rules of DVMAX Sync
To ensure the integrity of the data system the following rules exist to provide the best experience

for all users.

The Main System Always Wins
If a single file is edited on both the laptop and the main system in the same time frame, the Main

system always 'wins' and keeps it's version. For example:

A client phone number is changed on the main computer.

On the same day, the laptop changes the same client's address.

When synchronization occurs, the system will keep the main computer's version of the client

file, resulting in the phone number change being preserved, but not the address change.  Alter-

natively, if the main system did not touch the client file at all, then the laptop would successfully

update the client's address.

Financials Update on the Main System, Not the Remote Laptop
You can do many things remotely with DVMAX, but 'finishing' invoices is no longer possible.

You can still take payments and write full invoice and save them, but all final transactions must

be completed on the main system. Once this is done, the laptop will receive the updates through

Synchronizing.

A search for Patients with Unfinished Remote Invoices will return a list of all unfinished

remote invoices.  You can then use the Finish Unfinished Invoices option from Patients menu of

the Patients list to batch finish unfinished invoices.  Refer to the Patients chapter for more infor-

mation.
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Emailing Documents
You can use DVMAX to compose and send emails to your customers and referral staff through

your default email program. DVMAX can use text from Word Processing documents you gen-

erate in Clients, Patients or Referral Sources in the email you send.

Setting Up the Email Functionality
To send an email, the Client or Referral source information must contain a valid, current email

address. Your clinic’s outgoing and incoming mail servers must also be defined to allow the

emails to travel to their intended destinations.

Using DVMAX Email with SSL

DVMAX supports SSL. Contact DVMAX Technical Support if you are not sure about your

email settings or need assistance in setting up the email functionality in DVMAX.

Using DVMAX Email with POP Before SMTP
Some ISPs require your email setup to provide POP before SMTP.  If this is the case, select

Use POP Before SMTP under the Email Reminders tab from System Constants. Contact

DVMAX Technical Support if you are not sure about your email settings or need assistance in

setting up the email functionality in DVMAX.

Updating Client or Referral Source Email Addresses
From a Client or Referral Source record, add the email address in the appropriate field.  This

will be used as the default email address when you send an email to the client or referral source.

Setting the Mail Servers in DVMAX
To setup the Mail Server:

l Select System Constants from the Section menu.

l Select the Email Reminder tab.
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l Within the Server information area add the Outgoing Mail server address. This

is the server that will process the emails being sent from DVMAX.

l Add the Account Name and Password.

l Type the Incoming Mail server address. This is the server that processes mail

coming into DVMAX.

l Add the Account Name and Password.

l Click Test to test the email functionality.

l Select POP Before SMTP if this mail configuration is required by your ISP.

Define the Default Mail and Attachment Directories
To define the default mail and attachment directories:

l Select System Constants from the Section menu.

l Select the Email Reminder tab.

l Click Select and set the Download directories for mail and attachments.

Specify Your Default Email Settings
To setup you default email address, email subject and reply address:

l Select System Constants from the Section menu.

l Select the Email Reminder tab.

l Specify the default From Address, Reply To Address and Email Subject,
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l If you plan to use the Email Reminders feature, specify the default Days

between Reminders.

l Select the Send Reminders By Email If Possible check box if you would like

to use email reminders or email statements functions.

l Click OK to update this information.

See also Email Reminders under the System Constants chapter.

Send an Email from a Client, Patient or Referral Source Record
You can send an email directly from a Client, Patient or Referral Source record by clicking the

Email icon anywhere it is found on the record. For example, there are three areas on the Patient

record that can be used to initiate an email. You can send email:

l To a Client by selecting the email icon next to the Owner information in Clinic

Information.

l To Referral Source #1 by selecting the email icon next to the Referral #1

entry box in Clinic Information.

l To Referral Source #2 by selecting the email icon next to the Referral #2

entry box in Clinic Information.

To send an email:

l From a Client, Patient or Referral Source record, click the Email icon beside the

name of the person you wish to email.

l If there is not an email address for the person receiving the email you will be

asked to provide the email address.

l The default email program used by your system will launch with your clinic

information imbedded in the footer of the email.

l Type your note and select Send.
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Sending an Email from the Word Processing Area
In cases when your clients are not in the clinic to receive a report or when you need to send doc-

umentation to referral staff, you can send the body of your DVMAX generated Word Processing

documents with the DVMAX email functions.

To send a Word Processing document by Email:

l Select the Word Processing tab from the Patient, Client or Referral Source rec-

ord.

l Open a template or blank document and complete the document.

l Select the Email icon the bottom right of the Word Processing window.

l If an email address has not been entered to the Client or Referral Source Infor-

mation you will be asked to enter the destination email.

l The default email window will appear with the body of the Word Processing doc-

ument embedded in the email.

l Click Send.

Estimates
An estimate in DVMAX is a draft of an invoice that helps a client decide whether to purchase

the services listed on it. When the client decides to purchase, you can convert the estimate to an

actual invoice. You can also use an estimate to record a deposit on future bills.

Unlike invoices, estimates alone have no effect on financial records or medical histories of the

clients and patients named on the estimate.

Create an Estimate: An Overview
In order to create an estimate, you must be viewing the record of the client for whom you wish

to create the estimate, and that client must have at least one patient. Estimates, unlike invoices,

can be created only from a client record.
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There are several steps involved in creating an estimate. The steps below are a general over-

view. For more detailed information on each step, see About Estimate Data Entry.

To create an estimate:

l Open the Client record for whom you want to prepare an estimate.

l Choose Create an Estimate from the Client drop-down menu.

l If prompted, choose a Primary Provider for this estimate. The provider you

choose will be the default doctor on all lines of the estimate. The Estimate win-

dow displays.

CONTROL+E (COMMAND+E on Macintosh) is a keyboard shortcut for Create an Esti-

mate.

l In the Title field, type a title for this Estimate, if desired.  The title, if provided,

will become part of the Client’s financial history on the associated Estimate rec-

ord on the Finances tab of the Client record.  The Title can be up to 80 char-

acters, although a short title is recommended.

l The current date will be in the Date field. Type a different date in the date field

if needed. The default format for dates in DVMAX is MM/DD/YYYY.

If you eventually convert this estimate to an invoice, changing the date here can change the

date the invoice will become due, and affect interest you charge your client. For more infor-

mation, see the Invoices chapter of this manual.

l The Primary Provider you chose before the Estimate dialog opened will be

listed in the Primary Provider drop-down list.  You can choose a different staff

member who will appear by default on all new line items of the Estimate from

the Primary Provider drop-down list.

l Type the details of the product or service you are estimating in a Line Item row.

Include the Staff member; the Patient this product or service is for, the Item

Code of the product or service, and the Low Quantity and the High Quantity.

Each product or service uses one line item row. To add a line item row, click

Add Line.

l Record any deposit your client is making in the Deposit Information area. 
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l Type any notes you need in the Notes field. The text that is initially in the field

comes from System Constants (see The Default Estimate Note elsewhere in

this chapter for details). You can edit this text as needed.

l DVMAX updates the Subtotal, Discount, Taxes, Total, Deposit and Estimated

Balance fields automatically as you fill out the estimate. You cannot type any-

thing into these fields. For more information, see the Payment Information sec-

tion of this chapter.

Save an Estimate
To save an estimate:

l By default, DVMAX will print an estimate when you save it. If you do not wish

to print this estimate, click to deselect the Print checkbox

l Click OK to post the estimate and print it (provided Print has been selected).

DVMAX will return you to the window you were on when you created the esti-

mate.

-OR-

l Click OK and Next to post the estimate and print it (provided Print has been

selected). DVMAX will return you to the Find window to search for another

Client or Patient record.

Print an Estimate
To print an estimate from the Estimate dialog:

l Ensure that the Print checkbox is selected before you click OK. When you click

OK, the estimate will be printed.

To print an estimate from the Client Finances tab:

l Click once to highlight the estimate you want to print from the Recent Finances

or All Finances area of the Client Finances tab.

l Choose Print Item from the Finances menu.
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About Estimate Data Entry

Estimate Line Items
You record each different type of product or service on the estimate as a line item. If you plan to

sell multiples of an item, that sale is a single line item. For example, if there are 2 cans of dog

food and one can of cat food, 2 line items will be on the estimate: one for the dog food and one

for the cat food.

You can use TAB to move forward between fields in line item rows. You can use

SHIFT+TAB to move backward between fields in line item rows.

Completing Line Items on an Estimate
To complete a line item on an estimate:

l If necessary, change the Staff on this line item. You can change the staff for a

line item by clicking the triangle in the Staff field and selecting a different staff

member from the drop-down list that appears.

The staff member who appears by default on all line items is chosen in the Default Dr.

drop-down list. See Filling Out an Estimate.

l If necessary, change the Patient on this line item. You can change the patient

for a line item by clicking the triangle in the Patient field and selecting a dif-

ferent patient from the drop-down list that appears.
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l Type the code of the item being sold in the Code field. The Description field

will fill in automatically and is usually not editable.

If you do not know the code for the item you wish to enter, click inside the Bill Code field,

type in the first character of the code and press TAB. This will open a window listing available

codes.

Some codes have descriptions that you can or must edit. If you enter this kind of code,

DVMAX will play an alert sound and move the cursor to the Description field.

Some codes have prices that you can supply or change. If you type this kind of code,

DVMAX will move the cursor to the Lo Price field.

l The Lo Qty (Low Quantity) and Hi Qty (High Quantity) fields work together to

form a possible range of quantities for this line item. Type the quantity that is at

the low end of the range in the Lo Qty field. Type the quantity that is at the high

end of the range in the Hi Qty field. If there is an exact quantity for this line

item, these two fields can contain the same number.

l DVMAX will automatically fill in the Lo Ext, Hi Ext and Tax fields.
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Add Blank Lines to an Estimate
A setting in System Constants controls the number of available lines on an estimate. If the

default number of lines is not sufficient for your estimate:

l Click the Add Line button. DVMAX will create a new blank line and place the

cursor in its Code field.

For more information on the default number of lines on an estimate, see System Constants That

Affect Invoicing elsewhere in this chapter.

Removing Empty Lines from an Estimate
If there are more lines on an estimate than you need, DVMAX will automatically remove them

when the estimate is printed. Empty lines do not appear on printed estimates. There is thus no

need to remove unused lines.

Editing a Line Item on an Estimate
Double-click in the field you wish to edit, and type the new value.

Some fields are not editable (Tx, Lo Ext and Hi Ext), and others are not editable most of the

time (Description, Lo Price and Hi Price).

Fields dependent on the value you change will update automatically when you enter your new

value.

You can also edit a line item by bringing up the Edit Line Item window. For more information,

see The Edit Line Item Window.

Deleting a Line Item on an Estimate
To delete a line item:

l Click once on the line item you wish to delete.

l Click the Delete Line button.

The Edit Line Item Window on an Estimate
The Edit Line Item Window allows you to make changes that apply to a single line item on an

estimate. You must use the Edit Line Item Window to apply a discount to a single line item.
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To open the Edit Line Item Window:

l Click in the Qty field of the line item you wish to edit.

l Click the Edit Line button.

l The Code, Description, Lo Qty, Hi Qty, Lo Price, Hi Price, Lo Ext, Hi Ext

and Tax fields function identically to their counterparts on the main Estimate

dialog. See Line Items or more information.

Changing the Patient on an Estimate Line Item
To change the Patient for this line item:

l Choose the new Patient's name from the Patient drop-down menu.

l Click OK to save your changes.

Changing the Staff on an Estimate
To change the Staff for a line item:

l Select the line item you want to edit.

l Choose the new Staff member’s name from the Staff drop-down menu.

l Click OK to save your changes.

Not all items are discountable. For more information on discountable items, see the Bill

Items chapter of this manual.

Accepting Deposits on an Estimate
Line items on an estimate have no effect on a client’s balance; an estimate is merely a tool to

help a client decide on a purchase. When a client accepts an estimate, though, your practice may

require a deposit before you perform any services listed on the estimate.

DVMAX allows you to enter deposits directly on the estimate dialog.
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When an estimate is saved, DVMAX will post any deposit received to the client’s financial his-

tory.

A deposit will not appear on a saved estimate should you view it later, but it will appear in

the client’s past transactions as listed on the client Finances tab.

To accept a deposit on an estimate:

l Select a deposit method for this deposit from the Deposit Method drop down

menu.  For more information on accepting payment using DVMAX’s integrated

credit and debit card processing feature, see Integrated Credit and Debit

Card Processing.

If you do not know the code for the payment method you wish to enter, click inside the

Code field, type in the first character of the code and press TAB. This will open a window list-

ing available codes.

l Type the amount of this deposit into the Amt field. DVMAX may have auto-

matically entered a payment amount (equal to the client's Estimated Balance)

in the Amt field.

l You can safely replace this number with the amount of the client's deposit, if dif-

ferent. A System Constant controls whether DVMAX automatically fills in a

payment amount – see System Constants That Affect Estimates elsewhere in

this chapter for more information.

l Type any relevant notes about this deposit into the Deposit Note field. Deposit

Notes will appear on the printed estimate.

Use the Deposit Note field to record the estimate number, e.g. "Deposit on Estimate

#12345." This will make the listing of this deposit on the client Finances tab clearer in the future.
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Discounts on Estimates
You can apply a discount to any or all line items on an estimate. Line items that have a discount

applied are marked with an asterisk (*) following their description.

If a client has a Default Discount, DVMAX will automatically discount line items on an esti-

mate for this client. You can override this default discount.

Applying a Discount to All Line Items on an Estimate
To apply a discount to all line items:

l Choose Discount from the Estimate menu on the DVMAX main screen. The

Discount Settings window appears.

l Type a percentage in the Discount Percentage field. DVMAX will discount the

price of all items on the invoice the percentage you specify here.

l Select the Discount All Items radio button to apply the discount to all items on

the estimate. Select the Discount Only Discountable Items radio button to have

DVMAX apply the discount only to items marked as discountable. For more

information on the difference between these settings, see the Bill Items chapter

of this manual.

l Click OK to apply the discount.

The Global Discounting setting in System Constants controls the availability of the Dis-

count All Items radio button. If the Discount All Items radio button is not available, you will

not be able to apply a discount to line items that are not specified as discountable in their Bill

Item setup. For more information, see the Bill Items chapter of this manual, and the System Con-

stants that Affect Invoicing section of the Invoicing chapter of this manual.

Applying a Discount to a Single Line Item on an Estimate
To apply a discount to a single line item:

l Click in the Qty field of the line item you wish to discount.

l Click the Edit Line button.

l The Edit Line Item Window appears.
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l Type the percentage of the discount in the Discount field.

l Click OK to save your changes.

Not all items are discountable. For more information on discountable items, see Bill Items.

Editing a Saved Estimate
DVMAX allows you to revise an estimate at any time up until you convert it to an invoice. This

allows you to add or remove items as needed to reflect changes that may arise as time passes.

Each time you modify an estimate, DVMAX saves it as a new estimate.

DVMAX stores modified estimates as separate items in a client’s financial history. This

allows you to see the progress of an estimate over time.

To edit an estimate:

l Double-click an estimate in either the Recent Finances or All Finances area of

the client Finances tab.

-OR-

l Click once on an estimate to highlight it from the list in either the Recent

Finances or All Finances area of the client Finances tab, then choose View

Item from the Finances menu of the DVMAX main screen.

If you prepared the estimate recently, it will appear in the Recent Finances area of the

Financial Information tab. If some time has passed since you prepared the estimate, it will

appear in the All Finances area of the Financial Information tab.

l DVMAX will open the estimate and you can now revise it as needed. See the

Filling Out an Estimate section of this chapter for details on working with the

Estimate screen.

l When you have finished making changes to the estimate, click OK to return to

the Financial Information tab.
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l Your newly revised estimate appears as a new line in the Recent Finances

area. It is titled “Est x, for $y/z (Patient Name)”, where x is a unique estimate

number generated by DVMAX and y and z are the high and low ranges of the

estimate, respectively. Patient Name is the name(s) of the patient referred to in

the estimate.

Deleting Saved Estimates
You cannot delete an individual estimate from DVMAX. You can, however, delete a group of

Estimates that are older than a date you supply.

To delete a group of old Estimates:

l From the Section menu of the DVMAX main screen, choose General Man-

agement. The Management Functions screen appears.

l Click the Utilities tab on the Management Functions dialog.

l Click to select the Special Routines radio button.

l Click OK. The Special Routines dialog appears.

l Click to select the Delete Old Estimates from DVMAX radio button.

l Click OK. The Estimate Deletion dialog appears.

l Type a number of days into the Delete Estimates Older Than field.

l Click OK.

l If DVMAX finds Estimates older than the number you supplied, you will be

asked to confirm that you want to delete them.
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l Click Delete to delete the estimates.

You must have administrative privileges to delete Estimates from DVMAX.

Converting an Estimate to an Invoice
DVMAX makes converting an estimate to an invoice simple. To convert an estimate to an

invoice:

l Double-click an estimate in either the Recent Finances or All Finances area of

the client Finances screen.

-OR-

l Click once on an estimate to highlight it from the list in either the Recent

Finances or All Finances area of the client Finances tab, then choose View

Item from the Finances menu of the DVMAX main screen.

If you prepared the estimate recently, it will appear in the Recent Finances area of the

Financial Information tab. If some time has passed since you prepared the estimate, it will

appear in the All Finances area of the Financial Information tab.

l Choose Convert into an Invoice from the Estimate menu of the DVMAX main

screen.

l DVMAX will now ask you if you are sure you wish to convert this estimate to

an invoice. Click Convert to continue with the conversion, or Stop to stop the

process and return to the Estimate screen.

l DVMAX will create a new, unfinished invoice containing all the information

from your estimate. This new invoice will appear on the screen immediately, in

place of the old estimate. You may work with the new invoice as you would any

invoice. For more information on working with invoices, see the Invoices chap-

ter of this manual.

l The new invoice will have an invoice number identical to the old estimate

number. Line item dates on the new invoice are set to the invoice date (usually

the current date).

l Once you convert an estimate to an invoice, the estimate becomes read-only;

you will no longer be able to make changes to the original estimate.
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The Keep Line Item Providers When Converting EstimatesSystem Constant controls

whether Staff field selections are preserved in the process of converting an Estimate to an

Invoice. If the setting is selected, the Invoice’s line items will have staff field selections that

match those on the originating Estimate. Otherwise, DVMAX forces each line item’s Staff field

selection to the Estimate’s Primary Provider. See the System Constants that Affect Estimates

section of this chapter for more information.

If you have back-dated an estimate for any reason, this can affect the date an invoice

created from this estimate becomes due, and the interest you charge your clients. For more infor-

mation, see System Constants That Affect Invoicing in the Invoicing chapter of this manual.

Adding a New Patient from an Estimate
You can add a new patient to the DVMAX system directly from the estimate. This can save

time when an existing client brings a new patient in for treatment.

To add a new patient from the Estimate:

l Choose Add a New Patient from the Estimate menu. The Quick Entry For

New Patient window appears.

l Provide information for the new patient and click OK.

l The new patient is now available for this client.

System Constants that Affect Estimates

Default Estimate Note
The text that initially appears in the Notes field of the Estimate is controlled by a System Con-

stant. To set the default text of the Estimate Note:

l Choose System Constants from the Section menu on the DVMAX main

screen.
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l Choose Invoice Notes from the System Constants menu on the DVMAX main

screen, or click the Invoice Notes tab

l Type the text you want to appear in the Default Estimate Note field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Your default estimate note should contain general information that is relevant before the pro-

cedures on the estimate are performed. An example of this is pre-surgical instructions.

Default Lines on New Invoices and Estimates
This setting determines the number of blank lines that appear on a new estimate as well as

invoices. For more information about line items, see About Estimate Data Entry elsewhere in

this chapter. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings, or click the Invoice Settings tab.

DVMAX Practice V8.6 - User Manual



- 367 -

l Type the number of empty lines you want on new invoices and estimates in the

Default Line Items on New Invoice field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Discount Label for Estimates and Invoices
The text entered in this setting will appear on printed estimates and invoices beside the discount

amount. The default text is Discount. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Type a discount label in the Discount Label field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Include Bill Codes on Printed Invoices and Estimates
This setting controls whether DVMAX prints Bill Codes as part of the description of line items

on the estimate. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Select the Include Bill Codes on Printed Invoices and Estimates checkbox to

print Bill Codes on the estimate. Deselect the checkbox to have DVMAX sup-

press printing of Bill Codes.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Default Number of Estimate Copies to Print
This setting tells DVMAX how many copies of an estimate or invoice to print. To view or change

this setting:
l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab. The Invoice Settings

screen appears.

l Type a number in the Invoice Copies to Print field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Keep Line Item Providers When Converting Estimates
This setting controls whether an Invoice created from an Estimate retains individual line item

Staff selections from the Estimate. If this setting is checked, line items on the invoice's Staff

fields will contain the same values as on the originating Estimate. If this setting is unchecked,
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DVMAX will force each line item's Staff field to contain the Default Provider from the Esti-

mate.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the SysConstants drop-down menu on the DVMAX main screen, choose

Invoice Settings or click the Invoice Settings tab.

l Select the Keep Line Item Providers When Converting Estimates checkbox

to keep the Estimate’s line item Providers on a resulting Invoice. Deselect the

checkbox to have DVMAX force line items to have the same value as the

Invoice’s default provider.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Max Discount Percentage for Estimates
The number specified in this setting is the maximum discount that can be applied to any item on

an estimate or invoice. If no number is specified, the maximum discount is 0% - i.e., no discount

can be applied on an estimate or invoice.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Type a percentage in the Max Discount Percentage field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Print Practice Heading on Invoices and Estimates
If this setting is selected, DVMAX will print your practice's name and address at the top of an

estimate or invoice. If you are printing estimates on letterhead, turn this setting off.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Select the Print Practice Heading on Invoices checkbox to tell DVMAX to

print your practice's name and address at the top of estimates.
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l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Remove Price Details and Tax Column From Printed Estimates
This setting controls whether the Lo Price, Hi Price and Tx columns appear when you print the

estimate. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab..

l Select the Remove Price Details and Tax Column From Printed Estimates

check field to suppress printing of these columns. Deselect the checkbox to have

DVMAX print these columns on the estimate.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Suppress Auto-Entry of Payment Amount on Estimates
This setting tells DVMAX whether to automatically fill in the client's balance in the Deposit

Amount field when accepting a deposit on an estimate. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the SysConstants drop-down menu on the DVMAX main screen, choose

Invoice Settings or click the Invoice Settings tab..

l Select the Suppress Auto-Entry of Payment Amount checkbox to tell

DVMAX not to fill in a deposit amount. Deselect the checkbox to have

DVMAX automatically place full payment in the deposit amount field.
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l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Use Global Discounting on Invoices and Estimates
This setting tells DVMAX whether to allow discounting of all items on an estimate. If this set-

ting is not in effect, only items specified as discountable can have discounts applied to them.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Select the Use Global Discounting on Invoices checkbox to tell DVMAX that

all line items on an estimate can be discounted. Deselect the checkbox to

respect the discountable setting of a Bill Item.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Use Single-Click for Line Item Entry on Estimates
This setting determines whether a single or double-click in a line item field is required to edit a

line item on an invoice or estimate. If this setting is selected, DVMAX will allow editing of a

line item field with a single-click into that field. If this setting is deselected, you must double-

click a line item field to edit it inline. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings or click the Invoice Settings tab.

l Click to change the Use Single-Click for Line Item Entry checkbox.
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l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Fax Client
Licensing the Fax Client

Faxing is an add-on feature in DVMAX that requires a license. To enable faxing, call DVMAX

Tech Support at 1 (800) 950-5455 to discuss adding faxing to DVMAX.  Please have your

DVMAX ID ready when calling.

DVMAX also offers support online at DVMAX http://users.dvmax.com.

Setting up the Fax Client in DVMAX
To use the Fax Client, your terminal must have:

l An internet connection.

l A Fax Client. Contact DVMAX Technical Support for information on acquiring

the appropriate fax client.

l A DVMAX fax license to run the faxing options.  Contact DVMAX Technical

Support for information on licensing options.

Setting up the DVMAX Fax client is done by DVMAX Technical Support. The Fax client

details are located under the User tab in System Constants.  These details should not be mod-

ified without direction from DVMAX Technical Support.

Using the Fax Client
The Fax Client allows DVMAX you to digitally fax Word Processing documents to clinic con-

tacts such as referral sources.  You can send a fax from a referral source record or from a

Client or Patient record.

Send a Fax from a Referral Source Record
To send a fax from a referral source record:

l From the Section menu, choose Clients & Patients.

-OR-

l From the Command Palette click the Patient or Client icon.

l From the Find dialog, select Referral Sources from the Search For menu.
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l Perform a search for the referral source you would like to fax.

To be able to send a fax each referral source requires a valid fax number to be entered in

the source’s Fax # field.

l Select the Word Processing tab of the Referral Source window.

l Open the WP document you want to fax.

l Edit the WP document as needed.

l To fax: while holding down the Shift key, select Print from the WP File menu.

l The Fax dialog will display.

l From the Fax dialog, complete the Subject, Recipient, Company, and Fax

number as needed.  Note that when faxing a WP document from a Referral

Source record, the fax To field is set to the name of the referral source and the

Company field is set to the practice name of that referral source.

l Once you have entered the required information in the Fax dialog, click Send.

Referring Vet fax numbers are included in a patient's printed history.

Send a Fax from a Patient or Client Record
The process for sending a fax from a patient, client or referral source record is the same.  When

sending from a patient or client record, the default To and Company name details will be

derived from the Referred By field in the Client or Patient record.  These details can be mod-

ified before sending, when the Fax dialog is open.
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A “Fax Sent” MRE is added to a patient’s History whenever a fax is successfully sent from

a patient WP document.  This setting can be turned off via Advanced Settings.  Contact

DVMAX Technical Support for more information on Advanced Settings.

To send a fax from a Patient (or Client) record:

l From the Patient or Client record, select the Word Processing tab

l Open the WP document you want to fax.

l Edit the WP document as needed.

l To fax: while holding down the Shift key, select Print from the WP File menu.

l The Fax dialog will display.

l From the Fax dialog, complete the Subject, Recipient, Company, and Fax

number as needed.

l Once you have entered the required information in the Fax dialog, click Send.

The default To, Fax # and Company name values in the Fax dialog are derived from the

Referred By field in the Client/Patient record, provided that there is data in the Referred By

field.
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Financial Reports
DVMAX provides a variety of reports that can help you with all aspects of the financial man-

agement of your practice, from simple sales totals to complex accounts of revenue generated by

each provider in your clinic. Generally, financial reports gather, sort and total information from

invoices and transactions you post in your day-to-day work with DVMAX. This chapter reviews

all financial reports in DVMAX.

There are a number of reports that you should run at year-end. For more information about year-

end reports, see Year-End Procedures and Reports.

Accessing Reports
You can generate any financial report available in DVMAX from Reports list on the Com-

mand Palette. To open the Reports list:

l Click the Reports button on the Command Palette. A list of available reports

appears.

You can also generate financial reports from the Reports tab on the Management Functions

dialog. To open the Management Functions screen:

l Choose General Management from the Section menu on the DVMAX main

screen.

Reports launched from the Command Palette or from the Reports tab under General Man-

agement will appear in the Window List.

Printing and Exporting Reports
You can print all financial reports in DVMAX. You can also export some reports to a text file

that you can then open in a spreadsheet application such as Microsoft Excel. The reports avail-

able for export are:

l Full Details Transaction Summary (Transaction Summary Report)

l Daily Totals Transaction Summary (Transaction Summary Report)

l Totals Only Transaction Summary (Transaction Summary Report)

l Detailed Sales Report

l Receivables Report

l Sales Tax Charged Out Report
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Setting DVMAX to Allow Exporting of Reports
A setting in System Constants controls whether DVMAX gives you the option to export reports.

To see or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants dialog, select Prompt to Print or Export Financial

Reports to have DVMAX make the export option available. Deselect the check-

box to make printing reports the automatic choice.

l Click OK to save the setting.

Audit Trail Reports
Audit Trail reports list all transactions (invoices, payments, returns, refunds, etc.) for a time

period you supply. Unfinished invoices from outside the time period you supply are also included

in the report.

There is an Advanced Setting which controls whether Estimates appear in the audit trail

reports. By default, Estimates do not appear in these reports. Payments recorded on Estimates

will always appear. If you want to modify the default setting, please contact Technical Support

for assistance in making changes to any Advanced Settings.

The Audit Trail Detail report lists line item details on invoices, whereas the Audit Trail Sum-

mary report does not.
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Audit Trail Summary Report
The Audit Trail Summary report summarizes transactions by client for the time period you

specify. For each transaction, DVMAX lists the date, type of transaction, the patient, and the

transaction amount.

Generating an Audit Trail Summary Report
To generate an Audit Trail Summary report:

To generate a year-end ReceivablesReport:

l Click the Reports button on the Command Palette. A list of available reports

opens.

-OR-

l Choose General Management from the Section menu on the DVMAX main

screen.

l Double-click Audit Trail Summary Report to open the Audit Trail Summary

dialog.

l Type the Start Date and End Date for which you wish to run the report into the

appropriate Date Range Entry field. The default format for dates in DVMAX

is MM/DD/YYYY.

l Type a start time and end time for the report into the Start Time and End Time

fields. The Start Time is the time of day on the Start Date from which to

include transactions for the report. The End Time is the time of day on the End

Date after which no transactions will be included in the report.

You may use either a 24-hour clock for time entry, or you may type AM or PM after the

time. For example, you can type two o’clock in the afternoon as either 14:00 or 2 PM.

l Click OK to generate the report.

Audit Trail Detail Report
The Audit Trail Detail report lists all transactions, including line item information, posted in the

time period you specify. Transactions are grouped by client.

For each invoice in the report, DVMAX provides the following information:

l The invoice date.

l The client.

l The invoice number and status (finished or unfinished).
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l The total dollar amount.

l The line items on the invoice.

For each line item, DVMAX provides the following information:

l The patient name.

l The category.

l The Bill Item code.

l The description.

l The provider.

l The discount percentage.

l The tax percentage.

l The quantity.

l The dollar amount.

Generating an Audit Trail Detail Report
To generate an Audit Trail Detail report:

l Click the Reports button on the Command Palette. The Report List appears.

l Double-click Audit Trail Detail Report. The Audit Trail Detail screen

appears.

l Type a start date and end date for the report in the Start Date and End Date

fields. The default format for dates in DVMAX is MM/DD/YYYY.

l Type a start time and end time for the report into the Start Time and End Time

fields. The Start Time is the time of day on the Start Date from which to

include transactions for the report. The End Time is the time of day on the End

Date after which no transactions will be included in the report.

You may use either a 24-hour (military) clock for time entry, or you may type AM or PM

after the time. For example, you can type two o’clock in the afternoon as either 14:00 or 2 PM.

l Click OK to generate the report.

Detailed Sales Reports
A Detailed Sales report gives you comprehensive information on your practice’s sales for a

given time period. You can choose from many options when generating a Detailed Sales Report. 
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You can see sales totals grouped by Doctor and by Category, and by combinations of these group-

ings. You can also choose to report on a single Bill Code or Bill Code category.

Each variety of Detailed Sales report requests a time period to use for the report, and provides

you the choice of either printing or exporting the report to an Excel-compatible text file.

The Detailed Sales report can be used as a basis for staff compensation in your practice.

Generating a Detailed Sales Report
To generate a Detailed Sales report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Detailed Sales Report from the reports list.

l Choose the doctor for the report from the Doctor drop-down list at the top of the

Report Options dialog. The default is to report on all doctors in your practice.

l Type a start date and end date for the report in the Start Date and End Date

fields. The default format for dates in DVMAX is MM/DD/YYYY.

l Choose a Report Type (Dr. & Category, Dr. & Patient, Dr. & Item, Category,

or Category & Item) by clicking the appropriate radio button. For more infor-

mation on these report types, see Sales Summary Options.

l If you wish to report on a particular item or Bill Code only, type the item’s Bill

Code in the Bill Code field.

You can use the @ wildcard in the Bill Code box. For example, if all your Bill Codes for

medications begin with rx, type rx@ in the Bill Code box to limit the Detailed Sales report to

medications.

l Click OK to generate the Detailed Sales Report. DVMAX will begin com-

piling the report. The time it takes to generate the report depends on the amount

of data DVMAX needs to sort through and the speed of your computer.
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l When the report is ready, DVMAX will ask you if you want to print or export

the report.

l Click Export to export the report to an Excel-compatible file on your computer.

-OR-

l Click Print to print the report.

Sales Summary Options
You can choose from the following types of Detailed Sales Reports. Each type of report com-

piles information from invoices and transactions recorded during the requested time period.

Doctor and Category Detailed Sales Report
DVMAX will list sales totals, grouped by category, for each doctor selected to be on the report.

Listed on a line under every doctor on the report are:

l The total sales amount (in dollars) for each category.

l The % of total sales represented by each category.

l The cost to your practice of each category.

l Your profit from each category.

DVMAX also totals each of the values listed above for each of the doctors on the report. Grand

totals are provided at the end of the report.

For more information on Categories, see Inventory Management and Bill Items.

Doctor and Patient Detailed Sales Report
The Doctor and Patient Detailed Sales Report lists sales totals, grouped by patient, for each

doctor selected to be on the report. Listed on a line under every doctor on the report are:

l The name of the patient and client to whom an item was sold

l The item code and description of the item sold

l The amount the item was sold for

l The cost of the item to your practice

l Your profit from the sale of the item

DVMAX also totals each of the values listed above for each of the doctors on the report. In addi-

tion, DVMAX presents each doctor’s percentage of your practice’s total sales for the requested

time period. Grand totals are provided at the end of the report.

Doctor and Item Detailed Sales Report
The Doctor and Item Detailed Sales Report lists sales, grouped by bill item, for each doctor

selected to be on the report. Each item sold by a doctor is listed under that doctor, and the
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following information is provided for each item sold:

l The quantity sold.

l The bill item code and description.

l The item’s category.

l The dollar amount for which the item was sold.

l The percentage of total sales accounted for by this item (in the time period being

reported on).

l The cost to your practice of this item.

l Your profit from the sale of this item.

DVMAX also provides a subtotal, on a per-category basis, for each of the values listed above.

A subtotal is also provided for each doctor. Grand totals are provided at the end of the report.

The Doctor and Item report differs from the Item report in that it breaks out sales by doctor.

The Doctor and Item report differs from the Doctor and Category report in that the Doctor

and Item report lists individual item sales.

Category Report
The Category Detailed Sales report lists sales for a given time period, grouped by category.

The following information is provided:

l The dollar amount of sales of each category

l The percentage of total sales accounted for by each category

l The cost to your practice of each category

l Your profit from each category

DVMAX presents grand totals at the end of the report.

The Category report differs from the Doctor and Category report in that it does not break out

category sales by doctor. The Category report is like a simplified version of the Item report.

Item Detailed Sales Report
The Item Detailed Sales report lists item sales for a give time period, grouped by category.

Each item sold is listed under its category, and the following information is provided:

l The quantity of the item sold.

l The bill item code and description.

l The item’s category.

l The dollar amount for which the item was sold.

l The percentage of total sales accounted for by this item (in the time period being

reported on).

l The cost to your practice of this item.

l Your profit from the sale of this item.

DVMAX also provides a subtotal, on a per-category basis, for each of the values listed above.

Grand totals are provided at the end of the report.

DVMAX Practice V8.6 - User Manual



- 383 -

The Item Detailed Sales report is similar to the Category Detailed Sales and the Doctor and

Item report. It differs from the Category report in that it lists individual item sales where the

Category report does not. It differs from the Doctor and Item report in that it does not break

out information by doctor.

Invoicing Reports
DVMAX provides five reports that allow you to see how effectively your practice is invoicing.

For information on invoices, see the chapter Invoices.

Unfinished Invoices Report
This report lists all unfinished invoices in your practice. For each unfinished invoice, DVMAX

lists the invoice number, client and patient name, the current total on the invoice, and the date

the invoice was last modified.

Generating an Unfinished Invoices Report
To generate an Unfinished Invoices Report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Unfinished Invoices Report from the report list.

l DVMAX will tell you how many unfinished invoices are on file.

l Click OK to close the message box and print the report.

Unfinished Invoices by Doctor Report
The Unfinished Invoices by Doctor report lists each doctor’s unfinished invoices. Each unfin-

ished invoice appears under the responsible staff member’s name. The report lists the invoice

date and number, the doctor’s department, the primary patient and the current total on the

invoice.

Generating an Unfinished Invoices by Doctor Report
To generate an Unfinished Invoices by Doctor report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List appears.

l Double-click Unfinished Invoices by Doctor Report.
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Outstanding Invoices by Doctor Report
This report generates a listing of all invoices that have not been paid, sorted by doctor. DVMAX

lists each outstanding invoice’s date, number, client, client phone number, and total with tax.

In addition, DVMAX supplies the doctor’s share (as a percentage) of the total invoice and of the

outstanding receivable amount. These values are found in the Invoice Split % and O/S Share

columns, respectively.

Generating an Outstanding Invoices by Doctor Report
To generate an Outstanding Invoices by Doctor report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List appears.

l Double-click Outstanding Invoices by DoctorReport.

Average Invoice per Doctor Report
The Average Invoice per Doctor report presents, for each doctor or provider in your practice:

l The number of invoices posted.

l The average dollar amount per invoice.

l The average payment received per invoice, at the time the invoice was posted.

l The total dollar amount billed.

l The ratio of average dollar amount billed per invoice to average payment

received per invoice, expressed as a percentage.

This report also calculates the combined values of the items listed above for all the doctors in

your practice.  You may specify any date range you desire for these calculations. The default is

the current month.

This report uses the Primary Provider for each invoice to calculate its totals. It does not

take into account any invoice line items assigned to providers other than the Primary Provider

listed at the top of the invoice. Because of this, the Average Invoices per Doctor Report

should not be used as the basis of staff compensation. Use the Detailed Sales Report instead.

This report uses only payments received at the time the invoice was posted. It does not take

into account payments received after the invoice was posted.

Generating an Average Invoice Per Doctor Report
To generate an Average Invoice Per Doctor report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Average Invoice Per DoctorReport. The Date Range Entry

dialog opens.

DVMAX Practice V8.6 - User Manual



- 385 -

l Type the time period for which you wish to run the report into the Date Range

Entry fields. The default format for dates in DVMAX is MM/DD/YYYY.

l Click OK to generate the report.

Invoice Share By Provider Report
The Invoice Share by Provider report gives you the average revenue per invoice per provider

in your practice. DVMAX lists each invoice in a given time period and sorts this list by pro-

vider, so that you can easily see each invoice a provider appeared on, and how much of the total

billed on that invoice was credited to that provider. The total number of invoices a provider

appeared on and the actual dollar amount billed by each provider is also given, along with the

weighted average gross per transaction.

You can choose to generate a summary report only, which does not provide any invoice details

but presents instead totals for each doctor.  Unlike the Average Invoices per Doctor report, this

report takes into account providers credited on an invoice’s individual line items.

This report uses only payments received at the time the invoice was posted. It does not take

into account payments received after the invoice was posted.

Generating an Invoice Share by Provider Report
To generate an Invoice Share by Provider report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Invoice Share by ProviderReport. The Report Options dialog

displays.

l Type the year for which you wish to run the report into the Start and EndDate

Range Entry fields. The default format for dates in DVMAX is

MM/DD/YYYY.

l Select the Show Invoice Details checkbox to list each invoice on the report.
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-OR-

l Deselect the Show Invoice Details checkbox to produce a summary report.

l Click OK.

Receivables Report
The Receivables report gives you a snapshot of what is owed to you by your clients (Accounts

Receivables), and what you owe them (Credit Balances) at the time you run the report.

Generating a Receivables Report
To generate a Receivables report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Receivables Report. The Receivables Report Options dialog

opens.

l Choose a Receivables report type (Totals Only, Full Report or Provider

Breakdown) by clicking the appropriate radio button. For information on the dif-

ferences between types of Receivables reports, see Receivables Report

Types.

l Click OK to generate the report. DVMAX may ask you if you want to print or

export the report.

l Click Export to export the report to an Excel-compatible file on your computer.

-OR-

l Click Print to print the report.
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Receivables Report Types
DVMAX can produce three variations on the Receivables report: a Full Report, a Totals-Only

report, and a Provider Breakdown report.

Full Report (Receivables)
The Full Report is the most comprehensive Receivables report type. For each receivable and

credit balance, DVMAX lists:

l The client’s name and ID.

l The amount and date of the client’s last payment.

l The client’s telephone number.

l Subtotals of the client’s total balance by age (current, 30 days, 60 days, and 90+

days).

l The total amount due from this client.

DVMAX also totals receivables and credits, and combines the two for an overall total. The per-

centage of your balances at each age (current, 30, 60 and 90+ days) is also calculated.

Totals-Only Receivables Report
The Totals-Only Receivables report is a summary of your Accounts Receivables and Credit Bal-

ances. For both Receivables and Credits, DVMAX shows aged amounts (current, 30 days, 60

days, and 90+ days) and the percentage of the total balance at each age. Overall totals are also

provided.

Receivables by Provider Report
The Receivables By Provider report type lists the total receivables produced by each provider

in your practice. The percentage accounted for by each provider is also calculated, as is a total

for your practice as a whole.

Any receivables not attributed to a provider are also listed on the report. Finally, totals for sales

taxes are also provided.

The Provider Breakdown report type is useful if you pay your providers based on pro-

duction.

Referral Reports

Referral Source Ranking Report
The Referral Source Ranking report allows you to see which hospitals and doctors refer the

greatest number of clients to your practice. The report is compiled from invoices posted in a date

range you specify. You can sort the report by revenue generated by referrals or by a simple refer-

ral count. You can also choose to report only those referrals whose first visit to your practice

was within the date range you specify.

The printed report groups referrals by hospital and then by doctor from that hospital.  The total

number of referrals and the total value of revenues are listed for each doctor and hospital.
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Generating a Referral Source Ranking Report
To generate a Referral Source Ranking report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Referral Source RankingReport. The Referral Ranking

ReportOptions dialog opens.

l Type the date range for the report into the Starting Date and Ending Date

fields. The default format for dates in DVMAX is MM/DD/YYYY.

l Click to select the Descending Referral Revenue radio button to have

DVMAX sort the report by revenue, with the highest numbers first.

-OR-

l Click to select the Descending Referral Count radio button to have DVMAX

sort the report by number of referrals, with the highest numbers first.

l Click the Include New Patient Referral Counts checkbox to report only those

referrals whose first visit to your practice was within your date range. Click

again to deselect the checkbox and report on all referrals.

l Select Include Patient Details if you would like to include them in the report.

l Click OK to generate the report.

Revenue Referral Report
The Revenue Referral report allows you to see which other hospitals or doctors have referred

the greatest amount of revenue to your practice. You can track either client referrals or patient

referrals. In either case, the value in the referral field of the client or patient record is used as

one of the bases for this report.

You can also specify the time period for which you would like to track referrals, and you have

the option to filter the report to show only new referrals during the time period you specify. If

you do not filter to show only new referrals, any referred client whom you invoiced during the

time period covered by the report will be listed.
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The printed report groups referred visits to your practice by clinic and doctor within that clinic.

For each referred visit, DVMAX lists the patient, client, the patient’s first and most recent vis-

its, the patient’s doctor, and the revenue generated by that visit. DVMAX calculates subtotals

for each referring doctor and clinic, and provides you with a grand total of revenue generated by

referrals.

Generating a Revenue Referral Report
To generate a Revenue Referral report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Revenue Referral Report. The Referral ReportOptions dialog

opens.

l Click the Patient Referral Source and First Visit Date radio button to use

referrers from patient records in the report.

-OR-

l Click the Client Referral Source and First Visit Date radio button to use

referrers from client records in the report.

l Type the time period you would like the report to cover into the Starting Date

and Ending Date fields in the First Visit/Invoice Date Range section of the

screen. The default format for dates in DVMAX is MM/DD/YYYY.

l Click to select the Report Only New Referrals checkbox to report only

referred clients or patients new to your practice. Deselect the Report Only

New Referrals checkbox to report any referred client or patient you invoiced in

the specified time period.

l Click OK to generate the report.

The Sales Tax Charged Out Report
This report provides a detailed listing of sales tax your practice has charged to clients in a given

time period, along with a total. Information for this report comes from invoices posted in

DVMAX.
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This report calculates the sales tax recorded on invoices as billed to clients, regardless of

whether the bill has been paid. The Show Sales Tax Collected reporting function can provide

you with monthly totals of sales tax actually collected. See Practice Financials for more infor-

mation.

For each day in the time period you request, DVMAX provides the following information:

l The number of invoices posted.

l Total sales.

l Taxable sales.

l Sales tax charged.

l Total sales with tax.

Grand totals of these values are presented at the end of the report.

Generating a Sales Tax Charged Out Report
To generate a Sales Tax Charged Out report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Revenue Referral Report. The Date Range Entry dialog opens.

l Type the time period for which you wish to run the report into the Start Date

and End Date fields. The default format for dates in DVMAX is

MM/DD/YYYY.

l Type a start time and end time for the report into the Start Time and End Time

fields.

l Click OK to generate the report. DVMAX may ask you if you want to print or

export the report.

l Click Export to export the report to an Excel-compatible file on your computer.

-OR-
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l Click Print to print the report.

Transaction Summary Reports
Transaction Summary reports provide information about all transactions recorded by DVMAX

during the time period you specify. The various types of transaction reports allow you to check

activity at your practice by viewing recent transactions individually, on a daily basis or in an

overall summary, making it easy to keep tabs on day-to-day activity.

About Transaction Summary Report Types
There are four different types of Transaction Summary reports: End of Day, Full Details,

Daily Totals and Totals Only.

The End of Day (EOD) Transaction Summary Report
The End of Day (EOD) report is the most comprehensive, and most commonly used, of the

Transaction Summary reports.

The EOD report is divided into six sections:

l Financial Summary

l Transactions Entered Out of Sequence

l Client Activity Summary

l Unfinished Invoice List

l Close-out Worksheet

l Average Transaction

The Financial Summary provides a list of all transactions for the requested time period.

DVMAX breaks this list down by transaction type, and then by date of entry within each trans-

action type. Each transaction type is totaled.

The following information is provided for each transaction:

l The posted date.

l Any accompanying notes or description.

l The client name.

l The dollar amount.

Transactions Entered Out of Sequence lists transactions recorded during the requested period

that were:

l Edited, reversed or voided during the requested time period.

l Post- or back-dated to fall outside the requested time period.

The Smart Summary option determines whether the transactions listed here appear in the trans-

action lists elsewhere in the report. For more information, see The Smart Summary Option.

DVMAX lists the following information about each out-of-sequence transaction:

l The posted date

l The transaction type and any accompanying notes or description
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l The client and the date/time the transaction was recorded

l The dollar amount

These additional items make it easier to trace the origins and reasons for each out-of-sequence

transaction:

l The Client Activity Summary lists every client with recorded invoice or pay-

ment activity dated in the requested time period. For each client, DVMAX lists

the amount invoiced, the amount paid, net paid or owed, and any notes that

accompanied the invoice or payment.

l The Unfinished Invoice List presents all the unfinished invoices in DVMAX,

regardless of the invoice’s date. DVMAX lists each invoice’s date, number,

client, patient and current dollar amount.

l The Close-Out Worksheet summarizes all transaction activity, grouping all bill-

ing and all payment activities in adjacent columns. By comparing the difference

between the “Billed Out” total and the “Collected” total you can determine the

expected change in the Receivables during the period. This allows you to

“close-out” the activity at the end of the day, assuring proper accounting of all

activities.

l The Receivable Totals section of the Close-Out Worksheet lists the receiv-

ables on the current date and as of the time the last EOD report was run.

l The Average Transaction report summarizes information about all invoices for

the requested time period. DVMAX presents the total number of invoices, the

average invoice amount, the total of all invoices, and the average payment per

invoice (as dollar amount and percentage).

The Average Transaction report uses payments made at the time of billing only. Deposits

and payments on account are not used.

Totals Only Transaction Summary Report
The Totals Only report is the simplest of the four Transaction Summary reports, providing a

total count and dollar amount for each transaction type recorded during the requested time

period. This report is useful for spotting trends and examining monthly summaries in your prac-

tice.

The Smart Summary option will eliminate redundant transactions from the totals.

DVMAX will not list these removed transactions in a “Transactions Out of Sequence” section

in the Totals Only report.

Daily Totals Transaction Summary Report
The Daily Totals report provides a daily subtotal of transactions for each transaction type

recorded in the requested time period. Each daily subtotal consists of a count and dollar amount.

This report is useful for spotting daily trends in your practice. It is also helpful, in combination

with the End of Day report, in checking for alterations in the financial activity of past days.
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The Smart Summary option will eliminate redundant transactions from the daily totals.

DVMAX will not list these removed transactions in a “Transactions Out of Sequence” section

in the DailyTotals report.

Full Detail Transaction Summary Report
The Full Detail report provides a list of all transactions for the requested time period. DVMAX

breaks this list down by transaction type, and then by date of entry within each transaction type.

Each transaction type is totaled.

The following information is provided for each transaction:

l The posted date.

l Any accompanying notes or description.

l The client name.

l The dollar amount.

DVMAX also presents a Transactions Entered Out of Sequence section in the Full Detail

report. This section lists transactions recorded during the requested period that were

l Edited, reversed or voided during the requested time period

l Post- or back-dated to fall outside the requested time period

The Smart Summary option determines whether the transactions listed under Transactions

Entered Out of Sequence appear in the transaction lists elsewhere in the report. For more infor-

mation, see The Smart Summary Option.

DVMAX lists the following information about each out-of-sequence transaction:

l The posted date.

l The transaction type and any accompanying notes or description.

l The client and the date/time the transaction was recorded.

l The dollar amount.

These additional items make it easier to trace the origins and reasons for each out-of-sequence

transaction.

Generating a Transaction Summary Report
To generate a Transaction Summary report:

l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The

Report List displays.

l Double-click Transaction Summary Report. The Transaction Summary

dialog opens.

DVMAX Practice V8.6 - User Manual



- 394 -

l Type a start date and end date for the summary in the Start Date and End Date

fields. The default format for dates in DVMAX is MM/DD/YYYY.

l Type a start time and end time for the summary into the Start Time and End

Time fields. The Start Time is the time of day on the Start Date from which to

include transactions for the report. The End Time is the time of day on the End

Date after which no transactions will be included in the report. Using a 24-hour

clock for time entry, you would type 00:00:00 into the Start Time field and

23:59:59 into the End Date field to specify a report for June 1.

You may use either a 24-hour clock for time entry, or you may type AM or PM after the

time. For example, you can type two o’clock in the afternoon as either 14:00 or 2 PM.

l Select Use date processed, not Transaction date if you wish to use the actual

calendar date the transaction was entered instead of the "Transaction Date", the

date the user enters on the Transaction form.

l Choose a Transaction Summary report type (End of Day, Full Details, Daily

Totals or Totals Only) by clicking the appropriate radio button. For information

on the differences between types of reports, see Transaction Summary Report

Types.

l Select Smart Summary to tell DVMAX to remove corrected transactions, or

other transactions that cancel each other out, from the report. For more infor-

mation, see The Smart Summary Option.

l Select New Page for Each Type if you would like DVMAX to start a new

page for each transaction type in the report.

l Click OK to generate the report. DVMAX may ask you if you want to print or

export the report.

DVMAX Practice V8.6 - User Manual



- 395 -

l If available, click Export to export the report to an Excel-compatible file on

your computer, or click Print to print the report.

l If you chose End of Day as your report type, DVMAX will ask you to update

the timer for the next end of day report.

l Click OK to record the current date, time and current receivables total for use in

the next end of day report. For more information, see Transaction Summary

Report Types.

The Smart Summary Option
The Smart Summary option tells DVMAX to remove edits, corrections, voids and similar redun-

dant transactions from the summary lists. A transaction is removed if it can be matched with a

reversing transaction in the requested time period for the report.

If the Smart Summary option is not selected, Invoices and Payments that were corrected or

voided will be included in the report totals. Totals will still balance out, but will be inflated in

comparison to the totals generated with Smart Summary selected.

DVMAX will always list all transactions for the requested time period. Transactions

removed from the main summaries by the Smart Summary option are listed in “Transactions

Out of Sequence” section of the report. You should verify the “Transactions Out of Sequence”

section after generating a Transaction Summary report.

Transaction Types Used in Transaction Summary Reports
DVMAX looks at the following types of transactions when generating a Transaction Summary

report:

l Invoices

l Chargebacks

l Credits

l Edited Charges

l Edited Credits

l Estimates

l General Charges

l Interest Charges

l Payments

l Refunds

l Returns

l Write-offs
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Custom Reports
Custom Reports are available from the General Management Reports tab, and from the

Reports button on the Command Palette. These reports are web-based; that is, they require an

internet connection to generate the report. DVMAX’s reporting engine allows custom reports to

be sent to the clinics independent of release cycle. The reporting engine respects existing

DVMAX security and logins; each report's security is mapped to an existing Practice security

group. CSS style sheets are used for display and printing. For more on Custom Reports, refer to

the Custom Reports chapter in this User Guide.

To generate Custom Reports, the webserver must be running, and you must have a valid IP

address.

To verify that the webserver is running:

l Log in to DVMAX as Administrator.

l From the Section menu, select System Constants.  Go to the User Settings tab.

l From the Web area of the dialog, verify that the web server is running and that

there is a valid Port number. If the webserver is running, the Web area will con-

tain the note “Web server is running on [port]”.  Refer to the chapter System

Constants for more information.

l Close System Constants.

About Finance-Related Custom Reports
Custom reports not only offer a powerful addition to DVMAX’s report generating function, but

the reports offer the data in a more presentation-ready layout. Reports are stored in the "cus-

tomReports" folder in the web folder. Each report is contained in its own folder inside the "cus-

tomReports" folder.

In each report's folder are two files:

l index.shtml - this is the report code.

l Definition.xml - the report definition. This contains the report's name, security

access, and description.

The name of the report and its description appear on the Reports list. For more detail on these

reports, refer to the Custom Reports chapter in this user guide.

Complete Audit Trail – All Transactions
Complete Audit Trail lists all transactions, broken down by client, for a given time period.  All

unfinished invoices are included, regardless of specified date.

Detailed Doctor Production
The Detailed Doctor Production report allows you to configure and perform bonus calculations by

provider. The report gathers information from the Detailed Sales Report, Receivables Report and

the Average Invoices per Doctor report.

DVMAX Practice V8.6 - User Manual



- 397 -

Detailed Sales Report
The Detailed Sales Report is the standard DVMAX sales report, which allows you to report on

any combination of doctors, time periods and bill items.

Discount Report
This report gathers all undefined discounts (global/default discounts, etc) and reports on them.  Sep-

arately, it reports on bill item discounts as well and then returns a grand total value.

Initial Referral Report
The Initial Referral Report provides a comparison of referral numbers between two time periods,

broken down by referring DVM, Practice and referral recipient.  It allows users to measure impact

of marketing efforts.

Invoice to Line Item Comparison Report
Find how an adjustable bill item is used on invoices. The output shows the invoice number, the

invoice total, whether the queried bill item was used and how much money was associated with it.

Multi-Site Detailed Doctor Production
This report allows you to configure and perform bonus calculations per provider.  It gathers infor-

mation from the Detailed Sales Report, the Receivables Report and Average Invoices Per Doc-

tor Report.

Price Increase/Revenue Projection
This report shows the top-selling items in your practice over the last 12 months, and what the net

increase in revenue would be were you to increase the prices of these items 5%, 10% or 15%.

Referral Line Item Report
The Referral Line Item report gathers invoice line items in a specified date range and category and

reports on patient, provider and referral revenue associated with them.  This report is meant to be

exported.

Species Revenue Report
A report that groups sales totals by species.

Transaction Report
This report lists all transactions of selected types recorded in the date range you specify. You can

report on one or multiple transaction types. Output can be sorted by client or by date, and copied

into a spreadsheet for further manipulation.

Generating a Custom Report
l Click the Reports button on the Command Palette, or choose General Man-

agement from the Section drop-down menu, and click the Reports tab. The
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Report List displays.

l The Standard and Custom report lists display. Double-click the report in the Cus-

tom list you want to generate. The report opens in a new browser window. You

may be required to log in before you can run the report.

Adding a New Custom Report to the Custom Report List
When a new report is received (typically by e-mail from your SSI technical support), you must

place it in its proper folder.

Only alphanumeric codes and the underscore character can appear in the XML element def-

initions.

To add a new custom report:

l From the Section menu, select System Constants. Click the User Settings

tab. In the Custom Report section, click Reload From Server.
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Security Access
You can restrict access to a specific group by adding the group name to the "Access" parameter

in the XML file. Separate multiple groups with commas.

When upgrading from older versions of DVMAX (before 7.10), take care to preserve the

contents of the “customReports” folder.  Contact DVMAX Technical Support if you have ques-

tions.
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Findings
The DVMAX Findings functionality allows you to enter most of your patient history with almost

no typing. When you use a Finding to add information to a patient history, you can quickly select

from a predefined list of conclusions.

With Findings, you can quickly organize a large number of choices into an easy-to-use interface.

From this interface you can enter only those items that are relevant or noteworthy to a particular

case. This makes data entry fast, structured, and predictable.

This chapter covers setting up Findings for use on a Patient History. You must link a Finding to a

Medical Record Code or a Diagnosis before you can use it on a Patient History. For more infor-

mation on linking Findings, see Medical Record Codes and Diagnoses. For information on

using a Finding on a Patient History, see Working With Patient Records.

Findings: An Overview
A Finding is composed of three hierarchical elements: a Finding Class contains one or more

Finding Items, which in turn contain one or more Item Options.
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The Finding Class defines the type or category of information that will be entered onto the

patient record by a Finding. In practice, a Finding Class is referred to more generally as simply

a Finding.

Finding Items are the individual items that combine to make up the Finding Class.

Finding Item Options are the most common results arising from each Finding Item in the Find-

ing Class. Item Options become clickable elements in the DVMAX user interface.

Creating a New Finding

Overview of Creating a Finding
Plan your Finding before creating it in DVMAX. When mapping out a new Finding:

l Define the Finding Class that you want to create. It can be an exam, a diag-

nostic test, a lab result, or anything that you would normally make detailed and

structured notes about.

l List the Finding Items that make up the Finding Class. These are the different

types of information, observations or results that make up the Class. For exam-

ple, the Finding Items that make up a General Examination might include the

patient’s temperature, weight, and disposition, as well as the results of eye and
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ear examinations. Make certain you have covered them all, and to arrange them

in the order you want.

l List the most common Finding Item Options for each Finding Item. For exam-

ple, the Item Options for an Eye Exam in a General Examination might include

“Normal”, “Cataract”, and “Corneal Dystrophy.”

Once your Finding is planned, create it in DVMAX in the reverse order to which you planned it.

l Start with the lowest part of the hierarchy: create the Finding Items and their

associated Options.

l Create the Finding Class and attach to it all of the Finding Items you have just

defined. Make sure to add them in the order you want to enter them.

Consider working out the basic structure of a Finding Class on paper before you implement

it in DVMAX.

When you have successfully created a Finding, you need to associate it with a defined Med-

ical Record Code or Diagnosis. (You can also create a Medical Record Code or Diagnosis for

the sole purpose of entering Findings.) See the chapters Medical Record Codes and Diagnoses

for information on this.

Creating Finding Items
To create a Finding Item record:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Finding Items from the Search For drop-down

list.
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l Click Add New at the bottom of the Find window.

l The New Finding Item window displays.

l Type a unique name for this Finding Item in the Item Name field. The name can

be up to 40 characters long.
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l If this item will be measured in units, type the unit measure in the Units field.

For example, if you are creating a “Heart Rate” Finding Item, the unit measure

will be “BPM” (Beats Per Minute). Leave this field empty if the item is not

measured in units.

l Type the text to appear automatically when this Finding Item is used on a Patient

record into the Default Note field. You can leave this field empty if you do not

wish any text to appear by default, and you can change the Default Note when

you use the Finding Item on the patient record.

l If you wish to be able to use this Finding Item in a Macro, click to select the

Support MRE Macros checkbox. See Macros for more information on this set-

ting.

l Set the font and size for use in Word Processing documents.

l Click the Add Option button to add Options to this item. See Adding Options

to a Finding Item for more information.

-OR-
l Choose Add New Option from the Finding Items drop-down menu to add

Options to this item. See Adding Options to a Finding Item for more infor-

mation.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for Add New

Option.

l Click to select the Suppress Commas Between Selected Options checkbox to

tell DVMAX not to separate options with a comma when entering this Finding

Item on a patient record. Leave this field unselected to separate item options

with a comma on the patient record.

l Click OK to save this Finding Item.
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Adding Options to a Finding Item
To add options to a Finding Item:

l Click the Add Option button.

-OR-
l Choose Add New Option from the Finding Items drop-down menu.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for Add New

Option.

l The Add New Item Option dialog opens.

l Type the text that the user will select when entering this Finding on a Patient

History into the Description field.

l Click OK to save this option. DVMAX will save your Item Option and present

another empty Description field. You can enter as many options as you like by

typing descriptions and clicking OK.

-OR-
l Click Cancel to save this option and close the Add New Item Option dialog.

DVMAX will return you to the Finding Item dialog. The options you added will
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be listed in the Options area of the Finding Item window.

Reordering Finding Item Options
When placing a Finding on a patient history, DVMAX will present items in the order they are

listed in the Options area of the Finding Item record. You can specify the order in which Finding

Item Options will be presented when adding a Finding to a Patient History.

To reorder Finding Item Options:

l In the Options area of the Finding Item window, click and hold your mouse but-

ton down on the Option you wish to move.

l Drag the item in the list to the spot where you wish to place it. A small arrow

appears to the left of the list while you are dragging. This arrow indicates where

the item will be placed when you release your mouse button.

l Release your mouse button.
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If you change the design of a Finding Class after you have created and used it, patient his-

tories that have already used that Finding will not be altered or updated. Future entries will use

the changed design.

Modifying a Finding Item Option
To modify a Finding Item Option:

l Double-click the Option you wish to change in the Options list of the Finding

Item window.

-OR-
l Click once to select the Option you wish to change in the Options list.

l Choose Modify Item Option from the Finding Item drop-down menu.

l The Finding Item Option dialog displays.

l Type your changes in the Description field.

l Click OK to save your changes.

Deleting a Finding Item Option
To delete an Option from a Finding Item:
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Click once to select the Option you wish to delete from the Options list.

l Click the Delete Option button.

l DVMAX will ask you to confirm that you wish to delete this option.

l Click Delete. The confirmation dialog closes, and the Option is removed from

the list.

You can also delete a Finding Item Option from the Modify Finding Item Option dialog,

by clicking the Delete button.
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For more information on the Modify Finding Item Option dialog, see Modifying a Finding

Item.

If you change the design of a Finding Class after you have created and used it, patient his-

tories that have already used that Finding will not be altered or updated. Future entries will use

the changed design.

Creating Finding Classes
Finding Classes are collections of Finding Items. In order to create a Finding Class, the com-

ponent Finding Items must already have been created. For information on creating Finding Items,

see Creating Finding Items.

To create a Finding Class:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Finding Class from the Search For drop-down

list.

DVMAX Practice V8.6 - User Manual



- 410 -

l Click Add New at the bottom of the Find window.

l From the New Finding Class window, type a unique code for this Finding Class

into the Class Code field. The code is used to identify and select this Finding

Class, and can be up to 12 characters long.

l Type a name for this Finding Class into the Class Name field.

l Click the Add Item button to add Finding Items to this Finding Class. See Link-

ing Finding Items to a Finding Class for more information.

-OR-
l Choose Add New Linked Finding Item from the Finding Class drop-down

menu to add Finding Items to this Finding Class. See Linking Finding Items to

a Finding Class for more information.

l Click OK to save the new Finding Class.
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CONTROL+N (COMMAND + N on Macintosh) is a keyboard shortcut for Add New

Linked Finding Item.

Linking Finding Items to a Finding Class
You can add as many Finding Items as necessary to a Finding Class. To link or add Finding

Items to a Finding Class:

l Click the Add Item button.

-OR-
l Choose Add New Linked Finding Item from the Finding Class drop-down

menu

l From the Add New Finding Item dialog, type the name of a Finding Item into

the Description field. This name must be the name of an existing Finding Item.

CONTROL+N (COMMAND + N on Macintosh) is a keyboard shortcut for Add New

Linked Finding Item.

If you do not know the full name of the Finding Item you wish to link, type as much as you

know of the name and press TAB. DVMAX will present you with a list of Finding Items that

match the partial name you typed.
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l If a Unit has not been defined for this Finding Item, you can type it now into the

Unit field. For more information on Units, see Creating a Finding Item.

l If a default note has not been defined for this Finding Item, you can type it into

the Default Note field. You can have a different default note for the same find-

ing item when used with a different finding class. For more information on

Default Notes, see Creating a Finding Item.

l Click OK to save this option. DVMAX will link this Finding Item and present a

new, empty Add New Finding Item dialog. You can link as many Finding

Items as you like by filling out the Add New Finding Item dialog and clicking

OK.

-OR-
l Click Cancel to save this option and close the Add New Finding Item dialog.

DVMAX will return you to the Finding Class screen. The Finding Items you

linked will be listed in the Linked Finding Items area of the Finding Class

screen.
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Reordering Linked Finding Items
When placing a Finding on a patient history, DVMAX will present Finding Items in the order

they are listed in the Linked Finding Items area of the Finding Class screen.

You can specify the order in which Finding Items will be presented when adding a Finding to a

Patient History.

To reorder Finding Items in a Finding Class:

l In the Linked Finding Items area of the Finding Class window, click and hold

your mouse button down on the Finding Item you wish to move.
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l Drag the item in the list to the spot where you wish to place it. A small arrow

appears to the left of the list while you are dragging. This arrow indicates where

the item will be placed when you release your mouse button.

l Release your mouse button.

If you change the design of a Finding Class after you have created and used it, patient his-

tories that have already used that Finding will not be altered or updated. Future entries will use

the changed design.

Search for a Finding Item Record
To find a Finding Item record in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose Finding Items from the Search For drop-down

list.
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l Choose Finding Item Name from the By drop-down list to search Finding Item

records by name. This will find a matching record if it contains the text you type

anywhere in a Finding Item Name.

-OR-
l Choose Finding Item Option to find Finding Item records by looking for the text

you type in any of the Item Options of a Finding Item record. This will find a

matching record if it contains the text you type anywhere in its Options. See Cre-

ating a Finding Item for information on Finding Item Options.

l Type the text you wish to find into the field below the By drop-down list.

l Click Search.

l If there is more than one match for your search, the Finding Items List window

will display a list of items that matched your search.

l If there is only one Finding Item that matches your criteria, DVMAX will open

that Finding Item record.
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l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

You can also quickly locate a Finding Item by following the steps in Listing All Finding

Items and double-clicking the one you are interested in from the list.

Search for a Finding Class Record
To search for a Finding Class record:

l Choose Patient Codes from the Section drop-down menu.
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CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose Finding Class from the Search For drop-down

list.

l Choose Finding Class Code from the By drop-down list to search Finding Class

records by code. This will find any matching record whose code starts with the

text you type.

-OR-
l Choose Keyword in Name to search for Finding Class records by name. This

will find a matching Finding Class record if it contains the text you type any-

where in its Name.

l Type the text you wish to find into the field below the By drop-down list.

l Click Search.

l If there is more than one match for your search, the Finding Classes List win-

dow will display a list of items that matched your search.
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l If there is only one Finding Class that matches your criteria, DVMAX will open

that Finding Class record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.
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You can also quickly locate a Finding Class by following the steps in Listing All Finding

Classes and double-clicking the one you are interested in from the list.

List All Finding Item Records
To list all defined Finding Item records:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose Finding Items from the Search For drop-down

list.

l Click All Records at the bottom of the Find window. A list of all defined Find-

ing Items displays.
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l Each Finding Item record is listed on an individual line.

Listing All Finding Class Records
To list all defined Finding Class records:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose Finding Class from the Search For drop-down

list.
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l Click All Records at the bottom of the Find window. A list of all defined Find-

ing Classes displays.

l Each Finding Class record is listed on an individual line.

Delete a Finding Item Record
To delete a single Finding Item record from DVMAX:

l Open the Finding Item record you wish to delete. See Search for a Finding

Item.

l Click Delete at the bottom of the Finding Item window.
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l DVMAX will ask if you want to delete the Finding Item. Click OK to continue

or Cancel to keep the Finding Item.

l DVMAX will ask you to confirm that you want to delete the Finding Item. 

Click OK to continue and delete the item.

To delete multiple Finding Items from DVMAX:

l List all Finding Items (see List All Finding Item Records).

l Click to select the Finding Items you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Finding Items from the list. Press

and hold the CONTROL key to select multiple non-adjacent Finding Items.

l Choose Delete Records from the Finding Items menu.

l DVMAX will ask if you want to delete the Finding Items. Click OK to continue

or Cancel to keep the Finding Item.
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l DVMAX will ask you to confirm that you want to delete the Finding Item

records.  Click Delete to continue. The records will be deleted.

If you change the design of a Finding Class by deleting a Finding Item, patient histories that

have already used that Finding will not be altered or updated. Future entries will use the changed

design.

Deleting a Finding Class Record
To delete a single Finding Class record from DVMAX:

l Open the Finding Class you wish to delete. See Search for a Finding Class

Record.

l Click Delete at the bottom of the Finding Class window.

l DVMAX will ask if you want to delete the Finding Class. Click OK to continue

or Cancel to keep the Finding Class.
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l DVMAX will ask you to confirm that you want to delete the Finding Class

record.  Click OK to continue. The record will be deleted.

To delete multiple Finding Classes from DVMAX:

l List all Finding Class records (see List All Finding Class Records).

l Click to select the Finding Class records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Finding Classes from the list.

Press and hold the CONTROL key to select multiple non-adjacent Finding Classes.

l Choose Delete Records from the Finding Classes drop-down menu.

l DVMAX will ask if you want to delete the Finding Class. Click OK to continue

or Cancel to keep the Finding Class records.

l DVMAX will ask you to confirm that you want to delete the Finding Class

records.  Click Delete to continue. The records will be deleted.

DVMAX Practice V8.6 - User Manual



- 425 -

If you delete a Finding Class, patient histories that have already used that Finding will not

be altered or updated.
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General Searches and the Query Editor
The ability to find the right information quickly is an important part of running your practice effi-

ciently. DVMAX anticipates the most common lookups you will need by making them available

in drop-down lists in the Find window (the Find window displays when you choose Clients and

Patients, Inventory Management, Patient Codes or Log Records from the Section menu).

There may be times, however, when you will want particular information not supplied by a com-

mon search option. For these cases, DVMAX provides a Query Editor that allows you to

create a general search based on your own combination of available search fields.

Opening the Query Editor
You can open the Query Editor by choosing General from the By drop-down list in the Find win-

dow, and then clicking Search.

For example, to open the Query Editor to perform a General Search for a client:

l Choose Clients and Patients from the Section menu of the DVMAX main

screen.

l From the Find dialog, click the By drop-down list and choose General.

l Click the Search button to open the Query Editor.

The exact contents of the Query Editor depend on which section you have opened it from,

and your selection in the Search For drop-down list. For example, you cannot perform a general

search for a Bill Item if you have not opened the Query Editor from the Inventory Man-
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agement section. Similarly, you cannot perform a general search for a patient if you have

selected Clients in the Search For drop-down list.

Using the Query Editor
The Query Editor allows you to create a general search based on your own combination of a

large number of available search fields.

To use the Query Editor:

l Make a selection from the Available Fields list.

l Choose an operator from the Comparisons list.

l Type a Value where applicable.  For example, if you were searching for a Spe-

cies record, you might select Species from the Available Fields list, choose is

equal to from the Comparisons list and type Feline as the Value.

l If necessary, click And, Or or Except to add another line to your search.  This

lets you further narrow the search, useful when working with large numbers of

records or when trying to find a specific record.

l Click Query.

The [Dynamic_Client] and [Dynamic_Patient] tables are available for use in custom reports

and general searches.  You may need to select Master Tables from the menu immediately below

the Available Fields label to find Dynamic_Client or Dynamic_Patient options.

General Searches Using the Terms And, Or, Except
If your general search contains more than one line, you will need to use at least one of the And,

Or, or Except conjunction operators. Here is what each means:
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And - This operator finds all the records that meet two conditions simultaneously. For

example, the query “Find all the clients with pugs and who have outstanding invoices”

will find all pug owners who owe you money.

Or - This operator finds all the records that meet either of two simple queries. For

example, the query “Find all the clients with pugs or who have outstanding invoices”

will find all your clients who are pug owners, as well as all the clients who owe you

money regardless of what kind of animal they own.

Except - This operator is the equivalent of “not.” The query “Find all the clients except

those who own pugs” will exclude all clients with pugs.

Saving a General Search
If you will be performing a complex general search with any frequency, you can save your

search criteria to your computer’s hard disk and load it into the Query Editor at any time. To

save a General Search:

l Create a General Search as explained in Using the Query Editor.

l Click the Save button and type a filename in the dialog box that appears.

Loading a Saved General Search
To load a saved General Search into the Query Editor:

l Open the Query Editor as described in Opening the Query Editor.

l Click the Load button. In the dialog box that appears, navigate to your saved

query, and click OK.

General Search Example
The following example shows how to use the Query Editor to generate a list of the year’s top-

spending clients:

l Choose Client and Patients from the Section drop-down menu on the DVMAX

main screen.

l From the Find dialog, click and hold on the Last Name, First Name field and

select General from the drop down list that appears.
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l Click the Search button. The Query Editor window opens.

l In the Available Fields list to the left of the screen, click the down arrow until

you see Dynamic_Client

l In some cases, you may need to change the list of Tables from which Available

Fields displays. The default display when the Query Editor opens is a listing of

Available Fields from Related Tables. SelectMaster Tables from the drop-

down list immediately below the words Available Fields on the Query Editor

dialog

l Click the plus sign or arrow beside Dynamic_Client once. This will expand the

list.

l Locate Spent YTD in the list under Dynamic_Client. Click Spent YTD once.

l In the Comparisons list to the right of the screen, click is greater than or

equal to once.

l Type a dollar amount in the Value field. Do not type the dollar sign ($).

DVMAX Practice V8.6 - User Manual



- 430 -

l Click the Query button in the lower right hand corner of the Query Editor

dialog.

l A list of Client records with a Spent Year to Date history of greater than or

equal to the amount you typed in the Value field will display.
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HealthyPet Reminders
What Are HealthyPet Reminders?

HealthyPet Reminders are professionally published reminders mailed to your clients on

your behalf. HealthyPet reminders can be postcards, newsletters or the HealthyPet Mag-

azine, each customized to list upcoming treatments at your veterinary clinic.

DVMAX can integrate its own powerful, internal reminder system with your HealthyPet

account. This chapter provides instructions on how to send your DVMAX Reminders to

HealthyPet. For more information on DVMAX Reminders, see the Reminders and

Patients chapters of this manual.

Requirements
In order to send your DVMAX reminders to HealthyPet, you will need:

l A valid HealthyPet account number

l A connection to the internet on the computer running DVMAX

Setting Up DVMAX to Send Reminders to HealthyPet
To set up the HealthyPet Reminder system in DVMAX, follow these steps:

l Provide a valid HealthyPet account number

l Tell DVMAX to include the date with Reminders

To enter a HealthyPet Account number, follow these steps:

l Select System Constants from the Section menu on the DVMAX main screen.

l From the System Constants menu, choose Default Constants. Alternatively, click

the Default Constants tab.

l On the Default Constants tab, type a valid HealthyPet account number in the

HealthyPet Account # field.
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l Click OK to save your account number.

l From the System Constants menu, choose the Clients & Patients tab. Alter-

natively, click the Clients & Patients tab.

l From the Clients & Patients tab, select With WP Reminders under the Include

Dates heading.
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l Click OK to save the Include Dates with WP Reminders setting.

l Click OK to exit System Constants.

Sending DVMAX Reminders to HealthyPet
DVMAX uses the internet to send your Reminders to HealthyPet. The process is simple: you tell

DVMAX the range of dates for which you want to send reminders, and DVMAX scans all

patient records, removes inactive clients, and sends valid reminders to HealthyPet.

To send DVMAX Reminders to HealthyPet:

l Choose General Management from the Section menu on the DVMAX main

screen. The Management Functions screen appears.

l Select the Utilities tab fromManagement Functions.

l From the Utilities tab, select Send HealthyPet Reminder File

l Click OK. The Date Range Entry opens.

l Type the first day for which you wish to send Reminders into the Starting Date

field. Type the last day for which you wish to send Reminders into the Ending

Date field.

l Click OK to have DVMAX send your Reminders to HealthyPet.

l DVMAX will notify you when your Reminders have been sent.
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l If there were errors sending the Reminders, DVMAX will notify you of these as

well.

Technical Details

DVMAX uses FTP (File Transfer Protocol) to send your Reminders to HealthyPet. The relevant

FTP information is as follows:

l Server address: ftp.dvmreminder.com.

l User name: dvmax

l Password: 3pfg45

l Remote directory: /home/dvmax/incoming

When you tell DVMAX to send your Reminders to HealthyPet, DVMAX creates a temporary

file containing your Reminders on your computer. DVMAX then uses FTP to send this file to the

HealthyPet FTP server.

The name of this file is a combination of your HealthyPet account number followed by a Date

and Time Stamp. If you are using DVMAX SU, DVMAX will save this file in the same direc-

tory as your structure file. If you are using DVMAX Client, DVMAX will save this file in the

same directory as the DVMAX client application.

DVMAX deletes the temporary file after sending it to the HealthyPet FTP server.
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History Classes
You can use History Classes to categorize or group Diagnosis Codes and Medical Record

Codes. History Classes allow you to insert items from a Patient’s history in organized and

related sections into a Word Processing document.

History Classes are used on the Word Processing tab of the Patient record. You can insert

MREs or Diagnoses according to History Class from the WP Palette in a Patient WP

document.  For more information, see Working with Patient Records.

You can set up unlimited History Classes in any way that is useful to your practice. For exam-

ple, you may want to set up History Classes for Examination Procedures, Dental Procedures,

Anesthesia, or Discharge Comments.

Using a small number of History Classes is more manageable (and usable) than maintaining

a large list.

For information on including a Medical Record Entry in a History Class, see Medical Record

Entries. For information on including a Diagnosis in a History Class, see Diagnoses.

Add a New History Class Record
To add a new History Class in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose History Classes from the Search For drop-

down list.
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l Click Add New at the bottom of the Find window. The New History Class rec-

ord dialog opens.

l Type a unique code for this History Class record into the Type Code field. This

code can be up to 12 characters long.

l Type the name you want to assign this History Class record in the Type Name

field.

l Click OK to save the History Class record.

Search For History Class Records
To find a History Class record:

l Choose Patient Codes from the Section drop-down menu.
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CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose History Classes from the Search For drop-

down list.

l Choose Class Code or Keyword in Class Name from the By drop-down list.

l Type a History Class code or a word from a History Class name into the field

below the By drop-down list.

If you are searching by code, type as much of the start of the code as you know. DVMAX

searches History Class codes from the beginning of the code.

l Click Search.

l If there is more than one match for your search, the History Class List window

will display list of records that matched your search criteria.
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l If there is only one History Class record that matches your criteria, DVMAX

will open that record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

You can also quickly locate a History Class by following the steps in List History Class

Records and double-clicking the one you are interested in from the list.

List History Class Records
To list all History Class records:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l From the Find window, choose History Classes from the Search For drop-

down list.
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l Click All Records at the bottom of the Find window. A list of all defined His-

tory Class records displays

Each History Class record is listed on an individual line, with columns for Class Code and

Class Name.

Delete a History Class Record
To delete a single History Class from DVMAX:

l Open the History Class record you wish to delete. See Search for a History

Class Record.

l Click Delete from the bottom of the History Class window.

l DVMAX will ask you to confirm that you want to delete the History Class rec-

ord.
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l Click OK.

To delete multiple History Class records:

l List all History Classes (see List All History Class Records).

l Click to select the History Class records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent History Classes from the list.

Press and hold the CONTROL key to select multiple non-adjacent History Classes.

l Choose Delete Records from the History Classes menu.

l DVMAX will ask you to confirm that you want to delete the History Class.

l Click Delete.
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Inventory Items
You can use DVMAX to keep track of the physical goods, such as medications, food and other

products, that you sell to your clients. You can monitor monthly sales and quickly reorder an

item when DVMAX tells you that it is running low. DVMAX’s inventory management features

can help also help you write prescription labels, track controlled substances, and keep track of

costs.

DVMAX comes pre-supplied with records for thousands of the most common Inventory Items

sold in veterinary practices. Most often, you will edit existing Inventory Items rather than add

new ones.

DVMAX also provides an easy-to-use method of recording your inventory purchases – see Pur-

chases for more information.

What Inventory Items Are Not
It is vital to understand that you do not sell Inventory Items directly. In DVMAX, inventory

items are linked to Bill Items. Bill Items, and not Inventory Items, are entered on Invoices and

sold to clients.

See Bill Items and Invoicing for more information.

Search for Inventory Items
To find an Inventory Item in DVMAX:

l Select Inventory Management from the Section drop-down menu.

l From the Find dialog, choose a criterion (Item Code, Description, Keyword in

Description, Reorder, Expiration Date, or On Order) from the By drop-down

list. See Search Criteria for more information.
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l If necessary, type an Item Code, Description or Expiry Date in the field pro-

vided. See Search Criteria for more information.

l Click Search.

l If there is more than one match for your search, the Inventory Items window

will display a list of items that matched your search.
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l If there is only one Inventory Item that matches your criteria, that Inventory Item

record will open.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Inventory Item Record Search Criteria

DVMAX provides six predefined ways to search for Inventory Items. A description of each

follows.  You can also choose to use the General Search option and define your own search

criteria.  See the General Searches chapter for more information.

Item Code
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An Item Code search locates an Inventory Item using the item’s code. If you do not know the

entire item code, type as much of the start of the code as you know and click Search. DVMAX

will show a list of all items whose code starts with what you typed.

Description

A Description search finds Inventory Items using the items’ Description field. Your search term

does not need to be an entire word.  Note that a Description search will only match from the

start of the description – that is, you must know the exact start of the description to find any

matches.

Keyword in Description

A Keyword in Description returns a match if what you type is found anywhere in an item’s

description.  The term you type does not need to be an entire word.

Reorder

Reorder (no input) finds all items whose stock has fallen below their reorder minimum. Use

this search to see a list of items that need to be ordered.

Expiration

Expiration (enter date) finds Inventory Items that have lots that will expire by the entered date.

The format for all dates in DVMAX is MM/DD/YYYY. This search is helpful to identify items

that have expired or will expire soon.

On Order

On Order (no input) finds Inventory Items that have been entered on a Purchase Order. This

list is helpful to avoid double-ordering items that are low in stock.

The Inventory Items Window

The Inventory Items window contains a list of Inventory Item records that match your search.

You can see at a glance an item’s code, description, quantity on hand, cost to your practice, and

reorder status.
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To select and view an Inventory Item from the Inventory Items window:

l Double-click the Inventory Item you wish to view

-OR-
l Click once on the Inventory Item you wish to view, and then click Show.

Creating a New Inventory Item

Following are the general steps involved in creating a new Inventory Item record. For more infor-

mation on each step, see the appropriate section of this chapter.

l Open a new Inventory Item screen.

l Fill out the General Information tab of the Inventory Item screen.

l If the new Inventory Item is a Pharmacy item, fill out the Pharmacy Details

tab.

l Click OK to save the new Inventory Item.
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Opening a New Inventory Item Screen

You can create a new Inventory Item from either the Inventory Items Window or the Find win-

dow. For more information on these locations, see Finding Inventory Items

To create a new Inventory Item from the Inventory Items Window:

l Choose Add New from the Inventory Items menu

-OR-
l Click the Add New button at the bottom of the Inventory Items Window.

To create a new Inventory Item from the Find Window:

l Click Add New at the bottom of the Find window.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for creating a new

Inventory Item from either location.

Create an Inventory Item Record
The Inventory Item tabbed dialog is made up of four tabs: General Information, Pharmacy

Details, Past Purchases and Sales Information.

To create a new Inventory Item record, you must complete the details General Information tab.

If the Inventory Item is a prescription item, you must also complete the Pharmacy Details tab.

To create a new Inventory Item record:

l Type a unique code for this item in the Item Code field. The code you type can

be a maximum of 12 characters.

l Type a short description of this item in the Description field. The description

you type can be a maximum of 35 characters.
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l If you are using a bar code system, type the item bar code in the Bar Code

field.

l If your practice pays tax on the purchase of this item, click to select the Tax-

able checkbox, and choose a tax type from the Tax drop-down list. Tax rates are

set in the Finance Constants section of System Constants.

The Taxable checkbox does not indicate that you charge sales tax on this item when you

sell it to a client.  It indicates whether your practice pays tax on the item.

l If you know the Vendor Item Number for this item, type it in the Vend Item #

field.

You can make reordering an inventory item quicker and easier by using the vendor’s own

stock or item number when reordering.

l Type the units that you purchase this item in into the Purchase Units field. For

example, canned food is purchased in cases of cans, and medications can be pur-

chased in bottles of tablets.

l Type the smallest unit that you dispense this item by into the Dispensing Units

field. For example, you may sell food by the can, or medications by the tablet.

Provide as much information as possible when filling in the Purchase and Dispensing Units.

It is helpful, for example, to use “Case of 24” instead of just “Case”, “Bottle of 250 tabs”

instead of just “Bottle”, “Box of 12 vials” instead of just “Box”.  Placing clear, descriptive
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names in these fields will make it easier to link these items to Bill items and to understand the

relationships between items purchased and items sold.

l Type the number that defines the relationship between Dispensing and Purchase

Units into the Unit Factor field. For example:

l a canned food purchased in cases of 24 cans and sold by the can has a unit

factor of 24.

l a medication purchased in bottles of 100 tablets and sold by the tablet has a

unit factor of 100.

l A saline solution purchased by the liter and sold by the liter has a unit factor

of 1.

You cannot add a Unit Factor of 0.

l If this item is a Pharmacy item, type its Drug ID number into the DIN number

field. DIN numbers are not used n the U.S.

l If this item is a Pharmacy item, type its concentration into the Strength field.

l Type any remarks about this item into the Comments field.

The Pharmacy Details Tab
Filling out the Pharmacy Details tab involves providing general information about the Inventory

Item and specific information about any lots of this item you have on hand.

To complete the Pharmacy Details:
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l Click to select the Rx Label Item checkbox if you want to use DVMAX’s pre-

scription labeling features with this item.

All prescription Inventory Items must have their Rx Label Item checkbox selected in order

for Prescription labeling to work properly.

l Type the common instructions that will appear on the prescription label into the

Default Label Directions field.

l Click to select the Schedule, if any, that this item falls under. This information

is useful for tracking controlled substances.

l Type a default dispensing quantity for this item into the Default Dispensing Qty

field.

l Type the number of days until this medication expires after reconstitution into

the Reconstitute Exp. (days) field.  DVMAX uses this value to calculate the

label expiration date for reconstituted medications (e.g. a medication will expire

14 days after it is reconstituted for dispensing to the patient).

l Choose Add Pharmacy Info from the Pharmacy Info drop-down menu.

-OR-
l Double-click in the Listing field (the area of the screen with Qty, Units, Lot #

and Expiry Date columns).

l Type the Entry Date (typically the current date), Lot Number, Expiry Date

and Quantity (how many items, measured in dispensing units) into the Pharmacy

Info window.

l Click OK to save the information you typed in the Pharmacy Info window.

l Click OK to save the Inventory Item.

Information about individual lots can also be entered at when you record the purchase of an

Inventory Item. Recording the purchase of a Prescription item will automatically present the

Pharmacy Info dialog. See Purchases for more information.

Modifying an Inventory Item
To modify an Inventory Item:

l Select Inventory Management from the Section drop-down menu.
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l From the Find dialog, choose a criterion (Item Code, Description, Keyword in

Description, Reorder, Expiration Date, or On Order) from the By drop-down

list. See Finding Inventory Items for more information.

l If necessary, type an Item Code, Description or Expiry Date in the field pro-

vided. See Finding Inventory Items for more information.

l Click Search.

l If a list of matching Inventory Items appears, double-click the one you wish to

edit.

l Make the necessary changes in the General Information and/or Pharmacy

Details screen. See Filling Out the Inventory Item Screen for details.

l Click OK to save your changes.

Updating the Unit Factor
On rare occasions you may need to change an Inventory Item’s purchase and dispensing units,

and the Unit Factor that relates them.  This may happen because you want to update your inven-

tory, your supplier changed their packaging, or for any number of other reasons.

When the unit factor changes, DVMAX must preserve existing relationships of this Inventory

Item to other information (i.e. links to Bill Items for sales to Clients, records of past sales & pur-

chases, etc.). 

You cannot add a Unit Factor of 0.
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In order to do this, DVMAX will attempt to determine how you have altered the unit relationship

and offer to handle the change retroactively as best it can by presenting a dialog that asks you to

choose how to handle the change.

Changing the Purchase Units & Unit Factor
The most common situation arises when you change an item that previously had a unit factor of 1

to show the actual purchase units (e.g. Bottle of 100 tabs, Box of 12 vials, etc.).  In this situation

you should choose Multiply cost by new factor.

Changing the Dispensing Units & Unit Factor
Your practice may start selling items individually that were previously only sold in bulk. In this

situation you should choose Multiply linked quantity by new factor.

This will update any Bill item links to this Inventory item so that the proper quantity of inventory

is removed each time the item is sold.

For example, if you previously only sold food by the case and have decided to start selling it by

the can as well, DVMAX now needs to count inventory for this item in cans as well as cases. 

When changing the dispensing units to “Cans” we need to update the Bill Item links to make cer-

tain that each time a case of food is sold the appropriate number of cans are deducted from inven-

tory.

See Bill Items for more information on the link between Inventory Items and Bill Items.

Deleting an Inventory Item
To delete an Inventory Item:

Find the Inventory Item(s) you wish to delete by following the steps in Finding Inventory

Items.

l Click the Delete button on the Inventory Item record.

-OR-
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l On the Inventory Items screen, select the items you wish to delete.

l Choose Delete Records from the Inventory Items drop-down menu.

Deleting Inventory Items can have serious effects on your sales data. If you are unsure

about whether to delete an item, please contact DVMAX Technical Support.

Viewing Past Purchases
To view your practice’s past purchases of an Inventory Item:

l Find the Inventory Item you are interested in by following the steps in Finding

Inventory Items.

l Click the Past Purchases tab at the top of the Inventory Item tab.

Past Purchases are listed in reverse chronological order. You can see the date, Quantity, Cost

and Vendor for each purchase.
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Quantities shown may be in either Purchase or Dispensing units. For more information,

see Showing Purchase or Dispensing Units.

Viewing Sales Information
To view Sales Information for an Inventory Item:

l Find the Inventory Item you are interested in by following the steps in Finding

Inventory Items.

l Click the Sales Information tab at the top of the Inventory Item dialog.

l The list in the upper left shows Months, Units, and Sales Quantity for each past

months. DVMAX calculates and shows the monthly sales average in the

Monthly Avg. field to the right of the screen.

Quantities shown may be in either Purchase or Dispensing units. For more information,

see Showing Purchase or Dispensing Units.

The Sales Information Graph
The graph in the lower part of the Sales Information tab represents, by default, all sales infor-

mation shown in the list in the upper left of the screen. To change the date range of sales infor-

mation in the graph:

l From the Graph drop-down list, choose how many months you would like to see

graphed. DVMAX will count down from the currently selected month in the list

of monthly sales.
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Inventory Reports
DVMAX offers seven printed reports for Inventory Items. Each report can work on a selection

of Inventory Items. To generate a printed Inventory Item report:

l Select Inventory Management from the Section drop-down menu.

l To generate a report on all Inventory Items in your practice, click All Records

on the Find dialog.

-OR-
l Use the Find window as described in Finding Inventory Items to find the

items you wish to report on.

l If necessary, you can further narrow the items to report on by selecting those

you are interested in from the Inventory Items dialog. Press the CONTROL

key (COMMAND on Macintosh) while clicking to select multiple items.

l Choose Print from the File drop-down menu. The Printing Options dialog dis-

plays.

l Click to highlight a report type from the list. See Report Types for information

on each.

l Select the Page Setup checkbox if you would like the Page Setup dialog to

appear before the report is printed.

l Click Print to generate the report.

Report Types
Below is a list of Inventory Item reports, and a description of the information they provide.

DVMAX Practice V8.6 - User Manual



- 455 -

l Work List: Prints a list of the selected items including code, description, quan-

tity on hand and a blank line for actual quantity. This report is generally used for

counting a physical inventory.

l Reorder List: Prints a report listing code, description, reorder level, quantity on

hand, average sales per month and last vendor information. The default option

for this report allows it to be sorted by last vendor.

l General List: Prints the inventory code, description, quantity on hand, unit cost

and average cost.

l Net value: Prints a report calculating the net value of inventory items. Listed on

this report is the code, description, quantity on hand, last cost, net value and a

grand total.

l Export: Allows inventory item information to be exported from the DVMAX

system.

l Labels: Allows labels to be printed with inventory information.

l Custom: Prints a custom report with any inventory information.

Showing Purchase or Dispensing Units
DVMAX can display quantities of an Inventory Item in either purchase or dispensing units. All

calculations are based on the Unit Factor. See Creating a New Inventory Item for a discussion

of units and the Unit Factor.

To change an Inventory Item’s display mode, you must first be viewing the Inventory Item

tabbed dialog.

l From an inventory item record, select the Inventory Item drop-down menu.

l Choose Show Purchase Units to view all quantities of this Inventory Item in

purchase units. Choose Show Dispensing Units to view all quantities in dis-

pensing units.

l Your choice of purchase or dispensing units applies to all areas of the Inventory

Item record, including quantity on hand, reorder amount, costs, past purchases

and sales.

“On Order” Status
An item will be marked as “On Order” when you enter a Purchase Order for the item (see Pur-

chases for more information). You should not mark an item as “On Order” with the “On Order”

checkbox on the General Information or Past Purchases tabs.
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Invoicing
A typical invoicing system allows you to bill your clients for goods and services. DVMAX’s

invoicing system has this basic capability but is much more powerful.  In DVMAX, an invoice

has a two-way relationship with your patient records: an invoice will update a patient record,

and a patient record can create and update an invoice.

Standard Invoicing in DVMAX can update a patient’s record every time a line item is added to

an invoice.  See Invoices and Patient Histories for more information.

DVMAX’s Invisible Invoicing feature can automatically create invoices for you as you work

on patient records. Invisible Invoicing is the heart of a paperless office, where all information

goes directly into the patient record and DVMAX generates billing from those entries. See Invis-

ible Invoicing for more information.

Over-the-Counter invoices record walk-in sales that are not associated with regular clients of

your practice. See Over-the-Counter Invoices for more information.

Regardless of how a particular invoice is created, invoicing keeps track of goods and services

provided to your clients. If you are using DVMAX’s inventory tracking features, an invoice

decreases appropriate inventory records. Invoices also form the basis of many financial reports;

see Financial Reports for more information.

Invoices and Patient Histories
Every line item on an invoice in DVMAX is associated with a particular patient in your clinic. 

DVMAX takes advantage of this relationship by transferring the item entered on an invoice line

item directly to the history, or record, of the patient on the line item. The item transferred, in

turn, can cause any number of other changes to that patient's record.

To repeat, every line item on an invoice can change the record of the patient on that line

item.

This powerful feature means that the invoice can be the entry point for keeping track of your

practice's financials and your practice's patients in DVMAX.

It also means that you should take care to ensure that you name the correct patient on each line

item of every invoice you create.

A setting in System Constants controls exactly when the Invoice updates the patient record. For

more information, see Post History & Discharge Notes from Unfinished Invoices in the Sys-

tem Constants That Affect Invoicing section of this chapter.

For information on Advanced Setting that affect invoicing and the display of line items and find-

ings, refer to the chapter Advanced Settings in this document.

Bill Items control the relationship between patient records and invoices. For detailed information

on Bill Items, see the Bill Items chapter of this manual.

Updates Performed
Invoice line items can cause the following kinds of updates to patient histories:
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Reminders: Each item on an invoice can update, create, or remove reminders from the

Patient record.

Recalls: Each item on an invoice can update, create, or remove recalls from the

Patient record.

Medical Record Entries: Each item on an invoice can create Medical Record Entries

on the Patient record.

Diagnoses: Each item on an invoice can create diagnosis history entries on the Patient

record.

Discharge Notes: Each item on an invoice can add a Bill Item's discharge notes to the

Patient record.

For more information on these updates, see the Bill Items chapter of this manual.

Creating a New Invoice
In order to create a new invoice, the following conditions must be met:

l The client you are invoicing must be an active client

l The client you are invoicing must have at least one patient

DVMAX allows you to start a new invoice from either the client window or the patient window.

Finding the Client or Patient to Invoice
The first step in creating a new invoice is to access the appropriate client or patient. To access a

client or patient:

l Choose Clients and Patients from the Section drop-down menu on the

DVMAX main window

l The Findwindow opens. Use the Find window to locate the Client or Patient for

this invoice. For more information on finding Clients and Patients, see the rel-

evant section of this documentation.

Holding down the ALT key (OPTION on Macintosh) while clicking the Search button on the

Find window will take you directly to an invoice window for the client or patient you are searching

for. If the client or patient has an unfinished invoice, that invoice will be opened for you to com-

plete. Otherwise, a new invoice will be created. If your search results in a selection of clients or

patients, DVMAX will show you an invoice window after you select one of the possible matches.
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Starting a New Invoice
The procedure for starting a new invoice is different depending on whether you start from a

client screen or from a patient screen. Follow the steps below that apply to you.

CONTROL+i  (COMMAND+i on the Macintosh) is a shortcut for choosing Create an

Invoice in the steps below.

Starting a New Invoice From a Client Record

To create a new invoice from a client record:

l From the Patient List for this client, click the patient to appear on this invoice.

If you want more than one Patient to appear on the invoice, just select one from

the Client window; DVMAX will allow you to choose others as you build the

invoice. If the patient is not yet entered into DVMAX, you can skip this step and

enter the patient information from the invoice.

l Choose Create an Invoice from the Client drop-down menu on the DVMAX

main window.

l If you are asked, select a provider from the drop-down list in the Select a Pri-

mary Provider window. The provider you choose will be the default doctor on

all lines of the invoice.

If this client has an unfinished invoice on file, DVMAX will ask you if you wish to work on

the unfinished invoice. Click New Invoice to create a new invoice. For more information on

working with unfinished invoices, see Working With Unfinished Invoices.

Starting a New Invoice From a Patient Record
To create a new invoice from a patient record:
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l From the Patient drop-down menu on the DVMAX main window, choose

Create an Invoice

l If you are asked, select a provider from the drop-down list in the Select a Pri-

mary Provider window. The provider you choose will be the default provider

on all lines of the invoice.

If this patient is listed on an unfinished invoice, or if the patient’s owner has an unfinished

invoice on file, DVMAX will ask you if you wish to work on the unfinished invoice. Click

StartNew to create a new invoice. For more information on working with unfinished invoices,

see Working With Unfinished Invoices.

Filling Out an Invoice
The Invoice will be titled “Invoice xxx for Client Name”, where xxx is a unique invoice number

generated by DVMAX and Client Name is the name of the client you are billing.
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There are several steps involved in filling out an invoice. The exact sequence depends on your

DVMAX configuration and the particular items that will appear on the invoice. The steps below

are a general overview. For more information on each step, see Invoice Data Entry Details.

l The current date will be in the Date field. You may type a different date in the

date field if needed. The default format for all dates in DVMAX is

MM/DD/YYYY. Changing the date here will change the date for all new and

empty line items on this invoice. The date is set to the current date each time an

invoice is viewed and modified.

Changing the date here can change the date this invoice becomes due, and affect your

receivables. See Backdating an Invoice.

l Type the details of the product or service you are selling in a Line Item row.

Include the Quantity of the item sold, Date (if different from the current date),

Staff (if different from the Primary Provider), and Item Code. Each product or

service uses one line item row. To add a line item row, click Add Line.

l DVMAX updates the Subtotal, Discount, Taxes, and Total boxes as you com-

plete line items. These boxes are not editable. For more information, see Pay-

ment Information.
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l Enter payment information in the Pay Method area. If you are using DVMAX’s

integrated credit and debit card processing function to process a credit or debit

card payment, you can refer to the Credit Card Processing chapter for more

information on working with these types of transactions.

l Type any notes you need in the Notes field. The text that is initially in the field

comes from System Constants (see System Constants that Affect Invoicing

for details). You can edit this text as needed.

l If a line item requires a prescription label, click the Rx Label button while your

cursor is in the line item and complete the label details. See Prescriptions for

more information.

Saving and Posting an Invoice (Finishing an Invoice)
To post an invoice:

If the invoice is complete, select the Finished checkbox in lower left of the screen. Selecting

Finished will post the invoice. If you need to add more information to this invoice in the future,

do not select Finished. This makes the invoice an Unfinished Invoice. See Working With

Unfinished Invoices for more information.

Posting the invoice records the invoice in the client's financial history.

l If you want to print this invoice, select the Print checkbox in lower left of the

screen. See System Constants that Affect Invoicing for information on con-

trolling the number of copies printed.
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l Click OK to save the invoice into the DVMAX system and print the invoice (pro-

vided Print has been selected). DVMAX will return you to the screen you were

on when you created the invoice.

-OR-
l Click OK and Next to post (and possibly print) the invoice. DVMAX will return

you to the Find window to search for another Client or Patient record.

If an invoice is marked as Finished when you click OK or OK and Next, line items from the

invoice are transferred to the Patient History. If the invoice is not marked as Finished, the

Patient History may or may not be updated, depending on the Post History and & Discharge

Notes From Unfinished Invoices setting in System Constants. See Invoices and Patient His-

tories and System Constants That Affect Invoicing for more information.

DVMAX may require you to enter your staff code before allowing you to finish the invoice.

If DVMAX asks you for your staff code, you will not be able to finish the invoice without

supplying them. The initials you supply must be an existing Staff Code. The User Initials

Required to Finish Invoices System Constant controls whether DVMAX requires initials –

see System Constants That Affect Invoicing for more information. If this setting is in effect,

you will be asked to type your initials every time you OK an invoice with the Finished checkbox

selected.

Certificate Printing
If a line item on an invoice requires that the client receive a certificate, DVMAX will present a

Certificate Printing dialog when you finish the invoice.

To print the certificate:
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l Click once under the appropriate certificate column beside the patient’s name to

select the certificate you want to print.

l Click Print.

Bill Items control whether a line item requires DVMAX to print a certificate. See Bill Items for

more information.

Controlled Substances Log Entries
Some items on an invoice require that you complete a Controlled Substance LogEntry when

you finish the invoice.

The Bill Item on the invoice and its associated Medical Record Entry control whether a line item

requires DVMAX to present the Controlled Substance window.

Close Visit(s) When Finishing an Invoice
When an appointment is checked in, DVMAX begins a Visit record that includes all status

changes made to the appointment (see Appointments for more information). A Visit is closed

when the Visit Active checkbox is deselected from the Visits dialog.

Depending on your DVMAX setup, the Visits dialog may display when you finish an invoice.

You can choose to close any visits associated with this invoice by deselecting the appropriate

Visit Active checkbox. When you deselect the checkbox and click OK to close the Visits

dialog, DVMAX will ask you to confirm that you want to close the selected visit(s). Click OK

to continue.

Barn Billing
Barn Billing applies a singe invoice to a group of patients. DVMAX will generate an identical

invoice for each patient in the group. Barn Billing is used mostly in equine practices.
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We recommend you do not leave barn-billed invoices unfinished.

To barn bill:

l Create an invoice as outlined in Creating an Invoice.

l Before clicking OK to post or save the invoice, click once to select the Barn Billing

checkbox.

l Click OK. The invoice screen closes, and the Barn Billing window displays.

l Perform a standard patient search to produce a list of the patients you wish to add. See

Creating a New Invoice for details. The Barn Billing window will still be visible.

l Click once on the patients you wish to add to highlight them. You can select multiple

patients by holding the CONTROL key (COMMAND on Macintosh) while clicking.

l Click Add Patients on the Barn Billing window. The Barn Billing window will update

to reflect the number of patients you selected.

l When you have finished adding patients, click Apply to Patients on the Barn Billing win-

dow.
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l DVMAX will ask you to confirm that you wish to apply the invoice to this group of

patients.

l Click Yes to invoice the group of patients.

To use Barn Billing, your DVMAX datafile must be labeled Equine in System Constants.

Invoice Data Entry Details

Line Items
Each different type of product or service being sold on the invoice must be recorded as a line

item. If you sell multiples of an item, that sale is a single line item. For example, if you are sell-

ing 2 cans of dog food and one can of cat food, 2 line items will be on the invoice: one for the

dog food and one for the cat food.

You can use TAB to move forward between fields in line item rows. You can use

SHIFT+TAB to move backward between fields in line item rows.

Completing Line Item Fields
To complete a line item:

l Type the quantity you are selling into the Qty box.

l Type a different date in the Date field if needed.  The default format for all

dates in DVMAX is MM/DD/YYYY.

If you cannot type directly into the Date field, double-click it to show the Edit Line Item

window and change the date there (see The Edit Line Item window). The Line Item Dates

Enterable System Constant controls whether you can type in the Date box in the line item

itself.  See System Constants That Affect Invoicing for details.

You can credit a staff person other than the Primary Provider with the sale of the item on this

line. To do this, click the triangle in the Staff field and choose a different staff person from the

drop-down list that appears.
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If a Bill Item (the code that you type in the Code field) has an associated Default Doctor,

the Bill Item’s Default Doctor will automatically override your choice in the Staff field.

l DVMAX allows more than one patient of the same client to appear on an

invoice. You can change the patient for a line item by clicking the triangle in the

Patient field and selecting a different patient from the drop-down list that

appears.

l Type the code of the item being sold in the Code field. The Description field

will fill in automatically and is usually not editable. The Price field is also

usually entered for you. The Extended Price (Ext) and Tax (Tx) field will

always be filled in automatically.

If you know the start of the code or description, type as much as you are sure of into the

Code field and then press TAB to display a list of codes that match what you typed. If you know

the complete bar code for the item, type it into the Code field payment method.

DVMAX Practice V8.6 - User Manual



- 467 -

Some codes have descriptions that you can or must edit. If you enter this kind of code,

DVMAX will play an alert sound and move the cursor to the Description field. Some codes

have prices that you can supply or change. If you type this kind of code, DVMAX will play an

alert sound and move the cursor to the Price field.

l Indicate whether this item is being Dispensed or Administered by choosing

from the Disp/Admin drop-down list.

l If an item is being dispensed, all pricing calculations as set out in the Bill Item

record are performed and recorded on the invoice. If an item is being admin-

istered, then only the item’s Net Price plus its Administration fee are recorded

on the invoice. See Bill Items for more information.

Typically, you will dispense a drug once and administer it multiple times through the course

of treatment.

The <Enter> key is NOT a synonym for the <Tab> key, or the <Return> key. DVMAX has

a built-in feature (from 4D) where the <Enter> key is used for one specific purpose - accepting a

record that's being displayed in an input form. The <Enter> key is like clicking Save or OK on a

form. Because this is a built-in feature of 4D, using the Enter key in the wrong context (as in,

when entering a partial code in a line item) can cause odd results. If you want to move from

field to field - use the <Tab> key.
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Adding New Empty Line Items
A setting in System Constants controls the number of line items on an invoice. If the default

number of line items is insufficient for your invoice:

l Click the Add Line button. A new line item will be created, and your cursor

placed in its Qty field.

For information on setting the default number of line items on an invoice, see System Constants

That Affect Invoicing.

Removing Empty Line Items
If there are more line items on an invoice than you need, DVMAX will automatically remove

them when the invoice is printed. Empty line items do not appear on printed invoices. There is

thus no need to remove unused line items.

Editing a Line Item
Click in the field you wish to edit, and type the new value. Note that some fields are not editable

(Tx and Ext. Price), and that others are not editable most of the time (Description and Price).

Other fields that are dependent on the value you change will update automatically when you

enter your new value.

You can also edit a line item using the Edit Line Item window. For more information, see The

Edit Line Item window.

Deleting a Line Item
To delete a line item:

l Click to select the line item you wish to delete. The line will be highlighted or

the cursor will appear in that line.

l Click Delete Line.

l Where applicable, click OK to confirm you wish to delete the line item. You

will only see this Confirm dialog if you have enabled the special setting in

DVMAX. For information on this setting, contact DVMAX technical support.

You can specify that line item deletions be logged by using the Audit Invoice Line Item

Deletions setting in System Constants. See System Constants That Affect Invoicing for more

information.

Expand and Sort Invoice Line Items
The Expand and Sort option lets you easily move line items around on an existing invoice. This is

particularly useful on large invoices, because the Expand and Sort feature gives you a larger
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invoice window with which to work.

To use the Expand and Sort feature, click the Expand and Sort button. When clicked, it opens a

larger window on the line items and you can drag the items as you like. You can also use the col-

umn headings in the expanded window to sort the invoice according to the selected heading.

Click OK to save the changes to the sort order, or click Cancel to revert the changes.

The Edit Line Item Details Window
The Edit Line Item Details Window allows you to make changes that apply to a single line

item on an invoice. You must use the Edit Line Item Details Window to apply a discount to a

single line item, to delete a line item, or to change the patient on a single line item.

To open the Edit Line Item Details window.

l Click once in the Qty field of the line item you wish to modify, then click the

Edit Line button.

l The fields on this window function identically to their counterparts on the main

Invoice dialog. See Line Items or more information.

Changing the Patient on a Line Item
To change the Patient for a line item:

l Choose the new Patient from the Patient drop-down list.

l Click OK to save your changes.

Applying a Discount
To apply a discount to a single line item:

l Type the percentage of the discount in the Discount field.

l Click OK to save your changes.

Not all items are discountable. For more information on discountable items, for more infor-

mation, refer to the Bill Items chapter.
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Super Items
Some item codes are Super Items, meaning a group of codes. If the code you type on a line

item is a Super Item, DVMAX will ask you to provide quantities and other information about the

individual items that make up the Super Item.

When you finish entering information for the Super Item, click OK. DVMAX will place the

items that make up the Super Item on individual lines on the invoice.

See Bill Items for more information about Super Items.

Payment Information
You may accept payment using up to two methods of payment on a single invoice.  For example,

a client may make partial payment with cash and pay the remained by check or credit card.  This

is why DVMAX displays Pay Method 1 and Pay Method 2 fields on the invoice detail window.
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In most cases, only one method of payment per invoice will be needed.

If the invoice is for a split-ownership patient, the Payment Information area of the invoice

screen will not be available. You must create a payment transaction to enter payment for a split

ownership patient.

To add payment information:

l Select a pay method from the Pay Method 1 drop-down list.

l The full amount owing on the invoice may automatically appear in the first

Amount field, depending on the Suppress Auto-entry of Payment Amount

System Constant (see System Constants that Affect Invoicing for more infor-

mation). You can edit the contents of the Amount field at any time while the

invoice is unfinished.

l The Pay Notes field will fill in automatically when you supply a pay method.

You can edit the Pay Notes if necessary and your changes will appear on the

printed invoice.
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l Repeat the steps above for Pay Method 2 if necessary.

l The combined total of the values in the Pay Method 1 and the Pay Method 2

fields will appear in the Payments field.

Type CONTROL+P (COMMAND+P on Macintosh) to jump to the payments area from any

other part of the invoice. This will bring you to the first payment method field.

Balances and Totals
The fields to the right of the Payment Information fields show you the financial totals for this

invoice.

Adding line items to an invoice updates these fields:

l Subtotal: the total cost of all the line items on this invoice, before taxes and

discounts.

l Discount: the total of all discounts on this invoice. Discounts can be applied

to any or all line items. For more information on discounts, see Discounts.

l Taxes:  contains the total of all taxes on items sold on this invoice. Tax

rates are set in System Constants – see System Constants That Affect
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Invoicing for more information. Whether an individual line item is taxable is

determined in the setup for that item – see the Bill Items chapter for more

information.

l Total:  is the subtotal minus the discount, with taxes added.

l Previous Balance: the amount owed by this client from any previous

invoices.

l Payments:  total payments received on this invoice (the sum of the two Amt

fields).

l New Balance:  the amount owed by this client on all invoices. The New Bal-

ance is the sum of the Total and Previous Balance minus Payments.

Discounts
You can apply a discount to any or all line items on an invoice. Line items that have a discount

applied are marked with an asterisk (*) following their description.

If a client has a Default Discount, DVMAX will automatically discount line items on an invoice

for this client. You can override this default discount. For more information on Default Dis-

counts for clients, see the relevant chapter of this manual.

Applying a Discount to All Line Items
To apply a discount to all line items:

l Choose Discount from the Invoice menu on the DVMAX main screen.

l The Discount Settings window opens.

l Type a percentage in the Discount Percentage field. DVMAX will discount the

price of all items on the invoice the percentage you specify here.

l Select the Discount All Items radio button to apply the discount to all items on

the invoice.

-OR-
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l Select the Discount Only Discountable Items radio button to have DVMAX

apply the discount only to items marked as discountable. For more information

on the difference between these settings, see the Bill Items chapter of this man-

ual.

l Click OK to apply the discount.

A setting in System Constants controls the availability of the Discount All Items radio but-

ton. If the Discount All Items radio button is not available, you will not be able to apply a dis-

count to line items that are not specified as discountable in their Bill Item setup. For more

information, see the Bill Items chapter of this manual, and System Constants that Affect

Invoicing.

Applying a Discount to a Single Line Item
To apply a discount to a single line item:

l Select the line item you wish to discount, then click the Edit Line button. The

Edit Line Item Window appears.

l Type the percentage of the discount in the Discount field.

l Click OK to save your changes.

Not all items are discountable. For more information on discountable items, see Bill Items.

Adding A New Patient While Working On An Invoice
To save time, you can add a new patient to DVMAX while working on an invoice. The new

patient’s owner will be the client for whom you are creating an invoice. To add a new patient

from the invoice window:

l Select Add New Patient from the Invoice drop-down menu on the DVMAX

main screen.
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l The Quick Entry for New Patient dialog opens.

l Fill out at least one of the Name, Species, Breed, DOB, Weight and Sex fields

of the Quick Entry dialog. For information on filling out new patient records,

see Patients.

l Click OK. The patient is added to DVMAX and is available on the invoice.

Backdating an Invoice
You can backdate an invoice by typing a date from the past into the Date field in the upper left

of the invoice window.

The ability to backdate an invoice is controlled by the Prevent Back-Dating of Invoices

and Transactions System Constant. If this setting is selected, DVMAX will not allow invoices

to be backdated.  See System Constants That Affect Invoicing for details.

Backdating an invoice in this way can have one of two effects on the Receivable Aging Date for

this invoice. DVMAX can either:

l Backdate the Receivable Aging Date to match the new date on the invoice

l Leave the Receivable Aging Date at its default value of the current date.

When backdating an invoice, you must tell DVMAX which of these two options is applicable to

the Receivable Aging Date.

The backdated date of the invoice becomes the default for all new line items on this invoice. It

also becomes the date of any entries placed on the Patient History by this invoice.

The Receivable Aging Date is the date the amount on the invoice is charged to your client.

A client has a certain number of days from the Receivable Aging Date in which to pay the

unpaid balance on an invoice in full, after which interest charges will apply.

To backdate an invoice:

l Type a date into the Date field in the upper left of the invoice screen. The

default format for all dates in DVMAX is MM/DD/YYYY.

l Press the Enter key. DVMAX will ask you to confirm the new Invoice date.
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l Confirm that the Invoice/History date is the date you typed into the Date field.

Correct or modify the date if necessary by typing a new date in the Invoice/His-

tory Date field.

l Confirm that the Receivable Aging Date is correct. If it is not, type the right

date into the Receivable Aging Date field.

The default date in the Receivable Aging Date field will be either the current date or the

backdated date you typed in this invoice’s Date field. The default date in the Receivable Aging

Date field is determined by a setting in System Constants – see Receivables Aging Options for

Backdated Invoices in System Constants That Affect Invoicing for more information.

l Click OK to backdate this invoice and return to the invoice dialog.

-OR-
l Click Cancel to leave the invoice date unchanged and return to the invoice

dialog.

l When an invoice has been backdated, an Aging Date field will appear on the

invoice window, immediately to the right of the Date field.

Over-the-Counter Invoices (OTC)
Typically, you will use DVMAX to invoice for products and services related to a specific patient

or client. In the case of over-the-counter or walk-in retail sales, however, there will be no client or

patient in DVMAX with which to associate the sale. DVMAX’s Over-the-Counter (OTC) invoic-

ing feature allows you to quickly write an invoice at the point of sale, letting you keep track of

inventory.

About Over-the-Counter Invoices
OTC invoices are designed to be used at the point of sale. In order to use the OTC invoicing fea-

ture, the following conditions must be met:

l You must receive immediate, full payment for all items on an OTC invoice.

DVMAX does not allow OTC invoices to carry outstanding balances.

l The OTC invoice must be started and finished in one session. You cannot save

an OTC invoice to finish later.

l Only staff identified as doctors may sell prescription items on an OTC invoice.
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Opening a New Over-the-Counter Invoice
To start a new OTC invoice:

l Click OTC Invoice from the Window List.

-OR-

l From the Special drop-down menu on the DVMAX main window, clickWrite

anOTC Invoice.

CONTROL+O (COMMAND+O on Macintosh) is a keyboard shortcut forWrite an OTC

Invoice.

Filling Out an Over-the-Counter Invoice
There are several steps involved in creating an OTC invoice. The exact sequence depends on

your DVMAX configuration and the particular items that will appear on the invoice. The steps

below are a general overview. For more information on each step, see Invoice Data Entry

Details.

l The current date will be in the Date field. Type a different date in the date field

if needed. The default format for all dates in DVMAX is MM/DD/YYYY.

Changing the date here will change the date for all empty line items on this

invoice.

l Type the details of the product or service you are selling in a Line Item row.

Include the Quantity of the item sold, Date (if different from the current date),

Staff (if different from the current staff), and Item Code. Each product or serv-

ice uses one line item row. To add a line item row, click the Add Line button.

l The Subtotal, Discount, Taxes, and Total boxes are updated automatically as

you complete line items. These boxes are not editable. For more information,

see the Payment Information section of this chapter.

l Type payment information in the Pay Method area.

You must receive immediate, full payment for all items on an OTC invoice. DVMAX does

not allow OTC invoices to carry outstanding balances.

l Type any notes you need in the Notes field. The text that is initially in the field

comes from System Constants (see System Constants that Affect Invoicing for

details). You can edit this text as needed.

l If a line item requires a prescription label, click the Rx Label button while your

cursor is in the line item and complete the label details. See Prescriptions for

more information.
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Saving (Posting) an Over-the-Counter-Invoice
To post the OTC invoice:

l If you wish to print the invoice, make sure to select Print.

l Click OK to post the invoice into the DVMAX system and print the invoice (pro-

vided Print has been selected).

-OR-
l Click OK and Next to post and print the invoice and open a new OTC invoice.

See System Constants that Affect Invoicing for information on controlling the number of

copies printed.

Invisible Invoicing
Invisible Invoicing refers to DVMAX's ability to automatically create an invoice from changes

you make to a Patient's history. This is the reverse of updating the patient's history with items

entered on an Invoice (see the Invoices and Patient Histories for more information on this).

Invisible Invoicing works by monitoring changes you make to a patient's record. When you first

open a patient record, DVMAX can create an invoice in the background. This is the "invisible

invoice." When you add a billable item to the patient record, DVMAX adds this item to the invis-

ible invoice. You can stop the Invisible Invoicing process at any time while working on the

Patient record to convert it to a standard invoice.

You will typically use Invisible Invoicing in a paperless office, where all information goes

directly into the patient record and DVMAX generates billing from those entries.

Starting an Invisible Invoice
DVMAX usually starts an invisible invoice automatically when you open the Patient History

screen, although you may also set DVMAX to start an invisible invoice only when you tell it to.

Only one invisible invoice, per terminal, can be active at any one time.

Automatic Invisible Invoicing
With the Automatic Invisible Invoice setting turned on, DVMAX will open an invisible invoice

window every time you open a Patient's history screen.

See the System Constants That Affect Invoicing section of this chapter for instructions on how

to turn on the Automatic Invisible Invoice setting.
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If you are using Invisible Invoicing frequently, you should set DVMAX to start an invisible

invoice automatically. This will save time and prevent you from making changes to the Patient

History before you remember to start an Invisible Invoice.

Start an Invisible Invoice
You can tell DVMAX to start an Invisible Invoice at any time while you are working on the

Patient History screen. To tell DVMAX to start an Invisible Invoice:

l Choose Start Invisible Invoice from the History menu on the DVMAX main

screen.

Invisible Invoices and Unfinished Invoices
If DVMAX opens an invisible invoice for a patient who has an unfinished invoice, that unfin-

ished invoice will become the invisible invoice. That is, DVMAX will add any billable items

you add to the Patient history to the existing unfinished invoice rather than start a new invoice

for this patient.

For information on unfinished invoices, see Working With Unfinished Invoices.

The Invisible Invoice Window
When DVMAX has started an Invisible Invoice, a small Invisible Invoice window will appear.

The title of the Invisible Invoice window is a unique invoice number generated by DVMAX.

The Patient and Client are also listed.

DVMAX is ready to record the changes you make on the Patient History screen to the Invisible

Invoice.

DVMAX Practice V8.6 - User Manual



- 480 -

Working With Invisible Invoices
As its name implies, you do not work directly with an Invisible Invoice. Rather, DVMAX works

in the background, adding line items to the Invisible Invoice as you add Medical Record Entries

to a Patient History.  DVMAX updates the Invisible Invoice window simultaneously with the

Patient History. Each of the items in this Invisible Invoice window will become a line item on

the finished invoice.

Saving an Invisible Invoice
DVMAX saves the Invisible Invoice automatically when you leave or close the Patient History

screen. The Invisible Invoice is saved as an unfinished invoice on the client’s Finances screen.

You can also save an Invisible Invoice at any time while on the Patient History screen. To save

an Invisible Invoice without exiting the Patient History screen:

l Choose Save Invisible Invoice from the History drop-down menu on the

DVMAX main screen.

l You will see the message “Closing and Saving” appear as the Invisible Invoice

window’s status message. When the Invisible Invoice window disappears, the

Invisible Invoice has been successfully saved as an unfinished invoice on the

client’s Finances screen. Any further changes you make to the Patient’s history

will not be reflected on the Invisible Invoice.

When DVMAX saves an Invisible Invoice, it does not post the invoice to your financial rec-

ords. Your inventory will not be updated, nor will the client’s balance owing. In order to post the

invoice to the client’s actual financial records, you must complete the unfinished invoice and

actually bill the client.

See Working With Unfinished Invoices for more information.

Canceling an Invisible Invoice
To cancel an Invisible Invoice:

l Choose Stop Invisible Invoice from the History menu on the DVMAX main

screen.
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l DVMAX will ask you to confirm that you wish to cancel the Invisible Invoice.

l Click Proceed to cancel the Invisible Invoice without saving any changes you

have made since the last time the Invisible Invoice was started.

–OR–

l Click Save Entries to save any changes you have made before canceling the

Invisible Invoice (this is the equivalent of choosing Save an Invisible Invoice).

You cannot stop an invoice when Guaranteed Charge Capture is enabled.  See Guar-

anteed Charge Capture.

Guaranteed Charge Capture
Guaranteed Charge Capture prevents users from disabling or stopping invisible invoicing. This

ensures that all patient treatments and sales are “captured” on the invisible invoice.

This feature ensures that:

l Automatic invisible invoicing is on

l Disables the menu items that can stop the invisible invoice

l Disables the "No" option when starting the invisible invoice

To enable Guaranteed Charge Capture:

l Select System Constant form the Section menu.

l Select the Invoice Settings tab.

l Click the Automatic Invisible Invoicing checkbox.

l A confirm dialog appears asking, "Would you like to enable DVMAX Guar-

anteed Charge Capture?”

l Select Yes to enable the Guaranteed Charge Capture.

l Select OK to confirm the changes and move out of System Constants.

DVMAX Practice V8.6 - User Manual



- 482 -

Working With Unfinished Invoices
Most often, you will start and finish an invoice in one sitting – that is, you will enter all the data,

receive payment, print and post it before doing anything else in DVMAX. However, in some

cases you will leave the invoice unfinished so you can add to it later. For example, you can use

an unfinished invoice to track the treatment of a patient hospitalized for several days or weeks.

DVMAX allows you to add items to an unfinished invoice as necessary; the procedure is iden-

tical to that outlined in the Creating a New Invoice section of this chapter.

An unfinished invoice is exactly like a new invoice, with the following exceptions:

l DVMAX does not post an unfinished invoice to a client's financial history until

the invoice is marked as finished.

l DVMAX does not update sales histories until the invoice is marked as finished.

l Patient Histories may not be updated until the invoice is marked as finished,

depending on the Post History and & Discharge Notes From Unfinished

Invoices setting in System Constants. See System Constants That Affect

Invoicing for more information.

Finding Clients with Unfinished Invoices
To get a list of clients with unfinished invoices:

l From the Section drop-down menu on the DVMAX main window, click Clients

and Patients. The Find window opens.

l Select Clients from the Search For: drop-down menu.

l Select Unfinished Invoices (no input) from the By drop-down menu.

l Click Search. A list of clients with unfinished invoices appears. Double-click

the client with the unfinished invoice you want to edit.

For information on how to print a report of unfinished invoices, see the Financial Reports.
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Finding a Client's Unfinished Invoices
DVMAX lists a client's unfinished invoices on the Client Finances screen. To see a list of unfin-

ished invoices for a client:

l From the Section drop-down menu on the DVMAX main window, click Clients

and Patients. The Findwindow opens.

l Select Clients from the Search For: drop-down menu.

l Select Unfinished Invoices (no input) from the By drop-down menu.

l Click Search. A list of clients with unfinished invoices appears.

l Double-click the client whose unfinished invoices you want to see.

l Click the Finances tab (to the right of General Information) near the top of the

screen.

l The client's unfinished invoices are listed in the upper left of the Client

Finances screen. The date and Primary Patient on the invoice are listed.

Finding Unfinished Remote Invoices
Unfinished remote invoices are unfinished invoices created by a remote terminal (See DVMAX-

Sync).  It is not possible to finish invoices on a remote terminal.  You can search for Unfinished

Remote Invoices and then finish the invoices in the same manner as any other unfinished

invoice, provided you are not working from a remote station.  You can also use the Batch Finish

Unfinished Invoices option to finish a selected group of invoices at one time.
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To find unfinished remote invoices:

l From the Section drop-down menu on the DVMAX main window, click Clients

and Patients. The Find window opens.

l Select Clients or Patients from the Search For drop-down menu.

l If you chose Clients, select Unfinished Invoices (no input) from the By drop-

down menu, then select From Remote Stations Only to generate a list of unfin-

ished invoices from remote stations.  If you chose Patients, select Unfinished

Remote Invoices (no input) from the By drop-down menu.

l Click Search. A list of clients or patients with unfinished invoices created at

remote terminals displays.

Batch Finish Unfinished Invoices
You can use the Batch Finish Unfinished Invoices function from the Patients drop-down menu

on the Patients listing to finish a set of unfinished invoices.  This is particularly useful for

invoices created on remote terminals, since those types of invoices cannot be finished in the

field.

l From the Section drop-down menu on the DVMAX main window, click Clients

and Patients. The Find window opens.

l Select Patients from the Search For drop-down menu.

l Select Unfinished Remote Invoices (no input) from the By drop-down menu.

l Click Search.  This produces a list of patients with unfinished invoices.

l From the Patient menu, select Batch Finish Unfinished Invoices option to fin-

ish the invoices.

Opening an Unfinished Invoice
Typically, DVMAX will prompt you to open an unfinished invoice. You can also open an unfin-

ished invoice directly from the Client Finances tab.

Opening from the Client Finances Tab
DVMAX lists a client's unfinished invoices in the upper left corner of the Client Finances tab.

To see a list of a client's unfinished invoices, follow the steps outlined in the Listing a Client's

Unfinished Invoices section of this chapter.

When you can see the list of a client's unfinished invoices, follow these steps to open one:

l Click in the list of unfinished invoices to select the invoice you wish to edit

l Choose View Unfinished Invoice from the Finances menu on the main

DVMAX screen.
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l The selected invoice opens and is ready to be edited.

Opening from the Client Record
If a client has an unfinished invoice, DVMAX will ask you if you want to open the unfinished

invoice when you either:

l Open the client tab

l Choose Create an Invoice from the Client drop-down menu while viewing the

client tab

To open an unfinished invoice when opening the client tab:

l Click Reopen when asked if you want to reopen the unfinished invoice.

To open an unfinished invoice after choosing Create an Invoice from the Client drop-down

menu:

l Click Reopen when asked if you want to reopen the unfinished invoice.

-OR-
l If a client has more than one unfinished invoice, DVMAX will ask you to

choose which you want to reopen.
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l Click the unfinished invoice you want to open from the list, then click Select.

Opening from the Patient Record
If a patient's owner (a client) has an unfinished invoice, DVMAX will ask you if you want to

open the unfinished invoice when you create an invoice from that patient's tab.

To access an unfinished invoice from the Patient record:

l Choose Create an Invoice from the Patient menu.

DVMAX will ask you if you want to open this patient's unfinished invoice, or, in the case that

this patient has more than one unfinished invoice, to select an unfinished invoice to edit.

If this patient's owner (the client) has an unfinished invoice containing another patient, DVMAX

will ask you if you wish you add this patient to the existing unfinished invoice. To add this

patient to the unfinished invoice, click Add Patient.

Deleting an Unfinished Invoice
To delete an unfinished invoice:

l Open the unfinished invoice by following the steps outlined in Opening an

Unfinished Invoice.

l Choose Delete Unfinished Invoice from the Invoice menu on the DVMAX

main screen.
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l DVMAX will ask you to confirm that you want to delete the unfinished invoice.

Click Yes.

l DVMAX records the deletion of the unfinished invoice on the Client Finances

tab. It is listed as a Bill for $0.00, with the comment “For cancelled open

invoice #x”, where x is the number of the deleted invoice.

l Line items from deleted unfinished invoices are moved to its discharge notes

area. To see the line items that were on the deleted unfinished invoice, double-

click the deleted invoice on the Client Finances tab.

DVMAX does not permit you to void an unfinished invoice that contains payments made

using DVMAX’s integrated credit and debit card feature. For more on the credit and debit card

transactions, see Credit and Debit Card Processing.

Deleting an unfinished invoice does not remove any changes to the patient’s history made

by your work on the invoice in previous sessions. If you wish to remove these entries, you must

do so from the Patient History tab.

Editing, Correcting or Voiding Finished Invoices
You can edit a finished invoice if you need to correct an error you made while creating it. You

can also void or cancel a finished invoice if the entire invoice is unnecessary or incorrect, pro-

vided it does not contain a payment made through DVMAX’s integrated credit and debit card

processing feature.

Editing or correcting a finished invoice can have unintended consequences on your prac-

tice’s financial records. If you are uncertain how to correct an error on a finished invoice, or if

you are uncertain of the effects your correction might have on your financial records, please con-

tact DVMAX Technical Support before proceeding. Editing finished invoices is often not the

best solution to the problem you may be having.

When you choose to edit an invoice, DVMAX actually duplicates the invoice you wish to edit

and reverses the original. You can only edit a finished invoice once.

Editing or voiding finished invoices is one of two methods DVMAX provides you with to make

adjustments to your financial records.

You cannot edit or void a finished invoice for a split ownership patient.

Editing or Correcting a Finished Invoice
To edit a finished invoice:
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l Locate the client for the invoice.

l Locate the invoice you wish to edit on the Client Finances tab.

l Double-click the invoice you wish to edit.

l Choose Edit This Invoice from the Invoice drop down menu.

The Edit this Invoice menu item is disabled if you are working on an invoice that is

already in the process of being edited.

l DVMAX will ask you to confirm that you wish to edit the invoice.

l Click Yes.

l DVMAX will ask you to confirm again that you wish to edit the invoice.

l Click Yes.

l DVMAX may ask you if you wish to keep any payments originally made on this

invoice.
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l Choose Keep Pmnt (Keep Payment) if you have already deposited the payment

originally made on this invoice. Choosing Keep Payment will reverse the

invoice only, not the payment. The payment will stay on the client’s account.

If you choose Keep Payment, do not enter the payment again when editing the invoice.

-OR-
l Choose Enter Again if you have not deposited the payment originally made on

this invoice. Choosing Enter Again will reverse both the invoice and the pay-

ment.

If you choose Enter Again, make sure to enter the payment again while editing this

invoice.

l DVMAX will create a new invoice with the same line items, patient and staff

as the original. Make the necessary changes to the invoice. For information on

filling out invoices, see Creating a New Invoice.

l Click OK to save your changes.

Your changes are recorded on the Client Finances tab, creating a “paper trail” that allows you to

track altered transactions.

Voiding an Invoice
If an entire invoice is incorrect or unnecessary, you may void or cancel the invoice. When you

void an invoice, DVMAX creates an Edit Credit on the Client Finances tab to ‘zero’ the balance

due for the line items on that invoice. DVMAX also creates an Edit Charge on the Client

Finances tab to remove any payment(s) made on the voided invoice. DVMAX also stores a note

as to the date the void was performed.

Depending on your payment provider, DVMAX may not permit you to void an invoice that

contains payments made using DVMAX’s credit and debit card processing feature. For more on

the credit and debit card transactions, see Credit and Debit Card Processing.

To void an invoice:

l Locate the client for the invoice.

l Locate the invoice you wish to void on the Client Finances tab.

l Double-click the invoice you wish to void.

l Choose Void This Invoice from the Invoice menu on the DVMAX main

screen.
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l DVMAX will ask you to confirm that you wish to void this invoice.

l Click Yes. DVMAX voids the invoice and returns you to the Client Finances

tab.

You cannot edit or void a finished invoice for a split ownership patient.

Printing Invoices
DVMAX provides four ways to print invoices:

l You can print an invoice as soon as you have finished creating it.

l You can print an invoice at any time using the Print command.

l You can print a finished invoice from the Client Finances tab with the Print

Item command.

l You can batch print invoices from the General Management section.

For information on printing an invoice as soon as you have finished creating it, see Creating a

New Invoice.

Printing Using the Print Command
You can print an invoice at any time by using the Print command. To print an invoice using the

Print command:

l Locate the client for the invoice.

l Locate the invoice you wish to print on the Client Finances tab.

l Double-click the invoice you wish to print.

l Choose Print from the File drop-down menu on the DVMAX main screen.
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Printing with the Print Item Command
To print a finished invoice from the Client Finances tab:

l Locate the client for the invoice.

l On the Client Finances tab, click once to select the invoice you wish to print.

l Choose Print Item from the Finances drop-down menu.

Batch Printing Invoices
You can print any number of invoices at once with Batch Print Invoices. You can specify

either the date range of invoices or the range of invoice numbers you want to print. To batch

print invoices:

l Select General Management from the Section drop-down menu of the

DVMAX main screen.

l The Management Functions dialog opens. Click the Financials tab on the Man-

agement Functions dialog.

l Click to select the Batch Print Invoices radio button.
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l Click OK. The Batch Print Options dialog appears.

l Click the magnifying glass beside the Client field to print invoices from certain

clients only. Click to select the By Date radio button to print all invoices dated

within a certain time period. Type the start date and end date of the time period

in the Starting Invoice Date and Ending Invoice Date fields.

-OR-
l Click to select the By Invoice Number radio button if you wish to print a range

of invoice numbers. Type the appropriate numbers in the Starting Invoice

Number and Ending Invoice Number fields.

l Click OK. DVMAX will tell you how many invoices match your criteria.
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l Click OK to dismiss the message and print the invoices.

You can print up to two weeks of invoices in one batch.

The Printed Invoice
Below is a sample printed invoice. Note that upcoming Reminders are printed at the bottom of

the invoice. This can be controlled via the Print Reminders on Invoices setting in System Con-

stants. See System Constants That Affect Invoicing for more information on printing

Reminders on Invoicing.

There are a number of System Constants that affect what appears on the printed invoice, includ-

ing:

l Discharge Note Separator

l Discount Label

l Include Bill Codes on Printed Invoices and Estimates

l Print Client Phone on Invoices

l Print Practice Heading on Invoices

l Print Reminders on Invoices

l Print Staff Code on Invoice Line Items
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l Exclude Previous Balance from Printed Invoice

l Zero/non-zero balance notes

See System Constants That Affect Invoicing for details.

Split Ownership and Split Billing
If the patient named on an invoice has two or more owners, charges on that invoice are split

according to each client’s ownership percentage. DVMAX will alert you when about to invoice

a split ownership patient.

The following considerations apply to a split ownership patient:

1. If the invoice is created from the client record, the invoice will be addressed to the client

from whose screen the invoice was created.

2. If the invoice is created from the patient record, the invoice will be addressed to the client

listed as the owner on the patient screen.

3. An invoice will be posted to the Finances tab of clients/owners. The entry on the Finances

tab will reflect the client's percentage ownership.

4. Invoice balances on client statements are calculated according to each client's percentage

ownership of a patient. For example, if Client A owns 60% of a patient, and Client B

owns 40%, and an invoice is created for $100, Client A will owe $60 and Client B $40.

5. The Payment Area is unavailable when creating an invoice for a split ownership patient.

Regular (wholly-owned) and split-ownership patients cannot appear on the same invoice.

Further, you cannot add more than one split-ownership patient to an invoice.

You cannot edit or void a finished invoice for a split ownership patient.

System Constants That Affect Invoicing
You can control many aspects of DVMAX's invoicing behavior with settings in System Con-

stants.  Refer to the System Constants chapter for more information.
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Always Ask for Certificates
If selected, this setting will cause the Certificates dialog to appear every time you finish an

invoice. This allows for easy Certificate printing after every invoice.

Most often, you will leave this setting unselected because the Certificates setting in appropriate

Bill Items is a more efficient way to handle certificate printing (for more information, see the

Bill Items chapter of this manual).

To view or change the Always Ask for Certificates setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Select the Always Ask for Certificates checkbox to have DVMAX always

present you with a Certificate dialog when you finish an invoice.

l Click OK to save your setting.

l Click OK again to exit System Constants.

Audit Invoice Line Item Deletions
This setting controls DVMAX’s behavior when deleting line items. If this setting is off, line

items when deleted will simply disappear from the invoice. If this setting is on, DVMAX will

record the Date, Time, User, Station, Invoice number and line item details in a Deletion Log

(you can access the Deletion Log from General Management).

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Click to select the Audit Invoice Line Item Deletions checkbox. Click again to

deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Auto-Display Rx Label Printing Dialog
If this setting is checked, DVMAX will automatically display the Prescription Labeling dialog

after you enter a prescription item on an invoice line.  (The Prescription Labeling dialog allows

you to create and print labels for medications.) Selecting this setting eliminates the need to use

the Prescription Label button on the invoice screen.

To view or change this setting:

DVMAX Practice V8.6 - User Manual



- 496 -

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the Auto-Display Rx Label Printing Dialog checkbox. Click

again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Automatic Invisible Invoice
This setting control whether DVMAX automatically opens an Invisible Invoice when you open

the Patient History tab. For more information, see the Invisible Invoicing section of this chapter.

To turn on the Automatic Invisible Invoice setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings.

l From the Processing & Printing area of the Invoice Settings section, select

Automatic Invisible Invoice.

l Click OK to save your setting.

l Click OK again to exit System Constants.

Default Doctor
This setting controls the Doctor or Provider initially selected in the "Choose a Primary Provider"

dialog that appears when you create a new invoice. To view or change the Default Doctor:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants. The System Constants dialog appears.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Default Constants. Alternatively, click the Default Constants tab.  The

initials of the Default Doctor, if any, are in the Default doctor field. The Doc-

tor's full name and title are immediately to the right of the Default doctor field.

l To change the Default Doctor, first click the Clear Dr. button to the right of the

Doctor's name. Now type the new Doctor's initials in the Default doctor field.

Press TAB while your cursor is in the empty Default Doctor field to choose from a list of

Doctors.

l Click OK to save your setting.

l Click OK again to exit System Constants.
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Default Invoice Notes
The text in the Default Invoice Notes System Constant is the text that will appear by default in

the Discharge Notes field on the invoice screen. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Notes. Alternatively, click the Invoice Notes tab.

l Type the text you want in the Discharge Notes of every invoice in the Default

Invoice Note field.

l Click OK to save your setting.

l Click OK again to exit System Constants.

Default Line Items on New Invoice
This setting determines the number of empty line items that appear on a new invoice. For more

information about line items, see Invoice Data Entry Details elsewhere in this chapter. To

view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, type the number of empty lines you want on new invoices

in the Default Line Items on New Invoice field.

l Click OK to save your setting.

l Click OK again to exit System Constants.

Invisible Invoicing: Always Ask for Dr.
If this constant is selected, then when you switch between patients using the Next/Previous but-

tons, and there is an invisible invoice running, DVMAX will ask for the Dr. on each switch, and

will use that Dr. as the default value for invoice line items, and for MRE entries.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.
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l From the Invoice Settings tab, click to select the Invisible Invoicing: Always

Ask for Dr. checkbox. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Invisible Invoicing: Disable “No Invoice”
If this setting is on, DVMAX will not present a “No Invoice” option when asking for a Primary

Provider or other information before opening an invisible invoice. Effectively, this means that

any changes to a patient’s history will result in an invoice. See Invisible Invoicing for more

information.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, click to select the Invisible Invoicing: Disable “No

Invoice” checkbox. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Discharge Note Separator
The Discharge note separator holds the text that will appear before each discharge note printed

on an invoice.  Typically you will use two paragraph returns to space your discharge notes when

printed.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Notes. Alternatively, locate and click the Invoice Notes tab.

l From Invoice Notes, type the text you want to appear before each discharge note

printed on an invoice into the Discharge note separator field.

l Click OK to save your setting.

l Click OK again to exit the System Constants dialog.
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Discount Add-On Fees
This setting tells DVMAX whether to apply a discount to the Add-on amount defined for a Bill

Item. This gives you the option of always charging the full Add-on for every item, or discounting

the add-on fee along with the price of the item itself. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants..

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, click to select the Discount Add-on Fees checkbox.

This will tell DVMAX to apply discounts to Add-on fees. Click again to dese-

lect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Discount Label
The text entered in this setting will appear on the printed invoice beside the discount amount.

The default text is “discount”. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, type a discount label in the Discount Label field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Exclude Inactive Clients When Printing Statements
This setting controls whether DVMAX will include clients marked as “Inactive” when printing

statements (from General Management). If this checkbox is selected, statements will not be

printed for inactive clients.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.
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l From Invoice Settings, click to select the Exclude Inactive Clients When

Printing Statements checkbox. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Inactive clients can still owe you money. If you select this setting, do not overlook receiv-

ables pending for inactive clients.

Ignore Rx Info for Prescription Labeling
This setting tells DVMAX whether to notify you when you try to print a prescription label from

an invoice for a Bill Item that is out of stock.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, click to select the Ignore Rx Info for Prescription

Labeling checkbox. This tells DVMAX not to warn you if you write a pre-

scription label for an item that is out of stock. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Include Bill Codes on Printed Invoices and Estimates
This setting controls whether DVMAX prints Bill Codes as part of the description of line items

on an invoice. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, select the Include Bill Codes on Printed Invoices and

Estimates checkbox to print Bill Codes on invoices. Deselect the checkbox to

have DVMAX suppress printing of Bill Codes.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Invoice Copies to Print
This setting controls how many copies of an invoice will be printed. To view or change this set-

ting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l From Invoice Settings, type the number of invoices you want printed in the

Invoice Copies to Print field.

l Click OK to save your setting.

l Click OK again to exit System Constants.

Keep Line Item Providers When Converting Estimates
This setting controls whether an Invoice created from an Estimate retains individual line item

Staff selections from the Estimate. If this setting is checked, line items on the invoice's Staff

boxes will contain the same values as on the originating Estimate. If this setting is unchecked,

DVMAX will force each line item's Staff field to contain the Default Provider from the Esti-

mate.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Select the "Keep Line Item Providers When Converting Estimates" checkbox to

keep the Estimate’s line item Providers on a resulting Invoice. Deselect the

checkbox to have DVMAX force line items to have the same value as the

Invoice’s default provider.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Line Item Dates Enterable
This setting tells DVMAX to allow you to enter the dates for line items directly on the line items

themselves while creating the invoice. This setting is particularly useful for practices that enter

invoice information after the fact (eg. for field visits and hospitalized patients).

To view or change this setting:
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l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Click to select the Line Item Dates Enterable checkbox. Click again to dese-

lect.

l Click OK to save your setting.

l Click OK again to exit System Constants.

List Invoice Patients in Transaction
This setting tells DVMAX to include patient names in the record of an invoice transaction. We

recommend this setting be on to make it easy to see which patients were entered on which

invoices.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Click to select the List Invoice Patients in Transaction checkbox. Click again

to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Max Discount Percentage
The number specified in this setting is the maximum discount that can be applied to any item on

an invoice. If no number is specified, the maximum discount is 0% - i.e., no discount can be

applied on an invoice.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Type a percentage in the Max Discount Percentage field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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New Invoices Default to Print
This setting controls whether the Print checkbox is selected or unselected when you create a

new invoice in DVMAX. If this setting is selected, the Print checkbox will be selected when

you create a new invoice. If this setting is not selected, the Print checkbox will be selected

when you create a new invoice.

To view or change the New Invoices Default to Print setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Select the New Invoices Default to Print checkbox to have the Print checkbox

unselected when you create a new invoice. Deselect the New Invoices Default

to Print checkbox to have the Print checkbox pre-selected when you create a

new invoice.

l Click OK to save your setting.

l Click OK again to exit System Constants.

New Invoices Default to Unfinished
This setting controls whether the Finished checkbox is selected or unselected when you create a

new invoice in DVMAX. If this setting is selected, the Finished checkbox will not be selected

when you create a new invoice. If this setting is not selected, the Finished checkbox will be

selected when you create a new invoice.

To view or change the New Invoices Default to Unfinished setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, locate and click the Invoice Settings

tab.

l Select the New Invoices Default to Unfinished checkbox to have the Finished

checkbox unselected when you create a new invoice. Deselect the New

Invoices Default to Unfinished checkbox to have the Finished checkbox pre-

selected when you create a new invoice.

l Click OK to save your setting.

l Click OK again to exit System Constants.

If you work with many unfinished invoices in DVMAX, it's best to select this setting to

minimize the number of invoices you inadvertently mark as finished.
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Post History and & Discharge Notes from Unfinished Invoices
This setting determines when DVMAX transfers (or posts) a line item on an invoice to a

patient's history. If this setting is selected, DVMAX will post from an invoice to a patient's his-

tory regardless of whether Finished is selected on the invoice. If it is not selected, DVMAX

will wait until you mark the invoice as finished before transferring a line item to the patient's his-

tory.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l From the Processing & Printing area of the Invoice Settings section, select

Post History and Discharge Notes from Unfinished Invoices to have

DVMAX transfer line items from unfinished invoices to patient histories. Dese-

lect this setting to have DVMAX transfer line items from finished invoices only.

Prevent Back-Dating of Invoices and Transactions
If the Prevent Back-Dating of Invoices and Transactions setting is selected, DVMAX will

implement the following behaviors in regard to invoices and transactions:

l On new invoices, the "Date" field is prevented from being set to a date before

the current date. This restriction is also true for the "Aging Date" field.

l When an invoice is back-dated, the date is automatically forced to the current

date, but the line items are set to the back-dated value that the user entered.

l New transactions are prevented from being set to a date before the current date.

l When editing an invoice, if payments are not kept with the new invoice,

DVMAX will generate new receivables and transaction records. These are con-

strained to the current date. As well, on the newly created invoice, the Invoice

Date and Invoice Aging Date are constrained to the current date. The invoice

line items on the newly created invoice do not have their dates constrained.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to change the Prevent Back-Dating of Invoices and Transactions check-

box.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Print Client Phone on Invoices
This setting controls whether the client’s phone number is printed on invoices. To view or

change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the Print Client Phone on Invoices checkbox. Click again to

deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Print Practice Heading on Invoices
If this setting is selected, DVMAX will print your practice's name and address at the top of

invoices. If you are printing estimates on letterhead, turn this setting off.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Select the Print Practice Heading on Invoices checkbox to tell DVMAX to

print your practice's name and address at the top of invoices.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Print Reminders on Invoices
This setting controls which Reminders, if any, are printed on invoices.  There are 3 options:

l Never - no reminders will be printed on invoices

l Patients on Invoice - only reminders for patients that appear on the Invoice will

be printed.

l All Patients for Client - all reminders for all patients for the invoiced client

will be printed. This is the default setting.

To view or change the Print Reminders on Invoices setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.
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l Click to choose Never, Patients on Invoice, or All Patients for Client from

the Print Reminders on Invoice drop-down list.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

If the drop-down list is blank, this is equivalent to All Patients for Client.

The Print Reminders on Invoices setting applies to all clients in DVMAX.

Print Staff Code on Invoice Line Items
This setting controls whether the staff codes on an invoice’s line items appear on the line items

on the printed invoice. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the Print Staff Code on Invoice Line Items checkbox. Click

again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Receivables Aging Options for Backdated Invoices
This setting controls whether the default Receivable Aging Date for backdated invoices remains

at the current date or is changed to the new date on the invoice. For more information, see Back-

dating Invoices.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.
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l From the System Constants drop-down menu on the DVMAX main screen,

choose Finance Constants. Alternatively, click the Finance Constants tab.

l Click to select the Date Invoice Entered radio button to tell DVMAX to leave

the default Receivable Aging Date at the current date when an invoice is back-

dated.

-OR-
l Click to select the Date Service Performed radio button to tell DVMAX to

change the default Receivable Aging Date to the backdated date of the invoice.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

You can override the default behavior set by this System Constant.

Skip to First Empty Line
This setting determines whether DVMAX places the cursor in the Qty field of the first empty

line item when re-opening an unfinished invoice. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the Skip to First Empty Line checkbox. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Suppress Auto-Entry of Payment Amount
This setting tells DVMAX whether to automatically fill in the client's balance in the Payment

Amount field when accepting a payment. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Select the Suppress Auto-Entry of Payment Amount checkbox to tell

DVMAX not to fill in a payment amount. Deselect the checkbox to have

DVMAX automatically place full payment in the payment amount field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Use Global Discounting on Invoices
This setting tells DVMAX whether to allow discounting of all items on an invoice. If this setting

is not in effect, only items specified as discountable can have discounts applied to them.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Select the Use Global Discounting on Invoices checkbox to tell DVMAX that

all line items on an invoice can be discounted. Deselect the checkbox to respect

the discountable setting of a Bill Item.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

User Initials Required to Finish Invoice
This setting determines whether DVMAX requires the user to type their initials when an invoice

is finished. This allows you to determine exactly who in your practice completed the invoice. To

view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the User Initials Required to Finish Invoice checkbox. This

will cause DVMAX to present a dialog asking for initials when an invoice is fin-

ished. Click again to deselect.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Use Single-Click for Line Item Entry
This setting determines whether a single or double-click in a line item field is required to edit

that line item. If this setting is selected, DVMAX will allow editing of a line item field with a

single-click into that field. If this setting is deselected, you must double-click a line item field to

edit it inline. To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to change the Use Single-Click for Line Item Entry checkbox.
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l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Zero and Non-Zero Balance Notes
The Zero Balance Note and the Non-Zero Note affect the printed invoice. If the client has an

unpaid balance when the invoice is printed, DVMAX will print the contents of the Non-Zero

Note on the invoice near the client’s balance. If the client does not have an unpaid balance,

DVMAX will print the contents of the Zero Balance Note.

To edit the Zero Balance and Non-Zero notes:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants. The System Constants screen appears.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Notes. Alternatively, locate and click the Invoice Notes tab.

The Invoice Notes screen appears.
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l Type your text in the Zero Balance Note and Non-Zero Note fields. You can

leave either or both empty. Only the first 2 lines of text will display on the

printed invoice for Zero or Non-zero balance notes, though DVMAX allows you

to type more in each field.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.

Exclude Previous Balance from Printed Invoice
Selecting Exclude Previous Balance from Printed Invoice allows a clinic to remove the Previous

Balance box and label from a printed invoice. This information is not lost from the Client records

only excluded from the printed invoice.

To view or change this setting:

l From the Section drop-down menu of the DVMAX main screen, choose System

Constants.

l From the System Constants drop-down menu on the DVMAX main screen,

choose Invoice Settings. Alternatively, click the Invoice Settings tab.

l Click to select the Exclude Previous Balance from Printed Invoice checkbox.

l Click OK to save your changes.

l Click OK again to save your changes and exit System Constants.
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Item Categories
DVMAX uses Item Category records to classify Bill Items for reporting purposes. Some Finan-

cial Reports take advantage of Item Categories.

You can have as many Item Categories as you like, but we recommend that you keep the total to

around 20 or less for faster and simpler reporting.

This chapter deals with setting up and working with Item Category Records. For information on

how categories are applied to a Bill Item, see Bill Items. For information on how categories are

used in reports, see Financial Reports.

List All Item Category Records
To list all Item Category records:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, choose Item Category from the Search For drop-down

list.

l Click All Records.

l The Item Category List displays.
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The Item Category List
The Item Category list displays one Item Category record per line. There are columns for Cat-

egory Code, Name, Label, and Travel Sort Order.

Open an Item Category Record

l Double click a selected Item Category record to view.

Search from the Item Category List

l Click Search from the list window to run a new Item Category or other Inven-

tory Management search.

-OR-

l Choose Search from the Categories drop-down menu.

l The Find dialog box opens. See the section titled Search For Item Category

Records for more detail.

Add a New Item Category from the Item Category List
l Click Add New at the bottom of the Item Category List.

-OR-

l Choose Add New from the Categories drop-down menu.

l A new Item Category record window opens. See Create a New Item Category

Record for more information.

Show a Subset of Records
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l Click Show from the Item Category listing to display a group of selected rec-

ords.

Exclude a Subset of Records

l Click Exclude from the Item Category listing to hide a group of selected rec-

ords.

Search For a Item Category Record
To find an Item Category record:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, choose Item Category from the Search For drop-down

list.

l Choose Category Code from the By drop-down list to search Item Category rec-

ords by code.

-OR-

l Choose Category Description to search the description fields of Item Category

records.
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l Type a Category code or word from a Category description into the field below

the By drop-down list. If you are searching by code, you can type as many of the

characters of the Category code as you know.. If you are searching by descrip-

tion, DVMAX will find all Categories whose descriptions contain the word or

phrase you type.

l Click Search.

l If there is more than one match for your search, the Item Category List window

will display a list of all Items that matched your search.

l If there is only one Item Category record that matched your criteria, DVMAX

will open that record.
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l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

You can also quickly locate an Item Category record by following the steps in List All

Item Category Records and double-clicking the record you are interested in from the list.

Create a New Item Category Record
To create a new Item Category record:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, choose Item Category from the Search For drop-down

list.

l Click Add New.
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You can also add a new Item Category record by clicking the Add New button at the bot-

tom of the Item Category List. See The Item Category List for more information.

l A new, blank Item Category opens.

l Type a unique name for this Item Category into the Category field.

The name can be up to 15 characters long, but is usually a two-character code matching the

Bill Code for items of this category. See Item Categories and Bill Item Coding for more infor-

mation.

l Type a description of this Item Category into the Description field. The descrip-

tion can be up to 35 characters long and is usually an expansion of the name.

l If this Item category record is to be associated with a General Ledger account,

click the magnifying glass to open a pick list of GL Accounts. Select an account

and click OK.
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l Type the text that will represent this Item Category on graphs into the Label

field. This can be 5 characters long and is usually identical to the name.

l Type a number into the Travel Sort field. This number tells DVMAX where to

place Bill Items from this Item Category on a printed travel sheet. The lower the

number, the higher an item from this category will appear on a travel sheet.

Items from a category with a Travel Sort order of 0 will appear at the top of a

travel sheet; items from a category with a Travel Sort order of 100 will appear

at the bottom of a travel sheet.

The lowest Travel Sort number should be 0.

l Click OK to save the new Item Category record.

Item Categories and Bill Item Coding
We recommend a standardized coding system for Bill Items in which two or three letters or

numbers identify the Item Category of the Bill Item, followed by a number that makes the code

unique.

For example, Laboratory items might be listed as: Lab001, Lab002, Lab003. For more infor-

mation on Bill Item codes, see Bill Items.

Changing an Item Category Description
You can change the Description, Label or Travel Sort order of an existing Item Category. To

change the label or Travel Sort values, simply find and open the relevant Item Category record,

type the new values, and click OK.

To change the Description, find and open the relevant Item Category record, then:

l Click the Change button beside the Description field. DVMAX will warn you

that changing the Description will change the Description on all records that

already use this Item Category.

l The Description field will change color from grey to white. Type the new

description into the Description field.

l Click OK to save your changes and close the Item Category record.

Deleting an Item Category
To delete a single Item Category record:
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l Find and open the Item Category you wish to delete. See Searching for and

Finding an Item Category.

l Click the Delete button at the bottom of the Item Category window.

l DVMAX will ask you to confirm that you want to delete the Item Category rec-

ord.

l Click OK to continue, or click Cancel to go back to the Item Category window.

l DVMAX will check to make sure you want to delete the record. Click OK to

continue and delete the record.

l Click OK.

To delete multiple Item Categories from DVMAX:

l List all Item Categories (see List All Item Category Records).

l Click to select the Item Categories you wish to delete.

l Choose Delete Records from the Categories drop-down menu.

l DVMAX will ask you to confirm that you want to delete the Item Categories.

Click Delete to delete the selected item categories, or Stop to go back to the

Item Category window.
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l DVMAX will check to make sure you want to delete the record.  Click Delete

to continue and delete the record.

When you delete an Item Category, you will need to reassign a valid Category to any Bill

Items that used the deleted Item Category. See Bill Items for more information.
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Setup Label Printers
The Setup Label Printers function lets you add and configure a label printer attached to a work-

station and enables you to make that label printer available to other workstations.  If you have

more than one label printer, Setup Label Printers allows you to select which printer to use for

a particular label type.  As well, this function offers also you label formatting options, such as

including client or clinic address information on prescription labels

Keep in mind that labels generally have fairly limited “real estate”; that is, there is only so much

room in a label in which to fit information. However, DVMAX has a number of great label print-

ing features to help generate many label styles. DVMAX also allows you to use driver-based

printing and network-based printers.

If you have any questions about optimizing label printing, please contact DVMAX Tech-

nical Support for assistance.

The printer preferences you select under Setup Label Printers will only apply to the cur-

rent workstation.  If you have more than one workstation from which you plan to print labels, you

must set the label printing preferences for each workstation individually, even if all stations are

sharing the same set of printers.

Setting Up Label Printers: A Quick Overview
The following is a quick overview of the steps involved in adding a label printer and setting label

printer preferences.  For more on a particular step, see the related section in this Chapter.

To add a new label printer and set label printer preferences:

l From the File menu on the DVMAX main screen, select Setup Label Printers.

l If you have connected a label printer to your workstation, select This station

has an attached label printer.  You will need to complete several steps to set

the preferences for the attached printer.
-OR-
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l If your workstation does not have an attached label printer, the This station has

an attached label printer checkbox should be empty (not selected).

l Click OK on the message pop-up window that opens to notify you that label print-

ing is enabled.

l Click Share the label printer with other stations to make the attached label

printer available to other workstations.

l From the Setup tabbed window, click the Label Printer Type menu and select the

type of label printer that is attached to the workstation.
l Select a printer port from the Label Printing Port menu, where applicable. You

will not see this option if you select Driver-Based Printing.

l If you select Driver-Based Printing from the Label Printer Type menu, you will

see Selected Printer Driver menu. Select a driver.

l Type a name for the attached label printer in the Label Printer Name field.

l From the Options tab, select print style options, as needed.
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l Click Update List from the Select a Printer tab to add the label printer to the list of

available printers.

l From the Select a Printer tab, click in the appropriate column to identify the label

printer your workstation should use for each label type.  Only those printers that

appear on the list can be used for label printing.

l Click OK from the Label Printer Setup box to save preferences.

Opening the Label Printer Setup

To access the label printer setup:

l From the File drop-down on the DVMAX main screen, click Setup Label Printers

l A Label Printer Setup dialog box opens.  If no printers have been added, the Select a

Printer list area will be empty.
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About the Label Printer Setup Window
The Label Printer Setup window will look different depending on whether you have a label

printer attached to the workstation. If your workstation has an attached label printer, the Thissta-

tion has an attached label printer option will be selected and three tabbed dialogue boxes will

appear in the Label Printer Setup window.  Otherwise, you will only see the Select a Printer

tab, and the shared label printers available through other workstations will be listed.

Attached Label Printer
If there is a label printer connected to your workstation, you will need to identify this under

Label Printer Setup.

To indicate an attached label printer:

l From the Label Printer Setup window, click This station has an attached label

printer.

l A message box opens indicating that the label printer attached to the workstation is now

available for printing. Click OK from the message window to continue.  You will still
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need to set the preferences for the printer and add it to the printer list before it can be

used.

l Click Thisstation has an attached label printer again to deselect.

By deselecting This station has an attached label printer, the printer will no longer be

available to print labels by the attached workstation or any other workstations that may be shar-

ing that printer.

Share Label Printer
You must select the Share option if the label printer attached to the current workstation is to be

available to other stations. 

To share the label printer:

l From the Label Printer Setup window, click Share the label printer with other

stations.

l Click again to deselect.  The attached printer will no longer be available for use by

other stations.

By deselecting Share the label printer with other stations, the printer will no longer be

available to print labels by any workstation not directly attached to the printer.

Configuring a Label Printer
You will need to set the preferences for the attached label printer and add it to the printer list

before it can be used.

To setup the printer:

l From the Setup tab, select a label printer type. You may either select a printer from the

list or select Driver-Based Printing if you wish to use an attached printer employing

driver-based printing.
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l If you select a label printer type other than Driver-Based Printing, select a label printer

port from the Label Printer Port/IP drop down menu.

l If you are using a printer with driver-based printing, select the driver from the Selected

Printer Driver menu. You will only see this menu if you have already selected Driver-

Based Printing from the Label Printer Type menu.

l Provide a label printer name.

l From the Select a Printer tab, click Update List to add the printer to the list.

If you are using a serial to Ethernet adapter or network printer, you will need to specify an

IP address.  Contact DVMAX Technical Support for assistance.

Driver-Based Printing
Driver-based printing is a feature that was added in DVMAX v8.0 to permit greater printer flex-

ibility and accommodate requests from DVMAX users.  Driver-based printing may require users

to fine-tune the margins and font size to print properly to various label sizes employed. Please

contact DVMAX Technical Support for setup assistance if you need to make adjustments to

print formatting for standard size labels.

Selecting Label Printer Type
Use the Label printer type menu to identify the type of label printer (the make or model) con-

nected to your workstation. 

To select a printer type:

l From the Setup tab, click the Label printer type button.

l From the drop-down menu, select the type of label printer attached to your workstation.

Selecting the Label Printing Port
During DVMAX installation and initial setup, DVMAX will automatically select a printer port

for you.  The port is where the cable running from the printer connects to your workstation. 
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Most computers have more than one port (and types of ports), often in use for connections to

equipment such as printers, modems and blood analyzers. 

If it is not already set up or you have added a new printer since installation, you need to identify

the number of the port associated with the label printer connection.  If the wrong port is selected,

information cannot be sent to any printer attached to your workstation. 

To select or change the printer port setting:

From the Setup tab, click the Label Printing Port button. 

l From the drop-down menu, select the port for the attached label printer.

If you are using a serial to Ethernet adapter will need to specify an IP address.  Contact

DVMAX Technical Support for assistance.

Printing a Test Label
To test that your labeler and port are properly set up, you can try printing a test label.

To test your printer:

l From the Setup tab, click Print Test Label.

l Click OK from the Confirm window to print the label. Click Cancel to close the Con-

firm window without printing a label.

DVMAX Practice V8.6 - User Manual



- 527 -

l A message window will notify you when the test label is sent to the printer.  Click OK

to close the message window.

Label Printer Name
You must assign a name to the attached label printer.  This could be a descriptive title letting

users know where the printer is located or indicating its main function.  For example, you could

use “Pharmacy Printer” to name the printer on which prescription labels are run.  If other work-

stations have access to this printer, the name can be a quick way to identify a printer’s location

in the office. 

To assign a name to the attached label printer:

l From the Setup tab, type a name for the label printer in the Label Printer Name box.
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Updating the Printer List
Before you can use a newly added printer, you need to add it to the list of available printers. 

The list is shown on the Select a Printer tab.

To add an attached label printer to the list:

l From the Select a Printer tab, click Update List.

l The list of available printers will be updated to include the attached printer.

Choosing Printers for Specific Label Types
You can choose to have all of your labels, regardless of type, printed from the same printer.  If

you have more than one label printer available (either attached or shared with other work-

stations), you can choose to select different printers for specified tasks.  For example, you may

use one printer to run prescription labels, while another is used to create address labels. 

To select the label printer preferences for the current workstation:

l Choose the Select a Printer tab.

l Six different, pre-configured label types are provided as column headings across the top

of the Printers list.  These include the customizable Word Processing labels, which you

can define and access under the Specialmenu from the DVMAX main screen.

l For each label type, click the cell that represents the printer type you want to use. An

asterisk will indicate the printer that will be used for the specified label type. 
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The printer preferences you select will only apply to the current workstation.  You will

need to set the label printing preferences for each workstation individually.

Pre-Configured Label Types
There are six pre-configured label types listed as column headers under the Select a Printer

tab.  These are:

l Client:  Client labels

l Ref.: Referral labels

l BarC:  Bar Code labels

l Addr:  Address labels

l Presc: Prescription labels

l Cust:  Custom labels

If you have any questions about optimizing label printing, please contact DVMAX Tech-

nical Support for assistance.

Printer Options
The Options tab contains a series of specific label printing preferences that can be selected. 

To select an option:
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l Click to select an Option from the list.

l Click again to deselect.

Power Print
This option is only available with certain printers.

Skip Label
Use this option to leave a blank label between prints

Include Client Address on Rx Labels
Select this option to have a client’s address printed on your prescription labels.

Pre-Printed Rx Labels
Select this option to have prescriptions labels run on pre-printed labels.  Make sure that you have

pre-printed labels loaded in the printer before selecting this option and printing labels.

Number of Lines
Type the number of lines to be printed on the labels.  A default number appears in the #Lines

box until you type a new value.

Checking Printer Status
To check the status of label printing tasks:

l Click the small arrow at the bottom left corner of the Label Printer Setup window

l A status message displays.

If the Ignore Rx info for Prescription Labelling system constant is checked, DVMAX

will not warn you about expiration dates on pharmacy lots when Rx label printing. Refer to Sys-

tem Constants for more information.

The patient name is now included on the label when using Print->Labels and choosing

"Addr Label for Patient" in the label editor.
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Configuring Rx Label Space
There are a number of settings that affect Rx label printing.  These include:

l A limit on the number of characters that can be used in the first address line on the

label.  This is truncated at 28 characters. A warning displays if the user enters an

address longer than 28 characters in System Constants.

l The phone number is listed on the same line as the address1. This is controlled by a spe-

cial setting. 

l The warning at the bottom of the label has been compressed onto one line

l There is a default option to not word-wrap the text on the label, but simply to break it at

the label width.

l The label description can have a maximum length of 240 characters.

If you have any questions about optimizing label printing space, please contact DVMAX

Technical Support for assistance.

Monitoring the Label Printing Process
You can have DVMAX monitor label printing and have it alert you if your labels have not been

printed within a particular amount of time. The alert is displayed in the palette, like a client or

patient alert.

With the default settings, DVMAX will wait two minutes after a label has been printed, and will

then check if the printing was successful. If it was not successful, an alert will be displayed on

the screen of the originating computer.

If you have any questions about optimizing label printing, please contact DVMAX Tech-

nical Support for assistance.

Save Printer Setup
To save printer preferences:

l Click OK from the Label Printer Setup window.
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DVMAX License Codes
DVMAX will run in demonstration mode until you enter a valid Clinic ID and License Number.

About Demonstration Mode
While in demonstration mode, DVMAX will limit the result of any search you perform for

clients or patients to a chronological list of the first 100 relevant records. This means that while

you can input an unlimited number of clients and patients into DVMAX with the demonstration

license, you will be able to work only with the first 100 that you create.

In all other respects a demonstration license is functionally equivalent to a purchased license.

This allows your practice to set up and evaluate DVMAX in your regular working environment.

Entering Your DVMAX License Code

If you are using DVMAX client/server, entering or altering a license code on any client

machine on your network modifies the license code for your entire DVMAX installation.

In order to license your copy of DVMAX, you will need three pieces of information:

l Your DVMAX Administrative username and password. By default, the

administrative username is “Administrator”, though you may change it to some-

thing else. You must be logged into DVMAX as the Administrative user in order

to enter or alter your license code.

l Your unique Clinic ID provided when you purchased DVMAX.

l Your License Number provided when you purchased DVMAX.

Store your Clinic ID and License Number in a safe and secure place.

To enter a license for your copy of DVMAX:

Ensure that you are logged into DVMAX as the Administrative user.

l Close all windows, so that only the DVMAX splash screen (and optionally, the

Window List and Command Palette) are visible.

l Choose License from the File drop-down menu.

l The License Information window opens.

DVMAX Practice V8.6 - User Manual



- 533 -

l Type your clinic ID into the Clinic ID field.

l Type your License Number exactly as supplied to you in the License Number

field.

l Press <TAB>.

l If you have typed your Clinic ID and License Number correctly, you will see a

message confirming that this copy of DVMAX has been licensed.

l If there is an error in either the Clinic ID or License Number, DVMAX will

notify you of the error.

l In this case, re-enter both numbers, checking each carefully. If you continue to

have problems, contact DVMAX Technical Support.

l DVMAX will display detailed information about your license, including the ver-

sion number licensed, number of terminals and remote stations covered by this

license, and available modules, in the License Information window.
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l To close the License Information window and continue working with DVMAX,

click the Close button.

View License Information
To view your License information:

l Select License from the File menu.
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Log Records
DVMAX has several record logging features to assist you. You can access the following logs in

DVMAX:

l Pharmacy Log

l Radiation Log 

l X-Ray Log 

l Lab Log

l Anesthesia Log

l Controlled Substances Log

l Email Reminders Log

Pharmacy Log
If you select the RX Item setting on the Pharmacy Details tab of an Inventory item, when you

add an MRE with an MRC for that item to a patient’s history, the items are included in the Phar-

macy log.

To view the Pharmacy log:

l From the Section menu, choose Log Records.

l From the Find dialog, select Pharmacy Log from the Search For menu.

l Choose an option from the By drop-down menu:

l Date (Rx Date) or (Start, End) – prescription date (for a specific date) or

start, end (for a date range).

l Rx # (Rx#) or Start #, End #) – prescription number (for a specific

number), or start #, end # (for a range of Rx numbers).

l Rx Item Code

l Rx Item name (starts with)

l Schedule class (0,2,3,4,5)

l Scheduled drugs

l Patient Name

l Patient ID

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.
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View a Pharmacy Log Record
In the Log list, double-click an entry to view a pharmacy log record.  Click Print to reprint the

Rx label.

Radiation Log
If the Radiologic special setting is selected in a defined MRC, DVMAX will either initiate or

complete a Radiation log entry when you add an MRE with this setting selected to a patient’s his-

tory. These items are added to the Radiation log.

To view the Radiation log:
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l From the Section menu, choose Log Records.

l From the Find dialog select Radiation Log from the Search For menu.

l Choose an option from the By menu:

l Date – enter a specific date or a range of dates.  Use a comma between the

start and end date of a date range.

l Radioisotope – Enter the radioisotope you are searching for.

l Patient – type a patient name.

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.

X-Ray Log
If the X-Ray special setting is selected for a defined MRC, DVMAX will present the X-Ray

Log Entry dialog when you add an MRE with this setting selected to a patient’s history. These

items are added to the X-Ray log.

To view the X-Ray log

l From the Section menu, choose Log Records.

l From the Find dialog select X-Ray Log from the Search For menu.

l Choose an option from the By menu:

- Date (X-Ray Date) or (Start, End) – X-Ray date (for a specific date) or start, end (for

a date range).

l Patient – Specify a patient’s name.

l General – Click Search to open a Query editor, where you can build a custom query

with available tables and fields, comparison operators, and values.
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View an X-Ray Log Record
Double-click a record in the X-Ray Log list to view that record.

Lab Log
If the PACSLink special setting is selected for an MRC, DVMAX will create and send a req-

uisition to the DVMAXLink server when you add an MRE with this setting selected to a

patient’s history. These items are added to the Lab log.

To view the Lab log:
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l From the Section menu, choose Log Records.

l From the Find dialog select Lab Log from the Search For menu.

l Choose an option from the By menu:

l Patient ID and Name

l Keyword in recent entries

l Problem entries (no input)

l Lab Reference Number

l Lab Source

l Date (Lab requisition Date) or (Start, End) – Lab requisition date (for a

specific date) or start, end (for a date range).

l Keyword in all entries (slow)

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.

View and Assign the Lab Log Record
DVMAX automatically assigns incoming lab results to the appropriate patient record.  However,

occasionally records may be returned that do not get assigned.  You can manually assign these

records.  To view a lab log record and/or attach the record to a patient:

l In the Lab Log window, double-click a record to open it.  You can review lab

results in either a text format or using a graph.  For more information on lab

results, see the Lab Results chapter in this manual.
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l For unassigned results, open the lab result and click Assign. That opens a

Patient pick list, allowing you to assign the record to the appropriate patient.

l Note that the date format for lab results correspond to the format used by the lab

instrument from which the results were derived.

l Once a patient is assigned to the record, you may view the Patient record from

the Log record window.

l Click OK and View Patient to open the patient record.

l You are prompted to record the viewing of the lab log. To record the viewing,

click Yes. Otherwise, click No. If you click Yes, the viewing is recorded in the

Lab log record, in the Viewings field.

l Use the Previous and Next buttons to move between Lab Log records.

l Click Delete to remove the Lab Log record. You are advised that deleting a rec-

ord may leave other records incomplete. Click OK to continue, otherwise, click

Cancel.

Anesthesia Log
If the Anesthesia Log special setting is selected on a define MRC, DVMAX will present the

Anesthesia Log Entry dialog when you add an MRE with this setting selected to a patient’s his-

tory. These items are added to the Anesthesia Log.
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To view the Anesthesia log:

l From the Section menu, choose Log Records.

l From the Find dialog select Anesthesia Log from the Search For menu.

l Choose an option from the By menu:

l Date (start, end) – Type a date range using a comma to separate the Start

Date and End Date of the range.

l Anesthetic Agent – Enter the name of the anesthetic agent for which you

are searching.

l PreAnesthetic Agent - Enter the name of the preanesthetic agent for which

you are searching.

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.

View an Anesthesia Log Record
Double-click a record in the Anesthesia Log list to open that record.

Controlled Substances Log
When you create an MRC with the Controlled Substance special setting selected, DVMAX

will present the Controlled Substance Log Entry dialog when you add an MRE using this MRC

in a patient’s history. These items are added to the Controlled Substance log.
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When you select the Controlled Substance setting, the Schedule dialog opens. Select the Sched-

ule associated with this item.

To view the Controlled Substances log:

l From the Section menu, choose Log Records.

l From the Find dialog, select Controlled Substances Log from the Search For

menu.

l Choose an option from the By menu:

l Medication – Enter the name of the medication you are searching for.

l Staff Initials – Enter the initials to be used for the search.

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.

View a Controlled Substance Log Record
Double-click a record in the list to open it.
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Email Reminders Log
If you select the Email Reminders check box on a client record, when email reminders are due,

they are sent and added to the Email Reminders log.

To view the Email Reminders log

l From the Section menu, choose Log Records. The Find dialog opens.

l Select Email Reminders Log from the Search For menu.

l Choose an option from the By menu:

l Patient ID and Name

l Client ID and Name

l Date (start, end)

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables, fields, comparison operators, and values.
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Macros
Macros save you time and typing by allowing you to specify abbreviations for words or phrases.

When you type the abbreviation in a text or word processing area, DVMAX will automatically

replace it with the full word or phrase.

In addition, Macros themselves can include placeholder tags that serve as points you can jump to

and select text from a list of choices.  Macros are defined and controlled through the Patient

Codes section of DVMAX.

Macros must start with "\" (without the quotation marks) when being used. This applies only

when you are typing them in a text or word processing area. The "\" is not entered when adding

new macros in Patient Codes.

Where You Can Use Macros
You can use a macro in the following areas of DVMAX:

l The Client recordWord Processing area.

l The Patient recordWord Processing area.

l Diagnosis Comments on a patient record.

l MRE comments on a patient’s History.

l The Notes tab of a patient record.

Enabling and Disabling Macros
In order for Macros to work in DVMAX, they must be enabled. If Macros are not enabled, no

substitution will occur even if Macros are defined.

Enabling Macros
Macros can be enabled in two places in DVMAX. To enable Macros:

l Choose Preferences from the File menu.

l Click to select the Use Macros checkbox.
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l Click OK.

-OR-

l Select System Constants from the Section menu.

l Select the User Settings tab.

l UnderMisc select the Use Macros check box.

l Click OK.

Disabling Macros
To disable Macros in DVMAX:

l Choose Preferences from the File menu.

l Click to deselect the Use Macros checkbox.

l Click OK.

How to Use a Simple Macro
To use a Macro, it must first be defined in Patient Codes (see Setting Up Macros). To use a

Macro that has already been defined, simply type the character “\”, then the macro text itself,

then a space.

For example, if in Patient Codes you have specified that the Macro “behave” expand to “Behav-

ior Problem”, then to insert the text “Behavior Problem” into a word processing or text area you

would simply type “\behave “ (without the quotation marks).
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The Macro Pick List
If you cannot remember an exact Macro code:

l Type“\” and as much of the code as you remember.

l If there is only one macro that starts with the code you typed, DVMAX will

insert it automatically.

l If there is more than one macro that starts with the code you typed, DVMAX

will present a list of matching macros to choose from.

l Double-click a Macro from the list to choose it, or click Cancel to choose none.

Listing All Macros
To list all available Macros:

l Type “\” and a space into a word-processing or text area that utilizes Macros.

DVMAX will present a list of all macros to choose from.

l Double-click a Macro from the list to choose it, or click Cancel to choose none.

Defining a Simple Macro
Macros are defined in Patient Codes. To define a Macro in DVMAX:

l Choose Patient Codes from the Section menu.
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l From the Find Dialog, choose Macros from the Search For drop-down list.

l Click Add New at the bottom of the Find dialog.

l A new, blankMacro window displays.

l Type the short code for this Macro into the Code field. This code is the abbre-

viation you will type to invoke this Macro in a text area.

DVMAX Practice V8.6 - User Manual



- 548 -

Do not start the code with “\”. The slash character is used only in word processing or text

areas, not in Macro definitions.

l Type a description of this Macro in the Description field. The description is for

display only in the Macros list in Patient Codes and in the Pick List for selecting

Macro codes.

l Type the full text you would like to replace the Macro code with when it is

invoked into the Detail field.

l Click OK to save the Macro.

Search for Macro Records
To find a Macro in DVMAX:

l Choose Patient Codes from the Section menu.

l From the Find dialog choose Macros from the Search For drop down list.

l To search for a Macro by code, choose Code from the By drop-down list.
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- OR -

l To search for a Macro by a keyword in its description, choose Keyword from

the By drop-down list.

The Description search is a leading character search; it will match those Macros whose

description starts with the characters you type. For example, a keyword search for “Pharmacy”

will match “Pharmacy Item” but not “Item in Pharmacy”.

You can use the “@” wildcard operator in both Code and Keyword Macros searches. For

example, a search for “Abd@” will find Macro codes “AbdominalExploratory” and

“Abdomen”.

l Click Search. If more than one Macro matches your search criteria, DVMAX

will show you a list from which you can choose. If only one Macro matches

your criteria, that Macro record will be opened.

To get a list of all Macros currently defined in DVMAX, chick All Records instead of

Search, or leave the search criteria empty and click Search.

Printing Macros
You can print macros with finding options expanded. Select a macro from the Macros window,

and from the DVMAX File menu, select Print. Follow the directions in your print dialog, and

the macro will be printed with finding options expanded, if any.

To print all macros with finding options expanded, make certain no records are highlighted in the

Macros window. Then from the DVMAX File menu, select Print. Follow the printer prompts.

All macros are printed.

Edit a Macro Record
To edit an existing Macro:

l Choose Patient Codes from the Section menu.
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l From the Find Dialog choose Macros from the Search For drop-down list.

l To search for a Macro by code, choose Code from the By drop-down list.

- OR-

l To search for a Macro by description, choose Description from the By drop-

down list.
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The Description search is a leading character search; it will match those Macros whose

description starts with the characters you type. For example, a keyword search for “Pharmacy”

will match “Pharmacy Item” but not “Item in Pharmacy”.

You can use the “@” wildcard operator in both Code and DescriptionMacro searches.

For example, a search for “Abd@” will find Macro codes “AbdominalExploratory” and

“Abdomen”.

l The Macro window displays.

l Edit the Code, Description and Detail boxes as desired. Explanations of the pur-

poses of each box can be found in Defining a Simple Macro.

l Click OK on the Macro window to save your changes.

Delete a Macro Record
To delete a Macro from DVMAX:

l Choose Patient Codes from the Section menu.

l From the Find Dialog choose Macros from the Search For drop-down list.
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l To search for a Macro by code, choose Code from the By drop-down list.

- OR -

l To search for a Macro by description, choose Description from the By drop-

down list.

The Description search is a leading character search; it will match those Macros whose

description starts with the characters you type. For example, a keyword search for “Pharmacy”

will match “Pharmacy Item” but not “Item in Pharmacy”.

You can use the “@” wildcard operator in both Code and DescriptionMacro searches.

For example, a search for “Abd@” will find Macro codes “AbdominalExploratory” and

“Abdomen”.

l Click the Delete button near the lower-left hand corner of the Macro definition

window.
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l DVMAX will ask you to confirm that you wish to delete this Macro.

l Click OK on both dialogs. The Macro is deleted from the list and can no longer

be used in DVMAX.

Finding Items and Macros
Macros can be linked to Finding Items. This allows you to choose from a list of predefined Find-

ing Item options at the time you use the Macro. This powerful feature means you can be more

accurate, with less typing.

For information on Advanced Settings that affect findings in macros, refer to the chapter

Advanced Settings in this document.

Making Finding Items Available to Macros
You must explicitly make a Finding Item available for use in a Macro. You must do this from the

Finding Item screen.

To make a Finding Item’s options available to a Macro:

l Click to select the Support MRE Macros checkbox on the Finding Item

screen.

DVMAX Practice V8.6 - User Manual



- 554 -

Defining a Macro Containing a Finding Item
The process of defining a Macro that contains a Finding Item is almost identical to that outlined

in Defining a Simple Macro, with the addition of a single step.

You can include multiple Finding Items in a single Macro.

To include a Finding Item in a Macro:

l Choose Patient Codes from the Section menu.

l From the Find dialog choose Macros from the Search For drop down list.
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l Click Add New.

l A new, blankMacro record window opens.

l Type the short code for this Macro into the Code field. This code is the abbre-

viation you will type to invoke this Macro in a text area.

Do not start the code with “\”. The slash character is used only in word processing or text

areas, not in Macro definitions.

l Type a description of this Macro in the Description field. The description is dis-

played only in the Macros list in Patient Codes and in the Pick List for selecting

Macro codes.

l Type the full text you would like to replace the Macro code with when it is

invoked into the large Detail field.

l To include a Finding Item in the full Detail text, first position the insertion point

where you would like to Finding Item to appear. Then click the Insert Option

button.
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l The Select Finding Item dialog displays.

l Search for the item you wish to insert then click it to select it.

l Click OK. The option tag will appear in the Macro Detail field.

l Click OK to save the Macro.

Using a Macro that Includes a Finding Item
You invoke a Macro that includes a Finding Item in the same manner and locations as you

invoke one that doesn’t. See How to Use a Simple Macro andWhere You Can Use Macros

for more information.

DVMAX Practice V8.6 - User Manual



- 557 -

The Macro Translator Window
When you invoke a Macro that uses a Finding Item, DVMAX will present you with the Macro

Translator window.

The Macro Translator window allows you to choose which of a Finding Item’s options to include

as part of the Macro expansion. To use the Macro Translator window:

l Click to select the Finding Item Option you wish to use from the list on the

left. The Finding Item Option is inserted into the Macro text.

l If necessary, click the Next button to move to the next Finding Item option in the

Macro.

l Click OK to save your choice(s). DVMAX returns you to the text or word proc-

essing area from which you invoked the Macro.

If there is only one Finding Item in your Macro, selecting that Item’s option will return you

immediately to the text or word processing area from which you invoked the Macro.

Manual Macros
Manual Macros allow you to choose from a list of predefined options when you insert a Macro,

allowing you to be more accurate, with less typing. You can include multiple Manual Macros in

a single Macro.

To set up a Manual Macro:

l Choose Patient Codes from the Section menu.
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l From the Find Dialog choose Macros from the Search For drop-down list.

l Click Add New.

l Click the Add button beneath the list of existing Macros. The Macro window

appears.

l Type the short code for this Macro into the Code field. This code is the abbre-

viation you will type to invoke this Macro in a text area.
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Do not start the code with “\”. The slash character is used only in word processing or text

areas, not in Macro definitions.

l Type a description of this Macro in the Description field. The description is dis-

played only in the Macros list in Patient Codes and in the Pick List for selecting

Macro codes.

l If necessary, type the full text you would like to replace the Macro code with

when it is invoked into the large Detail field.

l To include a selectable item in the full text, first position the insertion point

where you would like to Finding Item to appear. Click the Insert Manual

Macro button.

l DVMAX will insert <mm>yes/no/maybe</mm> into the Detail box. This

default tag contains three choices that will appear when you insert this Macro

into a word processing document: “yes”, “no”, and “maybe”.

l Edit the default tag as necessary, replacing the 3 default tags with your choice

of words and or sentences. Your choices must be separated by the “\” character

and cannot contain the “\” character.

l Click OK to save the Macro.

DVMAX Practice V8.6 - User Manual



- 560 -

Using a Manual Macro
You invoke a Manual Macro in the same manner and locations as you invoke one that doesn’t.

See How to Use a Simple Macro andWhere You Can Use Macros for more information.

The Macro Translator Window
When you invoke a Manual Macro, DVMAX will present you with the Macro Translator win-

dow:

The Macro Translator window allows you to choose which of a Manual Macro’s predefined

options to include as part of the Macro expansion. To use the Macro Translator window:

l Click to select the option you wish to use from the list on the left. The option is

inserted into the Macro text.

l If necessary, click the Next button to move to the next Finding Item option in the

Macro.

l Click OK to save your choice(s). DVMAX returns you to the text or word proc-

essing area from which you invoked the Macro.

If there is only one option in your Macro, selecting that option will return you immediately

to the text or word processing area from which you invoked the Macro.
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Practice Management Financials
There are a number of practice management financial activity options available from the Gen-

eral Management Financials tab of DVMAX.  To access these options, select General Man-

agement from the Section menu on the DVMAX main screen then choose the Financials tab. 

Management Financials include batch printing of invoices, statement, monthly sales data and sev-

eral activities related to credit and debit card transactions.

Batch Print Invoices
The Batch Print Invoice function prints full invoices within the date range you specify.  You can

sort by date or invoice number.

See Batch Printing Invoices in the Invoicing chapter of this manual for details on working with

this functionality.

View Receivables
The View Receivables function displays a list of all outstanding receivables.  The totals dis-

played reflect the receivable amount not the full invoice amount.

To view receivables:

l From the Section menu, choose General Management.

l From the General Management dialog, select the Financials tab.

l Select View Receivables from the Financials tab.

l The report will show receivables by posting date, client name, amount due and

financing date.

Send Out Statements
DVMAX lets you print a statement for a single client or batch print or email a large number of

clients.  When a statement is printed, DVMAX records the activity in each client record for who

you produced a statement.

A single statement can be printed or emailed directly from a Client record or you can run Send

Out Statements from the Financials tab of General Management to batch print statements.

The Send Out Statements function provides more options than printing a statement from

the Client list or from a client record.

Print Client Statements from the Client List
A statement is a summary of all financial activity on the client’s account.  You can print a state-

ment for one or more clients from the Client list, or open a selected client record and print a

statement for that client.  To print a statement from the Client list:

l From a list of client records, select the client or clients for whom you want to

generate a statement.
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l From the list of Client records, select Print from the File drop-down menu. 

You can also access the Print option from the File menu of an individual Client

record.

l When you print a statement for a client, DVMAX will post a STMT transaction

to the client's transaction history.

For more information on statements and client finances, see Clients.

The Email Statements checkbox on the Client General Info tab is used when generating

statements using the Send Out Statements option under General Management.  See Batch

Print or Email Statements.

Batch Print or Email Client Statements
DVMAX lets you batch print and/or email statements using the Send Out Statements option

under General Management.  The Send Out Statements function processes outstanding receiv-

ables and generates your choice of printed or emailed statements or both.  In addition to letting

you choose to email statements, the Send Out Statements feature also lets you optionally sup-

press billing and interest charges.

To batch print or email statements:

l From the Section menu, choose General Management.

l From the General Management dialog, select the Financials tab.

l Select Send Out Statements from the Financials tab.

l From the Statement Setting dialog, complete the information as needed.

l In the Generate Statements for Names After field type the last name or par-

tial last name where you would like statements to begin.  For example, if you

want to begin the statement run with all clients from “Smith” onward, type

“Smith” in the field.  Leave this field blank if you want to generate statements

for all clients.

l From the Print or Email drop-down list, select your printing/emailing option. 

To print statements (no email), select Print.  To email where possible and print

all remaining, select Email First and Print Others. To print a copy of all state-

ments and also email statements where possible, select Print All and Email

Others.

l Select Add Interest and Billing Charges if you wish to apply interest (where

applicable) and billing charges (where applicable) to client statements.

l If you are running an Equine practice, DVMAX provides a Print Short Version

Statement option.  The Short Version Statement does not contain line item

details.

l Click OK to generate statements. 

l DVMAX asks you to confirm whether you want to or do not wish to add interest

and billing fees (depending on whether you selected Add Interest and Billing

Charges). Click Confirm to continue or Cancel to go back and change your

selection.
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l Statements will be emailed and/or printed as selected.

l Once the statement run has completed, DVMAX will ask you to confirm that

the statement run printed successfully. 

l Copies of the statements will be saved to client records.

You should not click Confirm to confirm the statement run printed successfully until after

you have checked that the statements have printed.

You can only email statements if the client has a valid email address and Email Statements

is selected from the General Info tab of the client record.  In addition, the email functionality

must be properly configured under System Constants.  See the related section in System Con-

stants form more information (see also Email Reminders in System Constants).

Print or Email Options
The following are the corresponding actions for the Print or Email Options:

Print: If you select Print from the Print or Email list, the statements will be printed only. 

Email First and Print Others: If you select Email First and Print Others, you will email a

statement to those clients with a valid email address and Email Statements selected on their

client record, then all other statements will be printed.  A printed copy of the statement will not

be created for clients who receive an emailed statement.

Print All and Email Others: If you select Print All and Email Others you will email a state-

ment to those clients with a valid email address and Email Statements selected on their client

record.  In addition, printed copy of the statement will be created for ALL clients who receive

an emailed statement.

Short Version Statement
If you have an Equine practice, DVMAX gives you the option of printing the standard statement

or the short version statement.  The short version statement displays opening balance, a summary

line for payments or credits applied, any charges for the current billing period and total out-

standing balance.

Print Trainer Charges Statement
The Trainer Charges statement applies to Equine practices.  The statement lists invoiced line

items by trainer and patient within a specified date range or from the last billing statement. 

Invoice line item details are provided.  In order for invoice line items to show on the statement,

Report Costs to Trainer must be selected on the General Info tab of the patient record.
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Display Monthly Sales Data
This function is NOT intended for accounting purposes.  It displays monthly sales data by date.

Values shown are ‘trend totals’ only.  Refer to the Reports chapter for information on more

detailed sales reports.

Show Sales Tax Collected
This function lists sales tax records by date for the past 6 months. Refer to the Reports chapter

for information on more detailed sales reports.

View Credit and Debit Transactions
Use the View Credit/Debit Card Transactions to view, print or export the credit card transaction

log.  See the Credit Card Processing chapter for more information on working with credit and

debit card transactions.

XCharge and DVMAX End Of Day Comparison
This function lets you compare credit card transactions in DVMAX to those posted to the

XCharge gateway.  You can only use this function if you use XCharge for processing credit and

debit card transactions. See the Credit Card Processing chapter for more information on work-

ing with credit and debit card transactions.

Intuit QuickBooks Merchant Service Center
This function allows you to securely access the Inuit Quickbooks Merchant Center from your

web browser. You can only use this function if you use Inuit Quickbooks for processing credit

and debit card transactions. See the Credit Card Processing chapter for more information on

working with credit and debit card transactions.

Release Current Open Batch for Settlement
This functionality can be used to force a settlement of the currently open batch at the XCharge

Payment Processor rather than waiting for the batch to process at the scheduled time. You can

only use this function if you use XCharge for processing credit and debit card transactions. See

the Credit Card Processing chapter for more information on working with credit and debit card

transactions.
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The Medical Record Code (MRC)
A Medical Record Code (MRC) identifies and classifies treatments and products that a patient

can receive from your practice. Medical Record Codes are used when you make a Medical Rec-

ord Entry on a patient history. See Working with Patient Records for more information.

Medical Record Codes can also be linked to Bill Items. If a Medical Record Code is linked to a

Bill Item, DVMAX will place that Medical Record Code on the patient history when that Bill

Item is included on an invoice for that patient. It is possible to have multiple MRCs linked to a

single Bill Item. See Bill Items and Invoicing for more information.

Like Diagnosis Codes, the MRCs can include linked external documents (such as LifeLearn doc-

uments) and editable templates that can be attached to the patient record when the MRC is

applied. As well, Medical Record Codes can be set to update areas of the patient record other

than the history. They can also initiate log entries or other procedures.

An Overview of the Medical Record Code
The Medical Record Code in DVMAX consists of a dialog box with 2 tabs: General Information

(Code, Description and Notes) and a Documents tab (for linking external documents).

On the General Information tab, there are also settings that determine how the patient record

will be affected when this MRC is placed on a patient history. For full information on Medical

Record Code settings, see Creating a Medical Record Code.
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Listing All Medical Record Codes
To list all Medical Record Codes in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window choose Med Rec Codes from the Search For drop-

down list.

l Click All Records at the bottom of the Find window.

l The Medical Record Code List displays containing all defined Medical Record

Codes in DVMAX.

The Medical Record Code List
The Medical Record Code list displays one MRC record per line. There are columns for Code,

Description and Notes. The Notes column contains any Special Settings for a Medical Record

Code. See Special Settings for more information.
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You can sort the Medical Record Code List by Code or Description by clicking the appropriate

column header.

Open a Medical Record Code
l Double click a selected Medical Record Code to view the record, or highlight a

record and click Show.

Show a Subset of Records
l Click Show to display a subset of selected records.

Exclude a Subset of Records
l Click Exclude to hide a group of selected records.

Search For Medical Record Codes
To find a Medical Record Code in DVMAX:

l Select Patient Codes from the Section drop-down menu.
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l From the Find window, click to selectMed Rec Codes from the Search For

drop-down list.

l Choose Medical Record Code from the By drop-down list to search Medical

Record Codes by code.

-OR-
l Choose Keyword in Description to search the description fields of Medical

Record Codes.

l Type a Medical Record Code or word(s) from an MRC description into the field

below the By drop-down list. If you are searching by code, you can enter as

many or as few of the characters of the Medical Record Code as you know. If

you are searching by description, DVMAX will find all Medical Record Codes

whose descriptions contain the word you type.

l Click Search.

l If there is more than one match for your search, the Medical Record Code List

window will display containing a list of items that matched your search.
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l If there is only one Medical Record Code that matches your criteria, DVMAX

will open that Medical Record Code.
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l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Creating a New Medical Record Code
To create a new Medical Record Code in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, click to selectMed Rec Codes from the Search For

drop-down list.

l Click Add New at the bottom of the Find window.

You can also create a new Medical Record Code by clicking the Add New button at the

bottom of the Medical Record Code Listing.
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l A new Medical Record Code window opens.

l Type a unique code for this MRC in the Medical Record Code field.

l Type a description of this MRC in the Description field.

l Type the text that DVMAX will automatically place on the patient record when

this MRC is used into the Default Notes field.

l Type the text that DVMAX will automatically place on a Treatment Plan that

uses this MRC into the Default Treatment Plan Note field.

l Click to select the Major Problem checkbox if you want DVMAX to place a

date-stamped copy of this MRC in the Major Problems area when it is entered

on a patient record.

l Click to select the Do Not Include on WP documents checkbox if you do not

wish this MRC to be inserted on Word Processing documents. See Word Proc-

essing for more information.

l Click to select the Hide Name on WP documents checkbox if you wish the con-

tents of this MRC, but not the name, to appear in Word Processing documents.

This setting is useful for inserting comments on the patient record.

l Click to select the Exclude From Web checkbox if you do not wish Medical

Record Entries containing this MRC to be available over the Internet. See Web

Patient Reporting for more information.
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The Hide on Web checkbox on the Medical Record Entry screen is also selected and disabled

if the MRE’s underlying Medical Record Code has the Exclude FromWeb setting enabled.
l Click to select Only Display Findings if you only want findings displayed with-

out comments for this MRC.

l Select the font size and attributes to be used in Word Processing documents.

l Click to place an asterisk (*) beside any Special Settings you want to apply

when a Medical Record Entry containing this MRC is placed on a patient rec-

ord. See Medical Record Code Special Settings for information about the

effect of each Special Setting.

l If you want to be able to enter Findings on the patient record with this MRC,

type a valid Finding Class Code in the Finding Class Code field. See Linking a

Medical Record Code to a Finding Class.

l If you wish this MRC to be included in a History Class, type a valid History

Class Code in the History Class Code field. See Linking a Medical Record

Code to a History Class.

l Click OK to save the Medical Record Code.

Medical Record Code Special Settings
The Special Settings area of the Medical Record Code screen allows you to attach specific

behaviors to the Medical Record Code. DVMAX will carry out the specified behaviors when a

Medical Record Entry containing the Medical Record Code is created on a patient history.

To enable a special setting:

l Click in the column to the left of its name.

l An asterisk (*) will appear beside the name, indicating that the setting is active.

l To disable a special setting, click on the asterisk (*) beside the setting name.

The asterisk (*) will disappear, indicating the setting is inactive.

l You can enable as many special settings as necessary for an individual Medical

Record Code.

Send Apteryx Command
If the Apteryx Command setting is selected, DVMAX will attempt to send an Apteryx com-

mand.
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The Chip ID Setting

If the Chip ID special setting is selected, DVMAX will present the Chip Number dialog when

you create a Medical Record Entry containing this MRC on a patient history.

Typing the patient’s Chip ID into the Chip Number dialog places the Chip ID on the General

Information screen of the patient record.

For more information on Chip IDs, see Working with Patient Records.

The Controlled Substance Setting

If the Controlled Substance special setting is selected, DVMAX will present the Controlled

Substance Log Entry dialog when you create a Medical Record Entry containing this MRC on

a patient history.
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Completing the Controlled Substance Log Entry dialog makes an entry in the Controlled Sub-

stance Log.  When you activate the Controlled Substance special setting, DVMAX will ask

you to choose the Schedule, if any, that the Inventory Item associated with this MRC falls under.

For more information on Schedules, see Inventory. For more information on the Controlled Sub-

stance Log, see Log Records.

The Copy to Patient User Field 1 Setting

If the Copy to Patient User Field 1 special setting is selected, DVMAX will place the name of

this MRC in the customizable User Field 1 box on the General Information tab of the patient

record.

This is useful for classifying patients.

This setting will completely overwrite any previous data in the User Field.
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See Working with Patient Records for information on the Patient User Field.

The Euthanise Setting

If the Euthanise special setting is selected, DVMAX will mark the patient as deceased when

you create a Medical Record Entry containing this MRC on a patient history.

Marking a patient as deceased has several implications in DVMAX. See Working with Patient

Records for more information.

The License Number Setting

If the License Number special setting is selected, DVMAX will present the License Number

dialog when you create a Medical Record Entry containing this MRC on a patient history.

Typing the patient’s License Number into the License Number dialog places the License

Number on the General Information screen of the patient record.
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For more information on License Numbers, see Working with Patient Records.

The Neuter/Spay Setting

If the Neuter/Spay special setting is selected, DVMAX will mark a patient as neutered or

spayed when you create a Medical Record Entry containing this MRC on a patient history.

See Working With Patient Records for more information.

The Radiologic Setting

If the Radiologic special setting is selected, DVMAX will either initiate or complete a Radi-

ation log entry when you create a Medical Record Entry containing this MRC on a patient his-

tory.
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Completing the Radiological Log Entry dialog will make an entry in the Radiological log. For

more information, see Log Records. For more information on Radiology integration in

DVMAX, see Working with Patient Records.

The PACS Link (Formerly Sound PACS) Setting

If the PACS Link special setting is selected, DVMAX will create and send a requisition to the

DVMAXLink server when you create a Medical Record Entry containing this MRC on a patient

history.

The Anesthesia Log Setting
If the Anesthesia Log setting is selected, DVMAX will add an entry in the Anesthesia Log

when this MRC is used.
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The Weight Setting

If the Weight special setting is selected, DVMAX will set the weight of the patient to the

number entered in the Quantity field of the Medical Record Entry that contains this MRC. A

note will also be made in the Patient Notes field with the date of the entry.

This setting is intended for recording a patient’s weight while working on an invoice. You

can enter the new weight as the Qty on an invoice line, and then enter a Bill item with a link to

a Medical Record Code with the Weight special setting enabled. This will record a patient’s

weight without leaving the Invoice screen.

The X-Ray Setting

If the X-Ray special setting is selected, DVMAX will present the X-Ray Log Entry dialog

when you create a Medical Record Entry containing this MRC on a patient history.

Completing the X-Ray Log Entry dialog will make an entry in the X-Ray log. For more infor-

mation, see Log Records. For more information on X-Ray integration in DVMAX, see Work-

ing With Patient Records.
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Linking a Medical Record Code to a Finding Class
When a Medical Record Code is linked to a Finding Class, the Findings button will become

available when you create a Medical Record Entry with that MRC on a patient history, allowing

you enter specialized predefined Findings for the MRE.

For more information on Findings, see Findings. For more information on entering Findings on a

patient history, see Working With Patient Records.

Linking a Medical Record Code to a History Class
History Classes allow you to insert items from a Patient’s history in organized and related sec-

tions into a Word Processing document. When a Medical Record Code is part of a particular His-

tory Class, that MRC will be included in any patient Word Processing documents that make use

of that History Class.

See History Classes for more information.

Linking a Document to an MRC
When an external document is linked to an MRC, the document will display when you enter the

MRC on a patient history. Depending on the document type you select, it will either be an inform-

ative document (non-editable) or an editable document (such as a template).

To link a document to an MRC:

l From the MRC, click the Documents tab.

l From the Documents tab, specify the document location for the document

you wish to link to the MRC under the Launchable Document Associations

area.

l From the File Name field, click Load and select your document. The name

of the file will display in the File Name field. Once you have specified the

Launchable Document Associations, you can click View to see the doc-
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ument. You can change the document at any time by repeating the Load

process.

l From the Type options, choose Informative Document if you do not want

the linked document to be added to the Attachments tab of the patient rec-

ord when you use the MRC. Choose Editable Template if you may want an

edited version of the document to be added to the Attachments tab of the

patient record when you use the MRC.

l From the Display options, select Upon MRC Selection to have the doc-

ument open when you click to create the diagnosis on the patient record,

Choose Upon MRE Save to have the document open when you click to save

the diagnosis to the patient record.

l In the Default Document Comment field, type the default comments you

want to post to the Comments area of the Attachments tab of the patient

record. These will only be applied to the Attachments tab of the patient rec-

ord if you have chosen document type Editable Template.

l Click OK to save the MRC.

Modifying an Individual Medical Record Code
You can change any part of a Medical Record Code at any time, except for its unique code

(because changing the code is equivalent to creating a new MRC). Patient records that use a

modified Medical Record Code will not be updated to reflect your changes, with the exception

of the MRC description. If you update the MRC description, the description will be updated on

Patient records which use the MRC.

To update the description on all records which use this Medical Record Code:

l Click Change beside the Description field.

l DVMAX warns you that changing the description will change the name on all

patient records containing this Medical Record Code.

l Click Yes.

l Type the new name into the Description field.

l Click OK to save the changed description.
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Changes made to the Do Not Include on WP documents, Hide Name of WP documents

and Exclude from Web, as well as changes to any Special Settings or Finding or History Class

associations, also take effect immediately.

Modifying Multiple Medical Record Codes
You can change Medical Record Code settings en masse. To modify multiple Medical Record

Codes at once:

l List all Medical Record Codes

-OR-
l Search for and Find the Medical Record Codes you wish to modify.

l Click to select the Medical Record Codes you wish to modify in the Medical

Record Code list.

Selecting no Medical Record Codes from the list is equivalent to selecting them all.

l Choose Mass Change Settings from the Med Rec Codes drop-down menu.

l The History Entry Setup dialog appears.

l Choose the settings you wish to change in the History Entry Setup dialog.

Click the Set button for each change you wish to make. A dialog will appear

when DVMAX has successfully changed a setting for the selected Medical Rec-

ord Codes.
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l Click OK to close the History Entry Setup dialog.

Deleting a Medical Record Code
To delete a single Medical Record Code from DVMAX:

l Find and open the Medical Record Code you wish to delete. See Searching for

and Finding a Medical Record Code.

l Click Delete at the bottom of the Medical Record Code window.

l DVMAX will ask you to confirm that you want to delete the Medical Record

Code.

l Click OK.

To delete multiple Medical Record Codes from DVMAX:

l List all Medical Record Codes (see Listing All Medical Record Codes).

-OR-
l Search for and find the Medical Record Codes you wish to delete. See Search-

ing For and Finding a Medical Record Code.

l Click to select the Medical Record Codes you wish to delete.

l Choose Delete Records from the Med Rec Codes drop-down menu.
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l DVMAX will ask you to confirm that you want to delete the Medical Record

Codes.

l Click Delete.

DVMAX does not recommend that you delete MRCs. When you delete a Medical Record

Code, it will affect any Patient record on which an MRE containing that MRC has been placed.

The text from the Medical Record Code will remain on the Patient record, but the Medical Rec-

ord Code itself will be marked as invalid in the Medical Record Entry area on the Patient his-

tory. See Working With Patient Records for more information.

Deleting a Medical Record Code will also leave incomplete any Bill Items that are linked

to the deleted MRC. You should remove the link to the deleted Medical Record Code from any

Bill Items that used the deleted MRC. See Bill Items for more information.

MRE Filtering
MRE Filtering allows you to narrow your view of Medical Record Entries on the History tab of

a Patient record. You can filter the list of Medical Record Entries by any combination of the fol-

lowing criteria:

l Date

l Staff

l Site

l Medical Record Code

l Category

l Keyword

You can make MRE filters persistent - DVMAX can automatically apply them to all patient his-

tories viewed on your terminal. DVMAX can also save MRE filters and load them automatically

on startup.

DVMAX notifies you that MRE filters are being applied by changing the color of the Medical

Record Entry header on the Patient history screen to bright red:
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MRE filters can affect your view of a Patient’s medical history. It is vital to be aware of

whether MRE filters are in effect when working with Patient information.

Applying a Simple MRE Filter
The following provides an illustrated example of applying filters to MRE History. To apply a sim-

ple MRE filter on a Patient’s history:

l Click the small triangle or the blue words underneath the Medical Record Entry

header at the top of the History tab.

CONTROL+R (COMMAND+R on the Macintosh) is a keyboard shortcut for activating the

MRE Filter Controls.

l The MRE Filter area opens.

l Choose a date range from the Date drop-down menu.

l Click Use This Filter Set.
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l Note that the Medical Record Entry header is now bright red to indicate that

filters are in place, and that the text immediately below the header and imme-

diately above the MRE list has changed to reflect the filters you have put in

place.

The MRE Filters: An Overview
MRE Filters include the following:

1. Date Filter: You can filter a Patient’s medical history by any date range. Common date

ranges are provided in the drop-down list; you can enter another date range by choosing Custom.

You can use standard DVMAX date shortcuts (such as “T” for tomorrow, “Y” for yes-

terday, or -3 for three days ago) in the date fields that become active when entering a custom

date.

2. Staff Filter: Any staff marked as a Doctor or Provider appears in the Staff list box can be

selected. You can filter a Patient’s medical history by clicking any number of Doctors or Pro-

viders.

3. Site Filter: This filter control will appear only if your installation of DVMAX encompasses

multiple sites. You can choose a site from this drop-down list to limit the list of MREs to those

performed at a particular site.

DVMAX Practice V8.6 - User Manual



- 586 -

4. Medical Record Code Filter: You can type as many Medical Record Codes as you need into

this field. Separate each code with a comma. You can use the wildcard operator in this field: for

instance, “rx@” will match any Medical Record Entries in the Patient’s history that begin with

the letters “rx”.

The wildcard operator can only be used at the end of a search term. For example, “dx@” is

a valid MRE filter, whereas “d@x” is not.

5. Category Filter: You can filter the Medical Record Entries in a Patient’s history by clicking

to choose any number of categories. An MRE’s category is determined by its linked Bill Item.

6. Keyword Filter: You can type as many keywords as you need into this box. Separate each key-

word with a comma. You can use the wildcard operator in this box: for instance, “surg@” will

match “surgical” and “surgery”.

The wildcard operator can only be used at the end of a search term: “surg@” is a valid

MRE filter, whereas “s@ic” is not.

7a. Description Checkbox: Selecting this checkbox will make DVMAX search the descriptions

of a Patient’s Medical Record Entries for the text you have typed in the Keyword Filter box. If

this field is not selected, DVMAX will ignore MRE descriptions when applying a Keyword

Filter. The Description field has no effect if the Keyword Filter field is empty.

7b. Comments Checkbox: Selecting this field will make DVMAX search the comments in a

Patient’s Medical Record Entries for the text you have typed in the Keyword Filter field. If this

box is not selected, DVMAX will ignore MRE Comments when applying a Keyword Filter. The

Comments field has no effect if the Keyword Filter field is empty.

7c. Findings Checkbox: If this field is selected, DVMAX will search the Findings of a Patient’s

Medical Record Entries for the text you have typed in the Keyword Filter box. If this checkbox

is not selected, DVMAX will ignore Findings text when applying a Keyword Filter. The Find-

ings field has no effect if the Keyword Filter field is empty.
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If your practice has used Findings in versions of DVMAX prior to v7.0.10, be sure to check

both the Comments and Findings checkboxes when constructing a Keyword MRE Filter designed

to find Findings text. Previous to version v7.0.10, DVMAX stored Findings as part of an MRE’s

comments; this is no longer the case as of version 7.0.10 and forward.

8a. Load Filter Set: Use this button to load a Filter Set you have saved previously with the Save

Filter Set button.

8b. Save Filter Set: Use this button to save your MRE filter for later use. You will be required to

name the Filter.

9a. Clear All Filters: Click this button to clear any applied filters and view all MREs in the

Patient History.

9b. Use This Filter Set: Click this button to apply the Filters you have defined to the current

Patient’s history.

10. Cancel: Click this button to close the MRE filter interface and return to the main Patient His-

tory screen. The list of MREs on the history screen will be as you left it when you activated the

MRE filter interface.

Activating the MRE Filter Controls
To activate the MRE Filter Controls, click the small disclosure triangle or the underlined text

immediately below the Medical Record Entry header.

CONTROL+R (COMMAND+R on the Macintosh) is a keyboard shortcut for activating the

MRE Filter Controls.

Hiding the MRE Filter Controls
There are several ways to hide the MRE Filter Controls and return to the History view.

l Click the small, open disclosure triangle immediately below the Medical

Record Entry header (this is the equivalent of clicking Apply Filters,

described below)

-OR-
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l Click Cancel if you do not wish to apply any further filters

-OR-

l Click Use This Filter Set to apply your filters and return to the main History

screen.

CONTROL+R (COMMAND+R on the Macintosh) is a keyboard shortcut for deactivating

the MRE Filter Controls. This key combination has the same effect as clicking Apply Filters,

described above.)

The Date Filter
To apply a date filter to the MRE list on Patient History:

l Choose a preset date range from the Date drop-down list.

-OR-

l Choose Custom from the Date drop-down list, and type or select a Start

Date and an End Date.

Standard DVMAX date shortcuts can be used in the Start and End date fields. You can also

click the Calendar icon beside either date field to choose a date from a calendar.

The Staff Filter
To apply a staff filter to the Medical Record Entries on a Patient’s History:

l Click in the Performed By staff list to choose the staff you want to include

in the filter.
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l When a Staff member has been selected, an asterisk (*) appears beside their

name.

Only Staff currently marked as Doctors or Providers appear in the Staff list. If an MRE was

performed by a Staff member no longer listed as a Doctor or Provider (most likely because they

are no longer employed at your Practice), you can catch this item in a filter only by using the last

item in the Staff list, “Other”.

The All and None Buttons
l Click All below the Staff list to quickly select all Staff members for inclu-

sion in a filter.

l Click None to remove all Staff from a filter.

All and None accomplish the same thing. Applying an MRE filter with all Staff selected

produces identical results as not filtering by Staff at all. Use the All and None buttons as short-

cuts to aid in selecting large numbers of staff for a filter.  If you want all MREs to be included,

regardless of Staff, click None.

The MRC Filter
To apply a Medical Record Code filter to the Medical Record Entries on a Patient’s History:

l Type the MRC you want to filter on into the Medical Record Code field. If

you wish to filter on more than one MRC, separate multiple MRCs with com-

mas.

l After adding at least one MRC to the field, press <Tab> to exit the Medical

Record Code field and see the results of your filters.

If you cannot remember the Medical Record Code you wish to filter on, type as much as

you can remember and press the Tab key. DVMAX will show you a pick list of MRCs that con-

tain what you typed.
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You can use the wildcard operator to include groups of MRCs in your filters. For example,

using an MRC filter of “rx@” will look for all MREs linked to any Medical Record Code that

begins with “rx”. You can use the wildcard operator only at the end of an MRC filter term.

The Category Filter
To apply a Category filter to the Medical Record Entries on a Patient’s History:

l Select at least one item from Category list.

l When a Category has been selected, an asterisk (*) appears beside the Cat-

egory.

Depending on the setup of your datafile, it is possible for MREs not to be included in any

Category at all. If you suspect this is the case, try including “Uncategorized” (the last item in

the Category list) in the Filter, or use a Medical Record Code filter to include the MRE you

need.

The All and None Buttons
l Click All below the Category list to quickly select all categories for inclu-

sion in a filter.

l Click None to remove all categories from a filter.

All and None accomplish the same thing. Applying an MRE filter with all Categories

selected produces identical results as not filtering by category at all. Use the All and None but-

tons as shortcuts to aid in selecting large numbers of categories for a filter.  If you want all

MREs to be included, regardless of category, click None.

The Keyword Filter
To apply a Keyword filter to the Medical Record Entries on a Patient’s History:

l Type the keyword you want to filter on into the Keyword field. If you wish to

filter on more than one keyword, separate multiple keywords with commas.

l Click the Description, Comments, and Findings checkboxes as desired.
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l Click Use this Filter Set to see the results of your keyword filter.

You can use the wildcard operator to include multiple keywords in your filters. For exam-

ple, using an keyword filter of “recover@” will find an MRE that contains either “recovering”

or “recovery”. You can use the wildcard operator only at the end of an keyword filter term.

If your practice has used Findings in versions of DVMAX prior to v7.0.10, be sure to check

both the Comments and Findings checkboxes when constructing a Keyword MRE Filter designed

to find Findings text. Previous to version v7.0.10, DVMAX stored Findings as part of an MRE’s

comments; this is no longer the case as of version 7.0.10 and forward.

Applying Filters
As you define your MRE filters, you can see the results immediately in the MRE list as you

move from filter to filter. To properly apply your filters and continue working with Patient His-

tory:

l Click Use this Filter Set.

l This will activate your filters. The Medical Record Entry header becomes bright

red, and a description of the filters in place appears directly below the header.

You can modify your filters at any time.

Saving a Filter Set
You can save a set of MRE filters for use at any time. To save a filter set, first set the filter

criteria you want, then:

l Click Save Filter Set.

l The Save Filter Set dialog opens.
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l Type a name for your filter set. Names can be any length, and may include

spaces.

l Click OK.

The name you give a filter set must be unique. If you type a name of an existing filter set,

DVMAX will ask you if you want to replace the existing filter set.

l Click Yes to replace the existing filter set.

l Click No to return to the Save Filter Set dialog and type a new name.

Loading a Saved Filter Set
To load a saved filter set:

l Click Load Filter Set.

l The Saved Filter Sets dialog appears

l Click a filter set from the list on the left hand side of the dialog to choose it.

A summary of the selected filter’s criteria appears in the right hand side of the dialog win-

dow.

l Click Select to load the filter set and return to the Patient History screen. The

filter set you selected will be in place, and the MRE filter controls will remain

active. You can make modifications to the filter you have loaded.
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To activate your loaded filter set:

l Click Use this Filter Set

Deleting a Saved Filter Set
To delete a saved filter set:

l Choose Preferences from the File menu. The Preferences dialog appears.

l Click the History Filters tab.

l Click once in the filter list to highlight the filter you wish to delete.

l Click Delete Selected Filter. The filter is deleted immediately.

l Click OK to close the Preferences dialog.

Persistent MRE Filters
If MRE filters are not persistent on your DVMAX terminal, filters that you define apply only to

the patient record on which you define them. If MRE filters are set to be persistent, however,

any defined MRE filter will apply to all Patient records you access while logged into your

DVMAX terminal.

For example: You are working with Patient A. You set up an MRE filter to show only MREs

from the last week. You finish working with Patient A, close its record, and open Patient B. If

persistent filters are on, you will see only MREs from the last week for Patient B (along with a

bright red indication that this MRE filter is in place). If persistent filters are off, you will see all

MREs in Patient B’s history.

To enable or disable persistent MRE filters:

l Choose Preferences from the File menu.

l From the Preferences tabbed dialog, click the History Filters tab.

l Click to select the Persistent History Filters checkbox to enable Persistent His-

tory Filtering. To disable persistent filtering, clear the Persistent History Fil-

tering checkbox.
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Persistent Filters Through Restart
If Persistent History Filters are active, you can also choose to have your active MRE filter

saved when you quit DVMAX and reloaded when you next log in.

For example: The Persistent History Filters checkbox is selected, and you set up an MRE filter

to show only MREs from last week. You then quit DVMAX for the day. The next morning you

log in again. If Filters Persist Through Restart is checked, you will see only MREs from the last

week (along with a bright red indication that this MRE filter is in place). If the setting is not

checked, you will see all MREs in a Patient’s History.

The Filters Persist Through Restart setting has no effect on Saved MRE filters (which

appear in the Filter list in the History Filtering Preferences dialog).

To enable or disable persistent-through-restart MRE filters:

l Choose Preferences from the File menu.

l From Preferences, click the History Filters tab.

l From the History Filters tab, select the Filters Persist Through Restart check-

box to enable this setting.  To disable, clear the Filters Persist Through Restart

checkbox.

Clearing (Turning Off) MRE Filters
To turn off all Filters on the Patient History tab:

l If the MRE Filter Controls are not visible, click Show All MREs.

-OR-

l If the MRE Filters are visible, click Clear All Filters.

l Click Use This Filter Set to close the MRE Filter controls.
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How Filters Interact
MRE Filters are cumulative. In other words, only MREs that match all of the filter criteria will

show up in the list of MREs once a filter has been applied. If an MRE matches one criteria, but

not another, it will not pass through the filter and will not appear in the MRE list on Patient His-

tory.

For example:

l A patient has two MREs in its history: “Annual Exam”, performed 11 months

ago, and “Dental Exam”, performed 3 days ago.

With this History:

l A filter for the keyword “exam” would show both MREs

l A filter for MREs performed in the last week would show only the Dental Exam

l A filter for the keyword “exam” in the last week would show only the Dental

Exam (because the Annual Exam does not match all filter criteria).

Filters and MRE Text View
MRE Filters will be in effect in Text View (and printed version of Patient History) if the Filters

Apply to Text View setting is enabled. If this setting is not enabled, no MRE filters are taken into

account in Text View or printed Histories.

To apply filters to Text View and printed histories:

l Choose Preferences from the File menu.

l From Preferences, click the History Filters tab.

l From History Filters Preferences select Filters Apply to Text View if you want

MRE filters to apply to Text View and Printed Histories

-OR-

l Deselect the Filters Apply to Text View checkbox if you do not want MRE

filters taken into account in Text View and Printed Histories.

l Click OK to close the Preferences Dialog.
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Multi-Language Support
DVMAX currently supports invoice and statement printing in English and Finnish.

The Practice Language Preference
The Practice Language Preference determines which language DVMAX will use when printing

client invoices and statements. To set the Practice Language:

l Choose System Constants from the Section drop-down menu.

l Click the Default Constants tab

l Choose a language from the Language field in the Practice Preferences sec-

tion of the Default Constants tab.

l Click OK to save your changes.

l Click OK to exit System Constants.

Practice Language and Invoices
DVMAX will automatically print invoices in the chosen Practice Language. The following

invoice fields, however, will need to be entered in the appropriate language in System Con-

stants:

l Default Invoice Note

l Zero Balance Note
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l Non-Zero Note

These items can all be edited on the Invoice Notes tab in System Constants.

See the Invoicing section of this reference for more information.

Reference Number for Finnish Invoices
If the chosen Practice Language is Finnish, DVMAX will automatically calculate and place on

the printed invoice the necessary Viitenumero reference number.

DVMAX Practice V8.6 - User Manual



- 598 -

The Payment Due Delay Setting
The Payment Due Delay setting allows you to specify the amount of time before an invoice

becomes due on a per-client basis. The Payment Due Delay setting is specified in days, and is

the number of days from the posting of the invoice until the invoice is due.

Currently, the Payment Due Delay setting applies only if the Practice Language Pref-

erence is set to Finnish. The calculated due date appears only on the printed Finnish invoice. The

due date is a one-time calculation – if the invoice is reprinted at a later date, the due date will

not change.

Setting the Default Payment Due Delay
To set the default Payment Due Delay that will apply to all new clients:

l Choose System Constants from the Section drop-down menu.

l Click the Finance Constants tab.

l Type the number of days until an invoice becomes due in the Default Payment

Due Delay field.
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l Click OK to save your changes.

l Click OK to exit System Constants.

DVMAX will apply the default Payment Due Delay setting to any new clients. The setting

will not be applied to existing clients. To set a Payment Due Delay for an existing client, see

Specifying a Payment Due Delay for an Individual Client.

Specifying a Payment Due Delay For an Individual Client

To set the Payment Due Delay for a single client:

l Open the Finances tab of the client record you wish to change.

l Type the number of days until an invoice becomes due in the Payment Due

Delay field.
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l Click OK to save your changes.

Practice Language and Statements
DVMAX will automatically print statements in the chosen Practice Language. The following

statement items, however, will need to be entered in the appropriate language in System Con-

stants:

l Billing Note

You can edit the Billing Note in the Default Notes tab in System Constants.
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Working with Patient Records
Patient records hold information about all of the patients in your practice, giving you access to

vital patient information, reminders, recalls, history (Medical Record Entries and Diagnoses),

notes and more.

All Patient records are associated with a Client record, and because all Patients must be asso-

ciated with a Client, new Patient records can only be created from a Client record. Existing

Patient records can be accessed either directly or through the associated Client record.

In addition to extensive reporting capabilities, DVMAX provides a powerful Word Processing

window where information from all parts of the Patient record can be used to construct a fluid

and effective communication to the client, to a referral source, or for specialized forms and

other documents.

Search for Patient Records
To find a Patient record:

l Click Patients on the Command Palette.

-OR-

l Choose Clients & Patients from the Section drop-down menu.

l From the Find window choose Patients from the Search For drop-down list.
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l Choose a criterion from the By drop-down list. See Search Criteria for more

information.

l If necessary, type an appropriate search term into the field below the By drop-

down list. See Search Criteria for more information on appropriate search

terms. The label of this field is determined by your choice from the By drop-

down list.

l If your practice has multiple sites, choose a site from the Site drop-down list.

l Click Search.

You can Copy/Paste text into fields in the Find dialog.

l If there is more than one match for your search, the Patient List window will

display a list of patients that matched your search.
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l You can sort the Patient list by Patient Status, File Number, Patient Name or

Client Name. For more information, see The Patient List.

l If there is only one record that matches your criteria, DVMAX will open that

Patient record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Patient Search Criteria
DVMAX allows you to search for patients in many ways.  A brief description is provided in the

following sections.
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Search By Patient ID Number
Select Patient ID from the By menu, then enter a Patient ID in the Patient ID Number field to

search for a patient based on their ID number. This is an exact match search.

Search By Patient File Number
Select Patient File Number from the By menu, then enter a Patient file number in the Patient

File Number field to search for a patient based on their file number. This is an exact match

search.

Search By Rabies Tag Number
Select Rabies Tag Number from the By menu, then enter a Tag#, as would be found in the

Tag# field of the Patient record, in the Rabies Tag Number field. This is an exact match

search.

This search finds all patients with the entered tag number regardless of the year the tag was

issued. Leaving the tag number blank and searching will bring up a list of all patients who have a

rabies tag number on file. To search for a tag number that has been replaced in the Tag# field,

you can do a General Search in the Patient Comments area.

Search By Patient Name
This search lets you look for patients by name, client name and number of days since a patient

was last seen. To do a simple search by patient name:

l Select Patient Name from the By menu.

l In the Name, Client, N Days field, enter the full or partial Patient name in the

Patient Name field to search for a patient based on their name.

This search will find all patients whose name is, or begins with, the name you type.  The search

will find both living and deceased patients with the entered name.  You can also add the last

name of the Client who owns this patient by listing it after the name with a comma. For exam-

ple, to find a patient “Buddy” owned by Oliver Jones, you would type “Buddy, Jones”.
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Search by Patient Name and Number of Days Since Last Seen
The search by Patient Name lets you look for patients by name, but you can narrow the search

by adding client name and number of days since a patient was last seen to the patient search.

This will help you distinguish between patients who may have the same name by adding in the

number of days since a patient was last seen (based on MRE history). For example, "Fluffy,,7"

means find all pets named Fluffy that have an MRE within the past 7 days. To do a search by

patient name, client name and last seen:

l Select Patient Name from the By menu.

l In the Name, Client, N Days field, enter the search information you want in the

following format: Patient Name,Client Last Name,Number of Days.

Search By Recall Dates
This search finds patients who are due for recalls during the specified dates (inclusive). Select

Recall Dates (Start, End) from the By menu, to search for a patient based on recall dates. 

Type a Start Date and End date in the Date Range field. Separate dates with a comma. For

example, typing “3/1/12, 3/2/12” would find all patients due for a recall on March 1, 2012 or

March 2, 2012.  To search for a single day, type the single date (ie. 3/1/12,3/1/12). By default,

DVMAX will suggest the current date when searching.  When searching on a Friday, the system

will include Saturday’s date.  When searching on a Monday, the system will include Sunday’s

date.

You can see a report of all Recalls that are due at any given time. You can either work with this

list on the screen, or print it out.

Viewing a List of Recalls by Date
To see a list of current Recalls:

l From the Find dialog, choose Patients from the Search By drop-down list.

l Choose Recall Dates (Start, End) from the By drop-down list.

l If necessary, edit the start and end dates into the Enter Date Range field.

DVMAX inserts the current date as both the start and end date by default.

l If applicable, choose a site from the Site drop-down list.

DVMAX Practice V8.6 - User Manual



- 606 -

l Click Search.

l A Patient List window will display containing a list of Patients with recalls due

on the date(s) specified.

l You can sort this list by Patient Status, File Number, or Owner Name by click-

ing on the appropriate column heading. Double-click a patient from the list to

view the Recalls for that patient.

Print the Recall List
To print the recall list:

l Follow the directions on Viewing a List of Recalls By Date to generate a list of

patients with recalls due on a specified date(s).

l While viewing the resulting Patient list, choose Print from the File drop-down

menu.

l The Printing Patients dialog appears.
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By default, the list is sorted by Doctor Code, Patient Name. If you select Sort Selection in

the printing dialog, then that sort order is used instead of the default sort order.

l Click to select Recall List from the list of available reports.

l Click Print. The Recall List report will print.

Search By Reminder Dates
This search finds patients who are due for reminders during the specified dates (inclusive).

Select Reminder Dates (Start, End) from the By menu, to search for a patient based on recall

dates.  Type a Start Date and End date in the Date Range field.

This search finds patients who are due for reminders during the specified dates (inclusive). Sep-

arate dates with a comma. For example, typing “3/1/12, 3/30/12” would find patients due for any

reminder(s) during the month of March, 2012.

DVMAX will suggest the current month if it is before the 15th of the month, or the following

month if it is after the 15th of the month.  If you enter only a single date, DVMAX will search

for all patients due between that date and the end of the entered month. The search will not

include deceased patients or patients who belong to clients that have been marked as “inactive”.

You can print reminders quickly from the Reminders option under the Section menu on the

DVMAX main screen.
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Search By Reminder Wizard (No Input)
The Reminder Wizard search option will bring up the Reminder Wizard dialog. This dialog

can also be accessed by choosing Reminders from the Section drop-down menu of the

DVMAX main screen. See the Reminders chapter for more information on working with

Reminders.

Search By Unfinished Invoice (No Input)
This search will show a list of all patients currently listed on unfinished invoices. This search

requires no input. 

Search By Unfinished Remote Invoice (No Input)
Use this search option to return a list of patients with unfinished invoices generated on remote

stations. See the chapter DVMAXSync for more information.

Search By Chip ID
Use this search option to return a list of patients by their Chip ID (as entered on the patient rec-

ord). This search will find patients whose Chip ID starts with the entered value.

Search By Birthday
Use this search option to return a list of patients with birthdates between the specified dates. 

Entering “3/1/97, 3/30/97” would find all living patients born during the month of March.  This

search does not take into account the year of birth, only the month and day.

The Birthday search allows you to send Birthday cards to your patients.
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Search By New Patient Date
Use this search option to return a list of new patients entered into DVMAX during the date

range entered.  For example, to find all new patients in the previous month, type the first and last

days of that month.

Search New Rabies Vaccine Date
Use this search option to return a list of patients who have received rabies vaccines during the

date range entered.  This is helpful for county and state reporting.

Search By License Number
Use this search option to return a list of patients based on the license number entered on its rec-

ord (typically a city, county, or state license number).  This is an exact match search. If no infor-

mation is entered for the search, DVMAX will return a list of all patients who have a License

number in their records.

Search By Tattoo Number
Use this search option to return a list of patients based on the Tattoo number entered on its rec-

ord. If no information is entered for the search, DVMAX will return a list of all patients who

have a Tattoo number in their records.

Search By User Defined Label
The User Defined Label on the Patient record is defined under the User Settings tab of System

Constants. Therefore, what appears in this field, located immediately below the Color field, will

vary based on your DVMAX setup. Use this search option to return a list of patients based on

the value of this User Defined Label field on the patient record. The contents of the field must

begin with the letters you type in your search.

Search By Keyword in User Defined Label
The User Defined Label on the Patient record is defined under the User Settings tab of System

Constants. Therefore, what appears in this field, located immediately below the Color field, will

vary based on your DVMAX setup. Use this search option to return a list of patients based on

the value of this User Defined Label field on the patient record. Your search term can appear

anywhere in the field.

Search By MRE History (Past Hx)
This search option allows you to find all patients who have had an MRE or MREs placed on

their history during a given period of time. To use this search, type a word or phrase that is part

of the MRE you are searching for, and then the starting and ending dates for this search. The

search will find all patients who have received an MRE containing the entered keyword during

the time span given.  If no dates are entered DVMAX will find all patients who have received

the specified MRE.  Entering an MRE code will not work for this search. This search uses the

description field of the MRE. For example, if you want to find all patients who have received a

Heartgard product during the past year, you would use “Heartgard” as the search term to find all

treatments, regardless of the dosage given to the patient.
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Search By Diagnosis History (Past Dx)
This search option allows you to find all patients who have received a diagnosis (or diagnoses)

during a given period of time. To use this search, type a word or phrase that is part of the diag-

nosis you are searching for, and then the starting and ending dates for this search. This search is

similar to the Past Hx search, but searches on Diagnosis entries from the Patient history.

Search By Stable Code or Contact Name
Use this search option to return a list of patients according to stable code. This option is only

available if DVMAX is set up for an equine practice. These criteria search the appropriate field

on the patient record for the criteria you provide.

Search By Trainer Code or Contact Name
Use this search option to return a list of patients according to trainer code or name. This option

is only available if DVMAX is set up for an equine practice. These criteria search the appro-

priate field on the patient record for the criteria you provide.

Search By Patient Status
This option is generally used to identify those patients who are hospitalized (i.e. their status is

“In Hospital”). Other possibilities are “Active”, “Deceased”, and “Inactive”.

You can also use the Hospital Census Report from Section ->  General Management to gen-

erate a list of patients by owner, doctor ad condition.

Search By Patient Status in Multi-Site (MPA) Environment
If you are working in a multi-site (MPA-enabled) environment, you will be able to search by Site

as well. There will be a Site drop down menu in the search dialog that defaults to Any. Choosing

a site will result in a list of animals whose status and location matches the criteria provided.

Search By Invoice Number
This search options returns patients named on the Invoice number you supply.

If you have recently upgraded from DVMAX version 7.0.5 or earlier, you may have difficulty

running this search. Contact DVMAX Technical Support for assistance.

Custom Search
The Custom search for patients allows you to create a very specific search based on multiple crite-

ria (eg. a certain treatment given between 2/1/12 and 2/28/12).

General Search
Please see the General Searches chapter for more information.

Listing All Patients
To list all Patients in DVMAX:

l Click Patients on the Command Palette.
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-OR-

l Choose Clients & Patients from the Section drop-down menu.

l From the Find window, choose Patients from the Search For drop-down menu.

l Click All Records at the bottom of the Find window.

l The Patient List appears, containing a list of all Patients in DVMAX.

The Patient List
Each Patient in DVMAX is listed on an individual line, with columns for Status, File Number,

Name, Sex/Gender, Species/Breed, Owner Name and Owner Telephone.
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You can sort the Patient List by Status, File Number, Patient Name and Owner Name by click-

ing the appropriate column heading.

An Overview of the Patient Record
A Patient record contains a series of tabbed windows, accessed either through tabs at the top of

the patient record window, or in some cases through the Patients drop-down menu.

The General Information tabbed window on a Patient Record contains vital statistics about a

particular patient, information about the patient’s owner and Doctor, as well as a list of

Reminders and Recalls for the patient. The General Information window may also contain a

picture of the patient.

The History tabbed window on a Patient Record stores Medical Record Entries and Diagnoses

documenting the medical history of the patient at your clinic. Patient History can be updated man-

ually, or automatically through invoicing.

The Notes tabbed window on a Patient Record has areas for entering and listing both Major Prob-

lems and more general information about a patient. Both areas of the Patient Notes tabbed win-

dow can be updated manually, or automatically through invoicing and/or Patient History updates.

The Attachments tabbed window on the Patient Record can store an image or document, med-

ical or otherwise, to do with the patient. The Attachments tabbed window is typically used to

provide a quick reference to diagnostic images.

The Treatment Plans tabbed window on the Patient Record lists any standard or customized

Treatment Plans and associated To-do items for a patient.
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The Word Processing tabbed window on a Patient Record allows you to create documents –

letters, reminder cards, custom certificates, etc. - based on information stored in other areas of

the Patient record.

DICOM Images tabbed window lets you open and view DICOM images for the patient directly

from the patient record.  Note you can only view any available images once your system is

configured.  This tab may not be available depending on your system configuration.  Contact

Sneakers/DVMAX Technical Support for more information.

Switching Between Tabs on the Patient Record
To switch between the different areas of a Patient Record:

l Click the tab corresponding to the window you wish to work with.

-OR-

l Choose the name of the window you wish to work with from the Patients drop-

down menu.

Creating a New Patient Record
You must create a patient record from the record of the client who owns the patient. The fol-

lowing steps assume you are working with the Client who owns the Patient. For more infor-

mation on Client records, see Working with Client Records.

To add a new patient to a Client Record:
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l Double-click in an empty area of the Patient list (in the lower left corner of the

Client General Information window).

-OR-

l Choose Add New Patient from the Patient drop-down menu on the Client rec-

ord.

CONTROL+N (COMMAND+N on Macintosh) is a keyboard shortcut for Add New

Patient.

l A new Patient General Information window appears, with the title “General

Info for <New Patient> (<Owner Name>)”, where <Owner Name> is the name

of the Patient’s owners.

Entering General Patient Information
To create a Patient record, you must at least provide a Patient name.

To fill out other general Patient information:

l If necessary, type a File Number for this patient into the File field. A file

number can be anything you require to match any existing filing system you may

have at your practice.

l Type the Patient’s name into the Name field.

A setting in System Constants determines whether you begin inputting data with the

patient’s name or file number. See System Constants that Affect the Patient Record for more

information.

l Click the magnifying glass beside the Species field to select the species of this

patient. The species must be defined with a valid Species code. See Species

Records for more information.

l Click the magnifying glass beside the Breed field to select the breed of this

patient. The breed must be defined with a valid Breed code. See Breed Rec-

ords for more information.
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If you cannot remember the Species or Breed Code, type as much as you can remember and

press the Tab key. DVMAX will show you a pick list of codes based on what you typed.

l Click to select radio button corresponding to the sex of the patient.

l If applicable, click to select the Spayed or Neutered checkbox.

The exact language of the gender buttons and the “Spayed” and “Neutered” checkboxes

varies depending on the species of a particular patient.

l Type the patient’s Date of Birth into the DOB field.

You can click the Calendar button to choose a patient’s date of birth from a calendar.

You can click the Calculator button and type the patient’s current age in years, months and

days, and DVMAX will calculate the date of birth for you.

l Type the patient’s color, if applicable, into the Color field.

l If applicable, type a value into the User Defined field. The label for this field,

located immediately below the Color field, is determined under System Con-

stants.

The Item 1 field is a user-defined field determined under System Constants field and may

contain any kind of information that is useful to your practice. See The User-Defined Field for

more information.

l If known, type the patient’s weight into the Weight field. If necessary, click to

select the proper weight units from the drop-down list beside the Weight field.

A setting in System Constants determines the default unit DVMAX uses for weight meas-

ures. See System Constants that Affect the Patient Record for more information.

Holding down the <Option-Alt> key while clicking on the weight units menu will convert

the weight from lbs to kilograms. For example, if you enter 75 in the Weight field, hold down

<Option-Alt> and select Kg from the Weights menu, the weight will be converted from lbs to kil-

ograms.
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l If necessary, change the patient’s status from Active to In Hospital by clicking

the Status drop-down list. See Patient Hospitalization Status for more infor-

mation.

l The Visits button in the Patient record lets you view patient appointment details,

including Visit Reason and any status changes (as tracked from the appointment

using Check In and Status drop-down menus).

Change the Patient File Number
To change the patient file number, select Change File Number from the Patient drop down

menu. In the field provided on the Request dialog, type a new file number and click OK to save

the new file number.

Set an Alert for a Patient Record
A patient Alert is a notice that pops up below the Command Palette when the record is opened.

The alert will also display on the Boarding dialog when you create a boarding record for the

patient. To create or edit an alert:

l From the Patient drop-down menu, select Set Alert Message.

l From the Alert dialog, type your note. Be sure to keep it brief, as space is lim-

ited, and the Alert should be easy to read at a glance.

l Click OK to save the Alert.

l If you already have an Alert for the patient, when you select Set Alert Message

you can click Edit to adjust the note.

l

Create a Memo for the Patient Record
A patientMemo is a notice that pops up on the patient record whenever the record is opened

after the date and time specified in the Memo. To create or edit a Memo:

l From the Patient drop-down menu, select Create a Memo.

l From the Memo dialog, type your note. Be sure to keep it brief, as the Memo

should be quick and easy to read at a glance.

l Specify a Due After date and time.

l Click OK to save the Memo.

l If you already have an Memo for the patient, when you select Create a Memo

you can simply adjust the note as needed.

Saving a New Patient Record
To save a new Patient record:

l Click OK to save this Patient record and return to the client (owner) record.

-OR-

l Click OK & Next Patient to create another Patient record for the same client.
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VetLab Census Data and New Patient Records
The VetLab button on the Patient General Info tab lets you send patient census data to the Vet-

Lab Station Network, when DVMAX is configured to work with a VetLab Station Network.

If you plan to send census data from DVMAX to the VetLab Station, the patient record must

first be saved. You cannot send census data to the VetLab Station for a new patient record until

it has been saved.

About the Patient General Information Tab
The General Information tabbed window shows the patient’s vital and clinical information, cur-

rent status, and lists of Reminders and Recalls pertaining to the patient.

The General Information Area
For information on the General Information Area, see Entering General Patient Information

in Creating a New Patient Record.

VetLab Button and VetLab Status Information
The VetLab button on the Patient General Info tab lets you send census details to, or remove

patient census information from, the VetLab Station Network connected to the terminal. Beside

the button is the VetLab status field. This field will show Active (if census data has been sent),

Pending or Deleted (if census data has been deleted), and may occasionally display an error con-

dition information message from the VetLab, if applicable.

To send or remove a patient from the VetLab census list:
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l Click the VetLab button.

l A Confirm dialog will display asking if you want to Add/Update or Delete the

patient from the VetLab census list.

l Click Add/Update to send census data to the VetLab Station Network

l Click Delete to remove a patient from the census list.

The Clinic Information Area
The Clinic Information area of the General Information window lists the client who owns the

patient, the date of the patient’s last visit to your clinic, the patient’s preferred doctor, and the

patient’s referral source(s). You can also print client and referral source address labels from the

Clinic Information area.

Showing a Patient’s Owner (Client) Information
To see a quick overview of a patient’s owner information while viewing a patient record:

l Click once on the underlined owner’s name in the Clinic Information area.

-OR-

l Click the face icon beside the owner’s name.

l The Owner Info floating window appears.

l The Owner Info floating window lists the Client name(s), File and ID numbers,

home and work telephone numbers, current balances and year-to-date spending,

and any alerts notes or comments about this client. For more information on all

these items, see Working with Client Records.

Jump to Owner
To quickly save and close the patient record and go to the Client (Owner) record, select Jump

to Owner/OK from the Patient drop-down menu.

Setting a Patient’s Primary Provider
You can choose the doctor or provider who will appear by default on a patient’s invoices, pre-

scription labels, and certificates.

To set the Primary Provider for a patient:

l Choose a provider from the Primary Provider drop-down list in the Clinic Infor-

mation area of the Patient General Information window.
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In order to appear in the Primary Provider drop-down lost, a Staff member must have the

Provider setting selected in the Staff record. The Doctor setting in the Staff record need not be

selected.

Setting a Patient’s Referral Source
DVMAX allows you to keep track of how patients are referred to your practice. Referrals can

come from other practitioners, from marketing sources, or from other clients.

Specialty and emergency practices can keep track of the colleagues who refer patients, and gen-

eral practices can record the source of new patients.

For more information, see Referral Sources.

In order to set a Referral Source for a patient, the source must already be defined. See

Referral Sources for information on setting up Referral Source records.

You can specify up to two referral sources for each patient.

To specify a patient’s referral source:

l Click the magnifying glass beside a Referred By: field (#1 or #2).

l The Select Referral Source window appears.
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l Click the Practice Name tag if you wish to search Referral Sources by Practice

Name rather than by the default, Full Name.

l Type the first few characters of the referral source’s name into the Search By

field at the top of the Select Referral Source window. This will narrow the list

of referral sources shown.

l Click to select the referral source you wish to use.

l Click OK.

You may be able to set the referral source to one of your practice’s clients. Whether you

can set the referral source to another client is controlled by the Allow Referrals By Other

Clients setting of the Client & Patient Settings of System Constants.  If this setting is enabled,

you can set a patient’s referral source to a client of your practice by typing “Client Referral”

into the Search By field and clicking OK. This will produce a list of clients in your practice from

which you can choose using techniques similar to those outlined above.

Showing Information About a Patient’s Referral Source
To see a quick summary of a patient’s referral sources:

l Click a Referral Info button to the right of either Referred By field.

l The Referral Info floating window appears, containing a summary of the

patient’s referral source.
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Patient Insurance Company and Policy Number
You can store a patient’s Insurance Company and Policy Number in the appropriate fields in the

Clinic Information area.

The Additional Info Area
The Additional Info area of the General Information window allows you to enter Chip ID, Tat-

too, X-Ray file number and License information for a patient. You can also enter rabies-related

information in this area.

Entering a Chip ID
To record a Chip ID number for a patient:
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l Type the Chip ID number in the Chip ID field in the Additional Info area of

the General Information window.

Entering a Tattoo Number
To record a Tattoo number for a patient:

l Type the Tattoo number in the Tattoo field in the Additional Info area of the

General Information window.

Entering an X-Ray or Radiograph File Number
To record an X-Ray or Radiograph File number for a patient:

l Type the file number in the X-Ray field in the Additional Info area of the Gen-

eral Information window.

Entering a License Number
To record a city, county or other municipal license number for a patient:

l Type the License number in the Lic # field in the Additional Info area of the

General Information window.

Printing Labels From the Patient Record
You can print the following labels from the General Information window of a patient record:

l Client Address Label

l Referral Source Address Label(s)

l Patient File Labels

l Prescription Labels

In order to print labels from DVMAX, a properly configured label printer must be avail-

able. See Setup Label Printers for more information.

Printing a Client Address Label
To print a client address label from the General Information window of a patient record:

l Click the Client Addr Label button in the Clinic Information area.
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Printing a Referral Source Address Label
To print a referral source address label from the General Information window of a patient rec-

ord:

l Click the Referral Address Label button beside the Referral Source for which

you wish to print a label.

Choosing Print Referral Addr Label from the Patient drop-down menu will print an

address label for the first Referral Source for a patient.

Printing a Patient File Label
To print a file label for a patient:

l Choose Print Patient File Label from the Patient drop-down menu.

Printing a Prescription Label
To print a prescription label for a patient:

l Click the Print Rx button on the Patient History window.
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-OR-

l Choose Prescription Label from the Patient drop-down menu.

l The Prescription Labeling window displays.
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l Complete the Prescription Labeling window and click OK & Print to print the

label. For information on the Prescription Labeling window, see Prescriptions

and Refills.

CONTROL+P (COMMAND+P on Macintosh) is a keyboard shortcut for Prescription

Label.

Create an Invoice from a Patient Record
For information on invoicing, see Patient History and Invisible Invoicing and refer to the chap-

ter on Invoicing in this user guide.

Patient History
The Patient History window lists a patient’s medical history, consisting of Medical Record

Entries and Diagnoses. From the Patient History window, you can add a Medical Record Entry

or Diagnosis to the Patient History, chart lab results, and view and print the complete medical

history of the patient.

Patient History can be updated manually, or automatically through invoicing.

For more information on Medical Record Entries and Diagnoses, see their respective chapters in

this reference.

Patient History
The Patient History window is divided into two main sections: Medical Record Entries (MREs)

are listed in the top half of the window, and Diagnoses are listed in the bottom half of the win-

dow.
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The History Preference setting in the Client & Patient Settings section of System Con-

stants controls the order of the MRE and Diagnosis lists. The lists may be ordered with the old-

est entries first, or vice-versa.

Viewing the Requisition History
To view a list of requisitions for this patient, click View Requisition History.  A list of open

requisitions will display. If there are no open requisitions for this patient, a message displays indi-

cating no records were found.

Filtering the List of Medical Record Entries
See the MRE Filtering chapter for detailed information about filtering the list of MREs in the

patient history.

Filtering the List of Diagnoses
DVMAX allows you to filter the Diagnosis list to those entries performed after a specified date.

This is useful when a patient has lengthy list of Diagnoses and you want to focus on recent

entries.

To filter Patient Diagnoses by date:

l Click the Calendar beside the Performed Since field in the Diagnoses area of

the Patient History tab.
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l The Calendar appears. Select a date from the calendar to serve as the earliest

date in the Diagnoses list.

l Click OK in the Calendar to filter the lists and return to the Patient History tab.

-OR-

l Click Cancel in the Calendar to return to the Patient History tab and leave the

lists unfiltered.

If the Diagnosis list seems incomplete, check the date in the Performed Since field to

make sure older entries are not filtered out, and adjust the date if necessary.

Patient History and Invisible Invoicing
Invisible Invoicing refers to DVMAX's ability to automatically create an invoice from changes

you make to a Patient's history. This is the exact reverse of updating the patient's history with

items entered on an Invoice (see the Invoices and Patient Histories section of the Invoicing

section of this reference for more information on this).

Invisible Invoicing works by monitoring changes you make to the Patient History. When you first

open a Patient History, DVMAX can create an invoice in the background. This is the "invisible

invoice." When you add a Medical Record Entry linked to a billable item to the Patient History,

DVMAX adds this item to the invisible invoice.

You can stop the Invisible Invoicing process at any time while working on the Patient record to

convert it to a standard invoice.

The Invisible Invoice Window
When DVMAX has started an Invisible Invoice, a small Invisible Invoice window will appear.

The title of the Invisible Invoice window is a unique invoice number generated by DVMAX.
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DVMAX is ready to record the changes you make on the Patient History tab to the Invisible

Invoice.

Automatic Invisible Invoicing
With the Automatic Invisible InvoiceSystem Constant turned on, DVMAX will open an invis-

ible invoice window every time you open a Patient's history. You will be asked to select a

default provider for the Invisible Invoice when you open the Patient History tab.

See the System Constants That Affect The Patient Record for instructions on how to turn on

the Automatic Invisible Invoice setting.

If you are using Invisible Invoicing frequently, you should set DVMAX to start an invisible

invoice automatically. This will save time and prevent you from making changes to the Patient

History before you remember to start an Invisible Invoice.

Telling DVMAX to Start an Invisible Invoice
You can tell DVMAX to start an Invisible Invoice at any time while you are working on the

Patient History. To tell DVMAX to start an Invisible Invoice:

l Choose Start Invisible Invoice from the History drop-down menu.

Saving an Invisible Invoice
DVMAX saves the Invisible Invoice automatically when you leave or close the Patient History

tab. The Invisible Invoice is saved as an unfinished invoice on the Client’s Finances tab.

You can also save an Invisible Invoice at any time while on the Patient History tab. To save an

Invisible Invoice without exiting Patient History:

l Choose Save Invisible Invoice from the History drop-down menu.
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l You will see the message “Closing and Saving” appear as the Invisible Invoice

window’s status message. When the Invisible Invoice window disappears, the

Invisible Invoice has been successfully saved as an unfinished invoice on the

client’s Finances window. Any further changes you make to the Patient’s history

will not be reflected on the Invisible Invoice.

When DVMAX saves an Invisible Invoice, it does not post the invoice to your financial rec-

ords. Your inventory will not be updated, nor will the client’s balance owing. In order to post the

invoice to the client’s actual financial records, you must complete the unfinished invoice and

actually bill the client.

For information on working with unfinished invoices in DVMAX, see Working With Unfin-

ished Invoices in the Invoices section of this reference.

Canceling an Invisible Invoice
To cancel an Invisible Invoice:

l Choose Stop Invisible Invoice from the History drop-down menu.

l DVMAX will ask you to confirm that you wish to cancel the Invisible Invoice.

l Click Proceed to cancel the Invisible Invoice without saving any changes you

have made since the last time the Invisible Invoice was started.

–OR–
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l Click Save Entries to save any changes you have made before canceling the

Invisible Invoice (this is the equivalent of choosing Save an Invisible Invoice).

It is not possible to stop an invisible invoice when Guaranteed Charge Capture is enabled

from System Constants.

Adding a Diagnosis to the Patient History
To add a Diagnosis to a patient’s medical history:

l Double-click in an empty area of the Diagnosis list on the Patient History win-

dow.

-OR-

l Choose Add New Diagnosis from the History drop-down menu.

-OR-

l Click the Add New Diagnosis button on the Patient History window.

CONTROL+D (COMMAND+D on Macintosh) is a keyboard shortcut for Add New Diag-

nosis.

l The Add New Diagnosis window appears.
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l Type a diagnosis code in the Code field in the Add New Diagnosis window.

l Depending on how the Diagnosis record was defined, there may be a linked

external document (such as a LifeLearn document or an editable template) asso-

ciated with the diagnosis code. This document can open as soon as you enter the

diagnosis code or when you OK the diagnosis. See the chapter Diagnoses for

more information.

If you cannot remember the Code, type as much as you can remember in the Code field and

press the Tab key. DVMAX will show you a pick list of codes based on what you typed.

l Choose the staff member or doctor making this diagnosis from the Staff drop-

down list.

l The current data and time appear in the Date and Time fields. You can alter

these if need be.

l If necessary, type any additional notes to the default diagnosis text that appears

in the Add New Diagnosis window.

l Click to select the Hide This Entry checkbox if you do not wish this Diagnosis

to appear in the Patient History window or to appear as part of the printed

Patient History. See Hiding Entries.

l Click to select the Do not include on WP documents checkbox if you do not

want this Diagnosis to be available for insertion on Word Processing documents

dealing with this patient.

l Click the Findings button if you want to utilize DVMAX’s preset Findings for

this Diagnosis. See Entering Findings for more information on Findings.
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If the Findings button is grayed-out or unavailable, this means that no Finding Class has

been associated with this Diagnosis. Not all Diagnoses have associated Finding Classes. See

Findings for more information on setting up Finding Classes.

l Click OK to save this Diagnosis and return to the Patient History window.

-OR-

l Click OK & Next to save this diagnosis to the Patient History and enter another

diagnosis.

-OR-

l Click Cancel to return to the Patient History window without adding the diag-

nosis.

l

Adding a Medical Record Entry to the Patient History
A Medical Record Entry cannot be deleted once it has been created. Further, DVMAX

locks a medical record entry 24 hours after it has been created. Text in a Medical Record Entry

cannot be altered or deleted once the MRE has been locked, although additional comments

(including Findings) can be added, and the Hide This Entry, Exclude From Printed History

and Exclude from Web settings can be changed.

To add a Medical Record Entry (MRE) to a patient’s medical history:

l Click the Add New MRE button near the top right of the Patient History win-

dow.

-OR-

l Choose Add New Medical Record Entry from the History drop-down menu.
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CONTROL+T (COMMAND+T on Macintosh) is a keyboard shortcut for Add New Med-

ical Record Entry.

l The Add New Medical Record Entry window opens

l Type a Medical Record Code in the Code field in the Add New Medical Rec-

ord Entry window.

l Depending on how the associated MRC was defined, there may be a linked

external document (such as a LifeLearn document or an editable template) asso-

ciated with the Code you entered. This document may launch as soon as you

enter the MRC or when you OK the diagnosis. See the chapterMedical Record

Codes for more information.

If you cannot remember the diagnosis code, type as much as you can remember and press

the Tab key. DVMAX will show you a pick list of codes based on what you typed.

If you enter an invalid MRC into an MRE, DVMAX keeps the cursor in the Code field,

instead of moving to the Qty field. As well, the invalid code is left in the field so it may be cor-

rected.
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l Enter the quantity for this Medical Record Code in the Qty field. If the MRE rep-

resents a service, the quantity will be 1. If the MRE represents a physical inven-

tory item, enter the actual quantity dispensed or administered. Decimal

quantities are permitted.

l Choose the staff member or doctor responsible for this MRE from the Staff

drop-down list.

l The current data and time appear in the Date and Time fields. You can alter

these if need be.

l If necessary, type any additional notes to any default text that appears in the

Add New Medical Record Entry window.

You can take advantage of DVMAX’s Macro capability while working in Medical Record

Entry text fields. See Macros for more information.

l Click to select the Hide in List checkbox if you do not wish this MRE to appear

in the Patient History window or to appear as part of the printed Patient History.

See Hiding Entries.

l Click to select the Hide on Printed History checkbox if you want this MRE to

appear in the MRE list but not in the patient’s printed medical history.

l Click to select the Hide on Web checkbox if you do not want this MRE to be

published on the Internet. See Web Patient Reporting for more information.

The Hide on Web checkbox will be selected and disabled if the MRE’s underlying MRC

has the Exclude from Web setting selected.

l Click the Findings button if you want to utilize DVMAX’s preset Findings for

this MRE. See Entering Findings for more information on Findings.

If the Findings button is grayed-out or unavailable, this means that no Finding Class has

been associated with this MRE. Not all MREs have associated Finding Classes. See Findings

for more information on setting up Finding Classes.

l If necessary, click the Attachments tab to add associate documents or images

with this MRE. See Adding Images or Documents to Medical Record

Entries for more information.

l Click OK to save this MRE and return to the Patient History window.

-OR-

l Click OK & New MRE to save this MRE to the Patient History and enter

another MRE. This button is only enabled if you are entering an MRE. Viewing

an existing MRE will not enable the OK & New MRE button.

-OR-

l Click Cancel to return to the Patient History window without adding the MRE.

You must save an MRE before you can print it. If the Print button on the MRE dialog is

clicked before the MRE is saved, DVMAX will prompt you to save before printing. If you select
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Yes from the dialog, DVMAX will save the MRE and then print. If you click No, DVMAX will

not print the MRE(s).

Displaying MREs and Diagnoses in Floating Windows
You can display MREs and Diagnoses in a floating window. To display:

l Press <Option/Alt> and double-click the MRE or Diagnosis.

l The comments and findings both display as text. If lab result MREs are present,

then a Lab Results tab displays as well. The position and size of the window is

saved restored.

l Alternatively, you can click the small arrow immediately to the left of the

MRE you wish to view, and an action menu displays.  From that window,

select Open or Open in floating window
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Copying MREs and Diagnoses
You can copy and paste MREs and Diagnoses either inside the same patient, or into a different

patient.

l Select an MRE or diagnosis, and from the MRE action menu (the down

arrow to the left of the MRE), select Copy.
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l Then click New MRE to add a new MRE. The Add New Medical Record

Entry window opens. Click Paste Copied MRE. The MRE is pasted, com-

plete with findings and comments.

Assigning a Color to an MRE
You can assign a foreground or background color to an MRE. Select a pre-defined color from
the Color drop-down menu on the MRE input form to cause that row to be drawn in that
color on the Patient listing page.
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Copying MRE Comments
There is a Copy button available when you open the MRC or Diagnosis from the patient History

tab. Click Copy to copy the contents of the Comments field to the system clipboard.

Combining Patients
You can combine data from two patients into a single record. With the patient record open, from

the Patients menu, select Combine Patients. The Combine Patients dialog opens. Click the mag-

nifying glass to open a pick list to select the Destination patient.
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If you want to remove the original record after the patients have been combined, select the

Delete Source when finished checkbox.

DVMAX prevents you from combining patients when opening a patient from the client rec-

ord. To combine patients, you must open the record directly.

All invoices for both patients must be closed before patients can be combined.

Assigning a New Owner to a Patient
With the Patient record open, from the Patient menu, select Assign to New Owner. The Select

New Owner dialog opens. You can search by Full Name or Client ID. Select the new owner,

and click OK. A message indicates the transfer was successful.

You cannot assign a new owner to a patient with open invoices.
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Medical Record Entries and Super Items
An Invisible Invoice must be active in order for a Super Item window to appear when add-

ing a Medical Record Code. See Patient History and Invisible Invoicing.

Some Medical Record Entries are linked to Super Items, meaning a group of related products or

services. If the Medical Record Code you enter on a Medical Record Entry is linked to a Super

Item, DVMAX will ask you to provide quantities and other information about the individual

items that make up the Super Item:

l Click to select the Include checkbox for every item you wish to include on the

Invisible Invoice associated with the Medical Record Entry you are creating.

l Enter a Quantity for each item you are including on the Invisible Invoice.

When you finish entering information for the Super Item, click OK. DVMAX will place the

items that make up the Super Item on individual lines on the Invisible Invoice.

See Bill Items for more information about Super Items.

Adding Images or Documents to Medical Record Entries
You can associate images – photographs, x-rays, ultrasound stills and more - or other documents

with new or existing Medical Record Entries.

DVMAX will automatically attach some images to automatically created MREs (see the

DVMAX PAC Link Integration and Lab Results chapters for more information on auto-

matically-attached images).

To attach a document or image file to a Medical Record Entry:
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l Open a new Medical Record Entry, following the procedures in Creating a

New Medical Record Entry.

-OR-

l Open an existing Medical Record Entry by double-clicking it in the MRE list on

the Patient History window.

l Click the Attachments tab at the top of the MRE window.

l The Attachments List appears. Double-click in an empty area of the Attach-

ments List.

l DVMAX will present an Attachment window. Select the Load image file but-

ton to locate the file on your computer that you wish to associate with this Med-

ical Record Entry.

-OR-

l Drag the image you wish to attach directly on to the attachments input window. 

DVMAX lets you drag a drop images from your system to the Image area of the

open Attachment window.

l Indicate whether the file is a document or an image by clicking the appropriate

radio button beside the Notes field.
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l If necessary, change the date of this image from the current date in the Date

field.

l If necessary, click to select the Image Type from the Type drop-down list.

l Enter any notes about this image in the Notes field.

l Click OK to save the image or document to the Medical Record Entry and return

to the Documents list. The image or document will now appear in the Doc-

uments list.

l Click OK to close and save the Medical Record Entry.

To add a document as an attachment:

l In the Attachment dialog, select the Document radio button, and click Add Doc-

ument. Locate the document you want to attach, and click Open.
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Drag and Drop Images and Documents
DVMAX lets you use simple drag and drop functionality to attach images or documents to a

patient file.  From your system, find the image you wish to place in the patient record and drag

the image from your system to the Image area of the Main Image Processing tab on the Attach-

ments window.

Image Scaling
Use the Image Scaling feature to adjust the size of the displayed image when viewing the image

from the Main Image Processing tab.  Drag the slider to make the image larger or smaller. 

Image scaling does not affect the size of the image when viewed from the Image Markup tab.

Attachment Properties
The Attachment Properties tab under the Attachments window lets you see the image or doc-

ument properties.  In addition to details about attachment type and size, the Attachment Prop-

erties tab also indicates the origin of the attachment, when it was added and when it was last

modified. These values are not editable.

Image Markup & Notation
The Image Markup and Notation feature provides a full range of text and image editing tools that

can be used to add detail to Patient images or added description to Patient diagnoses.

To markup an image:

l Select Attachments from the Patient record.

l The Attachments tab lists all of the Patient’s documents, including images.
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l Double click on the document row that includes the image requiring editing.

l The Attachment dialog opens. There are three tabs on the Attachment dialog -

Main Image Processing, Image Markup & Notation and Attachment Properties.

l Select Image Markup & Notation.

l The Image Markup & Notation dialog opens. Notation and markup options allow

you to add notes, add text, add shapes, edit colors, select fonts, adjust size, and

change angle and opacity.

l Edit the image as desired, then select OK to save the changes made.

Adding Text to the Image Markup Screen
The Image Markup and Notation dialog provides a full range of text editing options including

size, color and styling.

To Add and Edit Text in the Markup window:
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l Select the Text tool and drag a box on the screen where you would like text to

appear.

l A Request window will appear. Type the text you want to appear in the text box

and Select OK.

l Select the Pointer tool and click the text to move the text around the window.

l To change the Font Size, Angle and Opacity, use the slide tools on the left of

the window.

l To change the Font, click the “a” button and select the font of choice.

l To add Italics, Bold and Underline, use the text editing buttons on the left of

the screen.

l To change the Color, select the text with the Pointer tool and select a new

color from the options at the bottom of the screen.

Adding Images to the Image Markup Screen
The Image Markup and Notation dialog provides a range of shape creation and editing options.

To Add Shapes to the image:

l Click the Line, Square, Oval or Circle tool and drag the shape onto the screen

in the required location and to the required size.

l To adjust the position, select the shape with the Pointer tool and move the

shape.

l To adjust the Angle or Opacity of the shape, use the slider tool on the left of the

screen.

l To change the Color, select the shape with the Pointer tool and choose a new

color from the options at the bottom of the screen.
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Automated Image Import
DVMAX lets you attach images and other documents to a patient record as needed. It also has

an auto-image import function that will automatically pull attachments into the appropriate

patient record.  This feature is enabled from the Assorted Preferences tab located under Pref-

erences.

The Automated Image Import function works much like the automatic importing of lab results

from the Lab Results functionality.  The feature works with all file types.  You set the folder

where you want DVMAX to look for images and once you click to enable the functionality,

DVMAX automatically checks the specified folder at regular intervals for images that need to

be moved to patient records.  The files have to be in a specific naming format

To enable Automated Image Importing:

l From the File menu on the DVMAX main screen, select Preferences.

l From the Preferences dialog, select the Assorted Preferences tab.

l Under Assorted Preferences, click Select Folder from the Image Auto-

Import area.

l Select a folder to check for images.  This cannot be the same folder as your

DVMAX Images folder.  If you try to select the same folder as the current

DVMAX Images folder, you will be asked to make a different selection. 

l After you have specified an Auto-Import folder, click Check Folder for

Images to enable the auto-import function.

l Close the Preferences dialog.

The Auto-Import folder is the folder DVMAX checks for images or documents that need to

be uploaded to patient records.  It is used only to temporarily hold files while the files are wait-

ing to be attached to a patient record, such as images that have come in from, for example, a

diagnostic imaging request.  The DVMAX Images folder is where all of your images are per-

manently stored after they have been attached to a patient record.  The Auto-Images folder can

NEVER be the same as the DVMAX Images folder.  DVMAX prevents this from happening.

Auto-Image Import File Naming Conventions
In order for images to be auto-uploaded to the correct patient record, the image must be

named using the following format: PATIENTID_Filename.extension.  For example, 1234_

Test.jpg, where “1234” is the patient ID, then the underscore character “_”, then the filename

DVMAX Practice V8.6 - User Manual



- 647 -

and the file extension (.jpg, .doc, .PDF, etc.).  Contact DVMAX Technical Support if you have

any questions about file naming conventions.

Deleting Images or Documents from Medical Record Entries
To delete an image or document from a Medical Record Entry:

l Open an existing Medical Record Entry by double-clicking it in the MRE list on

the Patient History window.

l Click the Documents tab at the top of the MRE window.

l Double-click the image or document you wish to delete.

l The Attachments window appears. Click the Delete button in the lower left of

the Attachments window.

l DVMAX will ask you twice to confirm that you wish to delete the image or doc-

ument.
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l Click OK in each dialog to delete the image or document and return to the

Attachments window.

l Click OK on the Attachments window to return to the Medical Record Entry

window.

Medical Record Entry Locking
A Medical Record Entry is a permanent addition to a Patient’s history - it cannot be deleted once

created. It can, however, be hidden from view at any time – see Hiding Diagnoses and Medical

Record Entries.

Further, DVMAX automatically locks a Medical Record Entry 24 hours after it has been

created. Any subsequent edits to the existing text in a locked MRE result in a duplicate MRE –

the original always remains intact on the Patient History.

You can also manually lock an MRE any time within 24 hours of its creation. Manually locking

an MRE has the same implications as an automatic lock after 24 hours. You cannot unlock an

MRE once you have manually locked it.

Additional comments (including Findings) can be added to a Medical Record Entry at any time,

and the Hide This Entry, Hide on Printed History and Hide on Web settings can be changed

at any time.

The following components of a Medical Record Entry cannot be modified in any way after it has

been created:

l Medical Record Code & Description

l Quantity

l Date and Time

Manually Locking a Medical Record Entry
Manually locking an MRE is a one-way process: there is no way to unlock the MRE after you

have locked it.

When you manually lock an MRE, a date- and time-stamped note is placed in the MRE’s com-

ments (e.g. “Manually locked by Administrator on 7/1/2007, 16:50:44)

To lock an MRE before the 24-hour automatic lock takes effect:

l Click Lock Now on an open Medical Record Entry
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l A confirmation dialog will appear

l Click Yes to lock the MRE. Click No to leave the MRE unlocked.

l Click OK or OK & Next MRE on the Medical Record Entry window to lock

the MRE. Click Cancel to leave the MRE unlocked.

Modifying Text on an Unlocked Medical Record Entry
To add or change a comment to an existing, unlocked Medical Record Entry (i.e. an MRE that

was created less than 24 hours ago):

l Open an existing Medical Record Entry by double-clicking it in the MRE list on

the Patient History window. The Modify Medical Record Entry window

appears.
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l Click in the comments area and edit or add to any existing text as desired.

l You can change the Staff drop-down list.

l Click OK to save your changes to the Medical Record Entry and return to the

Patient History window.

-OR-

l Click Cancel to return to the Patient History window without saving any

changes to the Medical Record Entry.

You can take advantage of DVMAX’s Macro capability while working in Medical Record

Entry text fields. See Macros for more information.

Modifying a Locked Medical Record Entry or Diagnosis
You can alter the text of a Medical Record Entry or Diagnosis for up to 24 hours after is has

been created. After this point, DVMAX “locks” the record, and any attempt to modify the orig-

inal text contents results in a duplicate MRE or Diagnosis.

To modify the original text of a locked Medical Record Entry or Diagnosis:

l Open an existing Medical Record Entry or Diagnosis by double-clicking it in the

list on the Patient History window. The Modify window appears.

l Click the Edit button on the Modify window
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l DVMAX will ask you to confirm that you wish to edit and re-enter the MRE or

Diagnosis.

l Click Yes. The original MRE or Diagnosis is copied to a new, editable, MRE or

Diagnosis. DVMAX automatically timestamps your revision in the comments

area.
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l If necessary, change the staff member responsible for this MRE or Diagnosis by

choosing from the Staff drop-down list.

l Click in the comments area below the timestamp and edit or add to any existing

text.

l Click OK to save your changes to the Medical Record Entry or Diagnosis and

return to the Patient History window. The new, edited item appears in the list,

immediately above the original.

The date of the original MRE or Diagnosis is preserved in the edited version.

Adding a Comment to a Locked Medical Record Entry or Diagnosis
You can add a comment to a locked Medical Record Entry or Diagnosis at any time:

l Open an existing Medical Record Entry or Diagnosis by double-clicking it in the

list on the Patient History window.

l The Modify window appears, with the cursor positioned in the secondary com-

ments field.
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l Type your comment in the secondary comments field.

l Click OK to save your comment. DVMAX will timestamp your comment and

append it to the original text.

Copying the Text of a Locked Medical Record Entry
You can copy the text of a locked Medical Record Entry and paste it into another area of

DVMAX, or into another program on your computer. To copy the text of a locked Medical Rec-

ord Entry:

l Open the MRE whose text you wish to copy.

l Click the Copy button.
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Hiding and Showing Diagnoses and Medical Record Entries
You can hide selected Diagnoses and Medical Record Entries from the lists displayed on the

Patient History window. The Show Hidden Entries setting on the Patient on this History menu

controls the behavior of items marked as hidden:

l If Show Hidden Entries is not selected (i.e. there is no checkmark beside it in

the History menu), MREs and Diagnoses marked as hidden will not be listed on

window, printed on patient histories, or included in Word Processing documents.

l If Show Hidden Entries is selected (i.e. there is a checkmark beside it in the

History menu), MREs and Diagnoses marked as hidden will be listed on win-

dow, printed in patient histories, and included in Word Processing documents.

Hiding a Medical Record Entry or Diagnosis is the equivalent of crossing out an entry in a paper

record.  The entry still exists, but is not an active part of the history record.

Hiding a Medical Record Entry or Diagnosis
To hide a Medical Record Entry or Diagnosis from the Patient History window:

l Double-click the Medical Record Entry or Diagnosis you wish to hide.

l Click to select the Hide in List checkbox.
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l Click OK to return to the Patient History window.

If the MRE or Diagnosis you have hidden still appears onscreen after following the pro-

cedure above, check to ensure that Show Hidden Entries is not selected in the History menu. If

it is, choose it from the menu to deselect it.

Showing and Hiding Hidden Medical Record Entries and Diagnoses
To show Medical Record Entries and Diagnoses that have been marked as hidden:

l Choose Show Hidden Entries from the History menu, so that a checkmark

appears beside it

To hide Medical Record Entries and Diagnoses that have been marked as hidden:

l Choose Show Hidden Entries from the History menu, so that no checkmark

appears beside it.
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Entering Findings in Diagnoses and Medical Record Entries
Findings allow you to quickly select from a predefined list of conclusions when entering an MRE

or Diagnosis. They can eliminate the inaccuracies resulting from the need to type these items in.

Findings can be entered when initially creating an MRE or Diagnosis, or can be entered after the

fact as a subsequent comment to an existing MRE or Diagnosis (see Adding a Medical Record

Entry, Adding a Diagnosis, andModifying a Locked Medical Record Entry or Diagnosis.)

To enter Findings on an open Medical Record or Diagnosis:

l Enter the MRC in the Code field.

l If the MRC has associated Findings the remainder of the window will list the

available Finding items.

If the MRC does not have any associated Finding Items no Findings will be listed.

l Click a Finding item from the Findings list on the left.
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l Add notes for each Finding item in the comment box on the right of the window.

Each new finding note will be automatically compiled into the finding at the bot-

tom right of the window.

l Click once on each Finding item you wish to insert as a Finding on the MRE or

Diagnosis.

l Click OK & Next MRE to close the Findings Entry window, insert the Finding

Items on to the MRE or Diagnosis, and proceed to the next MRE or Diagnosis

on the Patient History.

Using Macros in Medical Record Entries and Diagnoses
You can take advantage of DVMAX’s Macro capability in the comments area of either a Med-

ical Record Entry or Diagnosis. Macros will work both in initial comment entry and in sub-

sequent comments.

You must define Macros before they can be available in MREs or Diagnoses. Macros are

defined in the Macros section of System Constants. See the Macros chapter of this reference for

more information.

You must type the character “\” before a defined Macro name in order for DVMAX to rec-

ognize it as a macro. For example, if there is a defined Macro called “behave”, you must type

“\behave” in an MRE or Diagnosis comment to use that Macro.

For more information on Macros, see the Marcos chapter of this reference.

Printing Medical Record Entries
You can print a patient’s entire or partial treatment history. To print a selection of Medical Rec-

ord Entries:

l Click in the patient history area to select the Medical Record Entries you wish

to print. You can skip this step if you wish to print all MREs.

Hold the SHIFT or CONTROL key (COMMAND on Macintosh) while clicking to select

multiple MREs.

l Click the Print MRE(s) button on the Patient History window.
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l The Print MREs dialog appears.

l Click the Highlighted MREs Only radio button to print only the MREs you have

highlighted in the list.

-OR-

l Click the ALL MREs in Current View radio button to print all MREs cur-

rently listed on the patient history window.

-OR-

l Click the Every MRE for this Patient radio button to print all MREs for the

current patient, regardless of whether it is currently listed on the patient history

window.

You must save an MRE before you can print it. If the Print button on the MRE dialog is

clicked before the MRE is saved, DVMAX will prompt you to save before printing. If you select

Yes from the dialog, DVMAX will save the MRE and then print. If you click No, DVMAX will

not print the MRE(s).
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The Hide on Printed History and Hide in List settings on individual Medical Record

Entries interact with the Print MRE button in the following ways:

l If an MRE is marked as Hide in List, it will print if All MREs in Current View or

Every MRE for this Patient is chosen.

l If an MRE is marked as Hide on Printed History, it will print if the Every MRE

for this Patient option is chosen. A note stating that the MRE is excluded from

standard printed histories will be printed along with the MRE.

The Include Time on Patient History Printouts System Constant controls whether

DVMAX includes the time of the MRE in the printed report. If this setting is selected, the time

the MRE was entered will be printed. The Include Time on Patient History Printouts setting

is found in the Client and Patient Settings section of System Constants.

Patient History Text View
You can view or print the complete medical history of any patient in DVMAX. The Patient His-

tory Text View consolidates Major Problems, Diagnoses, Comments, Medical Record Entries

and General Patient Information into a printable Patient History Report.

The Suppress Blank Findings From Text View setting in System Constants determines

whether DVMAX will include any blank (unfilled) Finding Items in the text view. If this setting

is on, no empty Findings will be included. The Suppress Blank Findings From Text View set-

ting is found in the Clients and Patients section of System Constants.

To view and print the Patient History Report:

l From a patient record, click the History tab.

l Click Text View.
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l The Patient History Text View window appears, containing the Patient His-

tory Report.  Scroll up or down to review the report.

l Click Print to print the Patient History Report.

l Click Close in the Patient History Text View window to return to the History

tab.

MRE Filters can change the Medical Record Entries section of Text View. If MRE Filters

are in effect, and the Filters Apply to Text View preference is set, only those MREs that

match the current filters will appear in Text View. See the MRE Filtering chapter for more

information.

Referring Vet fax numbers are now included in a patient's printed history.

The Patient name now also appears after the Patient: block in the header.

Web Patient Reporting
The Web Patient Reporting feature allows you to make the medical histories of selected patients

available via the Internet to consulting specialists and other referral sources.

Web Patient Reporting: Setup Requirements
Before the Web Patient Reporting feature can be used, you will need to do the following:

l Select the patient histories that can be viewed via the Internet.  This is done

from the Patient History tab of each individual patient record. (See ThePublish

History to the Web Setting.)

l Create usernames and passwords for the users (referral sources) permitted to

view patient histories. (See Creating Usernames and Passwords.)
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l Give those users, authorized to access records via the web, the web address

(URL) as well as their assigned username and password.

l From the User Settings tab under System Constants, make sure the Web

Server is running (See Web History Preferences). 

l From the Clients and Patients tab under System Constants, identify the number

of days of history you want displayed (See Web History Preferences).

Publish History to the Web Setting
You have the option of making each patient history available for viewing on the Internet via the

Web Patient Reporting feature.  To make a patient history available via the web:

l From the patient record, choose the History tab.

l Select Publish History to the Web to enable this record to be viewed via the

web by authorized users.

l Click Publish History to the Web again to deselect.  If the Publish History to

the Web field is not selected, the record cannot be accessed via the Internet.

Creating Usernames and Passwords
Before you can offer access to a patient history via the web, you will need to create a username

and password for all authorized users. To create a username and password:

l From the Section drop-down menu, choose Clients and Patients.

l From the Search For menu on the Find window, choose Referral Source. 
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l Click Add New to create a new referral source record. 

-OR-

l If you want to assign a username and password to an existing referral source,

type the name of the source (or partial name) in the Last Name, First Name

field; or click All Records and select the source name from the Referral

Sources list.  This will bring up the existing record.

l If this is a new referral source record, you will need to complete the Referral

Source information area on the record window before you can assign the source

a username and password.

l In the Web Account area, create a unique Username and Password for the

Referral Source.  Usernames and Passwords must be 6-12 characters long and

may contain letters and/or numbers.

l Click OK to save the referral source record.

l Supply the referral source with their unique username and password, as well as

the web address (URL) for the Patient History site (see Viewing Patient His-

tory via the Web).

Web History Preferences
There are a few preferences under System Constants that will need to be configured to make

sure the web reporting facility functions correctly.  You will need to ensure that the web server

is running and you will need to identify the number of days of patient history you want to display.

DVMAX Practice V8.6 - User Manual



- 663 -

Starting the Web Server
In order to use the web-based features of DVMAX, the web server must be running.  To enable

the web server:

l From the Section drop-down menu, choose System Constants.

l From the User Settings tab, click Start Web Server in the Web area to start

the server and enable the web reporting function.

l Type the number of the web server port in the Web Server Port field.

l Click Set Port ID.

l From the Confirm window, select OK to test the web connection.  If the con-

nection is functioning, you will see a message confirming this.

l Select Start Web Server Automatically if you wish to have the web server

restart when the server that runs DVMAX is restarted.

l Click Stop Web Server to stop the server and disable the web functions.

If you select Start Web Server Automatically, the web server will restart automatically

when the server that runs DVMAX is restarted.  However, if you choose Stop Web Server, the

web server will not start again until you select Start Web Server.  This is true even if Start

Web Server Automatically has been selected.

Number of Days of History to Display

You will need to identify the number of days of animal history you would like displayed when

using web history.  To set the number of days:

l From the Section drop-down menu, choose System Constants.

l Select the Clients and Patient Settings tab.
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l From the Web History Preferences area, type the number of days of history you

want displayed when using the web reporting function.  For example, if you

entered 90, then the web history would display medical record entries that had

been entered in the past 90 days from the current date.

Viewing Patient History via the Web
To view patient history via the web:

l From your web browser, launch the Web Patient Reporting site using the sup-

plied web address (URL).

l Enter your username and password as assigned by the referring clinic (see Cre-

ating Usernames and Passwords).

l DVMAX will check for a referral source that matches the username and pass-

word you provide.  A list of all patients that have that referral source will be

shown.

l From the list of patient records, click on the name of the patient whose medical

history you want to view.

l The medical history of the patient will be displayed.

A user will only be able to view the patient histories for patient records in which they have

been noted as a referral source.  Check the patient record under the General Information tab to

see if a referral source has been entered.

Don’t forget, DVMAX Anywhere App for iPhone and iPad let’s you look at Appointments

and Patient History. Visit the Apple App Store to download the free app. For more information,

contact DVMAX Technical Support.

Patient Notes Tab
The Patient Notes tab consists of two areas: Major Problems and Comments. DVMAX can auto-

matically put notes in these areas.

You can add, change or delete text in either of these areas at any time.

Major Problems
As its name implies, the Major Problems field contains the most important patient history

entries. You can also use it to record other critical health-related information.
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Placement of Notes into the Major Problems Area
DVMAX can automatically place notes into the Major Problems field. The following actions

will cause DVMAX to place a note into the Major Problems field:

l If a Medical Record Code (MRC) has the “Major Problem” setting selected,

DVMAX will insert the current date, the MRC’s Description and the MRC’s

Default Note, if any, on a new line at the beginning of the Major Problems area.

DVMAX will insert the Major Problem note when the MRC is added to the

patient history, or when a Bill Item linked to the MRC is added to an invoice.

See Medical Record Codes and Bill Items for more information.

l If a Diagnosis has the “Major Problem” setting selected, DVMAX will insert

the current date, the Diagnosis, and the Diagnosis’ Default Note, if any, on a

new line at the beginning of the Major Problems area. DVMAX will insert the

Major Problem note when the Diagnosis is added to the patient history.

l If a Patient is marked as deceased or subsequently revived, DVMAX will insert

a date-stamped note about this action on a new line at the beginning of the Major

Problems area. DVMAX will insert the Major Problem note immediately after

the Patient Status change has been confirmed.

Comments
The Comments field is meant to contain notes of a more general nature than those placed in the

Major Problems field. If a note does not describe a Major Problem with the Patient’s health, it

belongs in the Comments field.
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DVMAX can automatically place notes into the Comments field. The following actions will

cause DVMAX to place a note into the Comments field:

l When a new rabies tag number is entered on the patient record, the previous tag

number, new tag number, and date the new tag was entered are placed in the

Comments field.

l When a patient’s weight is updated, the new weight and current date are noted.

Patient Weight Graph
A Patient Weight Graph is available within the Notes section of the Patient History. The Patient

Weight Graph automatically generates a graph based on Weight of over Time. The recorded

weights and date-of-change are also listed on the side of the graph.

To remove a weight from the list and graph:

l Select the weight you would like remove.

l Select the Remove Weight button.

l The selected weight will be removed from the graph and listing.

Treatment Plans Tab
Treatment Plans tab provide a list of all treatments or To Do items due or pending for a

patient.  A selected treatment plan item can be recorded as a MRE in the associated patient rec-

ord by selecting an item on the list and clicking Perform.  Completing a treatment plan item also

adds the associated bill item to an invoice.

Adding a Standard Treatment Plan to a Patient Record
To add a Standard Treatment plan to a Patient record:

l Open a Patient Record.

l Select the Treatment Plans tab.

l To choose a Standard Treatment plan, select the Select button.

l The Select a Standard Treatment Plan window will appear.

l Select one of the listed Treatment plans
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l Click Select.

l The Treatment Plan window will appear.

l Make any required changes to the Treatment plan.

l Select OK

The Treatment Plan is the added to the Treatment Plan list. Once the Treatment Plan is in the

list you are able initiate this Treatment Plan. To Perform a Treatment Plan:

l Select the Treatment Plan from the list

l Select Perform

l The Treatment plan window will appear.

l Make any edits to the treatment plan

l Select OK

Adding a New Treatment Plan to a Patient Record
To add a New Treatment plan to a Patient record:

l Open a Patient Record.

l Select the Treatment Plans tab.

l Select the Create button.

l The Create a Treatment Plan for: window will appear.

l Select the Add button.

l Create the Treatment plan including Code, Quantity, Duration, Frequency, Dura-

tion and notes.

l Select OK

The New Treatment Plan is the added to the Treatment Plan list. Once the Treatment Plan is in

the list you are able initiate this Treatment Plan. To Perform a Treatment Plan:

l Select the Treatment Plan from the list

l Select Perform

l The Treatment plan window will appear.

l Make any edits to the treatment plan

l Select OK

Create a Treatment Plan
A treatment plan can only be added or built from a patient record. To build a treatment plan:

l From a patient record, select the Treatment Plan tab. 

l Click Create to build a custom plan, or choose Select to load a saved plan.

l This opens the Treatment Plan window.
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l In the Name field, type a name for the Treatment Plan.  If you choose a saved plan, the

name of the plan will already be defined.

l From the Treatment Plan window, click Add.  This opens the individual Treatment Plan

Item detail window.

l From the Treatment Plan Item window, type an MRC in the Code field.

-OR-

l Type a partial code and press <TAB> to display an MRC lookup window, then select a

code from the list.

l In the Quantity field, type the quantity of the selected procedure to administer each time

treatment is given.  For example, type the number of tablets of a medication to be admin-

istered per treatment.   If 3 tablets are to be given at each interval, the Quantity is 3.  For

procedures such as exams, the Quantity is typically 1 per interval.

l Type the unit of measurement as it relates to the administered procedure (if applicable) in

the Units field.

If you want to use the Schedules option, click the Use Schedule checkbox.  The Interval drop-

down list will be replaced with a Schedule drop-down list, and a First Day Times field will dis-

play below the Duration field.

l Choose a start time from the Start Delay drop-down list or type a Start code.  The Start

offset value determines when the treatment plan should begin.

l Choose an interval from the Frequency drop-down list or type a Frequency (interval)

code.  This indicates how often to administer the treatment.  If you clicked the Use Sched-

ule checkbox, the Frequency drop-down list will be replaced with a Schedule drop-down

list.

l Select the duration from the Duration drop-down list or type a Duration code.  This iden-

tifies how long the treatment plan is to continue.

l If you selected the Use Schedule checkbox, a First Day Times field will be displayed

below the Duration drop-down list.  The number of available First Day Times fields will

range from 1 to 4, depending on the Schedule you selected.  For example, if you chose

BID from the Schedule list, there will be 2 First Day Times fields available and a

default time will display in the Time 1 and Time 2 fields.

The Use Schedule option allows you to chose pre-set times for repeated events, giving you

further control over scheduling delivery of treatment plan items.  Schedules can have up to 4

fixed treatment delivery times per day, depending on what you select from the Schedule drop-

down list.   First Day Times are defined as the scheduled daily delivery times for the treatment

plan item.

The # Items To Be Created field indicates the total number of  Items created by the Treatment

Plan.  This number is calculated automatically after you have entered Start, Frequency or Sched-

ule and Duration values.

l Add notes or comments where needed in the Comments field.
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l Click OK to add the item to the Treatment Plan.

l You will be returned to the Treatment Plan window.  The Treatment Plan item details

appear in the columns in the Items area.

l The Treatment Plan item summary line appears in the Treatment Plan field on the bottom

half of the Treatment Plan screen.

l If you want to add more items to the Treatment Plan, click Add to repeat the Add To Do

Item process.

The Word Processing Tab
You can use the Word Processing window to write letters and other correspondence to your

clients, utilizing templates and accessing relevant client, patient and financial information. This

section of the documentation concentrates on the Patient Word Processing Palette, which pro-

vides easy access to patient information while you are working in the word processing window

on a Patient Record.

For a complete discussion of using the Word Processor, see Word Processing.

The Patient Word Processing Palette

The Patient Word Processing Palette allows you to easily insert patient information into a doc-

ument on the Word-Processing window of a Patient Record.

Opening the Patient Word Processing Palette
To open the Patient Word Processing Palette at any time while working on a Patient Word Proc-

essing window:

l Click the Show Palette button in the lower left of the WP window.
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Closing the Patient Word Processing Palette
To close the Patient Word Processing Palette at any time while working on a Patient Word Proc-

essing window:

l Click the Close field (‘x’) in the upper right corner of the Palette.

l - OR -
l Click the Hide Palette button in the lower left of the WP window.

DVMAX Practice V8.6 - User Manual



- 671 -

Using the Patient Word Processing Palette
To use the Patient Word Processing Palette, simply click an information field on the palette, then

click Insert at the bottom of the palette. DVMAX will place the selected information into the

word processing document at the current cursor position. Double-clicking a field name in the Pal-

ette is a shortcut for inserting that field.

Holding down the Shift key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

The Patient Word Processing Palette is broken down into 10 main “groups” of references:

1. Patient Fields insert information from the client record onto a document.

2. Patient Rabies Items inserts information about the client’s patients onto a document.

3. Client Merge Fields inserts pronouns and other special items related to patient infor-

mation onto a document.

4. Patient History Fields insert information about the referral source for this client.

5. Patient Log Fields insert the Client or practice address onto a document.

6. Patient Referral #1 Fields

7. Patient Referral #2 Fields

8. Patient Pronouns
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9. Address Blocks

10. Patient Reminder Names

Adding information through the WP Palette creates a reference to that field from the cur-

rent client record, as opposed to copying that information from the current client record.  This

means that if you insert the client’s “name” onto the document, then that document can display

the name of whichever client record you are viewing at the time you load the document.

Client Merge Fields
Inserting any of the Client Merge Fields will place that information from the client record into

the document.

Client Patient Info
Client Patient Info references allow you to insert information a group of patients belonging to

this client.

These references can deal only with groups of a client’s patients. To write about an individ-

ual patient, use the Word Processing Palette on the Patient Word Processing window.
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Patients List: Inserts a list of all living patients that belong to this client.  DVMAX separates

this list by commas if there are more than 2 patients and by “and” if there are only 2 patients. 

Single patients are listed alone. This makes it easy to write a sentence like “We welcome

Fluffy, Suzie, and Munch to our practice!”

Canines List: Similar to the Patients list command except that it inserts living canines only.

DVMAX identifies which patients are canines by comparing their species code to that specified

for canines in System Constants - Client & Patient settings.

Felines List: Similar to the Patients list command except that it inserts living felines only.

DVMAX identifies which patients are felines by comparing their species code to that specified

for felines in System Constants - Client & Patient settings.

Patient & Reminders Block: Inserts a block of text listing all patients due for reminders as

well as the procedures for which they are due.  The system determines which patients are due

based on the criteria of your most recent search for reminders.

The block will show the patient names on the left, and then include a list of reminders for which

they are due to the right.  This list of reminders is built from the “short note” field in the

Reminder Type record. The block will include all patients that are due, and is very useful if you

send reminder letters to your clients to inform them when their animals are due for their vac-

cines, etc.  It is not recommend for use on reminder cards because it may easily exceed the size

of a single card.

See Reminders for more information.

Patient & Reminders #1 through #5: These commands insert a single line, one for each patient

belonging to this client that is due for reminders. Each line is constructed in the same fashion as

the Patient & Reminders block, with the patient name on the left, and the list of reminders

slightly to the right.

Using the separate lines it is possible to build a compact document for printing onto a postcard. 

This makes it possible to send a single reminder card which refers to multiple patients to a

client.

Client Patient Extras
Client Patient Extras words your document so that it reads correctly regardless of how many

patients you are addressing.
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To use these commands, locate the type of “extra” you want to add (Pluralize, is or are, they

or he-she, their or his-her, them or him-her).  Then select the “group” of patients on which

DVMAX will base the “extra” (All Patients, Canines, Felines, Reminders).

For example, if you were writing to welcome a new client to your practice, you might write:

“We want to welcome your pet to our practice!”  But this would only be correct if the client has

only one pet.  If they have several animals, you would have to write: “We want to welcome your

pets to our practice!“ 

Pluralize: will add an “s” wherever it is inserted if the referred group has more than one

patient.  Thus “We welcome your pet to our practice” can automatically become “We welcome

your pets to our practice”.

Is or are: provides the right form of “is” or “are” depending on how many animals you are refer-

ring to.  For example: “Your pet is going to feel right at home in our practice” can automatically

become “Your pets are going to feel right at home in our practice”.

They or he-she: provides the right pronoun for the number of animals you are referring to.  For

example: “We know that he will feel comfortable with our staff“ can become “We know that

they will feel comfortable with our staff”.  In the case of just one animal, DVMAX will auto-

matically select the appropriate pronoun (he or she) based on the sex of the animal.

Their or his-her: provides the right possessive pronoun depending on the number of animals you

are referring to.  For example: “We will write again when his vaccines are due” can auto-

matically become “We will write again when their vaccines are due”.  DVMAX will auto-

matically select the appropriate pronoun (he or she) based on the sex of the animal.

Them or him-her: provides the right pronoun depending on the number of animals.  For exam-

ple: “We know you love him, so be sure to come back for your free follow-up exam” can

become “We know you love them, so be sure to come back for your free follow-up exams”.

Patient Referral Fields
Patient Referral Fields allow you to insert information from the Client referral source onto a

letter or other document. The fields are self-explanatory.
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Client Address Lines
Client Address Lines allow you to insert the client’s address onto a letter or other document

easily.

Using this menu you can also insert the Practice name, address, and telephone number. This is

useful since it will change automatically if the practice should move to a new location.

Below is a list of the other commands and their functions:

Address Block: inserts the complete client address as a single block.

Address, Line 1-4: inserts the client‘s address line-by-line. Using these separate lines makes it

possible to include text to the right of the address if this is required.

POSTNET Code: calculates and inserts a US Postal Service POSTNET delivery code to aid in

delivery of your letter. In order to use this feature you must have a printable POSTNET Bar

Code Font installed on your computer. The POSTNETcode must be printed using this font and in

an appropriate location on your document so it can be read by the Postal Service.

Practice Name: inserts the practice name onto your document.  The practice name is taken from

System Constants.

Practice Address, line 1 (etc.): inserts the lines of the practice address into your document. 

The address lines are taken from System Constants.
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Practice telephone: inserts the practice telephone number into your document.  The practice tel-

ephone is taken from System Constants.

Patient Hospitalization Status
If a patient is currently in hospital, this can be reflected in the Status area of the patient record,

along with a reason for hospitalization.

You can view or edit the reason for hospitalization, as well as change hospitalization status from

the patient record.  A list of all patients’ records marked as In Hospital can be generated using

the Find facility accessed from Clients and Patients on the Section drop-down menu (see Gen-

erating a List of Patients “In Hospital”) or clicking the Patients icon.

Mark a Patient as “In Hospital”
To indicate that a patient is in hospital:

l From the General Information tab of the patient record, select In Hospital from

the Status drop-down list.
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l From the Reason window, type a reason for hospitalization if needed.  Note that

a reason is not required in order to mark the patient as In Hospital.

l Click OK.

l If the Prompt for Boarding for ‘In Hospital’ Patients is selected under Board-

ing Setup, DVMAX will open the Boarding Scheduler when you mark a Patient

as In Hospital. In the bottom right corner of the Boarding Scheduler, you will

see a note that indicates that the next Boarding appointment created will be for

the patient you have just marked as “In Hospital”.

l The Prompt for Boarding for ‘In Hospital’ Patients setting can be found

under the Boarding Setup of the Boarding scheduler.

View or Edit the Reason for Hospitalization
To view or edit the reason for hospitalization:

l From the General Information tab of the patient record, click Reason.

l Edit or enter the reason for hospitalization in the dialog that appears.

l Click OK to save your changes.

Generating a List of Patients “In Hospital”
You can use DVMAX’s Find facility to generate a list of all patients marked as being In Hos-

pital.  To build a list of all patients with status In Hospital:

l From the Section drop-down menu, select Clients and Patients.
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l The Find window appears. From the Find window, select Patients from the

Search For menu.

-OR-

l Click Patients on the Command Palette.

l From the By drop-down menu, select Patient Status.
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l By default, the Patient Status field reads In Hospital.   Use this default status

to search for all patients with status marked In Hospital.

l Click Search. A list of all hospitalized patients appears

l To view a record from the list, select a record and click Show or double click on

a record.

Remember that in order for a patient record to be included in this list, the patient must be

marked as In Hospital.

Create a Patient Appointment
To create an appointment from a patient record, select Set Appointment from the Patient drop-

down menu. See the Appointments chapter in this User Guide details on creating, editing and

working with Client and Patient appointments.

If you create an appointment from a new patient record before you have saved the record,

DVMAX will automatically save the patient record when you select Set Appointment.

Patient Visit History
The Visits button in the General Info section of the Patient record lets you view patient appoint-

ment details, including Visit Reason and any status changes (as tracked from the appointment

using Check In and Status drop-down menus).

The top section of the Visits dialog shows Visits (current/active and past visits), and indicates

whether a visit is active or not.
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l If the Visit Active checkbox is selected (checked), then the visit is active.

l Click the Visit Active checkbox to deselect and close a patient visit. When you

close the Visits dialog, DVMAX will ask to confirm that you want to close the

visits you deselect. Those visits will remain in the visit history, but will be

marked as inactive.

l The lower portion of the Visit history dialog shows visit Events, or status

changes, over a selected visit. These Events are selected from an appointment

record. For example, a patient may be marked as being in the Waiting Room,

then an Exam Room, then a Treatment Room. In this way, you can see the

approximate amount of time a patient spent in the clinic and where they spent

their visit.

Create a Boarding Appointment
To schedule a boarding appointment from a patient record, select Set/Find Boarding from the

Patient drop-down menu. See the Boarding chapter in this User Guide details on creating, edit-

ing and working with the Boarding scheduler.
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Pay Methods
A Pay Method is a form of payment accepted by your practice, such as cash, check, Debit, Visa

or MasterCard.

Pay Methods in DVMAX allow you to keep track of how your clients are paying invoices or

other transactions. Settings in individual Pay Methods determine the default notes DVMAX

shows when recording payments on invoices, whether to print a deposit slip for the payment type

as part of the End of Day report, and whether this Payment Method appears as an option on the

tear-off sheet printed on statements for Equine customers.

Pay Methods and Integrated Credit Card Processing

To enable payment processing using the integrated credit card processing functionality,

DVMAX needs to create 2 specially named pay methods, one for credit card and one for debit

card payments.  These methods will have the abbreviations cCard and Debit, respectively, and

are created during the Payment Terminal setup process (Step 7 of 8).  These pay method code

names are automatically reserved by DVMAX for this purpose, and cannot be in use elsewhere

in your DVMAX database.  If they are, those existing codes will have to be renamed when you

run the Payment Terminal Setup Wizard.  See the Integrated Credit Card and Debit Card

Processing chapter for further information.

Search For a Pay Method
To locate a Pay Method record in DVMAX:

l Choose Inventory Management from the Section menu.

l From the Find Window choose Pay Methods from the Search By drop-down

list.
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l Choose Pay Methods from the Search By drop-down list.

l Choose a criterion from the By drop down list.

l To search existing Pay Methods by code or abbreviation, choose Pay Method

Code. To search for a word in the complete name of the Pay Method, choose

Keyword in Description.

l Click Search.

l If there is more than one match for your search, the Payment Method List win-

dow will appear, containing a list of items that matched your search.
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l If there is only one Payment Record that matches your criteria, DVMAX will

open that Payment Record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

You can also quickly locate a Pay Method by following the steps in List All Pay Methods

and double-clicking the one you are interested in from the list.

List All Pay Methods
To list all Pay Methods available in DVMAX:

l Choose Inventory Management from the Section menu.

l From the Find Window choose Pay Methods from the Search By drop-down

list.
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l Choose Pay Methods from the Search By drop-down list.

l Click All Records at the bottom of the Find Window. A list of all available

Pay Methods appears.

l Each Pay Method is listed on an individual line, with columns for code and

description.

Creating a New Pay Method
To enable DVMAX to accept a new form of payment:

l Choose Inventory Management from the Section menu.

l From the Find Window choose Pay Methods from the Search By drop-down

list.
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l Click Add New. A blank Pay Method window opens.

l Type a unique code for this Pay Method in the Pay Method Abbr field. This is

the code you will use when accepting payments of this type. The code can be up

to 6 characters long.

l Type a description of this Pay Method into the Description field. This is typ-

ically the full name of the Pay Method, and can be up to 20 characters long.

l Type a word or phrase that will prompt further information about this Pay

Method into the Prompt field. For example, if the Pay Method is “check”, the

Prompt would be “Check Number”. What you type here will appear in the Pay

Note field on an invoice and the Deposit Note field on an Estimate when this

Pay Method is chosen.

l Click the Yes radio button beside Print Deposit Slip if you want a deposit slip

for this Pay Method printed along with the End of Day Report. Click the No

radio button if you do not.

l Click the Yes radio button beside Print on Statement Tear-Off Form if you

want this Pay Method printed as an option on the tear-off sheet printed on state-

ments for Equine customers.

l Click OK to save the Pay Method.
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Delete a Pay Method

DVMAX does not recommend deleting a Pay Method

To delete a single Pay Method from DVMAX:

l Find and open the Pay Method you wish to delete. See Search for a Pay Method

Record.

l Click the Delete.

l DVMAX will ask you to confirm that you want to delete the Pay Method.

l Click Delete.

To delete multiple Pay Methods from DVMAX:

l List all Pay Methods (see List All Pay Methods).

l Click to select the Pay Methods you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Pay Methods from the list. Press

and hold the CONTROL key to select multiple non-adjacent Pay Methods.

l Choose Delete Records from the Pay Methods menu.

l DVMAX will ask you to confirm that you want to delete the Pay Methods.

l Click Delete.

DVMAX Practice V8.6 - User Manual



- 687 -

Pending Items
The Pending Items icon on the Command Palette allows you to see the status of all patients and

next tasks in your hospital or practice. You can quickly get a list of, and see details of:

l All patients whose status is “In Hospital”

l All appointments scheduled for yesterday, today, and tomorrow

l All Treatment Plan To Do Items due today or tomorrow, or overdue for admin-

istration (and, optionally, those that have been completed)

An Overview of the Pending Items List
Each pending item in your practice is listed on an individual line in the Pending Items list.

l For each In-Hospital Patient, DVMAX lists the patient’s name, the client’s

name, and the reason why the patient is In Hospital.

l For each scheduled appointment, DVMAX lists the time of the appointment

(using the 24-hour clock or military time), the patient and client scheduled

for the appointment, and the client’s home phone number.

l For each Treatment Plan To Do Item, DVMAX lists the time the item is due

(using the 24-hour clock or military time), the patient and client affected by

the item, and the title of the Treatment Plan Item.

About Times in the Pending Items List
A minus sign (-) in front of a listed time means that the item is overdue or occurred in the past.

The time indicates the time yesterday.

A plus sign (+) in front of a listed time means that the item is scheduled for tomorrow. The time

indicates the time tomorrow this item is due or scheduled.

If there is no sign in front of a listed item, the item is due or scheduled today. The time indicates

the time today this item is due or scheduled.
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Viewing the List of Pending Items
To view the list of Pending Items:

l Click the Pending icon on the Command Palette.

l The Command Palette expands to show a list of pending items in your practice.

By default, DVMAX shows all pending items, excluding Completed Items.

If you have filtered the list of pending items (see Filtering the List of Pending Items),

DVMAX will remember your choices from the last time you viewed pending items.

l You can view details or take action (where applicable) on any pending item by

double-clicking it.

l If necessary, use the scrollbar to the right of the Pending Items list to scroll

through the list.

l To close the Pending items drop down list, click another Command Palette icon.

Filtering the List of Pending Items
You can narrow the list of Pending Items to see only those types you are interested in. DVMAX

will remember your choices and show you only the items you choose until you make other

choices.

To filter the list of Pending Items:

l Click to select or deselect any combination of the checkboxes at the bottom of

the Pending Items list.

For example, to see only Appointments, select the Appts checkbox, and deselect In Hospital

and Treatments.  By default, all Pending item types are selected.
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The Hide Completed Checkbox
The Hide Completed checkbox applies only to Treatments listed in the Pending Items list.

Selecting the Hide Completed checkbox will remove from view any Treatment Plan items that

have been “done” or marked as completed. Deselecting the checkbox will show all pending

Treatment Plan Items regardless of their completion status.

In Hospital and Appointment Pending Items are unaffected by this checkbox.
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Prescriptions
DVMAX’s Prescription Labeling feature lets you write prescriptions and create prescription

labels in a few quick steps.  As well, DVMAX keeps a list of all prescriptions for which refills

are available, and makes it easy to select and print labels for existing prescriptions.

Write a New Prescription
You can write new prescriptions and create prescription labels from a patient or client record. 

To refill an existing prescription, see Prescription Refills.

To write a new prescription:

l Choose Prescription Label from the Patient drop-down menu.

-OR-

l When in a patient record, choose Print Rx from the History tab.

l A Prescription Labeling window opens.  You can write a new prescription, set

the number of refills and print a prescription label from this window.

l Select a prescription item from the items list.

The fact that an item appears on this list does not mean it is available in inventory, only that

it is an item for which an inventory record exists.   See Prescription Items and Inventory Man-

agement.

l In the Expiration Date field, type the product expiration date if required.
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l The Lot Number and Rx Number are provided by DVMAX as applicable.

l Type the quantity of the prescription item, such as number of tablets, in the Qty

field.  The Unit is provided automatically, based on your bill item setup.

l Type the number of refills in the Refills field.  The default value is 0.

l Type the refill expiration date in the Refill Expiry Date field where needed.

l Modify the directions in the Dir field if needed.  The default directions are set

under Inventory Management.

l Type the date of the prescription in the Date field. The current date is provided

by default.

l In the Copies field, type the number of copies of the prescription label you

would like printed.  The default value is 1.

l If applicable, select the patient for which the prescription is intended from the

Patient drop-down list.

Only patients associated with the Client shown will be listed under the Patient drop-down

list.

l From the Doctor drop-down list, select the prescribing doctor.

l Click OK & Print to print the label.

-OR-

l Click OK to save the label without printing.
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Using Mnemonics in Prescription Labeling Directions
DVMAX allows you to use mnemonics when adding directions into a prescription-labeling field.

To use mnemonics to search for prescription labeling instructions:

l Search for the Patient.

l Create an invoice for this Patient containing a relevant prescription item.

-OR-

l Add a prescription-related MRE from the History tab.

l The Prescription Labeling dialog will open.

l In the Directions field type a known mnemonic, such as TID and press <Tab>.

l A pick-list of RX Directions will open containing the mnemonic you typed.

l Select the appropriate directions.
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l Select OK.

l The directions will now be inserted into the Directions field.

Creating a New Prescription (Rx) Directions Record
To create a new Prescription (Rx) Directions record:

l Select Inventory Management from the Section drop-down menu.

l From the Search For menu, choose Rx Directions.

l Select Add New.

l A new Rx Directions record window opens.

l Add the new Direction Code (a brief mnemonic to use for these directions),

Description, and Rx Directions (as they will display on the Rx label) in the

appropriate fields.

l Select OK to save the new Rx Directions record.

Prescription Refills
The Refill Rx feature allows you to quickly prepare prescription details and produce a label for

a refill.  This feature is accessed through a patient record. The Refill Rx feature is only avail-

able to a patient with at least one existing prescription for which refills are available.  To create

a new prescription, see Write a New Prescription.

To refill a prescription:

l From a patient record, click Refill Rx.  This button will only be available if

there is an existing refill.

l From the Prescription List, select the prescription item you want to refill.  This

list contains all of the prescriptions for the current patient for which refills are
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available.

l Click Refill.

l The Prescription Labeling window opens. The prescription item you selected

will be highlighted in the item list area. 

l Update or confirm prescription details and print a prescription label as required.

The process is very similar to writing a new prescription.

You cannot select a different item on the list when refilling a prescription.  To write a new

prescription, see Write a New Prescription.

l Type the product expiration date if required.

l The Lot Number and Rx Number are provided by the system as applicable.

l Type the quantity of the prescription item, such as number of tablets, in the Qty

field, if different from the default value.

l Type the refill expiration date in the Refill Expiry Date field (MM/DD/YYYY)

where needed.

l The number of refills is indicated in the Refills field.  This value cannot be

altered here, as it was established by the original prescription.  It will be auto-

matically adjusted each time a refill is issued.

l Modify the directions in the Dir field if needed. The label will indicate the orig-

inal number of refills and the number remaining, where applicable.

l Type the date of the refill in the Date field.  The current date is provided by

default.

l In the Copies field, type the number of copies of the prescription label you

would like printed.  The default value is 1.
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l The name shown in the Patient field is the one for whom the refill is issued.  No

other selection can be made.

l From the Doctor drop-down list, select the prescribing doctor.

l Click OK & Print to print the label.

-OR-

l Click OK to save the label without printing.

Dismissing Prescription Refills
If you have prescribed the wrong medication, or have otherwise supplied incorrect information

while writing a prescription (e.g. doctor, patient, directions), you can dismiss or delete the

remaining refills, so that the invalid prescription cannot be refilled.

To dismiss a prescription refill:

l From a patient record, click Refill Rx. This button will only be available if there

is an existing refill.

l From the Prescription List dialog, click the prescription you would like to dis-

miss.

l Click Dismiss Refill at the bottom of the Prescription List.
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Prescription Items and Inventory Management
Prescription items can be added, deleted or modified from the Inventory Management area of

DVMAX.

l To modify, view, add or delete an inventory item, select Inventory Man-

agement from the Section drop-down menu; then choose Inventory Item from

the Find window.  Refer to the chapter on Inventory Management for more infor-

mation.

Ignore Prescription Lot Information
There is an option on the Invoice Settings tab under System Constants that allows you to ignore

prescription lot information for prescription labeling. If Ignore Rx Info for Prescription Label-

ing is selected, the system will use whatever lot information is on hand, or proceed with the pre-

scription labeling even if there is not enough in the existing lots to fill the current prescription or

refill.

To ignore prescription lot information for prescription labeling:

l From the Section drop-down menu, choose System Constants.

l Select the Invoice Settings tab from the System Constants window.

l Click Ignore Rx Info for Prescription Labeling.

l Click again to deselect.

l As with any changes to the Systems Constants settings, all workstations must

restart in order for any changes to take effect.
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Purchases
DVMAX uses Purchase records to document the purchase or order of Inventory Items. Purchase

records can record the receipt of actual purchased items by your practice (Inventory Purchases),

or can document the ordering of Inventory with Purchase Orders.

The price recorded for an Inventory Item on a Purchase record can update the Inventory cost and

the sale price of that Item.

Inventory adjustments are documented with Purchase records, reflecting losses or miscounts. Pur-

chase records also track internal consumption of Inventory Items by your practice.

In order to successfully create a Purchase record, you must have already defined a Vendor rec-

ord for the vendor you are purchasing from, and an Inventory Item record for the Inventory Item

you are purchasing. See Vendors and Inventory for related information.

Purchase Processing
Purchasing inventory items through a Purchase record has the following effects in DVMAX:

l The Quantity on Hand field of the Inventory Item record is updated to reflect

the quantity purchased. Purchases from standard vendors are always measured

in “purchasing units” for these calculations.

l DVMAX will update the Last Cost of an Inventory Item if the cost on a Pur-

chase record is higher than the existing Last Cost for that Inventory Item.

Lower costs on a Purchase record will not update Last Cost. See Inventory for

more information.

l If the Inventory Item’s Last Cost has changed because of this Purchase,

DVMAX will recalculate the sale price of any Bill Items that use this cost for

their pricing calculations and which are set to update inventory prices auto-

matically. See Bill Items for more information.

Exceptions to these effects arise when you use the Adjustment or Hospital Vendors on a Pur-

chase record. See Correcting a Purchase Record, Making Inventory Adjustments, and

Recording Hospital Use of Inventory.

Purchase Order Processing
A Purchase Order has the following effects in DVMAX:

l Each Inventory Item on the Purchase record is marked as “On Order”.

l The order quantity and cost is recorded for each Inventory Item. This infor-

mation will be used when the actual Purchase is received and the Purchase

Order is converted. See Converting a Purchase Order.

Only standard vendors (i.e. not the “Adjustment” or “Hospital” vendor) can be used for a

Purchase Order entry.
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An Overview of the Purchase Record

A Purchase record in DVMAX contains the Purchase or Purchase Order number in the title of

the window. The Purchase record screen is divided into three areas: the Vendor/Handling area,

which contains information about the vendor and whether this purchase is a Purchase Order or

not; the Line Items area, which lists the actual items purchased; and an area containing com-

ments about this purchase and financial information.

Listing all Purchases
To list all Purchases in DVMAX:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, choose Purchases from the Search For drop-down

menu.
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l Click All Records at the bottom of the Find window.

l The Purchases List appears, containing all recorded Purchases in

DVMAX.

The Purchases List
The Purchases list displays one Purchase record per line. There are columns for Purchase

Number, PO, Date, Purchase Total, Freight, and Vendor Name. (See An Overview of the Pur-

chase Record for more detail). 

Opening a Record from the Purchases List

To open a purchase record from the Purchases list that displays following a search of purchase

records:

l From the Purchases list, double click a selected purchase to view the record.
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Search from the Purchases List

l Click Search to run a new Purchase or other Inventory Management

search.

-OR-

l Choose Search from the Purchases drop-down menu.

l The Find dialog opens. See the section titled Search For Purchase Rec-

ords for more detail.

Creating a New Purchase from the Purchase List

l Click Add New of the Purchase List

-OR-

l Choose Add New from the Purchases drop-down menu.

l A new Purchase record window opens. See Recording a Purchase by Cre-

ating a New Purchase Record for more information.

Show a Subset of Records
l Click Show to display a subset of selected records.

Exclude a Subset of Records
l Click Exclude to hide a group of selected records.

Converting a Purchase Order from the Purchases List
The Purchases List allows you to convert one or more Purchase Orders to regular purchases.

You would do this when the inventory ordered arrives at your practice.

When a Purchase Order is converted to a purchase, DVMAX will update the Inventory Item

being purchased so that it is no longer marked as On Order. See Inventory Items for more

information.

To convert a Purchase Order on the Purchase List to a regular Purchase:

l Click to select the Purchase Order you wish to convert.

Purchase Orders are marked in the PO column of the Purchases List.

l Click the Convert PO button.

l DVMAX will duplicate the selected Purchase and open the copy. The Reg-

ular Purchase radio button will be selected on the copy.

DVMAX Practice V8.6 - User Manual



- 701 -

l Click OK to save the converted Purchase Order.

You can also convert a Purchase Order from an open Purchase Record. See Converting a Pur-

chase Order for more information.

DVMAX actually duplicates the Purchase record containing the Purchase Order, rather

than modifying the Purchase Order itself. This leaves you with a record of the original Purchase

Order, and also provides you the opportunity to record partial shipments of items in a Purchase

Order.

Searching for Purchase Records
To find a Purchase Record in DVMAX:

l Select Inventory Management from the Section drop-down menu.

l From the Find window, select Purchases from the Search For drop-down

list.

l Click to select a criterion from the By drop-down list. See Purchase Search

Criteria for information on possible choices.

l Type a Purchase Number, Vendor Code, or Vendor Invoice Number in the

box below the By drop-down list.

l Click Search.

l If there is more than one match for your search, the Purchase List window

will appear, containing a list of items that matched your search.
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l If there is only one Purchase that matches your criteria, that Purchase Rec-

ord will open.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.
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Purchase Record Search Criteria
DVMAX lets you search for purchase records by Purchase Number, Vendor Code, and Vendor

Invoice Number.

l Choose Purchase Number from the By drop-down list to search for Pur-

chases by the number DVMAX has assigned them.

-OR-

l Choose Vendor Code from the By drop-down list to find Purchases made

from a specific Vendor.

-OR-

l Choose Vendor Invoice Number if you have the Invoice number for the

Purchase at hand.

Create a New Purchase Record
You record a purchase or purchase order in DVMAX by creating a Purchase record. You can

record more than one actual purchase or purchase order on a Purchase record. You cannot rec-

ord a purchase order and an actual purchase on the same Purchase record. To create a new Pur-

chase record:

l Choose Inventory Management from the Section drop-down menu.
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l From the Find window, choose Purchases from the Search For drop-down

list.

l Click Add New.

l A new Purchase Record appears. The title of this Purchase Record contains

the sequential ID of this purchase as assigned by DVMAX.

DVMAX Practice V8.6 - User Manual



- 705 -

You can also create a new Purchase Record by clicking the Add New button at the bottom

of the Purchases List. See The Purchases List for more information.

l Type an existing Vendor Code into the Vendor Code field. See Vendors

for more information on Vendor Codes.

If do not know or cannot remember an exact Vendor Code, type the first letter into the Ven-

dor Code field and press TAB. This will bring up the Select Vendor Code window listing all of

existing vendor codes.

l If necessary, type a date other than the current date into the Date field.

l Type the vendor’s invoice number to your practice for this purchase into the

Vendor’s Invoice Num field.

l Click to select the Purchase Order radio button if you are recording the

ordering of a product.

-OR-

l Leave the Regular Purchase radio button selected if you are recording the

actual receipt of a product.

If you select Purchase Order, any Inventory Items listed on the line items of this Purchase

Record will be marked as On Order on their respective Inventory Item records. See Inventory

Items for more information.

Only standard vendors (i.e. not the “Adjustment” or “Hospital” vendor) can be used on a

Purchase Order entry.

l Complete a line item for each item purchased. For each item purchased,

type the Quantity and Item Code. DVMAX will automatically complete

the Item Cost, Item Total, and Tx fields. See Purchase Record Line Items

for more information.

The <Enter> key is NOT a synonym for the <Tab> key, or the <Return> key. 4D has a

built-in feature where the <Enter> key is used for one specific purpose - accepting a record

that's being displayed in an input form. The <Enter> key is like clicking Save or OK on a form.

Because this is a built-in feature of 4D, using the Enter key in the wrong context (as in, when

entering a partial code in a line item) can cause odd results. If you want to move from field to

field - use the <Tab> key.

l Type any comments about the purchases recorded on this Purchase record

into the Comments field. For instance, items may have been received dam-

aged or incomplete.
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l Type any freight, shipping, handling or delivery costs into the Freight &

Shipping field.

l If you wish to print this Purchase record when you complete it, leave the

Print checkbox selected.

-OR-

l If you do not wish to print this Purchase record when you complete it, click

to deselect the Print checkbox.

l Click OK to save the Purchase Record. If the Print checkbox is selected,

DVMAX will also print the Purchase.

Purchase Record Line Items
Each distinct type of item on a Purchase record occupies a single line in the Line Items area of

the Purchase record screen. For example, if you are purchasing two cases of dog food and one

case of cat food, your Purchase record will have two line items: one for the dog food and one for

the cat food.

To complete a Line Item on a Purchase Record:

l Type the quantity of the item you are purchasing into the Qty box.

l Type the Inventory Item Code of the item you are purchasing into the Item

Code box.

If do not know or cannot remember an exact Item Code, type the first letter into the Item

Code field and press TAB. This will bring up a window listing all existing codes.

l If necessary, replace the Item Cost with the per-unit cost of the item (i.e.

how much you paid for each quantity of the item).

DVMAX automatically places the Last Cost of an Inventory Item into the Item Cost field.

See Inventory Items for more information.

Adding a Purchase Record Line Item
To add a line item to a Purchase record:

l Click Add Line below the line items area.
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Deleting a Purchase Record Line Item
To delete a line item from a Purchase record:

l Click in the Qty or Description field of the line you wish to delete.

l Click Delete Line below the line items area.

The Pharmacy Item Lot Entry Dialog
When you add a prescription Inventory Item to a Purchase record, DVMAX will present you

with a Pharmacy Item Lot Entry dialog.

To complete the Pharmacy Item Lot Entry dialog:

l Type the Lot Number and Expiry Date of the prescription item into the appro-

priate fields.

l Click OK to save the Lot Number and Expiry Date information.

-OR-

l Click No Entry to dismiss the dialog without saving the Lot Number and

Expiry Date information.

See Inventory Items for more information on Item Lots.

Viewing Comments from a Line Item
To view the comments from Inventory Item listed on a Purchase record line item:

l Click in the Item Code field of the item whose comments you wish to view.

l Click View Comments.

DVMAX will display the comments from the selected Inventory Item record in a dialog. For

more information on Inventory Item comments, see Inventory.

Converting a Purchase Order
You can convert a purchase order to a regular purchase when the inventory you have ordered

arrives at your practice.

When a Purchase Order is converted to a purchase, DVMAX will update the Inventory Item

being purchased so that it is no longer marked as On Order. See Inventory Items for more

information.

To convert a Purchase Order to a regular Purchase:

l Locate and open the Purchase Record you wish to convert. See Searching

for and Finding Purchase Records.
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l Click Convert PO.

l Click OK to close the Purchase record.

You can also convert Purchase Orders from the Purchases List. See The Purchases List for

more information.

Converting a PO to a purchase will request Rx Lot information , where applicable.

DVMAX actually duplicates the Purchase record containing the Purchase Order, rather

than modifying the Purchase Order itself. This leaves you with a record of the original Purchase

Order, and also provides you the opportunity to record partial shipments of items in a Purchase

Order.

Recording Partial Receipt of a Purchase Order
If an item you have ordered is on backorder, or if you receive partial shipment of an order for

any other reason (for example, damaged goods that need to be returned or an incomplete ship-

ment), you may record partial receipt of that order on a Purchase record by converting the Pur-

chase Order and deleting the line items that were not actually received.

To record partial receipt of items on a Purchase Order:

l Locate and open the Purchase Order you wish to convert. See Searching

For and Finding a Purchase Order.

l Click Convert PO.

-OR-

l List all Purchase Orders (see Listing All Purchase Orders).

l Click to select the Purchase Order you wish to convert from the Purchase

List.

Purchase Orders are marked in the PO column of the Purchases List.

l Click Convert PO.

l At this point, DVMAX will duplicate the selected Purchase and open the

copy. The Regular Purchase radio button will be selected on the copy.

l Click in the Qty or Description field of the line you wish to remove from

the Purchase Order.

l Click Delete Line.

l Click OK to save the converted Purchase Order.

DVMAX Practice V8.6 - User Manual



- 709 -

The Purchases List will now contain the Purchase record containing the original Purchase Order

as well as the Purchase Record documenting the partial receipt of the order.

When your practice receives the remainder of the order, you may convert the original Purchase

Order again, this time deleting the line items that were received previously.

Purchase Reports
You can print various reports on purchases your Practice has made. In the case of the Freight

and Shipping report, you can also export report results to a spreadsheet-compatible text file.

See the sections The Purchase List Report, The Full Purchase Report, and Freight and

Shipping Reports for information on each kind of Purchase Report DVMAX can generate.

The Purchase List Report
The Purchase List Report prints a list of selected purchases. For each purchase in the list,

DVMAX shows the purchase number, date, purchase total, freight charges and vendor.

To generate a Purchase List Report:

l Find all the Purchases you wish to include in the report. See Search for Pur-

chase Records.

-OR-

l List all Purchases (see Listing All Purchases) and click to select the Pur-

chases you wish to include in the report from the Purchases list.

Press and hold the SHIFT key while clicking to select multiple adjacent Purchases from the

list. Press and hold the CONTROL key (COMMAND on Macintosh) to select multiple non-adja-

cent Purchases.

l Choose Print from the File drop-down menu.

l The Printing Options dialog opens.

DVMAX Practice V8.6 - User Manual



- 710 -

l Click to select List from the Select a Report list.

l Click to select the Page Setup checkbox if you wish to display your oper-

ating system’s Print or Page Setup dialog to specify print options before print-

ing the report.

l Click to select the Sort Selection checkbox if you wish to display the

Order By dialog to sort the list of Purchases on the report before printing.

l Click Print.

l DVMAX will print the Purchase List Report.

The Full Purchase Report
The Full Purchase Report prints a report showing full details for each selected purchase. For

each selected Purchase record, DVMAX shows the date, the type of purchase (Purchase Order

or Inventory Purchase), purchase record number, vendor, vendor invoice number, quantity, item

code and description, item cost and total, tax, freight and shipping charges, and a grand total for

the purchase.

To generate a Full Purchase Report:

l Find all the Purchases you wish to include in the report. See Searching for

and Finding Purchases.

-OR-

l List all Purchases (see Listing All Purchases) and click to select the Pur-

chases you wish to include in the report from the Purchases list.

Press and hold the SHIFT key while clicking to select multiple adjacent Purchases from the

list. Press and hold the CONTROL key (COMMAND on Macintosh) to select multiple non-adja-

cent Purchases.

l Choose Print from the File drop-down menu.

l The Printing Options dialog opens.
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l Select Full from the Select a Report list.

l Select the Page Setup checkbox if you wish to display your operating sys-

tem’s Print or Page Setup dialog to specify print options before printing the

report.

l Select the Sort Selection checkbox if you wish to display the Order By

dialog to sort the list of Purchases on the report before printing.

l Click Print.

DVMAX will print the Full Purchase Report.

Freight & Shipping Reports
Freight and shipping Purchase reports allow you to see how much your practice has paid on

freight and shipping for selected purchases. DVMAX provides three varieties of Freight and

Shipping report: Purchase Details, Vendor Totals, and Report Total Only.

You can also choose to export each type of Freight and Shipping report to an Excel-compatible

text file.

To generate a Freight and Shipping Purchase report:

l Find all the Purchases you wish to include in the report. See Searching for

and Finding Purchases.

-OR-

l List all Purchases (see Listing All Purchases) and click to select the Pur-

chases you wish to include in the report from the Purchases list.

Press and hold the SHIFT key while clicking to select multiple adjacent Purchases from the

list. Press and hold the CONTROL key (COMMAND on Macintosh) to select multiple non-adja-

cent Purchases.

l Choose Print from the File drop-down menu.

l The Printing Options dialog displays.
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l Select Freight and Shipping from the Select a Report list.

l Select the Page Setup checkbox if you wish to display your operating sys-

tem’s Print or Page Setup dialog to specify print options before printing the

report.

l Select the Sort Selection checkbox if you wish to display the Order By

dialog to sort the list of Purchases on the report before printing.

l Click Print.

l The Freight and Shipping Report dialog displays.

l Type a start and end date for the report into the Start Date and End Date

fields.

l Click to select a Report Type. See the sections for each report type for

more information.

l Click to select the Print radio button if you wish to print the report.

-OR-

l Click to select the Export radio button if you wish to export the report to an

Excel-compatible tab-delimited text file on your computer’s hard disk.

l Click OK to generate the report. If you selected Export as your output

option, you will now have to save the report file on your computer’s hard

disk.

If you are unsure where to save the file, save it on your Desktop so it will be easier to

locate. Make sure the file ends with the extension “.txt”.

Purchase Details Freight & Shipping Report Type
The Purchase Details Freight and Shipping Report lists the purchase and vendor invoice

numbers, vendor name, purchase date and total, and the freight and shipping charges for each

Purchase in the date range you specify. The total number of purchases from each vendor and the

number of these that incurred freight charges are also listed.
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DVMAX also calculates the amount paid for freight and shipping from each vendor, and the

total number of purchases, number of purchases that incurred freight charges, and the total

amount paid for freight and shipping for the entire specified time period.

Vendor Totals Only Freight & Shipping Report Type
The Vendor Totals Only Freight and Shipping Report lists the number of purchases, number

of purchases that incurred freight charges, and the total freight charges from each vendor.

DVMAX also calculates grand totals for these categories for the entire time period.

Report Total Only Freight & Shipping Report Type
The Report Total Only Freight and Shipping Report simply lists the number of purchases,

number of purchases that incurred freight charges, and the total paid in freight charges by your

practice for the specified time period.

Deleting a Purchase Record
You cannot delete a Purchase record from DVMAX.

If you need to correct an erroneous Purchase record, you can make an Inventory adjustment. See

Making Inventory Adjustments for information.

You can delete a line item from an individual Purchase record when converting it from a Pur-

chase Order. See Converting a Purchase Order.

Correcting a Purchase Record
You cannot change or alter a Purchase record in DVMAX. To correct errors in price or quantity

on a Purchase record, you need to create a new Purchase record that uses the Adjustment ven-

dor.

For more information on the Adjustment vendor, see Vendors.

Correcting Errors in Quantity
To adjust for errors in quantity on a Purchase record, you will need the Item Code and quantity

from the Purchase record you wish to correct. Since you cannot change or alter an existing Pur-

chase record in DVMAX, to correct errors in quantity you need to create a new record that uses

the Adjustment vendor.

To correct an error in quantity on a previous Purchase record:

l Choose Inventory Management from the Section drop-down menu.
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l From the Find window choose Purchases from the Search For drop-down

list.

l Click Add New at the bottom of the Find window.

l A new Purchase Record appears. The title of this Purchase Record contains

the sequential ID of this purchase as assigned by DVMAX.
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You can also create a new Purchase Record by clicking the Add New button at the bottom

of the Purchases List. See The Purchases List for more information.

l In the Vendor Code field type Adjust.

l In the Qty field, type the difference (either a positive or negative number)

between the quantity on the purchase you are correcting and the true quan-

tity purchased.

l Type the Item Code from the Purchase record you are correcting into the

Item Code field.

l Click OK to save the adjustment record.

Correcting Errors in Price
To correct or adjust price errors on a Purchase record, you will need the Item Code and quantity

of the item with the incorrect price from the Purchase record you wish to correct. Since you can-

not change or alter an existing Purchase record in DVMAX, to correct errors in price you need

to create a new record that uses the Adjustment vendor.

The following procedure lets you to correct the price without adding additional quantities to

inventory.

To correct a price error on a previous Purchase record:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window choose Purchases from the Search For drop-down

list.
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l Click Add New.

l A new Purchase Record displays. The title of this Purchase Record contains

the sequential ID of this purchase as assigned by DVMAX.

You can also create a new Purchase Record by clicking the Add New button at the bottom

of the Purchases List. See The Purchases List for more information.

l In the Vendor Code field type Adjust.

l Type 1 into the Qty field.

l Type the Item Code from the line item of the Purchase record you are cor-

recting into the Item Code field.

l Type the correct price into the Item Cost field.

l Press the <TAB> key twice to move to a new line item.

l Type -1 into the Qty field on the new line item.

l Type the Item Code from the line item of Purchase record you are correcting

into the Item Code field on the new line item.

l Type the correct price into the Item Cost field on the new line item.

l Click OK to save the adjustment record.

Making Inventory Adjustments
You can make a purchase using the Adjustment Vendor to correct discrepancies between man-

ual Inventory counts and Inventory levels as calculated by DVMAX.

l Choose Inventory Management from the Section drop-down menu.
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l From the Find window choose Purchases from the Search For drop-down

list.

l Click Add New.

l A new Purchase Record displays. The title of this Purchase Record contains

the sequential ID of this purchase as assigned by DVMAX.
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You can also create a new Purchase Record by clicking the Add New button at the bottom

of the Purchases List. See The Purchases List for more information.

l In the Vendor Code field, type Adjust.

l In the Qty field, type the difference (either a positive or negative number)

between the number of Inventory Items as calculated by DVMAX and the

number found in your Inventory count.

l Type the Item Code of the Inventory Item you are adjusting into the Item

Code field.

If do not know or cannot remember an exact Item Code, type the first letter into the Item

Code field and press TAB. This will bring up a window listing all existing codes.

l Click OK to save the adjustment record.

DVMAX will not calculate any sales tax on adjustment purchases (since there is no real

purchase made.) No changes are made to the Last Cost field for negative Adjustment Purchases

(decrease in Inventory) since the adjustment does not represent a real purchase of inventory.

Recording Hospital Use of Inventory
You can record consumption of inventory by your practice by creating a Purchase from the Hos-

pital vendor.

To record Inventory use by your practice, follow the procedure outlined in Recording a Pur-

chase by Creating a New Purchase Record, using Hospital as the Vendor code.

If a Purchase is made from the Hospital vendor, DVMAX updates only the quantity of an

Inventory Item. Hospital purchases have no effect on the cost of an Inventory Item.

Purchases made from the Hospital vendor always decrease the quantity of Inventory on

hand by the quantity purchased.

Purchases from the Hospital vendor are always measured in Dispensing units, not Purchase

units, reflecting the fact that your practice uses Inventory in dispensing units (1 tablet, 1 vial, 1

package, 1 cc at a time.) All other purchases are measured in Purchasing units. For more infor-

mation on Dispensing and Purchasing units, see Inventory.

Rabies Information Records
Rabies Information records contain producer (manufacturer) and lot number information for

rabies vaccines used by your clinic. When you administer a rabies vaccine, DVMAX places the

information from a Rabies Info record in two places:

l The patient record.

l The printed rabies certificate.

Each different brand or type of rabies vaccination injectable used in your practice must have its

own Rabies Info record.
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A Rabies Info record also contains a list of Reminder types that are linked to the record's vac-

cine. DVMAX uses these Reminder lists to distinguish rabies from other types of Reminders.

If a rabies vaccine is not linked to a rabies Reminder on a Rabies Info record, DVMAX

will not be able to ask for a rabies tag number when a rabies vaccine is administered, nor will

producer or lot number information be placed on the patient's record or the printed rabies cer-

tificate.

All Reminders types that use a Rabies Info record's vaccine should be listed on the

Rabies Reminder list.  Each Reminder that represents a rabies vaccination should only

be listed on one Rabies Info record.

Listing a Reminder on more than one Rabies Info record can produce unexpected

results when printing certificates.

For more information on Reminders, see the Reminders chapter of this manual.

Guidelines
The following are a few guidelines for rabies information records:

l You should update the Rabies Info record before new lots of vaccine injectable

are used. If the record is not kept up to date, incorrect lot number information

will be placed into patient records and printed on Rabies certificates.

l If you switch rabies vaccine manufacturers, you must create a new Rabies Info

record, and then remove appropriate Reminders from the old Rabies Info record

and add them to the new one.

l If you regularly use rabies vaccines from different producers, or if you change

producers frequently, you must create a separate Rabies Info record for each

type of injectable you use. You must also create a separate Reminder type for

each type of injectable you use.

l If you do not do this, DVMAX will not know which injectable was used for a

vaccination, and will choose at random from Rabies Info records containing that

reminder type.

l A scenario: if you have one Rabies lot for Canine and one for Feline, and they

both use 1 year and 3 year reminders, it is absolutely necessary that there be 2

sets of 1 year rabies reminders, and 2 sets of 3 year reminders, one for each spe-

cies.

l See Reminders for more information on creating Reminder types.

Creating a New Rabies Info Record

To create a new Rabies Info Record:
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l Choose Patient Codes from the Section drop-down menu on the DVMAX

main screen. The Find window displays.

l From the Search For drop-down list, choose Rabies Info.

l Click Add New. A new, blank Rabies Info record opens.
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l Type a description of the new record into the Description/Name field (e.g.
“RabVac”). The description can be a maximum of 40 characters. If the descrip-

tion is longer than this, DVMAX will retain only the first 40 characters.

l Type the producer (manufacturer) of the rabies vaccine into the Producer field
(e.g. “Rhone-Merieux”). The producer can be a maximum of 20 characters. If

the producer is longer than this, DVMAX will retain only the first 20 characters.

DVMAX will print the producer on certificates when this vaccine is administered.

l Type the current lot number of the vaccine into the Lot Number field. The lot
number can be a maximum of 20 characters. If the lot number is longer than this,

DVMAX will retain only the first 20 characters.

The lot number will be printed on certificates when this vaccine is administered.

l Choose Add Reminder from the Rabies Reminder drop-down menu. The
Add Rabies Reminder dialog displays.

-OR-
l Double-click in the Rabies Reminders field. The Add Rabies Reminder
dialog displays.

l Type an existing Reminder Code in the Reminder Code field. The reminder
code you type must be one linked to the Bill Item representing this vaccine.

If do not know or cannot remember an exact Reminder Code, type the first letter into the

Reminder Code field and press TAB. This will bring up a window listing all existing codes.

l Click OK to save your reminder code and return to the Rabies Info record win-

dow.

l Click OK to save the new Rabies Info record and return to the Find window.

List All Rabies Info Records
To see a list of all Rabies Info records in DVMAX:

l Choose Patient Codes from the Section drop-down menu on the DVMAX

main screen..
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l From the Find dialog, click the Search For drop-down list and choose Rabies
Info.

l Click All Records. A list of all records will display.

Search For Rabies Info Records
You can search for Rabies Info records by producer (manufacturer) or by the Reminder linked to

the record.

To find a Rabies Info Record:

l Choose Patient Codes from the Section drop-down menu on the DVMAX

main screen.

l From the Find dialog, click the Search For drop-down list and choose Rabies
Info.

DVMAX Practice V8.6 - User Manual



- 723 -

l If you know the name of the producer of the vaccine contained in a record, type

it into the Producer Name field. You do not need to type the entire name.

-OR-
l If you know the Reminder Code linked to the record you wish to find, choose

Linked Reminder Code from the By drop-down list.

l Type the code into the Reminder Code field. You do not need to type the entire
code.

l Click Search.

-OR-
l Click All Records to see a list of all Rabies Info Records.

l If there are multiple Rabies Info Records that match your search, DVMAX will

present a list. Double-click the record you wish to view.  If there is only one

match for your search, DVMAX will open the matching record.

l If there are no matches, DVMAX will present a dialog telling you so.

Edit a Rabies Info Record
To edit a Rabies Info Record:

l Open the Rabies Info Record you wish to edit by following the procedure out-

lined in Search For Rabies Info Records.

l Type your changes into the Description/Name, Producer, and Lot Number
fields as required.

l To edit or delete a linked Reminder, click once on the Reminder you wish to

modify in the Rabies Reminder field, and then choose Modify Reminder
from the Rabies Reminder drop-down menu.

-OR-
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l Double-click the Reminder you wish to modify in the Rabies Reminder field.

l The Modify Rabies Reminder dialog displays.

l If necessary, type an existing Reminder Code in the Reminder Code field. The
reminder code you type must be one linked to the Bill Item representing this vac-

cine.

l Click OK to save your reminder code and return to the Rabies Info Record

screen.

-OR-
l Click Delete to delete this Reminder and return to the Rabies Info Record
dialog.

l Click OK to save your changes.

-OR-
l Click Cancel to leave the Rabies Info record unchanged.

Delete a Rabies Info Record
To delete a Rabies Info Record:

l Open the Rabies Info Record you wish to delete by following the procedure out-

lined in Search For Rabies Info Records.

l Click Delete to delete this record and return to the Rabies Info Record screen.
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Recalls
Recalls are follow-up communications to clients about their patients, most often to do with a pro-

cedure recently undertaken by your practice on a patient. As the name indicates, recalls are

often performed via a telephone call to a client.

For example, you might add a recall to a patient’s record to make a post-operative call about a

patient, to call to inform a client it’s time to remove a patient’s sutures, or to send a sympathy

note to a client after a patient’s death.

Recall records can also be linked to Bill Items. If a recall is linked to a Bill Item, the sale of that

Bill Item on an invoice will automatically post or update a recall on a patient’s record. See Bill

Items and Invoicing for more information.

Recalls are similar in many ways to Reminders. For information on Reminders, see Reminders.

This chapter addresses the setting up and editing of Recall records. For information about work-

ing with Recalls on a patient record, see Working with Patient Records.

List Recall Records
To view a list of all Recall records:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.
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l Choose Recalls from the Search For drop-down list.

l Click All Records at the bottom of the Find dialog to see a list of all defined

Recall records.

l Each Recall record is listed on an individual line with columns for Recall Code,

Reason, Default Delay, Miscellaneous and Survives Death.

Search Recall Records
To find a Recall record:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.
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l Choose Recalls from the Search For drop-down list.

l Choose Recall Code from the By drop-down list to search Recall records by

code. Type a Recall Code in the Code field below the By drop-down list.  If you

are searching by code, you must type at least the first few letters of the Recall

code

-OR-

l Choose Keyword in Description to find Recall records by a keyword in the

recall description (called the Reason field in the Recall record). Type a key-

word or words from the Recall Reason into the Keyword in Description field

below the By drop-down list.  DVMAX will find all Recalls that contain the

word or words you type in the field.

l Click Search.

l If there is more than one match for your search, the Recall List window will pro-

vide a list of items that matched your search.
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l If there is only one Recall record that matches your criteria, DVMAX will open

that Recall record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

You can also quickly locate a Recall record by following the steps in Listing All Recall

Records and double-clicking the one you are interested in from the list.

Create a New Recall Record
To create a new Recall record:

l Choose Patient Codes from the Section drop-down menu.
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CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.

l Choose Recalls from the Search For drop-down list.

l Click the Add New button at the bottom of the Find window.

l The New Recall Type window opens.

l Type a unique code for this Recall into the Recall Code field. The Recall Code

can be up to 8 characters long.

l Type a description of the reason for this recall into the Reason field. The reason

is listed on the Patient record and printed on reports of Recalls that are due.

l Type the number of days from the time this recall is entered on a patient record

until it becomes due into the Default Delay recall. DVMAX uses this number
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as a default, but you can override it when you enter the Recall on the patient’s

record.

l Select From Administration to have the Recall date be based on when the

recall is entered onto the patient record.  The recall will be due “x” number of

days from when the recall was entered on the patient record, where “x” is the

Default Delay value.

-OR-

l Select From Birthdate to base the recall due date on the birthdate of the

patient, independent of the date the Recall request is added to the patient record.

This is useful for recalls such as early puppy or kitten vaccines that come due

based on the age of the animal.

l SelectMiscellaneous if you wish to allow the reason for the recall to be mod-

ified when the Recall is entered on the Patient record. Deselect the Mis-

cellaneous checkbox if you wish the Reason to be entered on the patient record

as-is.

l Select Survives Death if you will want to enter this Recall on a patient record

even if the patient is marked as deceased. Deselect Survives Death if you do

not wish this Recall to be entered on the record of a deceased patient.

The Survives Death option is useful in cases such as a Sympathy Recall for a deceased

patient.

l Click OK to save the Recall record.

Delete a Recall Record

Deleting a Recall record is not recommended.  It may leave other records incomplete, espe-

cially if the Recall record is linked to a Bill Item or has been added to a Patient record. 
To delete a single Recall record:

l Find and open the Recall record you wish to delete. See Searching for Recall

Records.

l From the Recall record, click Delete.

l DVMAX will ask you to confirm that you want to delete the Recall record. 

Click OK to delete.

To delete multiple Recall records:
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l From the Recall records list (see Listing All Recall Records), click to select

the Recall records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Recall records from the list. Press

and hold the CONTROL key to select multiple non-adjacent Recall records.

l Choose Delete Records from the Recalls menu.

l DVMAX will ask you to confirm that you want to delete the Recall records. 

Click Delete to proceed.
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Referral Source Records
Referral Source records help you keep track of how clients and patients are referred to your prac-

tice. Each Referral Source record stores identifying information about a particular source of

referrals.

Referral Source records also provide a list of referrals from each source, and make available a

word-processing environment to write to the source as needed.

Referral Source records are useful to specialty or emergency practices that need to keep track of

colleagues who refer patients to them. General Practices can use these records to track the

source of new clients. You can also use Referral Source Records to store information about cur-

rent clients who refer new clients.

The Referred By fields in Client and Patient records can contain only Referral Source Rec-

ords. See Working with Client Records andWorking with Patient Records for more information.

Search For Referral Source Records
To find a Referral Source record:

l Click Clients on the Command Palette

-OR-

l Choose Clients & Patients from the Section drop-down menu.

l From the Find window, choose Referral Source from the Search For drop-

down list.
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l Choose a criterion from the By drop-down list. See Search Criteria for more

information.

l Type your search term into the field below the By drop-down list. The label of

this field is determined by your choice from the By drop-down list.

l Click Search.

l If there is more than one match for your search, the Client List window will dis-

play a list of items that matched your search.
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l The first column of the Referral Source List displays the Referral Code for the

record. The second column displays the Doctor's Name, and the Practice Name,

where applicable.

l If there is only one Client Record that matches your criteria, DVMAX will open

that Referral Source Record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Listing All Referral Source Records
To list all Referral Source records:

l Click Clients on the Command Palette.

-OR-

l Choose Clients & Patients from the Section drop-down menu.
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l From the Find window, choose Referral Source from the Search For drop-

down list.

l Click All Records at the bottom of the Find window.

Create a New Referral Source Record
To create a Referral Source record:

l From the Section menu, choose Clients & Patients.

-OR-
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l Click the Clients icon on the Command Palette.

l From the Find window, choose Referral Source from the Search For drop-

down list.

l Click Add New at the bottom of the Find Window. A new Referral Source

Record window opens.

You can also find an Add New button at the bottom of the list of sources resulting from a

Referral Source search. For more information about Referral Source searches, see Searching

For Referral Sources.
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l Complete each field as appropriate in the Referral Source window. See Refer-

ral Source Fields for information on each field.

You can leave any field empty, except for the Ref Code and Last Name fields.

l Type a unique code in the Ref Code box. This code will be used to enter this

Referral source on Client and Patient records. Press the TAB key.

Create a Referral Code that closely matches the source's name. For example, the code for

John Smith could be "JohnSmith" (simply remove the spaces), or the code for ABC Animal Hos-

pital could be "ABCAnimalH".

l Type a title (i.e. Mr., Mrs., Dr, etc.) in the first name field. Press the TAB key.

l Type the source's first name in the second name field. Press the TAB key.

l Type the source's last name in the third name field. Press the TAB key.

l Type the name with which you start a letter to this source into the Salutation

field. Examples are "Dr. Roberts" or "John" or "Ms. Smith". Press the TAB key.

l Type the degree held by this source, if any, into the Degree . Examples are

"DVM." or "M. Sc." Press the TAB key.

l Type the name of the source's Practice or Business into the Practice/Bus field.

Press the TAB key.

l Type the source's Address, City, State and Zip or PostalCode into the appro-

priate field. Use the TAB key to move from field to field.

You can type the client’s zip code into the City field and DVMAX will automatically fill in

the City, State and Zip Code fields and move you to the Home Phone number field. For more

information, see Zip Code Lookups in the Working With Client Records section of this reference.

l If you classify sources by Sales Region, type this source's Region into the

Region field. Press TAB.

l Type the source's E-mail address into the E-Mail field. Press TAB.

l Type the source's Work Phone, Fax, Pager, Home and Cell Phone numbers

into the appropriate field. Use the TAB key to move from field to field.

DVMAX automatically formats any telephone number into “xxx-xxxx” or “xxx-xxx-xxxx”

format.  There is no need to type dashes or parentheses. The system will warn you if a telephone

number is not a 7 or 10 digit number. DVMAX will also convert letters to their number equiv-

alents.

l Enter the referral source e-mail address in the E-Mail field.

l If you wish this source to have access to Patient records via the Internet, type a

username and password into the Username and Password field. See Web

Patient Reporting for more information.

Usernames and passwords must be 6-12 characters long and may contain letters and/or

numbers.
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l Type any notes about this source into the Notes field.

l Click OK to save the new Referral Source Record.

E-Mail a Referral Source
To e-mail a referral source, click the e-mail icon beside the E-Mail field. The referral source e-

mail address is in the To field. Compose your e-mail and click Send. 

Delete a Referral Source Record

Deleting a Referral Source record can affect client and patient records that use this record.

Use this feature with caution.

Delete a Single Referral Source Record
To delete a single Referral Source record:

l Open the Record you wish to delete. See Searching For Referral SourceRecords

for more information.

l Click Delete from the Referral List window.

l DVMAX will ask you to confirm that you wish to delete this record. Click OK.
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Deleting Multiple Referral Source Records
To delete multiple Referral Source Records at once:

l Find the Referral Source Records you wish to delete from the list of Referral

Source Records. . See Search for Referral SourceRecords for more information.

l Click to select the record(s) you wish to delete. To select multiple records, hold

the SHIFT key while clicking to select adjacent records in the list. Hold the

CONTROL key (COMMAND on Macintosh) to select non-adjacent records.

l Choose Delete Records from the Referral Source menu.

l DVMAX will ask you to confirm that you wish to delete the record(s). Click

OK to delete the record(s).

Referral History Tab
The Referral History tab provides a list of the most recently referred patients from this referral

source, making it easy to review recent cases referred to you.
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Viewing a Referred Patient Record
To view the record of an individual referred Patient:

l Follow the steps in Sorting the List of Past Referrals to produce a list of patients.

l Double-click the Patient record you wish to view from the list.

-OR-

l Click to select the Patient Record you wish to view from the list.

l Click the Show button at the bottom of the Patient list.

l Click the Show button at the bottom of the Patient list

If there is only one patient in the List of Past Referrals, the steps in Sorting the List of Past

Referrals will open that patient's record.

Word Processing in Referral Source Records
The Word Processing function allows you to write to your Referral Sources, making it easy to

correspond with any referring colleague or client. For specialty and emergency practices, this

feature can make it easy to send out an occasional newsletter about your practice to your refer-

ring clinicians.  General practices can use it for sending “Thank You” letters to the referral

source.  You can also create emails or Fax documents (see the Faxing chapter in this Manual. 

Faxing requires a license from DVMAX).
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Select the Word Processing tab from Referral Sources to open the Word Processing facility.

For more information on word processing in DVMAX, see Word Processing elsewhere in this

documentation.

The Referral Source Word Processing Palette
The Referral Source Word Processing tab is designed for writing to Referral Sources directly. It

cannot be used to write about a specific case or client - that can be done from the specific

Patient or Client record word processing entry screen.

Use the Word Processing Palette, accessed from an open WP document by clicking Show Pal-

ette, lets you easily insert information from the current Referral Source record into your letters.

For more information on word processing in DVMAX, refer to the Word Processing chapter.

Closing the Referral Source Word Processing Palette
To close the Patient Word Processing Palette at any time while working on a Patient Word Proc-

essing screen:

l Click the Close Box in the upper right corner of the Palette, or select Hide Pal-

ette.
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Using the Referral Source Word Processing Palette
To use the Referral Source Word Processing Palette, simply click an information field on the pal-

ette, then click Insert at the bottom of the palette. DVMAX will place the selected information

into the word processing document at the current cursor position. Double-clicking a field name in

the Palette is a shortcut for inserting that field.

Holding down the Shift key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

The Referral Source Word Processing Palette is broken down into 2 main “groups” of ref-

erences: Referral Merge Fields and Referral Address Lines.

Referral Merge Fields

Referral Merge Fields items allow you to insert fields from the current Referral Source record

into the word processing document. Items inserted onto a letter are actually references to the cur-

rent Referral Source record. See Creating a New Referral Source Record for information on the

fields referenced by this menu.

Referral Address Lines

Referral Address Lines items allow you to insert the address of the Referral Source into your

document. Address lines are actually references to the address fields of the current Referral
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Source record. The address can be inserted as a block of text, or as individual lines (permitting

other text to appear alongside each line of the address).

See Creating a New Referral Source Record for information on the fields referenced by this

menu.

Clients as Referral Sources
Any active client can act as a referral source in DVMAX. To enable clients to act as referral

sources, you need to select Allow Referrals By Other Clients from the Clients and Patients

tab under System Constants.

DVMAX represents client referral sources with a special Referral Source record. This record

has the code ClientReferral. This record has no address or contact information, and is blank

except for the code and the last name, which is also ClientReferral.

When the ClientReferral source is referenced in Client or Patient record, DVMAX presents a

list of active clients to choose from. For more information on Client Referrals, see Working with

the Client Record andWorking with the Patient Record.
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Reminders

A reminder is a notice that is sent to a client indicating that a patient is due for a specified pro-

cedure or set of procedures.  DVMAX's Reminders function lets you identify all patients need-

ing reminders for procedures due within a specified date range, and allows you to create and

send reminder notices via email or standard mail.

Reminders can be linked to Bill items. Entering a Bill item on an invoice can automatically post

a new reminder, update an existing reminder, or remove an outdated reminder from the patient’s

record. This makes it easy to assure that specific treatments are always followed up with an

appropriate reminder. See Bill Items and Invoicing for more information.

Working With Reminder Types
Reminder Types define the different types of reminders that DVMAX tracks. Reminder Type

records identify the reminders that are included in a patient’s record.  Reminder Types may also

be linked to Bill Items so that the sale of a bill item through an invoice will automatically update

a reminder on a patient’s record.  See Bill Items for more information.

DVMAX contains a number of pre-defined, common Reminder Types.  Additional reminder

type records can be added.

View Reminder Records
To view a list of all Reminder records:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.

l Choose Reminder Types from the Search For drop-down list.
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l Click All Records at the bottom of the Find dialog to see a list of all defined

Reminder records.

l Each Reminder record is listed on an individual line with columns for Reminder

Code, Description, Duration Days, Fixed Date and Turnover (Days).

Search for Reminder Records
To find a Reminder record:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.

l Choose Reminder Types from the Search For drop-down list.

l Choose Reminder Code from the By drop-down list to search Reminder rec-

ords by code. Type a Reminder Code in the Reminder Code field into the field

below the By drop-down list.  If you are searching by code, you must type at

least the first few letters of the Reminder code

-OR-
l Choose Keyword in Description to find Reminder records by a keyword in the

recall description (called the Description field in the Reminder record). Type a

keyword or words from the Description into the Keyword in Description field

below the By drop-down list.  DVMAX will find all Reminder records that con-

tain the word or words you type in the field.

l Click Search.
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l If there is more than one match for your search, the Reminder Types List win-

dow will provide a list of items that matched your search.

l If there is only one Reminder record that matches your criteria, DVMAX will

open that Reminder record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.

Create a New Reminder Type Record
To create a new Reminder record:

l Choose Patient Codes from the Section drop-down menu.

CONTROL+4 (COMMAND+4 on Macintosh) is a keyboard shortcut for Patient Codes.

l The Find window opens.

l Choose Reminder Types from the Search For drop-down list.

l Click the Add New button at the bottom of the Find window.

l The New Reminder Type window opens.

l Type a unique code for this Reminder into the Reminder Code field. The

Reminder Code can be up to 8 characters long.

l Type a description of the reason for this reminder into the Description field.
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l Type a reminder note in the Note field.  The reminder note will appear on

reminder cards that are printed or emails, as well as on certificates.

l Type a summary or shorter version of your note into the Short Note field. The

short note is printed in place of the note when a reminder is printed with multiple

patients on a single card.

l Select the Don’t List on Certificates if you do not want Reminders of this type

printed on vaccination certificates. You may feel this option is appropriate, for

example, for Reminders for geriatric exams or stool samples.

l Type a number into the Duration (Days) field. This tells DVMAX how many

days to wait before sending the Reminder again.

Typical annual reminders are set to 365 days. Some puppy and kitten vaccines may be set

for 21 or 30 days. The duration that is set here is the default duration for this reminder type

throughout the system; you can change the duration for a reminder on any patient record and for

any Bill item link.

l Select From Administration to have the Reminder date be based on when the

procedure linked to this reminder was administered.  The reminder will be due

“x” number of days from when the linked procedure was added to patient his-

tory, where “x” is the Duration (Days) value.

-OR-
l Select From Birthdate to base the reminder due date on the birthdate of the

patient.  This is useful for reminders related to procedures that come due based

on the age of the animal.

l If you want this reminder to always be due on the same date every year, type

this date in the Fixed Date field. Type the current year for the year portion of

the date. The default format for all dates in DVMAX is MM/DD/YY.

l Type a number in the Turnover (Days) field. This number controls the behavior

of fixed date reminders in DVMAX. If a reminder is entered or updated within

the “turnover period” of the fixed date then it will be set to be due again on the

fixed date one year in the future. If it is before the turnover period, then it will

be set to be due on the upcoming fixed date.

Turnover (Days) Example: If a reminder for a heartworm test is set for April 1 and the turn-

over period is set for 31 days, then the following results are possible:

Test done before March 1: Due again on April 1 of the same year.

Test done between March 1 and April 1: Due again on April 1 of next year

Test done after April 1: Due again on April 1 of next year

l Click OK to save the Reminder Type record.
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Modifying a Reminder Type
To modify a Reminder Type:

l Find the Reminder Type you wish to modify.

l Make the necessary changes on the Reminder Type record dialog.

l Click OK to save the changes to the Reminder Type record.

Delete a Reminder Type Record

Deleting a Reminder record is not recommended.  It may leave other records incomplete, espe-

cially if the Reminder record is linked to a Bill Item or has been added to a Patient record. 
To delete a single Reminder Type record:

l Find and open the Reminder Type record you wish to delete. See Search for

Reminder Type Records.

l From the Reminder record, click Delete.

l DVMAX will ask you to confirm that you want to delete the Reminder Type

record.  Click OK to delete.

To delete multiple Reminder Type records:

l From the Reminder records list (see List All Reminder Records), click to

select the Reminder Type records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Reminder records from the list.

Press and hold the CONTROL key to select multiple non-adjacent Reminder records.

l Choose Delete Records from the Reminder Type menu.

l DVMAX will ask you to confirm that you want to delete the Recall records. 

Click Delete to proceed.
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Reminders and the Patient Record
Reminders can be added manually to a patient record, and automatically through invoicing. 

Refer to those chapters in the user guide for more information on adding reminders to a patient

record.

Reminders: A Quick Overview
Use the Reminder Wizard to create a list of patients requiring a reminder notice.  Briefly, the

steps involved are as follows:

l From the Section drop-down menu, choose Reminders.  This opens the

Reminder Wizard dialog.

l From the Reminders window, select a Date Range, or use the default

range as listed. 

l Choose the procedures for which you would like to create reminders from

the Types area of the Reminders window. 

l Click OK to produce a list of all patients requiring reminders.

l From the Reminder List window, click OK to generate the reminder

notices.  The kind of reminder notice created (email or standard mail) will

be determined by the selection you have made in the client record. 

l Click Cancel to abort the Reminder process.

Where the Email Reminder field is checked on the Client record, an email reminder will

be sent.  For those clients where the Email Reminder option is not selected, a regular mail

notice will be prepared.

Choosing a Date Range
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When generating a Reminders list, DVMAX will search the database for all patients due for

selected procedures within the specified Date Range.  The default Date Range is determined by

the Reminder Setup (see Reminder Setup). 

To select a Date Range:

l Use the default Date Range as provided.  The default Range can be

adjusted by clicking Setup from the Reminders window (see Reminder

Setup).

l Choose your own Date Range by clicking the Calendar icons and selecting

a Start Date and End Date from the Calendar.

Choosing Reminder Types
The Types area in the Reminder window lists all procedures for which reminders have been set

up.  Choose the procedures from the list for which you would like to generate reminders.

By default, all procedures are selected.  If you do not specify at least one Type, DVMAX can-

not run a search or generate a Reminder List. 

To select Reminder Types:

l Click Select All to include all Types.
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l Click any item to select it, click again to deselect the item.  An item is

selected when an asterisk (*) appears beside the reminder type.

l Click Remove All to deselect all Types.

Reminder Types are defined under the Reminder Types menu from Patient Codes in the

Section drop-down menu.

Generating List of Patients Due for Reminders
The DVMAX Reminder Wizard uses the Date Range and Reminder Types to generate a list of

all patients due for selected procedures within the specified time period.  This is called the

Reminder List.

To generate a Reminder List:

l Click OK from the Reminders window.  Make sure you have set the Date

Range and have selected Types first.

l A list of all patients matching the search parameters will be returned.
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No Reminders to Process
If there are no reminders due within the specified parameters, a message window opens indi-

cating there are no reminders to process.  Click OK to close the message window.

About the Reminder List
The list of patients generated by the Reminder Wizard is color-coded to indicate that the patient

is due to receive either a first, second or third reminder.  For each patient, all procedures due

within the specified date range will appear on the same reminder notice.  Depending on how you

have set up the Reminder function (see Reminder Setup), patients can be sent up to 3 reminder

notices.
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l Green indicates first reminder.

l Blue indicates second reminder.

l Red indicates third reminder.

The amount of time between reminder notices is determined by the Days Between

Reminders setting under Email Reminders from System Constants.  The days between

reminders applies to both emailed and printed reminders.

Creating Reminder Notices with the Reminder Wizard

Before you begin processing reminders, be sure to have your printer set up and ready with

the postcards or other paper you intend to use for any printed reminders.

Reminder notices can be generated using the Reminder Wizard.  The Reminder Wizard,

accessed from Reminders under the Section menu, lets you set up the reminder

card/letter/email format and generate a list of all patients due for first, second or third reminders.

To generate reminder notices using the Reminder Wizard:

l From the Section drop-down menu, choose Reminders.

l From the Reminders window, select a Date Range, or use the default

range as listed. 

l Choose the procedures for which you would like to create reminders from

the Types area of the Reminders window. 

l Click OK to produce a list of all patients requiring reminders.

l Click OK from the Reminders List to begin processing the reminders.

l A Confirm window opens indicating the number of reminders that are about

to be processed.  Click OK to continue processing reminders.

-OR-
l Click Cancel to abort the reminders process.

The type of reminder generated will depend on the selection made in the client record. 

Where the Email Reminder field is checked on the Client record, an email reminder will be
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sent.  For those clients where the Email Reminder option is not selected, a regular mail notice

will be prepared. The format of the reminder message is configured under Reminder Setup.

Excluding Patients from the Reminder List
You can choose not to generate a reminder for any patient on the Reminders list.

To exclude a patient:

l Click to highlight a patient from the list.

-OR-
l Click and drag to highlight a group of patients from the list.

l Click Exclude.  The selected patients will be removed from the list.

Reminder Notice Setup
The format of the reminder notice as well as the default Date Range is determined by the

Reminder Setup section of the Reminder Wizard. 

To configure the Reminder function:

l From the Section drop-down menu, choose Reminders.

l From the Reminders window, choose Setup.
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l From the Send Reminders area, choose how often you wish to generate

reminder notices (Monthly, Semi-monthly or Weekly).  The default value is

semi-monthly.  This will determine the default Date Range used in gen-

erating the Reminder List.  (Date Range, including Start Date and End Date

fields, appears on the main Reminder window.)

The Monthly default Start Date will be the first day of the month following the current

month (current date is the first of the month).  Semi-monthly will default to the first or middle of

the month, depending on the current date.  For example, if the current date is May 5, the default

date for Semi-monthly will start at May 15.  ForWeekly, the default Start Date will be the

Monday of the week following the current date.

l From the Reminders to Send menu, select the number of reminder notices

to send to each client and associated patient.  You can send a single

reminder, or choose to send second and third reminders.
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l From the Format drop-down menu, select Built-In (default), 4D Write or

Semi-Custom. Follow the same process forMail and E-mail reminders. You

must have a valid e-mail address in the client's record in order to send an

electronic reminder.

l If you choose a format other than Built-In, click Set to select the format for

reminders. 

l Repeat the format setup for First, Second and Third reminders as

applicable.  You will only see Second and Third reminder options if you

have chosen 2 or 3 from the Reminders to Send menu.

l If you are sending mail reminders, you can choose to include more than one

reminder card per printed page.  ClickMultiple Cards on a Page to include

more than one reminder on a page.

Only one reminder per patient will be sent out at any one time. All procedures for which a

patient is due within the selected Date Range will appear on the same reminder notice. If the

patient comes in they will be marked as complying with the reminder and will be sent no further

reminders for the procedures listed on the last reminder sent. If the patient does not present, the

patient may appear on the Reminder List the next time Reminders is run.   In order for a patient

to receive a second or third reminder, the specified time between reminders (as set up under

Email Reminders in System Constants) must have lapsed, and you must have indicated under

Reminder Setup that you wish to generate second and third reminders.

Reminder Sequencing
When generating a Reminders list, DVMAX will search the database for all patients due for

selected procedures within the specified Date Range. In addition, the Reminder wizard allows

the user to select the number of reminders sent and the frequency. While this provides a great

deal of customization to the user, it also increases the complexity of the reminder function.

The variables that must be considered when creating reminders include:
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l The number of Reminders to be sent (up to three).

l The interval between each reminder.

l Days between Reminders (in System Constants).

l Send Monthly, Semi- Monthly, Weekly.

l If the procedure for which the reminder was provided was completed or not com-

pleted.

l Dates of previous reminders.

l Has the previous reminder interval elapsed.

Example: The default settings are set to send three reminders at monthly intervals.

First Reminder: On May 1st, the Reminder wizard is used to perform a search for dates

between May 1 and May 31. DVMAX searches for all selected procedures in this date range

and which have not received a reminder. The clients with animals meeting these specifications

are sent a reminder.

Second Reminder: After the first reminders are sent, DVMAX searches for procedures that

were scheduled for the dates between April 1st and April 30th (30 days before or the previous

month interval). The wizard also searches if the procedures have been issued a first reminder

and if procedure was performed. If the procedure is overdue, has received a first reminder

and falls within the range to the previous interval, a second reminder is sent to the client.

Third Reminder: The third reminder works the same as the second reminder but searches for

the dates between March 1st and March 31 (60 days) and if a second reminder has been sent.

If you come back on May 15 and perform a new search (reminders to be sent) for the dates

between May 15 and May 30, the list would be empty. This is because:

l The previous search located all procedures within this date range.

l The procedures in this date range have been sent a first reminder.

l DVMAX will only send out a second reminder to those procedures who have

received a first reminder.

l DVMAX will not send out a follow-up reminder until the previous reminder

interval has elapsed or the procedure becomes overdue (reminder group date is

less than or equal to the previous reminder date, defined as the current date less

the reminder delay).

DVMAX helps distinguish between reminder list procedures with color-coding. See, About the

Reminder List for more details

Reminder Format
The Reminder Wizard allows you to select one of three formats for your reminders:  Built-In,

4D Write or Semi-Custom.
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l Built-In:  This is the standard reminder format that comes with DVMAX. 

First, second and third reminders will look the same.  This is the default for-

mat.

l 4D Write: Allows you to select a 4D Write document that has been pre-

viously created using 4D's Word Processing feature.  First, second and third

reminders can be different.  Select a document style from the 4D WP Doc-

ument list and click Select.

l Semi-Custom:  Semi-Custom allows for some modification of the built-in

reminder format that comes with DVMAX.  First, second and third

reminders can be different.  Click OK from the Custom Reminder Setup win-

dow to save changes to the reminder notice format.
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Email Reminder Setup
You must provide DVMAX with information about your internet connection and email account

in order to use Email Reminders.

To configure Email Reminders:

l Choose System Constants from the Section menu.

l Click the Email Reminders tab.
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l Type the name of your outgoing email server (also known as an SMTP

server) into the Outgoing Mail field. DVMAX will send Email Reminders

through this server.

l Type the name of your incoming email server (also known as a POP server)

into the Incoming Mail field. DVMAX will check email from this server

for responses and bounce messages.

l Type the name of your email account on the Incoming Mail server into the

Account Name field, and type your password into the Password field. Each

character in your password will be replaced with an asterisk (*) as you type.

l Click the first Select Folder button to select a directory in which DVMAX

will store any mail it receives in response to Email Reminders. Click the sec-

ond Select Folder button to select a directory in which DVMAX will store

any attachments received with any mail. These can be the same directory.

l Type a valid email address in the From Address field. The address you

type here is the address that Email Reminders will be sent from.

l If you wish replies to Email Reminders to be sent to an email address other

than the From Address, type it in the Reply To Address field. Otherwise,

type the same address as in the From Address field.

l Type a subject for the Email Reminder in the E-Mail Subject field.

l Click the Send Reminders By Email if Possible checkbox to enable Email

Reminders.
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l Click OK to save your changes.

l Click OK again to exit System Constants.

HealthyPet Reminders

What Are HealthyPet Reminders?
HealthyPet Reminders are professionally published reminders mailed to your clients on your

behalf. HealthyPet reminders can be postcards, newsletters or the HealthyPet Magazine, each

customized to list upcoming treatments at your veterinary clinic.

DVMAX can integrate its own powerful internal reminder system with your HealthyPet

account. This chapter provides instructions on how to send your DVMAX Reminders to Healthy-

Pet. For more information on DVMAX Reminders, see the Patients chapter of this manual.

Requirements
In order to send your DVMAX reminders to HealthyPet, you will need:

l A valid HealthyPet account number.

l A connection to the internet on the computer running DVMAX.

Setting Up DVMAX to Send Reminders to HealthyPet
To set up the HealthyPet Reminder system in DVMAX, follow these steps:

1. Provide a valid HealthyPet account number.

2. Tell DVMAX to include the date with Reminders.

To enter a HealthyPet Account number, follow these steps:

l Select System Constants from the Section menu on the DVMAX main

screen.

l From the System Constants menu, choose Default Constants. Alter-

natively, click the Default Constants tab.

l Type a valid HealthyPet account number in the HealthyPet Account # field.
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l Click OK to save your account number.

l From the System Constants menu, choose Clients & Patients. Alter-

natively, click the Clients & Patients tab.

l SelectWith WP Reminders under the Include Dates heading.
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l Click OK to save the Include Dates with WP Reminders setting.

l Click OK to exit System Constants.

Sending DVMAX Reminders to HealthyPet
DVMAX uses the internet to send your Reminders to HealthyPet. The process is simple: you tell

DVMAX the range of dates for which you want to send reminders, and DVMAX scans all

patient records, removes inactive clients, and sends valid reminders to HealthyPet.

To send DVMAX Reminders to HealthyPet:

l Choose General Management from the Section menu on the DVMAX

main screen.

l Click the Utilities tab on the Management Functions.

l Select Send HealthyPet Reminder File in the list of Utilities on the left

side of the screen.

l Click OK. The Date Range Entry screen opens.

l Type the first day for which you wish to send Reminders into the Starting

Date field. Type the last day for which you wish to send Reminders into the

Ending Date field.
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All dates in DVMAX must be typed in MM/DD/YYYY format.

l Click OK to have DVMAX send your Reminders to HealthyPet.

l DVMAX will notify you when your Reminders have been sent.

l If there were errors sending the Reminders, DVMAX will notify you of

these as well.

Technical Details

DVMAX uses FTP (File Transfer Protocol) to send your Reminders to HealthyPet. The relevant

FTP information is as follows:

l Server address: ftp.dvmreminder.com.

l User name: DVMAX

l Password: 3pfg45

l Remote directory: /home/DVMAX/incoming

When you tell DVMAX to send your Reminders to HealthyPet, DVMAX creates a temporary

file containing your Reminders on your computer. DVMAX then uses FTP to send this file to the

HealthyPet FTP server.

The name of this file is a combination of your HealthyPet account number followed by a Date

and Time Stamp. If you are using DVMAX SU, DVMAX will save this file in the same direc-

tory as your structure file. If you are using DVMAX Client, DVMAX will save this file in the

same directory as the DVMAX client application.

DVMAX deletes the temporary file after sending it to the HealthyPet FTP server.
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Requisitions and Lab Results
DVMAX allows you to submit lab and Cubex requisitions, as well as automatically import test

results from in-house lab instruments and external lab sources into patient records. This chapter

addresses the setup of requisitions and lab results integration. For information on PACS Link and

DICOM integration, refer to the DVMAX PACS Link chapter.

The Requisition Setup features apply to IDEXX Reference Lab, IDEXX VetLab Station Net-

work, Cubex and Antech/Zoasis. Using the Requisition Setup Wizard, you can configure

DVMAX to submit requisitions and, where applicable, generate printable requisition forms for

the associated provider(s). The Requisition functionality also includes a Reconciliation feature,

which compares what was requested to the results received. Reconciliation helps ensure charges

associated with work or supplies ordered and received are correctly applied to an invoice.

The Lab Result Setup feature is divided in to two main areas: setup for the In-Office Analyzer

(accommodates up to 2 instruments per workstation at one time) and configuring DVMAX to

send requisitions and receive results from IDEXX, IDEXX VetLab Station Network,

Antech/Zoasis and Marshfield. For more on using in-house blood analyzers, refer to the Blood

Analyzer chapter in this User Guide.

Requisition and Lab Results functions must be set up before the features can be used. It is

recommended that you review the contents of this Lab Requisitions and Lab Results chapter to

configure the features are applicable to your practice.

The Lab Result Setup Facility
Before any lab results can be sent to DVMAX, the lab result function must be properly

configured. 

To open the Lab Results Setup facility:

l From the File menu, choose Preferences. 

l From the DVMAX Preferences window, choose the Lab Result Setup tab.
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For In-House Analyzers, there can be only 2 instruments per terminal, so if you have more

than 2 instruments in use at your location, you will need to have additional terminals based on

the number of instruments you have running.

For Antech/Zoasis, Marshfield accounts, only 1 workstation needs to have Check for

Results details (folder path and time between checks) and account credentials entered, unless

your clinic has multiple external lab accounts for one or more of those providers. All stations

will, of course, be able to access the Labs log (requisition records and results records) and see

any returned results in patient records.

For IDEXX Reference Lab, only 1 workstation will need to be configured to check for

results. All stations will, of course, be able to access the Labs log (requisition records and

results records) and see any returned results in patient records.

About the Lab Result Setup Window
The Lab Result Setup window is divided into 4 main areas, In-Office Analyzer(s),

Antech/Zoasis, IDEXX, andMarshfield Labs set up.  You cannot send lab requisitions or

import lab results until you have properly configured the corresponding lab result features in

DVMAX.
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Setting Up an In-Office Blood Analyzer
The In-Office Analyzer feature lets you connect up to 2 in-house lab instruments per work-

station and configure DVMAX to allow test results from those instruments to be directed to the

associated patient file(s). A basic overview of the steps needed to enable the In-Office

Analyzer function is given below. Further details about each step are documented in related sec-

tions in this chapter.

For more on setting up the In-Office Analyzer, see the chapter on Blood Analyzers.

To configure DVMAX to receive results from an In-Office Analyzer:

l From the In-Office Analyzer 1 area, click Set Analyzer. This will open a

Select Analyzer window.

l From the Analyzer drop-down list, select the analyzer you have connected to

your system.  See Select an Analyzer for more detail on this step.

l From the Port drop-down list, select the computer port to which the analyzer is

connected. See Select a Port for more detail on this step.

l Click Select.
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l To enable DVMAX to receive results from the analyzer, click Start Analyzer

from the Lab Results Setup tab the In-Office Analyzer 1 area.  See Start the

In-Office Analyzer for more information.

l To configure a second in-house lab instrument, select Set Analyzer from the In-

Office Analyzer 2 area and repeat the steps listed above.

l Once you have configured the In-Office Analyzer setup, run the blood analysis

on the lab instrument(s) as usual. 

l Click OK from the Lab Results Setup tab to save settings in Preferences and

close the Preferences window.

l DVMAX’s lab results function automatically places lab results in the associated

patient file. Select the Lab icon from the Command Palette to review lab log

records for requisitions and results.

Once the In-Office Analyzer function has been set up, you do not need to set it up again,

unless you change analyzers or make other changes to the equipment. 

Select an In-Office Analyzer
The Select Analyzer window includes a list of all laboratory and blood analysis instruments that

are supported by DVMAX’s direct importing feature. This list may include instruments that are

not presently available in your office.

To select an analyzer:

l From the Select Analyzer window, select an analyzer from the Analyzer drop-

down list. 
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l With certain instruments, such as the Abaxis Vetscan HMT or Abaxis Vetscan

+ HMT, you may be asked to specify the time the interval at which the instru-

ment should be polled for results. In the Time Between Checks box, type a

value between 1 and 99 minutes.

Multiple Blood Analyzers for One Workstation
DVMAX allows you to have up to 2 analyzers active per workstation. If you want to use more

than 2 instruments for one workstation, you could switch between analyzers by adjusting the

Select Analyzer settings.

Where possible, the preferred alternative is to connect additional lab instruments to other work-

stations, making sure to configure each workstation according to the instrument(s) that are con-

nected to it.

Select a Port for the In-Office Blood Analyzer
The lab results will be set up to flow from the analyzer to a workstation via a cable or other con-

nection. The port is where the cable attached to the analyzer connects to the workstation. Most

computers have multiple ports (and types of ports), often in use for connections to equipment

such as printers, labelers and modems. 

You will need to identify the number of the port associated with the lab instrument connection. If

the wrong port is selected, lab result data cannot be sent to the workstation.

To select a port:

l Choose a port from the Port drop-down list.

l A port will not need to be specified for devices connected via network, such as

the IDEXX VetLab Station Network (where the VetLab is connected via Net-

work as opposed to a serial connection).
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Determining the Port Number for In-Office Analyzers
The Port drop-down list will display a number of choices for ports, but only one of those is the

actual port to which the lab instrument is connected. Here are two suggestions to help you deter-

mine the port number:

l Typically, the port number will be Com2. Try this option first. Select Com2 from

the drop-down menu; follow the rest of the setup instructions, then try running a

test.  If there is no data flow, try a different port.

-OR-

l If your workstation has USB-type ports, purchase a Keyspan Serial Port Con-

nection to USB Port conversion link. This is a piece of equipment that converts

a Serial Port connection (the most likely type of “plug” found at the end of the

cable running from the analyzer) to a USB Port connection. 

l Once this is hooked up, you can plug the instrument cable in to a USB port.  The

Keyspan connector has a built-in identification code (the P/N, found on the back

of the connector).

l The first few numbers of that P/N code will be listed on the drop-down menu,

making it easier to identify the proper port.

If you are using a serial to ethernet adapter, you will need to specify an IP address.  Contact

DVMAX Technical Support for assistance.

A port will not need to be specified for devices connected via network, such as the IDEXX

VetLab Station Network (where the VetLab is connected via Network as opposed to a serial con-

nection).

Confirm the In-Office Analyzer Settings
l Click Select to confirm the analyzer settings and close the Select Analyzer

dialog box.

-OR-
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l Click Clear Analyzer to remove the existing configuration and select a new

analyzer.  See Clear Analyzer for more details.

Start the In-Office Blood Analyzer
Once you have configured the In-Office Analyzer, you need to enable the function or turn it

“on”. To enable the flow of data from the analyzer to DVMAX:

l Click StartAnalyzer. Lab results from the attached analyzer(s) can now be

read by DVMAX.

The Start Analyzer and Stop Analyzer buttons will not start or stop the actual piece of lab

equipment you have connected to DVMAX. Your lab instruments may be on all the time, but

DVMAX will only accept results after the Start Analyzer button is clicked. Note that Stop

Analyzer is only available after Start Analyzer has been selected.

Stopping the Lab Results Flow for In-Office Analyzers
After Start Analyzer is selected, a Stop Analyzer button will be available. To turn off the In-

Office Analyzer function:

l Click Stop Analyzer. This will disable communication between the lab equip-

ment and the workstation.
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Clear the In-Office Analyzer Selection
You can clear the current analyzer setting from the Select Analyzer dialog box.

To clear the analyzer settings:

l From the Select Analyzer window, click Clear Analyzer. This will remove the

selected instrument and port settings.

If Start Analyzer has been selected, you must select Stop Analyzer before you can clear

settings.

Receiving and Saving In-Office Analyzer Lab Results
Lab results are sent to DVMAX Lab Log. Before you can receive results, be sure you have

done the following:

l You have properly set up the In-Office Analyzer(s).

l You have clicked Start Analyzer on the Lab Results Setup tab.

l You have run (or are running) an analysis on a lab instrument connected to your

workstation.

VetLab Active On Another Terminal
Only one terminal can be connected to a specific VetLab Station Network at one time. If you try

to connect to the same VetLab already running on another terminal, you will see the message

“VetLab is active on another terminal”.

VetLab HealthCheck Alert in Command Palette
If there is a VetLab HealthCheck timeout where the connection between DVMAX and the Vet-

Lab Station Network is interrupted, DVMAX will display an alert in the Command Palette. The

alert will say “VetLab HealthCheck TimeOut, Check Connections". Check your connection to

the VetLab Station Network.

Automatically Download Results from Antech/Zoasis
The Antech/Zoasis Lab Result function allows DVMAX to automatically read downloaded

Antech lab results from a specified folder and append the results to the appropriate patient rec-

ord.

To enable the lab results reader:

l Select Preferences from the File menu.

l From Preferences, select the Lab Results Setup tab.
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l In the Antech/Zoasis area, select Check for Results to enable the automatic

checking function.

l Type a number of minutes in the Check Every field. This tells DVMAX to

check the Antech/Zoasis Results folder at the specified interval.

l Type the path to the Antech/Zoasis results folder in the Path field, or click

Select Folder and select the Zoasis results folder from the directory.  DVMAX

will look for downloaded Antech/Zoasis lab results in this folder and place the

lab results in the appropriate patient record(s).

l If you would like the results to automatically download select the Automatically

Download Results check box.

l Enter the Zoasis ID, Username, Zip and Password

l Click OK from the Preferences tab to save your configuration.

l Quit and relaunch DVMAX.

Disable Checking for Antech/Zoasis Lab Results
To disable checking for lab results from the Zoasis folder:
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l Deselect Check for Results from the Antech/Zoasis area of the Lab Result

Setup tab under Preferences.

Automatically Download IDEXX Reference Lab Results
To configure DVMAX to automatically check for results and to enable the IDEXX requisition

submission features from IDEXX Reference Lab:

l Choose Preferences from the File menu.

l From Preferences, choose the Lab Result Setup tab.

l Use VC4 Lab Services will be selected by default. Use VC4 Lab Services

must be selected if you intend to make use of the IDEXX Lab Requisition fea-

tures in DVMAX. Contact DVMAX Technical Support with questions about

your IDEXX Reference Lab setup.

l Select Check for Results in the IDEXX Configuration section.

l Type a number of hours in the Check Every _ Hours field. The value must be a

whole number. DVMAX will not accept decimals in this field.

l Configure globally: For clinics using one IDEXX account, go to General Man-

agement -> Requisition Setup Wizard -> IDEXX to finish configuring

DVMAX to automatically send requisition and receive lab results. This permits

the credentials to be used by all terminals without having to enter the credentials

in every terminal. See Entering IDEXX Credentials for Lab Results and

Requisitions.

l Configure locally: If you your clinic actively uses more than one IDEXX

account, you may enter credentials on a per-terminal basis. The IDEXX cre-

dentials you enter on a terminal will only be used by that terminal. Local pref-

erences will override any global settings for this terminal. See Entering

IDEXX Credentials for Lab Results, Requisitions and VetConnect Plus.
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l Click OK to save your configuration.

l Quit and relaunch DVMAX.

Any changes you make in IDEXX Configuration will only take effect after DVMAX has

been restarted on the workstation.

DVMAX allows individual staff to attach their name to a requisition when submitting

IDEXX Reference Lab requisitions or to use the generic clinic name. For staff to use their

name when submitting an IDEXX Reference Lab requisition, they will need to type the staff

IDEXX User ID in the IDEXX Account field of the staff member from Section -> Patient

Codes -> Staff. Refer to the section in this chapter on Setting Up Requisitions for IDEXX

Reference Lab for more details.

If you have any questions about your IDEXX account, your VetConnect or your Vet-

Connect Plus credentials, please contact DVMAX Tech Support.

Entering IDEXX Credentials for Lab Results and Requisitions
The VC Agent and VetConnect credential fields must be completed before you can submit

IDEXX Reference Lab requisitions and receive IDEXX lab results. However, there are 2 dif-

ferent places where you could enter those credentials:  under Preferences -> Lab Result Setup

-> IDEXX or under General Management -> Requisition Setup Wizard -> IDEXX.  This

allows you to set your preferences globally or locally. Local preferences will override the global

preferences.

Global preferences: For clinics using a single IDEXX account, enter your account credentials

from General Management -> Requisition Setup Wizard -> IDEXX. This permits the
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credentials to be used by all terminals (for sending lab requisitions) without having to enter the

credentials in every terminal.

Local preferences: The VC Agent and VetConnect credential fields under Preferences -> Lab

Result Setup should only be filled in if your clinic actively uses multiple IDEXX accounts. The

IDEXX credentials you enter on a terminal will only be used by that terminal.

To enter credentials:

l VC Agent User ID - To use the same IDEXX account credentials for all ter-

minals, enter your VC Agent User ID credentials under General Management

-> Requisition Setup Wizard -> IDEXX. If this terminal will use a unique

IDEXX account, type the IDEXX VC Agent User ID in the VC Agent User

ID field under Preferences.

l VC Agent Password - To use the same IDEXX account credentials for all ter-

minals, enter your VC Agent Password credentials under General Man-

agement -> Requisition Setup Wizard -> IDEXX. If this terminal will use a

unique IDEXX account, type the IDEXX VC Agent Password in the VC Agent

Password field under Preferences.

l VetConnect User ID - To use the same IDEXX account credentials for all ter-

minals, enter your VetConnect User ID credentials under General Man-

agement -> Requisition Setup Wizard -> IDEXX. If this terminal will use a

unique IDEXX account, type your IDEXX VetConnect User ID in the Vet-

Connect User ID field under Preferences.

l VetConnect Password - To use the same IDEXX account credentials for all

terminals, enter your VetConnect Password credentials under General Man-

agement -> Requisition Setup Wizard -> IDEXX. If this terminal will use a

unique IDEXX account, type your IDEXX VetConnect Password in the Vet-

Connect Password field under Preferences.

Automatically Download Marshfield Labs Results
The Marshfield Labs function allows DVMAX to automatically read downloaded Marshfield

Lab results from a specified folder and append the results to the appropriate patient record.

To enable the Marshfield lab results reader:

l Select Preferences from the File menu.

l From Preferences, select the Lab Results Setup tab.

l In the Marshfield Labs area, select Check for Results.

l Type a number of minutes in the Check Every field.  This tells DVMAX to

check the Results folder at the specified interval.
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l Type the path to the Marshfield Labs results folder in the Path field, or click

Select Folder and select the Marshfield Labs results folder from the directory.

DVMAX will look for downloaded Marshfield Labs results in this folder and

place the lab results in the appropriate patient record(s).

l Click OK to enable checking of Marshfield Labs lab results.

l Quit and relaunch DVMAX.

Requisition Setup Wizard
The DVMAX Requisitions Setup Wizard, found under General Management -> Utilities, lets

you configure requisition setup for Cubex, Antech/Zoasis, IDEXX Reference Lab and VetLab

Station Network. The Setup Wizard guides you in the process of linking DVMAX Bill Item

Codes to Requisition Codes, so that each time a particular Bill Item Code is applied (either

because it is linked to an MRE added to a patient record or because the Bill Item is added to an

invoice), the associated requisition is generated.

In general, to set up requisitions for a provider, you will need to:

1. Select a Provider from the Provider drop down list.

2. Make the provider active by selecting This Provider Is Active.

3. Make sure Requisition Codes are downloaded from the selected provider.

4. Link Requisition Codes to DVMAX Bill Codes (this allows applied requisition codes to

have an associated charge, as determined by the Bill Code).

5. Link DVMAX Species Codes and Breed Codes to provider Species Codes and Breed

Codes, as applicable.

6. Add or build Panels (groups of requisition codes, similar to super items), as needed. The

Provider VetLab Station Network only uses Panels in requisitions.

Editing Requisition Codes
Depending on the provider, some requisition codes should never be edited. The option to edit req-

uisition codes is available for certain providers and should be enabled by default. Please contact

DVMAX Technical Support if you have any questions concerning the ability to edit existing

codes.

Setting Up Requisitions for the VetLab Station Network
The Requisition Setup Wizard lets you set up requisition functionality to submit requisitions from

DVMAX to the VetLab Station Network. To use this feature, the VetLab Station must be con-

nected to DVMAX via network (not serial connection). See the chapter Blood Analyzers for fur-

ther information. 

To set up requisition submission for the VetLab Station Network:

l From the Section menu, select General Management -> Utilities.

l Choose Requisitions Setup Wizard.
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l From the Provider drop-down menu, choose VetLab.

l If you wish to make this your default requisitions provider, click Default. From

the Confirm dialog, click OK to set the provider as default. The Requisition Wiz-

ard will open to the VetLab panel if you set VetLab as the default provider.

Note that you can use any of the providers you have configured regardless of which pro-

vider is set as the Default. The Requisition Wizard will default to the VetLab panel when

opened if you set VetLab as the default provider.

l Select This Provider Is Active to make the provider, VetLab, active. If the pro-

vider is not active, you cannot use the requisition features in DVMAX for this

provider.

l Select Send Census Data to VetLab Station to enable automatic submission of

patient census data to the VetLab Station. You can select any or all of the

options below to prompt DVMAX to send census data to the VetLab.

l From the Instruments list, select Active to identify the in-house instruments cur-

rently connected to the VetLab Station Network.

l From the Requisition Codes tab, you can view VetLab requisition codes

(assays) and assign a code to one or more instruments. You cannot add req-

uisition codes to the list.
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l From the Billing Codes tab, link DVMAX Bill Codes with Panels. A Panel is a

set of one or more requisition codes. This step is mandatory in order to accu-

rately capture charges associated with submitted requisitions. Double click a rec-

ord to view and edit.

Note that it is also possible to add or edit which Panel is linked to a Bill Item Code directly

from the Bill Item record (Section -> Inventory Management -> Bill Items)

l From the Species Codes tab, link DVMAX Species Codes with VetLab Species

Codes. Double Click a record to view details and edit.
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l From the VetLab Panels tab, add, edit and view Panels. A Panel is a set of one

or more VetLab Requisition Codes (assays). Panels are linked to Bill Codes.

Send Census Data to VetLab
You can send census data to the VetLab Station Network automatically or manually. To send

patient census data automatically, first select Send Census Data to VetLab Station from the

Requisition Wizard VetLab Setup Info tab. Then, selecting one or more of the following will

automatically send census data from DVMAX to the VetLab when the related action is

engaged:

l When Patient is in Hospital – Send Census data when the patient is marked as

In Hospital.

l When patient invoice is started – Send Census data when an invoice is

started or opened for a specified patient. You should only select this option if

neither of the other 2 options is selected.

l When patient visit is active – Send Census data when a patient visit is active

(when a patient is marked as Checked In for an appointment. See the Appoint-

ments chapter for more details on the Visits feature).

You can also manually send census data to the VetLab Station by clicking the VetLab button

from the Patient General Info tab of a patient record and clicking Add.
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Selecting Active Instruments
The Instrument List includes all blood analyzers/lab instruments supported by DVMAX. Select

the Active checkbox beside each of the instruments that are used by your clinic and currently

connected to a workstation.

Update Codes for VetLab
From time to time, the VetLab Directory of Services may add or remove requisition codes.

When you click Update Codes, DVMAX checks the VetLab Directory of Services for updates

to Requisition Codes (Assay List), provider Species Codes and Panels. To update codes:

l From the VetLab Provider dialog, click Update Codes.

l From the Confirm dialog, click OK to proceed or Cancel to stop the update.

l This process may take a few minutes.

The Update Codes process may remove requisition codes that are already linked to Bill

Items. See Deleted Codes List After Running Update Codes for more on managing deleted

codes.

VetLab Requisition Codes
The VetLab Requisition Codes tab provides a list of requisition codes (assays). These requisition

codes cannot be edited, but you can view the details of the code and assign specific lab instru-

ments to the selected code.  VetLab requisition codes are used to build VetLab Panels, which

are in turn linked to DVMAX Bill Codes.

Filter the List of VetLab Requisition Codes
Use the Filter field at the bottom of the Requisition Codes tab to filter the list of codes. In the

Filter field, type a full or partial code, name or description. The list will be constrained by what

you type. 
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Assign Instruments to VetLab Requisition Codes
You can assign VetLab requisition codes, or assays, to selected instruments. This can help you

identify which in-house instrument(s) you associate with a specified assay, and assist in creating

Panels. This can also help when constraining the list of VetLab requisition codes or panels. To

assign instruments to a code:

l From the Requisition Codes list, double click on a code.

l From the Add/Edit Requisition Codes dialog, click in the column beside an instru-

ment to select it. If there is an asterisk beside the instrument, it is selected.

l Click again to deselect.

Show Only Requisition Codes Assigned to Instruments
If you have assigned instruments to VetLab requisition codes, you can click Only Include

Codes That Are Assigned to Instruments to show only those requisition codes that are asso-

ciated with at least one in-house analyzer. This is helpful in constraining the list to only codes

that you use with analyzers in your clinic. See Assign Instruments to VetLab Requisition

Codes for more details.
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VetLab Requisition Panels
A Panel is a set of one or more requisition codes (or assays) grouped together under a Panel

Code and Name. Some panels are provided by the VetLab Station, but you can create and edit

your own panels. For Provider VetLab, only Panels can be linked to Bill Codes. Individual req-

uisition codes cannot be linked to Bill Codes. However, you can create a Panel with only one

associated requisition item or assay.

Create VetLab Panels
To create or edit a VetLab Panel:

l From the Requisition Setup Wizard, select Provider VetLab.

l Choose the Panels tab.

l Click Add from the list of Panels.

l In the Code field, type a brief code for the Panel.

l In the Name field, give a descriptive name to the Panel. The Panel Name dis-

plays in the Requisition window when a requisition is added to a patient record.

l Select Expand Items if desired. By default, when a Panel is added to a req-

uisition, only the Panel Name displays in the requisition window. To display all

of the assays associated with the panel in the Requisition window when this

Panel is added to a requisition, select Expand Items.

l Add items to the Panel. Click Add to add Requisition Codes, or assays, to the

Panel. To remove or delete an item from the Panel, select the item and click

Delete. See Add Items to a VetLab Panel for more information.

l Associate a Panel with one or more in-house lab instruments, if desired. From

the Instruments List area on the right of the Edit dialog, click in the column

beside an instrument to select it. If there is an asterisk beside the instrument, it

is selected. Using this feature allows you to assign instruments to a Panel. See

Assign Instruments to VetLab Panels.

l Click OK to save the Panel.
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Add Items to a VetLab Panel
A Requisition Code pick list displays when you click Add from the Edit Requisition Panel

dialog. You can select an item from the list, or type a VetLab Requisition Code or partial code

in the Linked Code field to filter the list. Select Only Include Codes That Are Assigned to

Instruments to constrain the list to codes that have been assigned to your in-house lab instru-

ments (See Assign Instruments to VetLab Requisition Codes). To select an item:

l Type a code in the Linked Code field, or click a code in the list to highlight.

l Click Select. The item will be added to the Panel.

View or Edit VetLab Panels
To view or edit a VetLab Panel:

l From the Requisition Setup Wizard, select Provider VetLab.

l Choose the Panels tab.

l Use the Filter field to constrain the list by the value you type in the field.

l Select Only Include Panels That Are Assigned to Instruments to constrain

the list of Panels to those assigned to one or more in-house analyzers.

l From the list of Panels, double click on a Panel to view or edit.

l From the Edit Requisition Panel dialog, click Add to add new requisition codes

to the Panel, or select an item on the list and click Delete to remove the item

from the Panel.

Delete VetLab Panels
To delete a VetLab Panel:
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l From the Requisition Setup Wizard, select Provider VetLab.

l Choose the Panels tab.

l Click to select a Panel from the list.

l Click Delete to delete the Panel.

Duplicate or Copy a Panel
You can duplicate or copy an existing VetLab Panel using the Duplicate button. To duplicate a

panel:

From the list of panels, click to select/highlight a panel.

Click Duplicate.

A duplicate of the panel will be added to the Panels list with the same name as the original panel

with the words “Copy of” at the beginning of the panel name. For example, if you created a

duplicate of Panel “Chem 15”, the duplicate would be called “Copy of Chem 15”.

Filter the List of VetLab Panels
Use the Filter field at the bottom of the Panels tab to filter the list of panels. In the Filter field,

type a full or partial code, name or description. The list will be constrained by what you type. 

Assign Instruments to VetLab Panels
You can assign VetLab Panels to selected instruments. This can be a useful tool in remembering

to use the appropriate instrument for a specified Panel and in filtering the list of Panels. To

assign instruments to a Panel:

l From the Panels list, double click on a Panel.

l From the Edit Requisition Panel dialog Instruments List area, click in the column

beside an instrument to select it. If there is an asterisk beside the instrument, it

is selected.

l Click again to deselect.

Show Only VetLab Panels Assigned to Instruments
If you have assigned instruments to VetLab Panels, you can click Only Include Codes That

Are Assigned to Instruments to show only those Panels that are associated with at least one

in-house analyzer. This is helpful in constraining the list to only Panels that you use with

analyzers in your clinic. See Assign Instruments to VetLab Requisition Codes for more

details.

DVMAX Billing Codes and VetLab
DVMAX Bill Items are linked to MRCs, so that every time an MRE is added to a patient rec-

ord, the associated charge is added to the invoice. If the Bill Item is also linked to a provider req-

uisition, then the charges associated with the requisition will be captured whenever the
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associated MRE is applied to a patient record or bill item is added to an invoice.  In the case of

VetLab, Bill Codes are linked to requisition Panels.

To view Bill Codes:

l From the VetLab Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record to view or edit.

To add Bill Item records, go to Section -> Inventory Management -> Bill Items

View Top Selling Bill Code Items Linked to VetLab Panels

You can constrain the Bill Items list by top selling bill items. To constrain the list, select Top

Selling Only.

Linking DVMAX Bill Codes to VetLab Requisition Panels
A Panel must be linked to a Bill Code in order for the correct charge to be added to an invoice

whenever the requisition is created, either by adding the Bill Item to an invoice directly or by

adding the MRE linked to the Bill Item to a patient record. For the provider VetLab, only Panels

can be linked to Bill Codes, individual requisition codes cannot. However, you can create a

Panel with only one associated requisition item or assay.

To link a Bill Code to a VetLab requisition Panel:

l From the VetLab Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.
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l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record.

l From the Select Requisition Panel dialog, choose a Panel to link to the Bill Item.

Type a code in the Linked Code field, or click a code in the list to highlight.

l Click Select. The Panel will be linked to the specified Bill Code.

Linking DVMAX Species Codes to VetLab Species Codes
The species codes that DVMAX uses to identify animal species may not be the same one used

by all in-house lab instruments and external lab providers. Linking the DVMAX species code to

the Provider code permits more accurate requisition information to flow from DVMAX to the

Provider and back.

l From the VetLab Species tab, double click a DVMAX species record you want

to associate with a VetLab species code.
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l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Species List, click to select the VetLab species to associate with the

DVMAX species record.

l Click OK to save the selection.

The DVMAX Species Code record is automatically updated when you link the DVMAX spe-

cies code with the Provider code in the Requisition Wizard.

Setting Up Requisitions for IDEXX Reference Lab
The Requisition Setup Wizard lets you set up requisition functionality to submit requisitions from

DVMAX to the IDEXX Reference Lab. To set up requisition submission for the IDEXX Ref-

erence Lab:

l From the Section menu, select General Management -> Utilities.

l Choose Requisitions Setup Wizard.
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l From the Provider drop-down menu, choose IDEXX.

l If you wish to make this your default requisitions provider, click Default. From

the Confirm dialog, click OK to set the provider as default. The Requisition Wiz-

ard will open to the IDEXX tab if you set IDEXX as the default provider.

Note that you can use any of the providers you have configured regardless of which pro-

vider is set as the Default. The Requisition Wizard will default to IDEXX tab when opened if

you set IDEXX as the default provider.

DVMAX allows individual staff to use their own IDEXX credentials when submitting

IDEXX Reference Lab requisitions or to use the credentials defined under the Requisition Setup

Wizard.

l Select This Provider Is Active to make the provider, IDEXX, active. If the pro-

vider is not active, you cannot use the requisition features in DVMAX for this

provider.

l Select Requisitions Can Be Canceled if this provider permits the Canceling of

Requisitions and your clinic wishes to access this option.

l Enter your IDEXX account credentials. These credentials will be applied glob-

ally, so that all terminals can make use of the requisition features. See Entering

IDEXX Credentials for Lab Results and Requisitions.

l From the Requisition Codes tab, you can view the list of IDEXX requisition

codes. You cannot add or edit requisition codes on this list.

l From the Billing Codes tab, link DVMAX Bill Codes with IDEXX Requisition

Codes. This step is mandatory in order to accurately capture charges associated

with submitted requisitions. Double click a record to view and edit.
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Note that it is also possible to add or edit which Requisition Code is linked to a Bill Item

Code directly from the Bill Item record (Section -> Inventory Management -> Bill Items)

l From the Species Codes tab, link DVMAX Species Codes with IDEXX Spe-

cies Codes. Double Click a record to view details and edit.

l From the Breed Codes tab, link DVMAX Breed Codes with IDEXX Breed

Codes. Double Click a record to view details and edit.

l From the IDEXX Panels tab, add, edit and view Panels. A Panel is a set of one

or more Requisition Codes.

l Link Panels to Bill Items if you have Panels you intend to use.

Update Codes for IDEXX
From time to time, the IDEXX Reference Lab provider may add or remove requisition codes.

When you click Update Codes, DVMAX checks for updates to Requisition Codes, provider Spe-

cies Codes, provider Breed codes.

To update codes:

l From the IDEXX Provider dialog, click Update Codes.

l From the Confirm dialog, click OK to proceed or Cancel to stop the update.

l This process may take a few minutes.

The Update Codes process may remove requisition codes that are already linked to Bill

Items. See Deleted Codes List After Running Update Codes for more on managing deleted

codes.

Deleted Codes List After Running Update Codes
When you click Update Codes, you update the list of all existing IDEXX requisition codes, spe-

cies codes and breed codes.  Any older requisition codes that are no longer used will be removed
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from the list. DVMAX will provide you with a list of deleted requisition codes and modified or

deleted requisition panels. Typically, the list of items will be very small, if any.

The deleted codes may leave some of the links between Bill Codes and Requisition Codes

incomplete, so you may wish to review the list of codes. To print a list of the deleted codes,

click Print on the Deleted Codes dialog.

If a requisition code that was linked to a bill item is deleted, the next time you apply that bill

item (either by adding an MRE linked to the bill item to Patient History or by adding the bill item

to an invoice), you may see an alert indicating this. You will need to review the bill code and

linked requisition code either from the Billing Codes tab in the Requisition Setup Wizard or

from Inventory Management -> Bill Items.

IDEXX Requisition Codes
The IDEXX Requisition Codes tab provides a list of requisition codes from IDEXX. These req-

uisition codes cannot be edited.

Filter the List of IDEXX Requisition Codes
Use the Filter field at the bottom of the Requisition Codes tab to filter the list of codes. In the

Filter field, type a full or partial code, name or description. The list will be constrained by what

you type. 

DVMAX Bill Item Codes and IDEXX Reference Lab
DVMAX Bill Items are linked to MRCs, so that every time an MRE is added to a patient rec-

ord, the associated charge is added to the invoice. If the Bill Item is also linked to an IDEXX
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Requisition Code, then the charges associated with the requisition will be captured whenever the

associated MRE is applied to a patient record or bill item is added to an invoice.  In the case of

IDEXX Reference Lab, bill codes are linked to requisition codes. You cannot add Bill Item rec-

ords from the Requisition Wizard. To add Bill Item records, go to Section -> Inventory Man-

agement -> Bill Items.

To view Bill Codes:

l From the IDEXX Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record to view or edit.

View Top Selling Bill Code Items Linked to IDEXX Requisition Codes
You can constrain the Bill Items list by top selling bill items. To constrain the list, select Top

Selling Only.

Linking DVMAX Bill Codes to IDEXX Requisition Codes
An IDEXX Requisition Code must be linked to a Bill Code in order for the correct charge to be

added to an invoice whenever the IDEXX requisition is created, either by adding the Bill Item to

an invoice directly or by adding the MRE linked to the Bill Item to a patient record. For the pro-

vider IDEXX, Requisition Codes must be linked to Bill Codes.

To link a Bill Code to an IDEXX requisition:

l From the IDEXX Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record.

l From the Select Requisition Code dialog, choose a Requisition Code to link to

the Bill Item. Type a code in the Linked Code field, or click a code in the list to

highlight.

l Click Select. The Requisition Code will be linked to the specified Bill Code.

Linking DVMAX Species Codes to IDEXX Species Codes
The species codes that DVMAX uses to identify animal species may not be the same one used

by all in-house lab instruments and external lab providers. Linking the DVMAX species code to
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the Provider code permits more accurate requisition information to flow from DVMAX to the

Provider and back.

l From the IDEXX Species tab, double click a DVMAX species record you want

to associate with an IDEXX species code.

l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Species List, click to select the IDEXX species to associate with the

DVMAX species record.

l Click OK to save the selection.

The DVMAX Species Code record is automatically updated when you link the DVMAX spe-

cies code with the Provider code in the Requisition Wizard.

Linking DVMAX Breed Codes to IDEXX Breed Codes
The breed codes that DVMAX uses to identify animal breeds may not be the same one used by

all external lab providers. Linking the DVMAX breed code to the Provider code permits more

accurate requisition information to flow from DVMAX to the Provider and back.

l From the IDEXX Breed tab, double click a DVMAX breed record you want to

associate with the IDEXX breed code.

l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Breeds List, click to select the IDEXX breed to associate with the

DVMAX breed record.

l Click OK to save the selection.

The DVMAX Breed Code record is automatically updated when you link the DVMAX breed

code with the Provider code in the Requisition Wizard.

Add and Edit IDEXX Requisition Panels
A panel is a set of one or more requisition codes grouped together under a Panel Code and

Name. Some providers have pre-defined panels, but you can create and edit your own panels.

To create or edit an IDEXX Panel:

l From the Requisition Setup Wizard, select Provider IDEXX.

l Choose the Panels tab.

l Click Add from the list of Panels.

l In the Code field, type a brief code for the Panel.

l In the Name field, give a descriptive name to the Panel.

l Select Expand Items to display all of the requisition items in the panel when

this is added to a requisition, otherwise, only the Panel Code will display in the

requisition window.
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l Click Add to add Requisition Codes to the Panel. To remove or delete an item

from the Panel, select the item and click Delete.

l Click OK to save the Panel. The Panel Code will be added to the list of req-

uisition codes.

l Once you have created the Panel, you must link the Panel Code to a Bill item.

See Linking DVMAX Bill Codes to Requisition Codes for more information.

Linking DVMAX Bill Codes to IDEXX Requisition Panels
A Panel must be linked to a Bill Code in order for the correct charge to be added to an invoice

whenever the requisition is created, either by adding the Bill Item to an invoice directly or by

adding the MRE linked to the Bill Item to a patient record. For the provider IDEXX, both individ-

ual requisition codes as well as Panels must be linked to Bill Codes.

Once you have created a Panel (see View and Edit IDEXX Requisition Panels), you link the

IDEXX Panel Code to a Bill Item in the same way as you link any other Requisition Code to a

DVMAX bill item.

To link a Bill Code to an IDEXX Panel:

l From the IDEXX Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click the Bill Item record you want to link to a Panel. A Select Req-

uisition Code pick list will display.

l From the Select Requisition Code pick list, choose the Panel to link to the Bill

Item. Type the Panel code in the Linked Code field, or click the Panel code

from the list to highlight.

l Click Select. The Panel code will be linked to the specified Bill Code.

Setting Up Requisitions for Cubex
The Requisition Setup Wizard lets you set up requisition functionality to submit requisitions from

DVMAX to your Cubex Cabinet. DVMAX Technical Support should assist you with

DVMAX/Cubex integration.
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l It is very important that Cubex be involved prior to the setup of

DVMAX/Cubex integration, as they should clear and turn off the Cabinet's

queuing of orders until AFTER the configuration is done. Failure to do will

result in DVMAX collecting OLD ordered information and populating it onto

invoices!

To set up requisition submission for Cubex:

l From the Section menu, select General Management -> Utilities.

l Choose Requisitions Setup Wizard.

l From the Provider drop-down menu, choose Cubex.

l If you wish to make this your default requisitions provider, click Default. From

the Confirm dialog, click OK to set the provider as default. The Requisition Wiz-

ard will open to the Cubex tab if you set Cubex as the default provider.

Note that you can use any of the providers you have configured regardless of which pro-

vider is set as the Default. The Requisition Wizard will default to the Cubex tab when opened if

you set Cubex as the default provider.

l Select This Provider Is Active to make the provider, Cubex, active. If the pro-

vider is not active, you cannot use the requisition features in DVMAX for this

provider.

l Enter your Cubex account credentials, including User ID, Password and Site

ID. These credentials will be applied globally, so that all terminals can make

use of the requisition features.
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l From the Requisition Codes tab, you can view the list of Cubex requisition

codes.

l From the Billing Codes tab, link DVMAX Bill Codes with Cubex Requisition

Codes. This step is mandatory in order to accurately capture charges associated

with submitted requisitions. Double click a record to view and edit.

Note that it is also possible to add or edit which Requisition Code is linked to a Bill Item

Code directly from the Bill Item record (Section -> Inventory Management -> Bill Items)

l Cubex does not use Species Codes or Breed Codes, so the associated tabs are

blank.

l Cubex requisition setup does not use the Panels tab, so the Panels tab is blank.

Update Codes for Cubex
From time to time, the Cubex provider may add or remove requisition codes. When you click

Update Codes, DVMAX checks for updates to Requisition Codes.

To update codes:

l From the Cubex Provider dialog, click Update Codes.

l From the Confirm dialog, click OK to proceed or Cancel to stop the update.

l This process may take a few minutes.

The Update Codes process may remove requisition codes that are already linked to Bill

Items. See Deleted Codes List After Running Update Codes for more on managing deleted

codes.

Deleted Cubex Codes List After Running “Update Codes”
When you click Update Codes, you update the list of all existing Cubex requisition codes.  Any

older requisition codes that are no longer used will be removed from the list. DVMAX will pro-

vide you with a list of deleted requisition codes and modified or deleted requisition panels. Typ-

ically, the list of items will be very small, if any.
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The deleted codes may leave some of the links between Bill Codes and Requisition Codes

incomplete, so you may wish to review the list of codes. To print a list of the deleted codes,

click Print on the Deleted Codes dialog.

If a requisition code that was linked to a bill item is deleted, the next time you apply that bill

item (either by adding an MRE linked to the bill item to Patient History or by adding the bill item

to an invoice), you may see an alert indicating this. You will need to review the bill code and

linked requisition code either from the Billing Codes tab in the Requisition Setup Wizard or

from Inventory Management -> Bill Items.

Cubex Requisition Codes
The Cubex Requisition Codes tab provides a list of requisition codes from Cubex. These req-

uisition codes cannot be edited.

Filter the List of Cubex Requisition Codes
Use the Filter field at the bottom of the Requisition Codes tab to filter the list of codes. In the

Filter field, type a full or partial code, name or description. The list will be constrained by what

you type. 

DVMAX Bill Item Codes and Cubex
DVMAX Bill Items are linked to MRCs, so that every time an MRE is added to a patient rec-

ord, the associated charge is added to the invoice. If the Bill Item is also linked to a Cubex Req-

uisition Code, then the charges associated with the requisition will be captured whenever the

associated MRE is applied to a patient record or bill item is added to an invoice.  In the case of

Cubex, bill codes are linked to requisition codes. You cannot add Bill Item records from the Req-

uisition Wizard. To add Bill Item records, go to Section -> Inventory Management -> Bill

Items.

To view Bill Codes:

l From the Cubex Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record to view or edit.
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View Top Selling Bill Code Items Linked to Cubex Requisition Codes
You can constrain the Bill Items list by top selling bill items. To constrain the list, select Top

Selling Only.

Linking DVMAX Bill Codes to Cubex Requisition Codes
A Cubex Requisition Code must be linked to a Bill Code in order for the correct charge to be

added to an invoice whenever the Cubex requisition is created, either by adding the Bill Item to

an invoice directly or by adding the MRE linked to the Bill Item to a patient record. For the pro-

vider Cubex, Requisition Codes must be linked to Bill Codes.

To link a Bill Code to a Cubex requisition:

l From the Cubex Provider section of the Requisition Setup Wizard, select the

Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record.

l From the Select Requisition Code dialog, choose a Requisition Code to link to

the Bill Item. Type a code in the Linked Code field, or click a code in the list to

highlight.

l Click Select. The Requisition Code will be linked to the specified Bill Code.

Setting Up Requisitions for Antech/Zoasis
The Requisition Setup Wizard lets you set up requisition functionality to create and print req-

uisitions from DVMAX to send to Antech/Zoasis. To set up requisition submission for the

Antech/Zoasis:

l From the Section menu, select General Management -> Utilities.

l Choose Requisitions Setup Wizard.
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l From the Provider drop-down menu, choose Antech/Zoasis.

l If you wish to make this your default requisitions provider, click Default. From

the Confirm dialog, click OK to set the provider as default. The Requisition Wiz-

ard will open to the Antech/Zoasis tab if you set Antech/Zoasis as the default

provider.

Note that you can use any of the providers you have configured regardless of which provider

is set as the Default. The Requisition Wizard will default to Antech/Zoasis tab when opened if

you set Antech/Zoasis as the default provider.

l Select This Provider Is Active to make the provider, Antech/Zoasis, active. If

the provider is not active, you cannot use the requisition features in DVMAX for

this provider.

l The Requisitions Can Be Canceled option is not available for Antech/Zoasis.

l In the Antech Account Number field, type your Antech account number. This

information is needed to allow you to use DVMAX to generate Antech/Zoasis

requisitions.

l In the Zoasis ID field, type your Zoasis ID. This information is needed to allow

you to use DVMAX to generate Antech/Zoasis requisitions.

l From the Requisition Codes tab, you can view the list of Antech/Zoasis req-

uisition codes. You cannot add or edit requisition codes on this list.

l From the Billing Codes tab, link DVMAX Bill Codes with Antech/Zoasis Req-

uisition Code. This step is mandatory in order to accurately capture charges asso-

ciated with submitted requisitions. Double click a record to view and edit.
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Note that it is also possible to add or edit which Requisition Code is linked to a Bill Item

Code directly from the Bill Item record (Section -> Inventory Management -> Bill Items)

l From the Species Codes tab, link DVMAX Species Codes with Antech/Zoasis

Species Codes. Double Click a record to view details and edit.

l From the Breed Codes tab, link DVMAX Breed Codes with Antech/Zoasis

Breed Codes. Double Click a record to view details and edit.

l From the Antech/Zoasis Panels tab, add, edit and view Panels. A Panel is a set

of one or more Requisition Codes.

Update Codes for Antech/Zoasis
From time to time, the provider may add or remove requisition codes. When you click Update

Codes, DVMAX checks for updates to Requisition Codes, provider Species Codes, provider

Breed codes.

To update codes:

l From the Antech/Zoasis Provider dialog, click Update Codes.

l From the Confirm dialog, click East orWest to proceed, or click Cancel to stop

the update.

l This process may take a few minutes.

Deleted Codes List After Running Update Codes
When you click Update Codes, you update the list of all existing Antech/Zoasis requisition

codes, species codes and breed codes.  Any older requisition codes that are no longer used will

be removed from the list. DVMAX will provide you with a list of deleted requisition codes and

modified or deleted requisition panels. Typically, the list of items will be very small, if any.

The deleted codes may leave some of the links between Bill Codes and Requisition Codes incom-

plete, so you may wish to review the list of codes. To print a list of the deleted codes, click

Print on the Deleted Codes dialog.

If a requisition code that was linked to a bill item is deleted, the next time you apply that

bill item (either by adding an MRE linked to the bill item to Patient History or by adding the bill

item to an invoice), you may see an alert indicating this. You will need to review the bill code

and linked requisition code either from the Billing Codes tab in the Requisition Setup Wizard

or from Inventory Management -> Bill Items.
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Antech/Zoasis Requisition Codes
The Antech/Zoasis Requisition Codes tab provides a list of requisition codes from Antech/Zoa-

sis. These requisition codes cannot be edited.

Filter the List of Antech/Zoasis Requisition Codes
Use the Filter field at the bottom of the Requisition Codes tab to filter the list of codes. In the

Filter field, type a full or partial code, name or description. The list will be constrained by what

you type. 

DVMAX Bill Item Codes and Antech/Zoasis
DVMAX Bill Items are linked to MRCs, so that every time an MRE is added to a patient rec-

ord, the associated charge is added to the invoice. If the Bill Item is also linked to an

Antech/Zoasis Requisition Code, then the charges associated with the requisition will be cap-

tured whenever the associated MRE is applied to a patient record or bill item is added to an

invoice.  In the case of Antech/Zoasis, bill codes are linked to requisition codes.

Note, you cannot add Bill Item records from the Requisition Wizard. To add Bill Item records,

go to Section -> Inventory Management -> Bill Items.

To view Bill Codes:

l From the Antech/Zoasis Provider under the Requisition Setup Wizard, select

the Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record to view or edit.

View Top Selling Bill Code Items Linked to Antech/Zoasis Panels
You can constrain the Bill Items list by top selling bill items. To constrain the list, select Top

Selling Only.

Linking Bill Codes to Antech/Zoasis Requisition Codes
A Requisition Code must be linked to a Bill Code in order for the correct charge to be added to

an invoice whenever the Antech/Zoasis requisition is created, either by adding the Bill Item to

an invoice directly or by adding the MRE linked to the Bill Item to a patient record. For the pro-

vider Antech/Zoasis, Requisition Codes must be linked to Bill Codes.

To link a Bill Code to an Antech/Zoasis requisition Panel:
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l From the Antech/Zoasis Provider section of the Requisition Setup Wizard,

select the Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click a record to select it and open the Requisition Code pick list.

l From the Select Requisition Code pick list, choose a Requisition Code to link to

the Bill Item. Type a code in the Linked Code field, or click a code in the list to

highlight.

l Click Select. The Requisition Code will be linked to the specified Bill Code.

Linking DVMAX Species Codes to Antech/Zoasis Species Codes
The species codes that DVMAX uses to identify animal species may not be the same one used

by all in-house lab instruments and external lab providers. Linking the DVMAX species code to

the Provider code permits more accurate requisition information to flow from DVMAX to the

Provider and back.

l From the Antech/Zoasis Species tab, double click a DVMAX species record

you want to associate with an Antech/Zoasis species code.

l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Species List, click to select the Antech/Zoasis species to associate

with the DVMAX species record.

l Click OK to save the selection.

The DVMAX Species Code record is automatically updated when you link the DVMAX spe-

cies code with the Provider code in the Requisition Wizard.

Linking DVMAX Breed Codes to Antech/Zoasis Breed Codes
The breed codes that DVMAX uses to identify animal breeds may not be the same one used by

all external lab providers. Linking the DVMAX breed code to the Provider code permits more

accurate requisition information to flow from DVMAX to the Provider and back.

l From the Antech/Zoasis Breed tab, double click a DVMAX breed record you

want to associate with the Antech/Zoasis breed code.

l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Breeds List, click to select the Antech/Zoasis breed to associate with

the DVMAX breed record.

l Click OK to save the selection.
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The DVMAX Breed Code record is automatically updated when you link the DVMAX breed

code with the Provider code in the Requisition Wizard.

View and Edit Antech/Zoasis Requisition Panels
A panel is a set of one or more requisition codes grouped together under a Panel Code and

Name. Some providers have pre-defined panels, but you can create and edit your own panels.

Like Requisition Codes, Panel Codes must be linked to Bill Item Codes.

To create or edit an Antech/Zoasis Panel:

l From the Requisition Setup Wizard, select Provider Antech/Zoasis.

l Choose the Panels tab.

l Click Add from the list of Panels.

l In the Code field, type a brief code for the Panel.

l In the Name field, give a descriptive name to the Panel.

l Select Expand Items to display all of the requisition items in the panel when

this is added to a requisition, select Expand Items.

l Click Add to add Requisition Codes to the Panel. To remove or delete an item

from the Panel, select the item and click Delete.

l Click OK to save the Panel. Once you have created the Panel, you must link the

Panel Code to a Bill item. See Linking DVMAX Bill Codes to Antech/Zoasis

Requisition Codes for more information.

Linking DVMAX Bill Codes to Antech/Zoasis Requisition Panels
A Panel must be linked to a Bill Code in order for the correct charge to be added to an invoice

whenever the requisition is created, either by adding the Bill Item to an invoice directly or by

adding the MRE linked to the Bill Item to a patient record. For the provider Antech/Zoasis, both

individual requisition codes as well as Panels must be linked to Bill Codes.

Once you have created a Panel (see View and Edit Antech/Zoasis Requisition Panels), you

link the Antech/Zoasis Panel Code to a Bill Item in the same way as you link any other Req-

uisition Code to a DVMAX bill item.

To link a Bill Code to an Antech/Zoasis Panel:

l From the Antech/Zoasis Provider section of the Requisition Setup Wizard,

select the Billing Codes tab.

l If you like, use the Filter field to constrain the list of records to those containing

what you type.

l If desired, select Top Selling Only to view the list of top selling items.

l Double click the Bill Item record you want to link to a Panel. A Select Req-

uisition Code pick list will display.

l From the Select Requisition Code pick list, choose the Panel to link to the Bill

Item. Type the Panel code in the Linked Code field, or click the Panel code
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from the list to highlight.

l Click Select. The Panel code will be linked to the specified Bill Code.

Creating and Submitting a Lab Requisition
Once you have configured your requisition provider(s) from the Requisitions Wizard and ena-

bled automatic receiving of lab results, creating a requisition is as easy as adding a MRE to a

patient record or bill item to an invoice. After a requisition is created, you have to submit the req-

uisition. You can then view requisition status and results from either the patient record or via the

Labs functionality.

Create a Lab Requisition
A new requisition is created when you add an MRE with an associated Bill Item Code and

linked requisition code to a patient record, or when you add a Bill Item with a linked requisition

code to an invoice. A requisition record is created for the associated test and a small Req-

uisitions dialog displays, much like what you see with invisible invoicing. You can add multiple

tests or items to the same requisition, and requisitions for more than one provider will display in

their own Provider tab on the Requisitions window.

To create a new requisition:

l Open a patient record to the History tab.

l Click New MRE. 

l The Add New Medical Record Entry dialog opens. Type the code MRE in the

Code field and enter any Notes in the Notes section. When an MRE associated

with a Bill Item and linked requisition code is added to the patient record, the

Requisition will be added to the invoice as soon as the MRE is saved.

l Click OK or OK and Next MRE.
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l The Requisitions window opens with the requisition or panel displayed.

l Add any additional MREs to the patient record. Those MREs linked via Bill

Item to a requisition code or panel will add more requisition items to the Req-

uisition dialog.

l Select a requisition staff, if desired. For VetLab, the name in the requisition

staff defaults to the primary provider on the Patient General Info tab. For

IDEXX, the staff defaults to blank and the default IDEXX credentials are

applied. See Use Staff IDEXX Account for more on assigning a staff name to

an IDEXX requisition.
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l Select a LIMS account. For Vetlab, the default LIMS account is listed auto-

matically. See Adding a Default VetConnect PLUS LIMS Account to Lab

Requisitions.

l Select any add-on tests to the requisition. Click the Add-on test are available.

Click to view. An IDEXX Add-on window will appear listing all the possible

add-ons. Select the add-on(s) and click the Select button to add the items to the

requisition.

l Click Submit from the Requisitions window to submit the requisition. If there

are multiple providers in your lab requisition window, click each provider tab

and click Submit.

l If you are submitting a requisition to IDEXX Reference lab, an IDEXX Lab

panel will appear. This panel will allow you to make edits to and add additional

tests to the requisition. Once complete, click the Order button to finalize the

submission.

l For IDEXX lab requisitions, a requisition form will be generated. This form can

be viewed as a PDF before being printed. This option is determined by your

setup. Contact DVMAX Technical Support for more information.

A requisition is created as soon as the line item is added to the invoice or the MRE is saved

to the patient record. Deleting or editing the line item will not remove the associated requisition,

though the charges associated with the deleted requisition will be removed.

Creating a Staff Lab Discount Link to a Client Record

The Client Staff Record setting allows DVMAX to identify if a Client is able to receive Lab

requisition discounts. The setting creates a link to a current Staff record and adds the Client

name to that Staff record. Only Clients with this Staff link will be able to receive discounts on

requisition billing.

To add a Client to a Staff Record:

l Open the Client record.
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l Click the Finances tab.

l Within the Other information box of the Finances tab, click the Staff Client

Record box. Once the box is clicked you will be able to select the associated

Staff member and create the Client/Staff link.

l Select OK.

Viewing Staff Client Records
To view the list of Clients linked to a Staff record:

l From the Section menu, select Patient Codes.

l From the Find dialog, select Staff from the Search for menu.

l Input the Staff Code or select All Records to see a list of all Staff records.

l Select the appropriate Staff record. The Staff record displays.
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l From the Staff record you can view Staff details, including Staff Client records. 

All Client records linked to this Staff record will be listed and will automatically

be able to receive discounts on requisition billing.

Note: You cannot add a Client directly in the Staff record. The link must be made from the

Client record.

Adding a Default LIMS Account to Lab Requisitions

The Requisition Setup window in DVMAX allows you to set a default LIMS account used for

VCPlus Requisition orders. The default account will be used unless another LIMS account is

selected from the LIMS drop-down menu.

Adding and Deleting a LIMS account, as well as setting the default LIMS account is done from

the IDEXX panel of the Requisitions Setup Wizard. To open the Requisition Setup Wizard:

l From the Section menu select General Management.

l The Management Functions dialog opens.

l Select the Utilities tab from the Management Functions dialog.

l Select Requisition Setup Wizard and select OK.

l From the Requisition Setup dialog, select IDEXX from the Provider drop down.

To add a LIMS to the IDEXX Requisition setup (required for sites with more than one LIMS

account):

l Select the Setup Info tab of the Requisition Setup Wizard.

l From the LIMS account setup area, click the Add button to add a LIMS

account.

l The Add LIMS code dialog displays.

l Add a LIMS Label to identify the LIMS.

l Add the LIMS Account number and click OK.
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l To make a LIMS account listing the default, click within the row of the account

you wish to make the default.

l Select Set Default. The account will then be listed as the default when a

VCPlus Requisition is ordered.

l Select Close to save changes to the Requisition Setup.

Requisition Code Not Found
From time to time, you may try creating a requisition and see the alert “The requisition code for

that bill item cannot be found. Perhaps it has been deleted?” You will need to confirm that the

Bill Item Code is still properly linked to a valid requisition code under Requisition Setup. The

Requisition Code or Panel Code could have been affected if the provider has removed or edited

the requisition code and the Update Codes routine has been run. Refer to the appropriate Pro-

vider Update Codes section of this Lab Results and Requisitions chapter for more infor-

mation.

About the Lab Requisitions Window
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The Requisitions window lists requisitions by provider. Below the requisitions list area, there is

the patient name, the Requisition Staff drop down and the Submit/Print and Edit buttons.

Requisitions Window Provider Tabs
If the requisitions list is for only one provider, there will be only one tab at the top of the dialog.

If you add requisitions for more than one provider, the Requisition dialog will have a unique tab

for each provider. You can click the Provider tab to view the requisition(s) for that provider.

Lab Requisitions Window Requisition List
Requisition items or panels display in the format Requisition Code – Name. If you add a Req-

uisition Panel, you will only see the Panel code and name, unless you selected Expand Items

when you were building the Panel record from the Requisitions Wizard. When you have Expand

Items selected under Panel setup, the individual items that make up the Panel will display.

Requisition Window Submit and Print Buttons
Depending on the provider, the Requisitions floating window will either display Submit and Edit

buttons or Print and Edit buttons. For IDEXX Reference Lab and VetLab Station Network pro-

viders, you will see Submit and Edit buttons, where the Submit button allows you to elec-

tronically submit a requisition to the provider.

For IDEXX Reference Lab, you will print the requisition form once the requisition is finalized.

For Antech/Zoasis, you will see Print and Edit buttons. You will print the Antech/Zoasis req-

uisition form and submit it along with your samples to the provider. DVMAX does not submit the

requisition to the provider electronically. For Cubex, there is no print option presented.

Adding Notes to a Requisition
To Add Notes to a Requisition:

l In the Requisitions window, click Edit.

l From the Edit Requisition dialog, type your notes in the Notes area. These notes

will be included with both an electronic and printed requisition.

DVMAX Practice V8.6 - User Manual



- 811 -

l Click Save.

Submit a Requisition
You can submit a requisition from the Requisitions window or from the Requisition area of the

Labs facility.

To submit a requisition from the Requisition window:

l From the Requisition window, click Submit or Print (depending on the provider

for whom the requisition was created).

l For Antech/Zoasis, clicking Print will produce a PDF requisition form that you

will send in to the lab with the samples.

l For IDEXX Reference Lab, clicking Submit will submit an electronic req-

uisition to the provider and create a printed requisition that is sent to the lab with

the samples.

l For IDEXX Reference lab, clicking Submit will pop-up an additional infor-

mation panel that allows for requisition edits and add-ons. Once complete, click

the Order button to finalize the submission.

DVMAX Practice V8.6 - User Manual



- 812 -

l For Cubex, clicking Submit will send the request to the Cubex cabinet.

If the IDEXX auto-finalize special setting is turned  “off”, clicking Submit will produce a

Draft requisition PDF. See Finalize a Lab Requisition for more information. This setting is

“off” by default.

l If you are submitting a requisition to IDEXX Reference lab and additional infor-

mation is required by IDEXX, an IDEXX LabREXX panel will display in an

internal browser window in DVMAX before the requisition form is generated.

You will need to provide the additional details to IDEXX about the sample(s)

being submitted, then close the LabREXX window.
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l For VetLab, clicking Submit will send the requisition to the VetLab Station Net-

work.

To submit a requisition from the Requisition area of the Labs facility:

l Click the Labs icon on the command palette to open the Labs facility.

l Select Requisitions from the Types drop-down menu.

l On the Requisitions list, double click the lab requisition you wish to submit.

l From the Edit Requisition dialog, click Submit/Print.

l For Antech/Zoasis, clicking Print will produce a PDF requisition form that you

will send in to the lab with the samples.

l For IDEXX Reference Lab, clicking Submit will submit an electronic req-

uisition to the provider and create a printed requisition that is sent to the lab with

the samples. The requisition may need to be finalized, depending on your setup.

See Finalize a Lab Requisition for more information.

l If you are submitting a requisition to IDEXX Reference lab and additional infor-

mation is required by IDEXX, an IDEXX LabREXX panel will display in an

internal browser window in DVMAX before the requisition form is generated.

You will need to provide the additional details to IDEXX about the sample(s)

being submitted, then close the LabREXX window.
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l For VetLab, clicking Submit will send the requisition to the VetLab Station Net-

work.

Edit a Requisition
DVMAX lets you add or remove tests from a requisition. The options available will vary depend-

ing on the lab provider for whom the requisition was created and the status of the requisition.

Edit and Add test to an IDEXX Reference Lab Requisition

The DVMAX-VetConnect PLUS workflow has been updated and enhanced to give you even

greater control over your requisitions. Once a requisition has been submitted, DVMAX gives

you the ability to edit the requisition and select add-ons. The requisition order can be opened,

reviewed and edited by selecting the test from the patient history and making changes on the

associated IDEXX Diagnostics dialog. 

To edit or select add-ons to a submitted requisition:

l Select the Lab Results icon from the Palette.

l Double click the requisition from the Lab Results list that would like to edit.

l Click the Edit Requisition button from the Edit Requisitions window.

l The IDEXX Diagnostic dialog opens displaying the original requisition order.
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l Make the edits and complete add-ons as desired and select Order to resubmit

the order.

Delete One or More Tests from a Requisition
Depending on the provider, you can delete one or more tests from a requisition or delete the full

requisition. If the requisition is open (not yet submitted), you can always delete an item from the

requisition. If a requisition has been submitted, what you can delete depends on the provider.

To delete an item from a requisition:

l From the Requisition window, click Edit.

l From the Edit Requisition dialog, select the item you want to delete.

l Click Delete.

l Click OK from the Confirm dialog to delete the requisition item.
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-OR-

l Click the Labs icon on the command palette to open the Labs facility.

l Select Requisitions from the Types drop-down menu.

l On the Requisitions list, double click the requisition you wish to change.

l From the Edit Requisition dialog, select the item you want to delete.

l Click Delete.

l Click OK from the Confirm dialog to delete the requisition item.

VetConnect PLUS orders cannot be edited 28 days past creation.

In cases where deleting an item from an unsubmitted (open) requisition leaves the req-

uisition blank, it is recommended that you delete the full requisition. Leaving blank, open req-

uisitions in DVMAX may affect the display of the Requisitions window.

Delete a Requisition Record

You can delete one or more items from a requisition or delete the full requisition. Deleting a req-

uisition record is NOT the same as canceling the requisition. See Cancel a Lab Requisition for

information on canceling a requisition. If the requisition has already been submitted, deleting the
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requisition record will only remove the record from requisition history, it will not affect any

changes to results received.

To delete a requisition:

l From the History tab of a patient record, click View Requisition History.

l From the Requisition History dialog, click to highlight the requisition you wish

to delete.

l Click Delete.

l From the Confirm dialog, click OK to continue and delete the record.

Add an Item to a Requisition
Depending on the provider, you can add an item to an open (unsubmitted) requisition.  Idexx Ref-

erence Lab requisitions can can edited anytime up to 28 days through VetConnect PLUS. See

the Editand Add test to an IDEXX Reference Lab Requisition section for details.

To add an item to a requisition:

l If the Requisition window is still displayed from the History tab of a patient rec-

ord, you should be able to add another requisition item or panel to the requisition.

l To add a requisition item or panel, follow the steps under Create a Requisition.

The new requisition item will be added to the requisition. If you have created

requisitions for multiple providers, the requisition item will be added to the req-

uisition for the appropriate provider.

Update Test on a VetLab Requisition
There is an Update Test button on the Edit Requisition dialog. This button is only available

when working with VetLab requisitions. The Update Test feature lets you resend or resubmit

one or more items on a VetLab requisition without having to recreate a requisition.

To use Update Test:
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l From the Edit Requisition dialog, select the requisition item(s) you want to resub-

mit to the VetLab Station Network.

l Click Update Test. A request will be resent to the VetLab Station to run the

selected tests. You will see the request(s) in the Pending tab of the VetLab Sta-

tion.

Cancel a Submitted Requisition
Depending on the status of the requisition and the provider for whom the requisition was created,

you may be able to cancel a submitted requisition. There is a Cancel Requisition button on the

Edit Requisition dialog. This button is enabled only for IDEXX Reference Lab requisitions

where the status is Submitted or Draft. Clicking Cancel Requisition from the Edit Requisition

dialog will change the status of the requisition to Cancelled. A requisition cannot be cancelled

until it has been submitted.

IDEXX Reference Lab – Submitted lab requisitions can be canceled from DVMAX for an

IDEXX Reference lab request as long as the status is not Accessioned or Completed. When

the requisition status is Submitted or Draft (submitted but not finalized), a requisition can be can-

celed.

VetLab Network – To cancel a submitted VetLab requisition, you must remove the request

from the VetLab Station Pending list. You cannot cancel a VetLab requisition from DVMAX.

Antech/Zoasis – Submitting a requisition involves printing the PDF requisition form and sending

the requisition form together with sample(s) to the provider. There is no way to cancel a req-

uisition of this type via DVMAX. Contact the provider. Note that canceling a requisition is not

the same as deleting a requisition record. See Delete a Lab Requisition Record. 

Cubex – Submitted requisitions cannot be edited or canceled from DVMAX.

To Cancel a Requisition using the Cancel Requisition button:

l From a patient record, click the Edit button on the Requisitions window to open

the Edit Requisition dialog.

l Click Cancel Requisition. If the Cancel Requisition button is not available, it

is because you cannot perform that operation for the selected requisition. Only

IDEXX Reference Lab requisitions with status Submitted or Draft can be can-

celled using the Cancel Requisitions button.

l From the Confirm dialog, click OK to cancel the requisition.

-OR-

l From the Labs functionality, select Type -> Requisitions, then double click to

select the requisition you want to cancel. This opens the Edit Requisition

dialog.

l Click Cancel Requisition. If the Cancel Requisition button is not available, it

is because you cannot perform that operation for the selected requisition. Only

IDEXX Reference Lab requisitions with status Submitted or Draft can be can-

celled using the Cancel Requisitions button.

l From the Confirm dialog, click OK to cancel the requisition.
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Cancelling a Requisition and Invoicing

It is very important to recognize that cancelling a requisition does not remove the associated

bill item from an invoice, nor does it remove the requisition record from patient History. Please

check your records and manually remove an item from the invoice if the client is not to be billed

for the canceled requisition.

Finalize an IDEXX Reference Lab Requisition

When an IDEXX Reference Lab requisition is submitted, it can either be auto-finalized (default

behavior) or the requisition can be held as a draft until you select Finalize on the requisition rec-

ord. With auto-finalize “on”, when you click Submit on an IDEXX requisition, a PDF req-

uisition is created to submit with your samples, and that requisition is also electronically sent to

IDEXX. You may still be able to edit or cancel the requisition, as long as you do so before the

samples you send in are processed. Once the requisition status is Accessioned or Completed no

further editing can be done to the requisition.

With auto-finalize turned “off”, DMVAX creates a Draft requisition. This draft can be edited,

or you can choose to cancel the requisition at any time while it is in draft.

To Finalize an IDEXX Draft Requisition:

l From a patient record, click the Edit button on the Requisitions window to open

the Edit Requisition dialog.
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l Click Finalize Requisition. If the Finalize Requisition button is not available,

it is because you cannot perform that operation for the selected requisition. Only

IDEXX Reference Lab requisitions with status Draft can be finalized using the

Finalize Requisitions button.

l The requisition status will change from Draft to Submitted and a PDF req-

uisition form will be generated.

-OR-

l From the Labs functionality, select Type -> Requisitions, then double click to

select the requisition you want to cancel. This opens the Edit Requisition

dialog.

l Click Finalize Requisition. If the Finalize Requisition button is not available,

it is because you cannot perform that operation for the selected requisition. Only

IDEXX Reference Lab requisitions with status Draft can be finalized using the

Finalize Requisitions button.

l The requisition status will change from Draft to Submitted and a PDF req-

uisition form will be generated.

Contact DVMAX Technical Support if you have questions or want to make changes to the

IDEXX Reference Lab auto-finalize special setting.

Printing a Requisition Form
l DVMAX automatically prints a lab requisition form for IDEXX Reference Lab

and Antech/Zoasis requisitions when you click Submit or Print from the Lab

Requisition floating window. This saves time and ensures accuracy over a man-

ually completed order form. You can also Print/Submit (or, in the case of
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Antech, Reprint where needed) from the lab requisition from Patient History ->

View Requisition History.

l When you add an MRE for a lab requisition from IDEXX Reference Lab or

Antech/Zoasis, DVMAX generates a PDF with a 2D bar code lab requisition

form that includes:

l Demographic information from DVMAX, including the provider account

number, pet owner name, pet name, age, breed, requesting doctor (where appli-

cable), species and gender.

l Provider-required information such as the lab order code and description.

l Any notes you type in the Notes area of the Edit Requisition dialog will be

added to the requisition form. Before you can generate the requisition form, you

must configure requisitions for each provider using the Requisition Setup Wiz-

ard.

Note that if you are submitting a requisition to IDEXX Reference lab and additional infor-

mation is required by IDEXX, an IDEXX LabREXX panel will display in an internal browser

window in DVMAX before the requisition form is generated. You will need to provide the addi-

tional details to IDEXX about the sample(s) being submitted, then close the LabREXX window

before you will see the requisition form.

Requisition Status
Once you create a requisition, it passes through several stages until the associated lab results are

received or the order is processed (Cubex). You can view requisition status from the requisition

record (the Edit Requisition dialog) or from View Requisition History on the History tab of a

patient record.

On the Edit Requisition dialog, the status of the requisition is shown in the Status field in upper

left area of the window.

The following are the requisition statuses you may see when working with requisitions:

Open – Requisition has been created but not submitted.

Draft – An IDEXX Reference Lab requisition that has been submitted as a draft but is not yet

finalized. See Finalize an IDEXX Lab Requisition.

Submitted – A VetLab or finalized IDEXX requisition that has been submitted.
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Cancelled – A requisition that was submitted but subsequently cancelled.

Accessioned – A requisition that is being actively processed. Accessioned requisitions cannot

be cancelled.

Completed – A requisition where lab results ordered have been received by DVMAX.

Closed – An Antech/Zoasis requisition that has been printed and closed (typically submitted

after printing).

View Requisition History
You can view complete requisition history for a patient from the patient record, or view all req-

uisition records for all patients over a selected time frame from the Labs window.

Requisition History for a Specified Patient
To view requisition history for a specified patient, click the View Requisition History button on

the History tab of a patient record.

Requisitions are shown in chronological order. You can double click a requisition from the list to

open the Edit Requisition dialog for that record. The View Requisition History dialog displays

Date created (or date submitted for submitted requisitions), Requisition Number, requisition

Status andModality (provider).
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Requisition History for All Patients
To view all requisitions for all patients within a specified time frame, click the Labs button on

the Command Palette and select Requisition from the Type drop down menu. Again, req-

uisitions are shown in chronological order. You can double click a requisition from the list to

open the Edit Requisition dialog. See Labs Window with Requisition Records for more on the

Requisition Records List.
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About the Requisition Record
View a requisition record by double clicking a record from Requisitions under the Labs facility,

or directly from a patient record by clicking View Requisition History from the patient History

tab.

A Requisition record includes several information fields at the top of the dialog, followed by the

list of items included in the requisition. If results have been received (where applicable), the

Requisition dialog will have 2 tabs, one fore the requisition details and one for lab results. Lab

results can be viewed in better detail by selecting a results type from the Type menu of the Labs

window. See About the Labs Window and About the Lab Results Record for more details on

working with lab results records.

Status – Shows requisition status. See Requisition Status for more on status.

Lab Provider – Shows the name of the lab provider to which the requisition was sent.

Have Results Been Received – A Yes/No status indicating whether results have been returned

for this requisition.

Staff – Shows the name associated with the requisition.

Notes – Shows any notes associated with the requisition. Notes can be typed at any time, even

after results are received.

Requisition Items and Panels List Area – Shows all requisition items and panels associated

with the requisition. Depending on the provider and status of the requisition, it may be possible to

delete items on the list using the Delete Test button or resubmit a test using the Update Test but-

ton.

View IDEXX Result Form – Available if the provider is IDEXX, this is the result form from

IDEXX.

View Requisition Form – Lets you view the original requisition PDF as submitted.

Finalize Requisition - Available if the provider is IDEXX. See Finalize Requisition for more

information.

Cancel Requisition - Available if the provider is IDEXX and dependant on requisition status.
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See Search for Lab Requisition Records from the Labs Window and About the Labs

Window for more details on working with lab requisition and lab results records.

View IDEXX Result Form
The View IDEXX Result Form button on a lab requisition record or View Result Form button

on an IDEXX lab result record will display the IDEXX result PDF generated by IDEXX.

If you click the button and there is no PDF displayed, you can re-download the result form using

Control+click (Windows) or Option+click (Mac).

Search for Requisition Records from the Labs Window
You can view requisition records for a patient from the patient record, or view all requisition rec-

ords for all patients over a selected time frame from the Labs window.

To view a requisition record:

l From the Command Palette, click Labs.

l From the Labs window, use the filters to find the record or group of records you

want to view.

l Use the Clients field to search for results or requisitions by client name. In the

Clients field, type a client name, or click the lookup icon to select a client name

from the pick list.

l Use the Patients field to search for results or requisitions by patient name. In

the Patients field, type a client name, or click the lookup icon to select a patient

name from the pick list.

l From the Type drop down menu, select Requisitions.

l Use the Date filter to indentify a range in which to look for requisitions or

results. Select a range from the drop down menu, or type a number of days back

in the field using a number of days preceded by a minus sign. For example, to

search 60 days back from the current date, type “-60”.

l Select a doctor/primary provider from the Status/Provider menu to filter by doc-

tor/provider.

l Requisition records displayed will match the criteria you select.

l Double-click a record to view it.

Search for Lab Results from the Lab Log
As results are returned to DVMAX, they are automatically sent to the appropriate patient rec-

ord. The Lab Log keeps a record of all lab results, both pending and received.
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You can access the Lab Log from the Section menu, or you can click the Labs icon from the

Command Palette to search for, review, assign or transfer lab results – from both in-house and

from external sources - as needed.

To view the Lab Log from the Section menu:

l From the Section menu, choose Log Records.

l The Find dialog opens. Select Lab Log from the Search For menu.

l Choose an option from the By menu:

l Patient ID and Name

l Keyword in recent entries

l Problem entries (no input)

l Lab Reference Number

l Lab Source

l Date (Date) or (start, end)

l Keyword in all entries (slow)

l General – Click Search to open a Query editor, where you can build a cus-

tom query with available tables and fields, comparison operators, and

values.

l If more than one result matches the constraints you specify, you will get a

list of records. Double click on a record to view. See Viewing a Lab Req-

uisition or Lab Result from the Labs Window for more on viewing results

and requisition records.

About the Labs Window
The Labs facility, accessed by clicking the Labs icon from the Command Palette, shows a list of

lab results or requisition records matching the constraints you select using the filters at the top of

the dialog. The default view shows all lab results for the current date. There is a VetConnect
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Plus button at the bottom of the Labs window that will take you to your VetConnect Plus home-

page when clicked.

There are 7 columns on the Labs window. These columns will have different labels when view-

ing Requisition records or Lab result records.

Labs Window with Lab Result Records
Date-Time – Shows the date and time the result was received. In the case of requisitions, shows

the date and time the requisition was created (if Open, Unsubmitted) or the date and time the req-

uisition was submitted.

Type – Shows the lab provider.

Destination – Shows the name of the patient associated with the requisition or result. If

DVMAX could not identify a patient to which to assign the record, DVMAX will state “Patient

Not Specified”.

Viewed – Shows if the results were viewed. This column does not apply to requisitions.

Contacted – Shows if the client associated with the result has been contacted. This column does

not apply to requisitions.

Reconciliation – Indicates whether reconciliation is required for the record. Reconciliation is a

process that helps ensure accurate charge capture for lab services on invoices by comparing the

requisition items to the results returned by the lab. See Reconciliation of Lab Results for more

on reconciliation. This column does not apply to requisition records.

Note – Shows the client name, patient name and doctor name associated with the record.

Labs Window with Requisition Records
Date-Time – Shows the date and time the requisition was submitted. In the case of open req-

uisitions, shows the date and time the requisition was created.

Type – Shows record type.

Destination – Shows the name of the patient associated with the requisition.

Modality – Shows name of lab provider associated with the requisition record.

Status – Shows status of the requisition.

Results – Indicates whether results have been received.

Note – Shows any notes that may have been entered in the Notes area of the requisition record.

Search for Lab Results from the Labs Window
As results are returned to DVMAX, they are automatically sent to the appropriate patient rec-

ord. DVMAX keeps records of all lab requisitions and results, including submitted requisitions

and pending and received results. You can view Lab activity – both from in-house equipment and
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external labs - from either the Lab Log under the Section menu or by clicking the Labs button

on the Command Palette.

Use the Labs icon from the Command Palette to search for, review and assign or transfer lab

results as needed.

To search for lab results from the Labs facility:

l Click the Labs button in the Command Palette.

l From the Lab Results window, use the filters to find a lab requisition or result

record.

l Use the Clients field to search for results or requisitions by client name. In the

Clients field, type a client name, or click the lookup icon to select a client name

from the pick list.

l Use the Patients field to search for results or requisitions by patient name. In

the Patients field, type a client name, or click the lookup icon to select a patient

name from the pick list.

l Select Include Partial Results to include partial lab result records in the

search. A partial result is a record that is only one part of the requested order.

l From the Type drop down menu, select a type of record. Options include All

Lab Results, Antech/Zoasis Results, IDEXX Results, In-House Lab Results,

Marshfield Lab results and Lab Requisitions.

l Use the Date filter to indentify a range in which to look for requisitions or

results. Select a range from the drop down menu, or type a number of days back

in the field using a number of days preceded by a minus sign. For example, to

search 60 days back from the current date, type “-60”.

l Select a doctor/primary provider from the Status/Provider menu to filter by doc-

tor/provider.

l Lab records displayed will match the criteria you select.

About the Lab Result Record
View a lab result by double clicking a record from the Labs facility, or directly from the patient

History tab of an MRE.

A lab result record includes several non-editable information fields at the top of the dialog.

The main body of the results record is a tabbed area with a Results tab and a Reconciliation tab.

Assign or Transfer – To assign or transfer results to a specified patient record.

Owner Contacted – A selectable box to indicate whether the client associated with the patient

record has been contacted about the lab results.

Results tab – Shows the lab results in a chart format.

Text tab – Shows the lab results in text format.
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Reconciliation tab - Reconciliation is a process that helps ensure accurate charge capture for

lab services on invoices by comparing the requisition items to the results returned by the lab. See

Reconciliation of Lab Results for more on reconciliation. This column does not apply to req-

uisition records. This tab will show you a comparison of what was ordered and what was

received and allow you to make changes, as needed, to the invoice.

Delete – Lets you delete the results record. Deleting the record does not remove any associated

charges from an invoice or remove the record from patient History.

Cancel – Close the results record without saving any changes.

OK & View Patient – Saves your changes and takes you to the patient record.

View IDEXX Result Form – Available if the provider is IDEXX, this is the result form from

IDEXX.

View Requisition Form – Lets you view the original requisition PDF as submitted.

See About the Lab Requisition Record for more details on working with lab requisition

records.

View a Lab Results Record from the Labs Window
To view a lab results record:

l From the Labs window, use the filters to find the record or group of records you

want to view.

l Double-click a record to view it.
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l Click Assign to assign this record to a patient if needed.  You will only see this

option if the results need to be assigned. This option only applies to lab results,

not requisition records.

l If the results have already been assigned but you want to move the results to a

different patient, click Transfer.  You will only see the Transfer option if the

results are already assigned. This option only applies to lab results, not req-

uisition records.

l Select Owner Contacted if the client has been contacted about the results. This

option only applies to lab results, not requisition records.

l Click the Reconciliation tab to review lab results reconciliation requirements.

See Reconciliation of Lab Results for more about reconciliation.

l Click OK to save your changes.

l DVMAX asks if you want to record this viewing of the lab log.

l Click Yes to record the viewing. The current date is inserted in the Viewed col-

umn of the Lab Results window. Click No if you do not wish to record a record

of viewing the results.

l The record closes.

Delete a Lab Result Record
It is possible to delete a lab result record from the lab log. Deleting the lab record does not

remove any associated charges from an invoice or remove the record from patient History.

To delete a lab result:

l Click Delete to delete the lab record and remove it from the Lab Results win-

dow.

l From the Confirm dialog, click OK to confirm you want to delete the record.
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l The record is removed from the lab log. The lab results remain in patient His-

tory.

Patient Not Found
If lab results received cannot be matched to an existing DVMAX patient, the Lab Info field of

the Lab Result record will display Patient Name, species, gender, spayed/neutered, patient ID

(in brackets) and Client Name associated with the lab result. Results can be manually assigned,

where needed, using the Assign button on the result record.

About Partial Lab Results
From time to time, lab results are sent to DVMAX in parts rather than all at once. For example,

a requisition may have included 3 tests, and the results for the 3 tests may be received individ-

ually. These are known as partial results. Partial results are not placed in the patient record until

all items ordered are delivered to DVMAX. 

To include partial results records when looking at the Labs window, select Include Partial

Results at the top of the Lab Results dialog.

VetLab and Partial Lab Results
When you submit a requisition to the VetLab Station Network, the status of each line on the req-

uisition will be shown on the requisition results, and results may be returned as partials, espe-

cially if multiple blood analyzers connected to the VetLab are used to process samples.

Viewing Lab Results from the Patient Record

In-House Lab Results
Lab results can be viewed by clicking the Labs button from the Command Palette. The in-house

lab results can also be reviewed from a patient record by looking at the record from patient His-

tory, or by using the Chart Labs option. The Chart Labs feature allows you to select any

number of assays from a list of available results, then chart the selected results.

To chart in-house blood results:

l From a patient record, select the History tab.

l Click Chart Labs.
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l Select the date range within which to search for results. Type the Start Date

and End Date or use the Calendar function to select a date range.

l Click OK.

l From the Assay List, select the items you would like to chart. 

l Click again to deselect an item.  If there are no items on the list, no in-office

blood results were found within the specified date range.

l Click Chart on the Assay List window to build the assays chart.

l Selected Assays are displayed on a graph.
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Assigning the Lab Log Record
DVMAX will automatically assign lab results to the appropriate patient record. Sometimes, how-

ever, results need to be manually assigned, such as when results are returned with the patient not

specified.

As well, sometimes results assigned to one patient may need to be transferred to another, such

as may happen if a user accidentally assigns a result to the wrong patient. To assign or transfer

results from the Labs window:

In the Lab Log window, double-click a record to open it.

l Click Assign to open a Patient pick list, allowing you to assign the record to the

appropriate patient. This option will only display if the result record needs to be

assigned.

l If a result has already been assigned but you wish to transfer the results, click

Transfer to open a Patient pick list, allowing you to transfer the results record

to the appropriate patient.

l Once a patient is assigned to the record, you may view the Patient record from

the Log record window.

l Click OK and View Patient to open the patient record.

l You are prompted to record the viewing of the lab log. To record the viewing,

click Yes. Otherwise, click No. If you click Yes, the viewing is recorded in the

Lab log record, in the Viewings box.

Manually Associating Incoming Results with Patient Records
If DVMAX cannot determine the patient ID from an incoming test result, you will be notified

and asked to provide the correct patient ID for the result.  Unassigned results in the lab results

listing will not have an associated Client/Patient. When you open an unassigned record, the

Assign button will be enabled.  See Assigning the Lab Log Record.

Reconciliation of Lab Results
Reconciliation is a process that helps ensure accurate charge capture for lab services on

invoices by comparing the requisition items to the results returned by the lab. For Cubex

orders, see Reconciliation and Cubex. Reconciliation may be required when the test items

received differ from what was requested via the submitted lab requisition. For example, if you

submit a lab requisition and the returned results include some add-on items not part of the orig-
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inal requisition. Alternatively, the results received may be missing one or more tests or panels

that were requested on the original requisition.

The process of reconciliation lets you decide whether any charges have been applied to an

invoice that should be removed or whether there are charges that need to be added to an invoice

based on the differences between requested tests and tests received.

Reconciliation Status
From the Labs window, you can view the reconciliation status of lab results.

The Reconciliation Required column of the Lab Results list will show one of 3 statuses:

Required – Recommended that you review the items on the Reconciliation tab of the lab result

to determine if you want to make changes to the invoice on which the bill item(s) associated

with this lab result appear. Once you have checked the reconciliation details, selecting Rec-

onciliation Has Been Completed from the Reconciliation tab of the lab results record with

change the reconciliation status to Completed.

Not Required – Reconciliation is not required. You can still review the Reconciliation tab of

the lab result record, but no reconciliation is required.

Completed – This record has been reviewed already and the Reconciliation has been com-

pleted checkbox on the Reconciliation tab has been selected.

About the Reconciliation Tab of a Lab Results Record
You view and work with reconciliation features from the Reconciliation tab of a lab result. The

Reconciliation tab is made up of some general information fields at the top of the dialog and 4

list areas. The general information at the top of the Reconciliation tab includes the same fields

as seen fields as seen at the top of the Results tab of the lab result record, such as Result Date,

Date Received and lab Provider name. The 4 list areas on the reconciliation are described in

their own sections.
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Original Requisition List Area of the Reconciliation Tab
The Original Requisition list area is the leftmost list box on the Reconciliation tab. All of the bill

item codes linked to lab requisition codes on the original requisition are listed in the Original

Requisition list area. In other words, this is the “what you asked for on your lab requisition” list.

Fulfilled Bill Items Area of the Reconciliation Tab
The Fulfilled Bill Items list area is the second list box from the left on the Reconciliation tab.

That list area shows all bill item codes associated with results that came in with this lab record.

This is a list showing which items you requested, you received.

Extra Codes on the Reconciliation Tab and Invoicing
DVMAX compares the requested codes in the Original Requisition list to the items in the Ful-

filled Bill Items list. These should be the same. If they are not, any additional items are listed in

the Extra Codes area, while any results not received are listed in the Unfulfilled Codes area.

These provider-specific lab codes may or may not be linked to an existing DVMAX bill item. If

they are linked to an existing DVMAX bill item, you will see both the code from the lab pro-

vider in the Lab Code column and the linked DVMAX Bill Item code in the Bill Item column.

If the lab code is not currently linked to an existing DVMAX Bill Item Code, DVMAX will

place a generic bill item code, LabReq99, in the Bill Code field for the purpose of allowing the

user to add this lab item to an invoice.

You can choose to add any of the extra codes to an invoice by selecting the item(s) from the

Extra Codes list and clicking Invoice Selected Bill Items.

To add extra codes to the invoice:

l From the Extra Codes area, select the item(s) you want to add to the invoice by

clicking in the field beside the Lab Code.

l An item is selected when an asterisk is in the leftmost column for the item you

want to add to an invoice. Click again to deselect.
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l Click Invoice Selected Bill Items.

l An Item Description Request dialog displays. Type a description for the lab

item. Click OK to continue.

l Another Item Price Request dialog displays for you to type a price for the item.

After entering a price, click OK to continue.

l The Invoice opens. Note that any new items are added to the invoice. Proceed

with the invoice as desired (close, finish, print or apply payment to the invoice).

Unfulfilled Codes on the Reconciliation Tab and Invoicing
DVMAX compares the requested codes in the Original Requisition list to the items in the Ful-

filled Bill Items list. These should be the same. If they are not, any additional items are listed in

the Extra Codes area. Any bill items requested/invoiced but not delivered as per the requisition

will display on the Unfulfilled Codes area of the Reconciliation tab. It may be the case that you

have billed for an item for which no result was received, and you can choose to remove the bill

item from the invoice.

You can choose to remove any of the unfulfilled items from an invoice by selecting the item(s)

from the Unfulfilled Codes list and clicking Return Selected Bill Items.

To remove unfulfilled bill items from the invoice:

l From the Unfulfilled Codes area, select the item(s) you want to remove from

the invoice by clicking in the field beside the bill item.

l An item is selected when an asterisk is in the leftmost column of the item you

want to remove from the invoice. Click again to deselect.

l Click Return Selected Bill Items.

l DVMAX creates a return for the selected item(s).

Reconciliation Completed
After you have reviewed the information on the Reconciliation tab and made any necessary

changes, select the Reconciliation Has Been Completed checkbox at the bottom left of the Rec-
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onciliation dialog to mark this as completed. The status of the reconciliation on the Rec-

onciliation Required column of the Lab Results list will change to Completed.

Reconciliation and Cubex
Reconciliation takes place automatically for Cubex orders. When the quantity supplied differs

from the quantity requested, Cubex will make necessary adjustments to the invoice auto-

matically. Be sure to review the invoice carefully.

Accessing VetConnect PLUS from DVMAX
You can access IDEXX VetConnect PLUS directly from the DVMAX Lab Results dialog. To

open VetConnect PLUS in DVMAX:

l Click the Labs button in the Command Palette.

l From the Lab Results dialog, click VetConnect Plus. The VetConnect Plus win-

dow will open inside DVMAX.

l Use VetConnect as you would normally.

If you have any questions about VetConnect, your IDEXX VetConnect account or your Vet-

Connect Plus credentials, please contact IDEXX VetConnect.

If DVMAX is not able to match a patient with a VetConnect PLUS account or with a Ref-

erence Lab result, the VetConnect PLUS home page will launch. The VetConnect PLUS home

page provides additional search, setup and review options.
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Writing Returns
You can write a return in DVMAX to record the return of inventory to your practice. Returns

can also be used to reverse double-billing and other mistaken financial entries.

Recording a return reverses sales and production entries and marks inventory as being back in

stock. A return has no effect on a patient record.

Returns can be written only from a DVMAX client Finances tab.

Returns and Invoices
The process of writing a return is very similar to that of writing an invoice. A return is almost an

invoice in reverse: on a return, all quantities are negative values; there is a refund method

instead of a payment method, and so on.

A return will not reverse any entries – MREs, Reminders or Recalls - made on a patient’s

record via an invoice.

If you are using DVMAX’s integrated credit card and debit card processing feature, please

note that you cannot perform a return on a debit card transaction, you must use credit card or per-

form a refund by other pay method.

For more information on invoices, see Invoicing.

Writing a Return in DVMAX
Returns must be written from the Client Finances tab. For more information on the Client

Finances tab, see Working with Client Records.

To write a return to a client in DVMAX:

l Choose Write a Return from the Finances menu on the Client Finances tab.

l The Select Primary Provider dialog appears. Choose a Primary Provider from

the drop-down list in the Select Primary Provider dialog.

l For information on choosing a Primary Provider, see Invoicing.

l The Return window opens, with a unique return number and the name client to

whom you are issuing this return as the title of the window.
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l If necessary, change the Default Dr. for this return by choosing a Doctor from

the Default Dr. drop-down list.

l If necessary, you can back- or post-date this return by typing a date other than

the current date into the Date field.

l Type the details of the product or service you are returning in a Line Item row.

Include the Quantity of the item being returned, Date (if different from the cur-

rent date), Staff (if different from the Primary Provider or Default Doctor), Item

Code, and whether the product or service being return was administered or dis-

pensed. Each product or service being returned uses one line item row. To add a

line item row, click Add Line.

If the line item being returned is a product, it will typically have been dispensed. If the line

item being returned is a service, it will typically have been administered.

Quantities must be negative when writing a return.

l DVMAX updates the Subtotal, Discount, Taxes, and Total fields as you com-

plete line items. These fields are not editable.

l If you are giving the client a refund, choose a refund method from the Refund

Method drop-down list.

l If you are giving the client a refund, type the amount of the refund into the

Amount field. You can also record any notes, such as the reason for the refund,

by typing them into the Refund Note field.

If you do not enter a refund amount, DVMAX will create a credit on the client’s account.
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If you are using DVMAX’s integrated credit card and debit card processing feature, please

note that some payment providers may not permit a return on a debit card transaction. In those

cases, you must use credit card or perform a refund by other pay method. If your payment proc-

essor does not permit a return using a Debit card transaction and you select Debit as pay

method, you will see an Alert message noting that this pay method cannot be used for a return.

l If you want to print this refund, select the Print checkbox in lower left of the

screen.

l Click OK to save the refund into the DVMAX system and print the refund (pro-

vided Print has been selected). DVMAX will return you to the client finances

screen.

Adding New Empty Line Items
A setting in System Constants controls the number of line items on a return. If the default

number of line items is insufficient for your return:

l Click Add Line. A new line item will be created, and your cursor placed in its

Qty field.

For information on setting the default number of line items on a return, see System Constants

That Affect Invoicing in the Invoicing section of this documentation.

Removing Empty Line Items
If there are more line items on a return then you need, DVMAX will automatically remove them

when the return is printed. Empty line items do not appear on printed returns. There is no need to

remove unused line items.

Editing a Line Item
Click in the field you wish to edit, and type the new value. Note that some fields are not editable

(Tx and Ext. Price), and that others are not editable most of the time (Description and Price).

Other fields that are dependent on the value you change will update automatically when you

enter your new value.

You can also edit a line item by clicking Edit Line Item.

Deleting a Line Item
To delete a line item:

l Click once on the line item you wish to delete. The line will be highlighted.

l Click Delete Line.
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Balances and Totals
The fields to the right of the Refund Method boxes show you the financial totals for this return.

Adding line items to a return updates these fields:

Subtotal: The total cost of all the line items on this return, before taxes and discounts.

Discount: The total of all discounts on this return. Discounts can be applied to any or all line

items. For more information on discounts, see Discounts.

Taxes:  Contains the total of all taxes on items listed on this return. Tax rates are set in System

Constants – see System Constants That Affect Invoicing in the Invoicing section of this doc-

umentation for more information. Whether an individual line item is taxable is determined in the

setup for that item – see the Bill Items chapter for more information.

Total:  Is the subtotal minus the discount, with taxes added.

Previous Balance: The amount owed by this client from any previous invoices.

Payments:  Total refunds issued with this return.

New Balance:  The amount owed by this client on all invoices. The New Balance is the sum of

the Total and Previous Balance minus Payments.

Discounts on Returns
You can apply a discount to any or all line items on a return. Line items that have a discount

applied are marked with an asterisk (*) following their description.

If a client has a Default Discount, DVMAX will automatically discount line items on a return

for this client. You can override this default discount. For more information on Default Dis-

counts for clients, see Working With Client Records.

You should discount items on a return in the same manner as they were discounted on the

original invoice.

Applying a Discount to All Line Items on a Return
To apply a discount to all line items:

l Choose Discount from the Return menu.

l The Discount Settings window opens.

l Type a percentage in the Discount Percentage field. DVMAX will discount the

price of all items on the return by the percentage you specify here.

l Select Discount All Items to apply the discount to all items on the return
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-OR-

l Select Discount Only Discountable Items to have DVMAX apply the discount

only to items marked as discountable. For more information on the difference

between these settings, see the Bill Items chapter of this manual.

l Click OK to apply the discount.

A setting in System Constants controls the availability of the Discount All Items radio but-

ton. If the Discount All Items radio button is not available, you will not be able to apply a dis-

count to line items that are not specified as discountable in their Bill Item setup. For more

information, see the Bill Items chapter of this manual, and System Constants that Affect Invoic-

ing in the Invoicing chapter.

Applying a Discount to a Single Line Item on A Return
To apply a discount to a single line item:

l Select the line item you wish to discount, then click the Edit Line button. The

Edit Line Item Window open.

l Type the percentage of the discount in the Discount box.

l Click OK to save your changes.

Not all items are discountable. For more information on discountable items, see Bill Items.

Viewing Past Returns
DVMAX lists all returns in the Recent Finances and All Finances areas of the Client

Finances tab. Returns are listed as type “Rtrn”.

To view a previously-posted Return:

DVMAX Practice V8.6 - User Manual



- 843 -

l Double-click the Return in either the Recent Finances or All Finances area of

the Client Finances tab.

-OR-

l Click once to select the Return you wish to see in either the Recent Finances or

All Finances area of the Client Finances tab.

l Choose View Item from the Finances drop-down menu.
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Shared Dictionary

DVMAX’s spell checking feature included in the Word Processing function relies on a dic-

tionary installed with the application.  This dictionary contains standard and medical references,

and new words can be added to customize the dictionary for your practice.  In order for all work-

stations at your location to have access to the same dictionary, you must set up DVMAX Pref-

erences to share a dictionary.

Selecting a Shared Dictionary

Setting the shared dictionary must be done on all workstations.

To set Preferences to Share a dictionary:

l Select Preferences from the File drop-down menu.

l Click to select the Assorted Prefs tab from the Preferences dialog.
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l From the Assorted Prefs tab, Click Add to Dictionary.

l Click Add from the Confirm dialog to continue and set up a Shared dictionary. 

Click Don’t Add to cancel and return to Preferences.

The steps to this point are the same for adding words to the existing dictionary as they are

for setting up a shared dictionary.  If you have already set up a Shared dictionary, clicking Add

will update your dictionary with any new words found in the database.  If you have not set up a

Shared dictionary, you will see a message window after you click Add.  You must continue

with the necessary steps as directed to set the shared dictionary.
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l If you have not set up a Shared dictionary, a message window opens directing

you to click the Options button on the window that opens next (the Spelling

dialog window) to set a Shared dictionary. It is not possible to cancel the oper-

ation at this point.

l Click Options at the bottom of the Spelling dialog to open the SpellingOptions

dialog.

l Select Shared from the Lexicon area of the Options window to make the dic-

tionary available to the current workstation. Click again to deselect.

l Click Accept to share the dictionary.

l The dictionary will be updated. This may take several minutes. A progress bar

will be shown.
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Species Records
Species records allow you to standardize the way you classify your patients in DVMAX. Setting

up Species records properly allows DVMAX to make certain species-specific adjustments to a

patient’s record.

Species records also allow DVMAX to prompt you to add Reminders when first creating a

patient record.

Species records are closely related to Breed records. See Breed Records for more information.

Search For Species Records
To find a Species record in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Species from the Search For drop-down list.

l Choose Species Code from the By drop-down list to search Species records by

code. You must type at least the first character of the species code you are

searching for.

-OR-

l Choose Keyword in Species to find any Species records by name.

l Type a Species code or name into the field below the By drop-down list. If you

are searching by code, you must type at least the first few letters of the species
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code. If you are searching by name, DVMAX will find all species that contain

the word you type.

l Click Search.

l If there is more than one match for your search, the Species List window will

appear, containing a list of items that matched your search.

l If there is only one Species Record that matches your criteria, DVMAX will

open that Species Record.

l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window to search again.
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You can also quickly locate a Species by following the steps in Listing All Species and dou-

ble-clicking the one you are interested in from the list.

Listing All Species
To list all Species defined in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find Window choose Species from the Search For drop-down list.

l Click All Records at the bottom of the Find Window. A list of all defined Spe-

cies displays.
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l Each Species is listed on an individual line.

Deleting a Species Record
To delete a single Species from DVMAX:

l Find and open the Species you wish to delete. See Searching for a Species Rec-

ord.

l Click Delete at the bottom of the Species window.

l DVMAX will ask you to confirm that you want to delete the Species.

l Click Delete. DVMAX will ask you two times to confirm that you wish to

delete the species.

l Click OK on each dialog to delete the species.

To delete multiple Species from DVMAX:

l List all Species (see Listing All Species).

l Click to select the Species you wish to delete.

l Choose Delete Records from the Species menu.
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l DVMAX will ask you to confirm that you want to delete the Species.

l Click Delete.

Species Names and Sex Nomenclature
Sex nomenclature is different for different species. DVMAX handles this by adjusting the

patient records for various species according to specific text in the name field of the Species

record. 

For example, for a species to be recognized as equine, the word “equine” must appear as part of

the Species name. This means DVMAX recognizes each of  “Equine”, “Horse (Equine)”, and

“Equine (Horse)” as an Equine species.

Below is a list of the specially recognized species and how they are reflected in the sex nomen-

clature of patient records:

Equine: If “equine” appears anywhere in the species name, sex nomenclature on the patient

record is automatically converted to equine terminology (Mare, Stallion, Gelding, Colt, Filly).

The “equine” keyword can also help trigger DVMAX to use the Thoroughbred aging system for

a patient. See Breed Names and January Aging in the Breed Records chapter for more infor-

mation.

Avian and Reptile: If “avian” or “reptile” appear anywhere in the species name, sex nomen-

clature on the patient record is changed so that the Spayed/Neutered field is instead a Sexed

/Not Sexed field. When the patient is marked as “not sexed”, the M/F options convert to “N/A”.

Creating a New Species Record
To create a new Species record in DVMAX:

l Choose Patient Codes from the Section drop-down menu.

l From the Find window, choose Species from the Search For drop-down list.
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l Click Add New at the bottom of the Find window.

l The New Species Record window opens.
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l Type a unique name in the Species Name field.

l Type a valid Antech requisition code in this field if you plan to use DVMAX’s

Antech barcode label feature.

See Species Names and Sex Nomenclature for information on special Species names.

l If desired, double-click in the Default Reminders field to add to the list of

default Reminders DVMAX will add when you create a record for a patient of

this species.

-OR-

l Choose Add Default Reminder from the Species drop-down menu to add to the

list of default Reminders DVMAX will add when you create a record for a

patient of this species.

Default reminders are used when you manually add the first reminder to a patient’s record.

They do not affect reminders added by invoices.

l The Add Default Reminder dialog opens.

l Type a code into the Reminder Code field in the Add Default Reminder

dialog. See Reminders for more information about Reminders.

If do not know the exact reminder code, type the first letter into the Reminder Code field

and press TAB. This will bring up a window listing all existing codes.
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l Click OK to save the Species record.

Linking DVMAX Species Codes to IDEXX Species Codes
The species codes that DVMAX uses to identify animal species may not be the same one used

by all in-house lab instruments and external lab providers. Linking the DVMAX species code to

the Provider code permits more accurate requisition information to flow from DVMAX to the

Provider and back.

l From the IDEXX Species tab, double click a DVMAX species record you want

to associate with an IDEXX species code.

l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Species List, click to select the IDEXX species to associate with the

DVMAX species record.

l Click OK to save the selection.

The DVMAX Species Code record is automatically updated when you link the DVMAX spe-

cies code with the Provider code in the Requisition Wizard.

Linking DVMAX Species Codes to VetLab Species Codes
The species codes that DVMAX uses to identify animal species may not be the same one used

by all in-house lab instruments and external lab providers. Linking the DVMAX species code to

the Provider code permits more accurate requisition information to flow from DVMAX to the

Provider and back.

l From the VetLab Species tab, double click a DVMAX species record you want

to associate with a VetLab species code.
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l If you like, use the Filter field to constrain the list of records to records con-

taining what you type.

l From the Species List, click to select the VetLab species to associate with the

DVMAX species record.

l Click OK to save the selection.

The DVMAX Species Code record is automatically updated when you link the DVMAX spe-

cies code with the Provider code in the Requisition Wizard.

Default Species Reminders
DVMAX can automatically present one or more Reminders to choose from when you first add a

Reminder to a patient’s record. These default Reminders are set in the Species record.

For information on adding a default Species Reminder, see Creating a New Species Record.

Modifying a Default Species Reminder
You can modify a default Species Reminder at any time from the Species record. To modify a

default Species Reminder:
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l From the Default Reminders list, double-click the Reminder you wish to

change

-OR-

l Click to select the Reminder you wish to modify in the Default Reminders list,

and then choose Modify Default Reminder from the Species drop-down menu.

l The Modify Default Reminder dialog opens.

l Type a different Reminder Code into the Reminder Code field of the Modify

Default Reminder dialog, or type the first letter into the Reminder Code field

and press TAB. This will bring up a window listing all existing codes.
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l Click OK to save the changed default Species Reminder.

Deleting a Default Species Reminder
You can delete a default Species Reminder at any time from the Species record. To delete a

default Species Reminder:

l From the Default Reminders list, double-click the Reminder you wish to

change.

-OR-

l Click to select the Reminder you wish to modify in the Default Reminders list,

and then choose Modify Default Reminder from the Species drop-down menu.

l The Modify Default Reminder dialog displays.
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l Click Delete. DVMAX closes the Modify Default Reminder dialog closes

returns you to the Species record.
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Staff Records
Adding and Editing Staff Records

To add new staff to the Staff Records:

l From the Section menu, select Patient Codes.

l From the Find dialog, select Staff from the Search for menu.

l Select All Records to see a list of all Staff records.

l To add a new record, click the Add new... button on the bottom of the window
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l From the Staff record you can view Staff details, including Staff Client records

l Add the Staff code, Staff name, Antech Barcode name and License # into the

text fields.

l Select the Doctor, Provider or Inactive Check boxes if appropriate.

Note: You cannot add or edit a Staff Client Record in the Staff Record. The link must be

made from the Client record.

To edit a Staff Records:

l From the Section menu, select Patient Codes.

l From the Find dialog, select Staff from the Search for menu.

l Input the Staff Code or select All Records to see a list of all Staff records.

l Select the appropriate Staff record. The Staff record displays.

l Make the required changes and select Ok.

Note: You cannot add or edit a Staff Client Record in the Staff Record window. The link

must be made from the Client record. See Creating a Staff Lab Dis

Creating a Staff Client Record

The Client Staff Record setting allows DVMAX to identify if a Client is able to receive Lab

requisition discounts. The setting creates a link to a current Staff record and adds the Client
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name to that Staff record. Only Clients with this Staff link will be able to receive discounts on

requisition billing.

To add a Client to a Staff Record:

l Open the Client record.

l Click the Finances tab.

l Within the Other information box of the Finances tab, click the Staff Client

Record box. Once the box is clicked you will be able to select the associated

Staff member and create the Client/Staff link.

l Select OK.
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System Constants and Preferences
System Constants, as the name implies, are settings that apply to DVMAX system-wide. Note

that the server must be restarted for changes to take effect. To access System Constants:

l From the Section drop down menu, select System Constants.

l The System Constants window opens to the Main Constants tab.

Main Constants

Data Audit Information
You cannot change information in the Data Audit Information area of the Main Constants tab.

Values reflect the last assigned number for each item: Last Client ID, Last Invoice #, Last

Transaction #, Last Appt #, Last Patient ID, Last Purchase #, Last Rx#, Last Appt Staff #.
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Financial Reporting
Select Prompt to Print or Export Financial Reports to ask the user whether they would like

to print or export reports to a .txt file (which can then be opened in a spreadsheet).

Backup Alerting

Use the Backup section to configure your automatic system backup notification. You can dis-

play an alert on the screen or send an email to an assigned email address if the back up fails.

Client Backup Alerting
If this setting is on and a backup fails, an Alert will appear under the Command Palette. When

Backup is Off, click Start to enable backup alerts.  To disable alerts, click Stop when Client

Backup is On.

Backup Alert Email Address
Type an email address in the Backup Alert Email Address field if you would like DVMAX to

send a Client Backup Alert email to the specified email address if the DVMAX backup fails.

Backup Alert Interval (Days)
Enter an interval, with value in days, for how often you would like DVMAX to check the status

of the backup.

Restore Backup Datafile
To restore your DVMAX system from a saved (Backup) datafile, click Restore and select the

datafile to use for the restore. Contact DVMAX Technical Support if you have questions or con-

cerns prior to running the Restore.

Spelling Setup
Click Spell Setup to open the dictionary editor.  Add, edit and delete words or import words

from another dictionary using Spelling Setup.
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Default Constants
To access Default Constants settings:

l From the Section menu, select System Constants.

l Click the Default Constants tab.

Location Preferences

l Default City –This sets the default city that will be used in a new Client record

under the Contact Info area.

l Default State – This sets the default State that will be used in a new Client rec-

ord under the Contact Info area.

l Default Zip Code - This sets the default zip code that will be used in a new

Client record under the Contact Info area.

l Default Doctor – You can assign a default Doctor for History entries. This set-

ting controls the Dr. or Provider initially selected in the Choose a Primary Pro-
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vider dialog that appears, for example, when you start a new invoice. Click the

Magnifying Glass to access a pick list of doctors.

l Clear Doctor - Click Clear Dr. to remove the Default doctor. Click the Mag-

nifying Glass icon to open a pick list of doctors.

l Site Code - If you have a multi-practice application, each site has its own three

letter code that is shown here.

Practice Preferences

This is where you define the name, address, and phone number of your practice, as it is to

appear on Invoices and correspondence.  You can also set the language for the program (English

or Finnish).

Zip lookups are supported when the country is specified as US, Canada or Finland in Sys-

tem Constants.

It is recommended you do not alter information in Currency Format field. Should you

require assistance, please call Technical Support.

Inserting a Clinic Logo (System Constants)

You can add your clinic logo in the Clinic Logo field in the Default Constants tab of System

Constants.  This logo will appear on printed invoices, estimates and similar documents.

To place a clinic logo in the Clinic Logo field:

l Open your clinic logo in a preview or other application where the logo can be

viewed, and from that application, click to highlight your logo and then click

Copy from the Edit menu.

l Go to DVMAX.

l From the DVMAX main screen, select System Constants from the Section

menu.

l Select the Default Constants tab.

l Click in the Clinic Logo field.

l From the DVMAX Edit menu, select Paste.

l The logo will be inserted in the Clinic Logo field.
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The image size must be 100 pixels x 100 pixels.  It will print out in the top left corner of

invoices, estimates, and returns, etc., at a size of 1” x 1”.  Larger images inserted in the Logo

field will be scaled to fit.

Account Preferences
Use this section to enter your business account preferences.

Bank Account - Enter your bank account number to be used with deposit slips in the End of

Day report.

Healthy Pet Account - If you use a Healthy Pet Account for your reminders, enter the account

number.

Company Number - This is typically used in countries outside Canada and the USA, and is

printed on the invoice and payment stubs for use with electronic payments.

WP Insertion Preferences

Use the WP Insertion Preferences section to set a default font, size, and style (bold, italics)

for inserting MREs or Findings into WP documents.  These preferences are used if the linked

MRCs/Finding Codes have no formatting information specified.

Client and Patient Settings
The Client and Patients tab in System Constants is used for settings that apply to a number of

client- or patient-specific constants, including some patient History preferences. To access the

Client and Patients tab:
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l From the Section menu, click System Constants.

l From System Constants, click the Client & Patient Settings tab.

Client Preferences

For Client Number, Display
When displaying a list of clients, this setting will either display the client’s ID number or file

number based on what you select here. This number is displayed on invoices, statements, and

reports. Refer to Searching For Client Records in the Client Records chapter for more infor-

mation.

Delayed Interest Default
Having this setting turned on will delay interest until billed for all new clients.  Refer to Setting

Billing Options for a Client under Client Records for more information.

Allow Referrals by Other Clients
Having this setting turned on will allow you to list another client of your practice as a referral

source for new clients and patients. Refer to Setting a Client’s Referral Source in the Client
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Records chapter, and Setting a Patient’s Referral Source in the Patient Records chapter for

more information.

Quicker Client Entry
Enable this setting to allow you to enter multiple clients quickly, one after the other.  DVMAX

will bring up a new client record as soon as you click OK on the previous client screen, or as

soon as you click OK & Next Client on a patient screen.  Refer to System Constants That

Affect the Client Record in the Client Records chapter for more information.

Set Visit Reasons

The Set Visit Reasons area of System Constants allows you to Add, Delete or edit visit reason

records. The Visit Reasons list is displayed when you Check In an appointment from the Sched-

uler. The Scheduler’s Check In functionality requires that you select a visit reason.

To Add or Edit Visit Reasons:

l From the Client Preferences area of the Client and Patient Settings tab of Sys-

tem Constants, click Set Visit Reasons.

l Click Add to create a new Visit Reason. The reason name will default to “Rea-

son (number)”. Edit the reason name as needed,

l Select a reason and click Delete to remove a visit reason from the list. From the

confirm dialog, click OK to continue and delete the reason, or Cancel to go

back to the Reasons list.

l To edit a visit reason, click to select the reason, then click the reason name

field. Edit the name as preferred.

Further detail on this feature, which has been introduced with DVMAX 7.6, will be pro-

vided as soon as the remaining functionalities are enabled. At present, Set In Hospital and Set

Reminder Compliance actions are not linked to Visit Reasons.

Deleting or editing visit reason records may leave other records incomplete.

Patient Preferences

Use Species Specific Breeds
Enable this setting to only allow you to enter a breed that exists under the species selected when

you enter a new patient.
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Start in Name Field
Enable this setting to place the cursor in the Name field on the patient’s General Information tab

when entering a new patient.

Suppress Rabies # Request
Enable this setting to prevent DVMAX from asking you to enter the rabies tag number when

putting a rabies vaccine onto a patient’s record.  If enabled, you can manually enter a rabies tag

number on a patient’s record if needed. To have DVMAX automatically ask for a rabies tag

number, refer to the chapter Rabies Information Records. 

Add Year to Rabies Tag Numbers
Enable this setting to add the current year to the end of an assigned rabies tag number.

Add Stables via Patient Screen
Enable this setting to allow you to enter a new stable directly from the patient’s record. 

Add Trainers via Patient Screen
Enable this setting to allow you to enter a new trainer directly from the patient’s record.

Add Referrals via Patient and Client Screen
Enable this setting to enter a new referral source directly from the patient’s record. For more

information, refer to Creating a New Referral Source Record in the Referral Source Rec-

ords chapter.

Canine Name
Type the word Canine and this will activate the BSA button for any patient marked as a canine.

Feline Name
Type the word Feline and this will activate the BSA button for any patient marked as a feline.

Rx Label Copies
Type the default number of Rx labels to print.  You can still change the number of labels to print

before printing a Rx label.
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Include Dates
With WP reminders, select to include the due dates when pulling reminders into a word proc-

essing documents.  With WP history, select to include the date of each entry when pulling his-

tory entries into a word processing document.

Default Weight Measure
This is the default weight measure for all new patients.  However, the weight measure can be

changed on a patient’s record if the default measure is not the desired measure.

VetEd CSV Path
Sets the VetEd CSV path. This field is only labeled when running DVMAX under a Windows

environment, not Macintosh.

History Preferences

Display and Print History Entries
Select Oldest entry first to display and print a patient’s history with the oldest entry first, in

chronological order, or selectMost recent days first to display and print a patient’s history with

the most recent entry first, in reverse chronological order.

Suppress Blank Findings from Text View
Enable this setting to suppress any blank finding item when viewing a patient’s history in text

view, when printing the patient’s history, and when pulling history entries into a word processing

document.

Include Time on Patient History Printout
Enable this setting to print the time each entry was entered into the patient’s record when the his-

tory is printed.

Limit Printed History Length
Enable this setting to limit the patient’s history when printed

Limit To
Type a number of entries and select Limit by Count to limit the patient’s history to a set number

of entries when printed.  Type a number of days and select Limit by Date to limit the printed
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history to a set number of days back from the current or selected date.

Web History Preferences

When allowing referring veterinarians to log into your system to see their patients’ records, you

can limit the number of days of history they can view. Type the number of days of history in the

# of days to display field. For more information, refer toWeb Patient Reporting.

Default Notes for Rabies Certificate, Health Certificate and Billing Notes
Default notes included with the Rabies Certificate, Health Certificate and Billing Statement are

written here. Different formats for the Rabies Certificate can be chosen from the Rabies Cer-

tificate format drop-down menu above the Rabies Certificate Note field on the right side. Type

the default note, or paste the note from another document, into the appropriate note area. Use the

Spell Check button to check the spelling of your note before you save.

Finance Constants
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The Finance Constants tab under System Constants includes options for financial settings such

as annual finance rate, sales tax rates and some receivables aging options.

Finance Constants Billing Options

Finance Rate (Annual)
This is the percent interest or finance rate that you will charge for unpaid balances.

Billing Grace Period
Specify the amount of days from the date of the invoice that you will begin charging the finance

rate (if you enter 30 in this field, the system does not begin charging finance rate until the bal-

ance is 30 days old).

Billing Charge
This is a fee that you might charge (in place of, or in addition to the finance rate). The reasoning

for this charge is that if you need to send a statement to a client due to an unpaid balance, you

need to pay someone to print it out, put it in an envelope, pay for postage, etc.
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Minimum Billing Balance
This is the least amount that you are willing to send a statement for.  Some hospitals don’t think

it is worth the time and postage to send a statement if someone only owes $2.00, for example. 

Enter the minimum dollar amount in this field. A common entry here is $5.00.

Billing Charge During Grace Period
This setting allows you to choose if you want to charge the billing charge even during the billing

grace period.  For example, if the unpaid balance is only 10 days old and the billing grace period

is 30 days, they would be charged the billing charge, but not the finance rate.  Select this setting

to charge the billing charge during the grace period. Clear this setting to prevent charging the bill-

ing charge until after the grace period.

Detailed Billing for All Clients
This setting allows you to choose if you would like detailed statements to print for all clients

with a balance. A detailed billing statement differs from a regular statement in that it contains

simplified copies of recently unpaid invoices on the statement.  The regular statement only

shows the invoice number, the patient on the invoice, and the total of the invoice. There is a set-

ting on each client record to allow you to print detailed billing statements for that client.

Default Payment Due Delay
This setting only applies if the Practice Language Preferences in System Constants is set to a

language other than English.  This setting is used as the basis of a due date calculation for some

non-English invoices.  See Multi-language Support for more information on this setting.

Management Reports

Use Fast Sales Reporting
This setting will allow reports such as the Detailed Sales Report to calculate quicker.

Sales Tax Rate

This area contains tax rate(s) used when calculating tax on invoices and estimates. To add a tax

rate, double click in the Sales Tax Rate field, or click on the Sales Tax menu at the top of the

screen and choose Add New. To modify a tax rate, double-click the appropriate tax rate. Gen-

erally, in the US there should only be one tax rate listed.

Tax rates are stored in a separate table.
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Receivables Aging Options for Backdated Invoices

This setting controls whether the default Receivable Aging Date for backdated invoices remains

at the current date or is changed to the new date on the invoice. Select

Date Invoice Entered if you would like backdated invoices to use the date the invoice was

entered or choose Date Service Performed if you would like to use the date the service was

performed.

General Ledger

Contact DVMAX Technical Support for details on using the settings under General Ledger

(Force Use of GL Accounts and GL Reporting Dept).

Invoice Settings
Use constants on the Invoice Settings tab to specify how your practice would like to format

invoices.
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Initial Invoice Settings

Use the Initial Invoice Settings section to specify the properties of a new invoice. For more

information, refer to Invoicing, System Constants That Affect Invoicing. See also the

Assorted Preferences tab (from the File menu, select Preferences), and refer to Assorted

Prefs in this chapter.

Default Line Items on a New Invoice: Set the number of empty line items that appear on a

new invoice.

Always Ask For Certificates: Select Always Ask for Certificates to cause the Certificates

dialog to appear every time you finish an invoice. This allows for easy certificate printing after

every invoice. Most often, you will leave this setting cleared because the Certificates setting in

appropriate Bill Items is a more efficient way to handle certificate printing (for more infor-

mation, see the Bill Items chapter of this manual).

New Invoices Default To Unfinished: This setting controls whether the Finished check box is

selected or not when you create a new invoice in DVMAX. If you want new invoices to default

to unfinished, select this checkbox, otherwise leave the checkbox blank and invoices will default

to Finished (the Finished checkbox on a new invoice will be selected by default).

Suppress Auto Entry Of Payment Amount: This setting tells DVMAX whether to auto-

matically fill in the client’s balance in the Payment Amount box when accepting a payment. If

selected, the client balance will NOT appear in the Payment Amount field when taking a pay-

ment.

Line Item Dates Enterable: This setting tells DVMAX to allow you to enter the dates for line

items directly on the line items themselves while creating the invoice. This setting is particularly

useful for practices that enter invoice information after the fact (for example, field visits and hos-

pitalized patients).

Use Single Click for Line Item Entry: This setting determines whether a single or double-

click in a line item field is required to edit that line item.

Invoice Copies To Print: In the Invoice Copies to Print field, type how many copies of an

invoice will be printed when you click Print from the open invoice.

Skip to First Empty Line: This setting determines whether DVMAX places the cursor in the

Qty field of the first empty line item when re-opening an unfinished invoice or the first line item

of that invoice.
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New Invoices Default to Print: This setting controls whether the Print check box is selected

or not when you create a new invoice.

Audit Invoice Line Item Deletions: This setting controls DVMAX’s behavior when deleting

line items. If this setting is disabled, line items when deleted will simply disappear from the

invoice. If enabled, DVMAX records the Date, Time, User, Station, Invoice number and line

item details in a Deletion Log (General Management).

User Initials Required to Finish Invoice: This setting determines whether DVMAX requires

the user to type their initials when an invoice is finished. If you select this setting, users will be

prompted to type their initials before an invoice can be finished and saved.

When Modifying an Invisible Invoice: If this constant is selected, then when you switch

between patients using the Next/Previous buttons, and there is an invisible invoice running,

DVMAX will ask for the Dr. on each switch, and will use that Dr. as the default value for

invoice line items, and for MRE entries. There are three possible options:

l Confirm Doctor With Default -When you switch between patients using

the Next/Previous buttons, and there is an invisible invoice running,

DVMAX will ask for the Dr. on each switch, but the Dr. listed in System

Constants under Default Settings will be the default Dr. that appears when

the box comes up. DVMAX will then use that Dr. as the default value for

invoice line items, and for MRE entries.

l Do Not Confirm Doctor -When you switch between patients using the

Next/Previous buttons, and there is an invisible invoice running, DVMAX

will NOT ask for the Dr. on each switch.  DVMAX will use the doctor

listed on the previously started invisible invoice.

l Confirm Doctor Without Default -When you switch between patients

using the Next/Previous buttons, and there is an invisible invoice running,

DVMAX will ask for the Dr. on each switch, and you will be forced to

choose a specific doctor. 

Discount Settings

Use this section to define the discount percentages for your practice, where applicable.

Max Discount Percentage: This percentage is the maximum discount that can be applied to

any item on an invoice. If no number is specified, the maximum discount is 0%, that is, no dis-

count can be applied on an invoice.
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Use Global Discounting on Invoices: This setting determines if the Discount All Items radio

button is available. Enable this setting to allow discounting of all items on an invoice. For more

information, refer to Applying a Discount to All Line Items in the Estimates chapter of the

DVMAX manual.

Discount Label: The text entered in this setting will appear on the printed invoice beside the

discount amount. The default text is discount.

Discount Add-On Fees: This setting tells DVMAX whether to apply a discount to the Add-on

amount defined for a Bill Item. This gives you the option of always charging the full Add-on for

every item, or discounting the add-on fee along with the price of the item itself.

Processing and Printing Settings

For more information on invoicing settings, refer to Invoicing, System Constants That Affect

Invoicing.

List Invoice Patients in Transaction: Enable this setting to include patient names in the record

of an invoice transaction. This is the recommended setting.

Print Practice Heading On Invoice: If enabled, DVMAX will print your practice’s name and

address at the top of invoices.

Post History and Discharge Notes From Unfinished Invoices: This setting determines when

DVMAX transfers (or posts) a line item on an invoice to a patient’s history. If enabled (check-

box is selected), DVMAX will post from an invoice to a patient's history, regardless of whether

Finished is selected on the invoice.   If not selected, DVMAX will wait until you mark the

invoice as Finished before transferring a line item to the patient's history.

Include Bill Codes on Printed Invoices and Estimates: Enable this setting to print Bill Codes

as part of the description of line items on an invoice.

Remove Price Details and Tax Column from Printed Estimates: Enable this setting to make

it easier for clients to read a printed estimate, by removing the Lo Price, Hi Price and Tax col-

umns from the estimate.

Print Client Phone on Invoices: Enable this setting to print the client’s phone number on

invoices.
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Ignore Rx Info for Prescription Labeling: This setting tells DVMAX whether to notify you

when you try to print a prescription label from an invoice for a Bill Item that is out of stock. If

enabled, the system will use whatever lot information is on hand, or proceed with the pre-

scription labeling even if there is not enough in existing lots to fill the current prescription or

refill. 

Print Staff Code on Invoice Line Items: This setting controls whether the staff codes on an

invoice’s line items appear on the line items on the printed invoice.

Print Reminders on Invoice: This setting controls which Reminders, if any, are printed on

invoices.

l Never - No reminders will be printed on invoices

l Patients on Invoice - Only reminders for patients that appear on the Invoice

will be printed.

l For All Clients’ Patients - All reminders for all patients for the invoiced

client will be printed. This is the default setting.

Exclude Inactive Clients when Printing Statements: This setting controls whether DVMAX

will include clients marked as Inactive when printing statements (from General Management).

If selected, Inactive clients are not included in statements.

Auto Display Rx Label Printing Dialog: If this setting is enabled, DVMAX will automatically

display the Prescription Labeling dialog after you enter a prescription item on an invoice line, or

when you add it as an MRE in patient history.  Selecting this setting eliminates the need to use

the Prescription label button on the Invoice screen.

Keep Line Item Providers When Converting Estimates: If this setting is selected, line items

on the invoice’s Staff field will contain the same values as on the originating Estimate. If this set-

ting is cleared, DVMAX will force each line item's Staff box to contain the Default Provider

from the Estimate.

Automatic Invisible Invoice: This setting controls whether DVMAX automatically opens an

Invisible Invoice when you open the Patient History screen. A Confirm dialog opens asking if

you want to enable DVMAX Guaranteed Charge Capture. Click Yes.

Invisible Invoicing: Disable “No Invoice”: If this setting is on, DVMAX will not present a

“No Invoice” option when asking for a Primary Provider or other information before opening an

invisible invoice.
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Prevent back Dating of Invoices and Transactions: This setting prevents the user from enter-

ing dates before the current date on invoices and new transactions, and even when editing

invoices (if the payments are entered again).  If you select Prevent Back-Dating of Invoices

and Transactions, DVMAX implements the following behaviors in regard to invoices and trans-

actions:

l On new invoices, the Date field is prevented from being set to a date before

the current date. This restriction is also true for the Aging Date field.

l When an invoice is backdated, the date is automatically forced to the current

date, but the line items are set to the back-dated value that the user entered.

l New transactions are prevented from being set to a date before the current

date.

l When editing an invoice, if payments are not kept with the new invoice,

DVMAX will generate new receivables and transaction records. These are

constrained to the current date. As well, on the newly created invoice, the

Invoice Date and Invoice Aging Date are constrained to the current date.

The invoice line items on the newly created invoice do not have their dates

constrained.

Exclude Previous balance from Printed Invoice: Selecting Exclude Previous Balance from

Printed Invoice allows a clinic to remove the Previous Balance box and label from a printed

invoice.

Estimate Label: In cases when a clinic decides that the term “Estimate” does not accurately

represent the service being offered, the label can be changed to better reflect the service

offered.

Lock Line Items: Locking Line Items means that when an item is placed on an invoice it is not

able to be altered in any way, or deleted.  Check this box if you would like to take advantage of

this feature.

Lock Delay Hours: Set a time limit for the line items to be modified before they become

locked.

Unlock Password: Enter a password that can be used to “Unlock” the line item if necessary

Invoice Notes
Use the Invoice Notes constants in this section to determine how your Invoice Notes appear.

Zero and Non-Zero Balance Notes will only display the first 2 lines on a printed invoice,

although you can type more text if desired.
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Default Invoice Note: This note will appear at the bottom of every invoice, in the Discharge

Notes field of the invoice.  Many hospitals change this note for different times of the year (heart-

worm month, dental month, holiday notes).

Default Estimate Note:  This note appears at the bottom of every estimate.  This is usually an

estimate “disclaimer” that reminds clients that this is just an estimate and the possible risks

involved, and so on.  Most hospitals also include a line for the client to sign approving the esti-

mate.

Discharge Note Separator: The text that will appear before each discharge note on an invoice.

Contents of this field separate multiple bill item notes on the bottom of an invoice. 

Some hospitals choose to insert a few carriage returns (<Enter> key) and then type the text

“***PLEASE NOTE”.  This will separate each note with some empty lines and then begin each

note with ***PLEASE NOTE.

Zero Balance Note: This note appears at the bottom of any invoice that has a zero balance.

This means that the invoice was paid in full.  It is generally used to thank the owner for prompt
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payment. You may elect to leave this field blank.  Only the first 2 lines of text will show on a

printed invoice.

Non-Zero Note:  This note will appear at the bottom of any invoice that does not have a zero

balance, that is, the invoice was not paid in full, or if they had a previous balance. This is gen-

erally used to state the interest rate for unpaid balances. You may elect to leave this field blank.

Only the first 2 lines of text will show on a printed invoice.

User Settings

OTC Staff

OTC staff code: Enter the staff code that you have set up for an over-the-counter sale in the

staff section. Most likely it will be OTC.

Clear OTC: This will clear the OTC staff that you have selected.

User Defined Fields
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User Defined Client Label 1: Use this label to define this field’s contents on the client Gen-

eral Information screen.

User Defined Client Label 2: Use this label to define this field’s contents on the client Gen-

eral Information screen.

User Defined Patient Label 1: Use this label to define this field’s contents on the patient Gen-

eral Information screen.

Statement Settings

Top of Page Gap: Enter the number of spaces left at the top of the page before starting to print

a statement.

Between Addrs Gap: Enter the number of spaces between the address of the clinic and the

client address.

Push Client Addr: Enter the number of spaces to push the client’s address to the right.

Path to Images Folder

Path to Images Folder: This is the path from the workstation to the images folder on the

server.  Please have your IT technician set this path on each workstation.

Set: Click to select the path created by your IT technician.

Web (System Constants Default Settings)

Web: Enable this setting to allow your referring veterinarians to log in and view their patient’s

history.

Start Web Server: To use the web-based services, you must start the Web Server, and enter a

working port number for the service to use. Refer to Starting the Web Server in the Patient

Records chapter for more information.

DVMAX Practice V8.6 - User Manual



- 884 -

Start Web Server Automatically: Select to start the web server automatically whenever

DVMAX is restarted. Refer to Starting the Web Server in the Patient Records chapter for

more information.

Faxing
DVMAX lets you to fax documents directly from a patient, client or referral source record.  The

fax feature requires a special license to use.  Contact DVMAX Technical Support for more

information. See also the chapter Fax Client.

Fax Server: Displays the fax server and port.

Set: Click Set to set the Fax Server and port.  Hold down the <Shift> key to enter a remote Fax

Server address.

Username: Enter your user name.

Password: Enter your password.

Custom Reports
From time to time, new Custom Reports are added to DVMAX.  Use the Reload from Server

function to update your Reports list.

Reload from server: Click to refresh the list of available custom reports.

Appointments

As of DVMAX v7.6, you will find Appointment Settings located under Setup from the

Appointment scheduler.  See the chapter, Appointments, for more information.

Multiple Card Settings

Top of Page Gap: Enter the number of spaces to leave at the top of the page when printing

reminder cards.
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Between Cards Gap: Enter the number of spaces between each card when printing reminder

cards.

Misc

Pending Refresh Interval: Enter the value in seconds for how often the pending treatments list

will update.

Labs Initials Required: Enable this setting to require users to enter their initials when altering

labs on the Labs tab on the Command palette.

Pending Display Hospitalized Patients from Local Site: Enable this setting to only display

hospitalized patients, in the Pending tab, for the local site.  Clear the setting to display hos-

pitalized patients for all sites.

Use Macros: Enable this setting to allow you to use macros.  See the Macros chapter for more

information.

Datafile Label
Datafile Label: This is the name of your datafile, and the name that will appear in the windows

list.

WP History Delimiters
Load WP Logo: To include a logo on your WP documents, load the logo here.  Click Load WP

Logo to import the logo. Check with DVMAX Technical Support before loading your logo to

make sure the size of the logo is appropriate, as too large a logo will create display problems. 

Clear WP Logo: To clear a previously loaded WP logo, click this button.

Individual History Entries: When displaying history in paragraph form in a word processing

document, the characters or text you type here will display at the beginning of each individual

history entry within that history class.

Findings Headings: When displaying history in paragraph form in a word processing document,

the characters or text you type here will display at the beginning of each finding class section.
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Finding Items: When displaying history in paragraph form in a word processing document, the

characters or text you type here will display at the beginning of each finding item within the find-

ing class.

DVMAX PACS Link Settings
This is the area where you will set the server information for the DVMAX PACS Link so that it

will send information to and from DVMAX. Contact DVMAX Technical Support for more

details on this

DVMAX PACS Link server address: Your DVMAX PACS Link server address.

Test PACS Link: Click to test PACS Link server address.

Search Defaults

From the Search Defaults tab you can determine what the default Search By item will be for a

given Search For record type on a Find dialog.  For example, when you select Clients from the

DVMAX palette, it brings up a Find dialog that gives you the option to search For Client records

and Search By a list of options.  Using the Search Defaults tab, you can select what Search By

item is listed first on the By drop down menu.

To set the Default Search option for a specific Record Type:
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l From the Record Type list box, click to select the record type you want to edit.

l From the Default Search list box, click to highlight an item on the list.  The high-

lighted item will automatically become the default Search By option on the Find

dialog for the associated record type.  In other words, it will be listed first on the

Search By drop down menu for the Record Type you are working with,

Cage Setup

Cage Setup is no longer located under System Constants.  As of DVMAX v7.5, you will

find Boarding Setup located under Setup from the Boarding window.  See the chapter,

Boarding, for more information.

Treatment Plans
You can create Standard Treatment Plans (Saved Treatment Plans) for use when creating individ-

ual treatment plans for patients under the Treatment Plan tab. Plans already created are listed

on the Treatment Plans tab in the Standard Treatment Plans area.  See the Treatment Plans

chapter for more information on creating and working with treatment plans.
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The lists of Treatment Plan codes in System Constants can be sorted by clicking in the col-

umn headers.

Adding and Deleting Standard Treatment Plans (in System Constants)
To add a new treatment plan:

l Click Add below the Standard Treatment Plans box. In the window that dis-

plays, assign a name to the treatment plan.

l Click Add in the pop up window to add a treatment to the plan. 

l Enter the MRC for the treatment you wish to add.

l Enter quantity, units, start delay, frequency, and duration. The Start Delay,

Frequency, and Duration are explained below. 

l Enter any Notes for the treatment in the Notes area. 

l Click OK to add the treatment to the plan. 

l Once all treatments have been added to the plan, click OK to save the plan.

To delete an existing plan:

l Highlight the name and click Delete below the Standard Treatment Plans box.

Treatment Plan Settings
Exclude Summary from Contents: Select to prevent entering a summary of the treatment into

the notes section of the associated MRE.

Max # To Do items: Enter the number maximum number of To Do items that can be scheduled

on a treatment plan.

Start Delay (Treatment Plan in System Constants)
The Start Delay is when you would like the treatment to first begin; 1 hour would be one hour

from the current time. See the Treatment Plans chapter for more information.

Schedules (Treatment Plan in System Constants)
Schedules gives you the ability to set specific times you would like treatments to be done. 

When creating a treatment you can use the schedule to assign a time. If you would like a treat-
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ment to be done twice a day but not exactly twelve hours apart, this would be what you would

use.  See the Treatment Plans chapter for more information.

Frequencies (Treatment Plan in System Constants)
Frequencies are how often you would like a treatment to be performed; every twelve hours, once

a day, etc.  See the Treatment Plans chapter for more information.

Durations (Treatment Plan in System Constants)
Durations are how long you would like a treatment to be scheduled for; three days, one week,

etc.  This often will be the length of the patients stay or when a Doctor would like to re-evaluate

the treatment plan. See the Treatment Plans chapter for more information.

Adding/Deleting Start Delay, Schedules, Frequency or Duration

To add a Start Delay, Frequency or Duration:

l Select the appropriate tab, and click Add below the box. A pop up window

prompts you for a mnemonic; this is an abbreviation you may use to quickly

choose.

l In the Full Text field, enter the description of the time length you are creating.

l Enter the length in hours. For example, if you are creating a start delay of one

hour, the mnemonic would be 1h, the full test would say one hour, and the # of

hours is 1. 

l Click OK.

To add a Schedule

l Select the Schedule tab, and click Add below the box. 

l In the pop-up window that appears, specify the abbreviation in the Mnemonic

field.

l Enter a description in the full text field. 

l There are four time slots; all slots do not have to be used.  Leaving a time of

00:00 or 12 am will register as empty. To create a schedule for 8am and 5pm

treatment time the mnemonic might be 8/5, the full text would read 8am and

5pm, next to Time 1 would be 08:00:00 and next to Time 2 would be 17:00:00.

Enter Times in a 24-hour format.

To delete an item
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l Select the appropriate tab, highlight the item, and click Delete below the box.

Email Reminders
Use the Email Reminders tab to configure your system for using email reminders.  The email

settings here will also apply to other emailed documents, such as statements delivered via email.

Servers
Refer to Emailing, Sending Email from a Patient Record and Setting Up the Email Func-

tionality for more information.

Outgoing Mail: This is the outgoing mail server (referred to as the SMTP server) that will proc-

ess the emails being sent from DVMAX.

Account Name: Enter the account name you use to log into your outbound mail server.

Password: Enter the password you use to log into your outbound mail server.
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Use POP Before SMTP: Select this setting if your ISP required POP before SMTP. Contact

DVMAX Technical Support if you are not sure about your email settings.

Test: Click to test that the email feature is working correctly.

Incoming Mail: Enter the incoming mail server (POP server) to process the emails being

received in DVMAX.

Account Name: Enter the account name you use to log into your inbound email server.

Password: Enter the password you use to log into your inbound email server.

Test: Click to test that the email feature is working correctly.

Download Directories
This specifies where your mail and attachments will be downloaded.

Mail: Shows you what folder you have selected (if any) for your mail to be downloaded to.

Select Folder: Click to select a specific folder to receive downloaded mail.

Attachments: Shows you what folder you have selected (if any) for your attachments to be

downloaded to.

Select Folder: Click to select a specific folder to receive downloaded attachments.

Options

From Address: Inserts this address into outgoing emails as the address the email was sent

from.

Reply To Address: Inserts an address that the recipient of the email can reply to if necessary.

Send Reminders By Email If Possible: Enable this setting to use the email reminders feature.

DVMAX Practice V8.6 - User Manual



- 892 -

Email Subject: Allows you to insert a default email subject for outgoing emailed reminders.

Days Between Reminders: Allows you the ability to set a number of days between each time

a reminder card is emailed/printed and mailed to a client, allowing you to run reminders as often

as you’d like without worrying about sending the same reminders to the same clients week after

week (for example).

Check For Bounces: Allows you to check for bounced back emails due to incorrect or no

longer in use email addresses.
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Treatment Plans
A treatment plan is defined by DVMAX as a scheduled series of one or more “To Do” items

that relate to a particular course of treatment.  The Treatment Plans listing from the Section

menu of the DVMAX main screen provides a list of all treatments due or pending for a patient. 

You can also view pending Treatment Plan items for a specific patient from the Patient’s

record.  When a selected treatment plan item is completed by clicking Perform, the associated

treatment is recorded as an MRE in the appropriate patient record.  The patient’s record does not

need to be open to do this.  Completed or Performed treatment plan items are also recorded on

the invoice.

The Treatment Plans Facility:  A Quick Overview
Pending treatment plan items for a particular patient can be viewed from a patient record.  How-

ever, you can use the Treatment Plan facility, accessed from the Section menu, to view a list of

all pending treatment plan items for all patients.  These items can be edited and completed with-

out having to open the patient record.

To view the Treatment Plan item listing:

l From the Section drop-down menu, click Treatment Plans.

l A Treatment Plan Items list containing all scheduled procedures, due dates

and other key details is displayed, by default sorted by time, date, and patient.
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l To find items that apply to a specific patient, enter the patient’s name or file

number in the appropriate fields at the bottom of the list.  The list will be filtered

according to the information you type.

l To filter the list by all items due within a specified date range, type the start

date in the From field and the end date in the To field.  You can also use the

Calendar to enter dates. To see all items due today, click the Today button.

Click inside the list area to filter by the date range typed.

l If applicable, you can filter the Treatment Plan list by treatment room by select-

ing a location from the Room drop-down menu.

l By default, Completed items are hidden.  To view all Treatment Plan items,

including those already completed, deselect Hide Completed.

l To view the details of a Treatment Plan item, double click an item.
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Completing a Treatment Plan Item

As procedures on the list are administered, they can be marked as “Done” from the Treatment

Plan list.  There are 3 ways to mark an item as completed from the Treatment Plan listing, and

they will allow you to add an MRE to the appropriate patient record and add the associated bill

item to an invoice.  You can also go to a patient record to complete a Treatment Plan item.

To mark an item as completed:

l From the Treatment Plan list, click to select the item you wish to mark as com-

pleted.

l Click Perform.

l An Add New Medical Record Entry window opens.  The appropriate Medical

Record Code is already entered on the MRE window.

-OR-

l Double click on an item from the Treatment Plan Items list.  This opens an

Edit Treatment Plan Item window.  Click Perform.
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l An Add New Medical Record Entry window opens.  The appropriate Medical

Record Code is already entered on the MRE window.

l Select a staff member from the Staff drop-down list.

l Where applicable, click Findings to add findings to the MRE.

l Click OK to add the MRE to the patient file.

-OR-
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l Double click on an item from the Treatment Plan Items list.  This opens an

Edit Treatment Plan Item window.

l Click the Completed check box.

l Click OK.

By default, DVMAX displays only uncompleted items on the Treatment Plan list.  To

view completed items as well, deselect the Hide Completed Items checkbox. 

When completing Rx treatment plan items from the "pending" list, by default DVMAX does

not display the Rx labeling dialog. This behavior can now be changed via an advanced setting. 

If you would like to have the Rx labeling dialog display, contact DVMAX Technical Support

and discuss adjustments to this default setting.

About the Edit Treatment Plan Item Window

The Edit Treatment Plan Item window contains information about the treatment plan item,

including patient and client names, patient species and notes about treatment details.  Some

details, such as the staff to which the treatment plan item is assigned, can be modified from this

window.

Adding and Performing Treatment Plans on a Patient Record
Treatment Plans are added from a Patient record, though the Plan can be completed from either

the Treatment Plan listing under the Section menu of the DVMAX main screen or from a Patient
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record.

Adding a Standard Treatment Plan to a Patient Record: An Overview
Standard Treatment Plans are saved plans that are created under the Treatment Plan tab of Sys-

tem Constants. Refer to that section in the chapter System Constants for more information. To

select a Standard Treatment plan to add to a Patient record:

l Open a Patient Record.

l Select the Treatment Plans tab.

l To choose a Standard Treatment plan, select the Select button.

l The Select a Standard Treatment Plan window will appear.

l Select one of the listed Treatment plans.

l Click Select.

l The Treatment Plan window opens.

l Make any required changes to the Treatment plan.

l Click OK.

The Treatment Plan is then added to the Treatment Plan list. Once the Treatment Plan is in the

list you are able initiate this Treatment Plan. To Perform a To Do item related to a Treatment

Plan:

l Select the Treatment Plan To Do item from the list.

l Click Perform.

l The Treatment Plan To Do item dialog opens.

l Make any edits to the treatment plan item, as needed.

l Click OK.

Adding a New Treatment Plan to a Patient Record: An Overview
To add a New Treatment plan to a Patient record:

l Open a Patient Record.

l Select the Treatment Plans tab.

l Select Create.

l The Create a Treatment Plan window opens.

l Click Add.

l Create the Treatment plan including Code, Quantity, Duration, Frequency,

Schedule, Duration and notes.

l Click OK.
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The New Treatment Plan is the added to the Treatment Plan list. Once the Treatment Plan is in

the list you are able initiate this Treatment Plan. To Perform a To Do item from the Treatment

Plan:

l Select the Treatment Plan To Do from the list.

l Click Perform.

l The To Do Item dialog opens.

l Make any edits to the item, as needed.

l Click OK.

Create a Treatment Plan
A treatment plan can only be added or built from a patient record. To build a treatment plan:

l From a patient record, select the Treatment Plan tab. 

l Click Create to build a custom plan, or choose Select to load a saved plan.

l This opens the Treatment Plan window.

l In the Name field, type a name for the Treatment Plan.  If you choose a

saved plan, the name of the plan will already be defined.

l From the Treatment Plan window, click Add.  This opens the individual

Treatment Plan Item detail window.

l From the Treatment Plan Item window, type an MRC in the Code field.

-OR-
l Type a partial code and press <TAB> to display an MRC lookup window,

then select a code from the list.

l In the Quantity box, type the quantity of the selected procedure to admin-

ister each time treatment is given.  For example, type the number of tablets

of a medication to be administered per treatment.   If 3 tablets are to be

given at each interval, the Quantity is 3.  For procedures such as exams, the

Quantity is typically 1 per interval.

l Type the unit of measurement as it relates to the administered procedure (if

applicable) in the Units box.

l If you want to use the Schedules option, click the Use Schedule checkbox.  The

Interval drop-down list will be replaced with a Schedule drop-down list, and a First

Day Times box will display below the Duration field.

l Choose a start time from the Start Delay drop-down list or type a Start

code.  The Start offset value determines when the treatment plan should

begin.

l Choose an interval from the Frequency drop-down list or type a Frequency

(interval) code.  This indicates how often to administer the treatment.  If you

clicked the Use Schedule checkbox, the Frequency drop-down list will be
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replaced with a Schedule drop-down list.

l Select the duration from the Duration drop-down list or type a Duration

code.  This identifies how long the treatment plan is to continue.

l If you selected the Use Schedule checkbox, a First Day Times box will be

displayed below the Duration drop-down list.  The number of available

First Day Times fields will range from 1 to 4, depending on the Schedule

you selected.  For example, if you chose BID from the Schedule list, there

will be 2 First Day Times fields available and a default time will display in

the Time 1 and Time 2 fields.

Helpful Hint: The Use Schedule option allows you to chose pre-set times for repeated

events, giving you further control over scheduling delivery of treatment plan items.  Schedules

can have up to 4 fixed treatment delivery times per day, depending on what you select from the

Schedule drop-down list.   First Day Times are defined as the scheduled daily delivery times

for the treatment plan item.

l The # Items To Be Created field indicates the total number of  Items created by

the Treatment Plan.  This number is calculated automatically after you have entered

Start, Frequency or Schedule and Duration values.

l Add notes or comments where needed in the Comments box.

l Click OK to add the item to the Treatment Plan.

l You will be returned to the Treatment Plan window.  The Treatment Plan

item details appear in the columns in the Items area.

l The Treatment Plan item summary line appears in the Treatment Plan box

on the bottom half of the Treatment Plan screen.

l If you want to add more items to the Treatment Plan, click Add to repeat the

Add To Do Item process.

Printing Treatment Plans
You can print the Treatment Plan listing in two formats: Regular and Compact. The contents of

each format will be the current view (i.e. with any filters applied) in the Treatment Plan Items

list.

The Regular format prints one page per patient. Patient information is printed in the header of

each page, and Treatment Plan items are printed in rows, with columns for Date, Time, Treat-

ment, Qty, Units, and MRC.

The Compact format essentially duplicates the current view in the Treatment Plan Items list.

Each Treatment Plan Item is printed on an individual line, with columns for Date, Time, Qty,

MRC, Patient, Staff, Room, Title (of the Treatment Plan Item), and Notes.

To print the current list of items in the Treatment Plan Item list:

l From the Treatment Plan list, click Print.
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l Click Regular or Compact from the dialog that appears.
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Vendors
DVMAX uses Vendor records to identify and standardize the names for the sources of inventory

for your practice. Vendor records are connected to Purchase records.

Vendor records allow you to see all purchases you have made from each vendor. Special Vendor

records are used for inventory adjustments and for recording inventory use by your practice or

clinic.

For more information on the relationship between Vendor and Purchase records, see Purchases.

Vendor Records: An Overview

Vendor Records can provide the following information:

l Contact Information for a Vendor

l Comments or notes about your dealings with a Vendor

l A list of your clinic’s past purchases from a Vendor

Creating a New Vendor Record
To create a new Vendor in DVMAX:

l Choose Inventory Management from the Section drop-down menu.
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l From the Find dialog, choose Vendors from the Search For drop-down list.

l Select Add New.

l A New Vendor record dialog opens.

l Type a unique code for this vendor into the Code field. This code identifies

the Vendor, and can be up to 8 characters long.

l Type the vendor’s name into the Name field. The vendor’s name can be up

to 40 characters long.

l Type the vendor’s mailing address into the Address, City, State, and Zip

fields.

l Type the name of your practice’s contact within the Vendor’s company into

the Contact field.

l Type your account number, if any, with this Vendor into the Acct# field.
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l Type the Vendor’s phone and fax numbers into the Toll Free#, Fax #, and

Alt # fields.

l Type the vendor’s Email address in the Email field..

l Type any relevant information about this Vendor into the Comments field.

l Click OK to save the Vendor record.

Search for a Vendor Record
To search for a Vendor record in DVMAX:

l Choose Inventory Management from the Section drop-down menu.

l From the Find window, choose Vendors from the Search For drop-down

list.

l Choose Vendor Code from the By drop-down list to search for Vendors by

code.

-OR-

l Choose Vendor Name from the By drop-down list to search for Vendors by

name.
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l Type a Vendor Code or Vendor Name in the field below the By drop-down

list. The label of this field depends on your choice from the By drop-down

list.

To find by Vendor code, you must type at least the first character, in sequence, of the code

you want to find. If you are searching by name, the characters you type can appear anywhere in

the Vendor’s Name field.

l Click Search.

If there is more than one match for your search, the Vendors List window will appear, con-

taining a list of items that matched your search.

l If there is only one Vendor that matches your criteria, DVMAX will open

that Vendor Record.
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l If there are no matches, DVMAX will display a message to that effect and

return you to the Find window. Try your search again.

You can also quickly locate a Vendor by following the steps in Listing All Vendors and dou-

ble-clicking the one you are interested in from the list.

Listing All Vendors
To list all Vendor records in DVMAX:

l Choose Inventory Management from the Section menu.
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l From the Find window, choose Vendors from the Search By drop-down

list.

l Click All Records at the bottom of the Find window. A list of all Vendor

records opens.

l Each Vendor is listed on an individual line, with columns for code and Ven-

dor name.

Deleting a Vendor Record
To delete a single Vendor record from DVMAX:

l Find and open the Vendor you wish to delete. See Search for a Vendor

Record.

l Click the Delete button at the bottom of the Vendor window.

l DVMAX will ask you to confirm that you want to delete the Vendor record.
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l Click Delete.

To delete multiple Vendors from DVMAX:

l List all Vendors (see Listing All Vendors).

l Click to select the Vendor records you wish to delete.

Press and hold the SHIFT key to select multiple adjacent Vendors from the list. Press and

hold the CONTROL key to select multiple non-adjacent Vendors.

l Choose Delete Records from the Vendors menu.

l DVMAX will ask you to confirm that you want to delete the Vendor rec-

ords.

l Click Delete.

About the Adjust Vendor Code
DVMAX uses the Adjust Vendor code to record adjustments to your inventory levels. By mak-

ing purchases with the Adjust Vendor code, you can set up initial inventory levels and make cor-

rections to recorded inventory levels.

When the Adjust Vendor code is used on a purchase:

l DVMAX permits you to purchase negative quantities. This means you can

use the Adjustment vendor on a purchase to record an increase or decrease

of inventory levels.

l DVMAX will not calculate any sales tax, since there is no real purchase

being made.
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l The costs that you put into the adjustment purchase will update the cost in

the system.

l The Adjust Vendor code is installed with DVMAX and cannot be altered or

deleted. DVMAX notifies you of this when you open the Adjust Vendor rec-

ord:

See Purchases for more information.

Listing Inventory Adjustments
To list all Inventory Adjustments in DVMAX:

l Locate the Adjustment Vendor by searching for the Adjust Vendor code

(see Search for a Vendor Record).

l All Inventory Adjustments are listed as part of the Adjustment Vendor rec-

ord.

The Hospital Vendor
DVMAX uses the Hospital Vendor code to record inventory used by your practice. The Hos-

pital Vendor code allows you to record your use of inventory items (such as foods, cleaners,

cage supplies, etc.) even though they are not billed.

When the Hospital Vendor code is used on a purchase:

l DVMAX treats the purchase as consumption, reducing the inventory on

hand. All quantities are automatically set as negative.

l DVMAX measures purchases in Dispensing units. All other purchases are

measured in Purchasing units. This makes it easy to record the consumption

of individual cans of food, etc. See Inventory for more information on Pur-

chasing and Dispensing units.

l Changes in the cost of an item are not recorded.

The Hospital Vendor code is installed with DVMAX and cannot be altered or deleted.

DVMAX notifies you of this when you open the Hospital Vendor record:
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Listing Hospital Inventory Use
To list all Hospital inventory use:

l Locate the Hospital Vendor by searching for the Hospital Vendor code (see

Search for a Vendor Record).

l All Hospital Purchases are listed as part of the Hospital Vendor record.
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Vetstreet (Pet Portals) and DVMAX

DVMAX works with the Vetstreet/Pet Portals systems to permit your clients access information

about their animals online and receive extensive educational materials.  To use this feature, you

must have a Vetstreet/Pet Portals account set up and have DVMAX configured to stream data to

Vetstreet.

DVMAX exports specific client and patient information, such as patient history, appointment

details and reminders, to Vetstreet on a set, daily time table. For more information on Vetstreet

(formerly Pet Portals), visit www.vetstreet.com.

To enable Vetstreet to work with DVMAX, you need to contact DVMAX Technical Sup-

port at 1 800 ,950 5455.  Our Technical Support staff will guide you through the basic setup

process.  Please have your DVMAX ID ready when calling Technical Support.
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VSurv and DVMAX Integration
VSurv is an automated client satisfaction measurement system from VetEd. It is designed to:

l Send survey emails to a practice’s customer base.

l Report survey results back to the practice.

l Alert the practice if a customer has had a bad experience.

Sending VSurv Surveys to Customer Base
Once a day, DVMAX will pull data of clients who have completed a finished invoice over the

last five days.

The Client data collected includes:

l Client ID

l Title, First Name, Last Name

l Address 1, Address 2, City, State

l E-mail

l Phone Number, Fax Number

l New Client (true or false)

l Client Status Code

l Client Status - Description of those who have had a finished invoice within the

last 5 days

The Patient data collected includes:

l Patient ID, Patient Name,

l Species, Breed, Sex, Color, Weight,

l Visit Reason,

l Visit check in Time & Date, Visit checkout Time & Date,

l New Patient (True or false),

l Euthanized (true or false),

l Microchip ID,

l Rabies Tag #,

l Patient Birthday (exported as Date of Birth)

l Patient Status,

l Patient Status Description
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DVMAX places this data in a specified location on the users hard drive or network.  The

data is then collected by the VSurv Client, which uploads the information to the VSurv Server

for processing.

The VSurv Server then generates a series of email invitations to specified clients asking them to

take part in an online quality survey based on their last visit.

VSurv is an Internet based system and can only send out email requests to clients who have a

valid email address.

Receiving VSurv Survey Results
When a client accepts to take part in an online survey, the results are collected by the VSurv

Server and forwarded to the practice for review.

A file containing survey results is sent to DVMAX. When these results are received:

l DVMAX is alerted that results from VSurv have been received

l Alert messages are created for appropriate clients

l Clients report having had a negative experience at the practice are noted.

In addition, survey results can reviewed on the VSurv website.

To view the results via the web:

l Go to www.vsurv.com

l Enter your username and password

You will presented with a list of options including:

l View Reports

l Manage Surveys

l Manage Alerts

l Edit Client E-mail

View Reports allows you to view survey Reports

Manage Surveys allows you to add or delete questions included in the survey.

Manage Alerts allows you to edit when a client survey response will warrant an alert in

DVMAX.

Edit Email allows you to edit the greeting email sent out with the survey.

Setting Up VSurv

To enable VSurv to work with DVMAX, you need to contact DVMAX Technical Support

at 1 800 950 5455. Our Technical Support staff will guide you through the basic setup process. 
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Please have your DVMAX ID ready when calling Technical Support.

In general, the steps involved include:

l From VSurv, you will need to complete a VSurv application, and acquire a

VSurv username and password.

l Download and follow the VSurv installation instructions.

l After installation is complete it will ask you to identify your practice software.

Choose DVMAX.

l VSurv will then ask for your VSurv username and password, which you would

be assigned during the application process with VSurv. Enter your VSurv user-

name and password.

l Unzip vsurvdataaccess.dll to c:\program files\vsurvclient\ and select "Yes" to

overwrite existing file.

l Select Run/Programs/Animal care Technologies/vsurv/vsurv

l Choose DVMAX as the practice software.
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Word Processing and Document Handling
DVMAX’s integrated, full-featured word processing facility makes it possible for you to quickly

and easily create customized letters, reminder cards, rabies certificates and any other documents

you require.  You can access the word processing features of DVMAX from Clients, Patients or

Referral Source sections, and the documents you create and save can be made available to all of

the workstations on your network.   The flexibility of the word processing facility allows you to

create individual case documents or build document templates that can include virtually any data

from a client, patient or referral source record.

For Macintosh Users - Apple now recommends that all documents have a filename exten-

sion.

Opening Word Processing
You can access the Word Processing function from a client, patient or referral source record. To

open the Word Processing facility:

l From a patient record, select the Word Processing tab or choose Word Proc-

essing from the Patient drop-down menu.

l From a client record, select the Word Processing tab or choose Word Proc-

essing from the Client drop-down menu.

l From a referral source record, choose Word Processing from the Referral

Source drop-down menu.
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l The Word Processing tab will present two options including opening a New

Blank Document or opening a Document Template.

l If you wish to open a blank document select New.

l If you wish to open a pre-existing Template select the document in the doc-

ument list and select Open.

Document Templates
DVMAX provides a long list of useful documents in the Word Processing tab. These documents

include:

l Templates used for everyday working tasks. These are usually Protected doc-

uments

l Detailed Health information listings provided by Lifelearn

Protected Document
Some documents listed in the Word Processing tab have an asterisk before the document name.

These asterisk usually distinguish the document as a Protected Document and are used to place

the most commonly used documents at the top of the document list. Protected documents are

usually templates that are used for daily tasks around the clinic.

For more information view Save As Template and Overwriting Protected Documents later in this

chapter.

Lifelearn Health Documentation
DVMAX has provided a series of health related documents from Lifelearn. These documents

provide background information on a series of common ailments. This can be printed or emailed

to the client for further reference.  These documents are listed alphabetically and do not have an

asterisk in front of the name.

To open a Health document:

l Select the document you wish to open

l Select the Open button

l The document will then open in the Word processing window.
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Navigating the Word Processing Facility
The Word Processing window is made up of several parts.   These include:

l A main Word Processing menu bar above the text area, with drop-down menus

such as File, Edit, Insert and Tools.  (See also, About the Word Processing

Menus.

l A white document area.

l Four toolbars, which may appear above or below the menu bar, depending on the

toolbar.  By default, some of the toolbars are hidden.  To view, select one or

more toolbars from the Toolbars list under the View drop-down menu.

l A WP Fields menu, which can be accessed by clicking the Show Palette but-

ton.

l A horizontal ruler, located above the text area and a vertical ruler on the left

side of the text area.

About the Rulers
The rulers display the position and type of tab stops, the position of margins and the position of

the first line indent. There are 2 rulers on the WP window: the horizontal ruler at the top of the

text area, and the vertical ruler on the left of the text area. 

The horizontal ruler consists of two main parts:

l The ruler itself displays the location and type of tab stops as well as the location

of the margins.  Symbols appear along the ruler to indicate the position and type

of tabs as well as the location of the margins. 
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l A drop-down menu, located at the top left end of the ruler, allows you to select a

type of tab. 

l The vertical ruler allows you to adjust top and bottom page margins, as well as

letting you quickly resize the header and footer areas as needed.

For more information about how to use the ruler to set tabs and margins, see Format a

Document.

Using the Copy Ruler command from the Paragraph drop-down menu lets you copy all

ruler settings from a current paragraph (including tab type and location, first line indent, and mar-

gin settings) and apply them to any other paragraph(s) you select.

E-Mailing an Open Word Processing Document
You can initiate e-mail directly from the e-mail button at the bottom of the Word Processing win-

dow.

l Click the email icon, and the Email WP Document window opens.
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l Specify an email address in the From field. If there is only one possible To

address, it is entered automatically. Complete the Subject field and Message

body, and click Send.

About the Word Processing Menus
There are 2 menu bars that relate to the Word Processing facility:

l The WP drop-down menu is available from the DVMAX menu bar until you

open a WP document.

The WP Fields menu, accessed by clicking the Show Palette button, is used for inserting ref-

erences in to word processing documents

WPMenu

The WP menu is located on the DVMAX main menu bar when a patient, client or referral

source record is open.  This menu allows you to delete the current word processing document,

WP Fields and the Word Processing Palette
The WP Palette replaces the WP Menu in Word Processing.  It is accessed by clicking Show

Palette from an open WP document and provides tools for inserting specific references from a

record in to a document.  Items like client name, patient name, addresses, reminders, logs and

more can be automatically inserted to quickly create customized documents or templates.  See

Inserting References as well as the Word Processing sections in Client, Patient and Referral

Source chapters for more information on the WPPalette.
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Main Word Processing Menus
The Word Processing menu bar has 10 drop-down menus.  Many of the functions listed under the

menus can also be accessed from the toolbars (see About the Toolbars).  The word processing

menus are briefly described below.

File - The File menu located on the Word Processing menu bar is used for printing, opening and

saving files and for accessing word processing preferences. See the related sections in this Word

Processing chapter for more detail.

All references to the File menu in this Word Processing chapter refer to the File menu

located on the Word Processing menu bar and not the File menu on the DVMAX menu bar.

Edit – From the Edit menu you can access familiar word processing features such as Cut/Paste,

Undo or Re-do, and the Find/Replace features. It also allows you to modify the character case

(toggle between upper and lower case) and to select the whole document. See Edit a Document

for more detail.

View - The View menu is used to choose how the document is displayed.  See Viewing Options

for Documents, Menus and Toolbars for more detail.

Insert – Use the Insert menu to insert certain references, such as current date, time, and page

number.  You must use the WP menu to insert specific references relating to a client, patient or

referral source record.  See Inserting References for more detail.

Style - The Style menu gives you access to defining certain attributes of selected text, including

plain, bold, underline, italics and case.  See Format a Document for more detail.

Colors – Use the Colors menu to choose a color for selected text or other characters.   See For-

mat a Document for more detail.

Paragraph – The Paragraph menu allows you to define or modify settings for selected par-

agraph(s), including line spacing, justification and alignment. It also lets you select and insert bul-

lets, and to copy or paste the Ruler (to apply formatting from one paragraph to another).  See

Format a Document for more detail.

Format – The Format menu provides access to the format choices for many style-related items,

including font type and font attributes, tab settings, borders, paragraph alignment, and column

format.  It enables you to access the style sheet dialogue box as well.  See Format a Document.

Tools – From the Tools menu you can select a spellchecker, define a language for the document,

display and edit the properties of the document (title, subject, author and notes) and display doc-

ument statistics (word count, number of characters, paragraphs and so on). It also allows you to

update or freeze 4D references in the document. See The Tools Menu.

About the Word Processing Toolbars
When you first access the Word Processing function, the toolbars may be hidden.  You can be

display one or more toolbars by selecting a toolbar from the Toolbars list under the View menu. 

The toolbars are designed to provide quick access to some features that would otherwise require

the use of menu commands.   The Toolbars will display above or below the Word Processing
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menu bar, depending on the toolbar.  See Viewing Options for Documents, Menus and Toolbars

for more information.

There are 4 toolbars available under the View menu:  the Standard toolbar, the Format toolbar,

the Style toolbar and the Borders toolbar. All of the functions available on the toolbars are also

available from the drop-down menus on the Word Processing menu bar.

The unit of measure for new Word Processing documents is inches.

Standard Toolbar
The Standard toolbar features the following buttons from left to right: New Document, Open

Document, Save Document, Print Preview, Print button, Find, Cut, Copy, Paste, Undo, Redo,

View Invisible, View References, Insert Current Hour and Insert Current Date. Information on

applying these commands is available from the related sections in the Word Processing chapter.

Format Toolbar
The Format toolbar includes the text alignment buttons, the line spacing buttons and the bullet

button.  These are also available from the Paragraph and Format menus on the Word Proc-

essing menu bar. This toolbar is displayed by default.  See Format a Document for information

on applying these commands.

Style Toolbar
The Style toolbar offers a Style Sheet drop-down list, a Font drop-down list, a Font size drop-

down list, and a set of 3 Style buttons (for bold, italic and underline styles).  This toolbar is dis-

played by default.  See Format a Document for information on applying these commands.

Borders
The Borders toolbar contains 2 sets of buttons:  the individual border buttons and the frame but-

tons. See Format a Document for information on applying these commands.

Using Paragraph-Based Formatting
As is common with full-featured word processing applications, DVMAX’s Word Processing

facility uses paragraph-based formatting.  This means that most formatting -like line spacing, jus-

tification, margins and tab stops - is applied to an entire paragraph.  Every paragraph within the

main body of the document will have the same formatting unless you specifically change the set-

tings, either by highlighting a paragraph(s) and applying new formatting preferences; or by using

the Copy Ruler and Paste Ruler commands to apply specific formatting to a selected paragraph. 
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Paragraphs are defined as text with a <RETURN> marking the end of the paragraph. The Word

Processing function uses word wrap, and will automatically wrap your text down to the next line

when you reach the right margin.  Therefore, you should not press <RETURN> or <ENTER> at

the end of a line unless you want to start a new paragraph.

Knowing how to format your document is helpful when creating new templates for items like

reminder cards, where you may want to vary the paragraph formatting in different parts of the

document.  See Format a Document for more information on paragraph formatting.

Using Word Processing Templates
The word processing function can be used to create a plain document for use only for one client,

patient or referral source.  However, most of the documents you create using DVMAX’s word

processing function will be templates, meaning they will not be written for use for just one client

or patient but can be used by any client or patient in the database. 

A template is basically a form letter, where some elements of the document are dynamic (they

can change each time the document is viewed or printed) while other parts of the document will

be static (the content will stay the same).  For example, in a client “Welcome” template, content

like client name or address will change each time you open the template in a different client rec-

ord, but the body of the letter will read the same for each client.  

To create templates, you will use DVMAX’s WP menu and various formatting options.  Tem-

plates are saved as a special document class (either Protected Documents, Label Documents or

Other Documents) in DVMAX, and can be accessed by any workstation on your network.  See

Inserting References and Document Class for more information on creating templates.

When you create a template, it will be available to any record of the same type as the rec-

ord in which it was created.  For example, if you create a form letter in a client record, that doc-

ument will be available from any other client record.  See also, Document Class.

Document Preferences and Page Setup
The document preferences and page setup options can be selected from the word processing File

menu. 

Page Setup
Selecting Page Setup displays the Page Setup options window, including page orientation (land-

scape or portrait), paper size, and page margins.  You can also choose a different printer by

clicking Printer from the Page Setup window.
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Preferences Menu
When you select Preferences from the word processing File menu, it opens a Preferences

window.  From the Preferences window you can set document preferences, such as ruler units

(centimeters or inches), header and footer options, and widow and orphan control.

From the Document tab under Preferences, you can determine the appearance of a document,

including whether headers and footers are displayed and whether a frame appears around the

text area of a document on the screen.

Units
The Units option determines the unit of measurement that will be displayed on the ruler. The

ruler is used to set the margins, first line indent and tabs for the document. 

l From the Units drop-down menu under Preferences, select centimeters or

inches.
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Headers and Footers
l From the Documents tab under Preferences, select Different on First Page if

you want to define different headers and footers for the first page and for the

remainder of the document.

l From the Documents tab under Preferences, select Different on Left and

Right Page if you want to define different header and footers for the left and

right pages.  If you do not select this option, the headers and footers will be the

same on every page.

See also Format a Document and View or Hide Headers and Footers for more information on

working with headers and footers.

First Page
l From the First Page Is option under Preferences, choose Right to set the side

of the first page to the right or choose Left to set the side of the first page to the

left.

l Type the number of the first page in the First Page Number box.  Page

numbers on the rest of the document will be updated accordingly.

DVMAX Practice V8.6 - User Manual



- 925 -

Paragraph
l In the Default Tab Spacing box, change the default value for tab spacing if

required.  This value will be applied to all the paragraphs that have no custom

settings.

l SelectWidow and Orphan Control to prevent the first line of a paragraph from

being left at the end of a page.  This will also prevent the last line of a par-

agraph from being left at the beginning of a page.

Spellchecker and Dictionaries
DVMAX comes with a built-in spellchecker and dictionary.  You should not use the Spell-

checker settings under Preferences under Word Processing.  You will, however, want to con-

figure the Shared Dictionary function in order to make the same dictionary available to all

workstations.  See Shared Dictionary in this User Guide.

Go To Full Window
Select Go To Full Window to expand the word processing window to the screen size (Mac OS)

or to the size of the window of the application (Windows).  In this view, the word processing

menu bar temporarily replaces the DVMAX main menu bar.

Viewing Options for Documents, Menus and Toolbars
The View menu provides several options for how you view documents, menus and toolbars.

View Document Layout
You can have the word processor display your document on the screen. In either Normal or Page

mode.

l From the View drop-down menu, select Normal to display the document as an

uninterrupted series of paragraphs without columns, headers or footers. When

this mode is selected, a checkmark appears next to the Normal option on the

View menu.

l From the View drop-down menu, select Page to display the document as a suc-

cession of separate pages, and display text columns. When this mode is

selected, a checkmark appears next to the Page option on the View menu.

DVMAX Practice V8.6 - User Manual



- 926 -

View or Hide Toolbars
Selecting the Toolbars option on the View menu displays a list of available toolbars.

l From the View drop-down menu, choose a toolbar from the Toolbars list.  The

toolbar will be displayed below or above the Ruler on the word processing win-

dow (depending on which toolbar you choose) and a checkmark will appear

beside the name of the selected toolbar on the Toolbar submenu.

l Click again to hide the toolbar. 

l See About Toolbars for information about each toolbar.

View or Hide Rulers
l From the View drop-down menu, select Rulers display the rulers.  This is the

default setting.  When rulers are displayed, a checkmark shows next to the

Rulers option on the View menu. 

l Click again to hide the rulers. 

DVMAX Practice V8.6 - User Manual



- 927 -

When Page view is selected, both horizontal and vertical rulers are displayed on the doc-

ument screen. When Normal view is selected, only the horizontal ruler shows.

View or Hide Headers and Footers
l When in Page view, selecting the Header option from the View menu displays

the document header area at the top of the current page (see Documents, Head-

ers and Footers.  When in Normal view, the Header option is not available,

since Normal view cannot display the header area.

l When in Page view, selecting the Footer option from the View menu displays

the document footer area at the bottom of the current page (see Documents,

Headers and Footers.  When in Normal view, the Footer option is not avail-

able, since Normal view cannot display the footer area. See also Format a Doc-

ument and Document Preferences and Page Setup for more on headers and

footers.

View or Hide References
By default, the computed values of references in a document are displayed.  For example, if

there is a client name reference inserted in your document, you will usually only see the actual

name of the client associated with the record in which you are working.  However, when you

choose to view references, you will see the reference value, such as [Client Name].  See Insert-

ing References for more on working with references.

l From the View drop-down menu, select References to display the values of the

references within the current document. When References is selected, a check-

mark appears before the References option on the View menu. 

l Click again to deselect and display only the computed values of the references.
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View or Hide Pictures
l From the View drop-down menu, select Pictures to display any pictures that

may be in your document.  When Pictures is selected, a checkmark appears

before the Pictures option on the View menu.

l Click again to deselect.  When Pictures is not selected, the document will dis-

play frames instead of pictures.  This makes the display faster.

View or Hide Invisible Characters
l From the View drop-down menu, select Invisible Characters to display invis-

ible characters, such as paragraph markers, page breaks and tabs. When Invis-

ible Characters is selected, a checkmark appears before the Invisible

Characters option on the View menu.

l Click again to deselect and hide invisibles.

View or Hide Frames
View Frames will show you the margins and borders of the document, footer and header areas,

as well as any other place in the document where frames are in use.

l From the View drop-down menu, select Frames to display any frames that may

be in your document.  When Frames is selected, a checkmark appears before

the Frames option on the View menu. 

l Click again to deselect and hide frames.

View or Hide Scrollbars
l From the View drop-down menu, selecting Horizontal or Vertical Scrollbar

displays the selected scrollbar.  When Horizontal or Vertical Scrollbar is

selected, a checkmark appears before the Scrollbar option on the View menu.

l Click again to deselect and hide the scrollbar.

View or Hide the Word Processing Menu Bar
l From the View drop-down menu, selectMenu Bar.  This displays the Word

Processing menu bar. WhenMenu Bar is selected, a checkmark appears before

the Menu Bar option on the View menu.

l Click again to deselect and hide the menu bar.  When the menu bar is hidden,

you can display it again either from the View menu or by pressing

CTRL+SHIFT+M (Windows) or COMMAND+SHIFT+M (Mac OS).

View or Hide the Status Bar
The status bar is located at the bottom of the word processing document window.  It includes

information such as page, line and column numbers in relation to the position of the cursor in the

document.
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l From the View drop-down menu, select Status Bar.  This displays the status bar

at the bottom of the document. When Status Bar is selected, a checkmark

appears before the Status Bar option on the View menu.

l Click again to deselect and hide the status bar.

Documents, Headers and Footers
Each word processing document is divided in to 3 main parts: the header, the footer and the main

body of the document.

About Headers
Material that is printed at the top of each page, such as the document title or company logo, is

known as the header. You must be in Page view to see the header.  You can control when the

header is printed from Preferences under the File menu on the Word Processing menu bar,

located above the text area.  See Viewing Options for Documents, Menus and Toolbars and For-

mat a Document for more information on headers.  You do not have to use a header in a

document.  Use the vertical ruler to adjust the upper and lower margins of the header.

About Footers
Material that appears at the bottom of each page of a document, such as the page number, is

known as the Footer. You can control when the footer is printed from Preferences under the

File menu on the Word Processing menu bar, located above the text area.  You must be in Page

view to see the footer.  See Viewing Options for Documents, Menus and Toolbars and Format a

Document for more information on footers.  You do not have to use a footer in a document.  Use

the vertical ruler to adjust the upper and lower margins of the footer.

About the Main Body of a Document
The main body is the core part of the document, such as the letter portion of a client Welcome

letter.  The practice or clinic letterhead is typically located in the Header area.

Create a New Document
DVMAX allows you to create a single document, created exclusively for a specific client,

patient or referral source record, or build a template or form letter.  A form letter lets you send

the same letter or reminder to a large number of recipients, while customizing details like client

name, address, patient name or reminder items.

The process of creating a document is the same, regardless of whether you intend to use the

letter for a mass mailing, or want to send only a single note.  Depending on how you save the

document, it will be saved as either a template (such as a Protected Document) or a document

specific to the record in which you are working (Case Document).  Most documents you work

with in DVMAX will be templates, in that they will not be written for a single client or patient

but can be used by any client or patient in the database.

The following steps provide an overview of the process used to create a document.  Refer to the

specified sections for further detail on a particular step. 

To create a new document:
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l From a client record, select the Word Processing tab or choose Word Proc-

essing from the Client drop-down menu.

-OR-
l From a patient record, select the Word Processing tab, or choose Word Proc-

essing from the Patient drop-down menu.

-OR-
l From a referral source record selectWord Processing from the Referral

Source drop-down menu.

l From the File drop-down menu on the Word Processing menu bar (above the

white text area), select New.

l Add text to the main body of the document.  This can include typing text as well

as the insertion of references from the WP Palette menu. See Inserting Ref-

erences for more detail.

l Make changes as needed to fonts, margins, styles or other formats.  See Format

a Document.

l Add a header and footer if needed. See Format a Document.

l Choose Save As from the File drop-down menu to save your document.

l From the Save WP Document window, type a name for your document.

l From the Document Class drop-down menu, select the type of document you

have created.  See Document Class under Save a Document.

l Click Save or Save as Case Document (depending on what type of document

you are creating) to save the file to the database, or choose Disk to save the file

to disk.  See Saving a Document for more.
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Before saving your document, make sure you understand the document class and save to

disk options.  See the section Save a Document for more information on this important issue.

Open an Existing Document
To open an existing document:

l From a client record, select the Word Processing tab or choose Word Proc-

essing from the Client drop-down menu.

-OR-
l From a patient record, select the Word Processing tab, or choose Word Proc-

essing from the Patient drop-down menu.

-OR-
l From a referral source record selectWord Processing from the Referral

Source drop-down menu.

l From the list of documents on the Word Processing window bar, click to select a

document, then select Open, or double click on a document to open.

Open a Document on Disk
To open a document located on a disk drive, USB drive, or other similar media:

l From the Word Processing tab, choose Disk.
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l From the Import window, select the document you want to import and click

Open.

-OR-
l From the Import window, double click on the document you want to open.

Edit a Document
You can make changes to any type of document, regardless of the Document Class.  Then, you

can choose to save the document under a new file name or under the same file name and doc-

ument class, replacing the older version.  You can use any of the formatting features to add to a

document or delete sections of a document. 

The Edit menu on the Word Processing menu bar contains several options that are useful for edit-

ing, moving and replacing parts of a document.  The Edit menu options are described in general

below and should be familiar to those who have worked with other word processing applications.

Undo Action – Word Processing
Selecting Undo Action from the Edit menu reverses your last action on the document. If the last

action cannot be undone, the Undo Action option becomes Cannot Undo Action. The Cannot

Undo Action menu option cannot be selected and does not perform an action.

Redo Action – Word Processing
Selecting Redo Action from the Edit menu repeats the last action you cancelled on the

document.  If the last action cannot be repeated, the Redo Action option becomes Cannot Redo

Action. The Cannot Undo Action menu option cannot be selected and does not perform an

action.
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Cut – Word Processing
Selecting Cut from the Edit menu deletes the current selection and places it in the clipboard.

Copy – Word Processing
Selecting Copy from the Edit menu copies the current selection and places it in the clipboard.

Paste – Word Processing
Selecting Paste from the Edit menu inserts a copy of the contents of the clipboard at the location

of the insertion point (where you place the cursor), or replaces a selection (such as a selected

paragraph) with the contents of the clipboard if anything is selected.  Use this in conjunction

with the Cut and Copy functions to move, copy or remove sections of text.

If the contents of the clipboard are an image, DVMAX will display a Paste Picture win-

dow. This window lets you to choose where the picture will be pasted.

Delete – Word Processing
Selecting Delete from the Edit menu deletes the current selection.

Select All – Word Processing
Choosing Select All from the Edit menu selects all of the elements present in the area being

edited (characters, tables and pictures).

If Page view is selected, and the cursor is located in either the header or footer area, only

the contents of that area will be selected.

Find – Word Processing
Selecting Find from the Edit menu opens the Find window.  The Find function is used to search

the current document for specified characters, styles, borders, or formatting.

To search for specified text or characters in your document:

l From the Edit drop-down menu, select Find.

l In the Find window, type the character or text you want to find in the Find box. 

Use the additional style options to conduct style, border or format searches.

l Click Find.  The first instance in the document that matches the search param-

eters will be returned.
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Find Next – Word Processing
Selecting Find Next triggers a search based on the last character or format search you

performed.  See Find for more on running a search.

Replace – Word Processing 
Selecting Replace from the Edit menu opens the Replace window.  The Replace function lets

you locate and replace specified text, characters, styles and more.   It is similar to the Find func-

tion, except that in addition to finding characters, text, formats or styles, you can replace those

instances with new text.

To search and replace text or characters in your document:

l From the Edit drop-down menu, select Replace.

l In the Replace window, type the character or text you want to find and replace

in the Replace box.  Use the additional style options to conduct style, border or

format searches.

l In the With box, type the character or text you want to use to replace the exist-

ing text. Use the additional style options to set style, border or format options for

the new text.

l Click Replace or Replace All.

Replace Next – Word Processing
Selecting Replace Next triggers a find and replace based on the last character or format search

you performed.  See Replace for more on running a search.

Saving a Word Processing Document
DVMAX allows you 2 options when saving documents:  Save or Save As.  As well, you can

choose to save the document either to the database, so that all workstations may access the doc-

ument, or save the file to disk.

If you are not sure if you should select Save or Save As, choose the Save As command and fol-

low the steps outlined under Save As.  The Save As command will always prompt you with a
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message in a Confirm window if you are about to overwrite an existing file with the current doc-

ument.

Save – Word Processing Option
Selecting Save saves the current document at its current location.  Use this option if you are sav-

ing changes to an existing document, using the same file name and Document Class settings

(see Document Class).  If you are saving a new document, selecting Save behaves like Save As,

and a Save WP Document window opens.  You will need to choose a file name and a Document

Class.  To save a new version of an existing document (separate from the original) or to save a

file to disk, choose Save As.

To save a document using Save:

l From the File drop-down menu, choose Save.

l The current document will be saved, overwriting the existing file.  No further

message is displayed.

If you use the Save command to save a Protected Document, the Save WP Document win-

dow opens, and DVMAX defaults the Document Class to Case Document in order to prevent

accidental overwriting of Protected Documents.  See Overwriting Protected Documents for more

information.

Save As – Word Processing Option
Selecting Save As opens the Save WP Document window.   Use this option if you are saving a

new document, saving a Protected Document or saving an existing document under another

name. 

To save a document using Save As:

l From the File drop-down menu, choose Save As.
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l On the Save WP Document window, type a name for the document.  Select

Disk to save the file to disk.  See also, Saving to Disk.

Placing an asterisk (*) before the name of a document will automatically make the doc-

ument a Protected Document.  Protected Documents named with an asterisk will appear at the

top of the list of Protected Documents.  If you are overwriting an older version of protected doc-

ument whose file name contained an asterisk, make sure the asterisk is included in the new file

name.  DVMAX automatically removes this asterisk to prevent accidental overwriting of pro-

tected documents.

Double clicking on the original protected document name in the document list will ensure

that both of the documents (old and new) will have the same name.

l From the Document Class drop-down list, choose a document class.  For more

information, see Document Class.

l Click Save to save the document to the database.  Files saved as Protected Doc-

uments, Label Documents or Other Documents will be available from any rec-

ord of the same type in the database.  For example, if you save a Label

Document from a client record, it will be available from any other client record.

-OR-
l Click Save As Case Document.  This will save the file as a Case Document,

regardless of what you selected from the Document Class list.  As Case Doc-

ument is only available from the record in which it was created.
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If you choose to use the same name and Document Class as the original file, you will over-

write the original file with the current document.  This is true for documents from all Document

Classes.  See Document Class for more information.

Document Class in Word Processing
The Document Class drop-down list from the Save WP Document window allows you to select

the type of document you want to save.  The class you select from determines how the document

is stored.  DVMAX provides 4 document classes:  Case Documents, Protected Documents,

Label Documents and Other Documents.

Case Documents in Word Processing
Case Documents are specific to a selected client, patient or referral source record and are only

available from the record in which they were created.  When you save a document, DVMAX

defaults to Case Document as the document class.  If you have created a form letter, label or

other template that you would like to make available from any client, patient or referral source

record, you must save the document as either a Protected, Label or Other document class. 

Save as a Case Document when:

l The document you are saving is only intended for the record in which you are

working, save it as a Case Document.

l Do not save it as a Case Document if you intend to use the document as a tem-
plate to create form letters, reminder card or similar documents, see Protected

Documents, Label Documents and Other Documents.

When you save a document as a Case Document, any reference values that may be

inserted in the document are replaced with the computed reference (actual data from a record)

and cannot be reversed.

Protected Documents in Word Processing
Protected Documents are templates, meaning they are not written for use by just one client or

patient but can be used by any client or patient in the database.  Unlike Case Documents, these

types of documents contain references inserted using DVMAX’s WP menu.  These references

will automatically pull in the appropriate information from a record and display it in the doc-

ument, customizing the document for each reader while allowing you to leave the body of the

letter or other document the same.  See Using Templates for more on templates.
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When you save a new document as a Protected Document, it stores that document in a Pro-

tected Documents directory and prevents you from accidentally overwriting the template using

a series of security measures.  This is especially useful if your practice keeps a variety of forms

on file and uses them to generate documents such as referral letters. 

If you make changes to a protected document and then choose Save or Save As, the document

class will default to Case, keeping the template from being overwritten.  To overwrite the exist-

ing Protected Document, you must make sure the file has the same name as the original doc-

ument and then choose Protected Document from the Document Class drop-down menu. 

DVMAX then confirms that you intend to overwrite the protected document.  See Overwriting

Protected Documents for more information.

Save as a Protected Document when:

l The document can be used as a template for creating form letters, reminder

cards, referral letters and similar documents.

l The document you are saving is a key template used in generating letters,

reminders or similar material in your practice.  Templates can also be stored

under Label Documents or Other Documents, but the Protected Documents

designation offers extra default security settings to prevent accidental over-

writing for core templates.

l You want to access the template from any record that is of the same type as the

record in which it was created.  For example, a Protected Document created in

a client record can be accessed from any other client record.

l Consider using Label Documents if this is a template used for creating labels. 

This may help you organize your template documents more efficiently.

l Consider using Other Documents if this template is not among the documents

you use heavily, or if you want a way to further organize your special template

files.

l If the document is not a template, see Case Documents.

Label Documents in Word Processing
Label Documents are templates you create for use in generating custom labels.  They are sim-

ilar to Protected Documents in that they are templates that can be used by any client or patient

in the database.  When you choose Label Documents from the Document Class menu, the doc-

ument will be saved under the Label Documents directory.  This helps sort regular Protected

Documents, like letters and reminders, from templates used for generating labels.

When you save an existing Label document, the default Document Class is Label Documents. 

If you try to overwrite an existing Label Document, you will be asked to confirm that you want

to overwrite the file.

Save as a Label Document when:

l The document can be used as a template for creating labels.

l Consider using Label Documents if this is a template used for creating labels. 

This may help you organize your template documents more efficiently. 
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l You can also save label templates under Protected Documents and Other Doc-

uments.

l If the document is not a template, see Case Documents.

Other Documents in Word Processing
Other Documents are also types of templates or forms.  You can use this document class to

save templates that may not be part of your main list of client, patient or referral letters, or if you

want to keep certain types of templates in a separate directory.

When you replace an existing Other document with a more current version (using Save As) the

default Document Class will be Other Documents.  If you try to overwrite an existing Other

Document, you will be asked to confirm that you want to overwrite the file.

l The document can be used as a template for creating form letters, reminder

cards, referral letters and similar documents.

l You want to further organize your template documents in to different directories.

l The document is a template that is not part of your core or heavily used

templates.  Consider saving your core templates as Protected Documents.

l Consider using Label Documents if this is a template used for creating labels. 

This may help you organize your template documents more efficiently.

l If the document is not a template, see Case Documents.

Save As Template Option in Word Processing
Under the File menu on the Word Processing menu bar there is a Save as Template command. 

DVMAX uses a special naming system for document types.  Document templates can be saved

as one of three Document Classes: Protected, Label and Other Documents.  You must use one

of these options when saving a template.  See Document Class.

Overwriting Protected Documents in Word Processing
Protected Documents are template documents used for creating letters, reminder cards and sim-

ilar documents.  They are typically considered part of your core or most heavily used templates,

and it is important to take care not to accidentally overwrite those documents. 

To help prevent accidental overwriting, DVMAX provides some default settings that are

selected on the Save WP Document window when you try to overwrite a Protected Document.

To overwrite a Protected Document:

l From the File menu, click Save or Save As.
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l If you chose Save from the File menu, DVMAX provides a note in red font on

the Save WP Document window indicating that the Document Class was

changed to Case Document. 

l If you select Save As, the Document Class defaults to Case Document, but no

notice in red font is provided on the Save WP Document window.

l To overwrite the current Protected Document, do not change the document name

in the Save As box.  If the current Protected Document begins with an asterisk

(*), make sure the document name in the Save As field also contains an asterisk

(*) if you plan to overwrite.

l If you want to create a new protected document, type a new name for the file in

the Save As box.

l To save the document as a Protected Document, choose Protected Document

from the Document Class drop-down menu.  This is essential if you want to

overwrite the original protected document.  Otherwise, the current document

will be saved as a Case Document, while the original Protected Document will

remain unchanged in the Protected Documents directory.
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l Click Save.

l A Confirm window opens. 

l From the Confirm window, choose Overwrite to replace the previous version of

the Protected Document with the current Protected Document. 

l Click Re-enter if you would prefer to give the document a different name.  This

will take you back to the Save a WP Document window.

Saving a Word Processing Document to Disk
To save a document to disk:

l From the Save WP Document window, click Disk.
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l On the Export window, select the location where you would like to save the file.

l In the File Name box, type a name for the document.

l Click Save.

Documents saved this way are only accessible on the workstation or media (such as disk or

CD) on which they have been saved.

Freeze a Word Processing Document
See The Tools Menu.

Close a Word Processing Document
To close a Word Processing document:

l Use the Save or Save As command from the File menu to save the document

first, as needed.  If you leave the document page without saving, any changes

you made will be lost.

l You may then either use the Open command to open a new or existing doc-

ument.

l If you want to exit WP, click Cancel at the bottom of the WP window

l The current document automatically closes.

Print or Preview a Word Processing Document
You can print or preview documents you have created.  As well, you can use the Print and

Print Merge functions to print a copy of the current document for a selected set of records.

Print a Word Processing Document
To print a document:

l From the File drop-down menu, select Print.

l From the Print window, make any adjustments needed, such as print quantity and

print quality.

l On the Print window, click Print.
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Print Preview a Document in Word Processing
To preview the document:

l From the File drop-down menu, select Print Preview.

l The Print Preview window opens.  The Preview window displays the document

as it will be printed. It also allows you to start or cancel the printing.
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Print Merge Option in Word Processing
The Print Merge function can be used when you want to perform a large mail out, such as mail-

ing Welcome letters or reminder cards.  To use this function, you must first have a selection of

client, patient or referral source records for which you plan to generate letters or reminders.  For

example, you may want to send a personalized Welcome letter to a selection of new clients. 

To print a copy of the current document for each record in your selection of records:

l Make sure you have generated a list of clients, patients or referral sources to

whom you would like to send a personalized copy of the current document.

l From the File menu on the Word Processing menu bar, select Print Merge.

l From the Print window, make any adjustments needed, such as print quantity and

print quality.

l On the Print window, click Print.

Format a Word Processing Document
There are a large number of formatting options available when creating a document.  Most of

these options will be familiar to you if you have experience with any major word processing

application.  The formatting options are described in general below.  See also, Document Pref-

erences and Page Setup.

Many of the formatting options can be accessed from both the toolbars (see About the Toolbars)

and from the drop-down menus on the Word Processing menu bar. 

Document formatting options can usually be applied to selected text, entire paragraphs; or

they can be applied to the full header, footer or body of a document.  This means that formatting
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options such as font, alignment, margins and tabs can change throughout a document depending

on the sections to which you choose to apply the attributes.  See Using Paragraph-Base For-

matting.

Selecting Paragraphs in Word Processing
l To select a single paragraph, click anywhere in the paragraph.

l To select several paragraphs, drag through the paragraphs to select them.

l To select every paragraph in the body of a document, choose Select All from the

Edit drop-down menu.

Adjusting the Font Style, Size and Other Text Attributes
You can customize the font or fonts you want to use in your document.  You can adjust font,

size, color, style and other text attributes.  There are font and text attribute buttons located on the

Style toolbar, as well as Format, Style and Colors menu options that you can use to select attrib-

utes.

Selecting a Font
All fonts available for use in your document can be viewed from the Format drop-down menu. 

If the Style toolbar is displayed (see Viewing Options for Documents, Menus and Toolbars), you

can select a font from the drop-down list on the toolbar. 

To select or change a font:

l Select the text you want to change, or click where you want to type text using a

new font.

l From the Font list on the Style toolbar, select a font.

-OR-
l From the Format drop-down menu, choose Character.

l From the Font list on the Character window, select a font.
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l Click OK from the Character window to apply the font selection.

Choosing Font Size
Text size is measured in points. A point is approximately 1/72 of an inch.  The font size drop-

down list shows sizes ranging from 8 to 72 points. Text size can be adjusted from the Format

drop-down menu.  If the Style toolbar is displayed (see Viewing Options for Documents, Menus

and Toolbars), you can select a text size from the drop-down list on the toolbar.

To select or change a font:

l Select the text you want to resize, or click where you want to type using a dif-

ferent size text.

l From the font size list on the Style toolbar, select a font.

-OR-
l From the Format drop-down menu, choose Character.

l From the Size list on the Character window, select a font size.

l Click OK from the Character window to apply the font size.
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You can directly type a size value in the size box if you would like to assign a size that is

not shown on the drop-down list.  The size must be between 1 and 255.

Choosing a Font Style
Font styles can be used to emphasize or enhance the appearance of text in your document.  Com-

mon examples of font styles are Bold, Underline and Italics. Font style can be adjusted from the

Format or Style drop-down menus.  If the Style toolbar is displayed (see Viewing Options for

Documents, Menus and Toolbars), you can select a style using the style buttons on the toolbar.

To select or change a font style:

l Select the text you want to appear in a different style, or click where you want

to type using a different style.

l From the font style buttons on the Style toolbar, select a style.  Note you can

only select Bold, Underline or Italics from the toolbar.  To choose other

options, use the Format menu.

-OR-
l From the Style drop-down menu, select a style.

-OR-
l From the Format menu, choose Character.

l From the Character window, select a style from the Attributes area.  If you

select Underline, use the Underline drop-down menu to choose an underline

style.
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l Click OK from the Character window to apply the style.

Changing Several Text Attributes at Once
If you have several changes to make to the attributes of a selection of text, you can make those

changes from a single menu.  The Character window, which opens when you select Character

from the Format menu, lets you adjust font, size, style, color and underline style.  It also lets

you preview the changes you are making before you apply them to the selected text. 

To make changes to several attributes at once:

l Select the text you want to change, or click where you want to type using

selected attributes.

l From the Format menu, choose Character.

l From the Character window, select a font type, text size, font color and style.

l Click OK from the Character window to apply the attributes.

Aligning Text
You can align text with the left or right margin of a document, center text between the left and

right margins, or justify the text so it is aligned with both the left and right margins. Text align-

ment can be adjusted from the Format or Paragraph drop-down menus.  If the Format toolbar

is displayed (see Viewing Options for Documents, Menus and Toolbars), you can select an align-

ment using the buttons on the toolbar.  

The alignment will apply to the paragraph or paragraphs you select.  The default value is left jus-

tified.

l To align text to the left, select the Left Align icon from the Format toolbar, or

choose Align Left from the Paragraph drop-down menu.
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l To align text to the right, select the Left Right icon from the Format toolbar, or

choose Align Right from the Paragraph drop-down menu.

l To center text between the left and right margins, select the Align Center icon

from the Format toolbar, or choose Align Center from the Paragraph drop-

down menu.

l To apply full justification, select the Full Justification icon from the Format

toolbar, or choose Full Justification from the Paragraph drop-down menu.

You can also access the justification attributes from the Format drop-down menu.  If you

are making several changes to a paragraph (alignment, line spacing, bullets and indentation)

select Paragraph from the Format menu.

Creating Bullets in a Word Processing Document
You can add bullets to your document from three different places in the Word Processing

facility.  Bullets can be added from the Format or Paragraph drop-down menus.  If the Format

toolbar is displayed (see Viewing Options for Documents, Menus and Toolbars), you can add bul-

lets using the Bullet icon on the toolbar.

Bulleted text formatting will be applied to all selected paragraphs.  To add bullets:

l Click the Bullet icon from the Format toolbar.  This will create bulleted text

using the default bullet selection.  Use the Paragraph drop-down menu to select

a different bullet style.

-OR-
l From the Paragraph drop-down menu, select Bullet; then select a bullet style

from the Bullet drop-down list. 
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l To select a custom bullet style, choose Other from the Bullet list.   From the

Special Character window, choose a bullet character.

You can also add bullets from the Format drop-down menu.  If you are making several

changes to a paragraph (bullets, alignment, line spacing and indentation), select Paragraph from

the Format menu.

Setting Line Spacing
You can set the line spacing used between lines within a paragraph.  Line spacing can be

adjusted from the Format or Paragraph drop-down menus.  If the Format toolbar is displayed

(see Viewing Options for Documents, Menus and Toolbars), you can set the line spacing using

the line spacing buttons on the toolbar.  

The spacing will apply to the paragraph or paragraphs you select.  The default value is single-

spaced.  To adjust line spacing:

l To apply single spacing, select the Single Spaced icon from the Format toolbar,

or choose Single Spaced from the Paragraph drop-down menu.

l To apply double spacing, select the Double Spaced icon from the Format tool-

bar, or choose Double Spaced from the Paragraph drop-down menu.

l To apply one and one half (1.5) line spacing, select the 1.5 Line Space icon

from the Format toolbar, or choose 1.5 Line Space from the Paragraph drop-

down menu.

l To apply custom line spacing, select Other from the Paragraph drop-down

menu.  From the Other Line Spacing window, type a value for the line spacing
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in the Size box.  As with any line spacing selection, the line spacing you type

will be applied to the selected paragraphs.

You can also access the line spacing attributes from the Format drop-down menu.  If you

are making several changes to a paragraph (line spacing, alignment, bullets and indentation),

select Paragraph from the Format menu.

Setting Margins and First Line Indent
You can use the Ruler to quickly and easily set the left and right margins for selected

paragraphs.  On the horizontal Ruler, grey triangles mark the left and right margins and first line

indent.   You may have several different margin settings in a single document.  Select the par-

agraph to which you want to apply margin settings, then set the margins for that paragraph.

You can change the location of the left margin, the right margin, and the first line indent by drag-

ging their markers to the left or right. All three markers move independently and you can position

the left and right margins to within an inch apart.  You can also adjust the upper and lower mar-

gins of the header, footer and main body of the document using the vertical Ruler.

Left and Right Paragraph Margins
The default margins for a new document are based on a standard 8.5 inch by 11 inch paper.  Left

and right margins are 1 inch (2.5 cm) from the edge of the page.  You can adjust those values as

long as you don’t set them beyond the physical edges of your paper size.  The Left and Right

margin markers are represented by upward facing triangles located along the bottom edge of the

Ruler.

To set the left or right margin using the Ruler:

l Select the paragraph or paragraphs to which you want to apply the margin set-

tings.

l Drag the Left or Right margin marker to the desired position.  

l Dotted lines display down the page as guides to help you align margins.

First Line Indent
The indent marker, represented on the by a downward facing triangle along the top edge of the

Ruler, tells you where the first line of text in a selected paragraph will begin.  If you do not want

a first line indent, leave the indent marker in the same position as the left margin marker.

To set the first line indent:
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l Select the paragraph or paragraphs to which you want to apply the first line

indent setting.

l Drag the First Line Indent marker to the desired position.

l Dotted lines display down the page as guides to help you align margins.

Adjusting the Top and Bottom Margins
You can use the vertical Ruler to adjust the upper and lower margins of the header, footer and

main body of the document.  To adjust the top and bottom margins:

l Position the cursor within the part of the document whose vertical margins you

want to adjust.  For example, if you want to adjust the upper and lower margins

of the header, position the cursor in the header area.

l The vertical limits of the document, header or footer are displayed on the ver-

tical ruler.

l Place the mouse cursor over the upper or lower limit of the area on the vertical

ruler. The cursor becomes a double-sided arrow.

l Drag the upper or lower limit of the area to its new location. The footer, header

or document area is then resized accordingly.

l See also, Adding Headers and Footers for more on adjusting vertical limits.

Tabs
Tabs allow you to line up blocks of text and numbers.  Understanding how to set and adjust tabs

is very useful, especially when creating new templates for reminder cards and other documents

that can contain a variety of types of paragraphs.  You can set different tab stops for different

paragraphs.

About Tab Default Settings
By default, new documents are preset with tab stops every 0.5 inches across the page. You can

use these tab stops even though they do not appear on the ruler.  Press TAB to move the inser-

tion point to the next tab stop. You can also set other tab stops anywhere along the ruler. The

default spacing between tabs can be set from Preferences under the File drop-down menu.
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When you set a tab stop, any preset tab stops to the left of it are removed.

Creating Tabs Using the Ruler
You can set tabs easily using the Ruler, or define tabs from the Tabs option under the Format

drop-down menu. 

To set tabs using the Ruler:

l Select the paragraph or paragraphs to which you would like to apply the tab set-

tings.

l Select the type of tab you want to use from the Tabs drop-down menu located on

the left of the Ruler.  There are 5 different tab stops.

l Click in the Ruler to insert the tab stop. The tab stop is inserted where you click.

You can modify its location by dragging it in the Ruler.

l To delete a tab marker, drag it anywhere below the Ruler.

Creating Tabs Using the Format Menu
To create tab stops using the Format menu:

l From the Format drop-down menu, select Tabs.
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l A Tabs window opens.  All tabs for the current paragraph are listed.  Types of

tab markers are listed under the Alignment area (see Tab Types).  Types of fill

characters are listed in the Leading area.

l Click Add to create a tab stop. This creates a new entry in the Tabs area.  To

delete a tab, select a tab from the Tabs area and click Delete.

l Type a new position value in the Position box.  The value will be in inches or

centimeters, depending on the Document Units you selected under

Preferences.  The default is inches.

l Click Set. The new position for the tab is updated in the Tabs area.

l Select the alignment you want for the new tab from the Alignment list.

l If you want a lead line associated with your tab (such as the dotted lines leading

to a page number in a Table of Contents), choose a leader style from the Lead-

ing list.  The default value is None.  Note that you can choose a custom fill type

by clicking the Other and selecting the fill character you want. 

l Click OK. The tab you added will appear on the Ruler.
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Double click on the Ruler to display the Tabs window.  The tab markers for the current

Ruler are listed.  Select the tab you want to modify from the list.

Tab Types
There are 5 tab options available in the word processing function:

Left-Aligned – Text typed after this tab stop will be left-aligned.

Right-Aligned – Text typed after this tab stop will be right-aligned.

Center-Aligned - Text typed after this tab stop will be center-aligned.

Decimal – Creates a decimal separator.

Vertical Separator – Similar to a left-aligned tab stop but a vertical separator is also displayed

at its location.  This is mainly used in tables.

Adding Headers and Footers
To add a header or footer to your document:

Choose Page from the View menu.  Your document must be in Page mode to work with headers

and footers.

l Type the text you want in the header or footer.  In addition to text, you can add

pictures, references or the current date or page number.

l To resize a header or footer, click in the Header or Footer area. The vertical lim-

its of the area are displayed on the vertical ruler.

l Place the mouse cursor over the upper or lower limit of the area. The cursor

becomes a double-sided arrow.

l Drag the upper or lower limit of the area to its new location. The footer or

header area is then resized accordingly.

Borders and Frames
To apply a border:

l Select one or more paragraphs from the document.

l From the Borders toolbar, choose the location where you would like the border

or frame to be placed around the selected text.  You must use the Format menu

to adjust the style of border or frame.
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-OR-
l From the Format drop-down menu, choose Borders. 

l Choose the location where you would like the border or frame to be placed

around the selected text.

l Select the type and color of border or frame you would like from the Frame

Style area of the Borders window.

l Click OK to apply the border or frame style.

Style Sheets
DVMAX lets you create, modify, import and apply style sheets to your document.  You can

apply existing style sheets using either the Style toolbar or the Style Sheets option from the For-

mat menu

The Word Processing facility lets you create two types of style sheets: style sheets that apply

only to characters and style sheets that apply to paragraphs.  A character style sheet specifies a

combination of attributes that can be applied to text.  A paragraph style sheet lets you to set

attributes for a paragraph, which includes the character formats, border settings, tab settings and

paragraph settings.

To apply a style to a paragraph or character:

l Select the character(s) or paragraph(s) to which you would like to apply a style.

l Select a style from the style sheet list on the Style toolbar.  If you want to add or

edit styles, you will need to access style sheets from the Format menu.
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-OR-
l From the Format menu, choose Style Sheets.

l From the Style Sheet menu, choose a style to apply to the current selection. 

The Preview area provides an example of the selected style.

l Use the New, Edit or Import functions to create, modify or add style sheets.

l Select the Description tab on the Style Sheets window to see a summary of the

formatting that is applied to the selected style sheet.

l Click Apply to apply the style to the paragraph or characters you have selected.

Creating Columns in Word Processing
To add columns to a document:

l Select Columns from the Format menu.  A Columns window opens.

l From the Columns window allows, set the width, spacing and number of col-

umns in the document.

l Click OK to apply the column formatting to the selected paragraphs.
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Copy Ruler
Using the Copy Ruler command from the Paragraph drop-down menu lets you copy all ruler

settings from the currently selected paragraph (including tab type and location, first line indent,

and margin settings) and apply them to any other paragraph(s) you select.

Inserting References
Most documents you will create using DVMAX’s word processing function will be templates,

meaning they will not be written for use for just one client or patient but can be used by any

client or patient in the database.  To create templates, you will use DVMAX’s WPPalette. 

The WP Palette
The WPPalette, accessed by clicking Show Palette from a Word Processing document, does

not enter client- or patient-specific information directly, but instead enters a reference to the

appropriate information.  This dynamic reference will automatically pull in the appropriate infor-

mation from the current record and display it in your document, customizing the document for

each reader while allowing you to leave the body of the letter the same.  For example, when you

open a reminder document in a client record, it will automatically pull in the name of the current

client and any other related information for which a reference exists on the template.

The references you can insert will vary depending on the type of record you are in when creating

the document.  While there is some overlap, Clients, Patients and Referral Source records

each have their own set of references.

The WP Palette in a Client Record
The WPPalette in the context of a client record lets you insert information from a client record

into your document, including client, patient and referral source data. See Clients in this user

guide for details on the WP references available for documents created from a client record.

To insert a reference from the WP Palette in a client record:

l Click Show Palette to open the WP Fields Palette.

l Click where you want to insert the reference.

l From the WPPalette, select an option and click Insert.
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Holding down the <Shift> key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

The WP Palette in a Patient Record
In a Patient record the WPPalette, accessed by clicking Show Palette from a Word Processing

document, lets you insert information from a patient record into your document, including client,

patient, referral source and patient history data.  See Patients in this user guide for details on the

WP references available for documents created from a patient record.

To insert a reference from the WPPalette in a patient record:

l Click Show Palette to open the WP Fields Palette.

l Click where you want to insert the reference.

l From the WPPalette, select an option and click Insert.
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Holding down the <Shift> key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

Inserting Lab Results in a WP Document
To insert lab results in a Patient WP document, select Insert Lab Entries from the WP Palette

under the Word Processing tab of a Patient record.
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From the Insert Lab Results dialog, select All Lab Results or specify a date range of lab

results for inclusion in the document. Results can be inserted in chronological or reverse chron-

ological order.

The formatting of the results can be fine-tuned using several advanced settings. Please contact

DVMAX Technical Support if you would like assistance in adjusting results display, including

column widths and margins.

The WP Menu in a Referral Source
The WP Palette in the context of a referral source record lets you insert information from a

referral source record into your document.  The WP Palette is accessed by clicking Show Pal-

ette from a Word Processing document.  See Referral Source in this user guide for details on the

WP references available for documents created from a referral source record.

To insert a reference from the WP menu in a referral source record:

l Click Show Palette to open the WP Fields Palette.

l Click where you want to insert the reference.

l From the WPPalette, select an option and click Insert.
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Holding down the <Shift> key on your keyboard while inserting an item from the Word Proc-

essing Palette will capitalize the text you are inserting.

Date and Time References in a Word Processing Document
To insert the current date, the current time or both:

l Click where you want to insert the date and time.

l From the Insert menu, select Date and Time.

l From the Insert Date window, select the date format from the left list box, or

choose No Date if you do not want to insert the date.  The date will appear in

the preview area according to the format you chose.

l Select the time format from the right list area, or choose No Time if you do not

want to insert the time. The time will appear in the preview area according to

the format you chose.

l Select Automatic Update to allow the date and time values in the document to

be updated to the current date and time whenever the document is opened.   If

you do not select Automatic Update, the time will be fixed on the date and time

the reference was first inserted.

l Click OK.

Inserting Page Numbers
You can place references to page numbers in headers, footers or the body of a document.  If you

insert the page number in the header or footer of a document (you must be working in Page

mode), the page number is automatically updated for each page of the document. This allows

you to number your pages.
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If you insert the page number in the body of the document, it displays the current page number

and will be updated if that page is modified, however this will not be repeated for each page.

This allows you to reference page numbers of your document.

To insert page numbers in your document:

l Click where you want to insert the page number.

l From the Insert drop-down menu, choose Page Number.

l From the Insert Page Number window, select the pagination style you want to

insert.

l Click OK.

The Tools Menu
The Tools menu lets you select utility features such as spellchecking, statistics and document

information and the language selection. Using the Tools menu also allows you to display either

values or references and to either force an update of the references or to freeze them.  You can

also activate or deactivate the Draft mode.
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Freeze a Document
Selecting Freeze Document from the Tools menu freezes the references to data records in the

document so that they are no longer dynamic. In other words, all references are replaced by

actual data, such as replacing a [Client Name] field with the actual client name, just as if the

information was typed in the document. This action cannot be canceled.  You can then save the

document.

Saving a document as a Case Document will accomplish the same task as Freeze

Document.  Select Save As, then choose Case Document from the Document Class menu on

the Save WP Document window.  See Document Class for more information.

Table Wizard
The table wizard allows you to define the settings when creating a table. You can:

l Select predefined table templates.

l Define the number of rows and columns.

l Set an automatic text format.

l Set different automatic values and styles for each column.

l Set different automatic values, colors and styles for specific rows.

Spell Checking in Word Processing
To check the spelling in your document, select Spelling from the Tools menu.  The checking of

the document will begin from the current cursor position.  If the spellchecker encounters a mis-

take, a Spelling dialog box is displayed. 
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You can also setup the Shared Dictionary function from the Spelling window.  The Shared Dic-

tionary function allows all workstations to access the same dictionary. See Shared Dictionary in

this User Guide for details on configuring the Shared Dictionary function.

Language
Choose Language from the Tools menu to check the current language of the document. This lan-

guage is used by the spellchecker to determine if the current selected dictionary fits the

document.  You will not need to use this command, as this is already configured during setup.

Document Information
When you select Document Information from the Tools menu, a Document Information win-

dow opens.  You can store useful extra information about the current document, such as title, sub-

ject, author, clinic or practice name and notes or comments.  Click OK to close the Document

Information window and save changes.

Document Statistics
When you select Document Statistics from the Tools menu, a Document Statistics window

opens.  It displays statistics related to the current document, including the total number of lines,

pages, characters, words, paragraphs, pictures and references in the current document.

Compute References Now
Selecting Compute References Now refreshes the references in the document with the current

data from the record in which you are working.  In general, this will have no effect on your doc-

ument and does not ever need to be selected.  DVMAX will update the information auto-

matically each time you open the document.

Draft Mode
Draft mode enables an accelerated display of characters in certain cases.
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Year-End Procedures and Reports
There are a number of reports and procedures that your practice should run at year-end. These

include backing up your DVMAX data, generating sales, tax, and other financial reports, and

clearing certain time-sensitive client records.

This chapter details what you should do in DVMAX at year-end in your practice. We divide pro-

cedures into those you can run after year-end, and those that must be run at year-end.

Since the time frame for many of these reports is the entire year, some reports will take

awhile to process, and can cause intensive processing on your server. It is advised that you run

these reports at a time that it will impact your business the least.

Accessing Reports
You can generate any financial report available in DVMAX from Reports list on the Command

Palette. To open the Reports list:

l Click the Reports button on the Command Palette to display a list of reports.

You can also generate financial reports from the Reports tab on the Management Func-

tions dialog. To open the Management Functions screen:

l Choose General Management from the Section menu on the DVMAX main

screen.

Reports launched from the Command Palette or from the Reports tab under General Man-

agement will appear in the Window List.

Reports That Must Be Generated At Year-End
The following reports must be run at year-end; they either cannot or should not be run in a new

financial year.

Receivables Report
The Receivables Report gives you a list of all outstanding receivables. For more information, see

the chapter, Financial Reports.

It may take some time to generate the Receivables Report, depending on the number of

invoices in your system and the speed of your computer.

To generate a year-end ReceivablesReport:
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l Click the Reports button on the Command Palette. A list of available reports

opens.

-OR-

l Choose General Management from the Section menu on the DVMAX main

screen.

l From the list of Reports, double-click Receivables Report.

l From the Receivables Report Options dialog, select Totals Only.

l Click OK to generate the report. DVMAX will ask you if you want to print or

export the report.

l Click Export to export the report to an Excel-compatible file on your computer.

-OR-

l Click Print to print the report.

For more information on exporting reports, see Financial Reports in this manual.

If you pay your providers based on production, repeat the steps above and click Provider

Breakdown instead of Totals Only to generate a Receivables Report broken down by provider.
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Inventory Value Report
The year-end Inventory Value Report provides you with the net value of the inventory you have

on hand in your clinic.

You only need to print this report if your practice makes use of DVMAX’s Inventory fea-

tures. For more information, see the chapter on Inventory.

It may take some time to generate the Inventory Value Report, depending on the number of

invoices in your system, and the speed of your computer.

To print the year-end Inventory Value Report:

l Select Inventory Management from the Section drop-down menu of the

DVMAX main screen.

l From the Find dialog, click All Records. This will display a list of all inventory

items.

l While viewing the list of inventory items, choose Select All from the Edit drop-

down menu to highlight all of the items.

l From the File drop-down menu, choose Print.  The Printing Options dialog

opens.
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l Click to highlight Net Value in the list of reports in the Printing Options dialog.

l Click Print.

Reports That Can Be Generated After Year-End
The following reports can be generated after year-end. We recommend you generate them as

early as possible in your new financial year.

Average Invoices Per Doctor Report
The Average Invoices Per Doctor Report gives you average billing and payment information for

each provider in your practice.  For more information on the Average Invoices per Doctor

Report, see the chapter Financial Reports.

The Average Invoices per Doctor Report bases its results only on an invoice’s Primary Pro-

vider. It does not take into account other providers specified on an invoice’s line items. For more

information about Primary Providers and Invoices, refer to the chapter Invoices.

This report can take a long time to complete. It is recommended that you start it at the end

of the day and leave it to run unattended while your business is closed.

To generate the Average Invoices per Doctor Report:

l Click the Reports button on the Command Palette. A list of available reports

appears.

-OR-
l Choose General Management from the Section menu on the DVMAX main

screen.

l Double-click Average Invoices Per Doctor Report from the Reports list. The

Date Range Entry dialog displays.

l Type the Start Date and End Date for the year for which you wish to run the

report into the appropriate Date Range Entry fields.

l The default format for dates in DVMAX is MM/DD/YYYY.

l Click OK.

l From the Print Setup window, make any necessary adjustments to the print set-

tings and click OK.
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l From the Print dialog, choose any necessary options and click OK to print the

report.

Invoice Share by Provider Report
The Invoice Share by Provider Report gives you the average revenue per invoice per provider in

your practice. Unlike the Average Invoices per Doctor report, this report takes into account pro-

viders credited on an invoice’s individual line items. For more information about Primary Pro-

viders and Invoices refer to the Invoices chapter in this Guide.  For more information on the

Invoice Share by Provider Report, refer to the Financial Reports chapter.

This report can take a long time to complete. We recommend you start it at the end of the

day and leave it to run unattended while your business is closed.

To generate the Invoice Share by Provider Report:

l Click the Reports button on the Command Palette. A list of available reports

appears.

-OR-
l Choose General Management from the Section menu on the DVMAX main

screen.

l Double-click Invoice Share by Provider Report from the list of reports. The

Report Options screen opens.

l Type the Start Date and End Date for the year for which you wish to run the

report into the appropriate Date Range Entry field.

l The default format for dates in DVMAX is MM/DD/YYYY. So, for example,

to generate a report for 2012, type 01/01/2012 into the Starting Date field and

12/31/2012 into the Ending Date field.

l By default, Show Invoice Details is selected. Deselect the Show Invoice Details

checkbox.

l Click OK.

l A Print Setup window opens. Set any necessary print settings and click OK.

l A Print window opens. Set any necessary options and click OK to print the

report.

About Generating a List of Top-Spending Clients
Determining which of your clients have spent the most over the course of the year involves per-

forming a search and printing the results of that search.
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Generate a list of top-spending clients before updating the Spent YTD Field. For more infor-

mation, see the Updating the Spent YTD Field section of this chapter.

Determining a Spending Threshold
You need to decide on a spending threshold before performing a search for your top-spending

clients. Simply put, the spending threshold is the minimum dollar amount a client must have

spent at your clinic over the past year in order to be included as a top-spending client. For exam-

ple, if you would like to see all clients who spent more than $1000 at your clinic over the last

year, then $1000 is your spending threshold.

Steps for Generating a List of Top-Spending Clients
To generate a list of the year’s top-spending clients:

l Choose Client and Patients from the Section drop-down menu on the DVMAX

main screen.

l From the Find dialog, select General from the By drop down menu.

l Click Search. The Query Editor dialog opens.

l In the Available Fields drop-down menu, choose All Tables.

l Scroll down the list of fields until you find Dynamic_Client.

l Click the plus sign or arrow beside Dynamic_Client once. This will expand the

list under Dynamic Client.

l Locate Spent YTD in the list under Dynamic_Client. Click Spent YTD once.

l In the Comparisons list to the right of the screen, click is greater than or equal

to once.

l Type your dollar threshold in the Value box. Do not type the dollar sign ($).

l To include only clients who are still active with your practice in the report, click

Add Line and click on Inactive under the available fields table.  Then, under the

Comparison’s table choose is equal to and in the Value field choose False. 
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l Click the Query button in the lower right hand corner of the Query Editor

screen.

The time required to perform this search is dependent on the speed of your computer and the

number of clients and invoices in DVMAX.

Printing the List of Top-Spending Clients
To print your list of top clients:

l While viewing the client list, chose Select All from the Edit drop-down menu at

the top of the screen.  This will highlight the entire list.

l Choose Print from the File menu on the DVMAX main screen. The Printing

Clients window opens.

l Choose Custom from the Report List and click Print. The Quick Report window

opens.

l In the Quick Report window, make sure Related Tables is selected from the

drop-down list under Report Parameters, then double click on Full Name.

l Now select All Tables from the drop-down list under Report Parameters and

click the arrow beside Dynamic Client to expand that listing.

l Drag [Dynamic_Client]Spent_YTD over into the Sort Order box
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l Click the 'up arrow' once, which makes it look like a 'down arrow'. This will

sort the list by Descending (biggest spender first.)

l Go to the File menu and choose Generate

l This will print the list of clients who have spent more than the amount specified

in your previous search, and will be sorted by the greatest to least.

Year-End Income Summary
A Year-End Income Summary allows you to see which categories account for what percentage

of your practice’s revenue over the last year. You generate a Year-End Income Summary by run-

ning a Detailed Sales Report broken down by Category. For more information on Detailed Sales

Reports, see Reports elsewhere in this manual.

This report can take a long time to complete. We recommend you start it at the end of the

day and leave it to run unattended while your business is closed.

To generate a Year-end Income Summary:

l Click the Reports button on the Command Palette. A list of available reports

opens.

-OR-

l Choose General Management from the Section menu on the DVMAX main

screen.

l Double-click Detailed Sales Report from the reports list. The Report Options

screen opens.

l Type the Start Date and End Date for the year for which you wish to run the

report into the appropriate Date Range Entry field.

l The default format for dates in DVMAX is MM/DD/YYYY. So, for example,

to generate a report for 2012, type 01/01/2012 into the Starting Date field and

12/31/2012 into the Ending Date field.

l Click the Category radio button. This tells DVMAX to generate a Category

Sales Report. For more information on this and other reports, refer to the Finan-

cial Reports chapter.
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l Click OK to generate the report. DVMAX will ask you if you want to print or

export the report.

l Click Export to export the report to an Excel-compatible file on your computer

-OR-
l Click Print to print the report.

Sales Tax Report
A year-end Sales Tax Charged Out Report allows you to see a detailed listing of sales tax col-

lected over the course of the year. A year-end total is also provided. For more information on

Sales Tax Reports, see the Financial Reports chapter.

This report can take a long time to complete. We recommend you start it at the end of the

day and leave it to run unattended while your business is closed.

To generate a sales tax report:

l Click the Reports button on the Command Palette. A list of available reports

opens.

-OR-

l Choose General Management from the Section menu on the DVMAX main

screen.

l Double-click Sales Tax Charged Out Report in the expanded Command Palette.

The Date Range Entry screen opens.
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l Type the Start Date and End Date for the year for which you wish to run the

report into the appropriate Date Range Entry field.

l The default format for dates in DVMAX is MM/DD/YYYY. So, for example,

to generate a report for 2012, type 01/01/2012 into the Starting Date field and

12/31/2012 into the Ending Date field.

l Click OK to generate the report. DVMAX will ask you if you want to print or

export the report.

l Click Export to export the report to an Excel-compatible file on your computer.

-OR-
l Click Print to print the report.

For more information on exporting reports, see Financial Reports.

Updating the Spent YTD Field
DVMAX keeps a running total of how much each client has spent per year at your practice.

Updating the Spent YTD (Spent Year-To-Date) tells DVMAX to zero all spending totals for all

clients in preparation for a new financial year. If you do not update the Spent YTD field early in

the new financial year, DVMAX will include the previous year’s spending with the current

year’s, and thus report confusing totals on reports.

You should run this procedure only after you have run all other procedures in this chapter.

In particular, do not run this procedure before generating a list of top-spending clients.

You should only update the Spent YTD field once per financial year, at the beginning of

your financial year. If you are unsure about performing this procedure, please contact DVMAX

Technical Support.

To update the Spent YTD field:
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l Select General Management from the Section menu of the DVMAX main

screen. The Management Functions dialog opens.

l Select the Utilities tab on the Management Functions dialog.

l From Utilities, select Special Routines.

l Click OK.

l From the Special Functions dialog, select Annual Update of the Spent YTD field

(use in January only).

l DVMAX will ask you to confirm that you want to update the Spent YTD field.

It is possible you will be asked to confirm more than once. To proceed, click OK

each time you are asked.
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l DVMAX will display a message when the Spent YTD field has been updated.

Click OK to dismiss the message and continue working with DVMAX.

Year-End Backup
An end-of-year backup does not differ significantly from your regular backup procedures. For

more information on backing up your DVMAX data, see the appropriate section of this manual.

General Backup Guidelines
Your DVMAX data is the single most important asset of your practice; you can protect your

investment by following the guidelines below.

l Backups should be performed daily. Each business day should be backed up to a

separate CD, cartridge, tape or other data storage device.

l Only staff properly trained in backup procedures should perform backups. Incor-

rectly performed backups can cause unexpected data loss. If you need help per-

forming backups, please contact DVMAX Technical Support.

l Keep at least one copy of your backup in a location other than your clinic or

office. This will protect you against theft or fire.

Year-End Backup
We recommend you make a year-end backup on a separate CD, cartridge, tape or other data stor-

age device. Follow these steps to make an annual archive of your DVMAX data:

l Obtain an additional CD, cartridge, tape or other data storage device.

l Make a backup of your DVMAX data as you would normally.

l Label your backup appropriately and store it in a safe place, preferably off-site

in a fireproof container.

Mirroring
DVMAX is able to keep a ‘mirror’ server up and functional to assist with Disaster Recovery

Plans. This feature allows an identical ‘read only’ server to exist idly with up-to-minute infor-

mation of the primary system. In an event that the primary server goes down, the mirror server

can immediately be accessed until a new primary server can be introduced.

To setup Mirroring and review full documentation, contact tech support.
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